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Warnings and Cautions
WARNING

The equipment includes high voltage (230V) which means that the
possibility of receiving an electrical shock is present.

WARNING

Lethal voltage

This system is not fitted with safety interlocks and lethal voltages
may be exposed when access covers are removed. Only persons
qualified and authorised must remove covers and these persons
should always take extreme care once the covers are removed.

WARNING

Fire

If a fire condition arises, emission of toxic fumes can be anticipated
from burning insulation, printed circuit boards, ETC.

WARNING

Health hazard

When cleaning the inside of this system, do not inhale the dust. The
dust is a temporary health hazard, depending on individual allergies.

Kongsberg Maritime AS disclaims any responsibility for damage or
injury caused by improper installation, use or maintenance of the
equipment.

WARNING

Rotating antenna

The rotating antenna may be dangerous for people close by. The
radiation levels at short distances may be harmful, especially for the
eyes if you look straight into the antenna when it is transmitting.

Due caution should be used when working close to the antenna. A note should be left at
the radar display that work is going on close to the antenna, and that the radar should
not be switched on.

There are normally isolation switches to inhibit rotation and transmission during work.

They are normally located so that they may be operated by the radar operator. For
S-Band there is also a switch on the Scanner Control Unit which inhibits rotation and
transmission. For other antennae, if there is an isolation switch for the Scanner Control
Unit, the switch should normally be located close to the Scanner Control Unit for ease
of operation.
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WARNING

Radiation hazard

Keep outside the hazard zone around an antenna or open waveguide
that is radiating power.

Refer to the table below for hazard zones.

When it is necessary to work on the scanner unit, make sure the radar is switched OFF and
that both the mains isolator and the scanner control unit are turned to the OFF position.

Never look directly into an open waveguide.

Radar and other forms of radio frequency radiation can cause cardiac pacemakers to
malfunction. If you use a cardiac pacemaker and suspect a malfunction, leave the
vicinity of the radar system immediately and seek medical advice.

Most countries accept that there is no significant radiation hazard at radio frequency
power density levels of up to 100 W/m2 (10 mW/cm2).

Table 1 Radiation hazard zones for antennae of different lengths

Antenna length 100 W/m2 50 W/m2 10 W/m2

1.2m (4ft) X-band 1.7m 3.4m 17m
1.8m (6ft) X-band 1.05m 2.1m 10.5m
2.4m (8ft) X-band 0.75m 1.5m 7.5m
2.7m (9ft) S-band 0.73m 1.5m 7.3m
3.7m (12ft) S-band 0.55m 1.1m 5.5m

Caution

Electrostatic sensitive device

Certain semi-conductive devices used in this equipment are liable to damage
due to static voltage. Observe all precautions for handling of semi-conductive
sensitive devices.

Note

The information contained in this document is subject to change without notice.
Kongsberg Maritime AS shall not be liable for errors contained herein or for incidental
or consequential damages in connection with the furnishing, performance, or use of this
document. ©2010 Kongsberg Maritime AS. All rights reserved. No part of this work
covered by the copyright hereon may be reproduced or otherwise copied without prior
permission from Kongsberg Maritime AS.
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List of abbreviations

AC Alternating current
ACQ Acquire
AIS Automatic Identification System
ARCS Admirality Raster Chart Service
ARPA Automatic Radar Plotting Aid
BCR Bow Crossing Range
BCT Bow Crossing Time
BIST Built In System Test
CD Compact Disk
CFAR Constant False Alarm Ratio
CLK Clock
COG Course Over Ground
CPA Closest Point of Approach
CPU Central Processing Unit
CRS Course
CTW Course Through Water
DCU Display and Control Unit
dGPS Differential GPS
EBL Electronic Bearing Line
ECDIS Electronic Chart Display and Information System
ETA Estimated Time of Arrival
GMDSS Global Maritime Distress and Safety System
GPS Global Positioning System
HCRF Hydrographic Chart Raster Format
HDG Heading
IBS Integrated Bridge System
IEC International Electrotechnical Commission
IMO International Maritime Organisation
INS Inertial Navigational System. System used to improve dead

reckoning by the use of accelerometers and gyro systems. Mostly
used on military vessels

INS Integrated Navigation System
I/O Input/Output
IP Ingress Protection
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KM Kongsberg Maritime
LAN Local Area Network
LRU Line Replaceable Unit
Man Manual
MBS Main Bang Suppression
MED Marine Equipment Directive (Council Directive 96/98/EC of 20

December 1996 on Marine Equipment)
MHz Mega Hertz
MMSI Maritime Mobile Service Identifier
MOB Man Over Board
NAVINT Kalmanfilter based on NAVigation INTegrator
NC Normally Closed
NM Nautical mile
NO Normally Open
NMEA National Marine Electronics Association (USA)
PC Personal Computer
PCB Printed Circuit Board
PCI Peripheral Component Interconnect (PC bus)
PDOP Position Dilution of Precision
PROX Proximity
PRF Pulse Repetition Frequency
PRN Satellite designated number
RAIM Receiver Autonomous Integrity Monitoring
RL RhumbLine
RIC Radar Interface Card
RM Relative Motion
ROM Read Only Memory
ROT Rate Of Turn
RPM Revolutions Per Minute
RS Radar System
Rx Receive
SA Combined Sync, Azimuth and Headingline signal
SART Search and Rescue Transponder
SMG Speed Made Good
SINT Sensor Interface
SOG Speed Over Ground
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STW Speed Through Water

TCPA Time to Closest Point of Approach

TFT Thin Film Transistor

TIC Transceiver Interface and Control

TM True motion

TP Turn Point

TTD An NMEA sentence for tracked target data

Tx Transmit

UPS Uninterruptible Power Supply

UTC Coordinated Universal Time

UTM Universal Transverse Mercator

VRM Variable Range Maker

WGS84 World Geodetic System 1984

WOL Wheel-over Line

WOP Wheel-over Point

WPT Waypoint

XTD Cross Track Distance

XTL Cross Track distance Limit
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Glossary

AIS targets Targets received from an external AIS receiver.
Apparent wind See Relative wind.
Bearing The horizontal direction of one terrestrial point from another,

expressed as the angular distance from a reference direction,
clockwise through 360º.

C-Map Third party supplier of electronic charts.
Cartesian
coordinate
system

A coordinate system where the axes are mutually-perpendicular
straight lines. Cartesian systems used are UTM, US State Plane
and Local N/E.

Course The horizontal direction in which a vessel is steered or is intended
to be steered, expressed as angular distance from north, usually
from 000º at north, clockwise through 360º. Differs from heading.
COG - Course over Ground. CTW - Course Through Water

Cross track
distance

The distance from the vessel's present position to the closest point
on the track

Datum Mathematical description of the shape of the earth (represented by
flattening and semi-major axis as well as the origin and orientation
of the coordinate systems used to map the earth).

Dead reckoning The process of determining the position of a vessel at any instant
by applying to the last well-determined position the run that has
since been made, based on the recent history of speed and heading
measurements.

Destination The immediate geographic point of interest to which a vessel
is navigating. It may be the next waypoint along a route of
waypoints or the final destination of a voyage

ECDIS Electronic Chart Display and Information System. A navigation
information system which can be accepted as complying with the
up-to-date chart required by regulation V/20 of the 1974 SOLAS
Convention, by displaying selected information from a SENC
with positional information from navigation sensors to assist the
mariner in route planning and route monitoring, and if required
display additional navigation-related information.

ENC Electronic Navigation Chart. A Cell for use in ECDIS systems.
Feedback Signals returned from the process (vessel) and used as input

signals to the Vessel Model.
Gyrocompass A compass having one or more gyroscopes as the directive

element, and which is north-seeking. Its operation depends
on four natural phenomena: gyroscopic inertia, gyroscopic
precession, the earth's rotation and gravity.
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Heading The horizontal direction in which a vessel actually points or
heads at any instant, expressed in angular units from a reference
direction, normally true north, usually from 000º at the reference
direction clockwise through 360º. Differs from course.

IAS Integrated Automation System from Kongsberg Maritime. In an
Integrated Automation System the K-Bridge communicates with
other Kongsberg Maritime systems such as K-Chief and K-Thrust
via a dual ethernet LAN.

IHO International Hydrographics Organisation. Coordinates the
activities of national hydrographic offices; promotes standards
and provides advice to developing countries in the fields of
hydrographic surveying and production of nautical charts and
publications.

IMO International Maritime Organisation. The IMO is the specialised
agency of the United Nations responsible for maritime safety and
effiency of navigation.

K-Bridge Kongsberg Maritime new line of Bridge products, such as
K-Bridge Radar, K-Bridge ECDIS, K-Bridge Planning, K-Bridge
Conning.

Kalman Filter The Kalman filter is a set of mathematical equations that provides
an efficient computational (recursive) solution of the least-squares
method. The filter is very powerful in several aspects: it supports
estimations of past, present and even future states, and it can also
do so even when the precise nature of the modelled system is
unknown.

Leg The straight line between two waypoints.

Log An instrument for measuring the speed or distance or both
travelled by a vessel.

Reference origin The reference point of the first position-reference system that is
selected and accepted for use with the system. The origin in the
internal coordinate system.

Relative bearing The bearing of an object relative to the vessel's heading.

Relative wind The speed and relative direction from which the wind appears to
blow with reference to the moving vessel.

Roll Vessel rotation about the own-ship's centre line.

Route A planned course of travel, usually composed of more than one
leg.

S-52 An IHO publication defining the standard for presentation of
charts on ECDIS.
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S-57 The standard for the transfer of digital hydrographic data. This
consists of (Part A) the Object Catalogue, (Part B) the S-57 format
and digitizing or transfer conventions. Published by the IHO as its
special Publication 57 (S-57).

SENC A database resulting from transformation of the ENC by ECDIS
for appropriate use, updates to the ENC by appropriate means and
other data added by the mariner. It is this database that is actually
accessed by ECDIS for display generation and other navigational
functions and is equivalent to an up-to-date paper chart. The
SENC may also contain information from other sources.

SOLAS International Convention for the Safety of Life at Sea developed
by IMO.

Surge Vessel movement in the fore-and-aft direction.

Sway Vessel movement in the transverse direction.

Setpoint circle The circle around the terminal buoy where the vessel is positioned
during offshore loading operations.

Thruster In this document, this is used as a general term for any element
of the vessel's propulsion system, such as an azimuth thruster,
tunnel thruster, propeller or rudder.

Track A route to be travelled defined by two or more waypoints. Line
of travel may follow arcs with system or operator defined turn
radius at waypoints.

Tracked targets Radar targets tracked by the display unit's tracking algorithm.

Transponder In this document, this is the physical reference of a
position-reference system. For example: for an HPR system this
means any deployed transponder; for an Artemis system, the
Fixed Antenna unit/beacon; for a Taut Wire system, the depressor
weight.

True bearing Bearing relative to true north.

VAC Voltage, Alternating Current

VDC Voltage, Direct Current

Way point A defined position or reference point on a track.

Way point table A set of way points with their parameters, shown in a tabular
form, which defines the track the vessel will follow.

Wheel-over
point

The point where a vessel is commanded to change heading before
a waypoint.

Windows A computer operating system.

Yaw Vessel rotation about the vertical axis; change of heading.
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The Multi-functional Display console

1 The Multi-functional
Display console

This section contains the following topics:
Introduction......................................................................................................................30
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K-Bridge Multi-functional Display Unit

1.1 Introduction
This manual describes the Radar, ECDIS, and Conning applications provided on the
K-Bridge Multi-functional Display (MFD) units running release 5.x (or later) of the
K-Bridge navigation software.

This chapter describes the operator panels and controls on the Multi-functional Display
(MFD) console.

For a description of the user interfaces to the three applications available on the MFD
unit, see The Radar, ECDIS and Conning displays on page 47.

For information about starting and stopping the MFD, switching between the different
applications, and controlling the brightness of the display, see Basic setup information
on page 103.

1.2 The console
The console of the Multi-functional Display (MFD) unit is fitted with a 26” or 27” colour
display with a resolution of 1920 x 1200, or a 23” colour display with a resolution of
1600 x 1200.

The display presents radar and chart images and symbols, on-screen data such as the
own-ship's heading and speed, information about radar targets, and conning information.
(To switch the display between radar, chart, and conning information, see Switching
between Radar, ECDIS and Conning on page 120.)

The display has a nominal viewing distance of 1.5 metres, which makes it comfortably
viewable from the navigator's chair on the bridge of the vessel.
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Figure 1 The K-Bridge Multi-functional Display (MFD) console
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1.3 The operator panel and controls
The console contains an operator panel with a track-ball and a computer-style keyboard.
The keyboard is located in a drawer below the operator panel. Use the openings
underneath the operator panel to pull this drawer out.

The operator panel contains buttons that give immediate access to the most frequently
used functions. These functions can in most cases also be accessed using the track-ball
and select keys. The buttons are organized into sub-panels and command groups. These
sub-panels, command groups, and all the buttons involved are described in the remainder
of this chapter.

The layout of the operator panel is shown in the figure below.

Figure 2 Layout of the operator panel

b
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1.4 The NAV (navigation) panel
The NAV panel contains the following command groups for Navigation commands:
Radar, Display, Modes, Target, Chart and Man Over Board (MOB). For details of the
buttons in each group, see the figures and description below.

Figure 3 NAV (navigation) panel

1.4.1 The RADAR group knobs
The RADAR group comprises three knobs:
• Gain. Used for setting of radar gain level.
• Rain. Used for setting of manual anti rain clutter level.
• Sea. Used for setting of manual anti sea clutter level.
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1.4.2 The DISPLAY group buttons
The DISPLAY group contains six buttons:
• PALETTE (+/-). Use + to brighten and - to darken the display.
• RANGE (+/-).

For K-Bridge Radar: Increases/decreases the range setting
by one increment.
For K-Bridge ECDIS: Increases/decreases the chart scale by a
factor of two.

• TRUE/REL. Toggles between true and relative vector
presentation mode.

• SUPPR.
For K-Bridge Radar: Removes all static information from the
display, leaving only the radar video.
For K-Bridge ECDIS: Removes radar video and targets from
the display when video or targets are visible.

• RESET/CENTRE.
For K-Bridge Radar:
– True motion: causes the sweep center to move to the

position on the screen that gives the maximum possible
look-ahead. For example, if the vessel is sailing from west
to east, resetting the center will position the sweep center
as close as possible to the left edge of the display. The reset
also causes the vessel's course vector to point through the
center of the display.

– Relative motion: moves the sweep centre to the centre of
the display.

– Course Up: resets the orientation of the screen so that
upwards signifies the direction of the ship's heading
(instead of signifying North).

For K-Bridge ECDIS: This button causes the system to move
the own-ship symbol on the screen to the position that gives
the maximum possible look-ahead. For example, if the vessel
is sailing from west to east, resetting the center will position
the own-ship symbol as close as possible to the left edge of
the display. The reset also causes the vessel's course vector to
point through the center of the display.

• ZOOM/RESET.
– For K-Bridge Radar: No effect.
– For K-Bridge ECDIS: Resets chart scale to largest

available.
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1.4.3 The MODES group lamps
The MODES group contains four lamps:
• CRS. When the lamp is lit green it indicates that the Autopilot

operates in CourseMode. Turn commands from Curved EBL
are accepted.

• HDG. When the lamp is lit green it indicates that the Autopilot
operates in Heading Mode. Turn commands from Curved
EBL are accepted.

• WP. When the lamp is lit green it indicates that the Autopilot
operates in Way Point Mode.

• TRACK. When the lamp is lit green it indicates that the
Autopilot operates in Track Mode.

1.4.4 The TARGET group buttons
The TARGET group contains three buttons:
• ACQ. The system will search for a radar echo near the marker

and try to acquire and track it as a target.
• DATA. Opens the Target Information dialog with information

about the target closest to the marker (see Target Information
on page 404).

• CANCEL. Causes tracking of the target closest to the marker
to cease.

1.4.5 The CHART group buttons
The CHART group contains four buttons:
• MONITOR. Press this button to display the chart centred on the

own-ship's current position. The best chart for that position is
then loaded.

• OBJECT INFO. Press this button to display information about
an object in the chart (see Object Info on page 377).

• MANAGE ROUTES. Press to manage routes (see Route List
on page 416).

• STD DISPLAY. This button selects the standard chart themes
(see Chart Themes on page 373). It has effect only when
charts are displayed.
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1.4.6 The MOB (Man Over Board) button
The MOB (Man Over Board) group contains only one
button. Press it to record the ship’s position at the time of a
Man-Over-Board incident.

1.5 The ALC (alarm and control) NAV panel
The ALC NAV panel contains the following command groups:
• The Panel group (see The Panel group on page 36)
• The Autopilot group (see The Autopilot group on page 37)
• The Alarms group (see The Alarms group on page 39)

Figure 4 The ALC (alarm and control) NAV panel

1.5.1 The Panel group
The PANEL group contains two lamps:
• POWER: This lamp is lit green when power to the operator

panel is OK.
• FAULT: This lamp is lit red when the operator panel has lost

contact with the computer; otherwise the lamp is off.

36 381287/A



The Multi-functional Display console

1.5.2 The Autopilot group
The AUTOPILOT group contains two buttons with lamps and
one button without a lamp:
• The IN CMD button (see The IN CMD button on page 37)
• The ACT TURN button (see The ACT TURN button on

page 38)
• The AUTO/PLAN button (see The AUTO/PLAN button on

page 39)

1.5.2.1 The IN CMD button

IN CMD (In Command): when you press this button on the
operator panel, its lamp starts to flash green and the console
attempts to become the operator station that is “in command” of
the autopilot.

Once the console is successfully “in command”, the IN CMD
button's lamp is lit a constant green. This indicates that:
1 This console is in command of the autopilot.

One of the lamps in the MODES group will be lit at the same
time to indicate the autopilot's operating mode; when the
autopilot allows itself to be commanded by a console, the
console automatically attempts to activate Heading Mode.
(For a description of the MODES group of lamps, see The
MODES group lamps on page 35.)

2 The vessel's steering control system is switched to autopilot
control.

3 The autopilot is ready to control the vessel's steering system.
When the IN CMD button is lit (indicating the above conditions),
if you press it again, the Autopilot Modes dialog appears on
the Radar or ECDIS console screen (see Autopilot Mode on
page 427).

For information about how to make a particular operator station
take command of the autopilot whenever the vessel's steering
control switches from manual to autopilot, see Making one
console take command of the autopilot by default on page 249.
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1.5.2.2 The ACT TURN button

ACT TURN (Activate Turn): Pressing this button has different
effects depending on the context in which it is pressed. Its main
function is to cause the autopilot to accept a planned manoeuvre
as input. But specifically it enables you to:
• Specify a preset turn

If the autopilot is in heading or course mode, press the
ACT TURN button to use the heading wheel and/or turn
radius buttons to specify a turn that will not be performed
immediately. A 'PT' symbol appears near the own-ship
symbol on the console display to indicate that the heading
controls are being used to specify a future maneouvre, not an
immediate one. While the 'PT' symbol is displayed — and the
button's green lamp is lit but blinking off every two seconds
— you are free to use the heading controls without affecting
the autopilot's heading set-point.

• Activate a preset turn
When you have finished specifying a preset turn and you want
to activate it, press the ACT TURN button again. The button's
lamp flashes on and off three times after you press it to send a
new manoeuvre to the autopilot.

• Activate a planned turn
If you have pressed the AUTO/PLAN button (see below) in
this command group and specified a planned turn (using
the Trial Manoeuvre and Curved EBL facilities, see Trial
Manoeuvre and Curved EBL on page 473), press the ACT
TURN button to activate the planned turn. (The turn will be
activated as a defined route, therefore the autopilot will go
into track mode to execute it.)
The ACT TURN button's lamp remains on while you specify
a planned turn, and a 'P' symbol appears near the symbol of
the own-ship on the console display. While the ACT TURN
button lamp is on and you see the 'P' symbol, you can use
the heading controls without affecting the autopilot's current
heading set-point.
The lamp flashes off three times after you press the ACT
TURN button to send the new manoeuvre to the autopilot.

• Abort a preset or planned turn
Press the ACT TURN button twice to abort a manoeuvre that
has been sent to the autopilot.

• Exit Track or Waypoint mode
Press the ACT TURN button twice to exit track or waypoint
mode.
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1.5.2.3 The AUTO/PLAN button

AUTO/PLAN (Autopilot Plan). This button toggles the Nav OS's
display between the AUTO view and the PLAN view. These are:
• A real-time view of the vessel under the autopilot's control

(AUTO).
• A view in which you can use the console display and heading

wheel controls — along with the Curved EBL dialog — to
specify a planned or preset turn (PLAN).

Press the AUTO/PLAN button to stop specifying a planned or
preset turn (before you have activated it) and return the chart
or radar display to a real-time view of the vessel under the
autopilot's control.

If the chart or radar display currently shows the real-time view of
the vessel under the autopilot's control, press the AUTO/PLAN
button to start specifying a planned turn.

When you are specifying a planned manoeuvre, a 'P' symbol
appears near the own-ship symbol on the console display.

When you are specifying a preset turn, a 'PT' symbol appears.

For more information about specifying manoeuvres in advance,
see Using the curved EBL facility on page 308 and Using the trial
manoeuvre facility on page 313. The Trial Manoeuvre facility
enables you to test a turn before executing it to see whether it
involves a risk of collision with a radar target. The facility is
only available in the radar system (see also Trial Manoeuvre and
Curved EBL on page 473).

1.5.3 The Alarms group
The Alarms group is comprised of one lamp and three buttons
without a lamp.
• ALARM. This lamp flashes red when an alert has been

detected. The lamp remains lit while the alert is still active.
The lamp is dark when there are no active alerts present.

• ACK. Press this button once to see a list of unacknowledged
alerts for the alert group of the most recent unacknowledged
alert (see Acknowledging alerts in the Alert Group dialog on
page 336.
Press the button again to acknowledge all unacknowledged
alerts in that group (as long as they have all been displayed;
see Acknowledging several alerts at once on page 335).
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• SOUND OFF. Press this button to silence audible alerts. When
more than one display unit is connected to the local area
network, pressing the SOUND OFF button on any display unit
will silence the audible alert on all units.

• ALARM VIEW. Press this button toggles the Alert Group
dialog between the different alert groups (see Acknowledging
alerts in the Alert Group dialog on page 336).
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1.6 The heading wheel
The Heading wheel is for setting or changing the vessel's course when the console is in
command of the autopilot.

For information about how to use it and its associated buttons, see the figures and
description below.

Figure 5 The heading wheel

The heading wheel comprises one heading wheel and seven buttons. Three of these
buttons are located above the heading wheel. The other four are located on either side of
the heading wheel.
• Heading Wheel: This is used for setting a new heading or course.
• Set/Activate button: Use this button to initiate a heading or course change.
• Heading buttons: If the console is in command of the autopilot, and the autopilot is

operating in Crs or Hdg mode, use the +/– buttons to set the new heading or course
set-point on the autopilot (they adjust the heading or course by ± 1 degree for each
press of the button).
You can also use these buttons to adjust the curved EBL for a planned turn (see The
AUTO/PLAN button on page 39). However, you cannot execute the planned turn
unless the console is in command of the autopilot.

• Turn Radius buttons: Use the left and right buttons to adjust the turn radius.
• Distance-to-Turn buttons: Use the up and down buttons to adjust the distance to turn.
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1.7 The input panel (including trackball)
The input panel is a general panel for navigation on bridge systems. It includes an
alphanumeric keypad and a trackball which functions as a mouse device.

Figure 6 The input panel

The INPUT group of buttons contains 19 buttons. One of these has a lamp. This is
the abc... (toggle) button.
• 2 / abc. If the button is pressed when the panel is in numeric mode, the number 2 will

be entered. When the panel is in alphanumeric mode the letter A will be entered. You
need to press the button twice to enter the letter B and three times to enter the letter C.

• abc... (toggle button). Toggles between numeric and alphanumeric mode. Numeric
mode is the default. Press the button for one second to toggle. A short beep will
confirm the change. The lamp is lit green when the panel is in alphanumeric mode
(letters) and not lit when it is in numeric mode (numbers).

• PAGE UP. This button has the same function as on a standard keyboard: it scrolls
the screen up.

• PAGE DOWN. This button has the same function as on a standard keyboard: it scrolls
the screen down.

The three mouse buttons have the following functions:
• Left button: Selects an object (and generally functions as a standard left mouse

button).
• Middle button: Redraws the chart so that the vessel is shown at the last marker/cursor

position. However, if the browsing facility is on (see ECDIS range panel: viewing
controls on page 88), then clicking the middle button redraws the chart so that the
centre of the display is at the last marker/cursor position.

• Right button: Brings up context-sensitive menus where applicable.
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1.8 The alphanumeric keyboard
A standard alphanumeric keyboard is available in a drawer in front of the operator panel.

They layout of the alphanumeric keyboard compartment is as follows:

Figure 7 Keyboard compartment layout

Filter

Power Supply

Keyboard releasing lock

Keyboard

115/230 V AC socket

Modem/Net connection
(RJ45)

(Service only)

Cd090902a

1.9 A removable mouse device
You can attach a mouse to the operator station computer inside the console.

If you do this, the three mouse buttons will have the same function as the mouse buttons
associated with the trackball (see The input panel (including trackball) on page 42).

However, if the mouse has a scroll button, you can use this to zoom in and out both in
ECDIS and Radar.

381287/A 43



K-Bridge Multi-functional Display Unit

1.10 The brightness controls on the monitor

1.10.1 The status indicators and brightness knob on 27”
and 23” monitors
If you are using a system with a Hatteland 27” TFT monitor (JH27T11, JH27T14) or
a Hatteland 23” monitor (JH23T02, JH23T12, JH23T14), there is a brightness control
knob with LEDs around it located near the bottom right-hand corner of the display. The
patterns formed by the LEDs around this knob indicate the status of the monitor. The
possible statuses are summarized in the table below.

Table 2 The monitor status LED patterns on the 27” monitor

LED pattern Monitor status Description
Status: No power is connected to
the monitor.

Eight LEDs are off (not lit).

Status: The monitor is in standby
mode.

Eight red LEDs are on (not
flashing).

Status: The monitor is searching
for a video signal.

One green LED comes on in a
sequence that loops through all
the LEDs.

Status: The monitor is on and the
video signal is OK.

Eight green LEDs are on (not
flashing).

Status: The monitor is on but
there is no video signal.

Four red LEDs, diagonally
opposite to each other, are on
(not flashing).

Status: The monitor is on but
there is a delay before the menu
appears.

Seven green LEDS are on (not
flashing) and one after another is
off. This is a repeating sequence
that loops through all the LEDs.

Status: The monitor is going into
standby mode.

One red LED after another is
on (not flashing) in a sequence.
This lasts for a few seconds, after
which all LEDs are lit red.

There are further LED patterns which indicate whether the back-light and brightness are
at the ECDIS calibration level. For instructions about checking the ECDIS calibration
level, see Establishing the correct colour calibration on the monitor on page 116.
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1.10.2 The brightness controls on 26” monitors
To control the back-light on the 26” monitors, use the up and down
(or on some models the + and – arrow) buttons beneath the screen.

For instructions about checking the ECDIS calibration level, see Establishing the correct
colour calibration on the monitor on page 116.

1.11 References
While using this manual, you might need to refer to the following other Kongsberg
Maritime publications:

386008 K-Bridge Autopilot Operator Manual
305306 K-Bridge Steering Control System Operator Manual
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2 The Radar, ECDIS and
Conning displays

This section contains the following topics:
Radar, ECDIS and Conning: general layout....................................................................48
The top bar .......................................................................................................................57
The menu area..................................................................................................................75
The radar dashboard.........................................................................................................77
The ECDIS range panel ...................................................................................................88
The radar video area.........................................................................................................93
The ECDIS chart area ......................................................................................................97
The boarding areas in Radar and ECDIS.........................................................................99
The track-ball marker in Radar and ECDIS...................................................................101
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2.1 Radar, ECDIS and Conning: general
layout
This chapter describes the screen user-interface for each of the three applications
available on the MFD unit: Radar, ECDIS and Conning.

For information about switching between the three applications, see Switching between
Radar, ECDIS and Conning on page 120.

The layout of the screen for each application partly depends on the aspect ratio of the
console’s display: 16:1 (widescreen) displays have a different layout from 4:3 (standard)
displays. The differences, as they affect each application, are listed in the table below.

Table 3 Differences in layout between 16:10 and 4:3 displays

Screen area Location on a 16:10
(widescreen) display

Location on a 4:3 (standard)
display

Top bar Top of screen Top of screen
Menu At the far right end of the top bar In Radar: beneath the radar

dashboard
In ECDIS: beneath the ECDIS
range panel
In Conning: top right-hand corner
(beneath the top bar)

Radar
dashboard

To the left of the square radar
viewer

To the right of the square radar
viewer

ECDIS range
panel

Top left-hand corner of the ECDIS
chart area

Top right-hand corner of the
ECDIS chart area

Boarding area In Radar: to the right of the square
radar viewer
In ECDIS: to the right and left of
the screen (as required)
In Conning: not available

In Radar: bottom right-hand
corner
In ECDIS: to the right and left of
the screen (as required)
In Conning: not available

The Conning application has a top bar and a menu, both of which it shares with ECDIS
and Radar.

However, the Conning display is divided into different panes containing, thruster and
rudder setpoints and feedback, heading, depth, and wind data, and some other panes
some of which are optional.

For a description of the Conning panes, see Using the Conning application on page 261.

The largest of the Conning panes is the Ship pane. This contains a large outline of a ship
which in turn encloses the thruster and rudder data. The orientation of this Ship pane
determines the layout of the Conning user interface, and its orientation depends on the
physical orientation of the operator station. If the operator station is:
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• In the centre of the forward bridge (so that you stand at it and look straight ahead)
then the Ship pane will be vertical with the bow of its ship symbol pointing upwards
in the direction of the ship’s bow.

• On a bridge wing (so that you stand at it and look straight out to port or starboard)
then the Ship pane will be horizontal with the bow of its ship symbol pointing to the
left or right in the direction of the ship’s bow.

For a description of the Ship pane, see The Ship pane on page 263.

For information about specifying the orientation of the Ship pane, see Select Monitor
on page 605.
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Figure 8 The Radar layout (16:10 display) – dashboard on left
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Figure 9 The Radar layout (4:3 display) – dashboard on right
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Figure 10 The ECDIS layout (16:10 display) – range panel on left
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Figure 11 The ECDIS layout (4:3 display) – range panel on right
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Figure 12 The Conning layout (16:10 display) with vertical Ship pane

54 381287/A



The Radar, ECDIS and Conning displays

Figure 13 The Conning layout (4:3 display) with vertical Ship pane
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Figure 14 The Conning layout depends on whether the Ship pane is vertical or
horizontal
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2.2 The top bar
The top bar presents:
• The console's system name and the current operator’s password access level: normal

(when no password has been entered); user (when the user password has been
entered); service (when the service engineer password has been entered).
To enter a password, see Password on page 593.

• The drop-down menu for switching between Radar, ECDIS and Conning (see
Switching between Radar, ECDIS and Conning on page 120).

• The date and time.
• A button for taking command of the autopilot from the console.
• A button for turning the radar on.
• Buttons for acknowledging different categories of alarm.
• The text of the most recent unacknowledged alarm
• The own-ship's position (and position offset, if any), and its heading and speed. This

information is presented on a series of buttons, and clicking them brings up dialogs
on the screen.

• (On 16:10 displays for ECDIS only) Buttons for toggling on and off the left and
right boarding areas.

• (On 16:10 displays) Forward and backward buttons (for navigating the menus and
dialogs of the user interface.

• (On 16:10 displays) Buttons to access the menus and dialogs.
The contents of the top bar are described in this section.
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Figure 15 The top bar for 4:3 and 16:10 displays
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2.2.1 Top bar: the colours of the sensor buttons
Note

The information is displayed with different background colours to provide additional
information to the user.

The colours of the position, position offset, heading and speed buttons in the top bar have
the following meanings:
• Grey: Normal operation.
• Yellow: Abnormal operation. An example is if you are operating the system with

manual heading or speed input: this will result in the heading or speed information
being displayed on a yellow background.

• Red: Alarm. The data for heading, speed and position will be shown on a red
background if there is no signal from the sensor providing the data.

For information about the colours of the alarm group buttons, see The alert condition
group buttons on page 61.

2.2.2 Top bar: the “AP in Cmd/In Cmd of AP” button
When the operator station is:
• in command of the autopilot, this button is green, and for:

– 4:3 displays, the text reads “In Cmd of AP”
– 16:10 displays, the text reads “AP Cmd”

• not in command of the autopilot, the button is grey and the
label reads “AP”.

Press the button to bring up the Autopilot Modes dialog (see Autopilot Mode on
page 427), which enables you to take command of the autopilot at the console you are
using and also to specify an operating mode for the autopilot.

2.2.3 Top bar: the Scanner/Transceiver button
Press this button to bring up the Radar Control dialog which
enables you to start the radar transceiver (see Radar Control on
page 539). To start it you must select Master and then Run in
the Radar Control dialog.

This button on the top bar has the same function as the
Scanner/Transceiver button on the Radar dashboard except
that it displays only the name of the selected transceiver as its
button text (it does not display any status information; see Radar
dashboard: the Radar System Information panel on page 83).

However, the colour of the button communicates status
information as follows:
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• Green: this console is master in relation to the transceiver
(see also Making the display unit master of the transceiver
on page 107).

• Grey: this console is a slave in relation to the transceiver.
• Yellow: one of the following is true:

– The transceiver is in standby.
– The pulse length is different from the current scale of the

display. When this is the case, the pulse length indicator in
the button text is prefixed by an exclamation mark (!).

For further information, see Radar dashboard: the Radar System
Information panel on page 83.

2.2.4 Top bar: the alert area

Figure 16 The area on the top bar

For more information about the numbered items, see:
1 The alert condition group buttons on page 61
2 The alert priority group buttons on page 65
3 The Alert priority button on page 66
4 The Alert help button and the Alert Information dialog on page 68
5 The Most-relevant dialog button on page 68
6 The Unacknowledged alerts button on page 69

The alert area of the top bar contains:
• Seven alert condition group buttons: DNG, LOST, NEW, XTD, GRND, AREA, ANCH.

These buttons each:
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– Show a certain colour to indicate that there are active alerts in the group. The
colour is determined by the priority of the alerts in the group: red (for alarms),
yellow (for warnings), off-white (for cautions). The alerts in a particular group are
always all of the same priority.

– Flash to indicate that there are unacknowledged alerts in the group.
– Show grey if there are no unancknowledged or active alerts in the group.
For information about how to use these buttons, see The alert condition group buttons
on page 61.

• Three alert priority group buttons: CAUTION,WARNING, and ALARM.
These buttons each:
– Show a certain colour to indicate that there are active alerts in the group. The

colour is determined by the priority of the alerts in the group: red (for alarms),
yellow (for warnings), off-white (for cautions). The alerts in a particular group are
always all of the same priority.

– Flash to indicate that there are unacknowledged alerts in the group.
– Show grey if there are no unancknowledged or active alerts in the group.
For information about how to use these buttons, see The alert priority group buttons
on page 65.

• A message area displaying the text of the most recent unacknowledged alert along
with the date and time it was issued.

• An alert priority button. This button appears to the left of the alert text for the most
recent unacknowledged alert, and indicates its priority. The button takes three forms:
an off-white Caution button (this is the lowest priority), a yellowWarning button, a
red Alarm button (this is the highest priority).

• An alert help button. Click this button to bring up a dialog containing more
information about the most recent unacknowledged alert (see The Alert help button
and the Alert Information dialog on page 68).

• A most-relevant dialog button. Click this button to bring up the dialog (if applicable)
that is most relevant to the alert displayed (see The Most-relevant dialog button on
page 68).

• An unacknowledged alerts button. Click this button to see a list of all currently
unacknowledged alerts (see The Unacknowledged alerts button on page 69). The
colour of this button is off-white, yellow, or red; it is determined by the priority of the
highest priority active and unacknowledged alert in the list.

2.2.4.1 The alert condition group buttons

These buttons each represent alerts associated with a particular condition (the condition
being one of either immediate or potential danger). Use the them as follows:
• Click on an alert condition group button when it is flashing see the list of active alerts

for the group (see The Alert list dialogs on page 70). Click it again to acknowledge to
acknowledge the currently unacknowledged alerts in the group.

• Click on an alert condition group button when it is not flashing but has a solid colour
(red or yellow but not grey), to see the list of active alerts for the group.
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If the button is not flashing but has a solid colour, there are currently no
unacknowledged alerts in the group but there are still active alerts that require
investigation.
If the button is grey, there are no active alerts in the group and no alert list will be
displayed.

DNG: . Alerts in this group indicate that one or more tracked targets are
exceeding the ship’s proximity limit or that the own-ship is exceeding the
CPA or TCPA limit for one or more targets. These limits are specified in
the Alarm Limits dialog (see Alarm Limits on page 411).

DNG alerts can only be finally acknowledged at the operator station that
generated them (see Alerts that must be acknowledged from the station
that generated them on page 332).

To indicate unacknowledged alerts the DNG button flashes RED.

To indicate acknowledged but still active alerts the DNG button shows
a constant RED.

DNG alerts generated by a Radar application that is running on the same
MFD unit as the ECDIS will not cause the DNG button to flash on the
ECDIS top bar, nor will they appear in the DNG alert list for ECDIS. (DNG
alerts generated by other Radar operator stations will cause the DNG button
to flash on the ECDIS top bar and will appear in the DNG alert list for
ECDIS.
LOST: . Alerts in this group indicate that the tracking system has lost track
of a target. They are not issued for targets that are more than 20 NM distant
from the own-ship or for automatically acquired targets that are lost in the
blind sector behind the own-ship (as defined by the automatic acquisition
zone). For an example of the symbol for a lost radar target, see Radar
target symbols on page 145.

LOST alerts can only be finally acknowledged at the operator station that
generated them (see Alerts that must be acknowledged from the station
that generated them on page 332).

To indicate unacknowledged LOST alerts this button flashes YELLOW.

To indicate acknowledged but still active LOST alerts the button shows a
constant YELLOW.

LOST alerts generated by a Radar application that is running on the same
MFD unit as the ECDIS will not cause the LOST button to flash on the
ECDIS top bar, nor will they appear in the LOST alert list for ECDIS.
(LOST alerts generated by other Radar operator stations will cause the
LOST button to flash on the ECDIS top bar and will appear in the LOST
alert list for ECDIS.
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NEW: . Alerts in this group indicate that a new radar target has been
acquired.

The radar system detects new targets automatically. They appear on the
display with a flashing new target symbol. For an example of the symbol
for a new target, see Radar target symbols on page 145.

When targets are in the acquisition phase (before they have been stably
tracked), the NEW button is not active: it shows grey (in the daylight
palette) and does not flash.

When one or more targets have been successfully acquired (in other words,
when they are being stably tracked), the radar system issues a new target
alert. The NEW button then flashes YELLOW until you click it. When you
click it, the button stops flashing and so do the new targets in the radar area;
they are now displayed as normal targets.

Note

If you click the NEW button while the targets are still in the acquisition
phase (before a new target alert has been issued), the target symbols in the
radar display stop flashing straightaway and no new target alert will be
issued when the targets become stably tracked.

NEW alerts can only be finally acknowledged at the operator station that
generated them (see Alerts that must be acknowledged from the station
that generated them on page 332).

To indicate unacknowledged alerts the button flashes YELLOW.

To indicate acknowledged but still active alerts the button shows a constant
YELLOW.

NEW alerts generated by a Radar application that is running on the same
MFD unit as the ECDIS will not cause the NEW button to flash on the
ECDIS top bar, nor will they appear in the NEW alert list for ECDIS.
(NEW alerts generated by other Radar operator stations will cause the NEW
button to flash on the ECDIS top bar and will appear in the NEW alert
list for ECDIS.
XTD: . Alerts in this group indicate that the cross-track distance exceeds
the off-track limit minus the Off-track Alarm Margin (see Ship (tab) on
page 571). The Off-track Alarm Margin is (at least) the distance from the
own-ship's pivot point to the outer edge of the hull. This value enables the
system to report that the ship is off track when part of it crosses the off-track
limit, not just when the ship's pivot point has crossed the off-track limit.

You can specify an off-track limit for each leg of a route in the Waypoint
List dialog (see Edit route on page 420).

The default off-track limit is specified in the Route tab of the System
Parameter settings dialog (see Route (tab) on page 570).
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XTD alerts can be acknowledged from any operator station on the network.

To indicate unacknowledged alerts the button flashes RED.

To indicate acknowledged but still active alerts the button shows a constant
RED.
GRND: . Alarms in this group indicate that the vessel is in danger of
running aground. The safe depth limits are specified in the Safety Depth
dialog (see Safety Depth on page 479).

The look-ahead time for the grounding alarm is specified in the Grounding
Alarm Setup dialog (see Grounding Alarm Setup on page 470; the width of
the ground-check area is also specified in this dialog).

To check the vessel's maximum draught (see Ship (tab) on page 571.

GRND alerts can only be finally acknowledged at the operator station that
generated them (see Alerts that must be acknowledged from the station
that generated them on page 332).

To indicate unacknowledged alerts the button flashes RED.

To indicate acknowledged but still active alerts the button shows a constant
RED.
AREA: . Alerts in this group indicate that the vessel is sailing close to an
area of the chart that is dangerous or restricted.

AREA alerts can only be finally acknowledged at the operator station that
generated them.

To indicate unacknowledged alerts the button flashes YELLOW.

To indicate acknowledged but still active alerts the button shows a constant
YELLOW.
ANCH: . Alerts in this group indicate that either the own-ship or a vessel
on target anchor watch has left its anchorage (see Using the anchor watch
function on page 324).

ANCH alerts can only be finally acknowledged at the operator station that
generated them (see Alerts that must be acknowledged from the station
that generated them on page 332).

To indicate unacknowledged alerts the button flashes RED.

To indicate acknowledged but still active alarms the button shows a
constant RED.

For a list of all the possible navigation alerts (including their priority and category of
severity), see Navigation system alerts on page 668.
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2.2.4.2 The alert priority group buttons

The alert priority group buttons are like the alert condition group buttons but each
represents a particular priority (caution, warning or alarm) not an alert condition.

There is no overlap between the alert lists belonging to the alert condition group buttons
and those belonging to the alert priority group buttons. For example, even though the
alerts in the DNG alert condition group are all of alarm priority, they will not appear in the
list displayed when you click the ALARM priority group button. Similarly, even though
the alerts in the LOST, NEW and AREA condition groups are all of the priority warning,
they will not appear in the list when you click theWARNING priority group button.

Use the alert priority group buttons as follows:
• Click the CAUTION button when it has a solid off-white colour (this button never

flashes) to see the list of active cautions (see The Alert list dialogs on page 70).
The CAUTION button does not flash, because alerts of this priority are always
acknowledged automatically by the originating operator station at the time it generates
them.

• Click the WARNING button when it is flashing to acknowledge all warnings in
the button’s group and to see the list of active warnings (see The Alert list dialogs
on page 70).
Click the button when it is a solid yellow colour to see the list of active warnings in
the button’s group.

• Click the ALARM button once whether it is flashing or is a solid red colour to see the
list of active alarms in the button’s group (see The Alert list dialogs on page 70). The
list contains all active alarms in the group, whether they have been acknowledged
or not.
Click a second time on the ALARM button to acknowledge all currently
unacknowledged alarms in the group.
If the button is not flashing but has a solid colour (red or yellow), there are currently
no unacknowledged alarms in the group, but there are still active alarms that require
investigation.
If the button is grey, there are no active alarms in the button’s group, and so no list
will be displayed.

ALARM: This is the highest priority of alert.

There are two categories of severity for alerts of this priority: A (highest)
and B.

Alarm priority alerts of category A trigger the BNWAS alarm sequence.
This starts with flashing BNWAS reset buttons, and proceeds to the
sounding of buzzers on the bridge and in the crew’s accommodation (see
The BNWAS alarm sequence on page 276).

Some category A alarms can only be finally acknowledged at the operator
station that generated them (see Alerts that must be acknowledged from the
station that generated them on page 332).
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This priority group can include alerts from systems on the bridge that are
not part of the navigation system.

To indicate unacknowledged alerts the button flashes RED.

To indicate acknowledged but still active alerts the button shows a constant
RED.
WARNING: This is the second highest priority of alert.

There are two categories of severity for alerts of this priority: A (highest)
and B.

Some category A warnings can only be finally acknowledged at the
operator station that generated them (see Alerts that must be acknowledged
from the station that generated them on page 332).

To indicate unacknowledged alerts the button flashes YELLOW.

To indicate acknowledged but still active alerts the button shows a constant
YELLOW.
CAUTION: This is the lowest priority of alert.

There is only one category of severity for cautions: A.

For a list of all the possible navigation alerts (including their priority and category of
severity), see Navigation system alerts on page 668.

2.2.4.3 The Alert priority button

This button appears to the left of the alert message both on the top bar and in the list of
unacknowledged alerts (seeThe Unacknowledged alerts button on page 69). It indicates
the priority of the alert. You can click it to acknowledge the alert and bring up a list
for the alert condition group or the alert priority group to which the alert belongs (see
The Alert list dialogs on page 70).

There are three levels of priority, as described in the previous section (see The alert
priority group buttons on page 65), but there are only two alert priority buttons:

Alarm: This is the highest priority of alert.

There are two of this priority: A (highest) and B.

Category A alarms trigger the BNWAS alarm sequence which
starts with flashing BNWAS reset buttons and proceeds to
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the sounding of buzzers on the bridge and in the crew’s
accommodation (see The BNWAS alarm sequence on page 276).
Warning: This is the second highest priority of alert.

There are two categories of severity for alerts of this priority:
A (highest) and B.

“Caution” Caution: This is the lowest priority of alert.

There is no priority button for cautions, because they cannot
appear on the top bar or in the unacknowledged alerts list (see
The Unacknowledged alerts button on page 69).

Instead cautions are automatically acknowledged by the operator
station as soon as it generates them. They do, however, appear in
the Alert Group dialog if you click the CAUTION button on the
top bar (see The Alert list dialogs on page 70). And they appear
in the lists of currently active alerts and in the alert history (see
Viewing current and past alerts on page 336).

There are two categories of severity for alerts of this priority:
A (highest) and B.
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Click the priority button next to the alert message to acknowledge the alert and to
acknowledge all alerts that have the same text (and originating operator station) as the
alert. For DNG, NEW, LOST, AREA and GRND alerts, the system displays only one
instance of an alert for each originating operator station. This means, for example, if there
are several DNG alerts generated by a particular operator station (perhaps concerning
several targets), you cannot see them individually: they will be represented by a single
message such as “Collision danger: MFD-1”, “Collision danger: MFD-2”, “New target:
MFD-1”, and so on. Click the priority button to acknowledge all of the alerts that the
single message represents from the particular operator station it identifies. Those alerts
will then be acknowledged as far as the operator station you are using is concerned
(therefore any flashing and audible sound indications caused by them on that operator
station will cease). However, you cannot acknowledge these alerts remotely on behalf of
the operator station that generated them: each operator station must acknowledge its own
instances of them. This is because the alerts are associated with graphical information
that the operator must see and evaluate before he or she acknowledges the alert (see
Alerts that must be acknowledged from the station that generated them on page 332).

As well as acknowledging the alert, clicking the priority button brings up the Alert
Group dialog (see The Alert list dialogs on page 70). In the Alert Group dialog, the alert
that you acknowledged by clicking the priority button will appear in the list as selected
(in other words, it will have a black background).

2.2.4.4 The Alert help button and the Alert Information dialog

This button appears on the top bar to the right of the most
recent unacknowledged alert text. It also appears to the right
of each alert text in the unacknowledged alert list (see The
Unacknowledged alerts button on page 69).

Click the alert help button to see a description of an alert.
For an alphabetical list of the alerts for which help is available,
click Back or Home in the Alert Information dialog.

2.2.4.5 The Most-relevant dialog button

This button takes you to the dialog (if applicable) that is most
relevant to the associated alert.

This button only works for ECDIS, radar, autopilot and speed
pilot alerts.
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2.2.4.6 The Unacknowledged alerts button

Clicking this button brings up a list of the currently
unacknowledged alerts. The button takes the colour associated
with the highest priority unacknowledged alert currently in the
list.

Each alert is listed with:
• A priority button (click this to acknowledge the alert) (see The
Alert priority button on page 66)

• A description (High or Normal)
• The time and date the alert was issued
• The alert message.
• A help button (see The Alert help button and the Alert
Information dialog on page 68)

• A most-relevant dialog button (if applicable; see The
Most-relevant dialog button on page 68) for the message.

To acknowledge an alert in the list, click its priority button (see
The Alert priority button on page 66).

Figure 17 The Unacknowledged alerts list
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2.2.4.7 The Alert list dialogs

To see the Alert Group dialog – which lists the active alerts for
each alert condition/priority group – click an alert group button
on the top bar (see The alert condition group buttons on page 61
and The alert priority group buttons on page 65). If there are no
active alerts for a group (in other words, if the alert group button
is grey), the dialog will not appear.
Alternatively, click the priority button to the left of the alert
message on the top bar or in the unacknowledged alerts list.

To toggle the list between groups, click the ALARM VIEW button
on the operator panel (see The Alarms group on page 39).

(The ALARM VIEW button on the operator panel can also be used
to bring up the alert list in the first place, listing the alerts in the
ALARM priority group.)
The Alert Group dialog also comes up (if it is not already
displayed) when you press the ACK button on the operator panel
(see The Alarms group on page 39 and Acknowledging alerts
using the operator panel on page 333).

Figure 18 Alert Group dialog (with flashing priority column)

The Alert Group dialog appears when you click the alert (condition or priority) group
buttons on the top bar; it lists the active alerts for the group whose button you pressed.
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The leftmost field of each row in the table contains a priority letter: A for alarms and W
for warnings. For:
• Unacknowledged alerts, the letter alternates rapidly between black text on a coloured

background and coloured text on a black background: the colours are RED for alerts
and YELLOW for warnings.

• Acknowledged alerts, this letter is black on a coloured background: the background is
RED for alerts and YELLOW for warnings.

For a full description of the Alert Group dialog and of the large format Alert List dialog
(which is displayed when you click the All Active Alerts or Alert History buttons in the
Alert Group dialog), see Viewing current and past alerts on page 336.
For information about individual alerts, see Alerts and Operator Messages on page 665.

Figure 19 Large format Alert List dialog (with flashing priority column)

The leftmost field of each row in the table contains a priority label: Alarm, Warning, or
Caution. For:
• Unacknowledged alerts, the letter alternates rapidly between black text on a coloured

background and coloured text on a black background: the colours are RED for alerts
and YELLOW for warnings (no unacknowledged cautions will appear in the list,
because cautions are automatically acknowledged by the originating operator station
at the time it issues them).
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• Acknowledged alerts, this letter is black on a coloured background: the background is
RED for alerts, YELLOW for warnings, and OFF-WHITE for cautions.

2.2.5 Top bar: the COG button
This button displays the own-ship’s course over ground, based
on data from the position reference system (typically, a GPS
device). The name of the source device is indicated in the label
text in the top lefthand corner. The button’s background colour
indicates the status of the source device:
• Grey: The position sensor is selected and functioning.
• Yellow: A low-accuracy source, such as radar positioning or

dead reckoning, based on manually entered position input
is selected, and the system is using this unreliable data to
estimate the vessel's course over ground.

• Red: The input from the selected position sensor is lost.
Clicking on the COG button brings up the Position dialog (see
Position on page 445). This dialog allows you to select a
different position source or to specify manual position input.

2.2.6 Top bar: the HDG button
This button displays the own-ship's heading. The name of the
source device is indicated in the label text in the top lefthand
corner. The button’s background colour indicates the status of
the heading source:
• Grey: The heading source is selected and functioning.
• Yellow: Manual heading input is selected.
• Red: The input from the selected heading source is lost.
Clicking on the heading button brings up the Heading dialog
(see Heading on page 452). This dialog allows you to select a
different heading source or to specify manual heading input.

2.2.7 Top bar: the SOG button
This button displays the own-ship’s speed over ground, based
on data from the position reference system (typically, a GPS
device). The name of the source device is indicated in the label
text in the top lefthand corner. The button’s background colour
indicates the status of the source device:
• Grey: The position sensor is selected and functioning.
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• Yellow: A low-accuracy source, such as radar positioning or
dead reckoning, based on manually entered position input
is selected, and the system is using this unreliable data to
calculate the vessel's current speed over ground.

• Red: The input from the selected position sensor is lost.
Clicking on the SOG button brings up the Position dialog (see
Position on page 445). This dialog allows you to select a
different position source or to specify manual position input.

2.2.8 Top bar: the STW button
This button displays the speed through water, as received from
the speed log. The name of the source device is indicated in the
label text in the top lefthand corner. The button’s background
colour indicates the status of the source device:
• Grey: The speed log is selected and functioning.
• Yellow: Manual speed input is selected.
• Red: The input from the selected speed sensor is lost.
Clicking on the speed brings up the Speed dialog (see Water
Speed on page 455). This dialog allows you to select between
available speed sources or to specify manual speed input.

2.2.9 Top bar: the depth button
If depth input is being provided to the system, then this button
gives the current depth of water beneath the own-ship. If it is not,
then the button gives the unit of measurement used for depth in
the currently displayed chart:
• m = meters
• ft = feet
• fat = fathoms
Click the button to display the Chart Legend dialog (see Chart
Legend on page 478).

The text in the right-hand corner gives the name of the depth
sensor.

For more information about depth, view the Depth pane in the
Conning application (see The Depth pane on page 269).
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2.2.10 Top bar: the position and offset buttons
Position data: This includes the position fixing system currently
in use plus the vessel's actual position in longitude and latitude.

It is clickable. Clicking it brings up the Position dialog (see
Position on page 445), which allows you to view and select from
the available position sensors.

The background colour of the button indicates the accuracy of
the source as follows:
• Grey: An accurate source such as GPS (differential or

absolute) is selected and functioning.
• Yellow: A low-accuracy source such as radar positioning or

dead reckoning based on manually entered position input is
selected and being used. For information about specifying the
position input manually, see Position on page 445.

• Red: The input from the selected positioning system is lost;
calculation is now based on dead reckoning.

Position Offset/No Offset: This button tells you whether or not
the position information is displayed with an offset applied. If
the button is yellow and its text is POS OFS, then an offset is
being applied.

Click the button if you need to specify a position offset to
compensate for errors arising from the positioning system or
from the use of a chart that uses a different datum from the
positioning system. (Clicking the button brings up the Position
Offset dialog (see Position Offset on page 443), which enables
you to specify the offset.)
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2.3 The menu area
This section concerns the location of the menu area; the location differs according to the
aspect ratio of the display. It also tells you generally how to access the dialogs, how to
pass backwards and forwards through the menu hierarchy (using the previous and next
dialog buttons), and how to toggle on and off the boarding areas (which are for keeping
several dialogs open at the same time but away from the centre of the display).

For a full description of the menus and dialog boxes associated with the Radar, ECDIS
and Conning applications, see Reference Guide on page 363.

2.3.1 Menu area: location
The top-level menu for accessing the dialog boxes associated with each application
appears at the right end of the top bar on 16:10 displays.

On 4:3 displays the menu appears in different places for each application. In:
• Radar it is underneath the radar dashboard (see The radar dashboard on page 77).
• ECDIS it is underneath the ECDIS range panel (see The ECDIS range panel on

page 88).
• Conning it is underneath the top bar in the top righthand corner.

Table 4 The menu area on 16:10 (widescreen) displays

Table 5 The menu area on 4:3 (standard) displays
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2.3.2 Menu area: ways of accessing the dialogs
Each item in the main menu is a clickable button: use the track-ball and Left mouse
button to click through the menus and dialog boxes.

You can also reach particular menus and dialogs by:
• Pressing buttons on the operator panel (see The operator panel and controls on

page 32).
• Clicking the sensor indicator buttons on the top bar (see The top bar on page 57).
• Clicking the buttons on the radar dashboard (see The radar dashboard on page 77).
• Clicking buttons on the ECDIS range panel (see The ECDIS range panel on page 88).
• Clicking the most-relevant dialog button on the top bar (see The Most-relevant dialog
button on page 68).

2.3.3 Menu area: the boarding buttons in ECDIS
The boarding areas are spaces on the right and/or left of the chart
display for keeping dialog boxes open for as long as you need
them. In ECDIS, you can toggle the boarding areas on and off.

This is convenient because sometimes you will need an
un-obscured chart display, and sometimes you will need multiple
dialog boxes open at once, using either or both boarding areas.

To toggle the boarding areas on and off, click the left and right
boarding buttons (see The boarding areas in Radar and ECDIS
on page 99).

The appearance of these buttons depends on the aspect ratio of
the display:
• On 4:3 displays the buttons just the letters ‘L’ and ‘R’

respectively.
• On 16:10 displays, the buttons are larger and contain the letters

‘BL’ (Boarding Left) and ‘BR’ (Boarding Right) respectively.

2.3.4 Menu area: the previous and next dialog buttons
Right arrow: Click to return from the previous dialog.

Left arrow: Click to bring up the previous dialog.

The appearance of these buttons depends on the display. On
standard 4:3 displays, the arrow symbol is a simple chevron
pointing to the left or right. On widescreen 16:10 displays, the
buttons are slightly larger and the arrow symbol itself is larger.
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2.4 The radar dashboard
The radar dashboard contains all the controls that you need immediate access to at all
times while operating the radar.

The buttons, menus, sliders and radio buttons on the dashboard are described in this
section. Some of the buttons bring up dialog boxes.

On widescreen 16:10 displays, the radar dashboard is on the left and its individual
panels are labelled.

On standard 4:3 displays, the radar dashboard is on the right of the screen and its panels
are not labelled.

16:10 display 4:3 display

381287/A 77



K-Bridge Multi-functional Display Unit

The information and controls on the radar dashboard are described in the following
sub-sections:
• Radar dashboard: the range panel on page 79
• Radar dashboard: the Target Information panel on page 81
• Radar dashboard: the Radar System Information panel on page 83
• Radar dashboard: the Radar Signal Information panel on page 85
• Radar dashboard: the Navigation Tools panel on page 86

2.4.1 Radar dashboard: the operator message field
Operator message field: Radar and ECDIS operator messages are
displayed on a yellow background in the message field just above
the range panel. They may be accompanied by an audible beep,
and they require no acknowledgement. The main purpose of
such messages is to indicate to the operator when he or she has
operated the system incorrectly.

For a list of the operator messages, see Radar and ECDIS
operator messages on page 732.
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2.4.2 Radar dashboard: the range panel
The range panel at the top of the radar dashboard shows the range and scale of the
display. This section describes the panel’s contents.

16:10 display 4:3 display

Range Up/Down: Use the arrows to increase and decrease the
range of the display. The range is the distance covered from the
centre of the radar display to the top of it. There ranges available
(in nautical miles) are: 0.125, 0.25, 0.5, 0.75; after 0.75 NM the
next available range is always the existing range multiplied by
two until the maximum range of 96 NM is reached. In radar the
chart scale is determined by the range selected.
Scale: Use this button to bring up the Zoom dialog (see Zoom on
page 370) which enables you to change the chart scale. In radar
the chart scale depends on the currently selected range (refer to
the description of the Range Up/Down arrows above).
Orientation and motion mode menus: Use these drop-down menus
to choose one of the following combinations of orientation and
motion modes:
• NUP/TM - north up, true motion
• NUP/RM - north up, relative motion
• CUP/TM - course up, true motion
• CUP/RM - course up, relative motion
• HUP/RM - head up, relative motion
The orientation modes specify whether the radar display's
vertical axis represents North or the vessel's course or heading.
They are as follows:
• North Up (NUP): The orientation of the screen becomes

northwards. The direction of the heading line changes during
manoeuvres.

• Course Up (CUP): The heading line points upwards on the
screen (so that the view out of the windows of the bridge will
correspond to the orientation of the screen). An automatic
reset of the centre is performed to give maximum coverage
ahead. The bearing scale will show north-referenced bearings.
The direction of the heading line changes during manoeuvres.
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• Head Up (HUP): The heading line points upwards on the
screen (so that the view out of the windows of the bridge will
correspond to the orientation of the screen). The bearing scale
will show relative bearings. If input from the compass fails,
the head-up option is the only available screen orientation.

The two possible motion display modes are True Motion (TM)
and Relative Motion (RM):
• TM (True Motion): In true motion, the chart is fixed in the

display while the own-ship symbol moves.
• RM (Relative Motion): In relative motion the own-ship symbol

is fixed while the chart moves.
Speed stabilisation menu: Use this drop-down menu to choose
between ground and water as the reference for the own-ship's
speed and course, for the speed and course of radar and AIS
targets, and for the vectors associated with the own-ship
and targets. For more information, see Ground and water
stabilisation on page 739.
Chart on/off: Click this button to turn the chart display on or
off (optional function) in the Radar application. If no chart is
available for the area you are navigating and you turn the chart
function on, the background colour of the button turns yellow
(to indicate there is a problem).

The range panel displays the symbols when charts are in use. For
more information about displaying charts, see Displaying charts
on the radar display on page 208.
– An hourglass is displayed when the system is fetching a new
chart or re-scaling.

No chart is available in this geographic position.

An ENC (Electronic Navigational Chart) official chart is
displayed.

The chart is being displayed over scale (in this example, by a
factor of 1.7). In other words, it is being displayed at a larger
scale than it was designed to be viewed at.

Click the button to display the chart at nominal scale.
The chart is being displayed under scale. In other words, it is
being displayed at a smaller scale than it was designed to be
viewed at.

Click the button to display the chart at nominal scale.

80 381287/A



The Radar, ECDIS and Conning displays

2.4.3 Radar dashboard: the Target Information panel
This panel enables you to control whether targets are shown with vectors, past position
indicators and/or trails.

16:10 display 4:3 display

The Target Information panel contains the following controls:

Vector: Click this button to turn vectors for tracked targets on
or off. Use the Left mouse button and the track-ball to change
the vector length: the length can be any value between 1 and
60 minutes.

The drop-down menu beneath the Vector button either displays
the vector length or states that vectors are switched off. You can
use the drop-down menu to toggle vectors on and off.

Use the True and Relative radio buttons so specify true or
relative vectors. You can increase the vectors' length and switch
to relative vectors to see if collision avoidance measures are
required.

For information about using vectors for collision avoidance, see
Collision avoidance on page 157.

For information about using vectors as compared with trails and
past position marks, see Trails compared to vectors and past
position marks on page 158.
Past Pos: Click this button to turn on or off. Use the Left mouse
button and the track-ball to specify the time interval between the
history dots. Available time intervals (and their corresponding
total past position times) are:
• 0.5 minutes
• 1 minutes
• 2 minutes
The drop-down menu beneath the Past Pos button either displays
the time interval between the history dots or states that past
position markers are off. You can use this drop-down menu to
toggle markers on and off.

The past position markers show true (not relative) positions.
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For more information, see Displaying the past positions of
targets on page 153.

To display a trailing line with time markers indicating the past
positions of the own-ship, select Own Ship Past Track in the
Radar Themes dialog (see Radar Themes on page 371).
AIS:ON/OFF Click this button to toggle between the following
AIS options:
• AIS:OFF – AIS target symbols and warnings are switched

off. (This is the default status.)
• AIS:ON – AIS target symbols and warnings are switched on.
For a list of sample AIS symbols, see AIS symbols on page 174.
Trails: Click this button to turn target trails (afterglow) on or off.
Radar trails resemble the afterglow found in many old radars,
giving an indication of where ships are moving to.

You can specify the length of time you want the trails to remain
visible: they can last a minimum of 10 seconds and a maximum
of 6 minutes.

The drop-down menu beneath the Trails button either displays
the length of time for which the trails are visible or states that
trails are switched off. You can use this drop-down menu to
toggle trails on and off.

Use the True and Relative radio buttons so specify true or relative
trails. True trails enable you to see exactly where the own-ship
has sailed. Relative trails enable you to see whether there is any
danger of collision. With true trails on, trails are displayed for all
your targets (even ones that you are not tracking). This enables
you to see at a glance if a target is moving: a stationary target
displays no trail.

For more information, see Using target trails on page 155.
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2.4.4 Radar dashboard: the Radar System Information
panel
This panel enables you to run the radar transceiver, tune it, and put it into standby. For
more information, see Starting up the MFD (including the radar scanner) on page 110.

16:10 display 4:3 display

Scanner/Transceiver: Click this button to bring up the Radar
Control dialog which enables you to start the radar transceiver
(see Radar Control on page 539). To start it you must select
Master and then Run in the Radar Control dialog. (When the
console is master, it means that you can control the transceiver
from the console.)

This button is the same as the Scanner/Transceiver button on
the top bar except that the text on the top bar button contains no
status information, it just gives the transceiver name (see Top
bar: the Scanner/Transceiver button on page 59).

The text displayed on this button tells you:
• Which transceiver is selected.
• Whether the transceiver is on, off or warming up. (When

the radar transceiver is warming up after being powered
on – which takes approximately three minutes – the label
"WarmUp" appears in the text of the Scanner/Transceiver
button.)

• The pulse length being used. Whenever the pulse length is
different from the default for the current scale of the display,
the Scanner/Transceiver button turns yellow and the pulse
length indicator (“SP”, “MP”, or “LP”) in the button text
is prefixed by an exclamation mark (!). The pulse length is
normally selected automatically by the system to match the
current scale of the display. However, when the console you
are using is master in relation to the transceiver, you can
specify a pulse length in the Radar Control dialog (this is the
dialog that is displayed at the top of the Docking area when
you click the Scanner/Transceiver button; see Radar Control
on page 539).
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• Whether the pulse length is locked (so that it remains the same
whatever the current scale of the display). You can lock the
pulse length in the Radar Control dialog. When it is locked,
this is indicated in the text of the Scanner/Transceiver button;
for example: Kongsberg S Locked Master.

• Whether the console you are using is master or slave with
respect to the transceiver (in other words, whether you can
control the transceiver from this console).

The colour of the button communicates status information:
• Green: this console is master in relation to the transceiver

(see also Making the display unit master of the transceiver
on page 107).

• Grey: this console is a slave in relation to the transceiver.
• Yellow: one of the following is true:

– The transceiver is in standby.
– The pulse length is different from the current scale of the

display. As described above, when this is the case, the
pulse length indicator in the button text is prefixed by an
exclamation mark (!).

An alternative way to bring up an instance of the Radar Control
dialog to is to click the chevrons in the bottom right-hand
corner of this panel. An instance of the Radar Control dialog
then appears not in the boarding area (to the right of the main
radar display area) but adjacent to the dashboard and partially
obscuring the radar display area itself.

Tune: This slider is for tuning the radar's reception from the
transceiver. To have the system tune itself automatically, click
the Auto button.
Click on the chevrons to bring up an instance of the Radar
Control dialog (see Radar Control on page 539) that partially
obscures the radar display itself. This dialog enables you to:
• Select the radar transceiver to be used .
• Start the transceiver (by selecting Run in the Radar Control

dialog).
• Configure the pulse length.
When you have clicked once to bring up the Radar Control
dialog, the chevrons appear inverted (see left); click on them
again to close the dialog.

The dialog is closed automatically if it is idle for more than a few
seconds or if you move the marker (cursor) out of the dialog.
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2.4.5 Radar dashboard: the Radar Signal Information panel
This panel enables you to control the radar video gain, and the rain and sea clutter.

16:10 display 4:3 display

To suppress noise and clutter across all ranges, use the slider to adjust the video gain
threshold: any echoes whose strength is below the threshold you specify with the slider
will not appear on the display.

To have the system tune itself automatically for rain or sea clutter, click the Auto button
next to the appropriate slider control.

To return to manual clutter control, click the Auto button next to the appropriate slider
once more or just use the sliders in this panel.

For full information about using the gain and clutter controls, see Setting the gain and
clutter controls on page 120.

Click on the chevrons to bring up an instance of the Radar
Control dialog (see Radar Control on page 539) that partially
obscures the radar display itself. This dialog enables you to:
• Select the radar transceiver to be used .
• Start the transceiver (by selecting Run in the Radar Control

dialog).
• Configure the pulse length.
When you have clicked once to bring up the Radar Control
dialog, the chevrons appear inverted (see left); click on them
again to close the dialog.

The dialog is closed automatically if it is idle for more than a few
seconds or if you move the marker (cursor) out of the dialog.
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2.4.6 Radar dashboard: the Navigation Tools panel
This panel enables you to turn the display of range rings and electronic bearing lines
(EBLs) on and off.

16:10 display 4:3 display

The Navigation Tool panel contains the following controls:

Rings: Click this button to toggle range rings on and off. When
range rings are on, the field to the right of the button indicates the
distance (in nautical miles) between the rings. You can vary the
brightness of the rings (see Intensity on page 367).
Marker: The “marker” is the cursor. Click the Marker button
to toggle the display of marker information (to the right of the
button) between the following:
1 The bearing and range from the marker to the own-ship.
2 The latitude and longitude of the marker position. (This

data is continuously updated as long as the marker remains
inside the radar area.)

3 The time it would take to steam to the marker position and
the ETA (Estimated Time of Arrival).
The values assume that the ship will sail in a straight line
to the marker position. The Time to Marker is therefore
Range/Speed Over Ground. The ETA is Local Time + Time
to Marker.
The Time to Marker data is presented as hours and minutes
(hh:mm) if the time is more than one hour; or minutes and
seconds (mm:ss) if the time is less than one hour.

4 The own-ship's Closest Point of Approach (CPA) to the
marker position, and the Time to the Closest Point of
Approach (TCPA).
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EBL/VRM: Clicking the EblVrm 1 and EblVrm2 buttons turns
each of the two electronic bearing lines/variable range markers
On or Off.

The True/REL radio buttons toggle between true and relative
bearing.

The position of the EBL/VRM can be set using the entry fields
and/or the Left mouse button and track-ball.

You can also drag the EBL/VRM so that its centre is not at the
own-ship symbol but at some other position:
1 Turn an EBL/VRM on by clicking either EblVrm1 or

EblVrm2.
2 Put the cursor over the own-ship and press the Left mouse

button.
3 Use the track-ball to reposition the EBL/VRM.
4 When you reposition an EBL/VRM in this way, the F/M:

button appears (see below).
When the EBL/VRM is offset from the own-ship, its centre
point can either be fixed (F) in a geographic position or it
can be set to move (M) with the ship. When you offset the
centre point, therefore, an F/M button appears appears next
to the EBL/VRM controls in the navigation panel. Use this
button to toggle between the two options. (By default, an
EBL/VRM is centred on the own-ship symbol and moves
with the ship.)

For more information about using EBL/VRMs, see Using the
EBL/VRM tool on page 300.
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2.5 The ECDIS range panel
The range panel in ECDIS shows the range and scale of the current chart and contains
buttons and menus for:
• Increasing and decreasing the range
• Controlling whether the chart’s vertical axis represents north or the vessel’s course or

heading
• Controlling whether the chart is displayed in true or relative motion
• Switching the display of radar and AIS targets on and off

It also contains chart type, scale and status indicators.

The ECDIS range panel cannot be closed or moved. Its position depends on the aspect
ratio of the display; on:
• Widescreen 16:10 displays, the range panel is on the left beneath the top bar
• Standard 4:3 displays, it is on the right beneath the top bar.

16:10 display 4:3 display

2.5.1 ECDIS range panel: operator message the field
Operator message field: Radar and ECDIS operator messages are
displayed on a yellow background in the message field just above
the range panel. They may be accompanied by a beep, and they
require no acknowledgement. Their main purpose is to indicate
to the operator when the system has been operated incorrectly.

For a list of the operator messages, see Radar and ECDIS
operator messages on page 732.

2.5.2 ECDIS range panel: viewing controls
Scale:This button shows the scale of the displayed chart.

Click the button to see the Zoom dialog (see Zoom on page 370).
Range Up/Down: Use the arrows to increase and decrease the
range of the display.
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Presentation mode menus: Use these drop-down menus to choose
one of the following combinations of orientation and motion
display mode:
• NUP/TM - north up, true motion
• NUP/RM - north up, relative motion
• CUP/TM - course up, true motion
• CUP/RM - course up, relative motion
• HUP/RM - head up, relative motion
The orientation specifies whether the display's vertical axis
represents North or the vessel's course or heading. The possible
orientations are as follows:
• North Up (NUP): The orientation of the screen becomes

northwards. The direction of the heading line changes during
manoeuvres.

• Course Up (CUP): The heading line points upwards on the
screen (so that the view out of the windows of the bridge will
correspond to the orientation of the screen). An automatic
reset of the centre is performed to give maximum coverage
ahead. The bearing scale will show north-referenced bearings.
The direction of the heading line changes during manoeuvres.

• Head Up (HUP): The heading line points upwards on the
screen (so that the view out of the windows of the bridge will
correspond to the orientation of the screen). The bearing scale
will show relative bearings. If input from the compass fails,
the head-up option is the only available screen orientation.

The two possible motion display modes are (TM) and (RM):
• TM: In true motion, the chart is fixed in the display while the

own-ship symbol moves.
• RM: In relative motion the own-ship symbol is fixed while

the chart moves.
Browse:When you click it on, the browsing indicator turns yellow
to show that you are using the cursor to move freely in the chart,
away from the own-ship's position. Click it again when you want
to turn it off (the button then turns grey again).

The way to move freely – when browsing is on – is to move the
trackball marker and then press the middle button on the trackball
(see The input panel (including trackball) on page 42); each time
you do this, the chart is redrawn with the trackball marker point
used as the centre of the screen.

While you are browsing in this way, the system will not
automatically update the display to follow the ship's movement.
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(The Browse button remains yellow to indicate that you must
return to one of the chart display modes to monitor the ship's
movements again.)

The browsing facility is also available from the Browse Position
and Date dialog in ECDIS (see Browse Position and Date
on page 378). This dialog enables you to specify precise
co-ordinates for the centre of the screen (instead of using the
trackball marker to indicate the position you want to use as the
centre of the screen).
TGT: Check the box to switch on the display of radar and AIS
targets. Un-check the box to switch the display of targets off.

Click the TGT button to to display the Radar menu for the ECDIS
application (see Radar menu on page 537).
VID:Check the box to switch the radar video display on for
ECDIS; un-check it to switch the radar display off for ECDIS.

Click the VID button to display the Radar menu for the ECDIS
application (see Radar menu on page 537).

When the video is distorted by more than 5 pixels relative to
the displayed chart, or when the video is rotated relative to the
chart and is therefore not displayed, the VID button is shown on a
yellow background to indicate an error condition.
This indicator is displayed when there is a risk that parameter
settings or external factors will permanently degrade the
performance of the ECDIS system or render its type approval
invalid. Click the button to bring up a dialog box explaining
why the indicator has appeared.
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2.5.3 The ECDIS range panel: chart indicators
This section describes the different values that the chart indicators in the ECDIS range
panel can display.

Figure 20 The chart indicators in the ECDIS range panel

Chart type indicator

This button indicates the type of chart displayed. Click it to display the Chart Type dialog
(see Chart Types on page 477).

The button takes the forms listed below:

No chart is available in this geographic position.

An (Electronic Navigational Chart) official chart is displayed.

A combination of ENC and vector (non-ENC) chart data is
displayed.

A vector (non-ENC) chart is displayed.

A raster chart is displayed.

Chart scale status button

As well as the actual scale of the displayed chart, the top bar includes a button that
indicates whether the chart is displayed at nominal scale or whether it is under or over
scale. The button takes the forms listed below.
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The chart is being displayed at nominal range (approximately).
This means it is being displayed at about the scale it was designed
to be viewed at.
The chart is being displayed over scale (in this example, by a
factor of 1.7). In other words, it is being displayed at a larger
scale than it was designed to be viewed at.

Click the button to display the chart at nominal scale.
The chart is being displayed under scale. In other words, it is
being displayed at a smaller scale than it was designed to be
viewed at.

Click the button to display the chart at nominal scale.

The chart selection indicator takes the forms listed below:

The best chart available is currently displayed.

A better chart exists for the area surrounding the own-ship's
current position.

Click the button to load the better chart at its nominal scale.
An official (ENC) chart is available at a better scale.

An official chart is available but it is a lower scale chart.

The chart with the best resolution (at the own-ship's position)
is automatically loaded and displayed at nominal scale. (This
facility is only available with the K-Bridge Planning application.)
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2.6 The radar video area
The part of the display that forms the radar area itself is 320 mm x 320 mm. This section
describes the main features of the radar area, including the own-ship symbol (which itself
includes the heading and beam lines, the radar antenna symbol, and an optional stern
marker), the bearing scale and the range rings.

For more information about using the radar area, see Tracking radar targets on page 141
and Working with AIS targets on page 165. Refer also to the sections later in this manual
on using:

• Electronic Bearing Lines and Variable Range Markers (Using the EBL/VRM tool
on page 300),

• Parallel Index Lines (Using parallel index lines on page 304).

Figure 21 Radar video area with range rings on

The figure above shows the radar area with rings set to ON in the radar dashboard (see
Radar dashboard: the range panel on page 79). The own-ship symbol is formed by the
vessel's heading- and beam-lines.

In addition to the heading line (which is always displayed) you can display a “stern
marker”. This is a dashed line that extends from the stern in the opposite direction to the
heading line. To display this line, select View→Main Radar Themes and check the box
labelled “Stern marker” (see Radar Themes on page 371).
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When the radar range you specify in the range panel is low (for example, 0.125 NM)
the own-ship symbol appears as a scaled outline of the vessel (see figure below). When
you set a higher range, causing the beam of the scaled outline to measure less than
6mm, the scaled outline disappears.

Note

If you do not want the scaled outline to appear when you set a low range, select
View→Main Radar Themes and un-check the Display Ship Outline option (see Radar
Themes on page 371).

Figure 22 Scaled outline of the own-ship2.6.1 The radar
antenna symbol
The vessel's radar antennas are
represented on the own-ship
symbol as a green line. The
line rotates around a point
on the own-ship symbol that
corresponds to the position on
the vessel of the radar antenna
for the selected transceiver.

When the transceiver is
transmitting, the direction
of the green line at a given
moment corresponds to the
direction that the antenna is
pointing towards in real time.

When the transceiver is not
transmitting (in other words,
when it is off, warming up
or in standby), the green line
flashes and points towards the stern (in the opposite direction from the heading line).

Note

If the green line stops rotating or flashing, then the radar screen is not refreshing. This
can only be caused by a failure in the display unit. To resume normal updates, try
restarting the display unit.

Note

By default the position of the radar antenna is additionally indicated by a small cross. If
you do not want the radar antenna cross to appear, select View→Main Radar Themes ,
and un-check the box labelled “Radar antenna” (see Radar Themes on page 371).
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The green line has a fixed length of 30 pixels. This can only be changed by qualified
service personnel and involves editing the Windows Registry: the maximum configurable
length is 100 pixels.

WARNING

Rotating Antenna and Radiation Hazard!

For important safety information about
working in close proximity to the antenna,
see Warnings and Cautions on page 3.

2.6.2 The radar bearing scale and
the conning position
The bearing scale is always centred on the vessel's
conning position. It shows the true bearing when in
stabilized modes, and a relative bearing in head-up
mode. You can find the vessel's precise conning

position by selecting System→Parameter Settings →Ship (tab), and inspecting the
“Conning Pos:” fields. (This data is not configurable except by service engineers; see
Ship (tab) on page 571.)

Figure 23 The radar bearing scale

If the radar antenna is located a long way from the vessel's conning position, then the
location of the CCRP will be outside of the radar area (in other words, off the screen)
for small range scales. When this happens, the bearing scale lines on the edge nearest
to the (off-screen) CCRP will not be drawn, because they cannot indicate that they are
pointing away from the screen. However, the bearing scale lines on the other three edges
will continue to point towards the CCRP.

The algorithms for removing bearing scale lines that are too close only remove the one
degree lines. This is normally sufficient to prevent the lines from blurring together.
When the CCRP is close to the edge of the screen, the remaining 5 and 10 degrees lines
and the bearing numbers may be too close to be easily distinguished.

For more information about the bearing scale, see Establishing a common reference
system on page 114.
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2.6.3 The behaviour of the radar area's centre
This section describes how and when the K-Bridge Radar system resets the centre of the
radar area. It also tells you how to reset the centre manually.

For information about defining the chart regeneration area in the ECDIS application, see
Defining the chart regeneration area on page 208.

Automatic resets

When the own-ship's radar antenna moves outside the Router circle (see figure below), the
system automatically resets the centre of the radar area.

If the system is displaying in:
• Relative motion, this automatic reset makes the radar antenna position the centre

of the radar area.
• True motion, the automatic reset makes the radar antenna position a point on the Rreset

circle (see figure below) that is in a straight line (determined by the vessel's course)
from the centre of the screen.

• True motion but the own-ship is steaming at less than 3 knots, the own-ship symbol
will always remain inside the Rreset (lowspeed) circle.

Resetting the centre manually

You can reset the centre of the radar area manually. To do so:
1 Place the marker at the point in the radar area that you intend as the new centre.
2 Click the middle mouse button on the track-ball.

Figure 24 The reset-centre circles
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2.7 The ECDIS chart area
As well as showing the chart itself, the chart area displays chart-related objects and data,
for example, routes and mariners' notes. It can also display radar and AIS targets.

Figure 25 Sample chart display

Table 6 The radar target symbol as displayed on a chart

This symbol is used to indicate tracked targets where radar video and
vectors for tracked targets are shown on top of chart information.

If the console is connected to an Automatic Identification System (AIS) receiver, AIS
targets are shown on the chart display (and on the radar display). For examples of AIS
target symbols and their meanings, see AIS symbols on page 174.

381287/A 97



K-Bridge Multi-functional Display Unit

Figure 26 A chart display showing an active AIS target and a dangerous AIS target
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2.8 The boarding areas in Radar and ECDIS
The boarding areas are on both sides of the ECDIS chart area and on the right-hand side
of the radar display area.

The boarding areas enable you to view more than one menu and/or dialog at a time.

Boarding buttons:In ECDIS, you can make the area appear or
disappear by clicking the boarding left and boarding right buttons
on the top bar (see Menu area: the boarding buttons in ECDIS
on page 76). The buttons differ according to the resolution of the
display (16:10 or 4:3).

Note

The Radar application has a boarding area on the right only, but
you cannot make it disappear therefore there is no boarding right
button in the radar top bar. (There is no boarding left button
either, because the radar dashboard occupies the area of the
screen to the left of the radar display.)

If you want to:
• Make a dialog or menu appear in the boarding area so that you

can open another dialog without losing sight of the current
one, click on the right or left arrow button in the top right-hand
corner of the dialog (see left).
The boarding areas are populated from the bottom upwards
(when you click the boarding right or left button, the menu or
dialog goes to the bottom of the boarding area).

• Move the dialog or menu up or down in the boarding area,
press the left-mouse button down and drag the dialog or menu.

• Close the dialog, click the 'x' button in the top right-hand
corner of the dialog.

Note

The Radar application has a boarding area on the right only.
Therefore the Radar's menus and dialogs have only a right arrow
in the top right-hand corner.
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Figure 27 An ECDIS chart on a 16:10 display with both left and right boarding areas
in use
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2.9 The track-ball marker in Radar and
ECDIS

The track-ball is the system's pointing device: it controls the marker. The marker (or
cursor) appears in three forms, depending where you position it on the screen:

The marker as it appears inside the chart or radar area.

The marker outside the chart or radar area.

Digitizing marker. The cursor takes this shape when the system is
waiting for a point input. You will see it, for example, during the
process of digitizing a new route or graphical note object, when
the system is waiting for you to left-click the mouse-button at
some point on the chart.

For details of the marker's position on the display, use the Marker button on the
dashboard (see Radar dashboard: the Navigation Tools panel on page 86).

381287/A 101



K-Bridge Multi-functional Display Unit

102 381287/A



Basic setup information

3 Basic setup information

This section contains the following topics:
Introduction....................................................................................................................104
About integrated navigation systems .............................................................................104
Starting up the MFD (including the radar scanner) .......................................................110
Establishing a common reference system......................................................................114
Establishing the correct colour calibration on the monitor............................................116
Switching off the MFD console ....................................................................................117
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3.1 Introduction
This chapter provides general information on the setup of the MFD unit.

It also tells you how to start and stop the MFD unit.

Finally it describes the radar system's failure modes and effects.

3.2 About integrated navigation systems
This section describes how the K-Bridge Mulit-functional Display Unit:
• Works with other Kongsberg Maritime navigation systems.
• Displays radar video on multiple display units.

3.2.1 Kongsberg Maritime's integrated navigation systems
K-Bridge navigation consoles now customarily communicate with each other over single
or dual Local Area Networks. K-Bridge consoles such as Multi-functional Display
(MFD) units running Radar, ECDIS and Conning applications, dedicated Radar, ECDIS,
and Conning consoles, and K-Bridge Autopilot systems are all able to communicate with
each other over the LAN. This enables them to share such information as:
• The palette setting (day, dusk, or night)
• Routes
• Charts
• Targets
• Barrier Lines
• Mariners' notes
• Templates

The information is distributed in such a way that if one console is switched off or fails,
the remaining consoles can continue without degraded performance. When, for instance,
a route is edited in one display, it is automatically updated in all the other units.

The principle of sharing information has the following benefits:
• A route selected for monitoring or for track steering will be common to all display

units.
• The own-ship data is common to all display units.
• Tracks from any radar/ARPA target can be monitored at every ECDIS display unit.
• Radar video from any radar/ARPA can be monitored at every ECDIS display unit.

It is possible to switch a display unit off-line. This will stop the unit from sharing the
system-wide information.
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3.2.2 The radar interswitch unit
On a K-Bridge Radar system, the presence of a radar interswitch unit between the
vessel's radar transceivers and display units means that it is possible to display radar
video from one transceiver on multiple display units.

Figure 28 The radar interswitch unit

There can be up to six transceivers in a K-Bridge Radar system, and up to six display
units. Only one console at a time, however, can be in control of the transceiver. This
display unit is referred to as master in relation to the transceiver; the other display
units are slaves in relation to it. They are also slaves in relation to the other display
units connected to the same transceiver: they cannot alter any settings that affect the
presentation of radar video on the other display units.

3.2.2.1 Selecting the transceiver for a display unit

When you select a transceiver for a display unit (by clicking one of the radio buttons
underneath the word Select in the Radar Control dialog), that display unit will become
master in relation to the transceiver if no master already exists; otherwise it will become
a slave.
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3.2.2.2 Making the display unit master of the transceiver

To make a particular console the master in relation
to the transciever when it is currently a slave,
select Radar→Source, and check theMaster radio
button (see Radar Control on page 539).
It is possible to prevent a display unit from
becoming master in relation to one or more
transceivers. However, this can only be done by
editing the Registry and is therefore reserved for
installation and service engineers. On a display
unit whose Registry has been edited to prevent
it becoming master, the Master and Slave radio
buttons in the Radar Control dialog are greyed out.
Any display unit (assuming that it has not had its
Registry edited in the way just described) can at

any time be made master or slave in relation to any transceiver.
When you make a display unit master, all other units connected to the same transceiver
as the new master (including the display unit that was previously master) immediately
become slaves. This is indicated by the Scanner/Transceiver buttons on the radar
dashboard (see Radar dashboard: the Radar System Information panel on page 83)
and on the top bar.
There is no requirement for the transceiver to have a master display unit at all times.
However, it is normal for example for one display unit to be master for the X-Band
transceivers and another to be master for the S-Band transceivers.
The transceiver controls that are only available to the operator of a master display unit
include:
• Standby/Run (see Radar Control on page 539)
• Pulse length selection (see Tx Configuration on page 653)
• Tuning (see Rx Configuration on page 654)
• Antenna alignment (see Azimuth Configuration on page 655)
• Inhibition of radar transmission (see Tx Mute on page 656)
Although slave display units cannot affect the display settings on other display units,
they do have control over their local display settings. They control their own:
• Gain and clutter settings
• Display orientation and principle of stabilisation (ground or water)
• The current centre of the display
• Operation of the radar tracker
• Operation of trails
• Range scale (but note that pulse length selection can only be performed on the master

display)
• Use of synthetic drawings or overlays
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3.2.2.3 Automatic standby of radar antennas

The radar interswitch monitors the use of the radar antennas by the MFDs. If five
minutes pass during which a particular antenna has not been selected as the source of
radar input for any MFD, the radar interswitch automatically puts that antenna into
standby. The antenna then remains in standby until an MFD that is set up as master in
relation to the antenna starts it up again. This is a precaution to prevent antennas from
running when they are not in use, for example, when a vessel has docked.

3.2.2.4 Fault tolerance in the design of the interswitch

The design of the radar interswitch unit ensures that, in a configuration of multiple
radar transceivers and display units, no single point of failure can bring down all
communication between the transceivers and display units.

Inside the interswitch unit there is a single large PCB which contains terminal lists and
connectors for up to six TIC (Transceiver Interface Control) boards. Each TIC interfaces
between one display unit and one transceiver. If a display unit has the transceiver
corresponding to its TIC selected, then only that TIC is involved in communication
between the transceiver and the display unit. In this case, if a problem arises with the
transceiver, the TIC or the display unit, the performance of the rest of the K-Bridge
Radar system is unaffected.

If a display unit has a transceiver corresponding to another TIC selected, then two
TICs are involved in the communication between the display unit and its transceiver.
However, in this case the signals are sent over a bus connection that is implemented in
back-wiring between the two TICs.

This means that, if there is a problem of communication between the two TICs, the
display unit will not be able to select a transceiver belonging to yet another TIC but it
will still be able to select the transceiver attached to its own TIC. Therefore its ability to
operate as a free-standing radar set is maintained.
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Figure 29 Layout of the radar interswitch unit

3.2.2.5 The interswitch unit's power supply

The power supply to the interswitch is 24V DC from the display units. Each display unit
has sufficient power capacity to power all six TIC boards. Diode logic ensures that each
TIC will draw power from its corresponding display unit if that unit is available and
switched on, and from any other display unit if its own is switched off.
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3.3 Starting up the MFD (including the
radar scanner)

WARNING
Before you start check that no personnel are within the hazard zone
around the radar antenna.

To start up the console, observe the following procedure:
1 Switching the power on

a Open the computer compartment door on the console.
b Locate the computer inside the console. The computer is attached to the

computer door inside the console.
c Click the POWER button on the front of the computer. The POWER indicator

on the ALC NAV panel is lit after approximately 2 seconds and the buzzer
beeps twice during the start-up sequence. The start-up sequence takes about 3
minutes, and the console is then ready to operate.
• If a problem occurs or the application does not start within 4.5 minutes

the FAULT and ALARM indicators on the ALC NAV panel are lit and the
buzzer is activated.

• During start-up, the display will remain dark to avoid accidentally harming
the operator's night vision.

2 Selecting the radar scanner/transceiver
a In the top left-hand corner of the screen (just beneath the Kongsberg Maritime

logo), use the drop-down menu to select the Radar application (see Switching
between Radar, ECDIS and Conning on page 120).

b In the radar application, click the radar Scanner/Transceiver button on the
radar dashboard.
The button's text will vary with the system's state and configuration (see Radar
dashboard: the Radar System Information panel on page 83).
When you click the scanner/transceiver button, the Radar Control dialog is
displayed in the boarding area to the right of the main radar display (see Radar
Control on page 539).

c Select the scanner/transceiver.
d Apply power to the selected scanner/transceiver unit by checking the Power

check-box for the selected scanner/transceiver.
e Select Master or Slave. If the scanner/transceiver is not already controlled by

another display, select Master.
f Pulse length is automatically selected for the range scale of the master console's

display. You can select a different length if you are configuring the master
console (short - SP, medium - MP, or long - LP).
• Pulse length can only be selected if you are at the master console.
• If the pulse length you select is not suitable for the range selected, the

Scanner/Transceiver button turns yellow.
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g Start the selected scanner/transceiver by selecting Run in the Radar Control
dialog.

3 Selecting range rings
A set of fixed range rings, displayed as a number of equally spaced circles can be
switched On or Off (see Radar dashboard: the Navigation Tools panel on page 86).

4 Changing range scale
The range scale is set by using the range up and down arrows in the Range panel of
the dashboard (see Radar dashboard: the range panel on page 79). Ranges from
0.125 to 96 NM are available. For the best detection of small targets in sea clutter,
always select the shortest range compatible with your operational requirements.

5 Turning range rings on and off
Turn range rings on and off by using the Rings button in the Navigation tool panel on
the radar dashboard (see Radar dashboard: the Navigation Tools panel on page 86).

6 Setting the video gain control
Adjust the video gain as required (see Radar dashboard: the Radar Signal
Information panel on page 85).
Always adjust the Video Gain control when using the longer range scales of 12 or
24 NM. A light background speckle must be present to make sure small targets are
displayed. A temporary reduction in gain can be beneficial when searching for
targets in rain or snow conditions. For more information, see Setting the gain and
clutter controls on page 120.

7 Using the sea clutter controls
Use the sea clutter controls to reduce sea clutter to an operational level at which a
little clutter speckle is present (see Radar dashboard: the Radar Signal Information
panel on page 85). The setting must permit small targets to be detected that are of
similar strength to the sea clutter returns.
Caution

Use the sea clutter controls with caution. Never completely remove sea
clutter, because this reduces your capacity to detect small targets.

You can use the AUTO setting to suppress sea clutter in open sea conditions. This
normally provides optimum detection by adapting sea clutter suppression to the
varying characteristics of the sea clutter.
Note

To return to manual sea clutter control when the system is performing automatic sea
clutter control, adjust the slider manually.

8 Using the rain clutter controls
Use the rain clutter controls to optimize the suppression of rain clutter (see Radar
dashboard: the Radar Signal Information panel on page 85). Try to balance the
detection of targets within the clutter area (under the rain) with detection of those
outside the clutter area.
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Caution
Always use the rain clutter controls with great care. Excessive
suppression can cause loss of small targets. It is often advantageous to
use this control to search for targets in the clutter region, returning the
control to minimum after the search.

You can use the AUTO setting to suppress rain clutter in open sea conditions. This
normally provides optimum detection by adapting rain clutter suppression to the
varying characteristics of the rain clutter.
Note

To return to manual rain clutter control when the system is performing automatic
rain clutter control, adjust the slider manually.

9 Using the tune control
The Tune slider control is on the Radar System Information panel on the Radar
dashboard (see Radar dashboard: the Radar System Information panel on page 83).
Note

The tune control is only available on the console that is master in relation to the
selected scanner/transceiver.

We recommend you click the Auto button so that the system tunes the transceiver
automatically.
If you want to tune the transceiver manually, move the slider to the maximum
setting (which is normally near the middle of the slider's scale) and then fine-tune
using weak targets.

10 Choosing the presentation mode
Using the drop-down menus in the Range panel of the radar dashboard (see Radar
dashboard: the range panel on page 79) select the combination of presentation
modes you require:
• Orientation (north up, course up, or head up)
• Motion (true or relative)
Also specify whether you are using ground- or water-referenced sensors for the
measurement of speed and course (see Ground and water stabilisation on page 739).

11 Setting the radar to standby
• Click the Scanner/Transceiver button (see Radar dashboard: the Radar Signal
Information panel on page 85) and, in the Radar Control dialog, select Standby.
For more information about the Radar Control dialog, see Radar Control on
page 539.

12 Selecting the chart database to use
a In the top left-hand corner of the screen (just beneath the Kongsberg Maritime

logo), use the drop-down menu to select the ECDIS application (see Switching
between Radar, ECDIS and Conning on page 120).

b If you have more than one chart database installed, select the one you require.
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Select Chart→Chart type (see Chart Types on page 477).
13 Specifying the safety contour

When the system is first started the safety contour is always set to 30 metres.
Select a safety contour that is appropriate to your ship's draught and to the depth
contours in the vector charts available (see Safety Depth on page 479).
When the system is restarted, it will automatically re-use the previously specified
safety contour.

14 Selecting the chart scale to use
The ECDIS application automatically starts monitoring in North Up, True Motion
and with the best chart available for the own-ship's current position.
Normally several charts of different scales are available for a given position.
a Click the scale button in the ECDIS range panel (see ECDIS range panel:

viewing controls on page 88) to bring up the Zoom dialog.
This dialog lists the available charts and states the nominal (that is, the optimal
viewing) scale for each (see Zoom on page 370).

b Use the Zoom In and Zoom Out buttons in the Zoom dialog to try out the
available chart scales:
• Zoom In: increases the chart range by a factor of two for each click of the

button.
• Zoom Out decreases the chart range by a factor of two for each click of the

button.
c Check the chart scale status indicator to see if the chart is displayed at over or

under scale (see The ECDIS range panel: chart indicators on page 91).
d Select the chart you want to use.

The chart will then be displayed at nominal scale.
Note

To give the best view of the area you are sailing in, always select the largest
scale that is compatible with your operational requirements.

15 Selecting radar video and target vectors
Both target vectors and radar video can be displayed as overlays to the chart.
In the ECDIS range panel, select TGT and/or VID (see ECDIS range panel: viewing
controls on page 88).

16 Changing chart themes
Vector charts are constructed in a way that enables you to switch on and off different
types of chart information belonging to them. Use the theme controls to avoid
cluttering the screen with information that you do not need.
a Select: View→Themes.

17 Select the themes you require, or choose Standard or Everything (see Chart themes
in ECDIS on page 374).

18 Changing presentation mode
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Use the drop-down menus in the ECDIS range panel to configure the presentation
mode you require (see ECDIS range panel: viewing controls on page 88). The
possible combinations are:
• NUP/TM - north up true motion
• NUP/RM - north up relative motion
• CUP/TM - course up true motion
• CUP/RM - course up relative motion
• HUP/RM - head up relative motion
• Browse - for north up planning

3.4 Establishing a common reference
system

To enable the system to provide an accurate correspondence between the symbols of the
own-ship and the target and chart data displayed, it is necessary when setting up the
console for the first time to establish a common reference system for all measurements of
range and bearing.

Unless otherwise stated, all measurements of range and bearing used by the K-Bridge
navigation system are relative to the vessel's Common Consistent Reference Point
(CCRP); in other words, its conning position.

You can find the vessel's precise conning position by selecting System→Parameter
Settings →Ship (tab) and inspecting the Conning Pos fields. (This data is only configurable
by service engineers.)

For information about the behaviour of the radar bearing scale in relation to the conning
position, see The radar bearing scale and the conning position on page 95.

The accuracy of the system depends on the following having been accurately specified
during commissioning:
• The ship's dimensions. These are specified in the Ship Parameter dialog (see Ship
(tab) on page 571).

• The conning position. The conning position is specified with a metric offset from the
stern and the ship's center line. The conning position is the bridge reference point
and is used for displaying the own-ship's position (unless otherwise specified). The
conning position is specified in the Ship Parameter dialog (see Ship (tab) on page 571).

• The position of the receiving antenna for each position sensor. This is specified with a
metric offset from the stern and the ship's centre line. The position receivers must also
output geographic data using the WGS-84 datum. These two measures ensure the
correct placement of the own-ship in the radar and chart displays.

• The position of the speed sensors (offset from centre-stern).
• The position of the radar antenna, for receiving radar targets.
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• The position of the pivot point (offset from centre-stern). The pivot point is the point
on the ship which follows a smooth curve when the vessel uses the rudder. Points
astern of the pivot point will move outwards, and points ahead of it will move inwards
when the rudder is used. Specifying the position of the pivot point accurately in the
console's system software ensures that the Dead Reckoning calculations are correct
during turns. It is also essential for the correct operation of the autopilot in track mode.
(The pivot point is not in fact a constant point on the ship; it will vary with different
load conditions and also during a turn. However, for simplicity it is configured as a
constant location on the ship. And the location will be different for different types of
ship. It is often found to be approximately 30% of the ship’s length from the bow.)

In addition, the heading sensors must each be calibrated to provide the correct heading of
the ship; this ensures that the ship is displayed at the correct angle.

3.4.1 The Ship parameters tab
To configure the ship parameters, select: System→Parameter Settings→Ship (tab).

The ship parameters are:
• Ship Name: This is used for verification of the position log and it appears on printouts.
• Ship Length/Width: This is used for drawing the ship symbol in large scale charts.
• Max Ship Draught: This value is used by the system to inhibit the navigator from

selecting a safety contour that is too shallow for the vessel.
• Conning Position: This is the common consistent reference point (CCRP) for all

K-Bridge measurements (it is the position reported on the top bar as the vessel's
position). This position should be defined on the centre-line of the ship and on a line
through the bridge consoles. Normally the conning position will be the helmsman's
position.

• Pivot Point: This is the reference point for track-keeping and for computing any
cross-track distance (XTD). It needs to be a point near the gravitational centre of
the ship.

• Min. Ship Turn Radius: This defines the sharpest turns available in Route Planning.
• Max. Ship Turn Rate: If set to a value above or below 0.0, this parameter defines the

maximum turn rate for the vessel. During route monitoring, if the ship approaches
a sharp turn at too high a speed, the turn rate will exceed this value and an alarm
will be activated.

• Turn Acceleration Length: This is set for computing the Wheel-over Line; it
corresponds to the Acc. Length setting in the K-Bridge Autopilot (see K-Bridge
Autopilot Operator Manual, see References on page 45).

• Offtrack AlarmMargin: This is the distance from the Pivot Point to the Offtrack-Limit
of the Route at which the XTD Alarm will be activated. To ensure that the whole
ship stays inside the area of the validated route, the alarm margin should be larger
than half the ship's width.
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3.4.2 Verifying the ship parameters and sensor geometry
against a chart
This section suggests two optional tests you can perform if you have good charts
available for the own-ship’s current location.
Preconditions:
• Have available a large scale chart (better than 1:50000) of the current ship area, check

the geometry of the ship contour with relation to the fixed geometry in the chart.
• Make sure the ship parameters have been set up properly.
• Make sure the GPS antenna offset has been defined properly.
• Make sure the heading sensor has been set up properly.
Selecting in turn all available position sensors, make sure the placement of the ship
symbol is correct with each sensor.
If a radar image is available, use the radar information to check the position of distinct
elements in the chart.

3.5 Establishing the correct colour
calibration on the monitor

1 If you are using:
• An ISIC 26” monitor, go straight to step 2.
• A Hatteland 27” TFT monitor (JH27T11, JH27T14) or a Hatteland 23” monitor

(JH23T02, JH23T12, JH23T14) installed and you have replaced the monitor
originally supplied with the console, you must upload the colour calibration table
from the monitor to the MFD's main computer:
a In the ECDIS application select: System→Maintenance→Configure Monitor

(see Select Monitor on page 605).
b Select the monitor type from the drop-down list.
c Click Load Calibration File from Monitor.

2 Select View→Palette/Intensity, and click Set Calibrated (see Intensity on page 367).
This sets the back-light to the correct level for displaying chart colours in the current
screen palette (day, dusk or night).

3 Select Chart→Colour Differentiation and Calibration.
To confirm that the monitor is functioning properly, make sure you can see a clear
difference between the foreground colour lines and the background colours (see
Colour Differentiation and Calibration on page 531).

4 Select View→Palette/Intensity and confirm that it is possible to adjust the backlight
on the monitor by using the brilliance slide control (see Intensity on page 367).
Also confirm that it is possible to adjust the back-light by using the brightness
controls on the monitor (see The brightness controls on the monitor on page 44).
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If the foreground and background colours cannot be differentiated, or if it is not possible
to adjust the backlight using the slide control and brightness controls on the monitor’s
housing, contact the Kongsberg Maritime service department.

On the 27” and 23” monitors, patterns displayed by the LEDs around the brightness knob
indicate whether the backlight and brightness are at the ECDIS calibrated level or not.
These patterns and their meanings are listed in the table below. For descriptions of the
other LED patterns and activity associated with the brightness knob, see The brightness
controls on the monitor on page 44.

Table 7 The calibration status LED patterns on the Hatteland 27” and 23” monitors

LED pattern Calibration status Description
Status: Calibrated

The back-light and brightness are at
the ECDIS calibrated level.

Four green LEDs are on (not
flashing). Each is directly
opposite another LED, and
between each is an LED that
is off.

Status: Over calibrated

The back-light and brightness are
above the ECDIS calibrated level.

To return to the ECDIS calibrated
level, turn the knob anticlockwise.)

Four green LEDs are on (not
flashing). One is next to
another LED on the right that
is also on.

Status: Under calibrated

The back-light and brightness are
below the ECDIS calibrated level.

To return to the ECDIS calibrated
level, turn the knob clockwise.

Four green LEDs are on (not
flashing). One is next to
another LED on the left that
is also on.

3.6 Switching off the MFD console
The system can be switched off in either of two ways: by means of the POWER button
on the main system computer (the computer is located inside the console), or using
the Shutdown menu.

3.6.1 Switching off the system using the computer's power
button
1 Open the computer compartment door on the console.
2 Locate the computer inside the console. The computer is attached to the computer

door inside the console.

381287/A 117



K-Bridge Multi-functional Display Unit

3 Press the POWER button on the front of the computer. This removes the power to
the computer (the power light on the computer is switched off).

3.6.2 Switching off the system using the Shutdown menu
1 Select System→Shutdown.
2 The Shutdown dialog is displayed (see Shutdown on page 664).
3 Select the function you require:

• Restart: Select to stop and restart the Radar, ECDIS and Conning applications.
• Restart Computer: Select to stop all programs and restart the entire computer.
• Power Off Computer: Select to stop all programs and remove power to the

computer.
4 To switch off the console, click the Power Off Computer button.

This stops all programs and removes power to the computer.
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4 Basic operating
information

This section contains the following topics:
Introduction....................................................................................................................120
Controlling the brightness of the display .......................................................................120
Switching between Radar, ECDIS and Conning ...........................................................120
Setting the gain and clutter controls...............................................................................120
Using and controlling chart objects on the screen .........................................................126
Zooming into and out of charts......................................................................................128
Making one console the navigation master....................................................................130
Using the console controls to make numeric data entries..............................................131
How an operator station responds to failures of the sensors..........................................132
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4.1 Introduction
This chapter tells you how to control the brightness of the display, how to switch between
the Radar, ECDIS and Conning applications, and how to perform certain other basic
ECDIS and radar operating procedures.

4.2 Controlling the brightness of the display
If the display is too bright and impedes
your night vision from the bridge, select:
View→Palette/Intensity→Night.

The brightness can be adjusted for both the display
and the operator panel. Three levels of brightness
are available, suitable for: Day, Dusk and Night.

For more information about controlling the brightness of the display, see Intensity on
page 367.

4.3 Switching between Radar, ECDIS and
Conning
In the top left-hand corner of the screen in all three applications (just below
the Kongsberg Maritime logo) is a drop-down menu.

Next to the menu arrow is the name of the application you are currently
using: RADAR, ECDIS or CONNING.

To switch to another application, click the arrow and select the application
you require.

You can also switch between applications by using the Shutdown menu (see Shutdown
on page 664).

4.4 Setting the gain and clutter controls
The gain and clutter controls on the radar dashboard (see The radar dashboard on
page 77) are designed to help you distinguish between echoes from targets and echoes
from clutter. The radar displays all the echoes it receives and there is no essential
difference between an echo from a target (such as a ship, buoy or other solid object)
and an echo caused by waves or precipitation. (Echoes caused by the latter are called
“clutter”.)

This section tells you how to use the gain and clutter controls to see targets more clearly.
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For more information about radar video display issues, see Concepts of video
enhancement on page 743 and Minimising radar display problems on page 751.

Figure 30 The gain and clutter controls (on the radar dashboard)

4.4.1 Setting the gain threshold
The video gain control on the radar dashboard (see Radar dashboard: the Radar Signal
Information panel on page 85) enables you to set a threshold for the strength of echoes:
any echoes whose strength is below the specified threshold will not appear on the display.

Broadly speaking, the gain and clutter controls have the following effects:
• The gain controls suppress noise and clutter across all ranges on the video display.
• The sea clutter controls suppress noise and clutter at close ranges.
• The rain clutter controls suppress noise and clutter at distant ranges. They also

more specifically enable you to regulate the degree to which echoes are enhanced to
differentiate them from local precipitation.

The minimum gain setting is zero and the maximum is 100.

There is no setting of either the gain or clutter controls that is optimal for all conditions.
However, the gain setting is appropriate when the parts of the screen that are outside
of the sea clutter area are neither too densely filled with speckles nor entirely empty
of them (see the figures below).

The optimal range scale for setting the gain threshold is 12 or 24 NM. Gain can be
adjusted by means of the rotary button on the operator panel, the Video Gain slider on
the radar dashboard, or the numeric field on the radar dashboard (see Radar dashboard:
the Radar Signal Information panel on page 85). The present gain setting is indicated by
the position of the Video Gain slider and by the numerical field.
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Figure 31 Gain setting too high (left), too low (middle), appropriate (right)

4.4.2 Using the manual sea clutter controls
The proper procedure for controlling the sea clutter manually is to adjust the gain setting
first (see Setting the gain threshold on page 121), then to adjust the sea clutter until the
sea clutter area around the own-ship symbol is reduced to a size that leaves a substantial
area of the screen free from clutter.

The minimum sea clutter setting is zero and the maximum is 100.

The current setting is indicated graphically by the position of the slider and numerically
by the value in the adjacent number field (see Radar dashboard: the Radar Signal
Information panel on page 85). Clicking the Auto button turns automatic sea clutter
control on or off (when it is on, an A appears in the number field). When it is off,
you can specify the setting manually by using the rotary button on the operator panel.
Whether it is on or off, you can specify a setting manually simply by moving the slider
or editing the number field.

Remember that sea clutter is caused by strong echoes from waves breaking in close
proximity to the own-ship. If you adjust the setting to a level that eliminates these
echoes, you risk also eliminating echoes from targets. It is often simply not possible to
set the controls so that echoes from breaking waves are rejected while echoes from all
the targets you are interested in show clearly.
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Figure 32 Sea clutter settings too high (left) and appropriate (right)

4.4.3 Using the manual rain clutter controls
The current rain clutter setting is indicated graphically by the position of the slider and
numerically by the value in the adjacent number field (see Radar dashboard: the Radar
Signal Information panel on page 85). Clicking the Auto button turns automatic rain
clutter control on or off (when it is on, an A appears in the number field). When it is off,
you can specify the setting manually by using the rotary button on the operator panel.
Whether it is on or off, you can specify the setting manually simply by moving the
slider or editing the number field.

The minimum rain clutter threshold is zero and the maximum is 100. With a threshold of
zero, a heavy rain-shower may appear so strongly enhanced on the display that it masks
any targets within it. When the setting is correct, the front edge of the shower will be
clear and so will the echoes from within the precipitation.

Caution

It is important to be aware of the possibility that a vessel may be “hidden”
in the rain echo while another smaller vessel at a similar range is clearly
presented.
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4.4.4 Using automatic rain and sea clutter control
You can have the sea and rain clutter controlled automatically. To do this, click the Auto
option for the Sea Clutter and Rain Clutter controls on the radar dashboard (see Radar
dashboard: the Radar Signal Information panel on page 85).

When automatic rain clutter control is on, attempting to control the rain clutter manually
using the rotary button on the operator panel will have no effect. The same is true for
automatic sea clutter control. However, you can return to manual clutter control, either
by turning off the automatic control explicitly by clicking the Auto button or simply by
using the slider on the radar dashboard.

The automatic clutter thresholds (for determining which radar echoes to display) are
dynamic: they are arrived at by a continuous sampling process based on the CFAR
(Constant False Alarm Rate) technique. This process takes the average amplitude of
the echoes in a 200 metre range and uses it as the clutter threshold within that range.
The whole of the radar's range is continuously sampled in this way, with the 200 metre
samples each starting 3 metres along from the start of the previous one (each sample
overlapping its neighbours by 197 metres). This means that no sudden transitions occur
from one clutter threshold to the next.

For automatic rain clutter control, the threshold at a given point on the screen is simply
the average amplitude of the echoes in the most recent sample to include that point
on the screen.

This is also true for automatic sea clutter control but with two exceptions:
• The sea clutter threshold is not allowed to increase with range.
• And the sea clutter threshold does not adapt to rising clutter levels that might be

caused, for example, by a shower of rain or a land mass. The radar will therefore
display land echoes fully (as opposed to representing them just by their front edges,
which is how it displays an area of precipitation).

At close ranges, K-Bridge Radar uses special algorithms (including a fast recursive
filter) to initialise the sea and rain clutter thresholds. These algorithms use an initial
average amplitude of zero at distance 0 for the 200 metre window average. As distance
increases, the average will build up. Finally, when the average for the 200 metre window
has reached the level of the fast recursive filter, the clutter thresholds are determined
purely by the averaging of real echo levels.
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Figure 33 Automatic clutter thresholds in relation to real echo levels
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4.5 Using and controlling chart objects on
the screen

To make use of and control objects that appear on digital charts in either the radar or
ECDIS applications, you must first select the object. Once it is selected, the object is
displayed with a set of handles. Most of the control operations involve dragging one
of the handles.

These principles apply to all the following objects on the display:
• Electronic Bearing Lines (EBL)
• Variable Range Markers (VRM)
• Parallel index lines
• Routes
• Mariners' Notes
• Distance Measures
Note

To make it easier to use the EBL and VRM facilities, EBL and VRM objects are
pre-selected. Therefore you can edit them without selecting them.

Figure 34 Examples of handles on chart objects
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4.5.1 Viewing data about an object
Use the track-ball and the OBJECT INFO button (on the operator panel, see The CHART
group buttons on page 35) to display the object information dialog for an object, or
double-click on the object with the left mouse-button.

The Object Info dialog displays data about one or more
objects on the chart. Point to an object and double-click it
using the Left mouse button. (You can also right-click objects
for context-specific menus and information; see Using an
object's context menus on page 128.)
Data for all objects under the marker (cursor) is shown in
this dialog. Select an object from the list at the top of the
dialog. All available information for the selected object is
listed in the part of the dialog below the object list. Use the

scroll bar if necessary to view all the information.
The information includes:
• Lights
• Depth contour
• Underwater rock
• Caution area
• Depth area
• Map source
• Chart identification
• Buoy
If you select Auto Update, then objects with changing data, for example, AIS targets,
are automatically updated.

Note

Unless you select the Auto Update option, all information in the Object Information
dialog is static: the data you see is a snapshot taken when you brought up the dialog
for the selected object.

The Object Info dialog for an object can include the
following buttons:
Highlight: If you click this button after selecting an object
in the chart, the selected object is highlighted.
Change: If you click this button after selecting an object in
the chart, the object can be manually updated.
Picture: (This button is available only if the selected object
has graphical data associated with it.) If you click this
button after selecting an object, another dialog is brought up

containing a graphic associated with the object (see Picture Dialog on page 128).
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4.5.1.1 Picture Dialog

In the dialog that comes up when you click Picture in the
Object Info dialog, there are buttons for:
• Zooming in (+ button)
• Zooming out (– button)
• Toggling between showing the full picture and showing

part of the picture at the fullest scale available (14%
button).

• Showing the full picture inside a large window (Full Picture button).

4.5.2 Using an object's context menus
Right-click over an object on the screen to display its context menu.

Context menus provide convenient short-cuts for the most frequently used functions
associated with an object. As their name suggests, however, these menus are
context-specific, therefore the list of functions available depends not just on the object
selected but on the current state of that object.

4.6 Zooming into and out of charts
The most convenient facilities for zooming in and out are the:
• Range + and Range – buttons on the operator panel (see The NAV (navigation) panel

on page 33).
• The range up and down arrows on the on the range panel in the top left-hand corner of

the radar and ECDIS displays (see ECDIS range panel: viewing controls on page 88).

However, this section tells you how to use some additional facilities for zooming in and
out while viewing charts.

4.6.1 Zooming in and out using the chart's context menu
To zoom in or out:
1 Right-click over the point on the chart that you want to

zoom in to or out from.
This brings up the chart's context menu.

2 Select Zoom In or Zoom Out.
The Zoom In and Zoom Out options on the chart's context
menu have the same function as the Range + and Range –
buttons on the operator panel.
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4.6.2 Scaling up and down
You can also use the chart's context menu to change the scale at which you are viewing
the chart. The Scale Chart Up and Scale Chart Down options are similar to the zoom
functions. The difference, however, is that the scale functions use the same chart data at
each scale, while the zoom function presents new chart data at each scale.

This has two important consequences.
• If you scale up fully from a fully zoomed out display, so little detail will be presented

that the chart becomes of almost no use. As you can see from the figure below, if
you zoom in instead, the data presented is appropriate to the scale at which you are
viewing the chart.

• If you scale down fully from a fully zoomed in display, so much detail will be
presented that the chart becomes cluttered and (for the opposite reason) of almost no
use (see figure below).

Figure 35 Losing data by scaling up instead of zooming in

Figure 36 Cluttering the screen by scaling down instead of zooming out
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Caution

If you scale down (instead of zooming out) from a zoomed in display, the
enormous amount of chart data displayed at the lower scales can cause the
system to slow down and eventually stop.

4.6.3 Zooming in on a particular chart area
To zoom in on a particular area of the chart (for example,
a harbour you are planning to enter):
1 In the chart display, use the cursor (holding down

the left button on the track-ball or mouse) to draw a
rectangle defining the area you are interested in.

2 Click with the left mouse-button inside the rectangle.
The view zooms to the centre of the rectangle you
have drawn.

If you are using a mouse with a scroll-wheel, you can also:
• Zoom in by scrolling the wheel forward.
• Zoom out by scrolling the wheel backwards.
Note

For the scroll wheel to work in this way, the chart display needs to be the currently
active window. If, for example, an alarm has just occurred, then the alarm window
will be the active window. To make the chart display active when another window has
taken over from it, just left-click anywhere on the chart.

When the ECDIS system is in any of the “monitoring” chart display modes, the
scroll-wheel zooms in on the own-ship. When it is in “browse” mode (North Up), the
scroll wheel zooms in to the centre of the screen. For information about these modes and
how to specify the one you require, see The top bar on page 57.

4.7 Making one console the navigation
master

You can configure one on the network as the navigation master. This means that it
performs its own calculations for the own-ship's position, speed and heading (it also
calculates the time on the own-ship) and then distributes the data over the LAN for
use by all the other consoles on the network; the result is that all the operator stations
operate with exactly the same data.
Also, if a sensor fails, the master automatically switches to an alternative sensor (if one is
available) and causes all the other K-Bridge operator stations to switch to that sensor too.
To make one console the navigation master, do the following:
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1 On a console that is at the front of the bridge, select System→Integration
Configuration.

2 Check the Master Enable option.
If you want the console to assert itself as the navigation master as soon as it starts
up, click Master at Start. Otherwise, select Own Ship→Data, and check the Master
box (see Own-ship Data on page 442).

3 On all the other consoles, select System→Integration Configuration and check the
Slave Enable option.
If you want the console to send a warning when it does not detect a navigation
master on the network, check the Enable button underneath the labelWarning if No
Master. (You can specify a delay for this warning in case the master console is
still starting up.)

For more information, see Integration Configuration on page 659.

4.8 Using the console controls to make
numeric data entries

There are two ways of entering numeric values into fields that require them:
1 Point the Marker to the entry field and click and hold the Left mouse button. Roll the

track-ball up or down to increase or decrease the value.

Figure 37 Numeric entries using the left mouse button and the track-ball

2 Point the marker into the entry field and type in the value using the alphanumeric
keyboard found in the drawer below the operator panel. If you type an illegal value,
the closest legal value will be entered.
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4.9 How an operator station responds to
failures of the sensors

The operator station is dependent on input from the own-ship's sensors if it is to operate
with full functionality. The most important external sensors are the:
• Heading sensor (typically a gyro compass)
• Speed sensor (typically a speed log; it must be able to measure speed through water)
• Position sensor (typically a Global Positioning System).

These sensors are vital for the quality, for example, of the radar presentation and for the
tracking of radar targets. Without them the radar can only be operated in Head-up mode
with relative motion, and target tracking capabilities will be greatly reduced.

The interfaces to all sensors are based on the international standard IEC 61162-1 which
is very similar to NMEA 0183.

K-Bridge Radar operator stations do not support analog gyro interfaces (such as Syncro,
Stepper or M-Type). These are subject to failures such as loss of alignment and must not
be used.

K-Bridge Radar operator stations do not support pulsed log interfaces (200 pulses per
mile). These cannot distinguish between a broken wire and zero-speed, and again they
must not be used.

On a typical K-Bridge system there is a network of integrated operator stations, including
Radar, ECDIS and Conning operator stations. One operator station will be designated
the “navigation master”. This operator station provides all the other operator stations on
the network with calculated (filtered) heading, speed, and position data. (Although the
other “slave” operator stations all receive sensor input of their own, they do not use it but
instead display the filtered measurements received from the master.)

It is only on the navigation master operator station that the operator can select alternative
sensors.

For each measurement – heading, speed, and position – the currently selected sensor will
be used and any alternative sensor will have no effect. (However, if there is a deviation
between the data reported by the sensor in use and a redundant sensor, the navigation
master operator station will issue an alert.)

If a sensor fails, it is the navigation master that automatically selects an alternative (if one
is available). If there is not an alternative available, the operator station (whether it is the
master operator station or a slave) continues to operate but with reduced functionality.

For more information about the operator station’s failure behaviour with respect to
each sensor, refer to the sub-sections below. For simplicity, these sub-sections describe
the behaviour of the navigation master operator station in response to sensor failures.
Remember that all the other operator stations receive the heading, speed and position
data that they display from the navigation master, and that only the navigation master
can automatically switch (or be manually switched) to an alternative heading, speed
or position sensor.
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4.9.1 Failures of the heading source
The table below describes the NMEA sentences that the operator station receives from
the heading source and also lists the error checks it performs on each sentence.

Table 8 The IEC 61162-1 sentences received from the heading source

Sentence: Content: Status of the heading
information:

Error check performed by
the operator station:

HDT True
Heading

None • Was there a time-out?
• Has a heading jump

occurred?
THS True

Heading • Autonomous (the heading
message is normal)

• Estimated (the heading
message has been
calculated on the basis of
a dead reckoning)

• Manual (the heading
message has been entered
manually)

• Simulator (the heading
message has been
generated by a simulator)

• Invalid

• Was there a time-out?
• Has a heading jump

occurred?
• Has the heading data been

generated autonomously
(in other words, normally)
by the heading sensor?

The table below lists the operator station's responses to the different heading errors
that are possible.

Table 9 The operator station's responses to heading sensor failures

Heading sensor error: The system's response:
Time-out In the event of a time-out, the radar system does all of

the following:
• Issues an alert
• Switches to an alternative heading sensor if one is

available (and the deviation if any between it and the
failed heading sensor does not exceed the deviation
limit)

• Uses the last received heading for its calculations
(unless you input a new heading manually)

• Turns the heading button red (in the top bar; see Top
bar: the HDG button on page 72)
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Table 9 The operator station's responses to heading sensor failures (cont'd.)

• Reverts to Head-up, Relative Motion for the display
mode

• Switches off charts
• Provides only relative bearing measurements

Heading jump In the event of a heading jump, the operator station
issues an alert.

The heading data has
not been generated
autonomously by the
heading sensor. It has been:
• Estimated (by dead

reckoning)
• Entered manually
• Generated by a simulator
• Or is simply invalid

If a heading measurement has not been generated
autonomously by the heading sensor, the radar operator
station:
• Ignores the heading measurement.
• Switches to an alternative heading sensor if one is

available (and the deviation if any between it and the
failed heading sensor does not exceed the deviation
limit)

When there are two heading sensors available on the own-ship, the operator station
issues an alert if the deviation between them exceeds a configurable limit.

The heading sensor can also send out the ROT (Rate Of Turn) sentence, and the operator
station can receive it. When this happens the ROT gives a small improvement in the
calculation of the own-ship's heading during turns. Also, if there has been a time lapse
since the last message received from the heading sensor, the radar operator station will
calculate the heading by using the last reported heading and the ROT. When there is no
ROT message available, the operator station calculates the turn rate from the series of
heading messages it has received.

If the operator station and the heading sensor are configured to communicate using the
ROT sentence and a time-out occurs in respect of the ROT, the operator station issues
an alert.
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4.9.2 Failures of the speed log
The table below describes the sentences that the K-Bridge operator station receives from
the speed source and also lists the error checks that the it performs on each sentence.

Table 10 The IEC 61162-1 sentences received from the speed log

Sentence: Content: Status of the speed
information:

Error check performed
by the operator station:

VBW Water speed
(longitudinal and
transverse)

Ground speed
(longitudinal and
transverse)

Water speed valid/invalid

Ground speed
valid/invalid

• Was there a time-out?
• Are the water speed

and/or ground speed
valid?

VHW • Water speed
• Magnetic

heading (note
that the
K-Bridge Radar
system ignores
this content if
present).

• True heading
(note that the
K-Bridge Radar
system ignores
this content if
present).

None Was there a time-out?

VTG • Course over
ground (true).

• Course over
ground
(magnetic).

• Speed over
ground
(absolute).

None Was there a time-out?

RMC Ground speed
(longitudinal and
transverse)

None Was there a time-out?

381287/A 135



K-Bridge Multi-functional Display Unit

Note

Although VHW sentences can contain heading information, note that the speed log
cannot be used as a heading sensor by a K-Bridge operator station.

The table below describes what a K-Bridge operator station does in the event of a
time-out in its communication with the speed log.

Table 11 The system's response to a time-out in its communication with the speed log

Speed log error: The system's response:
Time-out The radar operator station:

• Issues an alarm if it receives no valid ground or water
speed information within the time-out period.

• Switches to an alternative sensor if one is available
• Uses speed data (for its calculations) that has itself

been calculated from changes in the own-ship's
position. However, if you input new speed data
manually, the system will base its calculations on the
speed data that you provide.

• Turns the speed button on the top bar red (see Top
bar: the SOG button on page 72).

• Disables AIS facilities (reliable speed data is a
pre-requisite for the AIS facilities).
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4.9.3 Failures of the position sensor
The table below lists the sentences that the K-Bridge operator station receives from
the position sensor.

Table 12 The IEC 61162-1 sentences received from the position sensor

Sentence: Content: Status of the position
information:

Error check performed
by the operator station:

GGA Time of position
and position
(latitude, longitude)

• GPS SPS
• Differential GPS SPS
• GPS PPS
• Real Time Kinematic

(satellite system used
in RTK mode with
fixed integers)

• Float RTK (satellite
system used in RTK
mode with floating
integers)

• Estimated (the
position has been
calculated on the basis
of a dead reckoning)

• Manual (the position
has been entered
manually)

• Simulated (the
position has been
generated by a
simulator)

• Position fix not
available or invalid

• Was there a time-out?
• Has a position jump

occurred?
• Is the input OK for

use by the operator
station? Only the
following input can
be accepted by the
operator station: GPS
SPS, Differential GPS
SPS, GPS PPS, RTK,
and Float RTK.
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Table 12 The IEC 61162-1 sentences received from the position sensor (cont'd.)

Sentence: Content: Status of the position
information:

Error check performed
by the operator station:

GLL Time of position
and position
(latitude, longitude)

• Autonomous (the
position fix has
been generated
by the positioning
system without
any differential
corrections being
applied)

• Differential GPS
• Estimated
• Manual
• Simulated
• Invalid

• Was there a time-out?
• Has a position jump

occurred?
• Is the input OK for

use by the operator
station? Only the
following input can
be accepted by the
operator station:
Autonomous and
Differential GPS.

GNS Time of position
and position
(latitude, longitude)

• Autonomous
• Differential GPS
• Precise (the position

has been generated
by a satellite system
operating in precision
mode)

• Real Time Kinematic
• Float RTK
• Estimated
• Manual
• Simulated
• Invalid

• Was there a time-out?
• Has a position jump

occurred?
• Is the input OK for

use by the operator
station? Only the
following input
can be accepted
by the operator
station: Autonomous,
Differential GPS,
Precise, RTK, and
Float RTK.

RMC Time of position
and position
(latitude, longitude)

• Autonomous
• Differential GPS
• Estimated
• Manual
• Simulated
• Invalid

• Was there a time-out?
• Has a position jump

occurred?
• Is the input OK for

use by the operator
station? Only the
following input can
be accepted by the
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Table 12 The IEC 61162-1 sentences received from the position sensor (cont'd.)

Sentence: Content: Status of the position
information:

Error check performed
by the operator station:

operator station:
Autonomous and
Differential GPS.

For GPS, the sentences that the K-Bridge operator station uses are GGA or GNS. For
Loran C, the K-Bridge operator station uses the GLL sentence.

The table below describes the operator station's response to a time-out or other failure in
its communication with the position sensor.

Table 13 The radar operator station's response to a time-out in its communication
with the position sensor

Speed log error: The operator station's response:
Time-out The operator station:

• Issues an alert if it has not received valid position
data within the time-out period.

• Switches to an alternative position sensor if one is
available (and the deviation if any between it and the
failed position sensor does not exceed the deviation
limit)

• Now bases its position calculations on dead
reckoning.

• Turns the position button on the top bar red (see Top
bar: the position and offset buttons on page 74).

• Disables the presentation of electronic charts.
The position data has
not been generated
autonomously by the
heading sensor. It has been:
• Estimated (by dead

reckoning)
• Entered manually
• Generated by a simulator
• Or is simply invalid

If a position measurement has not been generated
autonomously by the heading sensor, the radar operator
station:
• Ignores the position measurement.
• Switches to an alternative position sensor if one is

available (and the deviation if any between it and the
failed position sensor does not exceed the deviation
limit)

The operator station performs continuous checking for position jumps. It compares the
current position sensor input with a predicted position (calculated on the basis of the last
known position, and the speed and course). If the deviation between the position sensor
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input and the predicted position exceeds the alert limit, the operator station issues an
alert. This continuous check for position jumps is performed only for the currently
selected position sensor (not for any alternative but un-selected position sensors).

Where two position sensors are available, the operator station issues an alert if the
deviation between them is greater than a specified limit. (This check is not a direct
comparison between position sensors: instead each sensor’s raw input is compared
with the filtered position data that represents the own-ship’s current official position
measurement.)

4.9.4 The operator station's interface for the geodetic
datum
The position sensor might also report the geodetic datum used by the positioning system.
If so, it presents this using the DTM sentence. If it is available, we recommend that you
use this sentence and set the datum to WGS84.

If the position sensor reports a datum other than WGS84 or does not report a datum at
all, the operator station will issue an alert.

When you configure the position sensor, you will see an option enabling you to accept
input from the sensor without a datum. Use this option only if the position sensor does
not report the datum but nevertheless uses WGS84 at all times.

4.9.5 The operator station's interface to the time source
If the operator station is interfaced to a time source it needs to accept the ZDA sentence.
This sentence is usually transmitted by the position sensor, and the operator station uses
it to synchronise the radar clock with the clock of the positioning system.

If there is no ZDA input to the operator station, the time on the operator station is
updated from the computer’s crystal clock. The operator station uses the computer
clock in any case between ZDA messages.
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5 Tracking radar targets

This section contains the following topics:
Introduction....................................................................................................................142
Limitations of the tracking system.................................................................................142
Manual acquisition of targets.........................................................................................143
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Ceasing the tracking of targets.......................................................................................145
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Adjusting tracking sensitivity ........................................................................................146
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Using the radar positioning system................................................................................148
Testing the radar's tracking capability............................................................................152
Displaying the past positions of targets .........................................................................153
Using target trails ...........................................................................................................155
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Trails compared to vectors and past position marks ......................................................158
Special considerations for high-speed craft ...................................................................159
Radar target error sources ..............................................................................................160
Monitoring the performance of the transceiver .............................................................163
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5.1 Introduction
This chapter tells you how to acquire targets manually and automatically; it also
describes generally how to use the radar tracking facilities.
For troubleshooting information, see Concepts of video enhancement on page 743 and
Minimising radar display problems on page 751.

5.2 Limitations of the tracking system
The performance of the tracking system is a function of many variables including clutter
conditions, signal-to-noise ratios and the quality of gyro, speed-log and chart data.
The design of the tracking system will minimise the effect of any errors in the input
data. However, as a radar operator you must be aware that such errors will produce
discrepancies in the readings that the system gives, for example, for the own-ship's
speed, course, bearing, position, and for the CPA and TCPA with respect to targets.
You must also be aware of the following specific limitations in the operation of the
tracking system:
• When the radar is switched to standby, all targets are cancelled automatically. No

warning is given.
• The maximum number of radar targets is 100. When this limit is reached the "No Free

Targets Left" alarm is issued.
• The tracking system will track targets having a speed of up to 100 knots. Above

this speed tracking is stopped.
• The maximum tracking range depends on the pulse repetition frequency (PRF).

For a PRF of less than 3200 the maximum tracking range is ~23.7 NM. For a PRF
of 4500 it is ~16.7 NM.

• The tracking system uses rain- and sea-clutter rejection circuits that are independent
of the display controls. These circuits automatically adapt to different conditions and
allow tracking in conditions of heavy rain and sea clutter. Tracking will continue if
target echoes are found for at least five out of twelve scans. When fewer than five
echoes are found the lost target symbol is displayed and the system issues a "Lost
Target" alarm.
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5.3 Manual acquisition of targets
1 Position the cursor over the target.
2 Click the ACQ button on the operator panel (The TARGET

group buttons on page 35).

• An initial tracking symbol is displayed centred on the target's
position. After about 10 scans the initial tracking symbol is
replaced by the target vector indicating speed and direction.
This initial period is longer if the target echo is weak or
unclear.

5.4 Automatic acquisition of targets
Targets can be acquired manually by the operator or automatically using a specified
auto-acquisition area. When a target enters the automatic acquisition area, the target
is automatically acquired and a "New Target Warning" is given. Auto-acquisition is
available in all display modes.

When automatic acquisition is enabled the radar system automatically detects video
above a detection threshold within the specified acquisition area (see Turning automatic
acquisition on on page 144). It tests echoes above this threshold to see if they represent
possible targets. If an echo passes this test for three successive antenna rotations the
system starts tracking it. It also marks its position with the symbol for a new target (a
flashing red dashed circle; see Radar target symbols on page 145).

At this point, the NEW button is displayed (as an indication only, not as a flashing alarm)
in the Alarms and Message Area (see Top bar: the alert area on page 60).

After about 10 further scans that have included the tracked target the vector is displayed,
the “NEW” button then flashes red and an alarm sound is given.

When the NEW button has been displayed (either as an indication or as a flashing red
alarm) you can click it to acknowledge all the new targets that have been detected. Their
symbols will then change to the normal target symbol (whether they are still in the
acquisition phase or have become stably tracked targets).

If you acknowledge new targets in the acquisition phase, then no “New target alarm”
will be issued for them when they are classified as stable tracked targets.

If new targets disappear when they are still in the acquisition phase, this will happen
“silently” without any alarm or warning. (They probably represent erroneous detection
attempts.)

New targets that move out of the auto-acquisition area before they have become stably
tracked are also silently removed. This is because it is assumed that they are outside
the area of interest.
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When the NEW button is an indication only (signifying that all the new targets are still
in the acquisition phase) and all the new targets are silently removed, the NEW button
disappears.
When a “New target alarm” is issued, the NEW button and the target symbol (on the
radar display) continue to flash until you acknowledge the alarm.

5.4.1 Turning automatic acquisition on
1 In the menu area click the following sequence of buttons: Targets →Auto Acquisition

Area.
• The Auto Acq menu is displayed.

2 Check the Auto Acquisition of Radar Tgt option.
- The Auto-acquisition area is displayed in the radar area.

3 Use the parameters to set up the acquisition area according to the conditions.
See Auto Acquisition on page 396 for more information.

Figure 38 Auto-acquisition Area

Left figure: Auto-acquisition Area when Port Range, Starboard Range and Forward
Range are identical.
Right figure: Auto-acquisition Area when Minimum Range > Port Range and Minimum
Range > Starboard Range.

Note

The automatic acquisition area retains its parameters when automatic acquisition
is turned off.
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For information about turning automatic acquisition off, see Ceasing the automatic
acquisition of targets on page 145.

5.5 Ceasing the tracking of targets

5.5.1 Ceasing to track a particular target
1 Position the cursor over the target.
2 Click the Cancel button on the operator panel.

The target vector and target number are removed from the target.

5.5.2 Ceasing to track all targets
1 Select Targets.
2 Click Cancel All Radar Targets.

5.5.3 Ceasing the automatic acquisition of targets
1 In the menu area, select Targets→Auto Acquisition Area.
2 Click Cancel Auto Acq Targets.

5.6 Radar target symbols
The following different target symbols are used to indicate target status and warning
state.:
For information about AIS target symbols, see AIS symbols on page 174.

Acquisition Phase: Indicates that a target has been detected, and
that initial target data is being established.
New target: Used for targets that have been detected automatically
but not yet acknowledged by a click of the NEW button on the
top bar. When you acknowledge new targets, the symbol is
replaced by the normal target symbol either for the “Acquisition
phase” (if the target is not yet through the acquisition phase) or
for a “Tracked target” (if the target has become stably acquired).
Tracked target: The common symbol for targets being tracked.

Lost target: Indicates the position where the target was lost. The
symbol is flashing until the Lost Target alarm is acknowledged.
The symbol is then cleared from the display.
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Collision danger: The CPA and TCPA limits are violated. The
symbol is red and flashes until the collision danger alert has been
acknowledged. It then ceases flashing but remains displayed as
long as the CPA/TCPA limits are violated. For more information
about these limits, see Alarm Limits on page 411.
Target with target data displayed: The four-corner symbol
indicates that data for this target is currently displayed in the
Target Info dialog (see Target Information on page 404).

Past Position Indication: When position history has been switched
on it will be displayed for all tracked targets. The interval
between the dots is selectable (see Radar dashboard: the Target
Information panel on page 81.

Target Identification: The target identification number or module
appears close to the target symbol.

Associated target (showing as radar): This symbol indicates an
associated (fused) AIS and radar target that is displaying as a
radar target. For information about making associated targets
display as either AIS or radar targets, see AIS Association on
page 392.
Associated target (showing as AIS): This symbol indicates an
associated (fused) AIS and radar target that is displaying as an
AIS target. For information about making associated targets
display as either AIS or radar targets, see AIS Association on
page 392.

5.7 Adjusting tracking sensitivity
Although the tracking system has advanced rain and sea clutter rejection circuitry you
may need to adjust the sensitivity of the tracker to reduce the number false targets in
heavy seas or to increase the tracking range of weak targets.
1 In the menu area click Targets.
2 Use the Tracker Sensivity spin buttons to adjust the setting.

• Increase value to increase sensitivity.
• Decrease value to lower sensitivity.
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5.8 Using barrier lines
In contrast with the automatic acquisition area – which moves with the vessel – barrier
lines represent fixed limits for automatic target acquisition. Targets are not automatically
acquired beyond the barrier lines. Barrier lines are stored for later use and can be created
and edited from the Barrier Line menu (see Barrier Line Menu on page 398).

To work with barrier lines, select Targets→Auto Acquisition Area→Edit

5.9 Displaying target data
1 Use the track-ball to point to a radar or (AIS) target.
2 Click Data on the operator panel.

The selected target is indicated by a small "□" symbol centred on the target.
The data belonging to the target is displayed in the menu area (see Target
Information on page 404). It includes:
• Target number
• Status
• Course
• Speed
• Bearing
• Range
• CPA
• TCPA
• Bow crossing range
• Time to bow crossing

Note

The range and bearing for a target is the range and bearing measured from the
own-ship's conning position. All target calculations are made from here.

3 Select Auto Update to display continuously updated information.
When Auto Update is not selected the information remains static.
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5.10 Using the radar positioning system
Radar positioning is a tool for calculating the position of the own-ship based upon the
ship's distance (range) from and bearing to one or more tracked radar targets; the radar
targets themselves must have known and fixed positions, and they must be physically
small. (There is nothing in the system that prevents the use of such a target as an anchored
boat, although this will obviously introduce errors if the target starts to sail away or drift.)
The accuracy of radar positioning is poor by comparison with electronic positioning
systems such as GPS, Glonass, Galileo and LoranC. Its accuracy will vary with the
character and geometry of the tracked radar targets in use, but radar positioning is much
more error-prone than electronic positioning systems. In general, therefore, you should
treat it as a low quality back-up system and never as a primary positioning system.
(However, it does have the advantage that it is independent of any electronic system
outside of the own-ship.)
Radar positioning cannot be used to estimate the own-ship’s speed through water; it can
only be used to estimate the speed over ground.
Because the own-ship’s calculated speed may be influenced by an error in the data
concerning one of the fixed reference targets, the relative speed calculated for other
targets is also subject to error.
Caution

If you are making relative speed calculations for the purpose of collision
avoidance, do so with extreme care.

Note

You cannot use radar positioning when the autopilot is performing automatic track
steering.

Finally, radar positioning cannot be used in conjunction with the Automatic Identification
System (AIS). This is because any disagreement between the position reference system
used by AIS (AIS uses GPS) and the position reference system used for the positioning
of the own-ship (in this case, radar positioning) would make the relative positioning data
unreliable. This would be dangerous because it could cause errors in the K-Bridge
Radar's anti-collision calculations.

5.10.1 Calculating the own-ship's position
1 Select a stable and stationary target to track.

You must track at least one fixed target but for the most accurate results we
recommend that you:
• Track more than one target (you can track a maximum of four).
• Choose targets at close range that are small and distinct.
• Choose targets with a difference in bearing between each other of about 90o.

2 Click Targets in the main menu.
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3 Click Target Data in the main menu.
4 Click Radar Target Operations and check the box Fixed Reference Target (see Radar

Target Operations on page 406).
The target is now marked with an “R” and its identification data on the radar area.
The “R” indicates that it is a “reference” target (although it is not yet being used
in any radar positioning calculations).

5 Repeat the previous steps for as many fixed targets as you wish to use as position
references.

6 From the main menu, select Own Ship→Position.
7 Click the RadPos button.

This brings up the Radar Positioning dialog which lists the targets you have
designated as reference targets.
For a description of the Radar Positioning dialog, see Radar Positioning dialog
on page 450.

8 In the Radar Positioning dialog, check the Include box for each target that you want
to include in the positioning calculations.
The system calculates the own-ship's position based on its range and bearing in
relation to the fixed co-ordinates of the reference targets you have included.
The own-ship position now appears in the top line of the Radar Positioning dialog,
and a measure of the “uncertainty” of the calculation appears underneath it.
Note

The figure for the “uncertainty” of the calculations is itself only an indication. It
is based on the geometry of the targets and on some fixed assumptions about the
targets. If a target is not quite fixed or has considerable dimensions, the figure for
the uncertainty of the calculations will be higher.

5.10.2 How radar positioning works
The radar positioning system is based on a Kalman filter which updates the own-ship's
position data each time the radar's target tracker updates the range and bearing from the
own-ship to one of the reference targets.

The Kalman filter also updates the own-ship position data in the intervals between
updates from the target tracker: during these intervals it uses the own-ship's heading and
speed to provide positioning data based on a dead reckoning.

When it receives new information from the target tracker, the Kalman filter automatically
adjusts its calculations according to the likely accuracy of the data. This means, for
example, that measurements for a target that is quite close will have more significance in
the calculations than measurements for a distant target. The Kalman filter also takes into
consideration any differences in the precision of the range and bearing data it receives.
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5.10.3 Error behaviour of the radar positioning system

The loss of one tracked reference target

If tracking of one reference target is lost, the system issues a “Lost Target” alarm but
continues to perform positioning calculations based on the remaining tracked reference
targets. The accuracy of the calculations will be reduced, however, and this will affect
the accuracy of the K-Bridge Radar's calculations of speed and course for the own-ship.
This in turn will affect the accuracy of the radar's calculations of the speed and course of
target vessels.

The loss of all tracked reference targets

If tracking of all reference targets is lost, the system issues a “Lost Target” alarm. It
does, however, continues to perform positioning calculations, but these are now based on
dead reckoning only and they will become gradually more and more inaccurate. This
will result in progressively inaccurate calculations of speed and course for the own-ship.
And this in turn will result in progressively inaccurate calculations of the speed and
course of target vessels.
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5.10.4 Warnings issued by the radar positioning system
Warning Meaning Action
Fixed Target n Speed
Limit Exceeded

The calculated speed
of the fixed target has
exceeded the warning limit
for “fixed” targets. This
normally means that the
target was not stationary
after all. However, it might
mean that the target has
changed its aspect ratio,
with the result that the
centre of its radar echo
has moved (even though
the target itself is really
stationary).

• Remove the offending
target's designation as a
fixed target.

• Reset the radar
positioning system's
calculations.

Fixed Target n
Position Deviation

The calculated position of
the target deviates more
than the warning limit
permits from the position
the target had when it was
designated as a reference
target. This can occur for
the same reasons as the
previous warning message.

• Remove the offending
target's designation as a
fixed target.

• Reset the radar
positioning system's
calculations.

Fixed Target n
Update Time Limit
Exceeded

The target tracker has not
updated the measurements
for the fixed target within
the required time period.

Remove this target from the
list of fixed targets that are
included in the positioning
calculations.
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5.11 Testing the radar's tracking capability
The system has a built-in target simulator and you can use this to test the radar's tracking
capabilities.

The principle is that you enter some initial bearing and range information (relative to
the own-ship) plus a constant speed and course for five simulated AIS targets (one of
which may also have a synthetic radar echo).

This information forms the initial data for the test; because the speed and course of each
target are assumed to be constant the simulator can maintain a table of the range and
bearing values for each target that is mathematically correct at any given moment in time.

You can then use this table – which is maintained in the Known Solution dialog – as a
benchmark against which to compare the target data presented by the radar for each
simulated target. If the target data reported does not match the data in the Known
Solution dialog for that target, then the radar's tracking system is not working.

Note

When you start the simulator, the presentation of real-time radar video is replaced with
the simulated signals. A large green X appears at the bottom of the screen to indicate
this, and a small green x appears at the position of each simulated target.

For more information about the Known Solution dialog, see Known Solution on page 413.

To perform the simulation, do the following:
1 From the main menu, select Targets→Known Solution.
2 Enter initial bearing and range data for as many simulated targets as you require.

The bearing and range data is relative to the own-ship.
3 Enter SOG (Speed Over Ground) and COG (Course Over Ground) data for each

simulated target.
4 Make one of the simulated targets a radar target (a target that generates a synthetic

echo).
5 Click the Apply button to confirm the initial values you have entered.
6 Check the Test Targets Active box to start the simulation.
7 In the radar display area, select the radar target and track it.
8 Compare the tracked target's data with the data in the Known Solution dialog.
9 Compare the AIS target data with the data in the Known Solution dialog.
10 If you want to, you can simulate manoeuvres of the own-ship by selecting Manual

for the radar's heading, speed and position input, and then entering values for them
manually.
To do this you need to go to the Heading, Speed and Position dialogs, respectively.
These are accessed from the Own Ship menu Own-Ship menu on page 440).
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Note

The simulated targets behave in the same way as real targets and you can perform the
same operations on and with them as you can on real targets.

5.12 Displaying the past positions of
targets

It is possible to display an indication on the screen of the past
positionsof stably tracked targets and activated AIS targets.

To turn past position marks on or off, click the Past Pos button on the
radar dashboard (see Radar dashboard: the Target Information panel on page 81).

Five past positions are shown for each target. You can specify the time interval
represented by the distance between each past position. The available intervals are 0.5,
1 and 2 minutes. Corresponding to each possible interval is the total time represented
by the past position indication.

Because there are five past positions displayed, the total past position time shown is five
times the selected interval. The table below summarizes the available intervals and their
corresponding total past position times.

Table 14 Available intervals between past position rings

Available interval (minutes) Corresponding total of past position
time shown (minutes)

0.5 2.5
1 5
2 10

To specify the past position interval, use the drop-down menu beneath the Past Pos
button (see Radar dashboard: the Target Information panel on page 81) and move
the track-ball up or down.

Note

If there are many targets on the screen and you specify a long interval between past
positions, you might find it difficult to identify the relationship between targets and
their past position marks on the screen.
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The past position plot-rings represent the target's past geographical
positions. They are drawn on the screen (and in the chart if present)
and they represent true, not relative, positions.

Past positions are built up from scratch when the tracking of a radar
target passes from the acquisition phase to stable tracking. This
transition takes less than one minute from the initial detection of the

target. When it happens, it means that the target has satisfied the stability criteria for
tracking. The target symbol changes from the symbol for a target in the acquisition phase
to the symbol for a stably tracked target, and the vector is displayed.

Caution

The total past position time will be less than the indication in the Target
Information panel until the target has been steadily tracked for at least the
total past position time. Do not use the distance from the echo to the first
past position ring to estimate the speed of the target.

For information about how to display a trailing line with time markers indicating the past
positions of the own-ship, see Radar Themes on page 371.
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5.13 Using target trails
Target trails are similar to the CRT (Cathode Ray Tube) afterglow on old radar systems.
They provide a trail showing where there have recently been echoes on the screen.
Target trails are available only for radar echoes, not AIS targets. Also, only correlated
video can support trails.

The trails are presented in green, and echoes are presented in yellow. The selected trail
time is divided into two parts. The oldest part is presented in darker green and gives an
indication of the direction of movement even if the video disappears for one or more
scans.

Figure 39 A target trail with a vector and past position indicator

The K-Bridge Radar system stores target trails in x/y format with the same resolution
as is used to present them on the screen. The system stores them even if you have not
chosen to display them. It stores them in memory that is larger than the memory required
to present them on the screen. It does this so that when the centre of the radar area is
reset, the screen them further ahead than was previously presented.

When you increase or decrease the range scale by one step, the system recalculates the
trails to match the new resolution.

When you:
• Increase the range scale by one step, the trails will be shown closer to the own-ship.

All previously presented trails will be maintained, but there will be parts of the
screen (further out than previously presented) where the trails have to be built up
from scratch.

• Decrease the range scale by one step, the trails will be shown further away from the
own-ship. The entire screen will contain trails, but the trail resolution will be coarser
until the system has had time to build up new trails for the new range scale.
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• Increase or decrease the range scale by more than one step, the change of resolution is
so large that the system will not recalculate the existing trails but will remove them
instead. It will then have to be build them up again from scratch.

• Alter the gain, clutter, pulse length or scan correlation schemes, these alterations do
not affect any trails that existed before you made the alteration.

Caution

Trails are built up from scratch both when the K-Bridge Radar system starts
up and whenever the range scale is changed by more than one step. Do not
use trails to estimate the speed of targets during either of these periods.

5.13.1 Turning trails on and off

Trails: To turn trails on or off, click the button (see Radar
dashboard: the Target Information panel on page 81).

5.13.2 Specifying the duration of the afterglow
To specify the length of time for trails to survive on the screen, click the Trails button
to turn trails on, then use the drop-down menu beneath the Trails button (see Radar
dashboard: the Target Information panel on page 81).

The available lengths of time are 10s, 30s, 1min, 3min and 6 min.

Because the trails are stored constantly, the new setting will be used from the next time
the target is updated (in other words, from the next time the antenna passes the target's
echo).

5.13.3 Specifying true or relative trails
To choose between true and relative trails, select the True or Rel radio button to the
right of the Trails button.

The default settings (if you do not specify true of relative trails) are:
• True trails when the display is in true motion.
• Relative trails when the display is in relative motion.

True trails are the best choice if you need to enhance the visibility of moving targets.
Relative trails are the best when you are estimating whether any targets present a danger
of collision.

You can select true or relative trails independently of your selection of true or relative
motion and true or relative vectors.
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Enhancement of stable echoes is possible only when true trails are selected. Technically
this is done by making two sets of radar pictures; one is a picture in true motion
(geographically stabilised) and one is a picture in relative motion (ship-stabilised). The
picture on the screen is a selection from the true or relative picture inside the computer.
The change on the screen is thus performed in one antenna rotation.
True trails may help you distinguish weak moving targets in clutter: both the clutter and
the targets will leave trails, but the trails from the clutter will have a random character,
while those from the moving targets will have a pattern that is easily perceived.
The trails display will be maintained after a change:
• Of the own-ship position on the screen
• Of orientation (north up, course up, or head up)
• Between true and relative trails
• Of range scale of one step (up or down). However, they will be cleared if the range is

changed by more than one step. You can clear the trails from the screen (for example,
if the gain and clutter settings have left too many trails) by changing range by more
than one step: just press the Range Up arrow twice or the Range Down arrow twice
(see ECDIS range panel: viewing controls on page 88), and the trails will be cleared
(but they will automatically start to be rebuilt).

Note

True trails are not available when the display orientation is Head Up.

5.14 Collision avoidance
The proper procedures to adopt for avoiding collisions are described in text books for
navigation. This section provides a brief introduction to the subject.
The radar does not suggest any actions to take; this is always the responsibility of the
navigator.
The use of the radar must never be regarded as a substitute for other measures, such as
looking through the windows and using radio communication.

The CPA, TCPA and proximity warnings
The K-Bridge system calculates the CPA (Closest Point of Approach) and TCPA (Time
to CPA) for all tracked targets and AIS targets, and it issues a collision warning if the
CPA is less than the specified warning limit and the TCPA is between zero and the
specified warning limit. (For more information, see Alarm Limits on page 411, and also
see AIS collision warnings on page 172.)
The warning limits must always be set to appropriate values. But since the warnings
can be disabled or their limits given inappropriate values you must not use them as a
substitute for making regular personal assessments of the situation.
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Always be aware that vectors calculated by the radar may be inaccurate and that there
may be dangerous targets nearby that are not being tracked.
Also remember that other vessels may make sudden manoeuvres. This is particularly
important because the radar's vector and collision calculations assume that targets will
not make manoeuvres. You must constantly consider the possible manoeuvres that target
vessels will make, given for example the nature of the waters, the fairways, and any
interactions that you know to be taking place between target vessels.
In addition to the collision warnings issued when the CPA and TCPA for a target are
below the specified limits, the system also issues a proximity warning if a target is closer
to the own-ship than the specified proximity alarm warning limit. This is because a target
that is close to the own-ship may be a danger if a small manoeuvre is performed (or if the
vector calculation is inaccurate) even though TCPA is calculated to be:
• negative because the calculated range to the target is increasing, or
• long because the relative range is calculated to decrease slowly.
In such cases, no collision warning will issued but there is nevertheless a danger of
collision.

Target vectors and collision avoidance
You can use target vectors explicitly to estimate the danger of collision. A relative
vector of a dangerous target will point directly towards the own-ship. A true vector of a
dangerous target will cross the vector of the own-ship at some point in the future. With
true vectors, you can make the vector longer to see if any target vector will be close to
intersecting the own-ship vector at any time. (The ends of the vectors represent the
calculated future positions of the ships at a given point in time.)

Target trails and collision avoidance
Relative trails also provide a useful indication of the danger of collision. If the relative
trail of a target is close to a line through the own-ship, then there is a danger of collision.
True trails will often give a first indication that other vessels are starting to manoeuvre.

5.15 Trails compared to vectors and past
position marks

Trails are available for all targets, whereas vectors and past position marks are available
only for tracked targets and AIS targets.
True trails are an excellent indication of movement: echoes from moving targets leave
a clear and distinct trail; and the patterns of their trails can in some conditions help
you to distinguish targets from sea clutter.
Trails are updated for each antenna rotation. Therefore a manoeuvre by a target will
often be clear earlier from the trails than from the filtered vectors or the non-contiguous
past position marks.
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However, bear in mind that you will lose the trails if you change the range scale by
more than one step at a time, whereas vectors and past position marks persist through
range scale changes.

Also trails will reflect changes you make to the settings for gain and clutter, whereas
vectors and past positions marks are independent of these settings.

5.16 Special considerations for high-speed
craft

There is likely to be some degradation in the performance of the radar when the own-ship
is travelling at high speeds and you are operating at small range scales. This section
explains why.

5.16.1 Smearing of echoes in head-up presentation
The vessel travels quite a distance between each rotation of the antenna. If the vessel's
speed is 50 knots and the rotation speed of the antenna is 48 RPM, the vessel travels
25.7 m/s or 32 m/antenna rotation.

Because each point on the screen (pixel) is updated only when the antenna passes this
point, a point will be drawn in a position 32 m away from the real position just before the
antenna passes it (in Head-up presentation). This will lead to jumps in the presentation
of targets and land masses.

These jumps will be even larger when the own-ship is turning in Head-up presentation
mode.

5.16.2 Scan-to-scan correlation
Scan-to-scan correlation is not suitable in Head-up presentation because of this smearing.
Scan-to-scan correlation is correlating in the display, and targets will therefore not
correlate when travelling with high speed in Head-up. For the same reason, scan-to-scan
correlation may mask small and fast targets so that they are more difficult to detect, also
in stabilised presentation. Scan-to scan correlation is therefore not recommended when
high speed traffic is of interest; even if there will be more noise on the picture.

5.16.3 Reduced quality of true motion stabilisation
When the own-ship is manoeuvring quickly, there will be more noise on the
measurements of speed and position and obviously the vessel's movements will be faster
than normal. Both of these factors mean that the quality of stabilisation will not be as
good as when the vessel is travelling or manoeuvring slowly (or as good as it would be
on large, slow vessels). In true motion, there will also be slightly more smearing of radar
echoes than at slower speeds, especially at small range scales.
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5.16.4 Reduced quality of tracking
The vectors for tracked targets will be slightly more unstable than for slower vessels (for
the same reasons as described in the previous paragraph on stabilisation): the radar
measurements are relative to the own-ship, and the noise caused by the vessel's own
movements will be reflected in the vectors of the targets. In extreme cases, a target
loss may occur.

5.17 Radar target error sources

5.17.1 Bearing errors
The radar antenna was aligned during installation. There is normally no need for
realignment other when the antenna has been serviced. It is vital for the performance of
both the radar display and the automatic tracking that the bearing error is as small as
possible, preferably less than 0.5 degrees.

The antenna bearing alignment can best be checked when the vessel is heading straight
towards a small object that is clearly visible both visually and on the radar screen. The
object should then be exactly in the middle of the heading line on the radar display.
If not, an adjustment is needed.

The influence of the radar display is more critical than the influence on the automatic
tracking of a bearing error.

5.17.2 Biased range measurements
A biased range measurement (i.e. with a constant error) will result in a transient error in
the estimated speed and course when the target passes through the CPA, in addition to
the constant error in range. Such an error may occur if the trigger pulses from the radar
transceiver are delayed in relation to the start of the sweep. This will result in a too short
range measurement. To see the effect of such an error, see figure below:
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The target passes the own-ship with a relative speed Vx and a minimum distance of a
(CPA). The range at a given time is R, the range error is R, and the apparent range is
R+ R ( R is negative on the figure). Due to the range error, the target seems to follow a
curved relative track instead of the straight line. The errors can be quite large. As an
example, the maximum errors when the actual range a is 0.2 NM, the range error R is
-0.1 NM, and the relative speed is 10 knots, can be shown to be 5 knots in X-direction
and 1.9 knots in Y-direction. A range error is easiest to observe when sailing between
two rows of buoys. The buoys will then have a vector when passed by the own-ship.

5.17.3 Weak signals
Sometimes tracking picks up targets that have a weak echo compared to the noise in the
surrounding area. The weakness of the echo may be because the target is itself small (it
might, for example, be the echo of a small vessel or a buoy at some range), or it may
be because there is so much noise surrounding the target.

In these circumstances even when tracking is maintained its performance is reduced. The
vector is more unstable, and the calculated values for CPA and TCPA fluctuate more
than normally. This is because the noise makes it difficult for the tracker to define the
limits of the real echo. Sometimes noise is included in the calculations at one end of
the target echo, and this interferes with the position measurement for the target, which
again interferes with the speed calculation for the target.
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The noise may also lead to complete failure of the tracking. There is a possibility that
the tracker will jump to the clutter instead of the real target. It uses the strongest echo it
finds of the target's expected size and close to the target's expected position, and it treats
the position of this echo as the target's new position. If the clutter is stronger than the
target echo therefore, the tracker might mistake the echo from the clutter as marking the
new position of the target.

This swapping by the tracker from target to clutter is especially likely in heavy clutter
when a target is still new and the tracker has not yet established the real characteristics
of the target.

Because of these possibilities, you must exercise special caution when tracking targets
with weak echoes in conditions of heavy clutter.

5.17.4 Manoeuvres of the own-ship
During a manoeuvre of the own-ship, the track that the ship follows must be calculated
very accurately. The deviation between the true track and the calculated one is actually
transferred to all the targets as a manoeuvre of these targets.

A small deviation between the true track and the calculated one cannot be avoided
completely, but it can be minimized with a good position calculation. The track is based
on the series of calculated positions. Each position estimate is based on the position input
from the navigation receiver (GPS) and a dead reckoning based upon gyro and log. The
dead reckoning is based upon the pivot point of the vessel, not the conning position. The
pivot point is defined as the point which the ship moves around during a manoeuvre.

In reality, the pivot position on the ship is not constant, but will vary with load conditions
and speed (it moves forward as speed increases). However, for simplicity it is set to a
fixed value during installation. Usually the pivot point is not far from the bow.

5.17.5 Errors in the own-ship's speed
An error in the speed of the own-ship will result in a similar error in the true speed of
tracked targets, because the true speed of a target is calculated as the sum of the relative
speed and own-ship's speed. The relative speed will not be influenced by a constant error
in the own-ship's speed. A varying error will result in similar variations on tracked
targets, and the resulting vectors will be difficult to understand. Note that it is the speed
components in North/East that are reflected in the vector of a tracked target. This means
that an error in the own-ship's speed along ship will result in the wrong direction of true
vectors for all tracked targets that have a different course.
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5.18 Monitoring the performance of the
transceiver

This section tells you how to use the Performance Monitor option in the Decca radar
transceiver. For general information about preventive maintenance of the transceiver,
refer to the Kongsberg Radar Sensors (Decca) Maintenance Manual (part number
300552).
Note

The Performance Monitor must be calibrated by authorized personnel during radar
installation and after replacement of any vital parts in the transceiver, such as the
Magnetron or receiver circuitry.

5.18.1 The Performance Monitor
The Performance Monitor is an option for the Decca transceiver (it is a separate hardware
unit inside the transceiver). It enables you to detect degradation in the performance
of the transceiver.
The Performance Monitor consists of a receiver which detects and measures the
transmitted pulse, and a small transmitter which transmits a response to the received
pulse. The response is shown as 4 arcs on the screen. The arcs start at a range of 8 NM
and are 0.3NM apart. They appear in a sector of approx. 290° to 320° for S-Band and
155° to 185° for X-Band. The first arc is the strongest one and the arcs decrease in
strength by 5 dB from one arc to the next. This means that if performance is degraded by
5 dB only three arcs will be presented, if performance is degraded by 10 dB only two
arcs will be presented, and so on.
The Performance Monitor can be operated in two modes, Receive Mode (Rx Mode) and
System Mode (see Performance Monitor on page 540).
• In RxMode only the receiver of the Performance Monitor is used, and the response

is sent to the rest of the transceiver through wires. This means that in RxMode the
performance of the radar transmitter is tested.

• In SystemMode, the Performance Monitor transmits the response through the air, so
that the performance of both the transmitter and receiver are tested.

5.18.2 Checking the sensitivity of the Decca
We recommend that you run the Performance Monitor once a month.
To run it, do the following:
1 Set up the operating conditions required for the Performance Monitor:

a Set a range scale of 12 NM by using the range control (see ECDIS range panel:
viewing controls on page 88).

b Set the transmit mode to On by clicking the Scanner/Transceiver button (see
Radar dashboard: the Radar System Information panel on page 83) and
selecting Run in Radar Control dialog (see Radar Control on page 539).
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c Specify Head Up as the display's presentation mode (see Radar dashboard:
the range panel on page 79).

d Select Relative as the display's motion selector (see Radar dashboard: the
range panel on page 79).

e Select Tune: Auto (see Radar dashboard: the Radar Signal Information panel
on page 85).

f In the main menu, select Radar and in the Radar dialog Radar menu on
page 537:
i Un-check the box for Scan Correlation.
ii Check the box for Sweep Correlation.
iii Un-check the box for Sweep Integration.
iv Click the Source button, and select the radio button for Long: Pulse.

2 In the main menu, select Radar again, then select Performance Monitor.
3 Use the Video Gain control on the dashboard to adjust the gain until some

background noise is visible in the range from 8 to 10 NM (see Radar dashboard:
the Radar Signal Information panel on page 85).

4 In the Performance Monitor dialog (see Performance Monitor on page 540):
a Select Mode: Rx.
b Adjust the PM Tune setting until the arcs are presented at maximum intensity.

Coarse adjustment is performed with the slider, and fine tuning with the spin
buttons.

c Select Mode: System.
d Adjust the PM Tune setting until the arcs are presented at maximum intensity.

Coarse adjustment is performed with the slider, and fine tuning with the spin
buttons.

If fewer than three arcs are now visible, the performance of the radar has degraded by
more than 10 dB and a service engineer must be contacted. The most likely reason is
that the magnetron unit needs replacing.

The Performance Monitor will be automatically switched off when you leave the
Performance Monitor dialog or after 15 seconds without operation.

If any mute sectors are set up, they are automatically disabled while performance
monitoring is activated. They are re-enabled when performance monitoring is stopped.
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6 Working with AIS targets

This section contains the following topics:
Introduction....................................................................................................................166
AIS and radar target vectors ..........................................................................................166
The association of target vectors and data .....................................................................166
Automatic AIS target acquisition or activation .............................................................167
Displaying AIS target data.............................................................................................168
Acknowledging lost AIS targets ....................................................................................169
Viewing the own-ship's AIS data...................................................................................169
Specifying the own-ship's AIS data ...............................................................................169
Sending and receiving text telegrams and safety messages ..........................................170
AIS collision warnings...................................................................................................172
The influence of the AIS target's sensors on CPA and TCPA........................................172
The influence of the own-ship's sensors on CPA and TCPA .........................................173
AIS symbols...................................................................................................................174
Limitations of the AIS system .......................................................................................175
Installations with AIS on more than one radar ..............................................................176
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6.1 Introduction
This chapter tells you how to use the AIS facilities on the MFD system.

6.2 AIS and radar target vectors
The same length, presentation mode (True/Relative) and stabilisation mode are used for
both AIS targets and radar targets. There are however some basic differences in the
origins of the data used for presentation:

AIS vectors are based upon the reported Position, COG and SOG of the target. This
means that the accuracy of the vectors depends on the (unknown) sensors of the target.
The data reported is: Ground Stabilised, TRUE. Other presentations are calculated
from the True Ground data. In these calculations, the speed, course, set and drift of the
own-ship are used. This means that the accuracy of AIS vectors in other modes than
True, Ground Stabilised depends on the sensors of both the own-ship and the target.

Position reports from AIS targets are irregular and their frequency depends on such
factors as the speed at which the target is moving, its rate of turn and the class of vessel
concerned. The radar system extrapolates from the position reports it has received for the
target to represent a smooth movement for the target on the screen (obviously, because
of the infrequency of the position reports, some of the target's movements might not be
represented).

Radar vectors are based upon the relative positions of the own-ship and the target. First
of all relative vectors are produced, and on the basis of these other calculations involving
the speed, course, set and drift of the own-ship are performed. Radar vectors therefore
depend more on the own-ship's position, heading and speed sensors than do AIS vectors
(which depend largely on the sensors of the AIS target vessel).

You must be aware of these basic differences when assessing the traffic situation using
the vectors.

Note that it is possible for a target to appear on two radar screens and to present AIS
vectors (if available) on one and radar vectors on the other.

6.3 The association of target vectors and
data

When a target is reporting AIS data as well as being tracked as a radar target, the speed
vector is calculated in two different ways. This will give two slightly different results.

To improve readability, only one vector will be presented in these cases. This vector is
normally the AIS vector, because AIS data is normally more accurate.

The criteria used to determine whether AIS and radar data are from the same or different
targets are that the:
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• Difference in position is less than a configurable limit.
• Difference in speed is less than a configurable limit.

Both criteria need to be fulfilled for the two sets of data to be treated as coming from a
single target.

You can adjust the limit for the criteria in the AIS Association dialog (see AIS Association
on page 392).

6.4 Automatic AIS target acquisition or
activation

Figure 40 The automatic target acquisition zone

The same zone is used for the automatic acquisition of AIS targets as for that of radar
targets. The dimensions of the zone are set in the "Auto Acq" dialog (see Auto Acq
on page 389).
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If barriers (which exclude geographical areas from automatic acquisition; see Using
barrier lines on page 147) are in use for the acquisition of radar targets, they will also be
valid for the automatic acquisition of AIS targets.

Automatic activation of AIS targets cannot be enabled without automatic acquisition of
radar targets.

When a target enters the automatic acquisition zone, the response time will be a little
different for the two target types. Automatic acquisition of radar targets requires there to
have been a steady echo for at least three antenna rotations before tracking is initiated,
while AIS targets are promoted from sleeping to active instantly. Furthermore, AIS
targets have an instant vector, while several rotations must occur before a radar target
vector is drawn and can be several minutes before the radar target's vector is stable.

6.5 Displaying AIS target data
1 Use the track-ball to point to the AIS target.
2 Press the Data button on the operator panel (see The TARGET group buttons on

page 35).
The selected AIS target is indicated by a small "□" symbol centred on the target.
The data belonging to the target is displayed in a dialog box (see Target Information
on page 404). It includes:
• Target number
• Status
• Course
• Speed
• Bearing
• Range
• CPA
• TCPA
• Bow crossing range
• Time to bow crossing
Note

The range and bearing for a target are the range and bearing measured from the
own-ship's conning position. All target calculations are made from there.

3 Select Auto Update to display continuously updated information.
When Auto Update is not selected the information remains static.
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6.6 Acknowledging lost AIS targets
1 Position the cursor over the target and do one of the following:

a Select: Targets→AIS→Acknowledge Lost AIS Targets, or
b Click the Object Menu button and choose Acknowledge from the list.
The target symbol is removed from the display.

Note

Lost targets that are closer than the specified lost-target distance or that are categorized
as dangerous are not removed from the display. Instead they are indicated in their last
known position using the lost target symbol.

6.7 Viewing the own-ship's AIS data
1 Select: Targets→AIS→Display Own Ship Data.

• A window displaying the own-ship's data is shown. It includes position data and
static ship and voyage data (see Display Own Ship Data on page 385.

2 Use the scroll bar to view all available information.

6.8 Specifying the own-ship's AIS data
The following is used to specify own-ship information broadcast to other vessels and
vessel traffic surveillance systems.

6.8.1 Static ship data
This is normally done during commissioning of the AIS system.
1 Click the following sequence of buttons in the menu area: System→Passwords and

type in the service password.
2 Click the following sequence of buttons in the menu area: Targets→AIS→Set Static

Ship Data (see Set Static Ship Data on page 383).
3 Type in the ship's MMSI number and click Apply.
4 Type in the IMO number and click Apply.
5 Type in the ship's Call Sign.

• The ship's name, length and width are taken from the Ship Parameters dialog
(see Ship (tab) on page 571).

6 Type in the AIS antenna's distance From Aft.
7 Type in the AIS antenna's distance from the ship's centre line. Use negative values

for distance to port.
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6.8.2 Static voyage data
1 Click the following sequence of buttons in the menu area: Targets→AIS→Set Static

Voyage Data (seeSet Static Voyage Data on page 384).
2 Select Type/Cargo from the drop-down list.
3 Select Nav.Status from the drop-down list.

• Max Draught is taken from the Ship Parameters dialog (see Ship (tab) on
page 571).

4 Select Number of Persons Onboard using the spin buttons.
5 Type in the Destination.
6 Select Arrival (UTC) time using the spin buttons.
7 Click Apply.

6.9 Sending and receiving text telegrams
and safety messages

The AIS functionality allows you to transmit text messages to other ships and to vessel
traffic surveillance systems. Text telegrams and safety messages can either be broadcast
or sent to a specific ship. Only upper case characters can be used and the message is
limited to approx. 160 characters, depending on type of message and transmission mode.

AIS messages can either be broadcast or addressed to a single recipient. Recipients and
message senders are basically identified by their MMSI numbers. If the ship name
corresponding to the MMSI number is available, the ship name is also displayed.

When messages are received from other ships or vessel traffic surveillance systems, the
user will receive a notification. Messages are automatically stored in an UnRead folder,
waiting for the mariner's attention.

6.9.1 Managing the telegram archive
All sent or received telegrams and messages are stored in the system until deleted by the
operator.
1 Select: Targets→AIS→Text Message List (see AIS Text List on page 386).

• The displayed dialog enables you to manage the four message archives :
– Unread: Stores all received messages not yet read.
– Read: Stores incoming messages after they have been read.
– Predefined: Stores predefined messages for frequent use.
– Sent: Stores sent messages.

2 Select the archive you want to view.
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6.9.2 Reading and answering telegrams
1 Select: Targets→AIS→Text Message List (see AIS Text List on page 386).
2 Select the Unread option button.
3 Select the telegram/message you want to read using the and Left mouse button.

• The telegram/message is displayed.
4 To compose an answer do the following:

a Click the Reply button.
b Type in your answer.
c Click the Send button.
• In some cases the sender may have requested that you acknowledge receiving

the telegram/message.
5 To acknowledge it click the Acknowledge button.

6.9.3 Creating new telegrams
1 Select: Targets→AIS→Text Message List (see AIS Text List on page 386).
2 Select the Text Telegram or Safety Message option button.
3 Select Broadcast or type in the recipients MMSI number.
4 Select Acknowledge Req. if you want the recipient to acknowledge receiving the

telegram/message.
• Acknowledged messages will appear in the Unread message archive, when

acknowledged. Broadcasts can not be acknowledged.
5 Type in your telegram/message.
6 Click the Send button.

6.9.4 Creating pre-defined telegrams
The system allows you to store a number pre-defined messages that you expect will
be frequently used.
1 Select: Targets→AIS→Text Message (see AIS Text Message on page 387).
2 Select the Text Telegram or Safety Message option button.
3 Select Broadcast or type in the recipients MMSI number.
4 Select Acknowledge Req. if you want the recipient to acknowledge receiving the

telegram/message.
• Acknowledged messages will appear in the Unread message archive, when

acknowledged. Broadcasts can not be acknowledged.
5 Type in your telegram/message.
6 Click the Save Predef. button.
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6.9.5 Sending pre-defined messages
1 Select the target you want to send a predefined message to using the track-ball

and Object Menu button.
2 Select Send Predef Message from the displayed list.

• Your list of predefined messages is displayed.
3 Double-click on the message you want to send using the and Left mouse button.
4 Click Send.

6.10 AIS collision warnings
The same formula is used for calculations on AIS targets and radar targets.

The alarm limits are also identical for AIS targets and radar targets, so that a target
should initiate a collision warning at the same time, whether it is a reported AIS target
or a plotted radar target.

There may however be some differences, because different sensors are used: the CPA
and TCPA calculations for AIS targets depend on the position, course and speed reported
by the other ship; the calculations for radar targets are independent of the sensors on
the target vessels.

For information about collision avoidance, see Collision avoidance on page 157.

6.11 The influence of the AIS target's
sensors on CPA and TCPA

This section provides information that you need to consider in relation to the CPA and
TCPA for AIS targets.

6.11.1 Position sensors (GPS)
The relative position of the AIS target as it appears on the screen depends on both the
position of the own-ship and the position of the AIS target. Position data for both vessels
also obviously affects the calculated CPA and TCPA.

6.11.2 Ground speed sensors (bottom log)
The vector of an AIS target is based upon the SOG and COG reported over the AIS
system. The source and accuracy of this data are not directly known. The target's
speed-log may contribute but position data from a GPS system will often have been
used to calculate COG and SOG (Speed Over Ground): the own-ship's CPA and TCPA
calculations are heavily dependent on this information from the AIS target.
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6.11.3 Water speed sensors (water log)
The vector of an AIS target is based upon the SOG and COG reported over the AIS
system. The source and accuracy of this information is not directly known. The
speed-log may contribute but often position data from a GPS system will be used to
calculate COG and SOG (Speed Made Good). An AIS target's water speed is not
reported over AIS, therefore the influence of the AIS target's water log is not significant.

6.11.4 Heading sensors (gyros and compasses)
The heading sensor is normally not used for the calculation of SOG and COG, and will
not influence the position or vector of the AIS target. The heading sensor of the other
ship will be used to determine the heading line and turn indication of the AIS target, but
it will not contribute to the CPA/TCPA calculations.

6.12 The influence of the own-ship's
sensors on CPA and TCPA

For AIS targets, the data reported comes from each target's own sensors, not from the
sensors belonging to the own-ship. The data used for vector presentation is the target's
SOG, COG and position.

The presentation of true, ground-stabilized AIS vectors depends only on the target's
sensors, and not at all on the own-ship's sensors.

Note

However, the relative location of the vector depends on the position of the own-ship.

The presentation of relative and/or water-stabilized AIS vectors is determined by data
from both the target and the own-ship. The own-ship's sensors for speed, position and
heading will be involved. They will also influence the CPA and TCPA calculations.

6.12.1 Position sensors (GPS)
The position of the own-ship and the position of the other ship obviously both play a
role in determining the relative positions of the vessels as shown on the screen, and they
both influence the calculated CPA and TCPA for AIS targets. Changes in the vessels'
positions over time are also used as input to the navigations system's Kalman filter; they
therefore affect the COG and SOG calculations for the own-ship.

6.12.2 Ground speed sensors (bottom log)
The own-ship's bottom log is used as input to the Kalman filter. Also, along with changes
in the position data, the bottom log is used to calculate the own-ship's COG and SOG. The
bottom log therefore influences the CPA and TCPA calculations in respect of AIS targets.
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6.12.3 Water speed sensors (water log)
The water log is used as input to the Kalman filter and it is also used to calculate the
course and speed through water. Because the CPA and TCPA calculations for AIS targets
are based on ground-stabilised data, the water log does not affect the CPA and TCPA
calculations. However, dynamic fluctuations in water speed measurements will affect the
COG and SOG calculations indirectly through the Kalman Filter.

6.12.4 Heading sensors (gyro compasses)
The heading of the own-ship will not affect the vectors of AIS targets, although it will
affect the vectors of ARPA targets. A permanent offset in the heading will not affect the
calculation of the CPA and TCPA for AIS targets, although a dynamic error will cause a
dynamic error in the CPA and TCPA calculations.

6.13 AIS symbols
If sensor failure on the own-ship or an AIS target (or if missing data for any other
reason) causes the CPA and TCPA calculations to be uncertain, the AIS symbols for the
affected targets will be dashed.

For information about the radar target symbols, see Radar target symbols on page 145.

Table 15 Some AIS symbols as they appear on the display

Sleeping AIS target: Initial position reports received from other ships
result in "sleeping" targets on the display. Sleeping targets display a
minimum of information, revealing position and course.
Active AIS target: Active targets reveal the ship's position, speed,
heading and course. Vector length for other ships corresponds to the
length set for the own-ship's vector.

Target with target data displayed: The symbol indicates that data
for this target is currently displayed in the Target Info dialog (see
Target Information on page 404).

Lost target: Targets lost from the air that are nearer than a set
distance, or that are categorised as dangerous, will not be removed
from the display. These are indicated in their last known position
as a lost target.
Dangerous target: Targets having a TCPA and a CPA of less than the
user-specified values, are considered to represent a collision danger
and will be indicated using a red blinking symbol.
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Table 15 Some AIS symbols as they appear on the display (cont'd.)

Target Identification: The name of the target vessel (if available) or
its MMSI number appears close to the target symbol.

Associated target (showing as AIS): This symbol indicates an
associated (fused) AIS and radar target that is displaying as an AIS
target. For information about making associated targets display as
either AIS or radar targets, see AIS Association on page 392.

Associated target (showing as radar): This symbol indicates an
associated (fused) AIS and radar target that is displaying as a radar
target. For information about making associated targets display as
either AIS or radar targets, see AIS Association on page 392.
Aid to navigation: This symbol indicates the location of a landmark
or buoy that is signalling to shipping from an active transponder.

Aid to navigation (virtual): This symbol is for a virtual aid to
navigation: it contains a V (for virtual) in addition to the + sign
inside the aid-to-navigation symbol. The symbol appears on the
chart only; no active transponder at a physical location is associated
with it.
Base station: A shore-based station providing text messages,
time synchronization, meteorological, hydrological or navigation
information, or data on the positions of other vessels.
Search and rescue aircraft: An aircraft flying with AIS equipment
on-board.

Search and rescue (SAR) transponder: To acknowledge the signal
from a SAR transponder, select Targets→AIS→Acknowledge SAR
Transponder (see AIS on page 382).
For information about detecting search and rescue transponders, see
Operating marine radars for SART detection on page 352.

For information about search and rescue operations generally, see
Performing search and rescue operations on page 351.

6.14 Limitations of the AIS system
The K-Bridge Radar has the capacity to handle 1000 AIS targets in addition to 100
ARPA targets. If more than 1000 AIS targets are received, the alarm "Too many AIS
targets" is issued.
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6.15 Installations with AIS on more than
one radar

If AIS is enabled on more than one radar system on the bridge, the number of vectors
displayed – and the vector types displayed – might be different on the different consoles.
When you activate or de-activate a target, the effect of this is to activate or de-activate it
only on the console you are using; targets displayed on any other consoles on the bridge
are not affected. Similarly, target fusion occurs independently on each console.
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7 Managing charts

This section contains the following topics:
Chart formats .................................................................................................................178
C-Map CM-93 edition 3 charts ......................................................................................178
C-Map CM-93 edition 2 charts ......................................................................................185
S57/S63 charts from PRIMAR or AVCS.......................................................................193
HCRF charts ..................................................................................................................203
Defining the chart regeneration area ..............................................................................208
Displaying charts on the radar display...........................................................................208

For information about:
• Manipulating chart objects, see Using and controlling chart objects on the screen

on page 126.
• Zooming into and out of charts (see Zooming into and out of charts on page 128).
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7.1 Chart formats
The K-Bridge MFD system currently supports the following
chart formats:
• S57 Ed.3 official vector charts (unencrypted)
• S57 Ed.3 official vector charts encrypted according to S-63

encryption scheme.
• CM93 Edition 2 vector charts from C-Map Norway.
• CM93 Edition 3 vector charts from C-Map Norway.
• C-Map ENC official vector charts distributed as a compact

SENC (system ENC)
• HCRF raster charts: either ARCS charts from the United

Kingdom Hydrographic Office or Seafarer charts from
the Australian Hydrographic Office (ARCS charts are not
available in the Radar application)

• NSKV vector charts from Norwegian Hydrographic office.
• PL2 vector charts, proprietary format.
Charts must be purchased/subscribed to from the individual
suppliers. As charts are updated frequently, subscribing to
updates will normally be essential.

Charts provided with the K-Bridge MFD system are a chart of
the whole world at a scale of 1:20,000,000 and a chart covering
the area to be used for the sea trial.

Follow the procedures in the next few sections for the particular
formats you are using.

7.2 C-Map CM-93 edition 3 charts
Caution

Chart database maintenance may interfere with the radar display and should
only be carried out when the radar picture is not needed.

CM-93 edition 3 conforms to the IHO S57 edition 3 format and is manufactured by
C-Map. The C-Map CM-93 Edition 3 chart database contains the same charts as are
available in CM-93 Edition 2, but the format is different and the handling inside the
K-Bridge system is different. All CM-93 Edition 3 charts are available on a single
CD-ROM or DVD. Both official HO ENC charts and unofficial non-ENC charts may be
included.
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The most common C-Map Edition 3 database is called "Professional+" and contains
charts for the whole world. K-Bridge Radar allows you to install the whole database, and
license only the charts that you want to use.

7.2.1 Configuring the chart database
To create the chart database for the CM-93 edition 3 charts, perform the following.
This need only to be done once.
1 Select System→Passwords.
2 Type in the user password and click Open.
3 Select Chart→Reconfigure Chart Database (see Chart Type Setup on page 532 ).

• A list of available databases is displayed.
4 Click Add New.

• Available database types are shown, one button for each type.
5 Click C-Map Professional+ (DVD).

• The C-Map CM-93 Edition 3 Database is added to the list of available databases.
This databse is called Professional+ and uses a two-letter mnemonic CP.
If you need to use the CD version, the database is calledWorld and uses the two
letter mnemonic CW.

• By default the system is set up to load chart databases across the Local Area
Network from a particular K-Bridge system. You can however configure the
system to load from any K-Bridge system or from a CD or DVD. To check or
change where the databases are loaded from, do the following:

6 Click Change Mirror.
7 Select Install from Local CD or Install from Remote Station and select unit from the

drop down menu.
8 Click Apply Changes twice to confirm the new settings, or Cancel to return.
9 Power the console down and then power it up gain.

• This is necessary for the changes to take effect.

7.2.2 Installing charts
When the software has been set up properly, you must load the database must be loaded
and enter the license code.
1 Select System→Passwords.
2 Type in the user password and click Open.
3 Select Chart→Chart Types (see Chart Types on page 477).
4 Click the Mng button next to CP:Professional+.

• The dialog you see contains several tabs. An Install tab is available if the system
is configured to load charts from the DVD drive , and aMirror tab is available if
the system is configured to load charts from another console.
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5 Installing from the DVD drive
Use this procedure if the Install tab is present in the dialog you are viewing;
otherwise go to step 8.

6
• The systems checks the DVD and compares it with the installed version, if any.

An information message is displayed.
a Insert the C-Map CM-93 edition 3 DVD into the drive.
b Select the Install tab.
c Click Check CD.
d Click Install Chart Database.

Note

This operation will disable normal operation of the MFD console for about 10
minutes. It might also temporarily affect the performance of other applications
using the Local Area Network.

7 Go to step 9.
8 Installing from another console or from a K-Bridge Planning Station

Use this procedure if the Mirror tab is present in the dialog you are viewing. (The
mirror tab is only displayed when the system is configured to load chart databases
from a K-Bridge ECDIS, MFD or K-Bridge Planning Station system. On systems
that are configured to load chart databases from a local CD-ROM or DVD drive, the
Install tab is displayed instead; see Install tab on page 503.)
a Select the Mirror tab.
b Click Chk.

The system checks the database in the source system and compares it with the
currently installed version (if any). An information message is displayed.

c Click Install Charts.
Note

This operation will disable normal operation of the MFD console for about 10
minutes. It might also temporarily affect the performance of other applications
using the Local Area Network.

9 Select Chart→Chart Types.
10 Select the CP:Professional+ database using the check box on the left side.
11 Switch back to the ECDIS application.
12 Click the Chart button in the range panel (see ECDIS range panel: viewing controls

on page 88).
• Verify that a chart is displayed.

Overview charts at a scale of 1:20 000 000 and 1:3 000 000 are available without
requiring a license code; these can be used as a background for larger radar
ranges.
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• If this is the first time a CM-93 Edition 3 database has been defined on the
console, you will need to enter the serial number of the console. K-Bridge
consoles have a six digit serial number (K-Bridge MFD SN.: 23xxxx).

Figure 41 Where to find the console serial number

13 Open the front cover of the console and note down the serial number found on the
left side (see the figure above).

14 Select Chart→Install C-Map SDK.
15 Select the Reinitialize License option.
16 Type in the serial number.
17 Click Install.

This installs the C-Map edition 3 software into the system.
18 Select Chart→Chart Types→CP Professional+→Mng.
19 Select the General tab.
20 Click License.
21 Insert a USB memory stick into the computer.
22 Click C-Map User ID to Medium.
23 Select the area(s) you want to licence charts for.
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Figure 42 C-map zone definition

The charts are grouped in Levels according to the scale:

Table 16 C-map chart level definition

Level Scale
Z 1 : 20.000.000
A 1 : 3.500.000 ‒ 1 : 1.500.000
B 1 : 1.500.000 ‒ 1 : 500.000
C 1 : 500.000 ‒ 1 : 150.000
D 1 : 150.000 ‒ 1 : 50.000
E 1 : 50.000 ‒ 1:15.000
F 1 : 15.000 ‒ 1 : 5.000
G Larger than 1 : 7.500

24 Send the file by e-mail to "license@c-map.no" and include information to tell them
the area(s) you want to licence charts for. Or contact them at:
• C-MAP NORWAY A/S

Hovlandsveien 52
P.O.Box 212
N-4379 Egersund NORWAY
Tel.: +47 51 46 47 00
Fax: +47 51 46 47 01
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• C-Map will send you a licence code for each zone or area.
25 Insert the C-Map CM-93 edition 3 CD into the drive.
26 Select Chart→Chart Types→CP Professional+→Mng.
27 Select the General tab (General tab on page 497).
28 Select Zone License or Area License and the zone or area from the drop-down menu,

and type in the 16-character code for the license into the text field.
29 Click Add.

• The new license code is registered.
30 Go back to step 30 and repeat this procedure for each license code.

Without license codes only Z-level and A-level charts are available for viewing.
31 If you do not see the new charts, restart the system.

7.2.3 Using multiple chart databases
When several chart databases are present, each database can be enabled/disabled to
provide the desired chart selection. Based on the radar range the best matching chart
from enabled databases are chosen. To enable or disable a chart, perform the following:
1 Select Chart→Chart Types (see Chart Types on page 477).
2 Use the check box on the left side of each database type to enable or disable it.
3 Select Fill in Background Chart to enable the background to be filled in for the

display of lower scale charts. This is particularly useful when the foreground chart
only covers part of the screen.

7.2.4 About CM-93 edition 3 chart options
A number of options are available to control the display of CM-93 edition 3 charts.
Perform the following:
1 Select Chart→Chart Types→CP Professional+→Mng.
2 Select the Settings tab (see Settings tab on page 506).

• Traditional Symbols: Selects between simplified and traditional symbols.
• Plain Boundaries: Selects between complex and plain line styles to designate

the boundary of an area.
• Do Not Use S52 for C-Map Ch.: When selected, dangerous objects are displayed

using normal cartography symbols instead of S52 symbols, to reduce clutter in
older charts.

7.2.5 Updating charts
Use the following procedure to install updates of the CM-93edition 3 database:
1 Select System→Passwords.
2 Type in the user password and click Open.
3 Select Menu→Chart→Chart Types.

381287/A 183



K-Bridge Multi-functional Display Unit

4 Click the Mng button next to CP:Profesional.
• The dialog you see contains several tabs. An Install tab is available if the system

is configured to load charts from the CD drive, and aMirror tab is available if the
system is configured to load charts from another console.

5 Updating from the DVD drive
Use this procedure if the Install tab is present in the dialog you are viewing;
otherwise go to step 6.
a Insert the C-Map CM-93 edition 3 DVD into the drive.
b Select the Install tab.
c Click Check CD.

The system checks the DVD and compares it with the installed version, if any.
An information message is displayed.

d Click Install Chart Database.

Note

This operation will disable normal operation of the MFD console for about 10
minutes. It might also temporarily affect the performance of other applications
using the Local Area Network.

6 Installing from another console or from a K-Bridge Planning Station
Use this procedure if the Mirror tab is present in the dialog you are viewing. The
mirror tab is only displayed when the system is configured to load chart databases
from a K-Bridge ECDIS, MFD or K-Bridge Planning Station system. On systems
that are configured to load chart databases from a local CD-ROM or DVD drive, the
Install tab is displayed instead (see Install tab on page 503).
a Select the Mirror tab.
b Click Chk.

The system checks the database in the source system and compares it with
the installed version (if any) on the target system. An information message
is displayed.

c Click Install Charts.

Note

This operation will disable normal operation of the target MFD console for
about 10 minutes. It might also temporarily affect the performance of other
applications using the Local Area Network.
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7.3 C-Map CM-93 edition 2 charts
This section tells you how to install and manage C-Map edition 2 digital charts.
It includes a reference section that describes the menus and dialogs for managing,
removing and installing these charts.
Caution

Chart database maintenance may interfere with the radar display and should
only be carried out when the radar picture is not needed.

CM-93 Edition 2 charts conforms to the IHO S57 edition 2 format and is manufactured
by C-Map. All C-Map CM-93 edition 2 charts are available on three compact discs. To
use the charts you need a authorization code from C-Map. The world is divided into nine
zones (see below), and each zone is again divided into a number of areas. The license
number defines which zones or areas you are able to use.

Figure 43 C-map zone definition

The charts are grouped in Levels according to the scale:

Table 17 C-map chart levels

Level Scale
Z 1 : 20.000.000
A 1 : 3.500.000 ‒ 1 : 1.500.000
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Table 17 C-map chart levels (cont'd.)

Level Scale
B 1 : 1.500.000 ‒ 1 : 500.000
C 1 : 500.000 ‒ 1 : 150.000
D 1 : 150.000 ‒ 1 : 50.000
E 1 : 50.000 ‒ 1:15.000
F 1 : 15.000 ‒ 1 : 5.000
G Larger than 1 : 7.500

Z level charts include functions for installing, updating and deleting charts.

7.3.1 Mirroring CM-93 edition 2 charts from the K-Bridge
MFD Unit
You can mirror (in other words, copy) C-Map CM-93 edition 2 charts on to one console
from another or from a K-Bridge Planning Station.

1 At the console that is to receive the new charts, select Chart→Chart
Types→C-Map→Mng.

2 Select the Mirror tab (if not already selected).

• Before installing the new charts, you can modify the chart area graphically by
using the cursor or by typing in the co-ordinates of the area required.

• The following functions are available:

– Remove Charts Outside Area.

– Remove Old Charts.

– Force Regeneration (if you select this option, the console will clean up the
chart database).

• To have the same database available in the console that is receiving the charts as
in the source console:

a Do not restrict the chart area.

b Enable removal of Old Charts.

3 Click Install charts.

• The charts on the receiving console are updated to the latest versions available
in the source console.
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7.3.2 Maintaining a stand-alone chart database

7.3.2.1 Installing charts

To install C-Map CM-93 Edition 2 charts you will need CD-ROM(s) containing the
charts and an authorization code from C-Map. To obtain the authorization code you must
first define which chart zones or areas you need. Perform the following:
1 Contact C-Map to enter into an agreement with them and to obtain CD-ROM(s)

for the zones relevant to you.
• C-MAP NORWAY A/S

Hovlandsveien 52
P.O.Box 212
N-4379 Egersund NORWAY
Tel.: +47 51 46 47 00
Fax: +47 51 46 47 01
E-mail: license@c-map.no

2 Insert the C-Map CM-93 Edition 2 CD-ROM into the drive. If you received more
than one you can use any of them at this point.

3 Select Chart→Chart Types→C-Map→Mng.
4 Select the zones or areas you need.
5 Click Authorize.

• The system generates a User code defining the zones or areas you have selected.
6 Write down the code.
7 Send the code by e-mail to "license@c-map.no", call them at +47 51 46 47 00, or

fax them at +47 51 46 47 01.
• C-Map will respond by returning an Authorisation code. To enter the code into

the system perform the following:
8 Select Chart→Chart Types→C-Map→Mng.
9 Click the New License button (with the CD-ROM still in the drive).
10 Enter the user code and the authorization code and click Authorize.

• The charts can now be loaded into the system.

7.3.2.2 About navigation and overview working sets

When you install the C-Map CM-93Edition 2 charts, they are converted to a proprietary
format. If there are a lot of charts this can take a considerable time - even hours. To
reduce the time, charts that are not required need not be converted. For any given area
several charts at different scales will normally be available. We have defined two
categories of charts:
• Navigational working set: These are the charts you need to enable you to navigate

on a particular voyage. Select all of the scale levels you require (Z, A, B, C, D, E,
F and/or G).
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• Overview working set: These are charts covering areas outside the areas covered
by the navigational working set. For this category of charts, we recommend you
install only charts of scale level A (1:3.500.000 ‒ 1:1.500.000) and/or B (1:1.500.000
‒ 1:500.000).

7.3.2.3 Installing all charts in a zone

1 Select Chart→Chart Types→C-Map→Mng.
2 Select the Install tab.
3 Click Set to Licensed.

• This selects all charts available according to your
Authorization Code.

4 Click Set to Nav. Working Set.
5 Click Install charts.

• The installation process may take some time, depending
on the number of charts specified. An indicator is
available to monitor the progress.

7.3.2.4 Installing a selection of charts

1 Select Chart→Chart Types→C-Map→Mng.
2 Select the Install tab.
3 Click Set to Licensed.

• This selects all charts available according to your
Authorization Code.

4 Click Set to Nav. Working Set.
5 Click Install charts.

• The installation process may take some time, depending
on the number of charts specified. An indicator is
available to monitor the progress.

If you do not need all the charts in a zone to navigate on the up-coming voyage, specify
the Working Set in the following way:
1 Select Chart→Chart Types→C-Map→Mng.
2 Select the Install tab.
3 Under Navigation Working Set; select Edit.
4 Select a large chart scale, for instance 1:20.000.000

• A grey grid is overlaid the chart.
5 Each rectangle in the grid can be selected by pointing to it and clicking the Left

mouse button on the input panel. The rectangle is grey when selected.
6 Select the Navigation Working Set.
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7 Select the required chart levels.
8 Under Overview Working Set; select Edit.

• A green grid appears as on overlay on the chart. Each rectangle in the grid is
select-able; click in a rectangle with the Left mouse button to select it. The
rectangle turns green when selected.

9 Select the Overview Working Set.
10 Select the required chart levels.
11 Click Install charts.

• The installation process may take some time, depending on the number of charts
specified. An indicator is available to monitor the progress.

7.3.3 Updating charts
If you subscribe to chart updates, C-Map will from time to time send out new CD-ROMs.
To install the chart updates perform the following:

Figure 44 Specification of a working set

1 Insert the new CD-ROM into the drive.
2 Select Chart→Chart Types→C-Map→Mng.
3 Select the Install tab (if not already selected).

• Before installing the new charts, you can modify the chart area graphically by
using the cursor or by typing in the co-ordinates of the area required.

• The following functions are available:
– Remove Charts Outside Area.
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– Remove Old Charts.
– Force Regeneration (if you select this option, the console will clean up the

chart database).
4 Click Install charts.

• The working set is automatically updated with the new charts from the CD-ROM.

7.3.4 Deleting charts
The chart delete function provides means to delete all charts, old charts or charts located
outside the navigation working set. Perform the following:
1 Select Chart→Chart Types→C-Map→Mng.
2 Select the Delete tab.
3 Click the button for the selected option.

7.3.5 Reference information
This section describes the dialog for managing, removing and installing C-Map CM-93
edition 2 charts.

The path to the dialog is: Chart→Chart Types→C-Map→Mng.

The dialog contains four tabs. They are for:
• Copying charts from another navigator station on the same network, see Mirror tab

on page 190.
• Monitoring the loading of a chart, see Process tab on page 192.
• Deleting charts from the system, see Delete tab on page 192.
• Configuring elements of the chart display, see Set tab on page 192.

7.3.5.1 Mirror tab

When the console is connected to a local area network, you can use this dialog to copy
charts to the console from another console or from a K-Bridge Planning Station.

The path to the tab for this is: Chart→Chart Types→C-Map→Mng→Mirror (tab).

The tab contains the following elements:
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Chart Source: Select the unit (K-Bridge Planning or K-Bridge
ECDIS) that you want to copy charts from.

Chart Area: Specify the chart area entering the latitude and
longitude values for upper left and lower right corner of the area.

All Charts: Selects all charts available in the unit you are copying
from.

Get Cursor: Click this button to specify a chart area by pointing
and dragging a rectangle in the chart using the track-ball and
Left mouse button.

Chart Levels: Different charts are used for viewing at different
scales. Select the scale ranges you want installed:
• A: 1:3.500.000 ‒ 1:1.500.000
• B: 1:1.500.000 - 1:500.000
• C: 1:500.000 ‒ 1:150.000
• D: 1:150.000 ‒ 1:50.000
• E: 1:50.000 ‒ 1:15.000
• F: 1:15.000 ‒ 1:5.000
• G: > 1:7.500
Remove Charts Outside Area: Removes all charts outside the area
specified above.

Remove Old Charts: Removes old charts when newer charts are
available.

Install Charts: Installs selected charts.
When you have clicked Install Charts, the tab changes to a
statement of how many charts will be copied. The tab now
contains the following buttons:

Copy Charts: Click to start the copying process.

Copy Charts: Click to cancel the copying process.
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7.3.5.2 Process tab

Use the process tab to monitor the loading of charts (it includes a
progress indicator).

The path to the tab is: Chart→Chart Types→C-Map→Mng→Proc.
(tab).

The tab contains the following elements:

Information: Presents information about the ongoing chart
operation.

Cancel Generation: Stops the installation of further charts after
the chart that is currently loading has finished loading.

7.3.5.3 Delete tab

Use this tab to delete charts from the system.

The path to the tab is: Chart→Chart
Types→C-Map→Mng→Delete (tab).

Delete all Charts: Deletes all loaded charts.

Delete Old Charts: Removes all charts that have not come from
the CD currently in the CD-reader.

Delete Charts Outside Working Set:Click the button to delete all
charts outside the current Working Set.

Cancel: Stops deleting of old charts.

7.3.5.4 Set tab

Use this tab to select S52 symbols and to configure chart
coverage.

The path to the tab is: Chart→Chart Types→C-Map→Mng→Set
(tab).

The tab contains the following elements:

Do not use S52 for C-Map Charts: When selected, dangerous
objects are displayed using normal cartography symbols instead
of S52 symbols, to reduce clutter in older charts.

Coverage: Click the button to specify the levels of detail you
require in the chart coverage.
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7.4 S57/S63 charts from PRIMAR or AVCS
Regional Electronic Navigating Chart Coordinating Centres (RENCs) work on behalf
of national hydrographic offices to provide coordinated chart distribution, quality
assurance and service improvement. They normally provide ENC charts in a common
encrypted format designated as S63. One of the most well-known RENCs is PRIMAR
in Stavanger, Norway (see www.primar-stavanger.org).
PRIMAR and AVCS charts can be installed on to one or several operator stations.
If you choose to have PRIMAR or AVCS charts installed on several stations, a convenient
way to deploy charts is to install them first on to a Planning Station and then to mirror (in
other words, copy) them over the network to the individual operator stations.

7.4.1 Preparing your station(s) for the installation of
S57/S63 charts
To install PRIMAR™ S57/S63 charts you will need a licence code from Kongsberg
Maritime (for each station that you intend to use the charts on) and the charts and chart
permits from PRIMAR (which will typically be contained on a CD-ROM or DVD).
This section will guide you through the process of obtaining the license codes from
Kongsberg Maritime and the charts and chart permits from PRIMAR. It will also show
you how to prepare the operator stations for the chart installation. Please follow all the
instructions in this section for every station that you intend to have S57/S63 charts
installed on.
If you intend to use the mirroring feature to load the charts on several stations, you must
decide which station (for example, the Planning Station) will be the mirror host. Make
sure you follow the procedures in this section for the host station before attempting
to configure any of the clients.

7.4.1.1 Verifying software, hardware and licenses

To use S57/S63 charts, you must ensure that:
• The C-Map SDK is installed.
• A C-Map e-Token dongle is inserted. (The e-Token dongle must be inserted at all

times while you are installing or using the charts. Do not remove it.)
• ECDIS (or Planning Station software) is running on the operator station you are using.
In addition to the software and the dongle you will need a license that is generated
specifically for each e-Token dongle, based on a 16-character hexadecimal code. Each
license belongs uniquely to one dongle.
Normally this will all be taken care of during commissioning of the vessel. However, to
verify that the station is provided with the necessary license, follow these steps:
1 Make sure that the e-Token dongle is inserted.
2 Log into the system using the Service password.
3 Select Chart→Chart Types.
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4 Click theMng... button next to the label for the chart database you are updating.
A default chart database framework will normally be installed during
commissioning, and an entry for PRIMAR charts will therefore be listed in the
Chart Types dialog. However, if no PRIMAR database framework is listed, or if for
any reason you are not certain whether the existing database framework is correct,
create one now; see Creating a database framework on the computer on page 194.
When you have finished, start this section again from step 1.

5 In the Settings tab, click the C-Map Software License button.
The license will be appear in the list of Registered Licenses with the name
V3CATMGR.
If for any reason the S57/S63 license for your e-Token is missing, do the following:

a Request the 16-character hexadecimal code (if you
do not have it yet) by sending an e-mail, quoting the
company name and number printed on your e-Token, to
km.support@kongsberg.com.
You can view the company name and number as printed on
your e-Token by selecting Chart→Install C-Map SDK (you
can do this without going on to re-install the SDK).

b When you have the code, select V3CATMGR from the Select
Collection drop-down menu.

c Enter the 16-character hexadecimal code for the dongle and
press the Add button.

d Make sure that the V3CATMGR license has appeared in the
list.
If it has not, repeat the previous step in case you entered the
16-character code incorrectly.

7.4.1.2 Creating a database framework on the computer
1 Select Chart→Chart Types.

If there is a PRIMAR or AVCS database in the list, this indicates that a PRIMAR
or AVCS database framework has already been created on the computer. If you
are not certain whether this previous installation has been carried out correctly,
we recommend that you remove the PRIMAR or AVCS database and re-install
it. However, if you decide to keep the current installation you should verify the
configuration of the station (as single station, mirror host or client), and whether
the PRIMAR charts and chart permits are loaded. Then, resume the installation
procedure where necessary.

2 Select System→Passwords and enter the User password.
3 Select Chart→Reconfigure Chart Databases→Add New.
4 Click on the database you want to install, for example, click S63 Database

(Primar/AVCS).
5 Configure the computer as a single station, a mirror host or a mirror client.
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If you intend to:
• Install the charts on to a single operator station, or if you intend to use removable

media (CD-ROM, DVD, USB stick) to load the charts on to multiple operator
stations individually (this is an alternative to using the mirroring feature), then
skip this step altogether and go to step 6.

• Use the operator station you are currently working at as a host for a mirror
operation (in other words, if you intend to copy the charts from this computer to
other computers on the network), do the following:
a Click Change mirror.
b Check the Use as Mirror Host checkbox.
c Click Apply Change.

• If you intend to use the operator station you are currently working at as a mirror
client (in other words, if you intend to copy the charts from the mirror host to this
computer), do the following:
a Click Change mirror.
b Make sure that the Use as Mirror Host check-box is unchecked.
c Click on the drop-down box under Install from Remote Station.
d Select the host from the list.
e Select the radio button Install from Remote Station.
f Click Apply Change.

6 In the Chart Type Setup dialog:
a Click Apply Changes.
b Confirm by clicking Apply Changes again.
The system creates the database framework.

7 Restart the system:
a Select System→Shutdown.
b Click Restart Computer.
c Confirm by clicking Restart Computer again.

7.4.1.3 Obtaining chart permits from PRIMAR
1 In the ECDIS (or Planning Station) application, select Chart→Chart Types.
2 Click the Mng... button next to the label for the chart database whose permits you

are updating (for example, PR: Primar).
3 In the General tab, click the License button.

The system generates the user permit for the computer. It is displayed as a
28-character string.

4 Write down the character string that appears in the User Permit field.
This character string will be used by PRIMAR™ – when you contact them – to
generate a chart permit for each chart you intend to use on the computer.

381287/A 195



K-Bridge Multi-functional Display Unit

Since this chart permit provided by PRIMAR™ will be machine-specific, you need
to write down the user permit character string for every computer you are intending
to use the charts on.
So before proceeding to the next step – which is to send the strings to PRIMAR™ –
write down the user permit character string for each navigation operator station and
Planning Station computer that you are going to use the charts on.

5 Send the character string(s) you wrote down to:
PRIMAR™
Lervigsveien 32
P.O.Box 604001 Stavanger, Norway
Phone:+4751939500
Fax:+4751939501
E-mail: info@primar.org
PRIMAR™ will send the chart permits you require either by post or e-mail. For
each computer, the permits will be contained in two files called "PERMIT.TXT"
and "ENC.PMT". (If you receive permits by e-mail, save the files on a disk or
USB stick.)

7.4.2 Installing S57/S63 charts on to a single operator
station or a mirror host from removable media
You should by now have received the chart permits and the charts themselves (typically
contained on a CD-ROM) from PRIMAR. If so, you ready to install them on to your
operator station(s).
If you intend to mirror the charts on to several operator stations, install them on to the
mirror host first (by following the instructions in this section), then load them on to the
clients (see Mirroring S57/S63 charts on to several operator stations on page 198).
Although it is not recommended, you can install the charts individually on to several
stations (in other words, without mirroring). To do so, just follow the instruction in this
section for each operator station and use removable media.
You might prefer to copy the charts from the CD-ROM or DVD on to a USB memory
stick before starting the installation process. Both charts and permits can be loaded on
to an operator station from a USB stick. Always make sure the USB stick is virus-free
before inserting it in the computer.

7.4.2.1 Load the chart permits on to the computer
1 Insert the medium (for example, a CD-ROM, DVD or USB stick) containing the

chart permits into the computer.
2 Select Chart→Chart Types.
3 Click the Mng... button next to the label for the chart database whose permits you

are updating (for example, PR: Primar).
4 In the General tab, click the License button.
5 Use the drop-down menu to browse the specified medium for the folder containing

the permits.
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If you have licenses for several stations, make sure you know which license file
belongs to which station.
When the system detects a folder containing permit files, the following text appears
inside the dialog: Chart Permit File Found.
If you are satisfied that the permits are for the correct computer, click OK.

6 Click Read Permits from.
7 Click OK.

The system lists the chart permits that now exist on the computer.

7.4.2.2 Install the charts themselves
1 Insert the medium (a CD-ROM, a DVD or a USB stick) containing the base release

of the PRIMAR™ charts.
2 Select Chart→Chart Types.
3 Click the Mng... button next to the label for the database whose charts you are

installing (for example, PR: Primar).
4 Select the Install tab.
5 If you are using a:

• CD or DVD, click Check CD.
This will make the system recognize the PRIMAR™ disk.

• USB stick, browse for the folder containing the charts.
When you select the correct folder a text status appears in the dialog, indicating that
the charts have been found (e.g. UKHO ENC BASE ...).

6 Click Import S57 Charts.
a The system might notify you that the digital certificate for the new charts is

different from the one for the previously installed charts. If this happens:
i Click the Check button.

The certificate you want to use appears by default under New certificate.
ii Click Trust and Install to install the specified certificate.
iii Click Import S57 Charts.

b The system might notify you that a new Primar Product List was found in the
catalog. If so, click Install.

The system goes through all licensed charts on the CD, checks which to install, and
gives you a time estimate for the installation.

7 Click Install to install the charts, and wait for the installation procedure to complete.
If you are installing a lot of charts, the process can take a considerable amount of
time. The dialog displays progress information during the installation.

8 Click OK.
If any errors are reported at the end of the installation process, contact PRIMAR™
to resolve them.

9 Make the charts you have installed active:
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a Select Chart→Chart Types.
b Check the check-box to the left of the name of the database whose charts you

have installed (for example, PR: Primar).
If you found this check-box already checked, it is a good idea to uncheck it and
then check it again. This ensures that all the charts in use will be the latest
ones installed.

7.4.3 Mirroring S57/S63 charts on to several operator
stations
This section tells you how to mirror (in other words, copy) S57/S63 charts from one
computer (for example, a Planning Station or operator station computer) on to one or
more operator stations over the network.

Before installing permits and charts, make sure that:
• You have set up the source computer as a mirror host and that the permits and charts

have been loaded on to it (see Preparing your station(s) for the installation of S57/S63
charts on page 193 and Installing S57/S63 charts on to a single operator station or a
mirror host from removable media on page 196).

• You have created an S57/S63 database framework for each mirror client (in other
words, for each operator station that is to receive the new charts) . To do this, you
must follow the procedure Preparing your station(s) for the installation of S57/S63
charts on page 193 for each client, taking care that the name of the S57/S63 database
framework is the same on the mirror host and on each client.

To install permits and charts on your mirror client, you can choose whether initiate the
transfer from the mirror host or from the mirror client. Perform one of the following
procedures:
• Mirroring charts on to the mirror client from the host (initiated from the client) on

page 198
• Mirroring charts on to the mirror client from the host (initiated from the host) on

page 200.

7.4.3.1 Mirroring charts on to the mirror client from the host
(initiated from the client)
1 To load the required permits from the mirror host, do the following:

a At the client station, select Chart→Chart Types.
b Click theMng button for the S57/S63 database (for example,PR: Primar).
c In the General tab, click License (see General tab on page 482).
d From the Read Permits from drop-down list at the bottom of the dialog, specify

the device (in other words, the mirror host computer) that you want to load
the permits from.
(If you are installing the permits from a removable medium, specify that
instead.)
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2 To load the charts, check in the Mirror tab that the correct mirror host is specified,
then click Update Chart Database.

Figure 45 Updating the chart database on the mirror client

The status window at the bottom of the dialog reports whether the chart permits and
updates match those on the mirror host or not.

3 Activate the charts:
a Select Chart→Chart Types.
b Check the check-box to the left of the name of the S57/S63 database (for

example, PR: Primar).
If you found this check-box already checked, it is a good idea to uncheck it and
check it again to make sure all charts displayed are the very latest ones installed.

4 When you have installed the charts on to all the mirror clients, go to the mirror
host computer again and view the state of the chart database and permits on both
the host and client computers:
a At the mirror host, select Chart→Chart Types.
b Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
c In the General tab, click Manage Mirrors.

An overview is displayed of the permit and chart statuses for the mirror host
along with indications for each mirror client of whether the permits and updates
match those on the mirror host.
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Figure 46 The status of the permits and updates on the mirror host and clients

7.4.3.2 Mirroring charts on to the mirror client from the host
(initiated from the host)
1 At the mirror host, log into the system using the User password.
2 Select Chart→Chart Types.
3 Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
4 In the General tab, click the Manage mirrors button.

The list appears populated with the host and the clients (see The status of the
permits and updates on the mirror host and clients on page 200), with the host
clearly indicated. The status of permits and charts already installed on the clients
is shown as well.

5 Select the client you want to install the charts on to by clicking its name.
6 Click the Install Permits button.

The system transfers the permits to the client (and a message appears on the screen
of the client operator station to this effect).

7 Click the Install Charts button.
The system transfers the charts to the client (and a message appears on the screen of
the client operator station to this effect).
While the installation of charts is taking place, a text box in the active window on
the host will indicate “Charts Mirroring running”. However, if you suspect that the
installation may have already finished, you can press the Refresh button at any time.
If the “Charts Mirroring running” text is visible, the installation is still in progress.

8 Activate the charts:
a Select Chart→Chart Types.
b Check the check-box to the left of the name of the S57/S63 database (for

example, PR: Primar).
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If you found this check-box already checked, it is a good idea to uncheck it and
check it again to make sure all charts displayed are the very latest ones installed.

7.4.4 Updating permits and charts on the mirror host
When the current permits on your operator station have expired, you must obtain new
ones from PRIMAR and then follow the procedure Load the chart permits on to the
computer on page 196.
To see the expiry date of your chart permits, do the following:
1 Select Chart→Chart Types.
2 Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
3 In the General tab, click the License button.

The system displays the chart permits currently loaded on to the operator station,
along with their expiry dates.

To update the charts loaded on to the mirror host, use a removable medium (typically
a CD-ROM or DVD from PRIMAR) containing the latest release of the charts. You
may choose to have the charts copied on to a USB stick from which to load them on to
the mirror host. If so, make sure it is virus-free before inserting it in the computer.
Then do the following:
1 Insert the removable medium (CD-ROM, DVD, USB stick) in to the mirror host

computer.
2 Select Chart→Chart Types.
3 Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
4 In the Updates tab, click the Update by Disk button.
5 Under Chart CD Status, choose the correct drive.
6 If you are using a:

• CD or DVD, click Check CD.
This will make the system recognize the PRIMAR™ disk.

• USB stick, browse for the folder containing the charts.
When you select the correct folder, a text status appears in the dialog indicating that
the charts have been found (e.g. UKHO ENC UPDATE ...)

7 Click Import S57 Charts.
a The system might notify you that the digital certificate for the new charts is

different from the one for the previously installed charts. If this happens:
i Click the Check button.

The certificate you want to use appears by default under New certificate.
ii Click Trust and Install to install the specified certificate.
iii Click Import S57 Charts.
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b The system might notify you that a new Primar Product List was found in the
catalog. If so, click Install.

The system goes through all licensed charts on the removable medium, checks
which to update, and gives you a time estimate for the update.

8 Click Install to update the charts, and wait for the update procedure to complete.
If you are updating a lot of charts, the process can take a considerable amount of
time. The dialog displays progress information during the update.

9 Click OK.
If any errors are reported at the end of the update process, contact PRIMAR™ to
resolve them.

10 Activate the charts:
a Select Chart→Chart Types.
b Check the check-box to the left of the name of the S57/S63 database (for

example, PR: Primar).
If you found this check-box already checked, it is a good idea to uncheck it and
check it again to make sure all charts displayed are the very latest ones installed.

7.4.5 Updating permits and charts on the mirror clients
from the host
To check whether the permits on the client have expired or not:
1 Select Chart→Chart Types.
2 Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
3 In the General tab, click the License button.

The system displays the chart permits currently loaded on to the operator station,
along with their expiry dates.

To update the charts on a mirror client, you must first update them on the host and then
you can transfer the updates from the host to the mirror client. You can choose whether
to initiate this transfer from the host or from the client:
• Updating charts on the mirror client from the host (initiated from the client) on

page 202
• Updating charts on the mirror client from the host (initiated from the host) on

page 203.

7.4.5.1 Updating charts on the mirror client from the host (initiated
from the client)
1 At the mirror client, select Chart→Chart Types.
2 Click the Mng button by the name of the S57/S63 database (for example, PR:

Primar).
3 In the Mirror tab, click the Update Chart Database button.
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4 Click OK when the update process is completed.
5 Activate the charts:

a Select Chart→Chart Types.
b Check the check-box to the left of the name of the S57/S63 database (for

example, PR: Primar).
If you found this check-box already checked, it is a good idea to uncheck it and
check it again to make sure all charts displayed are the very latest ones installed.

7.4.5.2 Updating charts on the mirror client from the host (initiated
from the host)

1 At the mirror host, select Chart→Chart Types.
2 Click the Mng button by the name of the S57/S63 database (e.g. PR: Primar).
3 In the General tab, click the Manage Mirror button.
4 Select the client you want to update the charts on by clicking on its name.
5 Click the Install Charts button.

When all charts have been updated, a message will appear on the host screen
indicating that the update process was successful.
While the installation of charts is taking place, a text box in the active window on
the host will indicate “Charts Mirroring running”. However, if you suspect that the
installation may have already finished, you can press the Refresh button at any time.
If the “Charts Mirroring running” text is visible, the installation is still in progress.

6 Make the charts you have updated active:
a Select Chart→Chart Types.
b Check the check-box to the left of the name of the S57/S63 database (for

example, PR: Primar).
If you found this check-box already checked, it is a good idea to uncheck it and
check it again to make sure all charts displayed are the very latest ones installed.

7.5 HCRF charts
Raster charts can be used in the ECDIS application but not the Radar application.
They are either ARCS charts provided by the United Kingdom Hydrographic Office or
Seafarer charts provided by the Australian Hydrographic Office. These are distributed
in a common format but have slightly different licensing conditions. The term HCRF -
Hydrographic Chart Raster Format - is used as a common term for ARCS and Seafarer
charts. ARCS Navigator provides an annual supply of digital chart information,
supported by the weekly issue of Update Discs for mariners whose vessels are mandated
under Safety of Life at Sea (SOLAS) regulations or for other subscribers who require
access to frequent updating.
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Figure 47 ARCS charts broken down into individual Area Disc CD-ROMS

If you want to use HCRF charts and your ECDIS application has not been configured for
HCRF chart you need to contact Kongsberg Maritime. Use the addressing information
found at the beginning of this book.

7.5.1 Installing charts
To install ARCS charts you will need a CD-ROM containing the charts and a Chart
Permit. Do the following:
1 Select Chart→Chart Types.
2 Under databases, see if there is an ARCS database.
3 If it is included, this indicates that the system has been initialised, go to step 18,

otherwise continue at step 4.
4 Select System→Password
5 Enter the user password (see Password on page 593).
6 Select Chart→Reconfigure Chart Databases.
7 Click ARCS Database.
8 Click Apply Changes twice.
9 Select Chart→Chart Types→Database: AR: ARCS.
10 Select the License tab.
11 Click Show User Permit.
12 Write it down.
13 Contact an ARCS Chart agent providing the User permit and the PIN code "1234".

• You will receive the Chart Permit on a disk.
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14 Insert the disk in the selected device.
15 Select Chart→Chart Types→Database: AR: ARCS→Mng.
16 Select the License tab.
17 Click Add Chart Permits from Medium.

• Chart permits can also be inserted manually if obtained by telephone or fax.
• When the Chart Permit has been loaded, you can display the License information

by clicking Show Licence.
• You can also take back-up and remove chart permits from here.
• The first time charts are loaded into the system, use the most recent chart

catalogue.
18 Select Chart→Chart Types→Database: AR: ARCS→Mng.
19 Select the Update tab.
20 Click Load Updates.
21 You will be asked to insert the Update CD.
22 Click Load Updates from CD.
23 Select the Load tab.

• There are three ways of selecting the charts to be loaded:
– By clicking Select all.
– By selecting all charts within a geographic area. The area can be specified

either by latitude and longitude values, or by clicking Get Cursor and drawing
a rectangle in the overview chart on the screen.

– By selecting individual charts listed under Licensed.
24 When the required charts are selected, start the loading by clicking Load Selected

Charts.
• The user is requested to insert chart CDs as required by the loading process.

7.5.2 Updating charts
The United Kingdom Hydrographic Office issues chart updates on a weekly basis. From
time to time they will also issue new chart CDs.
1 When you receive an update CD perform the following:

Select Chart→Chart Types→Database: AR: ARCS→Mng.
2 Select the Update tab.
3 Click Load Updates.
4 You will be asked to insert the Update CD.
5 Click Load Updates from CD.
1 When you receive a new chart CD perform the following:

Select Chart→Chart Types→Database: AR: ARCS→Mng.
2 Select the Update tab.
3 Click Load Updates.
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4 You will be asked to insert the Update CD.
5 Click Load Updates from CD.
6 Insert the Chart CD.
7 Select Chart→Chart Types→Database: AR: ARCS→Mng.
8 Select the Load tab.

• In the Licensed window some charts will be listed as Incompat.
9 Select these.
10 Click Load Selected Charts.

7.5.3 Deleting and adding charts
The charts installed in the system may from time to time need to be changed, either
because the sailing route is changed or for other reasons. Such changes may include both
deleting and adding charts. If new chart permits are needed contact your ARCS chart
agent, who will issue new chart permits.

7.5.3.1 To enter new chart permits

1 Select Chart→Chart Types→Database: AR: ARCS→Mng.
2 Select the License tab.
3 Click Add Chart Permits from Floppy Disk.

• Chart permits can also be inserted manually if obtained by telephone or fax.

7.5.3.2 To remove charts

1 Select Chart→Chart Types→Database: AR: ARCS→Mng.
2 Select the Load tab.
3 Select the charts you want to remove.
4 Click Unload Selected Charts.

• The charts are removed.

7.5.3.3 To add new charts

1 Select Chart→Chart Types→Database: AR: ARCS→Mng.
2 Select the Load tab.
3 Select the charts you want to add.
4 Click Load Selected Charts.
5 Install the CD as requested
6 Click Load CD-ROM.

• The charts are loaded.
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7.5.4 ARCS demonstration charts
Three ARCS charts are normally available on the hard disk for demonstration purposes.
A voyage through these charts has been recorded and can be replayed. To set up the
demonstration, do the following:
1 On the monitor select ChartReconfigure Chart Databases.
2 Select ARCS Demonstration Dataset.

• The charts are installed in the system's chart database.
3 When the installation is finished, click Apply Changes .
4 Restart the system by turning it off and then on again.
5 On the monitor select ChartChart Types.
6 Select AD;ARCS-DEMO, and de-select all other databases.

Figure 48 Demonstration of ARCS raster charts

7 Set the chart scale to 1:50.000, and choose N UP/TM.
• The ARCS charts are now ready for display.

8 Select Own Ship→Voyage Recordings List (see Logging the voyage details on
page 324).

9 Select ARCSRiverHumber, and then click Replay.
10 In the Voyage Recording Replay dialog, select Interpolate, click Start then click

the > button.
11 Drag the Voyage Recording Replay dialog into the chart area.

• The own-ship is now sailing through the displayed ARCS charts.
12 To stop the demonstration, click the Close Button ("X") in the Voyage Recording

Replay dialog.
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7.6 Defining the chart regeneration area
When the system is operated in true motion the own-ship moves across the chart and as it
approaches the edge of the display the chart needs to be regenerated. The operator can
configure when this happens by defining a regeneration rectangle. To do this:
1 Select: System→Parameter Settings.
2 Select the Display tab.
3 Select Chart Regeneration Area (see Chart regeneration area on page 569).
4 The regeneration rectangle can be defined in three ways (use the marker to drag the

sides of the rectangle or enter exact values using the keyboard):
• Fixed Border Offset: The chart is regenerated when the own ship gets closer than

the set percentage from the edge. (In percent of the screen diameter).
• Movable rectangle: Allows you to define each side of the rectangle individually.
• Minimum chart area ahead: The chart is regenerated when the distance ahead of

the own ship is less that the set percentage.
Figure 49 Fixed border
offset

Figure 50 Movable
rectangle

Figure 51 Fixed border
offset with 50% minimum
chart area ahead

The regeneration rectangle has its own object menu. To display
it point to the rectangle and click Object Menu on the operator
panel.
• Reset to Left Area Default sets: Sets a regeneration area that

is not in conflict with the menu area on the right hand side
of the display.

• Reset to Full Area Default: Sets a regeneration area that is 20%
off the border of the chart area.

7.7 Displaying charts on the radar display

7.7.1 Introduction
The K-Bridge Radar can display official and unofficial electronic charts.
Official charts are charts that have been issued by an authorized hydrographic office.
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Unofficial charts are charts that have not been issued by an authorized hydrographic
office. Unofficial vector charts can be purchased from distributors of Jeppesen (C-Map).
Note

Even with official charts displayed, the K-Bridge Radar is a chart radar and not an
ECDIS (neither is it an approved back-up for ECDIS). Displaying ENC on the K-Bridge
Radar is an aid to navigation and not an alternative to viewing the chart on an ECDIS
or using a paper chart.
You cannot use raster charts on K-Bridge Radar (or on any chart radar).

7.7.2 Switching chart presentation on and off
To switch chart presentation On or Off in the Radar application, click the Chart button
on the range panel of the radar dashboard (see Radar dashboard: the range panel on
page 79).

7.7.3 Presenting charts and radar video on the same screen
When radar video and charts are presented together on the radar screen, it is important
to bear the following principles in mind:
The radar application is primarily an ARPA system, and the presentation of charts
should not degrade or obscure the radar video. It is extremely important for example
that an unexpected radar target is not difficult to observe because of the additional chart
information. This has been guidance throughout the entire design of the system, but it
has not been possible to test the system with all possible combinations of charts (some of
which have not been published at the time of testing), range scales and radar echoes. It is
important that the operator at all times estimates whether the selected chart information
may degrade or obscure the readability of radar echoes. If so, he should reduce the
numbers of presented chart themes, or even switch off chart presentation on the radar
application completely until the situation has changed.
The localisation of the radar video and the chart data on the screen is in principle
independent. Radar video is presented relative to the own-ship, while chart data is
presented based upon its absolute geographical position. The relative position of the
chart data is determined also by the calculated geographical position of the own-ship.
The following factors will influence the alignment of the radar video and chart
presentation:
• Correct configuration of the position of the antennas on the own-ship, both for

radar antenna and position receiver (GPS) antenna. After correct installation and
commissioning, this should not be an influential error.

• The quality of the chart material. This is extremely difficult for the operator to
estimate.

• The chart material and the position receiver (GPS) shall both use the same
geographical datum. This shall be WGS84 for official electronic charts, and the GPS
shall also be configured to transmit WGS84 to K-Bridge Radar.
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• The accuracy of the calculated position of the own-ship. This is difficult for the
operator to estimate, but the basic accuracy should be in the range of less than 10m
when absolute GPS is used and less than 5 m when differential GPS is used.

• Correct input from the compass. An offset in heading will result in a rotation of the
radar video relative to the chart.

• Correct radar azimuth alignment. If the heading line alignment is erroneous, this will
result in a rotation of the radar video relative to the chart.

When land is included in the chart data and parts of the land are distinct radar echoes,
the superposition of radar echoes and chart data may be used to assert the quality of
the match. The radar echoes should be on the same location on the screen as the
corresponding places on the chart. When doing so, it is essential to be aware that the
strongest radar echoes may be from other parts of land than the coast line. As an
example, a steep hill with a flat strip of land towards the sea will often have the strongest
echo from the hill. It is also important to be aware of the opening angle of the radar
beam, which will tend to enlarge radar echoes in azimuth.

An offset in compass reading may result in a small rotation of coast lines between radar
echoes and charted coast lines.

7.7.4 Limitations on the display of chart themes
The presentation of chart is not permitted in Head Up. This is to avoid temporary
mismatches between radar and chart when the chart is being recalculated. Recalculation
is frequently necessary in Head Up. When chart is On and Head Up is selected, the chart
is automatically switched Off.

Initially the primary chart items are displayed. Chart themes up to and including ECDIS
standard display may be selected.
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Figure 52 A radar screen with primary chart items displayed

Figure 53 A radar screen with only chart outlines displayed
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8 Using the Navtex hazard
services

This section contains the following topics:
Introduction....................................................................................................................214
Viewing Navtex messages .............................................................................................215
Configuring the navigation area.....................................................................................215
Filtering Navtex stations ................................................................................................215
Filtering message categories ..........................................................................................215
Creating Mariners' notes from Navtex messages...........................................................216
Printing out Navtex messages........................................................................................216
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8.1 Introduction
All Navtex functions require a Navtex receiver to be installed and connected to the
K-Bridge MFD system. Navtex is a maritime service that advises ships of navigational
hazards, weather hazards, weather forecasts, vessels in distress and other important
information. There are a number of coastal stations around the world that transmit Navtex
messages on 518 kHz. Each station transmits messages every 4 hours. The service range
is 200-400 nautical miles for each station, depending on terrain and transmitter power.
The K-Bridge system's Navtex interface stores telegrams in an archive on its hard drive
and allows you to read and manage telegrams on the screen.

Figure 54 Navigational warning received on Navtex and annotated in the chart

The following functions are available:
• Store telegrams as files in a directory.
• Read and delete new and old telegrams.
• Extract latitude/longitude positions in telegrams and see that area in the chart or

generate Mariners’ notes at the specified position.
• Generate an alarm when critical Navtex telegrams arrive.
• Filter out certain telegram types and Navtex stations.
Note

The Navtex interface provides a receive-only type of interface to the Navtex receiver.
User interface settings on the K-Bridge MFD display, such as coast station filter settings,
do not affect the Navtex receiver.
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8.2 Viewing Navtex messages
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Select either the Unread or Read list using the option buttons

• The corresponding Navtex message list is displayed.
3 Select the message you want to view using the track-ball and Left mouse button.
4 Click Display.

8.3 Configuring the navigation area
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Click Configure.
3 Select the Stations tab (for more information, see Navtex Stations tab on page 529).
4 Select the area you are in from the drop-down list.
5 Select an overlapping area, if any, from the drop-down list.

8.4 Filtering Navtex stations
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Click Configure.
3 Select the Stations tab.
4 If it is not already selected, select the area you are in from the drop-down list, and

select an overlapping area (if applicable).
5 Select the Navtex stations whose messages you want to ignore.

8.5 Filtering message categories
To avoid receiving unwanted messages:
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Click Configure.
3 Select the Categories tab. See section 20.7.7 on page 524 for more information

on the Stations tab.
4 Select message types to be ignored.
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Note

Messages of categories A, B, D and L can not be ignored.

8.6 Creating Mariners' notes from Navtex
messages

If the message you want to create a Mariner's note from is already displayed go to Step
5, otherwise do the following:
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Select either the Unread or Read list using the option buttons.

The corresponding Navtex message list is displayed.
3 Select the message you want to view using the track-ball and Left mouse button.
4 Click Display.

• The message is displayed. The text message is scanned for positional information.
When found, it is displayed as Latitude and Longitude at the bottom of the dialog.

5 Click Go To.
• The chart jumps to show the position specified in the Navtex message.

6 Click Mark in Chart.
• A Mariners note is created in the specified position. The telegram text is

automatically inserted into the note. If the text is too long it is truncated.
7 When multiple latitude/longitude pairs are displayed in the Navtex message, each

position can be used for the Go To or Mark in Chart functions, by selecting the line
with the position information in the telegram text.

8.7 Printing out Navtex messages
1 Click the following sequence of buttons in the menu area: Chart→Navtex Messages

(see Navtex Message List on page 524).
2 Select a message to send to the queue for printing.

To select more than one message:
a First select a single message.

Use the trackball to position the mouse marker over the message, then click
the left mouse-button

b Select another message but this time hold down the Shift key on the keyboard
when you click the left mouse-button.
This selects all messages in the list between – and including – the first and
second selections.
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3 Click Print.
4 Select a printer from the drop-down list.
5 Select the message or messages that you want to print from the list of items in

the queue for printing.
6 Click Print.

For more information about printing, see Printer on page 590.
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9 Using mariners' notes

This section contains the following topics:
What are mariners' notes? ..............................................................................................220
Turning mariners' notes on.............................................................................................220
Managing mariners' notes ..............................................................................................220
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Creating area notes.........................................................................................................222
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Printing notes .................................................................................................................223
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This chapter tells you how to use mariners' notes. These are items of graphical
information that you can add to a chart or to the radar display and that have a fixed
geographical position.

9.1 What are mariners' notes?
Mariners' notes are geographically fixed symbols, lines and
areas that are used to complement charts or supplement radar
information when charts are not used. Notes consists of lines,
symbols and text. The different types of notes you can create are
shown in the illustration to the left.

The Event note is automatically located at the own-ship's position
at the time it was created. Pressing the MOB (man over board)
button on the operator panel creates an Event note. For all other
note types, the navigator specifies the location.

9.2 Turning mariners' notes on
To display notes in the radar area, perform the following:
1 Click the following sequence of button in the menu area: →View →Main Radar

Themes.
2 Check the box for Notes.

9.3 Managing mariners' notes
1 From the main menu, select: Chart→Manage Notes→List and Create Notes (see

section 20.7.5.1 on page 508).
• The Nav Note List menu is displayed.

2 Select Type, Distance or Date to sort the list by type of note, distance from own-ship's
position, or date of creation/ modification.

3 Click the List button to display the full text and other information.
4 Click the Edit button to make changes to notes.
5 Click Delete to remove a note.
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9.4 Creating point notes
A point note is a symbol placed at a specific position. There are three types of point
notes: Event, Caution and Information notes. The Event note is automatically placed at
the own-ship's position. Clicking the MOB (Man Over Board) button on the operator
panel creates an event note.
1 Select: Chart→Manage Notes→List and Create Notes.
2 Click the Info Note button.
3 If the note position is specified using a local datum, select Local and specify the

offset from WGS-84.
4 Type in the note text in the Comment field.
5 Specify the position by double clicking the latitude and longitude fields. Type in a

new value or modify the existing value.
• Latitude and longitude formats are as follows:

– Lat: 12 34.123 or -12 34.123
– Lon: 123 45.123 or -123 45.123

• If the latitude is in the southern hemisphere or the longitude is westerly, use a "‒"
in front of the latitude or longitude.

6 As an alternative to typing in the latitude and longitude values use the track-ball and
Left mouse button in the radar area to point to the position.

7 When the note is completely specified click Apply.

9.5 Creating line notes
Line notes are lines placed at fixed positions. There are three types of lines:
• Solid lines
• Dashed lines
• Safety Contour
1 Select: Chart→Manage Notes→List and Create Notes.
2 Click the Solid Line, Dashed Line or Safety Contour button.
3 If the note position is specified using a local datum, select Local and specify the

offset from WGS-84.
4 Type in the note text in the Comment field.
5 Specify the position by double clicking the latitude and longitude fields. Type in a

new value or modify the existing value.
• Latitude and longitude formats are as follows:

– Lat: 12 34.123 or -12 34.123
– Lon: 123 45.123 or -123 45.123

• If the latitude is in the southern hemisphere or the longitude is westerly, use a "‒"
in front of the latitude or longitude.
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• Lines may be specified as either rhumb lines (RHL) or great circle (GC).
6 Click Enter on the keyboard to provide a new line for the next point. Continue

entering points until the line is defined.
7 Click Apply.
8 As an alternative to typing in the latitude and longitude values use the track-ball and

Left mouse button in the radar area to specify the position of the lines.

9.6 Creating area notes
Area notes are polygons placed at fixed positions. There are two types of areas:
• Areas
• Filled areas
1 Select: Chart→Manage Notes→List and Create Notes.
2 Click the Area or Filled Area button.
3 If the note position is specified using a local datum, select Local and specify the

offset from WGS-84.
4 Type in the note text in the Comment field.
5 Specify the position by double clicking the latitude and longitude fields. Type in a

new value or modify the existing value.
• Latitude and longitude formats are as follows:

– Lat: 12 34.123 or -12 34.123
– Lon: 123 45.123 or -123 45.123

• If the latitude is in the southern hemisphere or the longitude is westerly, use a "‒"
in front of the latitude or longitude.

• Lines may be specified as either rhumb lines (type in "RHL") or great circle
(type in "GC").

6 Click Enter on the keyboard to provide a new line for the next point. Continue
entering points until the area is defined.

7 Click Apply.
8 As an alternative to typing in the latitude and longitude values use the track-ball and

Left mouse button in the radar area to specify the position of the corners in the area.

9.7 Modifying notes
1 Select: Chart→Manage Notes→List and Create Notes.
2 Select the note to be modified either in the list or in the radar area.
3 Click Edit.
4 The NAV Note menu will appear ready for editing.
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5 To edit the latitude or longitude values, double click on the field using the track-ball
and Left mouse button and modify the value.
• Use the Tab or Shift & Tab keys on the keyboard to move back and forth between

the entry fields in the menu.
6 As an alternativ drag the symbol or any line end in the radar area using the track-ball

and Left mouse button.
7 Modify the note text in the Comment field.
8 Click Apply.

9.8 Printing notes
1 Select: Chart→Manage Notes→List and Create Notes.
2 Select the note or notes to be printed.

To select more than one note to print:
a First select a single note.

Use the trackball to position the mouse marker over the note, then click the
left mouse-button

b Select another note but this time hold down the Shift key on the keyboard
when you click the left mouse-button.
This selects all notes in the list between – and including – the first and second
selections.

3 Click Print.
4 Select a printer from the drop-down list.
5 Select the note or notes that you want to print from the list of items in the queue

for printing.
6 Click Print.

For more information about printing, see Printer on page 590.
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10 Using templates
(ship-relative notes)

This section contains the following topics:
What are templates?.......................................................................................................226
Creating or editing a template........................................................................................227
Attaching the template to an object on the display ........................................................228
Copying templates .........................................................................................................229
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10.1 What are templates?
Templates (otherwise known as “ship-relative notes”) are graphical objects that you can
design yourself and then attach to particular objects or locations on the radar display, for
example, the own-ship, a target (radar or AIS), or a fixed geographical position. The
template will then be displayed along with the object it is attached to on the chart or
radar display.
You can double-click a template to view information about it.

Figure 55 Some examples of templates attached to objects on a chart
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10.2 Creating or editing a template

10.2.1 Selecting the template

1 Select Chart→Manage Notes→Ship-relative Notes
(Templates).

2 In the Template Manager dialog (see Template Manager
on page 518), either:
• Click New to create a new template.

The name New Template will then be highlighted to
indicate that it is edit-able. Specify the name you want
to give the template you are creating, then, with that
template selected, click Edit.

• Or select an existing template from the list and click Edit.
3 Follow the instructions below on defining the template (see

Defining the template on page 227).

10.2.2 Defining the template
When you click the Edit button in the Template Manager dialog
(see Selecting the template on page 227), the Template Edit
dialog appears.

The Template Edit dialog enables you to draw the template you
want to use.
1 Click Insert and put the cursor into the graphical window in

the bottom half of the dialog; put it at the position that you
want the first node to appear in your template design.

2 Click with the left mouse-button.
An unfilled black square appears at the position of the first
node in the template's design.

3 Move the cursor to the position you want the next node to
appear in and click again with the left mouse-button.
A line appears from the first node to the second.

4 Repeat the previous step until you have drawn all the lines
that form the design of your template.

5 Click End Insert.
This stops the application from drawing a line to the point in
the graphical window where you next click with the mouse
button.

381287/A 227



K-Bridge Multi-functional Display Unit

6 Select individual nodes either in the graphical window or in
the node list in the top half of the dialog, and use the mouse
to drag them into the exact positions you require.

7 When you are ready, click Save to save the template design.
If you want to use the template you have drawn as a
replacement for the own-ship symbol on the chart display,
you must save the file with the name $$OwnShip and then
check the Use Template '$$OwnShip' as Outline option in the
Display tab of the Parameter Setup dialog (see Display tab
on page 565). Skip the last step below.

8 Next attach the template to an object (see Attaching the
template to an object on the display on page 228).

For more information about the Template Edit dialog, see
Template Edit on page 520.

10.3 Attaching the template to an object
on the display

When you click the Use button in the Template Edit dialog (see
Defining the template on page 227), the Template Use dialog
appears.

The Template Use dialog enables you to attach the template you
have created to an object or fixed position on the chart or radar
display.
1 In the Template Use dialog, specify whether the template is

to be attached to the own-ship symbol, to a target, or to a
fixed geographical position. If it is to be attached to a:
• Target, you must select the target by clicking Select New

Target and then selecting the target in the chart or radar
display with the cursor.

• Fixed geographical position, specify the precise
co-ordinates. You can do this manually in the co-ordinate
fields of the Template Use dialog or automatically by
clicking the EBL button and moving the EBL to the
position required.

2 Also in the Template Use dialog, specify the template's
attributes (colour, size, orientation and position).

For more detailed information about using the Template Use
dialog, see Template Use on page 522.

228 381287/A



Using templates (ship-relative notes)

10.4 Copying templates
You can have all ECDIS, planning station, and radar systems on the bridge update each
other automatically whenever new edits to their templates are saved. For information
about how to do this, see Treating templates as global on page 229.
However, you can also copy templates from one vessel to another manually. For
information about how to do this, see Copying templates from one vessel to another
on page 229.

10.4.1 Treating templates as global
If you are editing templates on one workstation on the bridge, you can have your edits
(each time you save them) automatically updated to all other ECDIS , planning station
and radar systems on the same network.
To do this, enter a user password (see Password on page 593), then:
1 Select: Chart→Manage Notes→Ship-relative Notes (Templates).
2 In the Template Manager dialog, select the Global Templates option.
3 Repeat the above steps for the other ECDIS, planning station and/or radar systems

on the network (only those systems whose Global Templates option is selected will
have their templates automatically updated).

10.4.2 Copying templates from one vessel to another
You might want to generate a template on one operator station and then copy it to
an operator station on another vessel. One situation where this would be useful, for
example, is if you were planning for a number of vessels to sail in formation. In this
case, you could create templates on one workstation for each vessel in the proposed
formation so that the navigator on each vessel involved would be able to see, on the
chart or radar display, both:
• Where his or her own-ship needed to be in the formation,
• And how well the other vessels in the formation (which would appear on the chart

or radar display as radar targets) were keeping to the formation as indicated by the
template drawn on the chart or radar display for each vessel.

When you have created a template or a series of templates that you want to pass to
another vessel, do the following:
1 Insert an external medium such as a USB memory stick into the operator station.
2 From the main menu, select Chart→Manage Notes→Ship-relative Notes (Templates).
3 In the Template Manager dialog, select the templates you want to copy.
4 With the required templates selected, click Output to floppy and when prompted

specify the target disk or drive.
5 When the template files have been copied, take the external medium (for example,

the USB memory stick) to an ECDIS or radar system on the vessel that requires
the templates.
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6 Insert the external medium.
7 From the main menu on the receiving system, select Chart→Manage

Notes→Ship-relative Notes (Templates).
8 In the Template Manager dialog, click Input from medium and when prompted

specify the source disk or drive.
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11 Working with routes

This section contains the following topics:
What is a route? .............................................................................................................232
Creating routes ...............................................................................................................233
Modifying routes............................................................................................................234
Inserting waypoints........................................................................................................234
Adding waypoints at the end of the route ......................................................................235
Modifying routes in the display area .............................................................................235
Copying waypoints ........................................................................................................236
Monitoring routes ..........................................................................................................238
Inserting critical points into a route ...............................................................................240
Importing and exporting route information ...................................................................242

For information about
• Using routes to perform automated track steering, see Using the K-Bridge Autopilot

on page 247.
• Generating routes automatically and using the tide prediction facilities, seeGenerating
routes, predicting tides, avoiding pirates on page 767.
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11.1 What is a route?
A route is a sequence of waypoints defining a geographical passage. A chart must be
presented when you are working with routes. Therefore, although route functionality is
available in both the Radar and ECDIS applications, it is normally best to work with
routes in the ECDIS application. ECDIS is designed specifically for the purpose, and for
example the dialogs you need to use are larger (they are not restricted by the need to
avoid obscuring the radar display).
Each route must be assigned a unique name. Each waypoint in a route represents a
change of course that takes place in a fixed-radius turn. The beginning and end points of
the turn are called turnpoints. The straight line between two turnpoints is called a leg.

Figure 56 Route with waypoints, turnpoints and leg

A set of parameters are used to specify each waypoint and the following leg. The
parameters are:
• W: Waypoint number.
• Name: Waypoint name (manually entered).
• Lat: Latitude (manually entered).
• Lon: Longitude (manually entered).
• COG: Course Over Ground.
• Dist: Length of leg.
• Leg: Rhumbline (RL) or Great Circle (GC) (manually entered).
• TDist: Distance from the start of route to a waypoint.
• RDist: Distance from a waypoint to the end of a route.
• Spd: Speed (manually entered).
• ETA: Estimated Time of Arrival at the waypoint.
• Rtime: Remaining Time, estimated time to reach the end of the route.
• Wait: Delay at waypoint (manually entered).
• Radius: Turn Radius (manually entered).
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• Offtrack: Off track limit (manually entered).
• Max: Maximum speed (manually entered).
• Message: Message associated with waypoint (manually entered).

11.2 Creating routes
There are two ways of creating routes: using the waypoint list or graphically, using the
display area. This section describes both.

11.2.1 Creating a route using the waypoint list
1 Select Route→Manage Routes.
2 Click the New button.

• If the radar area covers the area for the new route, the new route will be displayed
as it is built.
See section 20.4.2 on page 420 for more information.

3 If the route is specified using a local datum, select Local and specify the offset from
WGS-84 (normally found in the chart).

4 In the menu select Entry.
• All the fields that can be changed are displayed in the menu (use the horizontal

scroll bar). The difference between Entry and Full is that Full displays additional
items in the waypoints list.

5 Click Insert.
• The first waypoint now appears with default values. These values are specified in

Parameter Setup dialog (see Parameter setup on page 565).
6 Enter the values for the waypoint by double clicking each required field using the

track-ball and Left mouse button.
• Type in a new value using the keyboard or modify the existing value.
• Latitude and longitude formats are as follows:

– Lat: 12 34.123N or 12 34.123S
– Lon: 123 45.123E or 123 45.123W

• Use the Tab or Shift + Tab on the keyboard to move back and forth between
the entry fields in the menu.

7 When the waypoint is completely specified, click Enter on the keyboard.
• The next waypoint will appear in the list as a copy of the last waypoint.

8 Make the necessary modifications as described above.
9 When all waypoints have been specified, click End Insert.
10 Type a Route Name and click Save.

381287/A 233



K-Bridge Multi-functional Display Unit

11.2.2 Creating a route in the display area
To specify waypoints in the radar area the radar display must cover the area for the route.
1 Select Route→Manage Routes.
2 Click the New button.
3 Click Insert.
4 Move the cursor into the radar area.

• The cursor changes shape to a cross.
5 Click Left mouse button when the cursor is in the position for the new waypoint.

• The position of the waypoint is specified.
6 Click Left mouse button when the cursor is in the position for the next waypoint.

• Create all waypoints in the route in this manner.
7 Click End Insert.
8 Type a Route name and click Save.

Note

All other parameters for the waypoint have default values. If you need to change
these use the procedure above, under "How to create waypoints using the waypoint
list".

11.3 Modifying routes
1 Select Route→Manage Routes.
2 Select the route you want to modify using the track-ball and Left mouse button.
3 Click Edit WP.
4 Select the waypoint field you want to modify by double-click the field using the

track-ball and Left mouse button.
5 Insert your changes.
6 When the modification is carried out, select a new field until all modifications have

been carried out.
7 Click End Insert.

11.4 Inserting waypoints
1 Select Route→Manage Routes.
2 Select the route you want to modify using the track-ball and Left mouse button.
3 Click Edit WP.
4 Select the waypoint after the one you want to insert.
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5 Click the Insert button, and modify the parameters as appropriate.
6 Click the Enter button.
7 The new waypoint appears in the table.
8 Modify the waypoint parameters as required.
9 If more waypoints are to be inserted click Enter on the keyboard. Continue this

procedure until all new waypoints have been specified.
10 Click End Insert.

11.5 Adding waypoints at the end of the
route

1 Select Route→Manage Routes.
2 To add waypoints at the end off the route select the line after the last waypoint.
3 Click the Insert button and define the new waypoint(s) as described under inserting

waypoints.
4 Click End Insert.

11.6 Modifying routes in the display area
1 Select Route→Manage Routes.
2 Select the route you want to modify using the track-ball and Left mouse button.

• The location of waypoints and turnpoints can be modified directly in the display.
3 To modify the position of a waypoint or turnpoint select it using the track-ball

and Left mouse button.
4 Drag it to the new location.

• The effect of moving a turnpoint is shown in the illustration below.

Figure 57 Effects of moving waypoints
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5 To insert a new waypoint select the waypoint after the one you want to insert.
Click the Insert button in the menu, and point the cursor to where you want the
new waypoint.

6 Click End Insert.
7 To add waypoints after last one, in the menu select the line after the last waypoint.
8 Click the Insert button, and add one or more waypoints by pointing and clicking

in the radar area.
9 Click End Insert.

11.7 Copying waypoints
Waypoints existing in one route may be copied to a new route, see the illustrations
below. The new route uses waypoints (marked with squares) defined in an existing route.
This is done by copying the waypoints into the new route.
1 Select Route→Manage Routes.
2 Select the route you want to modify using the track-ball and Left mouse button.
3 In the Route List dialog (see Route List on page 416), select the same route.
4 Click the List WP button to display a list of the route's waypoints (see Edit route

on page 420).
5 Select the waypoints to be copied (do this by highlighting the first waypoint and

dragging the cursor down the list to highlight the other waypoints you require).
6 Click Copy.

• Use the Mark button to select several waypoints if the list needs to be scrolled
between the first and last waypoint in the selection.

7 In the Route List dialog, select the new route, and click Edit WP.
• The waypoint list for the new route is displayed (see Edit route on page 420).
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8 In the waypoint list select the point where you want the waypoints to be inserted,
and then click the Paste button.
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11.8 Monitoring routes
The system includes functionality to monitor the position of the ship against the planned
route. Do the following:
1 Select Route→Manage Routes.
2 Select the route to be monitored.
3 Click Monitor.
4 Select Route→Monitor Route.

• The dialog provides information about the up-coming portion of the route (see
Route Monitor on page 425).

• The information it contains includes:
– The name of the route
– The waypoint you are currently sailing towards
– The bearing and range to the next wheel-over point (WOP)
– The time to the next WOP at the current speed
– The course of the next leg
– The turn radius for the next turn
– The distance to the start of the next turn
– The current cross-track distance (if any) and the cross-track distance limit

5 Click AP Mode in the Route Monitor dialog when you want to go to the Autopilot
Mode dialog (see Autopilot Mode on page 427).
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For full information about using the autopilot, refer to the K-Bridge Autopilot
Operator Manual (for the document number, see References on page 45 at the
front of this manual).
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11.9 Inserting critical points into a route
Critical points are operator defined messages placed along the route. When reaching (or
at a set time before reaching) a critical point, the system gives an alarm. Critical points
can be defined in two ways; directly on the chart or through the menu system.

Figure 58 An illustration of critical points and the critical points menu

Note

Reaching a critical point means passing abeam of it.
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11.9.1 Creating a critical point in the chart

1 The route must be displayed but not monitored in the chart
area.

2 Select Own Ship→Ship Parameters.
3 Select the Route tab.
4 Make sure that Critical Points is selected both in the

Edited and Active column of the dialog (see Route (tab) on
page 570).

5 On the chart, point the marker to the place on the route
that you want to insert the critical point and click the right
track-ball button.
• An object menu (as shown on the left side) is displayed

next to the marker.
6 Select Insert Critical Point.

• The critical point is created.
7 Use the marker and the Left mouse button to drag the symbol

to the exact position you require.
• A message text can be tied to each critical point.
• If required an alarm can also be given at a set time before

the critical point is reached.
8 On the chart, point the marker to the critical point and click

the right track-ball button.
• An object menu (as shown on the left side) is displayed

next to the marker.
9 Select Critical Point List.

• The Critical Point dialog is displayed (see the figure
above).

10 Insert message text and time setting by double clicking the
appropriate field in the dialog's table of critical points.

11 Click Save Route.

11.9.2 Creating a critical point using the menu
1 Click the following sequence of softkeys in the menu area: Route→Manage Routes.
2 Select the route you want to insert critical points for using the track-ball and Left

mouse button.
3 Click the List WP button.
4 In the Waypoint List menu click the Critical Points button (see Edit route on

page 420).

381287/A 241



K-Bridge Multi-functional Display Unit

5 Click Add.
6 Type in the waypoint number, distance (to the waypoint), time (the alarm can also

be given at a set time before reaching the critical point) and a message.
7 Click Apply.
8 Add critical point messages to all waypoint that require them in this way.
9 When completed click Save Route.

11.10 Importing and exporting route
information

This section tells you how to import route information from another navigation console
or Planning Station system and how to export route information to another navigation
console or Planning Station system.
You can use a straightforward file copy process to transfer the route data between
systems.
Alternatively, you can use the Exchange Protocol. In this case, the copy process is
a client-server transfer. Two computer systems are involved: one acts as the client
(either passively receiving route data from the server or passively allowing route data to
be copied from it by the server) and the other acts as the server (actively transmitting
route data to the client or actively copying it from the client). For a description of the
implementation of this process, see The implementation of the RRXP exchange process
on page 243.
Whichever of these processes you use, before you start the copy process, you need to
specify the import (source) and export (target) directories in the Configure Route Export
dialog box (see Configure Route Export on page 661). If you are using the Exchange
Protocol process, you can also use this dialog box both to specify that you are using the
Exchange Protocol and to make the system act as the client for the transfer (one of
the systems has to be the client).

Note

Make sure that the two systems you want to transfer route files between are on the Local
Area Network and that they each have the read and/or write access they require to the
two directories involved:
• A K-Bridge MFD system that is performing a route export in the role of server needs
read-write access to the export (target) directory.

• A K-Bridge MFD system that is performing a route import in the role of server needs
read access to the import (source) directory.

• The external client system must have read-write access to the import (source)
directory.

• The external client system must have read access to the export (target) directory.
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11.10.1 Exporting
To export routes do the following:
1 On the console you are exporting from, make sure the system is configured to

perform the export operation (see Configure Route Export on page 661).
If you intend to use the Exchange Protocol for the transfer, specify this in the dialog
and specify also whether the system is acting as the client or not.

2 Select: Route→Manage Routes→Export (see Route Export on page 419).
3 Select the routes you want to export.

If no routes appear in the list, make sure you have specified the export directory
correctly in the Configure Route Export dialog box (see Configure Route Export
on page 661).

4 Click Backup.

11.10.2 Importing
To import routes do the following:
1 On the console you are importing to, make sure the system is configured to perform

the import operation (see Configure Route Export on page 661).
If you intend to use the Exchange Protocol for the transfer, specify this in the dialog
and specify also whether the system is acting as the client or not.

2 Select: Route→Manage Routes→Import (see Route Import on page 418).
3 Select the routes you want to import.
4 Click Restore.

11.10.3 The implementation of the RRXP exchange process
This section describes how the RRXP process for transferring route plans between
systems needs to be implemented.

Two sub-directories are used for the transfer of route plans:
• From an external “client” computer (or program on a PL-10 station) to the K-Bridge

system (Import directory),
• Or from the K-Bridge system to an external client computer (Export directory).

The actual locations of the Import directory and the Export directory are defined through
the K-Bridge configuration interface (see Configure Route Export on page 661) and
stored in registry variables.

If you are transferring to and/or from an external computer, the two computers involved
must both have network connections. The K-Bridge computer (program) must have
read/write-access to the Export directory and read access to the Import directory. The
client must have read/write access to the Import directory and read access to the write
directory.
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The process by which files are imported to the K-Bridge computer
On start-up the client clears all files in the Import directory.
1 The client writes route files to the Import directory with a “.rux” suffix.

It then writes a file named “ImportReady.txt” to the Import directory (the file will be
empty or have only minimal content).

2 The K-Bridge computer checks for the existence of a file named “ImportReady.txt”
in the Import directory on a regular basis (approximately every 10 seconds).
When it detects this file, it reads all files in the Import directory that have a “.rux”
suffix.

3 When it has read all the “.rux” files in the Import directory, it writes a file named
“ImportResult.txt” to the Export directory.
This file will be empty (but containing one space character) if the import is OK, or it
will contain an error text if there were import errors.

4 When the client computer sees the “ImportResult.txt” file, it checks its contents.
If the file is non-empty, the client computer deletes all the files in the Import
directory.

5 The K-Bridge computer detects that the “ImportReady.txt” file has been removed
and it deletes the “ImportResult.txt” file from the Export directory.

Note

The client computer must not write any more files to the Import directory before the
K-Bridge computer has deleted the “ImportResult.txt” file from the Export directory.

The process by which files are exported from the K-Bridge computer
1 The K-Bridge computer writes route files with a “.rux” suffix to the Export directory.

It then writes a file named “ExportReady.txt” to the Export directory (the file will be
empty or have only minimal content).

2 The client computer checks for the existence of a file named “ExportReady.txt” in
the Export directory on a regular basis (approximately every 10 seconds).
When the client computer detects this file, it reads all files in the Export directory
that have a “.rux” suffix.

3 When the client computer has read all the “.rux” files in the Export directory, it
writes a file named “ExportResult.txt” to the Import directory.
This file will be empty (but containing one space character) if the export is OK, or it
will contain an error text if there were export errors.

4 When the K-Bridge computer sees the “ExportResult.txt” file, it checks its contents.
If the file is non-empty, the K-Bridge computer deletes all the files in the Export
directory.

5 The client computer detects that the “ExportReady.txt” file has been removed and it
deletes the “ExportResult.txt” file from the Import directory.
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Note

The K-Bridge computer must not write any more files to the Export directory before the
client computer has deleted the “ExportResult.txt” file from the Export directory.
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12 Using the K-Bridge
Autopilot

This section contains the following topics:
Introduction....................................................................................................................248
The autopilot's operating modes ....................................................................................248
Adapting the autopilot to different conditions ...............................................................249
Making one console take command of the autopilot by default ....................................249
Giving the autopilot control of the vessel's steering system..........................................250
Taking command of the autopilot at a new Nav OS ......................................................251
Operating the autopilot in track-steering mode .............................................................251
Operating the autopilot in other modes..........................................................................256
Conditions resulting in an automatic switch-over to a different steering mode ............258
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12.1 Introduction
This chapter tells you how to perform automated track steering, how to make the
autopilot steer the vessel using a particular heading or course, and how to make it steer
the vessel towards a particular waypoint.

However, the parts of the MFD user interface that concern the K-Bridge Autopilot are
described fully in a separate manual and you must therefore read that manual (see the
K-Bridge Autopilot Operator Manual, part number 372906) in conjunction with this
chapter.

12.2 The autopilot's operating modes
When the MFD unit is interfaced to a K-Bridge Autopilot, routes created in the system
can be used to steer the ship. The MFD unit sends the course, the turn radius for the next
turn, the new course (after the turn), the off-track distance etc. to the autopilot, and the
autopilot adjusts the steering accordingly. The K-Bridge Autopilot can be controlled
from the MFD unit in four modes:
• Heading mode: The heading set-point for the ship is used as the course to steer. No

route required.
• Course mode: The course set-point and the calculated drift are used to calculate the

heading to steer. No route required.
• Waypoint mode: The route and the calculated drift are used to calculate the heading to

steer. The system compensates for cross track distance in order to reach the waypoint.
Waypoint mode is selected for one waypoint at a time. When the ship is close to the
waypoint, the mode is changed to Course mode to avoid major course changes close
to the Waypoint. Turns must be started manually.

• Track mode: The MFD unit steers the ship according to the programmed route with
a minimum of cross-track distance (XTD), a minimum of course alteration, and
optimum rudder usage. In this mode turns are executed automatically.

Figure 59 Waypoint mode compensates for drift

The following abbreviations are used:

TP - Turn Point
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T.Rad - Turn Radius
WP - Waypoint
WOP - Wheel Over Point. Where the turn is started to reach the next waypoint
WOL - Wheel Over Line. Line through the WOP parallel to the departing leg
XTD - Cross Track Distance. The shortest distance between the own-ship and the
intended route
Auto - Autopilot
Man - Manual
Stb Auto - Standby Autopilot

12.3 Adapting the autopilot to different
conditions

For information about how to adapt the autopilot to various weather, speed and
vessel-load conditions, refer to the K-Bridge Autopilot Operator Manual.

12.4 Making one console take command of
the autopilot by default

One operator station must take control of the autopilot whenever the vessel's steering
system switches from manual control to autopilot steering.
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To make a particular radar operator station do this, perform the following steps:
1 At the chosen radar console, select System→Passwords.
2 Type the service password.
3 Select System→AP Configuration (see Autopilot Configuration on page 658).
4 Check the box labelled AP In Command enabled.

This allows the autopilot to receive steering commands from this console.
5 Check the boxes labelled Default In Command (Global), Route Monitoring enabled,

and Route Monitoring enabled.
This operator station is now the one that is in command of the autopilot by default
whenever the own-ship's steering system switches from manual control to Autopilot.
It controls the Autopilot in Heading mode until you select another operating mode.
You can subsequently give command of the autopilot to another operator station
either by:
• Pressing the IN CMD button on the operator panel (see The ALC (alarm and
control) NAV panel on page 36) belonging to the new operator station,

• Or by selecting In Command in the Autopilot Mode dialog (see section 20.4.6 on
page 427) on the new operator station.

Note

If you have a dedicated autopilot operator panel installed (in other words, an operator
panel that is separate from any navigator operator station consoles), then the dedicated
operator panel automatically takes command by default whenever the vessel's steering
gear is put into autopilot mode from manual control.

12.5 Giving the autopilot control of the
vessel's steering system

This section tells you how to give control of the vessel's steering system to the autopilot.
1 Put the vessel's steering system into autopilot steering mode.

The autopilot will immediately take control of the vessel's steering gear in heading
mode.
When you first give the autopilot control of the steering gear it steers the vessel in
heading mode, using the current heading as the heading set-point.
At the same time the autopilot activates the relevant panel controls (and lights the
IN CMD button; see The IN CMD button on page 37) on the Nav OS that is in
command of it.

2 Use the heading wheel on the Nav OS's operator panel to control the vessel through
the autopilot.
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Note

If the Nav OS that has command by default is not operational, the autopilot will still take
control of the steering gear; it will maintain the current heading but it will also generate
a system alarm after 30 seconds to indicate that no Nav OS is in command. In this
situation, you must take command of the autopilot at another Nav OS or return the
vessel to manual steering control.

The autopilot can only be controlled from one Nav OS at a time. In other words, it
can only be controlled from the Nav OS whose IN CMD lamp is lit. For information
about transferring command to another Nav OS, see Taking command of the autopilot
at a new Nav OS on page 251.

12.6 Taking command of the autopilot at
a new Nav OS

To transfer command of the autopilot, do the following:
• Press the IN CMD button (see The IN CMD button on page 37) on the Nav OS at

which you want to take command.
When you transfer control of the autopilot from one Nav OS to another (by pressing the
IN CMD button at the new Nav OS), the autopilot continues operating in the steering
mode it was in before you pressed the IN CMD button. Therefore, for example, there is
no interruption of track steering when you transfer command of the autopilot between
operator stations.

12.7 Operating the autopilot in
track-steering mode

This section tells you how to put the autopilot into track-steering mode.
Before you follow the instructions in this section, make sure that one MFD (or dedicated
radar or ECDIS) console on the bridge is configured to take control of the autopilot
whenever the vessel's steering system switches from manual control to autopilot steering
(see Making one console take command of the autopilot by default on page 249).
This section contains the following sub-sections:
• Requirements for automated track keeping on page 252
• Selecting track mode on page 252
• Track steering using the curved EBL tool on page 253
• Stopping track steering manually on page 253
• Stopping track steering automatically on page 254
• Waypoint alarms on page 254
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• Other track steering alarms on page 254
• Accuracy and performance constraints on page 255
• Practical hints on page 255

12.7.1 Requirements for automated track keeping
The following requirements must be met for track steering to be possible:
• Position, gyro and speed log input must be present and available to the autopilot.
• A sailing route is displayed and being monitored. Both AP in command enabled

and Route Monitoring enabled must be checked in the AP Configuration menu (see
Autopilot Configuration on page 658).

• One console must be in command of the autopilot.
• The ship must be on a straight leg.
• The distance from the ship to the leg must be less than 1 NM (5 NM in WP mode).
• The difference between the heading of the ship and the direction of the leg must be

less than 30º.
• The ship must be currently on a leg and the remaining part of that leg (before the next

wheel-over-point) must be more than 500 meters.
• The pre-planned track must have been checked for its safety and for its observance

of geometric and ship-dependent limits. (The system parameters on the Ship tab
and Route tab must be set to safe and correct values; see Ship (tab) on page 571
and Route (tab) on page 570.)

• The difference between the heading of the ship and the bearing to the turn point
must be less than 15º.

• Communication between the autopilot and the ECDIS must be established and
working.

• A K-Bridge Conning display must be operative.

12.7.2 Selecting track mode
To use the autopilot to steer the ship in track mode:
1 On the navigator operator station that is in command of the autopilot, select

Route→Manage Routes.
2 Select an existing route by using the track-ball and the Left mouse button.

For information on how to create routes, see Creating routes on page 233 and Route
List on page 416.

3 In the Route List dialog, click the Monitor button.
The route is displayed on the screen and appears in the route list as active.
Note

Active routes cannot be modified as long as they remain active.
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4 Make sure that the own-ship is currently at a position between two waypoints in
the selected route, that it is actually on or almost on the selected route, and that its
current heading is close to the course that the route takes between the two waypoints.

5 Verify that the next waypoint is the active waypoint.
The active waypoint is indicated by a pulsating ring in the display. It can also be
verified in the Route Monitor dialog (see Route Monitor on page 425).

6 Switch the vessel's main steering control system from manual operation to autopilot.
• The console's Autopilot Mode dialog indicates AP-Mode = Heading.

For more information seeAutopilot Mode on page 427.
7 Select Track in the Autopilot Mode dialog.

After a few seconds the Autopilot Mode dialog indicates AP-Mode = Track, and
course/heading and cross-track distance are monitored.
Track-steering is in operation.

12.7.3 Track steering using the curved EBL tool
1 Specify a planned turn using the curved EBL.

See Specifying planned turns (planning mode) on page 308 for information on how
to set up a curved EBL on the main radar display area.

2 When you have specified a turn, click Activate in the Curved EBL dialog, or click
the ACT Turn button on the console's operator panel (see The ALC (alarm and
control) NAV panel on page 36).

3 Put the vessel's main steering system into Autopilot mode.
• The Autopilot Mode dialog on K-Bridge Radar indicates AP-Mode = Heading (see
Autopilot Mode on page 427).

4 If you do not have the Autopilot Mode menu visible on the screen, in the K-Bridge
Radar application click Menu →Routes →Autopilot Mode.
See Autopilot Mode on page 427 for more information.

5 On the K-Bridge Radar console panel, press the In Cmnd button.
• The K-Bridge Radar Autopilot Mode menu indicates AP-Mode = Heading.

6 Select Track in the K-Bridge Radar Autopilot Mode menu.
• After a few seconds the Autopilot Mode menu indicates AP-Mode = Track, and

course/heading and cross track distance are monitored for the turn you have
used the curved EBL to specify.

• Track-steering is in operation.

12.7.4 Stopping track steering manually
There are several ways to stop track-steering:
• By selectingWP, CRS or HDG mode in the Autopilot Mode menu (see Autopilot Mode

on page 427).
• By switching the vessel's main steering system to manual control.
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• By pressing the IN CMD button on the console's operator panel or Top Bar.

12.7.5 Stopping track steering automatically
The following conditions automatically switch the system from automatic track steering
to a different steering mode:
• Sensor failure: A faulty sensor or a sensor monitoring alarm (indicating that the

difference between the main and secondary sensor is greater than a pre-set limit).
• ECDIS failure: The K-Bridge ECDIS monitors the track and is needed for track

steering.
• Conning display failure: Track steering is not allowed without a conning display

available.
• Communication error: Communication error between the K-Bridge Radar and the

autopilot.
• Extreme changes: Extreme changes in cross-track distance, heading or position. These

can be caused by sensor failure.
• Last waypoint: When the vessel reaches the last waypoint in the route, the system will

automatically come out of track steering mode and will continue in heading mode
using the last heading from the just completed route.

12.7.6 Waypoint alarms
Two to five minutes before reaching the wheel-over line for the next waypoint, a pre-alert
message is issued.
1 Acknowledge it.

• 30 to 60 seconds before reaching the wheel-over line for the next waypoint, a
warning is issued.

2 Acknowledge it.
Note

The planned turn will be carried out in track mode if the warnings are left
unacknowledged. To cancel the turn, you must exit track mode.

Note

For information about changing the settings for the waypoint alarms, see Autopilot
Configuration on page 658).

12.7.7 Other track steering alarms
The following warnings related to the automatic track keeping are given:
• XTD-limit is exceeded.
• Time to Wheel Over Position (WOP) = 3 min (AP Turn Prewarn).
• Time to Wheel Over Position (WOP) = 30 sec (AP Turn Warn).
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• Control of steering is taken by the K-Bridge Autopilot or by manual override.
• Communication failure between the K-Bridge Autopilot and the K-Bridge Radar.
• Power failure (signal from UPS).
• Time to last waypoint = 3 min.
• The last waypoint in route is reached (end of track).
• Loss of position data from Navigation Receiver.
• Loss of Gyro input.
• Loss of Speed Log input.
• Loss of communication with K-Bridge ECDIS.
• Loss of communication with Conning display.

12.7.8 Accuracy and performance constraints
The effectiveness of the automated track-keeping function depends on the accuracy of
the vessel's position, heading and speed sensors. For information about troubleshooting
when track steering is poor, refer to the K-Bridge Autopilot Operator Manual (part
number: 372906).

12.7.9 Practical hints
Before initiating track steering we recommend you steer manually (or using the
autopilot) until the ship is approximately on a straight leg with its heading towards
a selected waypoint on the track. This reduces the likelihood of sudden unexpected
manoeuvres when you initiate track steering.

The illustration below provides an example: the ship steers towards waypoint 03 by
making two turns and following a short straight leg between the turns. It initiates track
steering after the second turn on the straight leg just before waypoint 03.
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Note

The operator can change between WP mode and Track mode. In the above illustration it
is also possible to select WP04 as the "approach waypoint”, keeping the autopilot in WP
mode until WP04 is reached and then changing to Track mode.

12.8 Operating the autopilot in other
modes

This section tells you how to put the autopilot into heading, course or waypoint mode.

Before you follow the instructions in this section, make sure that one MFD (or dedicated
radar or ECDIS) console on the bridge is configured to take control of the autopilot
whenever the vessel's steering system switches from manual control to autopilot steering
(see Making one console take command of the autopilot by default on page 249).

12.8.1 Selecting heading mode
Perform the following to steer the ship in heading mode using the autopilot:
1 Switch the vessel's main steering control system from manual operation to autopilot.
2 On the navigator operator station that is in command of the autopilot, select

Route→Autopilot Mode.
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• The Autopilot Mode dialog (see Autopilot Mode on page 427) indicates AP-Mode
= Heading.

3 Click the IN CMD button on the operator panel or select In Command in the
Autopilot Mode dialog.

4 Select HDG in the Autopilot Mode dialog.
• After a few seconds the Autopilot Mode dialog indicates AP-Mode = Heading.
• Heading mode steering is in operation using the own-ship's current heading

as the course to steer.

For more information see Autopilot Mode on page 427.

12.8.2 Selecting course mode
Perform the following to steer the ship in course mode using the autopilot:
1 Switch the vessel's main steering control system from manual operation to autopilot.
2 On the navigator operator station that is in command of the autopilot, select

Route→Autopilot Mode.
• The console's Autopilot Mode dialog indicates AP-Mode = Heading.

3 Select In Command in the Autopilot Mode dialog.
4 Select CRS in the Autopilot Mode dialog.

• After a few seconds the Autopilot Mode dialog indicates AP-Mode = Course.
• Course steering is in operation using the own-ship's current course as the course

to steer.

For more information see Autopilot Mode on page 427.

12.8.3 Selecting waypoint mode
Perform the following to steer the ship in waypoint mode using the autopilot:
1 Switch the vessel's main steering control system from manual operation to autopilot.
2 On the navigator operator station that is in command of the autopilot, select

Route→Autopilot Mode.
• The console's Autopilot Mode dialog indicates AP-Mode = Heading.

3 Select In Command in the Autopilot Mode dialog.
4 Select WP in the Autopilot Mode dialog.

• After a few seconds the Autopilot Mode dialog indicates AP-Mode = Waypoint.
• Waypoint steering is in operation.

For more information see Autopilot Mode on page 427.

381287/A 257



K-Bridge Multi-functional Display Unit

12.9 Conditions resulting in an automatic
switch-over to a different steering
mode

12.9.1 Switch-over from track steering to local autopilot
control
The system will automatically change from track steering to local autopilot control in
the following cases:
• When the system does not receive valid signals from the position, heading or speed

sensor.
• When the end of the route has been reached.
• When a jump in the calculated cross-track distance of more than the preset limit

occurs.
• When a jump in the calculated cross-track distance corresponding to a cross-track

velocity of more than the preset limit occurs.
• When the K-Bridge navigation software cannot detect at least one active radar, ECDIS

and Conning system on the network. (The application you are currently using on the
MFD is the “active” one. This means, for example, that if you are in the ECDIS
application, then the Radar and Conning applications on the same MFD are not
“active” for the purposes of track steering; other Radar and Connong systems must be
available somewhere on the bridge for track steering to continue.)

• When the K-Bridge MFD system ceases to receive messages from the autopilot,
due to a communication failure.

• When the autopilot cannot detect the presence of the K-Bridge MFD system, due to a
communication or K-Bridge MFD system failure.

12.9.2 Switch-over from waypoint mode to local autopilot
mode
• The system will automatically change from waypoint mode to local autopilot control

when the K-Bridge MFD system is not receiving valid signals from the position,
heading or speed sensor.

12.9.3 Switch-over from waypoint mode to course mode
• The system will automatically change from waypoint mode to course mode if the

remaining distance to the wheel-over point is less than 0.5 NM.
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12.9.4 Switch-over from course mode to local autopilot
steering
• The system will automatically change from course mode to local autopilot control

when the K-Bridge MFD system is not receiving valid signals from the position,
heading or speed sensor.

12.9.5 Switch-over from heading mode to local autopilot
control
• The system will automatically change from heading mode to local autopilot control

when the K-Bridge MFD system is not receiving valid signals from the position,
heading or speed sensor.

Note

There are no automatic transitions to track mode, waypoint mode or heading mode.
The only automatic transition to course mode is from waypoint mode when the
remaining distance to the wheel over point is small.
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13 Using the Conning
application

This section contains the following topics:
The Heading pane ..........................................................................................................262
The Ship pane ................................................................................................................263
The Speed pane ..............................................................................................................264
The Steering control mode pane ....................................................................................265
The Depth pane ..............................................................................................................269
The Wind pane ...............................................................................................................270
The Wind sensors pane ..................................................................................................271
The Weather pane ..........................................................................................................273
The Bridge Watch pane..................................................................................................274

Note

When sensor input is missing, the affected data fields in the Conning application appear
light red and show either the last value received from the sensor or no value at all.

For images of the Conning screen on displays of different aspect ratios, see Radar,
ECDIS and Conning: general layout on page 48.
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13.1 The Heading pane
The Heading pane shows the heading, the heading set-point, the rate of turn, and the
deviation between the heading and the heading set-point.

The Heading pane appears in the top left-hand corner of the Conning display. You can
also view it separately from the:
• ECDIS application. Select: Options→Conning Panes→Heading Pane

• Radar application. Select: Tools→Options→Conning Panes→Heading Pane.

Figure 60 The contents of the Heading pane

The information displayed in the Heading pane is as follows:
• Heading: The heading data is received from the gyro system. The large blue numbers

in the centre of the dial give the heading.
• Heading set-point: When the autopilot is operating in heading mode, the Heading pane

also includes the heading set-point. This is given both numerically (in small orange
numbers beneath the heading itself in the centre of the dial), and on the dial (in the
form of an orange pointer).

• ROT: The Rate of Turn for the turn in progress.
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13.2 The Ship pane
The Ship pane displays the state of the ship's thrusters, propellers and rudders. It appears
in the centre of the Conning display but you can also view it separately from the:
• ECDIS application. Select: Options→Conning Panes→Ship Pane
• Radar application. Select: Tools→Options→Conning Panes→Ship Pane.

A blue wind arrow appears
somewhere close to the outside
edge of the ship symbol. The
position of the arrow indicates
the true direction from which the
wind is blowing.
The ship pane provides
at-a-glance status information
(including the current set-point
if available) for each thruster,
propeller and rudder. Where
the set-point is available, it is
indicated by an orange line on
each rudder scale symbol and on
each bar graph for the propellers
and tunnel thrusters. For the
azimuth thrusters the set-point
is indicated by an orange line on
the symbol’s rotatable bar graph
and by an orange arrow on the
symbol’s outer circumference.
Whether the set-points are
available or not, the following
information is provided for each
thruster, propeller and rudder:

Tunnel thrusters: The degree of thrust in either direction (port or
starboard) is represented by a blue bar graph and by a figure for the
percentage of maximum thrust currently deployed.

Main propellers: For each propeller, the amount of thrust is shown as
a numerical value (a number of revolutions per minute) and is also
indicated by a blue bar graph.

For forward thrust, the blue bar ascends from the central axis of the
graph. For reverse thrust, the blue bar descends from the central axis.

Rudders: The rudder angle is shown numerically (in degrees) above a
graphical indication of whether the angle is to port or starboard.

381287/A 263



K-Bridge Multi-functional Display Unit

13.3 The Speed pane
The Speed pane gives the vessel's speed. It also contains an arrow (and a numerical
reading) indicating the vessel's course along with the cardinal points of the compass. The
points of the compass vary in relation to the fixed ship symbol, enabling you to gauge
the direction of travel at the speed shown.
The Speed pane appears in the top right-hand corner of the Conning display. You can
also view it separately from the:
• ECDIS application. Select: Options→Conning Panes→Speed Pane
• Radar application. Select: Tools→Options→Conning Panes→Speed Pane.

Figure 61 The contents of the speed pane

The information displayed in the speed pane is as follows:
• Speed: The vessel's speed is given in the top right-hand corner of the speed pane. The

direction of movement at this speed is given by the course arrow and bearing value on
the dial. (Where water speed is shown, the reading for speed is the same as the value
in the middle of the ship symbol for forward/reverse speed.)

• Course set-point: When the autopilot is operating in Crs, Track or Wpt mode, the
speed dial includes the course set-point. It is shown as an orange pointer on the dial.

• Forward/reverse speed: The speed forwards or backwards is shown in the centre of the
fixed ship symbol (where it appears beneath an arrow indicating forwards or reverse).

• G/W: The G or W indicator next to the reading for speed tells you whether ground (G)
or water (W) speed is shown. To change the speed stabilisation setting, see Radar
dashboard: the range panel on page 79. (Where water speed is shown, the course
arrow and bearing do not appear on the dial.)
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• Transverse speed: Transverse speeds astern and at the bow are also shown.
• Course: The own-ship's course is indicated by an arrow and bearing. (This does not

appear if water stabilisation is selected.)

13.4 The Steering control mode pane
The Steering control mode pane tells you whether the steering system is being controlled
manually or by the autopilot. If a route is being monitored, it provides route information.
When the steering system is being controlled by the autopilot, this pane also contains
the autopilot set-points.

The Steering control mode pane appears in the bottom left-hand corner of the Conning
display.

Figure 62 The contents of the Steering control mode pane (in Conning)

Figure 63 Example (in Conning) showing a turn in progress
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The Steering control mode pane contains the following information at the top:
• Steering control mode: This value can only be either Autopilot or Manual.
• Mode: This is the autopilot mode. It is only displayed when the steering control mode

is Autopilot. The autopilot mode can be any of the following:
– Track
– HDG (with the autopilot controlled from the heading wheel on the console's

operator panel; The heading wheel on page 41)
– Heading (with the autopilot controlled from a dedicated K-Bridge Autopilot

operator panel)
– CRS
– WPT

• Console name: The name of the device that is currently in command of the autopilot.
(The device might be another Multi-functional Display unit, a dedicated ECDIS or
Radar operator station, or a dedicated autopilot operator panel.)

The top part of the Steering control mode pane also contains set-point information.

Set-points:
• Heading: The current heading set-point.
• ROT:When this value is given in orange, it is the set-point for the Rate of Turn for a

turn that is currently in progress. When the value is grey, it is the calculated Rate of
Turn for a turn that is currently in progress.

• Radius: When this value is given in orange, it is the set-point for the Turn Radius for
a turn that is currently in progress. When the value is grey, it is the calculated Turn
Radius for a turn that is currently in progress.

If the MFD console is monitoring a route, then the steering control mode panel contains
the following information in addition to the set-points:

Destination:
• ETA: The estimated time of arrival at the route's destination.
• Remaining time: The time left until the estimated time of arrival.

Next leg:
• Course: The course of the next leg of the programmed route.
• DIST: The length of the next leg.
• Next turn radius: The radius of the up-coming turn (if you are on track).

Current leg:
• Course: The course of the current leg of the programmed route.
• DIST to WOL: The distance to the next Wheel-over-Line.
• Time to WOL: The time left till arrival at the next Wheel-over-Line.
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Course leg progress and turn indicator:

The Steering control mode panel includes a progress indicator, showing how much of the
current leg has been travelled so far. The indicator is in the form of a vertical sequence of
10 rectangles: the filled ones each represent a tenth of the completed leg.

It also includes a turn indicator arrow, showing the general direction of the turn between
the current and the next leg. The size of the turn in degrees is given too.

Figure 64 Current leg progress and turn indicator

Cross-track distance information:

Any cross-track distance is indicated numerically in meters (with a P or an S to indicate
distance to port or starboard) and graphically by a horizontal bar chart.

When the cross-track distance limit is exceeded, the cross-track distance indicator has a
bright red border.

Figure 65 Cross-track distance indicator
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13.4.1 Viewing the steering control data from outside
Conning
You can also view the steering control data individually from the following applications:
• ECDIS. Select: Options→Conning Panes→Track Pane

• Radar. Select: Tools→Options→Conning Panes→Track Pane.

However, when you do this, the information is organized differently, and no graphical
indication is given of progress on the current leg or turn.

Figure 66 The Track pane (showing the same data as the Steering Control Mode
pane in Conning)
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13.5 The Depth pane
The Depth pane gives a reading for the depth of the water at the own-ship's current
position. It also contains a chart of the depth readings over the last 5 minutes. The most
recent reading is the one furthest to the right.
The Depth pane appears towards the bottom right of the Conning display. You can
also view it individually from the:
• ECDIS application. Select: Options→Conning Panes→Depth Pane

• Radar application. Select: Tools→Options→Conning Panes→Depth Pane.

Figure 67 The depth pane

The vertical axis of the chart (the depth axis) is variable. If the current depth is:
• < 50 metres, the vertical axis will be 0-50m.
• 50-100 metres, the vertical axis will be 0-100m.
• > 100 metres, the vertical axis will be 0-200m.
The Depth pane indicates the following:
• The period of time for which previous depth readings are shown on the chart.
• Whether the depth is measured from the water-line, the keel or from the position of

the sensor in the water. If the echosounder does not apply an offset (to enable the
system to present the reading as from the water line), then the depth readings are
given as from the sensor's own position in the water. In this case, instead of “water
line” or “keel” the label will read “sensor”.)

• Whether the transducer is located to the fore or aft of the vessel (if there are several
transducers in use[1]).

The depth pane histogram covers only the last 5 minutes of sailing. For information
about maintaining (and printing out) a log of depth data, see Capturing depth data for
other applications on page 329.

1. If there are several transducers connected to one echosounder and there is one echosounder for each
Depth pane in the Conning display, the system will be configured to use different transducers for
different depths. The transducer used for the current depth reading is indicated on the right of the graph.
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13.6 The Wind pane
The Wind pane gives a reading for true wind speed (relative to ground) and true wind
direction (relative to north) from the selected wind sensor. The true wind speed, which
appears in the top right-hand corner of the pane, is calculated by the system: it takes the
reading from the wind sensor and applies a formula to it that takes account of vessel
speed and heading. The true wind direction appears on the compass dial as a numerical
value and a blue arrow indicating the direction graphically.

The Wind pane appears towards the bottom right-hand corner of the Conning display.
You can also view it individually from the:
• ECDIS application. Select: Options→Conning Panes→Wind Pane

• Radar application. Select: Tools→Options→Conning Panes→Wind Pane.

Figure 68 The Wind pane

The wind pane also presents a one-minute “history” of the wind data. The blue lines on
the dial are speed/direction vectors. The system takes one reading per second and each
line on the dial represents a single reading:
• the length of the line indicates the wind speed
• the bearing indicates the true direction of the wind
• the intensity of the colour blue indicates how recently the reading was taken (the

darkest blue line represents the most recent reading, and the line colour fades from
dark to light blue and finally to white to indicate the age of the data).
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Finally the wind pane also includes a reading – in the bottom right-hand corner – for
the “calculated drift”. This is effectively the speed of the current. It is calculated as the
difference between the filtered speed input from the GPS and the filtered water speed
input from the speed log. This data is only provided if it is available from the selected
sensors, in other words if the currently selected position sensor is providing speed data
and the currently selected speed sensor is providing speed-through-water (STW).

The direction of the current is indicated on the dial by a greenish arrow and
accompanying numerical bearing.

13.7 The Wind sensors pane
The Wind sensors pane gives relative and true wind speed readings from up to four
wind sensors installed on the own-ship. It also shows the approximate location of each
sensor (on a diagram of the ship).

The Wind sensors pane appears towards the bottom right-hand corner of the Conning
display. You can also view it individually from the:
• ECDIS application. Select: Options→Conning Panes→Wind Sensors Pane

• Radar application. Select: Tools→Options→Conning Panes→Wind Sensors Pane.

Figure 69 The Wind Sensors pane

The Wind sensors pane uses the internationally accepted arrow symbols for representing
wind speed. The range of speeds that each arrow represents is shown below.
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Figure 70 The wind-speed arrows used in the Wind sensors pane
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13.8 The Weather pane
The Weather pane gives:
• A graphical indication of both relative and true (relative to north) wind direction

from the selected wind sensor.
• A numerical reading for both relative and true (relative to ground) wind speed from

the selected wind sensor. (The true wind speed is calculated by the system: it takes
the reading from the wind sensor and applies a formula to it that takes account of
vessel speed and heading.)

• Numerical readings for air temperature, humidity and atmospheric pressure.
• A chart of the atmospheric pressure readings for the last 48 hours.

The Weather pane appears near the right-hand edge of the Conning display. You can
also view it individually from the:
• ECDIS application. Select: Options→Conning Panes→Weather Pane

• Radar application. Select: Tools→Options→Conning Panes→Weather Pane.

Figure 71 The Weather pane

381287/A 273



K-Bridge Multi-functional Display Unit

13.9 The Bridge Watch pane
The Bridge Watch pane provides the main user interface to the Bridge Navigational
Watch Alarm System (BNWAS). This is the system that automatically raises the alarm
amongst the captain and ship's officers if the bridge becomes unattended.

The Bridge Watch pane displays the operational state of the BNWAS and the countdown
associated with its alarm timer. It also enables you to call for backup from one or more
particular officers.

On some vessels, the Bridge Watch pane is included in the main Conning display. On
others you must bring it up as a separate dialog.

To bring up the Bridge Watch pane if it is not part of the main Conning display:
• Select Options→Conning Panes→Bridge Watch Pane.

You can also view the Bridge Watch pane from the following applications (although the
list of Backup Navigators and the system settings area are then not displayed):
• ECDIS application. Select: Options→Conning Panes→Bridge Watch Pane.
• Radar application. Select: Tools→Options→Conning Panes→Bridge Watch Pane.

Figure 72 The Bridge Watch pane in Conning (left) and ECDIS and Radar (right)

For full information about using the BNWAS, see Operating the Bridge Navigational
Watch Alarm System on page 275.
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14 Operating the Bridge
Navigational Watch
Alarm System
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Introduction....................................................................................................................276
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14.1 Introduction
This chapter tells you how to use the K-Bridge Bridge Navigational Watch Alarm
System (BNWAS) from Kongsberg Maritime.

The BNWAS is designed to monitor bridge activity and alert the ship’s captain and/or
other qualified navigators if the bridge becomes unattended.

If there has been no activity on the navigation operator stations and nobody has pressed
a “Dead Man” reset button for a specified time period (of between 3 and 12 minutes)
– or (where motion detectors are installed) if the motion detectors have picked up no
movement on the bridge for a specified time period (of between 3 and 12 minutes) – then
the alarm will be raised in the stages described below (see The BNWAS alarm sequence
on page 276) and, unless timely action is taken, buzzers will sound on the bridge and
around the vessel.

The BNWAS alarm will also be raised in response to certain priorities of alert.

14.2 The BNWAS alarm sequence
The BNWAS alarm sequence is as follows:
1 The BNWAS countdown reaches (or is set to) zero because:

• Nobody has used the controls on a navigation operator station or pressed a “Dead
Man” reset button in the time required

• The BNWAS motion detectors (if installed) on the bridge have picked up no
movement in the time required

• A category A emergency alert has been received by a navigation operator station
or a category A alarm has been received or generated by a navigation operator
station (for information about alert categories, see The Alert priority button on
page 66)

2 The pre-warning lamps flash on the bridge. You must do one of the following:
• Press the PRE-WARNING RESET, ALARM RESET or SOUND OFF button (on

any operator station located in a designated look-out point) to reset the timer
• Make a movement on the bridge that is picked up by a BNWAS motion detector

(if installed)
• Use any of the controls on the navigation operator stations (or on third-party

navigation equipment that is integrated with the BNWAS).
3 15 seconds later, if nothing has happened to reset the timer, a buzzer is sounded

on the bridge.
4 15 seconds after that, if nothing has happened to reset the timer, buzzers are sounded

in the selected backup navigators' cabins.
Once the cabin buzzers have sounded, you must press the red ALARM RESET
button on the main alarm reset panel to reset the timer.
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5 Finally, 90 seconds[2] after the buzzers have sounded in the selected backup
navigators' cabins, if no one has pressed the red ALARM RESET button on the main
alarm reset panel, buzzers are sounded in all backup navigators’ cabins and in the
common areas of the crew's accommodation.
You must press the red ALARM RESET button on the main alarm reset panel to
reset the timer and stop the alarm sound.

For a list of the things you can do (before and during these stages) to reset the timer and
so prevent the buzzers from sounding or stop them if they have started sounding, see
Resetting the alarm timer on page 280.

2. On some larger vessels it is possible that the time period between the cabin buzzers sounding and the
common area buzzers sounding will be longer than 90 seconds. Where this is the case, it is to allow
the captain and/or backup officers time to reach the bridge. (This time period is configured when the
BNWAS is installed; it is not operator-configurable. The maximum permissible time period between
the cabin buzzer alarms sounding and the common area buzzers sounding is 3 minutes whatever the
size of the vessel.)
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14.3 The architecture of the BNWAS
The main user interface to the BNWAS is provided by the Bridge Watch pane in the
Conning application. The elements of the Bridge Watch pane are described below (see
The BNWAS user interface in the Conning application on page 279), and the rest of this
chapter tells you how to use it. (Note that you need a password to perform some tasks,
including starting and stopping the BNWAS and setting a new value for the alarm timer.)

Before you begin your watch, you must familiarise yourself with the BNWAS alarm and
pre-warning reset panels (see Resetting the alarm timer on page 280). Also make sure
you know where they are located on the bridge.

Figure 73 The hardware components of the BNWAS
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14.4 The BNWAS user interface in the
Conning application

The main user interface to the BNWAS is provided by the Bridge Watch pane in the
Conning application. On some vessels this pane is part of the main Conning display.
On others, you must bring it up as a separate dialog by selecting: Options→Conning
Panes→Bridge Watch Pane.

Figure 74 The Bridge Watch pane in Conning
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14.5 Resetting the alarm timer
This section tells you how to reset the alarm timer to prevent the buzzers from sounding
or silence them if they have already sounded.

Main alarm reset panel Pre-warning reset panel

Resetting the timer: Before the countdown reaches zero
• Make some movement on the bridge that is picked up by a motion detector installed for

the purpose. (Not all vessels have motion detectors installed as part of the BNWAS.)
• Use any of the controls on the navigation operator stations (or on third-party

navigation equipment that is integrated with the BNWAS).
• Press the PRE-WARNING RESET button or the red ALARM RESET button on the

BNWAS main reset panel, or press the PRE-WARNING RESET button on a BNWAS
pre-warning reset panel.

• Press the SOUND OFF button on any operator station (or on any piece of third-party
navigation equipment that is integrated with the BNWAS and) that is located in a
designated look-out point.

Resetting the timer: Before the buzzer sounds on the bridge
• Within 15 seconds of the PRE-WARNING RESET lamp flashing, press the

PRE-WARNING RESET button or the red ALARM RESET button.
• Within 15 seconds of the PRE-WARNING RESET lamp flashing, press the SOUND

OFF button on any operator station (or on any piece of third-party navigation
equipment that is integrated with the BNWAS and) that is located in a designated
look-out point.

• Make some movement on the bridge that is picked up by a motion detector installed for
the purpose. (Not all vessels have motion detectors installed as part of the BNWAS.)

• Use any of the controls on the navigation operator stations (or on third-party
navigation equipment that is integrated with the BNWAS).

Resetting the timer: Before the selected backup navigators’ buzzers sound
• Within 30 seconds of the PRE-WARNING RESET lamp flashing, press the

PRE-WARNING RESET button or the red ALARM RESET button.
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• Within 30 seconds of the PRE-WARNING RESET lamp flashing, press the SOUND
OFF button on any operator station (or on any piece of third-party navigation
equipment that is integrated with the BNWAS and) that is located in a designated
look-out point.

• Make some movement on the bridge that is picked up by a motion detector installed for
the purpose. (Not all vessels have motion detectors installed as part of the BNWAS.)

• Use any of the controls on the navigation operator stations (or on third-party
navigation equipment that is integrated with the BNWAS).

Resetting the timer: After pressing the CALL BACKUP button
• Press the red ALARM RESET button (see Calling for backup on page 283).

Resetting the timer: After the selected backup navigators’ buzzers sound
• Press the red ALARM RESET button.

Resetting the timer: After the buzzers sound in all backup navigators’ cabins and
in the common areas
• Press the red ALARM RESET button.
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Figure 75 BNWAS alarm timeline
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14.6 Calling for backup
To call for backup, do one of the following:
• Click the white Call Backup button in the Bridge Watch pane.

• Alternatively, press CALL BACKUP on the main alarm reset panel for the BNWAS.

When you have called for backup, this is what happens:
• The BNWAS alarm sequence begins at the 30 second point on the timeline (see
BNWAS alarm timeline on page 282).

• The alarm buzzers sound in the selected backup navigators' cabins.
• The red ALARM RESET button on the main alarm reset panel starts flashing.

• The Call Backup button in the Bridge Watch pane turns red and remains red until
the BNWAS alarm timer has been reset.

14.7 Stopping the alarm sound in the
backup cabins and beyond

For information about stopping the alarm sound before the buzzers sound in the backup
navigators’ cabins and the common areas of the crew’s accommodation, see Resetting
the alarm timer on page 280.

The alarm buzzers sound in the backup cabins 30 seconds after the
BNWAS countdown reaches zero or whenever backup has been called.

To stop the alarm sound and reset the timer, press the red ALARM RESET
button on the BNWAS main alarm reset panel.

90 seconds after the buzzers have sounded in the selected backup
navigators' cabins, if this button has not been pressed, the buzzers
will sound additionally in all the backup navigators’ cabins and in the
common areas of the crew's accommodation. The only way to stop the
alarm sound and reset the timer after this remains to press the red ALARM
RESET button on the BNWAS main panel.
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14.8 Selecting backup navigators
When you begin your watch, you should if possible select one or more backup navigators.

The backup navigators you select are the people whose cabin buzzers will sound:
• 30 seconds after the BNWAS alarm countdown reaches zero (if the [PRE-WARNING]

or main [ALARM RESET] button has not been pressed).
• 30 seconds after a category A alarm or emergency sets the BNWAS countdown to zero

(if the [PRE-WARNING] or main [ALARM RESET] button has not been pressed).
• When backup is called.

To select the backup navigators:
1 In Conning, access the Bridge Watch pane.

If this pane is not part of the main Conning display on your vessel then, in the
Conning application, select Options→Conning Panes→Bridge Watch Pane.

2 In the Bridge Watch pane, check the box next to each backup navigator you want
to select.

Figure 76 The Bridge Watch pane (with the captain and all backup navigators selected)

If there are no backup navigators selected, then after a few seconds the BNWAS system
will automatically select the captain (who is always the first backup navigator in the list)
and generate a warning to alert you of this.

If you have at least one other backup navigator selected, you can un-select the captain.
In this case, buzzers will not sound in the captain's cabin until the final stage of the
alarm when they sound in all backup navigators’ cabins and in the common areas of the
crew's accommodation.
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14.9 Entering the password for the BNWAS
system settings

You must enter a password for the system settings in the Bridge Watch pane to enable
or disable the BNWAS or to set the countdown period. The only settings you can
change in the Bridge Watch pane without entering a password are the selections for the
backup navigators.

Figure 77 The Conning Bridge Watch pane (before a password has been entered)

To enter the password:
1 In the Conning Bridge Watch pane, click the locked padlock symbol.

The Passwords dialog appears.

2 In the User Password section of the Passwords dialog type the password for the
BNWAS.

3 Click Open
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If the password is accepted, when you click Open all elements of the system settings
area in the Bridge Watch pane become available (they are no longer greyed out) and
the padlock symbol shows as an open padlock:

4 Make the necessary changes to the system settings section of the Bridge Watch pane.
In other words, enable or disable the BNWAS, configure it to start automatically
with the autopilot, or set the countdown period for the alarm timer.

5 When you have finished, restore password protection to the system settings (see
Restoring password protection when you have finished on page 289).

14.10 Starting the BNWAS
1 Enter the BNWAS password (see Entering the password for the BNWAS system

settings on page 285).
2 In the system settings section, select On.
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Figure 78 Turning the BNWAS on manually

This starts the BNWAS. To confirm that it has started:
• The alarm timer starts counting down in seconds from the start of the currently

set countdown period.
• The operating status indicator on the Bridge Watch pane turns green and its text

displays Manual ON.

14.11 Making the BNWAS start
automatically

To make the BNWAS start automatically when the vessel's autopilot is in operation, do
the following:
1 Enter the BNWAS password (see Entering the password for the BNWAS system

settings on page 285).
2 In the System settings section, select Automatic On/Off.

Figure 79 Making the BNWAS start and stop automatically

This starts the BNWAS automatically whenever the vessel's autopilot is in operation
and disables it automatically whenever the autopilot is not in operation.
The operating status indicator on the Bridge Watch pane turns green and its text
displays:
• Automatic On when you have the Automatic On/Off option selected and the

autopilot is in operation.
• Automatic Off when you have the Automatic On/Off option selected but the

autopilot system is not in operation.
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Figure 80 The BNWAS in Automatic On (Active) and Automatic Off (Standby)
operating modes

14.12 Stopping the BNWAS
1 Enter the BNWAS password (see Entering the password for the BNWAS system

settings on page 285).
2 In the System settings section, select Off.

Figure 81 Turning the BNWAS off manually

This turns the BNWAS off. To confirm that it is off:
• The operating status indicator on the Bridge Watch pane turns white and its text

displays Manual OFF.
Note

When the BNWAS is turned off, the countdown timer continues to operate. When it
reaches zero, however, it starts again from the currently specified countdown period
without causing any alarm buzzers to sound.

288 381287/A



Operating the Bridge Navigational Watch Alarm System

14.13 BNWAS operating statuses
The table below lists the four possible operating statuses of the BNWAS.

Table 18 BNWAS operating statuses

Operating status System settings Autopilot state
On selected Not applicable

Off selected Not applicable

Automatic On/Off selected Operating

Automatic On/Off selected Not operating

14.14 Setting the countdown period for the
BNWAS timer

The default countdown period for the BNWAS timer is 3 minutes. However, you can
change it to any period between 3 and 12 minutes.
1 In the Bridge Watch pane, enter the BNWAS password (see Entering the password

for the BNWAS system settings on page 285).
2 In the system settings section use the slider to set the countdown period you require.

14.15 Restoring password protection when
you have finished

When you have finished changing the BNWAS system settings, you must lock these
settings again to prevent unauthorized access to them:
1 If the Passwords dialog has been closed, bring it back by doing one of the following:

• Click the unlocked padlock symbol in the system settings section of the Bridge
Watch pane:
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• Select System→Passwords

2 In the Passwords dialog, click the Lock button beneath the User Password field.
When you have done this, the text field at the bottom of the dialog reads “Passwords
locked”.
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15 Monitoring whether the
vessel is off-course

This section contains the following topics:
Introduction....................................................................................................................292
The Off-course Alarm pane ...........................................................................................292
Using the off-course alarm system ................................................................................293
Specifying the permitted deviation ................................................................................294
Operating statuses ..........................................................................................................294
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15.1 Introduction
An optional Off-course Alarm System is available as part of the K-Bridge navigation
system. The Off-course Alarm System enables you to monitor when – and by how
much – the vessel is sailing off-course.

The system monitors the vessel’s actual heading in relation to a required heading
(effectively a heading set-point that is local to the Off-course Alarm System).

The heading set-point that the Off-course Alarm System uses can either be specified
by you (if the vessel is being steered manually) or the system can receive it from the
autopilot (if the autopilot is operating).

15.2 The Off-course Alarm pane
The user interface to the Off-course Alarm System is a single dialog called the
Off-course Alarm pane.

If the Off-course Alarm System is installed for your vessel, you can access this dialog
from the:
• ECDIS and Conning applications. Select: Options→Conning Panes→Off-course Alarm

Pane

• Radar application. Select: Tools→Options→Conning Panes→Off-course Alarm Pane.

Figure 82 The Off-course Alarm pane
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The heading set-point that the system is currently using appears as a vertical orange line
on the heading scale in the Off-course Alarm pane.

On either side of it are two vertical red lines. These mark the limits of the range within
which the vessel’s heading is permitted to deviate from the heading set-point before the
system issues an off-course alarm. You can increase or decrease these limits by using
the buttons at the bottom of the Off-course Alarm pane (see Specifying the permitted
deviation on page 294).

15.3 Using the off-course alarm system
To turn on and use the off-course alarm system:
1 Check the ON box under System Settings in the Off-course Alarm pane.
2 If the vessel is being steered:

• Manually, when the heading in the top right-hand corner of the Off-course Alarm
pane represents the direction in which you want to sail, click the Use HDG button.
The off-course alarm system then takes the current heading value (as it was at the
moment when you clicked the Use HDG button) as its new heading set-point.
You will see the vertical orange line indicating the heading set-point appear in a
different position on the heading scale.

• By the autopilot, check the Follow the autopilot option.
The Off-course Alarm System then takes the autopilot’s current heading set-point
as its new heading set-point.
You will see the vertical orange line indicating the heading set-point appear in a
different position on the heading scale.
Whenever the autopilot’s heading set-point changes, the Off-course Alarm
System’s heading set-point will change to the same value.

From now on the Off-course Alarm System monitors the vessel’s heading in relation
to the Off-course Alarm System’s heading set-point. If the vessel’s heading deviates
from that set-point by more than the currently permitted limit, then the system issues
an off-course alarm.
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15.4 Specifying the permitted deviation
At the bottom of the Off-course Alarm pane is a section called Set limit. This section
of the dialog concerns the “alarm limits”: it displays the number of degrees by which
the vessel’s heading is currently permitted to deviate from the required heading (in
other words, from the Off-course Alarm System’s heading set-point) before the system
issues an off-course alert.

You can adjust the number to suit your requirements. Use the:
• < and > buttons to increase or decrease the permitted deviation by 1° either side

of the heading set-point.
• +10 and -10 buttons to increase or decrease the permitted deviation by 10° either

side of the heading set-point.

Figure 83 The buttons for specifying the permitted deviation

15.5 Operating statuses
Table 19 Off-course alarm system operating statuses: manual steering

Operating status System settings Meaning
The system is monitoring
whether the vessel is
off-course.
The heading set-point is
whatever the heading value
was when the Use HDG
button was last pressed.

On
Set course: Use HDG

The vessel is either
on-course or it is off-course
within the currently
permitted limits: no
off-course alarm has been
issued.

Off
Set course: Use HDG

An operator has un-checked
the ON box. The system is
not monitoring whether the
vessel is off-course.
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Table 19 Off-course alarm system operating statuses: manual steering (cont'd.)

Operating status System settings Meaning
The system is monitoring
whether the vessel is
off-course.
The heading set-point is
whatever the heading value
was when the Use HDG
button was last pressed.

On
Set course: Use HDG

The vessel is off-course by
more than the permitted
limit: an off-course alarm
has been issued.

381287/A 295



K-Bridge Multi-functional Display Unit

Table 20 Off-course alarm system operating statuses: autopilot steering

The system is monitoring
whether the vessel is
off-course.
The system is receiving its
heading set-point from the
autopilot.

On
Set course: Follow the
autopilot

The vessel is either
on-course or it is off-course
within the currently
permitted limits: no
off-course alarm has been
issued.

On
Set course: Follow the
autopilot

The system has temporarily
stopped monitoring
whether the vessel is
off-course either because
the autopilot is no longer
operating or because the
vessel is performing a turn.

When the system receives
a heading set-point from
the autopilot that is outside
the alarm limits associated
with the previous heading
set-point, it assumes that
the vessel is performing a
turn and stops monitoring.

The system starts
monitoring again as soon
as the vessel’s heading
is inside the alarm limits
associated with a new
heading set-point received
from the autopilot. (When
the heading is inside the
alarm limits, the system
assumes that the turn is
complete.)
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Table 20 Off-course alarm system operating statuses: autopilot steering (cont'd.)

The system is monitoring
whether the vessel is
off-course.

On
Set course: Follow the
autopilot

The vessel is off-course by
more than the currently
permitted limit: an
off-course alarm has
been issued.
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16 Some useful tools
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16.1 Introduction
This chapter describes some useful tools and utilities available from the menus on the
Multi-functional Display unit. Most of them are available from the Tools menu (see
Tools menu on page 543), but note that the Tools menu is different in the different
applications on the MFD unit. Others are available from the Own Ship and Chart menus.

16.2 Entering a position offset
If you need to specify an offset from WGS-84: do the following.
1 Click the OFFSET/NO OFFSET button in the top bar (see Top bar: the position

and offset buttons on page 74).
• The Pos. Offset menu is displayed (see Position Offset on page 443).
• The offset can be entered either as a position offset (in latitude and longitude) or

as a bearing and range offset.
2 Use the button to select the appropriate mode.
3 Enter the offset.
4 Click Apply.

16.3 Using the EBL/VRM tool
Two Electronic Bearing Lines (EBL) and Variable Range Markers (VRM) are available
and can be displayed simultaneously. The EBL and VRM always appear in pairs. A
number at the base of the EBL identifies each pair.

16.3.1 Creating and adjusting an EBL/VRM pair
1 Turn the EBL/VRM on using the buttons on the radar dashboard (see Radar

dashboard: the Navigation Tools panel on page 86).
The EBL/VRM will appear centred on the own-ship.

2 Adjust the EBL direction by dragging the line using the track-ball and Left mouse
button.

3 Adjust the VRM's diameter by dragging the circle using the track-ball and Left
mouse button.

4 Adjust the EBL and VRM simultaneously by dragging the intersection between the
two using the track-ball and Left mouse button.

5 Move the EBL/VRM pair by dragging the centre using the track-ball and Left
mouse button.
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• An EBL/VRM pair centred on the own-ship will move with the own-ship.
An offset pair will either move with the own-ship or be geographically fixed,
depending on whether the M (moving) or F (fixed) option is selected (see Radar
dashboard: the Navigation Tools panel on page 86).

Figure 84 Adjusting an EBL/VRM pair

6 To obtain an exact bearing or range use the spin buttons for the bearing and range
fields next to the EBL, VRM button.

7 To select true or relative bearing, use the radio buttons next to the EBL, VRM button.
Only relative bearings are possible in Head Up mode, which is selected
automatically when heading input fails.
When the own-ship changes its heading, a true EBL/VRM pair will keep its 0°
referenced bearing, and a relative EBL/VRM will keep its bearing relative to the
heading line.
For important considerations about the accuracy of the EBL/VRM tool, see The
accuracy of the EBL/VRM tool in the Radar application on page 302.

8 To remove an EBL/VRM pair, just click the EBL VRM button for the EBL/VRM
pair you want to remove.

16.3.2 Displaying your EBL/VRM on another operator
station
You can display your EBL/VRM pair or pairs (optionally along with the cursor and/or a
curved EBL) on the screen of another operator station. For information about how to do
this, see Sharing your markers and viewing remote markers on page 311.
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16.3.3 The accuracy of the EBL/VRM tool in the Radar
application
The accuracy of the EBL and VRM tool in the Radar application varies with the position
of the line or marker on the screen and depends critically upon the precision with which
the radar has been aligned during installation.

Measuring from the CCRP to radar targets
The EBL/VRM tool has been tested on a properly adjusted radar installation against
known radar targets and the:
• EBL has been found to be accurate to within 1° for targets close to the edge of the

display. For echoes closer to the centre of the display, the accuracy of the EBL is
reduced.
When you are working with true bearing measurements (referenced to north), you
must allow for any known error in the gyro bearing as well as the EBL's relative error.

• VRM has been found to be accurate to within 1% of the selected range scale. For
example, on a 3NM range scale the VRM has been found to be accurate to within
0.03NM, and on the lowest range scale it has been found to be accurate to within
30m or 0.016NM.

If the radar's heading line and range have not been properly adjusted during installation,
these levels of accuracy will not be attained.

When you are using the EBL/VRM tool on radar targets, remember that the radar echoes
are extended both in bearing and range beyond the targets' actual bearing and range. This
is an effect of the opening angle of the radar beam and the pulse length of the radar
transmitter (see diagram below).
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Measuring from the CCRP to chart objects

If you are using the EBL/VRM tool to measure from the own-ship to objects in the chart,
the uncertainties will be dominated by the uncertainty of the own-ship's position and
by uncertainties in the chart itself. At high latitudes (close to the North or South Poles)
additional uncertainties arise when you are using high range scales; this is because
the chart is displayed in Mercator projection. When the combination of latitude and
the selected range scale is significant in this regard, the radar system issues a “Chart
projection mismatch” alarm.

16.3.4 The advanced EBL/VRM tool on ECDIS
In ECDIS more advanced EBL/VRM facilities are available, including great circle and
rhumb-line geometry (see EBL/VRM Advanced on page 546).
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16.4 Using parallel index lines
You can place up to four parallel index lines on the radar display to use as general
purpose navigation guides.

A number in the middle of the line identifies the line that is selected.

Parallel index lines are either fixed relative to the own-ship's heading (relative mode) or
they have a fixed orientation that is independent of the own-ship's heading (true mode).

In relative mode parallel index lines follow the heading line when the own-ship changes
course.

In true mode the bearing of the parallel index lines is geographically fixed.

In both modes, the distance from the own-ship to the line is constant.

To create a parallel index line, do the following:
1 Select Tools→Parallel Index Lines.
2 Click New to insert a new parallel index line.

The parallel index line will appear to one side of the own-ship.
3 To change the distance the own-ship to the line, drag the rectangular handle using

the track-ball and Left mouse button, or enter the required distance into the Distance
field of the Parallel Index Lines menu (see Parallel Index Lines on page 548).

Figure 85 Parallel index lines
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4 To change the bearing drag the line (not the rectangular handle) using the track-ball
and Left mouse button, or enter the bearing into the Bearing field of the Parallel
Index Lines menu.

5 To truncate a parallel index line, select it in the display (by using the track-ball and
Left mouse button), check Truncate in the Parallel Index Line menu, then click the
Left mouse button at the point on the line where you want it to end.
When you have truncated a line, you can stretch or contract it by dragging the ends.
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16.5 Using position lines to estimate the
own-ship's position

The position line facility (available only in the ECDIS application) allows you to make
visual position fixes if you want to:
• Check that the automatic position fixing system (GPS or some other system) is

working correctly,
• Get an approximate manual position fix because the automatic position fixing system

has failed.

The facility is provided by the Position Line dialog which allows you to create two
or three position lines on the chart. These can be (straight) bearing lines or (circular)
range lines.

To bring up this dialog, select Tools→Position Line. For a description of the Position
Line dialog, see Position Line on page 549.

To obtain a reliable position fix we recommend you measure the bearings to visually
conspicuous objects on the horizon that are easily identifiable on the chart. The measured
bearings should preferably intersect at right angles. Specify the bearing that changes
fastest (i.e., the athwart ship movement) last.
1 Click the New Bearing button to create a new bearing measurement entry in the

table and to fix the time for it.
2 Select the new table entry and click the Get Cursor button.
3 Click on the point in the chart that you intend to use as the reference point (choose a

point that corresponds to the position of an identifiable object on the horizon).
Its latitude and longitude appear in the table entry for the measurement.

4 In the BRG/RAN column, specify the bearing from the own-ship to the specified
reference point.
This creates a position line in the chart.

5 Repeat the previous steps once or twice (depending on whether you are using two or
three reference points).
The latitude and longitude that appear in the Intersection field give you a position fix.

6 To insert a position-fix object in the chart itself, click the Define Position Fix button.

When you use position lines whose measurements have been taken at different times, the
system updates the old measurements by estimating the ship's movement since they were
taken; this enables it to give a position fix appropriate to the time of the last measurement.

The figure below displays a position fix that has been obtained from two bearings and
one range measurement.

The athwart bearing line (marked 0759) and the range position line (marked 0800)
have been transferred to the last measurement time (marked 0803/TPL) before being
intersected with the forward position line (marked 0803).
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Figure 86 Sample position fix (using two bearings and one range measurement)
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16.6 Using the curved EBL facility
The curved EBL is a tool that enables you to plan and execute a turn by specifying a
fixed turn radius. The curved EBL tool can be operated in two modes: "Autopilot Mode"
and "Planning Mode".
In Autopilot Mode, the turn will be executed immediately (or, if the Preset Turn box is
checked, it will be executed immediately you click the Activate button in the Curved
EBL menu; see Trial Manoeuvre and Curved EBL on page 473).
In Planning Mode, you can specify a particular time and distance to the beginning of
the turn.

16.6.1 Specifying planned turns (planning mode)
1 Display the Curved EBL menu as follows: Tools→Curved EBL.
2 In the dialog select Plan Mode and Enable (see Trial Manoeuvre and Curved EBL

on page 473.

3 Course after the manoeuvre
To set the course at the end of the manoeuvre drag the curved EBL using the
trackball and Left mouse button, or in the Curved EBL dialog click the spin buttons
for New Heading (see The heading wheel on page 41).

4 Distance to the manoeuvre
To set the distance to the start of the manoeuvre, drag the closest "▫" handle to the
own-ship on the curved EBL, or in the Curved EBL dialog click the Distance to
Turn spin buttons.

5 Turn radius
To set the turn radius for the manoeuvre drag the "▫" handle for Turnpoint 2 (see
above) on the curved EBL, or in the Curved EBL dialog click the Turn radius spin
buttons.
• The waypoint is not changed when you change the turn radius. This means that

the time and distance to the start of the turn will change.
6 Start over again (if you want to)

Use the Reset button to set the parameters to their initial values if you want to start
over.
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7 Activate the route
• For systems fitted with an autopilot the curved EBL can be used as input to

control the autopilot.
• The autopilot must be in command and operating in either heading or course

mode.
Click Activate or press the ACT TURN button on the operator panel (see The ACT
TURN button on page 38) to convert the curved EBL to an active route.
The autopilot will go into Track mode to execute the planned turn; the Track mode
LED on the operator panel will be lit, and the Route Monitor dialog will be displayed.
Note

Execution of automatic steering along a track you have defined as a planned turn is
not possible if another route is currently being monitored.
Also it is not necessary for planned turns to be verified before they are executed.

8 When you have completed the planned turn, exit Track mode (and revert to Heading
mode, taking the current heading as set-point), by doing one of the following:
• Select HDG or CRS mode in the Autopilot Mode dialog.
• Press the ACT TURN button twice to enter Heading mode.

For more information, see Track steering using the curved EBL tool on page 253.

16.6.2 Aborting a planned turn
To abort a planned turn after activating it, press the ACT TURN button on the operator
panel twice (see The ACT TURN button on page 38). This causes the autopilot to revert
to Heading mode, using the current heading as its set-point.

16.6.3 Specifying preset turns (autopilot mode)
If you want to use the curved EBL as input to the autopilot, the autopilot must be in
command of the vessel's steering gear, and the autopilot must be operating in either
heading or course mode.
You can use the curved EBL to provide immediate input to the autopilot (on other words,
to steer the vessel). Or by checking the Preset Turn box in the Curved EBL menu, you
can delay the execution of the curved EBL until you click the Activate button (see Trial
Manoeuvre and Curved EBL on page 473).
To use the curved EBL as input to the autopilot, do the following:
1 On the Nav OS console's operator panel, press IN CMD (see The IN CMD button

on page 37).
2 In the Nav OS application, select Route→Autopilot Mode.

Then select either Hdg or Crs mode:
• Hdg: The selected heading and turn radius will be sent to the autopilot.
• Crs: The calculated drift is added to the heading order.
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3 Press the AUTO/PLAN button once or select Tools→Curved EBL.
The AUTO/PLAN button is on the operator panel (see The AUTO/PLAN button on
page 39). Press it once to bring up the Curved EBL dialog and to transition the
display from the real-time view of the vessel to the view that enables you to plan a
turn (press the button again to toggle back to the real-time view).

4 Select ENABLE in the Curved EBL dialog.
5 If you want the turn you specify to execute immediately, leave the Preset Turn

box un-checked.
If you want to delay execution of the turn until later, check the Preset Turn box.

6 To set the course at the end of the manoeuvre drag the curved EBL using the
track-ball and Left mouse button, or in the Curved EBL dialog click the spin buttons
for New Heading.
During the period that the heading wheel and turn radius buttons are activated for
the performance of an immediate turn, numeric values for the specification of the
turn appear next to the curved EBL and the own-ship symbol.

7 To set the turn radius for the manoeuvre drag the "▫" handle on the curved EBL, or in
the Curved EBL dialog click the Turn radius spin buttons.
The selected turn is executed either:
• immediately (if the Preset Turn box is un-checked),
• or (if the Preset Turn box is checked) as soon as you click the Activate button in

the Curved EBL dialog or press the ACT TURN button on the operator panel (see
The ACT TURN button on page 38).

The vessel's minimum and maximum turn radius are set in the Ship tab of the
Parameters Setup dialog (see Ship (tab) on page 571). If you need to find out what
they are, select either of the following:
• OwnShip→Ship Parameters

• System→Parameter Settings→Ship (tab).

For more information, seeUsing the curved EBL facility on page 308.

16.6.4 Aborting an immediate or preset turn
With the autopilot operating in Heading or Course mode, you can abort an immediate or
preset turn at any time either by:
• Changing the heading set-point (in other words, by performing a new immediate

turn or a new preset turn)
• Or by pressing the ACT TURN button on the operator panel twice (see The ACT
TURN button on page 38). This causes the autopilot to take the current heading as
its set-point.
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16.7 Sharing your markers and viewing
remote markers

16.7.1 Letting other operator stations display your cursor,
EBL/VRM and curved EBL
You can let people at other operator stations view the markers – that is, the cursor,
EBL/VRM pair or pairs, and/or curved EBL – from your operator station on their screens.

This is useful, for example, if you are planning a turn using the curved EBL facility and
before executing it you want someone else to see it who is standing at another operator
station some distance from your own.

To make your markers available to other operator stations on the bridge:
1 Select View→Remote Markers.
2 Check the option to Send Marker Data.
3 Tell the person at the other operator station to follow the instructions for Viewing the

cursor, EBL/VRM and/or curved EBL from another operator station on page 311.

16.7.2 Viewing the cursor, EBL/VRM and/or curved EBL
from another operator station
To display the markers – that is, the cursor, EBL/VRM pair or pairs, and/or curved EBL
– from another operator station on your screen, do the following:
1 Make sure the operator station whose remote markers you want to see is making

them available to the other operator stations on the bridge (see Letting other
operator stations display your cursor, EBL/VRM and curved EBL on page 311).

2 Select View→Remote Markers.
3 Select Display Remote Markers, and specify one or more of the sub-options Cursor,

EBL/VRM, and Curved EBL.
4 From the Source drop-down menu, specify the operator station whose remote

markers you want to see on your screen.
The remote markers you selected for the specified operator station now appear on
your screen. They are labelled with the name of the operator station that provided
them (for example, MFD-1) and their shapes are composed of faint yellow dots to
distinguish them from the heavy orange lines and dashes used for the operator
station’s own markers.

381287/A 311



K-Bridge Multi-functional Display Unit

Figure 87 Remote markers displayed alongside an operator station’s own markers
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16.8 Using the trial manoeuvre facility
The Trial Manoeuvre facility (available only in the Radar application) enables you to
specify a point on the curved EBL at which to view the future position of the own-ship
in relation to other vessels if the manoeuvre represented by the curved EBL is actually
executed. (The Trial Manoeuvre facility shows the own-ship in relation to both tracked
radar targets and reported AIS targets.)
In other words, the Trial Manoeuvre facility enables you to predict how close you will
come to a collision with another vessel if you perform a specified turn.

16.8.1 Limitations
• The Trial Manoeuvre is available only when the own-ship has a speed of at least 1

knot.
• Only one manoeuvre of the own-ship can be simulated at a time. The manoeuvre can

include both a course and speed change, but both must start simultaneously.
• It is assumed that the targets will continue at a constant course and speed.

(Manoeuvres by the targets are not simulated.)
• You can move the trial distance point to any point on the manoeuvre's time/distance

line. However, the maximum trial distance is the point that would be one hour's
sailing from the own-ship's current position (given the specified New Speed and
Speed Rates; see Trial Manoeuvre and Curved EBL on page 473).

16.8.2 Operation
1 Select true or relative motion for the display (see ECDIS range panel: viewing

controls on page 88).

Note

Trial manoeuvre is most effective as a tool for collision avoidance when the radar is
displaying in relative motion using water stabilisation.

2 Select ground or water stabilization by checking the Ground or Water radio button
in the radar dashboard (see Radar dashboard: the range panel on page 79).

3 Click the following sequence in the menu area: Own Ship→Trial.
4 In the Curved EBL dialog (see Trial Manoeuvre and Curved EBL on page 473)

select Enable and Trial Man.
• When the trial manoeuvre facility is running, a large green "T" flashes at the

bottom of the radar area.
5 Course after the turn

To set the course after the turn, perform one of the following sequences:
- drag the curved EBL using the track-ball and Left mouse button
- in the Curved EBL menu click the spin buttons for New Course

- rotate the Heading wheel
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- click the Heading buttons on the Heading wheel
See section 1.6 on page 41 for Heading wheel information.

6 Manoeuvre turn radius
To set the turn radius for the manoeuvre drag the second handle (marked "g" in the
illustration) on the curved EBL, or in the Curved EBL menu use the Turn radius spin
buttons, or click the Turn radius buttons on the Heading wheel.
• The waypoint is not changed when the turn radius is changed. This means that

the time and distance to the start of turn will change.
7 Time or distance to the manoeuvre

To set the time or distance to the start of the manoeuvre, do one of the following:
• drag the first handle (marked "f" in the illustration) on the curved EBL
• in the Curved EBL menu use the Time to Turn/Dist. to Turn spin buttons
• click the Distance To Turn buttons on the Heading wheel

8 Speed to the Trial Manoeuvre point
To set the speed that the vessel is assumed to be travelling at for the purpose of the
Trial Maneouvre calculations:
a In the Curved EBL menu use the spin buttons for New Speed.
b If the vessel is not currently travelling at the new speed, set a value for Speed

Rate. This is the rate of acceleration or deceleration to be assumed from the
vessel's current actual speed to the new speed
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Figure 88 Example showing trial manoeuvre
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9 Moving the Trial Manoeuvre point
The Trial Dist. value (in the Curved EBL menu) is a point on the time/distance line
for the manoeuvre. It is marked by a "T" and a cross line on the radar display (see
Figure 88 on page 315). Moving this point allows you to see the position of the
own-ship and tracked targets at different points in the trial.
To move this point:
• Drag the cross line marked "T "on the curved EBL
• Or in the Curved EBL dialog use the spin buttons for Trial Dist.
Presentation of tracked targets
• Tracked targets are shown with a dashed line (marked "c" in the illustration)

connecting their present position with their predicted position when the own-ship
is at point “T”.

10 Target data
To see the data for a tracked target during trial manoeuvre, position the cursor at
the present position of the target, and click DATA on the operator panel (see The
TARGET group buttons on page 35). CPA and TCPA are the values for the trial
manoeuvre.

11 CPA circle
Select CPA Circle in the Curved EBL dialog to draw a Closest Point of Approach
circle around the own-ship symbol when it is at point "T".
The radius is the configured CPA limit.
To check if any targets will come closer than the CPA limit, drag the cross line
representing the Trial Manoeuvre point and see if any targets come inside the CPA
circle.

12 Activation of the trial manoeuvre
If the K-Bridge Radar is set up to control the autopilot, you can use the curved EBL
from your Trial Manoeuvre to steer the ship. To do this, press the ACT TURN button
on the ALC NAV panel (see The ACT TURN button on page 38) before closing the
curved EBL window for the current Trial Manoeuvre.
The curved EBL is translated into a sailing route that the autopilot will follow.
When the turn is completed the curved EBL is switched off.
Caution

The predictions made by the Trial Manoeuvre facility assume that tracked
targets continue at their current course and speed. This may not be the
case. As a result of heavy sea or rain clutter, or for other reasons, the
target vectors may be unstable. This will influence the quality of the CPA
and TCPA predictions. Evaluate the situation carefully!
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16.9 Displaying the own-ship's predicted
movements

In the Radar and ECDIS applications you can display predicted positions for the
own-ship, based on the its current heading, speed and rate of turn.

Figure 89 A ship's predicted “corridor” of movement and five predicted positions

To display the vessel's predicted movements:
1 If you are in the:

• Radar application, select View→Main Radar Themes, and check the Display Ship
Outline option (see Radar Themes on page 371).
Then select System→Parameter Setup (Display tab).

• ECDIS application, select System→Parameter Setup (Display tab), and check the
Display Ship Outline option.

2 In the Display tab (see Display tab on page 565), check the Predict Ship Movement
option.
The corridor of predicted movement and the predicted positions appear on the
display.

3 Click Setup to specify the number of predicted positions you want to see, the
interval (in seconds) between each predicted position, and the length (in seconds) of
the corridor of predicted movement (see Ship's movement predictor setup dialog
on page 568).
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16.10 Identifying a target interception
point

In both the Radar and ECDIS applications, you can identify a point at which to intercept
a target, given the current speed and bearing of both the target and the own-ship.

The interception point can be based on either an absolute or a relative target position.

16.10.1 Using an absolute target position
To find the point of interception between the target and the own-ship, do the following:
1 From the main menu select Tools →Target Interception.
2 Click Select Target.

This activates the Target Interception function. You can now use the cursor in the
main area of the radar display to select a target.
When you have selected a target, the system computes a valid interception point (IP)
and draws bearing lines from the own-ship to the IP and from the target to the IP.
These lines will be updated once per second until you click the Stop Tracking button.

3 To stop tracking the IP for the selected target, click Stop Tracking in the Target
Interception dialog.

For a full description of the Target Interception dialog, see Target Interception on
page 558.

318 381287/A



Some useful tools

16.10.2 Using a relative target position
You can also use the Target Interception dialog to find out what the interception point
would be between the target and the own-ship if the target were in a different position
(relative to its current actual position). This can be useful, for example, for intercepting a
target ahead of, behind or alongside the target.
1 From the Main Menu select Tools →Target Interception.
2 Click Select Target to activate the Target Interception function.
3 Specify the range and bearing values that define a position relative to the target's

actual position.
Do this either by using the spin buttons for the relative range and bearing fields or
by clicking the R. Pos (Relative Position) button.
Any of these three actions causes an EBL/VRM to be displayed with its centre on
the selected target. Use the mouse or track-ball and left mouse-button to re-size the
range circle and drag the bearing line (see Using the EBL/VRM tool on page 300).
The EBL/VRM moves with the target.
Note

The relative range is given by the range circle, and when you re-size the range circle
the new relative range is reflected in the Target Interception dialog. The relative
bearing is given by the EBL. The bearing line is drawn on the chart relative to the
target's heading, and when you move the bearing line the new value is reflected in
the Target Interception dialog. The point at which the EBL intersects the range
circle is the relative target position.
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4 When you are happy with the range and bearing values, and with the relative target
position you have specified, press the Apply button.

5 To stop tracking the IP for a particular target, click Stop Tracking in the Target
Interception dialog.

For more information about the Target Interception dialog, see Target Interception on
page 558.
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16.11 Using the stopwatch and countdown
facilities

The Radar, ECDIS and Conning applications all include a stopwatch and countdown
facility.

16.11.1 Using the stopwatch
To use the stopwatch, do the following:
1 From the main menu, select Tools →Stopwatch.

The Stopwatch dialog appears (for a description of this window, see Stopwatch
on page 556).

2 To start the stopwatch, click the Start button.
The clock starts counting in 1/100s of a second (and the Start button becomes a
Stop button).

3 To record split times, click the Split button.
4 To stop timing, click the Stop button
5 To resume timing, click the Start button.
6 To reset the stopwatch to 00:00:00.00, click the Reset button.

16.11.2 Using the countdown facility
The countdown facility is available from the stopwatch dialog. It enables you to run the
stopwatch in reverse, counting down in 1/100s of a second from a specified amount of
time (instead of counting up from 00:00:00.00).
When the countdown reaches zero, it stops and an alarm is issued.
To use the countdown facility, do the following:
1 From the main menu, select Tools →Stopwatch.

The Stopwatch dialog appears (for a description of this window, see Stopwatch
on page 556).

2 Check the Count down box.
3 In the upper time field, type in the amount of time that you want to count down from.
4 Click the Start button.

The clock starts counting down in 1/100s of a second (and the Start button becomes
a Stop button).

5 To record split times, click the Split button.
6 To review split times, use the arrow buttons.
7 To stop counting down, click the Stop button.
8 To resume counting down, click the Start button.
9 To reset the counter to 00:00:00.00, click the Reset button.
When the countdown reaches zero, it stops and an alarm is triggered.
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16.12 Calculating the time, distance and
speed for a journey

To calculate the time, distance and speed for a planned journey, use the
Time/Distance/Speed calculator.

To use this, from the main menu, select Tools →Time/Distance/Speed calc, then follow the
instructions below.

For a description of the Time/Dist/Speed dialog, see Time/Distance/Speed Calculator
on page 557.

16.12.1 Calculating the time a journey will take
To calculate the time that a journey you are planning will take:
1 Type in the journey's distance (check the 'm' box if you are using metres instead

of nautical miles).
2 Type in the speed you expect to travel at (check the 'm/s' box if you are using metres

per second instead of knots).
3 Click the Time button.

16.12.2 Calculating the distance of a journey
To calculate the distance of a journey:
1 Type in the speed at which you expect to travel on average (check the 'm/s' box if

you are using metres per second instead of knots).
2 Type in the time you expect the journey to take.
3 Click the Distance button.

16.12.3 Calculating the speed required
To calculate the average speed you need to maintain to cover a specified distance in a
specified time:
1 Type in the distance for the journey (check the 'm' box if you are using metres

instead of nautical miles).
2 Type in the time you expect the journey to take.
3 Click the Speed button.
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16.13 Using the trip meter
A trip meter is provided in the Tools menu to enable you to record the distance covered
for a particular journey. You can also use it in reverse (by checking the Count down box)
to measure the distance that remains to be covered for a journey of a specified distance.

For more information about the Trip Meter window, see Trip Meter on page 555.

16.13.1 Measuring the distance travelled
When you are ready to start measuring the distance travelled by the vessel, do the
following:
1 From the main menu, select Tools →Trip Meter.
2 In the Trip Meter window, press the Start button.

The trip meter starts recording the distance travelled in nautical miles (also the
Start button changes into a Stop button).

3 To record split distances, click the Split button.
4 To review split distances, use the arrow buttons.
5 To stop the trip meter, click the Stop button
6 To resume, click the Start button.
7 To reset the trip meter to 0.00, click the Reset button.

16.13.2 Measuring the distance that remains to be travelled
To measure the distance that remains to be covered for a journey:
1 From the main menu, select Tools →Trip Meter.
2 Check the Count down box.
3 In the upper distance field, type in the total distance for the journey.
4 To start counting down the distance click the Start button.
5 To record split distances, click the Split button.
6 To review split distances, use the arrow buttons.
7 To stop the trip meter from counting down the distance, click the Stop button
8 To resume, click the Start button.
9 To reset the trip meter to 0.00, click the Reset button.

When the trip meter's distance countdown reaches zero, it stops and an alarm is triggered.
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16.14 Using the anchor watch function
The radar system has a built in anchor watch function that can be applied either to the
own-ship or to a target vessel.

16.14.1 The own-ship anchor watch facility
1 Select: Own Ship→Anchor Watch.
2 Click the Bow To APOS to set the own-ship's current position as the anchor watch

position.
3 Enter a deviation limit using the track-ball and Left mouse button.

For more information, see Own Ship Anchor Watch on page 471.
4 Select Active to activate the alarm if the own-ship's position deviates more than the

specified limit from the anchor watch position.

16.14.2 The target anchor watch facility
1 Click the following sequence of softkeys in the menu area: Targets→Target Anchor

Watch.
2 Select the tracked target you want to watch using the track-ball and Target Data

button.
3 Click the Set Current button to set the target's current position as the anchor watch

position.
4 Enter a deviation limit using the track-ball and Left mouse button.
5 Select Active to activate the alarm if the target position deviates more than the limit

from the anchor watch position.
See section 20.3.6 on page 410 for more information.

16.15 Logging the voyage details

16.15.1 Configuring and saving the past track log
The system keeps a continuous record of the ship's past track for the last 12 hours.
It records the following details:

Table 21 Past track parameters

Past track Chart
Time ENC source
Position Edition
Heading Date
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Table 21 Past track parameters (cont'd.)

Past track Chart
Speed Cell

Update history

To change the settings or to save the past track log do the following:
1 To display the past track, select View→Main Radar Themes and select Own Ship Past

Track (to display the track as a thick line) and Past Track Labels (to display the
time at the various positions).

2 On the monitor select OwnShip→12 hr Log Control.
3 Select the Track tab (see section Track tab on page 573).
4 Use the Log Interval spin buttons to change the time between each logging (or select

the box and type in the interval). In most cases the initial setting of logging every 10
seconds is sufficient (adjustable between 5 and 60 seconds).

5 Use the Past Track Displayed spin buttons to select how many minutes of track
history you want displayed.

6 Use the Past Track Label Interval spin buttons to specify the interval between time
labels on the past track line.

7 Click Save to Folder to save the track log to the system hard disk.
8 To select a filename or to reduce the interval for the log file click Save As. Specify

the file name and the interval. Click Save to Folder.
9 Click Save to Medium.
10 Specify the filename and the interval.

11 Click Save to Medium.

16.15.2 Recording the voyage
The system can record the own-ship's track for the entire voyage. The navigator
chooses the recording interval and defines the voyage by manually starting and stopping
recording. Where a voyage includes several ports, the voyage recording can be paused
on reaching a port and resumed on leaving it again.
Do the following:
1 Select OwnShip→Voyage Recording.
2 Select the Voyage tab. See section 20.10.2.5 on page 577 for more information.
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3 Use the Voyage Display Label Interval spin buttons to change the time between each
logging (or select the box and type in the interval).
In most cases the initial setting which logs data every 10 seconds is sufficient (but
you can choose a setting of between 5 and 60 seconds).

4 Use the Past Track Displayed spin buttons to specify how many minutes of track
history you want displayed.

5 Use the Past Track Label Interval spin buttons to specify the interval between time
labels on the past track line.

6 Click Start New Voyage to start saving voyage data to the system hard disk. The
file name will be as follows:

7 Click End Voyage when you have reached port or want to end voyage recording.
8 Click Resume Voyage to continue the voyage after calling at a port.
9 Click Voyage List to display a list of recorded voyages and past track logs.

16.15.3 Replaying past track or voyage logs
Saved track and voyage logs can be replayed when required. Do the following:
1 Select Own Ship→Recording List.
2 Select the Track Log or Voyage Log you want to replay.
3 Click Display.
4 Click Replay.

Caution

When you click the Play button the displayed information comes from the
log file. The yellow REPLAY is ON button is a warning that the own-ship's
current position is not displayed. Click this button or click Cancel to
display the own-ship's current position.

Note

The system keeps track of the best chart available for every position, but it does not
keep track of the scale used or the chart that was actually displayed at each position
during the voyage.

The progress indicator gives an impression of where in the log file the replay is
currently located.

5 Drag the slider to move quickly to a different location in the file.
6 To replay faster or slower than the original recording use the Speed spin buttons.
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7 Select Interpolate to view a smooth replay between recorded intervals.

16.15.4 Viewing the past track or voyage log as text
The past track or voyage log can be viewed as text. To view it this way, do the following:
1 Select Own Ship→Recording List.
2 Select the log file you want to view by clicking it.
3 Click Show Text.
4 Specify the start time for the part of the logged data that you want to see.
5 Specify the end time for the part of the logged data that you want to see.
6 Optionally specify the time interval you require between the items of logged data

displayed.
7 Check the Print AIS and ARPA Targets button if you want to include AIS and ARPA

Target data in the logged information displayed. (However, you need to be aware
that this might produce a lot of output.)

8 Click Show as Text.

16.15.5 Printing out the past track or voyage log
The past track or voyage log can be displayed or printed on a separate PC. However
the recorded data is protected against manipulation and requires a special program to
be displayed. Do the following:
1 Insert a removable medium into the operator station computer.
2 Select System →Maintenance.
3 Click Copy Log Decoding Program to Medium.

• The program is saved to the medium.
4 Do one of the following:

• Select OwnShip→Recording List, then:
a From the list, select the voyage log file that you want to view.
b Click Back-up.
c Note down the file name, for example, V120822A.voy.

• Select OwnShip→12hr Log Control, then:
a Click Save to Medium.
b Note down the file name, for example, L120909A.log.

5 Click Save to Medium.
6 Take out the removable medium and insert it into a separate PC.
7 Open a command prompt window by selecting:

Windows Start→Run...
and typing:
cmd
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8 Go to the directory that you saved the log decoding program to and run the setup
file (ListLogInstall.exe).
When prompted, specify an installation path for the program.
The program creates a bin folder at the destination you specified; the folder contains
some executable files (one of which is called ListLog.exe).

9 When the installation finishes, copy the voyage or past track log file that you
previously saved into the same folder as the new executables.

10 To display the file on the screen, run the listlog program from the command line,
giving it the name of the log file as a parameter; for example:
listlog V120822A.voy |more

Use the |more parameter if the file is too long to view in the command window.

11 Before you can print out the log, you must create an ASCII text file containing it.
To do this, run the listlog program from the command line, but this time give it
as parameters both the name of the log file and a name for the target text file (the
target filename must have a > (greater than) sign before it). For example:
listlog V120822A.voy >V120822A.txt

12 The file can now be opened, viewed and printed from a text editor.
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Figure 90 A sample voyage log converted to text and viewed in Windows Notepad

16.16 Capturing depth data for other
applications

Depth recording is an option and is not available with all systems. Depth files are
stored in binary format. If you want to use the depth recording for other purposes do
the following:
1 Save the depth file to disk (see Backup Depth Recording on page 467).
2 Use the Voyage/Log printout program to read the file (see Printing out the past

track or voyage log on page 327).
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3 The data is converted to an alphanumeric format that can be interpreted by other
programs.

Figure 91 Text output from depth file
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17 Alert handling

This section contains the following topics:
Introduction....................................................................................................................332
Alerts that must be acknowledged from the station that generated them ......................332
Handling target alerts in ECDIS ....................................................................................333
Acknowledging alerts using the buttons on the top bar.................................................333
Acknowledging alerts using the operator panel.............................................................333
Acknowledging alerts using the unacknowledged alerts list .........................................334
Acknowledging several alerts at once............................................................................335
Acknowledging alerts that have been received by several consoles..............................335
Silencing alerts from other consoles ..............................................................................336
Viewing current and past alerts......................................................................................336
Issuing alert output to an external alarm system............................................................344
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17.1 Introduction
This chapter describes the different ways of acknowledging – and also of viewing lists of
– alerts on the MFD unit.

For descriptions of all the navigation alerts and system operator messages you might see
on the operator station, see Alerts and Operator Messages on page 665.

17.2 Alerts that must be acknowledged
from the station that generated them

Most category A alerts can only be finally acknowledged from the operator station
that generated them.

The reason for this is that these alerts are associated with graphical information that
you must see when you evaluate them. And, because you can only see the information
at the operator station that generated the alert, maritime regulations dictate that you
acknowledge the alert from that operator station.

There are some exceptions. For example, you can acknowledge XTD alerts (as well as
ALARM group alerts that are associated with critical point notes on a chart) from any
operator station. It is true that these alerts have graphical information associated with
them. However, the graphical information is part of the route data that is distributed
over the network to all operator stations. And, since you can see it on all operator
stations, there is no need for the alerts associated with it to be acknowledged only from
the operator station that generated them.

The following category A alerts can be acknowledged from operator stations other than
the operator station that generated them (see Navigation system alerts on page 668):
• AP turn pre-alert, Ship will turn in nn min
• AP turn pre-alert, WOP will be passed in nn min
• AP turn, Ship will turn in nn sec
• AP turn pre-alert, WOP will be passed in nn sec
• Autopilot off course
• Critical point reached
• Deviation between heading sensors
• Position deviation
• Too many AIS targets
• XTD limit exceeded
Although you cannot finally acknowledge most category A alerts except from the station
that generated them, you can use the alert group buttons to acknowledge these alerts
locally: the alerts will then be acknowledged as far as the operator station you are using
is concerned and as far as any other operator stations on the network are concerned
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except for the originating one. Therefore any flashing and audible sound caused by those
alerts on the local operator station (and on the other operator stations on the network,
except the originating one) will cease.

17.3 Handling target alerts in ECDIS
If you have radar targets and/or video displayed on the ECDIS charts or if your operator
station is an MFD with both ECDIS and radar running on it, note that:
• Radar target alerts generated locally will not cause the alert group buttons to flash on

the local ECDIS top bar.
• AIS target alerts will cause the DNG, LOST, and NEW buttons to flash on the local

ECDIS top bar.
• Radar target alerts will only appear in the lists of alerts displayed in the local ECDIS if

they have been generated by a Radar application running on another operator station.

17.4 Acknowledging alerts using the
buttons on the top bar

For an explanation of how to use the alert group buttons to acknowledge alerts, see The
alert condition group buttons on page 61 and The alert priority group buttons on page 65.

Figure 92 The alert group buttons on the top bar

The alert message on the top bar always presents the most recent unacknowledged alert.

17.5 Acknowledging alerts using the
operator panel

When an alert group button is flashing on the top bar:
1 Press the SOUND OFF button on the operator panel to silence the audible sound

associated with an alert (see The Alarms group on page 39).
2 Press the ACK button to bring up the Alert Group dialog.
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Pressing the ACK button once brings up the Alert Group dialog if it is not already
displayed (see Acknowledging alerts in the Alert Group dialog on page 336).

3 Press the ACK button again to acknowledge all unacknowledged alerts in the
currently displayed group.

4 If the current alert list is longer than the Alert Group dialog box and contains
unacknowledged alerts that have not been displayed, scroll down and display them.
Note that you can only acknowledge alerts that have been displayed.

5 Use the ALARM VIEW button on the operator panel to cycle through the alert groups
displayed in the dialog, and press the ACK button to acknowledge the alerts in
each displayed group.

17.6 Acknowledging alerts using the
unacknowledged alerts list

To see a list of all unacknowledged alerts, click the
unacknowledged alerts button on the top bar (see The
Unacknowledged alerts button on page 69).

Figure 93 The unacknowledged alerts list

To acknowledge:
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• The alert at the top of the list (in other words, the alert currently displayed on the top
bar), click the priority button to the left of the alert on the top bar (see The Alert
priority button on page 66).

• An alert in the list, click the priority button to the left of the alert in the list (see
The Alert priority button on page 66).

When you click the priority button for an alert, all alerts that have the same text as the
one whose priority button you clicked are acknowledged (whichever operator station
generated them).

17.7 Acknowledging several alerts at once
While the alert list for an alert group is displayed (in the Alert Group dialog), you can
acknowledge all unacknowledged alerts in that group that have already been displayed
with a single press of the ACK button on the operator panel.

To bring up the Alert Group dialog, click on one of the alert group buttons on the top
bar or press the ALARM VIEW button on the operator panel (see The Alarms group on
page 39).

You can only acknowledge alerts that have been displayed. If the list is longer than the
dialog box and contains unacknowledged alerts that have not been displayed, you must
scroll down and display them before they can be acknowledged.

For more information, see Acknowledging alerts in the Alert Group dialog on page 336

17.8 Acknowledging alerts that have been
received by several consoles

Alert lists on a particular operator station will include alerts originating from that
operator station as well as alerts originating from other operator stations. The origin of
each alert is shown in the Origin column in the tables of alerts displayed in the Alert
Group dialog and in the large Alert List dialog (see Viewing current and past alerts
on page 336). You can always see which message you are acknowledging and which
operator station (or other piece of equipment) issued it.

When a sensor is connected to more than one operator station, all operator stations will
probably detect a malfunction related to the sensor. When an identical alert exists on
different operator stations, you only need to acknowledge it on one of them.

There are also alerts that you can only acknowledge from the operator station that
generated them, see Alerts that must be acknowledged from the station that generated
them on page 332.
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17.9 Silencing alerts from other consoles
If several K-Bridge consoles are connected together on a Local Area Network (LAN), an
alert on one of them can be silenced from any of the others by means of the SOUND OFF
button on the remote console’s operator panel (see The Alarms group on page 39).

17.10 Viewing current and past alerts
The sub-sections below tell you how to use two dialogs – the Alert Group dialog and the
large Alert List dialog – for listing current and past alerts.

These dialogs enable you to acknowledge particular alerts, view the entire alert history,
and view the history of alert messages associated with a particular alert condition.

To access the:
• Alert Group dialog, click the button on the top bar for the alert group you require (see
The alert condition group buttons on page 61 and The alert priority group buttons
on page 65).
For information about using the Alert Group dialog, see Acknowledging alerts in the
Alert Group dialog on page 336.

• The large format Alert List dialog (containing all the current alerts), click the All
Active Alerts or Alert History button in the Alert Group dialog.
The large format dialog is not available in the Radar application, because it would
obscure the radar image on the screen.
For a description of the Alert List dialog, see Acknowledging alerts in the large-format
Alert List dialog on page 339.

17.10.1 Acknowledging alerts in the Alert Group dialog
To view all currently unacknowledged alerts in an alert group, click the relevant alert
group button on the top bar:

The Alert Group dialog appears, listing the active alerts for the group whose button you
pressed.
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Figure 94 Alert Group dialog (with flashing priority column)

The alerts in the list for each alert group button are all of a single priority. The leftmost
field of each row in the dialog’s table contains a letter indicating the priority: A for
alarms, W for warnings, and C for cautions.

For:
• Unacknowledged alerts, the form of the priority letter alternates rapidly between black

text on a coloured background and coloured text on a black background: the colours
are RED for alarms, YELLOW for warnings, and OFF-WHITE for cautions.
The effect for alarms and warnings is of a flashing indicator enabling you to identify
unacknowledged alerts at a glance. (Caution alerts will not flash, because they are
automatically acknowledged as soon as they are generated.)

• Acknowledged alerts, this letter is black on a solid (non-flashing) coloured
background: the background is RED for alerts and YELLOW for warnings.

As well as a priority each navigation alert has a category of severity: A, B, or C (A is
the most urgent). This appears in the fourth column of the table, to the right of the
time-stamp. For a general description of the priorities and categories of severity, see The
Alert priority button on page 66.
You can toggle the dialog between alert groups by pressing the ALARM VIEW button on
the operator panel when the Alert Group dialog is already displayed. Alternatively, just
click another alert group button on the top bar to see the list for another group.

To acknowledge all currently un-acknowledged alerts, press ACK on the operator panel
(see Acknowledging several alerts at once on page 335).
To acknowledge an individual alert in the list, double-click on it, or right-click on it
and select Acknowledge.
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Note

You can only acknowledge alerts that have been displayed. If the list is longer than the
dialog box and contains unacknowledged alerts that have not been displayed, you must
scroll down and display them before they can be acknowledged.

To see a description of an alert, right-click on it and select Info .... This brings up the
Alert Information dialog: the explanation for the message you selected appears at the
top of the Alert Information dialog (see The Alert help button and the Alert Information
dialog on page 68).

To bring up the most relevant dialog for an alert, right-click on it and select Navigate.

The Alert Group dialog contains all or some of the following controls, depending on
the application you view it in:
• All Active Alerts: In ECDIS and Conning, click this button to see a large-format list of

all active alerts from all alert groups (see Acknowledging alerts in the large-format
Alert List dialog on page 339).

• Alert History: In ECDIS and Conning, click this button to see a large-format history
of the alerts in the group whose listing is currently displayed in the Alert Group dialog
(see Viewing the history for an alert group on page 340).

• Possible alerts: In Radar, ECDIS and Conning, click this button to display a list of
all the ECDIS, radar, autopilot and speedpilot alerts you can receive on the MFD
system. The list appears in the Alert Information dialog. Click on one alert in the list
to read an explanation of it (see The Alert help button and the Alert Information
dialog on page 68).

• Pop-up on ack: Check this option to make the Alert Group dialog appear whenever
you acknowledge an alert. Once it is displayed, the next time you press the ACK
button on the operator panel, all un-acknowledged alerts that have already been
displayed will be acknowledged.

• Auto-hide: Check this option to make the Alert Group dialog close automatically a
few seconds after it has displayed.
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17.10.2 Acknowledging alerts in the large-format Alert List
dialog
When you click the All Active Alerts button in the Alert Group dialog (see Acknowledging
alerts in the Alert Group dialog on page 336), a list of all active alerts (from all alert
groups) appears in a large new dialog and on a tab called All Active Alerts.

The colour coding, priority and category of severity indications are the same as for the
Alert Group dialog except that the text of the priority label in the lefthand column uses
the whole word instead of an initial letter.

The large-format alert list contains both the “Message” and a “Description” for each
alert: the message text is the same as the text that appears for the alert in the top bar and
in the unacknowledged alerts list (see The Unacknowledged alerts button on page 69).
For some alerts the description provides additional and more specific information; for
others it simply repeats the message text.

The same right-click menu functions are available for the large-format list as for the
Alert Group dialog (see Using the right-click menu for the Alert Group and Alert List
dialogs on page 340).

Figure 95 The large format Alert List (right-click menu showing)
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17.10.3 Using the right-click menu for the Alert Group and
Alert List dialogs

Select an alert in the small- or large-format list, and right-click on
it to bring up a menu containing the following options:
• Acknowledge: Select this option to acknowledge the selected

alert.
• Info ...: Select this option to see a description of an alert in

the small- or large-format list. The Alert Information dialog
comes up, with the explanation for the message you selected
appearing at the top (see The Alert help button and the Alert
Information dialog on page 68).

• Navigate: Select this option to bring up the most relevant
dialog for an alert. The effect is the same as clicking the
most-relevant dialog button (see The Most-relevant dialog
button on page 68).

The Info ... and Navigate options only work for ECDIS, radar,
autopilot or speedpilot alerts.

17.10.4 Sorting alerts in the Alert List dialog
In the All Active Alerts and Alert History tabs in the Alert List dialog, you can sort the
alerts by priority, time, message text, origin, or tag number. To do this, click on the
relevant column heading.

If you click on the Time column heading first and then click on one of the other column
headings, the alerts will be sorted by priority, message text, origin or tag number (as
appropriate), but the list for each priority, message, origin or tag number will be sorted
chronologically.

Figure 96 The column-headings you can use to sort alerts in the list

17.10.5 Viewing the history for an alert group
In the ECDIS and Conning applications, click the History button in the Alert Group
dialog (see Acknowledging alerts in the Alert Group dialog on page 336) to bring up a
large-format history of all alerts generated and/or received by the operator station.
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Note that the priority column has the same format as the other columns: there is no use of
colour to indicate the priority of an alert, and although unacknowledged alerts can appear
in the Alert History tab, no flashing will indicate their presence. The priority column
only flashes for unacknowledged alerts that are listed in the Alert Group dialog and the
All Active Alerts list). Unacknowledged alerts in the Alert History tab are indicated in
the Message column by a ‘>’ character preceding the message text.

It is not possible to say how far back in time the alert history extends. The history is
stored in a buffer that can store approximately 50,000 alerts. When the buffer is full the
oldest alerts are over-written by the most recent.

For information about the right-click menu functions available for the alert history, see
Using the right-click menu for the alert history on page 344).

Figure 97 The alert history (sorted by time)
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17.10.5.1 Scrolling and filtering the alert history list

At the bottom of the Alert History tab is a set of controls for scrolling and filtering the
alert history list. These are summarized in the figure below:

Figure 98 Scrolling and filtering controls

Scrolling and refreshing the list
Use the Refresh button to populate the dialog with the latest acknowledged alerts. When
you first view the Alert History tab, the list may be empty until you click Refresh. The
process of populating the list can take some time, therefore, after you have pressed
Refresh the button it turns into a Cancel button; this gives you the option to abort the
process if it is taking too long. A progress bar to the right of the Refresh button indicates
the progress of the refresh operation.
The list of alerts will display using the current scroll and filter criteria. This means that,
for example, if the first alert in the current page is number 125, then the first alert in the
refreshed page will also be number 125 although it may well be a different alert.
Scroll to the beginning or end of the list by using the << First or Last >> arrow button
(as applicable).
Scroll backwards or forwards one “page” at a time by using the << Prev or Next >>
arrow button (as applicable).
Specify the number of alerts to include in a “page” by selecting an option from the
drop-down list. The Visible only option in the drop-down list makes a “page” equal
to the number of lines that can be displayed in the dialog. If you select more alerts
per “page” than can be displayed in the dialog (without scrolling), a scroll bar appears
on the dialog's right boundary.
You can re-size the columns in the list by dragging the sides of the list headings using the
mouse pointer. If you widen them so that not all the data can be shown in the dialog at
once, a horizontal scroll bar appears at the bottom of the dialog.

Filtering the alert history
You can apply filters to the list of past alerts. Use the following check boxes to do this:
• First report of alert: Check this box to include for each alert the first report of the alert.
• Report of Ack'd status: Check this box to include for each alert the message confirming

that the alert has been acknowledged.
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• Report of Ack'd and Normal status: Check this box to include for each alert the
message confirming that the alert has been acknowledged and that its state is now
“Normal”. (Alerts that meet this criterion have all been removed from the list of
active alerts.)

17.10.5.2 Viewing the history of a single alert condition

In the Alert History tab, you can view all messages associated with a particular alert
condition in isolation from the rest of the list.

To do this in the Alert History tab select one instance of the alert condition you are
interested in, then right-click on it and select Isolate.

A new list is presented of all the alerts associated with that alert condition.

To return to the main alert history list, right-click on any alert in the isolated list, and
select Cancel isolate.

Figure 99 The isolated history of one alert message type
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17.10.5.3 Using the right-click menu for the alert history

Select an alarm in the alarm history list and right-click on it to
bring up a menu containing the following options:
• Info ...: Select this option to see a description of an alert in

the small or large format list. The Alert Information dialog
comes up with the explanation for the message you selected
appearing at the top (see The Alert help button and the Alert
Information dialog on page 68).

• Navigate: Select this option to bring up the most relevant
dialog for an alert. The effect is the same as clicking the
most-relevant dialog button (see The Most-relevant dialog
button on page 68).

• Isolate: Select this option to view the history for one particular
alert condition in isolation from the general list (see Viewing
the history of a single alert condition on page 343).

• Cancel isolate: Select this option to return to the comprehensive
alert history list after viewing the history of an alert condition
in isolation from the comprehensive list.

17.11 Issuing alert output to an external
alarm system

The K-Bridge console can be connected to an external alarm system so that K-Bridge
alerts are then transmitted to and from the external alarm system.
There are several types of alert output from the MFD:
• System alerts: These are the alert messages themselves (and they can be acknowledged

by the external alarm system). They are standard NMEA 0183 ALR messages (and
the acknowledgements are ACK messages). If you are using a serial connection to
communicate with the external alarm system, LOST and TARGET alerts will not
be transmitted to it. However, you can set up a “TargetOut” interface to notify the
external alarm system of these alerts (see Target out interface on page 632). (Operator
stations that send alerts to the SINT over the LAN do send LOST and TARGET alerts
and therefore do not use the “TargetOut” interface.)

• System fail: This is a digital output signal that simply indicates to the external alarm
system that the MFD has issued an alert. (The MFD is not necessarily configured to
transmit this digital output signal.)

• System watchdog: This is a digital output signal that indicates to an external alarm
system that the MFD is no longer operational. (The MFD is not necessarily configured
to transmit this digital output signal.)

• System sound off: This is a digital output and input signal. The output signal indicates
to an external alarm system that the SOUND OFF button on the MFD's operator panel
has been pressed (see The Alarms group on page 39). The input signal indicates to the
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MFD that the SOUND OFF button on another device has been pressed and therefore
that the MFD should execute its sound-off routine. (The MFD is not necessarily
configured to transmit or receive this digital I/O signal.)

• System user activity: This is a digital output signal. It indicates to the external alarm
system (and to the Bridge Navigational Watch Alarm System) that there is user activity
on the console. The signal is triggered by, for example, a button being pressed on the
MFD's operator panel or by a button in the user interface being clicked. If there is no
activity, the external alarm system will issue a system watchdog alarm after a specified
period. (The MFD is not necessarily configured to transmit this digital output signal.)

There are three possible types of connection between the MFD and the external alarm
system:
• LAN connection

Where a LAN connection exists from the MFD to the SINT, the external alarm
system's event server will have a proprietary connection to the SINT and will receive
alerts from the SINT. The operator stations on the LAN will be clients of the event
server and can have filters applied that control which alerts they receive from it. Only
service personnel can change this filter.
In this configuration, the MFD transmits all alarms to the SINT. They are then
forwarded by the SINT to the event server.

• Serial connection
This type of connection is for MFD systems that are not connected to a Local Area
Network or are not connected to a SINT but have separate connections to the
individual sensors instead.
Where a serial connection exists between the MFD and the external alarm system, the
MFD transmits all alerts (except NEW and LOST target alerts) directly to the external
alarm system over the serial connection.
If there is a serial connection from the MFD to the external alarm system, then you
must configure the interface to the alarm system in the Number of Sensors dialog
(see Number of Sensors on page 617):
1 Set the number for Alarm to 1 (from zero).
2 Click Details and assign a port number to the interface you are specifying.

• Digital I/O connection
This type of connection is not required for MFD systems that are connected to the
LAN. However there are four digital output relays that can be used: they are for the
system fail, system watchdog, system sound off, and system user activity signals.
Although these four signals are possible, only two digital output lines are in fact
available. Therefore the signals actually in use on your MFD will depend on the
choices made when it was commissioned.
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18 Accessing, saving, and
restoring console data

This section contains the following topics:
Accessing the system's configuration data.....................................................................348
Backing up mariners' notes, routes, and barrier lines ....................................................348
Backing up the entire configuration to CD-ROM..........................................................349
Restoring the configuration from CD-ROM..................................................................349
Restoring parameters after replacing hardware .............................................................350

For information about:
• Exporting ship-relative notes (templates), see Copying templates on page 229.
• Exporting route plans to other systems, see Importing and exporting route information

on page 242.
• Exporting depth data for use by other applications, see Capturing depth data for
other applications on page 329.
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18.1 Accessing the system's configuration
data
The K-Bridge MFD system has three access levels. The two higher levels are used to
prevent unauthorised access to key system functions and parameters.
• Operator access: All functions that an officer on bridge watch will need are available

with this level of access. This includes all functions stipulated by the IMO radar and
ARPA performance standards. You do not need a password for this level of access.

• User configuration access: This level of access requires a “user” password. It enables
you to perform all general operator tasks and procedures. For example:
– Viewing and acknowledging alarms
– Viewing route and ship parameters
– Adjusting the video configuration

• Service access: This level of access requires a “service” password and is mainly for
service engineers. It is for changing more permanent settings, such as the details of
the display units connected, their characteristics and voltage levels. It also enables
you to upgrade system software (see System Upgrade Software on page 596).
WARNING
If you have service-level access, do not change any service-level
settings unless you are trained to do so. Changing these
settings can render the system useless or seriously degrade its
performance.

18.1.1 Gaining user-level access to the system
1 Select: System→Password (see Password on page 593).
2 Type in the password.

• The user-level password is user.
3 Click the Open button.

• You can now make the changes you need to make.
4 When you have finished, go back to the Password dialog and click Lock.

• The system is now locked again. To prevent unauthorized access, always lock
the system as soon as you have finished changing any settings.

18.2 Backing up mariners' notes, routes,
and barrier lines

The system enables you to back up and restore certain user-generated data.
You can save this data to (and restore it from) an external medium, such as a USB
memory device or CD-ROM.
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The types of data you can back up are:
• Mariners' notes to charts (these are sometimes called “radar maps”; see Note Save on
Medium on page 514 and Note Load from Medium on page 513).

• Sailing routes (see Routes Backup/Restore on page 424 and Configure Route Export
on page 661).

• Target acquisition barrier lines (see Save barrier lines to an external medium on
page 403 and Load barrier lines from an external medium on page 402 ).

18.3 Backing up the entire configuration to
CD-ROM

The system's entire configuration (including the data referred to in the previous section)
is stored on the hard disk in the system's main computer unit: some of it is stored in the
Windows Registry and some in other system files.
To back up the entire configuration to a CD-ROM (or to restore it from a CD-ROM)
requires service-level access.
To back up the system configuration, do the following:
1 Insert a write-able CD-ROM (not a DVD).
2 From the main menu, select System→Maintenance→Backup→Backup (tab).
3 Check all the check boxes (except for the Log box; this is only required if you want

to back up the K-Bridge Radar system's log files).
For the meanings of the options in the Backup tab, see Backup/Restore – Backup
tab on page 607.
Note

Make sure the CD you insert has enough space left on it to store the configuration.
Figures for the amount of data you have selected to back up and the space available
on the CD are displayed in the dialog. (These figures are recalculated each time you
check or un-check the selection boxes.)

4 Click the Backup button.
When you back up the system configuration, the settings are stored with the date and
time of the backup. You cannot specify a particular drive for the backup to be written to:
it is automatically written to the first available CD drive.

18.4 Restoring the configuration from
CD-ROM

To restore a system configuration from a CD-ROM, do the following:
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1 From the main menu, select System→Maintenance→Backup→Restore (tab).
2 Insert the CD containing the configuration data you want to restore.
3 Check the boxes for the parts of the configuration you want to restore (check all

three boxes to restore the entire configuration) and from the drop-down list for each
box select the data you want to restore (it is labelled by date and time.

4 Click the Restore button.

For more information about the Restore tab, see Backup/Restore – Restore tab on
page 608.

18.5 Restoring parameters after replacing
hardware

If you replace the hard disk in the K-Bridge MFD system's main computer unit, or if
you replace the entire main computer unit, then you need to restore the parameters from
backup as described above (see Restoring the configuration from CD-ROM on page 349).

Note

If you replace the radar interswitch unit, you do not need restore any configuration data:
no system configuration data is stored in the radar interswitch unit or transceivers.
(For more information about the radar interswitch unit, see The radar interswitch unit
on page 106.)
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19 Performing search and
rescue operations

This section contains the following topics:
Operating marine radars for SART detection ................................................................352
Specifying the search pattern .........................................................................................354
Specifying the search area graphically ..........................................................................355
Generating a search and rescue route plan.....................................................................356
The flower/sector search pattern ....................................................................................357
Expanding square search pattern ...................................................................................359
Parallel track search pattern ...........................................................................................360
Creeping line search pattern...........................................................................................361
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This chapter includes guidelines for using your radar system in a search and rescue
operation, and it describes the search patterns you can specify in ECDIS to conduct
the search.

19.1 Operating marine radars for SART
detection
The IMO sub-committee on navigation has prepared the following guidelines for use
during search and rescue operations.
WARNING
A Search and Rescue Transponder (SART) will only respond to an
X-Band (3 cm) radar. It will not be seen on an S-Band (10 cm) radar.

1 Introduction
A Search and Rescue Transponder (SART) may be triggered by any X-Band (3 cm)
radar within a range of approximately 8 nautical miles. Each radar pulse received
causes it to transmit a response which is swept repetitively across the complete
radar frequency band, When interrogated, it first sweeps rapidly (0.4 microsec)
though the band before beginning a relatively slow sweep (7.5 microsec) through
the band back to the starting frequency. This process is repeated for a total of twelve
complete cycles. At some point in each sweep the SART frequency will match that
of the interrogating radar and be within the pass band of the radar receiver. If the
SART is within range, the frequency match during each of the 12 slow sweeps will
produce a response on the radar display, thus a line of 12 dots equally spaced by
about 0.64 nautical miles will be shown.

2 When the range to the SART is reduced to about 1 n.mile the radar display may
show also the 12 responses generated during the fast sweeps. These additional
dot responses, which also are equally spaced by 0.64 nautical miles, will be
interspersed, with the original line of 12 dots. They will appear slightly weaker and
smaller than the original dots.

3 Radar Range Scale
When looking for a SART it is preferable to use either the 6 or 12 nautical mi1e
range scale This is because the total displayed length of the SART response of 12
(or 24) dots may extend approximately 9.5 nautical miles beyond the position of
the SART and it is necessary to see a number of response dots to distinguish the
SART from other responses.

4 SART Range Error
When responses from only the 12 slow frequency sweeps are visible (when the
SART is at a range greater than about 1 n.mile), the position at which the first dot
is displayed may be as much as 0.64 nautical mile beyond the true position of the
SART. When the range closes so that the fast sweep responses are seen also, the first
of these will be no more than 150 metres beyond the true position.

5 Radar Bandwidth
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This is normally matched to the radar pulse length and is usually switched with the
range scale and the associated pulse length. A narrow bandwidth of 3-5 MHz is
used with long pulses on long range scales, and a wide bandwidth of 10-25 MHz is
used with short pulses on short ranges.

6 A radar bandwidth of less than 5 MHz will attenuate the SART signal slightly, so
it is preferable to use a medium bandwidth to ensure optimum detection of the
SART. The Radar Operating Manual should he consulted about the particular radar
parameters and bandwidth selection.

7 Radar Side Lobes
As the SART is approached, side lobes from the radar antenna may show the SART
responses as a series of arcs or concentric rings. These can be removed by the use of
the anti-clutter sea control although it may be operationally useful to observe the
side lobes as they may be easier to detect in clutter conditions and also they will
confirm that the SART is near to the own-ship.

8 De-tuning the Radar
To increase the visibility of the SART in clutter conditions, the radar may be detuned
to reduce the clutter without reducing the SART response. Radars with automatic
frequency control may not permit manual detune of the equipment. Care should be
taken in operating the radar in the detuned condition as other wanted navigational
and anti-collision information may be removed. The tuning should be returned to
normal operation as soon as possible.

9 Gain
For maximum range SART detection the normal gain setting for long range
detection should be used i.e., with a light background noise speckle visible.

10 Anti-clutter sea control
For optimum range SART detection this control should be set to the minimum.
Care should be exercised as wanted targets in sea clutter may be obscured. Note
also that in clutter conditions the first few dots of the SART response may not be
detectable, irrespective of the setting of the anti-clutter sea control. In this case, the
position of the SART may be estimated by measuring 9.5 nautical miles from the
furthest dot back towards the own-ship.

11 Some sets have automatic/manual anti-clutter sea control facilities. Because the way
in which the automatic sea control functions may vary from one radar manufacturer
to another, the operator is advised to use manual initially until the SART has been
detected. The effect of the auto sea control on the SART response can then be
compared with manual control.

12 Anti-clutter rain control
This should be used normally (i.e. to break up areas of rain) when trying to detect a
SART response which, being a series of dots, is not affected by the action of the
anti-clutter rain circuitry. Note that Racon responses, which are often in the form. of
a long flash, will be affected by the use of this control.
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13 Some sets have automatic/manual anti-clutter rain control facilities. Because
the way in which the automatic rain control functions may vary from one radar
manufacturer to another, the operator is advised to use manual initially until the
SART has been detected. The effect of the auto rain control on the SART response
can then be compared with manual control.

Note

The automatic rain and sea clutter controls may be combined in a single 'auto-clutter'
control, in which case the operator is advised to use the manual controls initially until
the SART has been detected, before assessing the effect of auto.

19.2 Specifying the search pattern
The aim of a Search And Rescue (SAR) operation is to locate a missing object as fast as
possible. The Search and Rescue dialog in ECDIS (see Search and Rescue on page 437)
allows you to select a search suitable for your requirements.

To specify the search pattern you must enter the following information:

• The search pattern type (flower/sector, expanding square, parallel track, or creeping
line).

• Latitude and longitude.

• The initial bearing for the search.

To bring up the Search and Rescue dialog, select Route→Search and Rescue.

Click the Apply button, to generate the search pattern according to the parameters you
have entered.

Click the Go To button to move in the display to the actual position of the defined search
pattern and to change the screen scale to enable the pattern to be displayed optimally.

Check or un-check the Display Pattern toggle, the turn the display of the Search and
Rescue pattern on and off.
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19.3 Specifying the search area graphically
• By clicking the Get Cursor button, an EBL/VRM tool will be displayed. The tool can

both be used for specifying the search centre (the VRM centre) and for specifying the
Starting Bearing (the EBL direction) and the radius (the VRM radius).

Figure 100 Changing the position, radius and bearing of the search area graphically
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19.4 Generating a search and rescue route
plan

• By clicking the Apply button, the suggested parameters for the turn radius and the
planned speed is displayed.
The Turn Radius field is by default set to the default turn radius specified in the ship
(route) parameter settings. However, if the pattern is such that this turn radius is too
large, a smaller turn radius is computed. If this is smaller than the minimum turn
radius specified in the ship (route) parameters, the minimum radius will be used.
The Planned Speed field is by default set to the default speed (Cruise Speed) from the
ship (route) parameters.

• By clicking the Generate Route button, a route plan named “$$SearchRescue” will be
generated and automatically monitored.
As this is a normal route plan object it can be renamed, edited, validated and printed
just like any other route plan.

Figure 101 Showing details of the generated and monitored “$$SearchRescue” route
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19.5 The flower/sector search pattern
• The “Flower” search pattern concentrates the search around a specific centre and

searches a circular pattern with a specified radius. For the Flower pattern the Number
of Passes field is used to specify the number of “petals” on the pattern.

• The “Sector” pattern is just a special case of the Flower pattern with three “petals”.
For a second pass (or search unit) the sector pattern should be turned clockwise by 30
degrees.

Figure 102 The “Flower” search and rescue pattern
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Figure 103 The “Sector” search and rescue pattern
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19.6 Expanding square search pattern
• The “Expanding Square” search pattern concentrates the search around a specific

centre and searches a circular pattern with a specified radius.
The Track Spacing field is used to specify the distance between search lines.

Figure 104 The Expanding Square search and rescue pattern
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19.7 Parallel track search pattern
• The “Parallel Track” search pattern carries out a uniform search in a rectangular area.

The Starting Bearing field defines the major axis of the area.
The Length andWidth fields defines the size of the rectangular area.
The Track Spacing field is used to specify the distance between search lines.

Figure 105 The “Parallel Track” search and rescue pattern
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19.8 Creeping line search pattern
• The “Creeping Line” search pattern carries out a uniform search in a rectangular

area, but starting at the short end.
The Starting Bearing field defines the major axis of the area.
The Length andWidth fields define the size of the rectangular area.
The Track Spacing field is used to specify the distance between search lines.

Figure 106 The “Creeping Line” search and rescue pattern
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20 Reference Guide

This section contains the following topics:
The main menu ..............................................................................................................364
View menu .....................................................................................................................366
Targets menu ..................................................................................................................380
Route menu ....................................................................................................................415
Options menu.................................................................................................................439
Own-Ship menu .............................................................................................................440
Chart menu.....................................................................................................................476
Radar menu ....................................................................................................................537
Tools menu.....................................................................................................................543
System menu..................................................................................................................561

381287/A 363



K-Bridge Multi-functional Display Unit

20.1 The main menu
This chapter describes the menus and dialogs associated with the Radar, ECDIS and
Conning applications. The menus and dialogs enable you to monitor, operate and
configure the system.
On widescreen (16:10) displays, the main menu appears at the right end of the top bar.
On 4:3 displays its location is different for each application (see the figures below).
For more information about the presentation of the main menu and its associated buttons,
see The menu area on page 75.

Table 22 The menu area on 16:10 (widescreen) displays

Table 23 The menu area on 4.3 (standard) displays

The main menu contains some or all of the following buttons (depending on the
application):
• View: Click this button to regulate the amount of light emitted by the display and the

operator panel, and to configure the tools, symbols and data that appear on the radar
and chart displays (see View menu on page 366).

• Targets: Click this button to work with radar and AIS targets and to test the target
tracker (see Targets menu on page 380).

• Route: Click this button to create, manage, use and monitor routes (see Route menu
on page 415).

• Own ship: Click this button to access menus concerned with the vessel's position,
heading, speed, general movement and sensors (see Own-Ship menu on page 440).
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• Chart: Click this button to manage charts (see Chart menu on page 476).
• Option: Click this button to view the optional components enabled on the console

(see Options menu on page 439).
• Radar: Click this button to set parameters for tuning the radar picture and also to

monitor the radar's transceiver and Magnetron unit (see Radar menu on page 537).
• Tools: Click this button to use parallel index lines as a navigation aid or to specify a

turn and programme it into the autopilot (see Tools menu on page 543).
• System: Click this button to access various system setup, maintenance and

configuration menus.(see System menu on page 561).
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20.2 View menu

This menu enables you to regulate the amount of light emitted by the display and the
operator panel, and also to configure the tools, symbols and data that appear on the
radar and chart displays.

To see this menu, click the View button on the main menu.

It contains contain some or all of the following buttons (depending on the application):
• Palette/Intensity: Click this button to regulate the amount of light emitted by the

display and the operator panel (see Intensity on page 367).
• Zoom: Click this button to select the chart scale (see Zoom on page 370).
• Main Radar Themes: Click this button to control the visual tools, symbols and data

that appear in the radar area (see Radar Themes on page 371).
• Chart Themes: Click this button to select the types of chart information to be

displayed in the radar area (see Chart Themes on page 373).
• Object Information: Click this button to display information about an object in the

chart that is near to the marker (cursor) (see Object Info on page 377).
• Browse Position and Date: Click this button to use the browsing facility for route

planning (see Browse Position and Date on page 378).
• Remote Markers: Click this button to make the markers (cursor, EBL/VRM pair or

pairs, and/or curved EBL) on your operator station available to other operator stations
or to display the markers from another operator station on your screen (see Remote
Marker Setup on page 379).
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20.2.1 Intensity
This dialog enables you to regulate the light emitted by the display and the operator panel.

The path to the dialog is: View →Palette/Intensity.

Three levels of intensity are available: Day, Dusk and Night.

In radar, the light intensity can be adjusted for both the display and the operator panel.

Note

In the radar application, when you set the intensity for the Display, the Panel intensity
is automatically set to the same value. However, changing the Panel intensity does not
change the intensity setting for the Display.

The Intensity dialog also contains one or more of the following options and buttons,
depending on the application:
• Set Calibrated: Clicking this button sets the monitor’s backlight to the level at which

the colours are correctly calibrated (for displaying charts) in the current palette. (The
button is only present for certain monitors.)

• Brilliance: You can adjust the back-light level by operating the slider.
• Own Ship: Adjusts the intensity of the own-ship symbol and heading line.
• ARPA Info: Adjusts the intensity of all target symbols.
• Nav. Tools: Adjusts the intensity of EBL/VRM and parallel index lines.
• Range Rings: Adjusts the intensity of the range rings.
• Radar Video: Adjusts the intensity of radar echoes and trails on the display.
• Menus: Adjusts the intensity of those parts of the screen that are outside the radar or

chart display area. Menu intensity will be reset to max (99) whenever the palette is
changed; this ensures that the menus remain visible after palette changes.

• BRG scale: Adjusts the intensity of the bearing scale.
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• Panel BLight: Adjusts the intensity of the backlight for the buttons on the operator
panel.

• Panel LED: Adjusts the intensity of the status LEDs on the operator panel.

20.2.1.1 The colours in the display palettes

The tables in this section list the colours used in the different display palettes (day,
dusk and night).

Table 24 The colours used for text (in the different palettes)

Text Day Dusk Night
Normal text Black on Grey White on Black Yellow on Black
Text indicating
conditions other
than normal
operation

Black on Yellow Black on Yellow Black on Yellow

Alarm condition Black on Red Black on Red Black on Red, or
Red on Black

Table 25 The colours used for radar and chart items (in the different palettes)

Radar and chart
items

Day Dusk Night

Radar echoes,
strong

Yellow Yellow Yellow

Radar echoes,
uncorrelated or
weak

Darker

Yellow

Darker

Yellow

Darker

Yellow

Radar trails Green Green Green
Radar background
(no chart)

Dark Blue Black Black

Deep water Darker Blue Black Black
Shallow water Light Blue Light Blue Light Blue
Filled land masses Brown Brown Brown
User tools
(EBL,VRM,
Parallel index lines
etc.)

Orange Orange Orange

Heading Line,
Range Rings

White White White

Traffic information Magenta Magenta Magenta
Target vectors Green Green Green
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Table 25 The colours used for radar and chart items (in the different palettes) (cont'd.)

Radar and chart
items

Day Dusk Night

Auto Acquisition
Area

Red Red Red

Shoreline Grey Grey Grey
Safety contour Grey Grey Grey

Note

The colours used for elements in the chart display have been (as far as was practicable)
based on the definitions in the IHO S-52 background colour schemes.
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20.2.2 Zoom

This dialog enables you to set the chart scale.

The path to the dialog is: View →Zoom.

By default, the system automatically selects the best chart available for the own-ship's
current position. To use a chart with a different scale:
• Select the required scale from the FG (foreground) chart list.
• Click the Zoom In or Zoom Out button.

The selected chart will sometimes not cover the whole display area. Rather than leave
the area that is not covered blank the system can fill it with another chart, normally of
lower resolution. The best chart is called the foreground (FG) chart and the other is
called the background (BG) chart.

Reset: Resets chart selection to automatic chart mode (selection of the best chart
available for the own-ship's position).

Zoom In: Increases the chart scale by a factor of two.

Zoom Out: Decreases the chart scale by a factor of two.

FG: (Foreground) Lists the available chart types and chart scales at the own-ship's
position (in monitoring mode) or in the middle of the display (in browse mode). Select
the chart you require.

BG: (Background): If the selected foreground chart does not cover all of the display, the
rest of the display can be filled with another "fill-in" chart, normally of lower resolution.
When you select a new entry in the "BG" list, the system's choice for background chart
is overridden.

?: Click to display the chart legend for each chart (see Chart Legend on page 478).
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20.2.3 Radar Themes
This dialog enables you to specify which visual tools, symbols and data appear in the
radar area.

The path to the dialog is: View→Main Radar Themes.

The Radar Themes dialog contains the following options and buttons:
• Target ID: Turns target identification numbers on/off.
• Radar antenna: Turns on and off the cross symbol that indicates the position of the

radar antenna (for more information, see The radar antenna symbol on page 94).
• Stern Marker: Turns the own-ship's stern marker on and off.
• Display Ship Outline: Causes the own-ship to be presented as a scaled outline at

large range scales. When un-checked, the ship is represented by the heading- and
beam-lines only at all range scales (for more information, see The radar video area
on page 93). When this option is checked, you can also display the ship's predicted
movements (see Displaying the own-ship's predicted movements on page 317).

• Own Ship Past Track: Enables you to display a trailing line with time markers (at
two-minute intervals) indicating the past positions of the own-ship over the previous
30 minutes (see illustration below). Click the More button to configure the track
display (see Track tab on page 573).

• Past Track Labels: Select to display past track time labels indicating the time the
own-ship was at the various positions (for the past 12 hours). (Own-ship Past Track
must be selected.)

• Voyage Recordings: Select to display the past track for an entire voyage. Click the
More button to specify the intervals between the past positions displayed (see Voyage
tab on page 577).
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• Voyage Recording Labels: Select to display voyage time labels, indicating the time the
own-ship was at the various positions. (Voyage Recordings must be selected.)

• Position Measurements: Select to display the line or lines associated with any distance
measurements you are currently making using the Distance Measure tool (see
Distance Measure on page 554). Click the More button to bring up the Distance
Measure dialog.

• Position Sensors: Check this box to indicate the location of the position sensors that
the vessel is currently using. Click theMore button to select position sensors and/or to
determine the exact position of your operator station (see Position on page 445).

• Notes: Turns the display of mariners' notes on and off. Click the More button to
manage your notes (see Manage Notes on page 507).

• Route Plans: Check this box to turn the display of the route on and off. Click the
More button to specify parameters for the display of route information (see Route
(tab) on page 570).

• Chart: Turns the chart display on and off. Click the More button to choose the type
of information to be displayed on the chart (see Chart Themes on page 373). Not all
systems are fitted with charts.
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20.2.4 Chart Themes

20.2.4.1 Chart themes in Radar

Use this dialog to select the types of chart information to be displayed.
In Radar the path to the dialog is: View→Chart Themes.
In Radar the dialog includes the following options:
• Outline: Displays only coastlines.
• Dangers: Displays dangerous objects in the chart area such as ship wrecks and so on.
• Safety Contour: Displays the safety contour line at the depth set in the Safety Depth

Setting menu (see Safety Depth on page 479).
• Areas: Displays areas filled with colour (when not selected only boundary lines are

shown).
• Base: Select to display all themes in the list.
• Traffic: Displays traffic separation zones and so on.
• Restricted Areas: Displays restricted areas such as where cables and pipelines are

laid on the seabed.
• Aids to Navigation: Displays aids to navigation such as buoys and light sectors.
• Standard: Select this to display all themes in the list above the Standard check-box.
• Depth Contours: Select to display depth contour lines.
• Soundings: Select to display soundings that are less than the set safety depth.
• Deep Soundings: Select to display soundings that are deeper than the set safety depth.
• Cables/Wrecks: Select to display sea bottom related objects in the chart area such as

ship wrecks and cables.
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• Land Details: Select to display objects of interest on land.

20.2.4.2 Chart themes in ECDIS

In ECDIS the path to this dialog is: View→Themes.
Turning off all themes corresponds to Base Display in ECDIS terminology.
Note

Only vector charts have themes. The themes information available varies between chart
suppliers.

In ECDIS this dialog includes the following options:
Standard: Select to display standard chart items.
• Aids to Navigation: Select to display navigation lights.
• Alternative Route: Select to display an alternative sailing route, if any.
• Chart Boundaries: Select to display chart boundaries.
• Cautionary Areas: Select to display cautionary areas.
• Important Text: Select to display important text related to charts.
• Ferry Routes: Select to display ferry routes.
• Other (Standard): Select to display various other standard information.
• ARPA Targets: Select to display tracked targets when the system is connected to a

K-Bridge ECDIS.
• Target Names: Select to display identifiers for AIS and radar targets.
• Target Past Track: Select to display pasttrack for AIS and radar targets.
• Mariners’ Notes: Select to display mariners’ notes.
Everything: Select to display all available items.
• Past Track: Select to display the own-ship's past track (for the past 12 hours; see
Track tab on page 573).

• Secondary Track: Select to display the own-ship's past track related to a secondary
position sensor (for the past 12 hours).

• Past Track Labels: Select to display past track time labels indicating the time the
own-ship was at the various positions (for the past 12 hours). Past Track or Secondary
Past Track must be selected.

• Voyage Recordings: Select to display the past track for an entire voyage (see Voyage
tab on page 577).

• Voyage Labels: Select to display voyage time labels indicating the time the own-ship
was at the various positions. Voyage Recording must be selected.

• Depth Contours: Select to display depth contour lines.
• Soundings: Select to display soundings that are less than the set safety depth.
• Deep Soundings: Select to display soundings that are deeper than the set safety depth.
• Cables/Wrecks: Select to display sea bottom related objects in the chart area such as

ship wrecks and cables.
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• Light Ranges: Select to display black lines indicating the nominal range of the
navigation lights on the chart. (When Active Lights is also selected the black lines
are shown only for the light sector or sectors inside which the own-ship is currently
sailing.)

• Active Lights: Select to display the sector colour for each light sector as seen from the
own-ship's position: a coloured rectangle appears (if you have Light Ranges selected)
along the nominal range lines of each sector that the ship is currently sailing inside.
Adjacent sectors are also indicated so that you can see when you will cross from a
sector of one colour into a sector of another colour.
Finally, the lighthouse point for the sector inside which the own-ship is sailing is
indicated by a dot whose colour also indicates the sector colour.

• Radar Video: Select to display radar video as an overlay when the system is connected
to a K-Bridge ECDIS.

• Add. Information: Select to display various additional information. If you do this,
then objects that have additional text or graphics associated with them will be
displayed on the chart with the following symbol: . Click this symbol to view the
additional text or graphics. (For more information, see Object Info on page 377.)

• Land Details: Select to display relevant details on land.
• Place Names: Select to display relevant place names.
• Object Names: Select to display object names such as for buoys.
• Seabed Text: Indicates seabed structure (sand, clay, stone, etc.).
• Light Char. Text: Select to display text related to navigation lights characteristics.
• Scalebar Labels: Select to display distance labels for the scalebar on the left side of

the monitor. Lat/Long Scale must not be selected.
• Lat/Long Scale: Select to display a latitude/longitude scale and the outer edge of the

monitor instead of the scale bar.
• Data Quality: Indicates the accuracy of the chart data.
• Other: Select to display various other information.
• Configure: Clicking the Configure button brings up the Theme Configuration dialog

(see Theme Congifuration dialog on page 377).
• Tides and Streams: Select to display tide and stream data on the chart if you have the

C-Map Services option enabled (see Generating routes, predicting tides, avoiding
pirates on page 767).

• GMDSS: Select to display C-Map GMDSS data.
• SAR areas: Select to display C-Map SAR data.
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Figure 107 Light Ranges and Active Lights
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20.2.4.2.1 Theme Congifuration dialog

This dialog enables you to specify whether mariners' notes and radar/AIS targets are
to be included among the Standard themes in the Themes dialog (see Chart Themes
on page 373) or not.

The path to the dialog in ECDIS is: View→Themes.→Configure.

20.2.5 Object Info

This dialog enables you to view information about objects in the chart or on the radar
display. Point to an object and double-click using the Left mouse button. (You can also
right-click objects for context-specific menus and information.)

In ECDIS the path to the dialog is: View→Object Information.

In Radar the dialog is only available if you double-click an object.

Object information for all objects under the cursor is captured in the dialog.

For further information about this dialog, see Viewing data about an object on page 127.
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20.2.6 Browse Position and Date

The dialog allows you to set a precise position for the centre of the screen while you are
browsing the ECDIS chart. (Browsing means that the chart is displayed independently of
the own-ship's position. The facility is useful for route planning.[3])

The path to this dialog in ECDIS is: View→Browse Position and Date.

Latitude/Longitude: Enter a latitude and longitude position for the area you want to view.
The information is automatically updated during browsing. When you leave browse
mode the last position is saved for later use.

GoTo: Click the button to start browsing and to centre the chart display at the specified
position and using the specified scale.

Get Cursor: Click the button; then use the track-ball and Left mouse button to specify a
rectangular area. This updates the Lat/Long and Scale fields. Click the GoTo button to
zoom into the area.

Apply Scale: Enter a scale and click the button to set the chart to any scale. Can be used
in both Monitoring and Browse modes.
• Hint: When disrupting a route planning activity in Browse mode by clicking the

Monitor button, the last position is remembered by this menu. Click the GoTo button
will bring you back to your planning context.

Browse Date: This field controls the display of date-dependent chart information. Select
one of the following to display the date:
• None: Select to present all date-dependent information
• Now: Select to present all information that is present today
• Date: Select to present all information present at a specified date

3. You can also turn browsing on and off by clicking the Browse button on the ECDIS range panel; see
ECDIS range panel: viewing controls on page 88.
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20.2.7 Remote Marker Setup

This dialog allows you to:
• Make the markers (that is, the cursor, EBL/VRM pair or pairs, and/or curved EBL) on

your operator station available to other operator stations on the bridge.
• Specify an operator station on the bridge whose markers you want to display on

your operator station.

The path to the dialog in ECDIS or Radar is: View→Remote Markers

• Send Marker Data: Check this option to make the cursor, EBL/VRM pair or pairs, and
curved EBL on your workstation available to other operator stations on the bridge.

• Display Remote Markers: Check this option to display the cursor, EBL/VRM pair or
pairs, and/or curved EBL from another operator station on your screen. You must
then also select one or more of the sub-options Cursor, EBL/VRM, and Curved EBL
and, from the Source drop-down menu, select the operator station whose remote
markers you want to display.

• Source: Specify the operator station whose cursor, EBL/VRM pair or pairs, and/or
curved EBL you want to display on your screen. Only operator stations on which
the Send Marker Data option in this dialog has been checked will appear in the
drop-down list.

For more information, see Sharing your markers and viewing remote markers on
page 311
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20.3 Targets menu

This is the main menu for working with radar and AIS targets. Depending on the
application you are in, it enables you to:
• Manage and operate the AIS facilities (in Radar and ECDIS).
• Control the input sources for radar targets and radar video (in ECDIS only).
• Manage the automatic acquisition of radar and AIS targets (in Radar only)).
• View data about specific targets.
• Display a list of all targets known to the system.
• Set an alarm to notify you when a target vessel leaves its anchor position (in Radar

only).
• Set alarms to notify you when targets come within a specified range of the own-ship

(in Radar only).
• Use the radar's own facilities for estimating the position of the own-ship (in Radar

only; this is provided as a backup to the GPS system).
• Cancel tracking of all targets (in Radar only).
• Configure the level of tracking sensitivity you require (in Radar only).
• Test the radar's tracking capabilities (in Radar only).
To see this menu, click the Targets button on the main menu.

The Targets menu in Radar
The buttons and options in the Targets menu in the Radar application are as follows:
• AIS: Click this button to use the radar system's AIS facilities and work with AIS

targets (see AIS on page 382).
• Auto Acquisition Area: Click this button to define the area around the own-ship within

which the tracker will acquire targets and to set up the automatic acquisition of targets
(see Auto Acquisition on page 396).

• Display Target Data: Click this button to display data for the selected target (see
Target Information on page 404).
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• Display Target List: Click this button to display a list of all targets (see Target List
on page 408).

• Target Anchor Watch: Click this button to set up an anchor watch alarm with respect
to a target that is currently at anchor (see Target Anchor Watch on page 410).

• Target Alarm Limits: Click this button to set or display CPA, TCPA and Proximity
alarm limits (see Alarm Limits on page 411).

• Cancel All Radar Targets: Click this button to cancel tracking of all radar targets. For
information, see Ceasing the tracking of targets on page 145.

• Number of AIS Targets: Displays the number of AIS targets being tracked.
• Number of Radar Targets: Displays the number of radar targets being tracked.
• Tracker Sensitivity: Specify the level of tracker sensitivity you require by using

the spin buttons. (The higher the number the greater the sensitivity.) For more
information, see Adjusting tracking sensitivity on page 146.

• Known Solution: Click this button to use the facilities for testing the tracker's
capabilities (see Known Solution on page 413).

The Targets menu in ECDIS

The buttons and options in the Targets menu in the ECDIS application are as follows:
• AIS: Click this button to use the radar system's AIS facilities and work with AIS

targets (see AIS on page 382).
• AIS Settings: Click this button to see an overview of the AIS target settings (see AIS
Target Settings on page 388).

• Select Target: Click to bring up a dialog that enables you to select a target and view
data about it (see Select Target on page 409).

• Target Data: Click this button to display data for the selected target (see Target
Information on page 404).

• Target List: Click this button to display a list of all targets (see Target List on
page 408).

• Target Sources: Select the sources of target data you want to use (the sources are radar
systems or an AIS receiver). The lamp blinks when target data is being received.

• Radar Video Sources: Select one of the sources of radar video. The corresponding
lamp blinks when radar video is received from the selected source.

• Align to Video: Click to align the electronic chart with the radar video. The
presentation mode will be changed to the same presentation mode as is selected for
the radar video source.
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20.3.1 AIS

The sub-menus and dialogs described in this section enable you to:
• Set and display information describing the own-ship (including its MMSI and IMO

numbers, its call sign, legnth and width, and the location of its conning position).
• Set and display information concerning the own-ship's current voyage (including the

number of people onboard, and the vessel's maximum draught when fully laden).
• List the AIS data associated with the own-ship itself.
• Send and receive AIS text messages.
• Configure AIS target alarms and warning limits.
For information about viewing the AIS data for an individual target, see Target
Information on page 404.
This is the AIS menu. The path to it is: Targets→AIS. It contains the following buttons:
• Set Static Ship Data: Click to view or specify static information about the own-ship

(see Set Static Ship Data on page 383).
• Set Static Voyage Data: Click this button to set or display static information concerning

the voyage that the own-ship is currently embarked upon.(see Set Static Voyage Data
on page 384)

• Display Own Ship Data: Click this button to list the AIS data associated with the
own-ship itself (see Display Own Ship Data on page 385).

• Acknowledge Lost AIS Targets: Click this button to acknowledge lost AIS targets
(there is no dialog associated with this action).

• Acknowledge SAR Transponder: Click this button to acknowledge an alert from a
search and rescue transponder (there is no dialog associated with this action). For
information about detecting messages from search and rescue transponders, see
Operating marine radars for SART detection on page 352.

• Text Message List: Click this button to view and send text messages (see AIS Text
List on page 386).

• Text Message: Click this button to create and send text messages (see AIS Text
Message on page 387).

• Targets Settings: Click this button to see an overview of the AIS target settings (see
AIS Target Settings on page 388).
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• Configure: Click this button to configure the handling of AIS alarms and messages
(see AIS Configure on page 394).

20.3.1.1 Set Static Ship Data

This dialog is for setting and displaying static information describing the own-ship.

To edit some of the parameters in this dialog, you need to enter the service password;
you must also be using the Kongsberg Seatex AIS receiver, and the interface to it must
be configured for Seatex AIS messages (see AIS interface on page 636); finally the radar
operator station must be set up to transmit to the AIS receiver.)

The path to this dialog is: Targets →AIS →Set Ship Static Data.

The dialog contains the following information:
• MMSI Number: The Maritime Mobile Service Identity number.
• IMO number: The International Maritime Organization number.
• Call Sign: The ship's call sign.
• Ship Name: The ship's name.
• Length: The ship's length.
• Width: The ship's width.
• From Aft: The ship's conning position, from aft.
• Starboard of center: The ship's conning position, starboard of center.
• Apply: Click to apply a data entry.
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20.3.1.2 Set Static Voyage Data

This dialog enables you to set or display static information concerning the voyage that
the own-ship is currently embarked upon.

The path to the dialog is: Targets→AIS→Set Static Voyage Data.

The dialog contains the following information:
• Type/Cargo: The voyage type or the cargo the vessel is carrying.
• Nav. Status: The current navigation status.
• Get Ship Data: Click this button to retrieve the currently configured value for the

vessel's maximum draught (see Ship (tab) on page 571).
• Max Draught: Use the up and down arrow controls to specify the maximum draught

for the fully laden vessel on its current voyage.
• Number of Persons Onboard: Use the controls to specify the number of persons

currently onboard.
• Destination: Enter the voyage destination into this field.
• Arrival (UTC): Use the control to specify the vessel's planned arrival time at the

end of the voyage.
• Apply: Click to apply any data you have entered.
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20.3.1.3 Display Own Ship Data

This dialog lists the AIS data associated with the own-ship itself.

The path to the dialog is: Targets→AIS→Display Own Ship Data.

The content of the dialog is as follows:
• Upper part: This part of the dialog displays the Maritime Mobile Service Identity

(MMSI) name of the object.
• Lower part: This part of the dialog lists the own-ship's AIS data.
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20.3.1.4 AIS Text List

This dialog enables you to view any AIS text messages received.

The path to the dialog is:Targets→AIS→Text Message List.

The dialog contains the following elements:
• Unread/Read/PreDef./Sent: Select one of the categories of message to list.
• Time: The time at which the text message was sent.
• MMSI: The Maritime Mobile Service Identity.
• Subject: The subject of the text message.
• Delete: Click this button to delete an entry in the list.
• New: Click this button to create a new text message. It brings up the AIS Text Message

menu (see AIS Text Message on page 387).
• Display: Click this button to list incoming AIS text messages from other vessels.
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20.3.1.5 AIS Text Message

This dialog enables you to create and send AIS text messages.

The path to the dialog is: Targets→AIS→Text Message.

The dialog contains the following elements:
• Text Telegram/Safety Message: Select type of text message to be made.
• To: Select a distribution method for the text message (Broadcast/MMSI).
• Acknowledge Required: Select this box if the text message requires an

acknowledgement.
• Window: This field contains the text message.
• Cancel: Click this button to cancel the text message.
• Reply: Click this button to reply to a text message.
• Save Predef.: Click this button to save a pre-defined text message.
• Send: Click this button to send the text message.
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20.3.1.6 AIS Target Settings

This dialog gives an overview of the AIS target settings.
The path to the dialog is:Targets→AIS→Target Settings.
The dialog contains the following elements:
• AIS processing status: Indicates the AIS operating status. When the maximum number

of targets has been exceeded, this area is red. When AIS is disabled, it is yellow.
During normal operation, however, it is grey and provides the number of active and
sleeping AIS targets

• Lost Target Warning: Indicates whether lost target warnings are enabled or disabled.
• Collision Warning: Indicates whether collision warnings are enabled for all targets,

enabled for active targets only, or disabled.
If they are enabled for active targets only, you will receive no warning when sleeping
AIS targets come inside the collision warning limits.
If they are disabled you will receive no warning when AIS targets come inside the
collision warning limits (see AIS Configure Warning Limits on page 390).

• Warning Details: Click this button to configure the warning limits (see AIS Configure
Warning Limits on page 390).

• Activation Area: Indicates whether a target acquisition area is enabled or disabled.
• Specify Area: Click this button to specify the auto-acquisition area (see Auto
Acquisition on page 396).

• Display True Ship Size: Check this box if you want the target to appear on the screen
along with a ship's outline that reflects the actual size of the target vessel according
to the scale of the display. The ship symbol will be displayed with true dimensions
if the K-Bridge MFD system has received the AIS telegram reporting the actual
ship dimensions and if the display scale is larger than 1:15000 (which also triggers
the display of the own-ship symbol with true dimensions). In accordance with AIS
requirements, however, the true scaled outline is not available when a target's heading
has not been received or when the beam of the outline is less than 7.5mm.
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• Target Association: Enabled/Disabled Indicates whether AIS target association is
enabled, enabled for active targets only, or disabled (“target association” was
previously known as “target fusion”).

• Pref: AIS/Radar: Indicates whether targets that have been associated are displayed as
AIS or radar targets (“Pref” is short for “prefer”).

• Association Details: Click this button to specify the conditions (if any) under which you
want AIS and ARPA/Radar targets to be associated (see AIS Association on page 392).

• Sleeping Target Filter: Indicates whether filtering of sleeping AIS targets is currently
enabled.

• Filter Details: Click this button to go to the AIS Sleeping Target Filter menu (see AIS
Sleeping Target Filter on page 393).

20.3.1.6.1 Auto Acq

This dialog is for defining the area around the own-ship within which targets are
automatically acquired.

There are two paths to the dialog:
• Targets→AIS→Target Settings →Specify Area.
• Targets →Auto Acquisition Area

For a description of it, see Auto Acquisition on page 396.
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20.3.1.6.2 AIS Configure Warning Limits

This dialog enables you to configure the warning limits associated with AIS targets.
The path to the dialog is: Targets→AIS→Target Settings→Warning Details.
The dialog contains the following elements:

Lost Target Warnings
• Max. Distance if Approaching: Use the spin buttons to set the maximum distance at

which a lost target warning will be issued for a target that was heading towards the
own-ship when it stopped sending AIS position messages.

• Max. Distance if Departing: Use the spin buttons to set the maximum distance at
which a lost target warning will be issued for a target that was heading away from the
own-ship when it stopped sending AIS position messages.

• Enable Lost Target Warning: Select to enable "Lost" target warnings. A LOST alarm is
issued when a target stops sending AIS position messages and either of the following
sets of conditions are true:
– The target's distance from the own-ship is less than "Max. Distance if

Approaching" and the heading of the AIS target is towards the own-ship.
– The target's distance from the own-ship is less than "Max. Distance if Departing"

and the heading of the target is away from the own-ship.
Either of these set of conditions will result in a LOST alarm being issued (see The
alert condition group buttons on page 61).

Collision Warnings
• CPA Alarm Distance: The CPA alarm distance (see Alarm Limits on page 411).
• TCPA Alarm Time: The TCPA alarm time (see Alarm Limits on page 411).
• Enable Collision and Proximity Warning: Select to enable collision and proximity

warnings for active AIS targets. An alarm is issued if a target has a CPA smaller than
the "CPA Alarm Distance" (nautical miles) and a TCPA smaller than the "TCPA
Alarm Time" (minutes:seconds). This will activate the COLL alarm field.
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• Enable Collision Warning on Sleeping: Select to enable collision warnings for sleeping
AIS targets. An alarm is issued if a sleeping target has a CPA smaller than the "CPA
Alarm Distance" (nautical miles) and a TCPA smaller than the "TCPA Alarm Time"
(minutes:seconds). This will activate the COLL alarm field.

Other elements
• Proximity Alarm Distance: If you are in the ECDIS application, you can specify the

proximity alarm limit in this dialog. For an explanation of the proximity alarm, see
Alarm Limits on page 411.

• Change Target Alarm Limits: Select to specify the radar target alarm limits (see Alarm
Limits on page 411). These limits apply to both radar and AIS targets.

• Enable New Target Warning: Select to receive a warning whenever the system
acquires a new AIS target.
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20.3.1.6.3 AIS Association

This dialog enables you to specify the conditions (if any) under which you want AIS
and ARPA/Radar targets to be associated with each other (the term “association” now
replaces the old term “fusion”).

The path to the dialog is: Targets→AIS→Target Settings→Association Details.

The dialog contains the following elements:
• Enable AIS/Target Association: Select this box to associate AIS and ARPA/Radar

target symbols if the distance and the difference in speed between them are within
the limits defined in this dialog.

• Enable Association of Sleeping: Check this box to enable target association where the
AIS target is a sleeping target.

• Maximum Distance: Use the up/down controls to specify a maximum distance
permissible between associated targets.

• Maximum Speed Difference: Use the up/down controls to specify a maximum (vector)
speed difference permissible between associated targets.

• Hysteresis: Specify the amount of hysteresis to allow while the targets are associated
(fused) with each other. The value you specify determines the frequency with which
the symbols for associated targets jump on the display between appearing as a single
target and appearing as two separate targets. If you specify a high percentage, there
will be less of this jumping. However, bear in mind that the percentage of hysteresis
you specify results in an equivalent percentage increase in both the maximum distance
permissible between associated targets and in the maximum difference in speed
permissible between the targets.

• Display AIS Target for Association: Select this box if you want the associated (fused)
target to display as an AIS target (see AIS symbols on page 174).

• Display Radar Target for Association: Select this box if you want the associated (fused)
target to display as a radar target (see Radar target symbols on page 145).
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20.3.1.6.4 AIS Sleeping Target Filter

This dialog enables you to configure the filtering of sleeping AIS targets. The filtering
criteria are: range, CPA (Closest Point of Approach) and TCPA.(Time to Closest Point
of Approach).

The path to the dialog is: Targets→AIS→Target Settings→Filter Details.

The dialog contains the following elements:
• Enable Filtering of Sleeping Tgts: Check this box to enable filtering of sleeping targets.

Sleeping AIS targets will not be presented if their range is greater than the value
specified for RMax (maximum range) and either:
– the CPA is greater than the CPAMax value or
– the TCPA is greater than the TCPAMax value
In other words, sleeping AIS targets with a range of less than RMax will be presented.
Sleeping AIS targets with a range greater than RMax will be presented only if the
CPA is less than CPAMax and the TCPA is less than TCPAMax.

• RMax: Specify the range within which you want to filter out sleeping AIS targets.
• CPAMax: Specify the CPA (between the own-ship and sleeping AIS targets) beyond

which you want to filter out sleeping AIS targets.
• TCPAMax: Specify the TCPA (between the own-ship and sleeping AIS targets) above

which you want to filter out sleeping AIS targets.
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20.3.1.7 AIS Configure

This dialog enables you to configure the handling of AIS messages and alarms.

The path to the dialog is: Targets→AIS→Configure.

The dialog contains the following elements:
• Auto Save Sent Messages: Check to store each outgoing message in a Sent mailbox.
• Auto Save Read Messages: Check to store each incoming message in a "Read" mailbox

after it has been sent.
• Handle AIS Equipment Alarms: Check to allow AIS alarms to be presented inside the

K-Bridge MFD's alarm system. If you check this option, you can also acknowledge
AIS alarms from inside the K-Bridge MFD's alarm system.

• Alarm on Safety Message: When this is checked, safety messages will generate an
alarm (the option is checked by default).

• Inhibit Class B targets: When this is checked, the display of class B targets is inhibited
(the option is un-checked by default).

• Inhibit VTS targets: When this is checked, the display of class VTS targets is inhibited
(the option is un-checked by default).

• Inhibit Misc. Objects: When this is checked, the display of AIS objects other than
class B and VTS targets is inhibited (the option is un-checked by default).

• Configure for BaseStation (not Ship): This option must always be un-checked on
K-Bridge systems that are installed on a vessel (the option is only available for
demonstration or training purposes on a land-based installation).

• Own Ship Position from AIS: This option causes the system take the own-ship’s
position from AIS. The option must be un-checked during normal operation.
However, you can check it in an emergency if all the ship’s primary position reference
systems have failed.
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• Time Sensor for Synchronization: Select a time sensor to synchronize the AIS with.
AIS messages can be subject to significant delay, but synchronizing the AIS with
a GPS time sensor will ensure that the AIS system estimates the position of other
vessels precisely (by extrapolating from the time, speed and position data received
from them).
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20.3.2 Auto Acquisition
The dialogs and sub-menus described in this section enable you to:
• Define the area around the own-ship within which ARPA and AIS targets will be

automatically acquired.
• Turn on and off the automatic acquisition of radar targets.
• Define fixed geographical limits (barrier lines) beyond which targets will not be

automatically acquired.

This dialog enables you to start the automatic acquisition of targets and to define the area
around the own-ship within which the tracker will automatically acquire targets.

There are two paths to this dialog:
• Targets →Auto Acquisition Area

• Targets →AIS →Target Settings →Specify Area.
The dialog contains the following elements:
• Auto Acquisition of Radar Tgt: Click this box to turn on the automatic acquisition of

targets. The acquisition area is displayed in the radar area.
• Auto Activation on AIS: Click this box to turn on the automatic activation of AIS

targets.
• Forward Radius: Use the arrow controls to set the forward outer limit for automatic

acquisition (range 0.1 - 24NM).
• Port Distance: Use the arrow controls to set the port outer limit for automatic

acquisition (range 0.1 - 24NM).
• Starboard Distance: Use the arrow controls to set the starboard outer limit for

automatic acquisition (range 0.1 - 24NM).
• Minimum Range: Use the arrow controls to set the inner limit for automatic

acquisition (range 0.1 - 24NM).
• Blind Sector: Use the arrow controls to define the aft blind sector where no tracking

will be performed (maximum ±90º).
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• Cancel Auto Acq Tracks: Click this button to stop tracking all automatically
acquired targets. (Targets inside the automatic acquisition area will be automatically
re-acquired if auto-activation is still enabled.)

• (Barriers) Active: Check this box to start using and displaying radar barrier lines (if
any are defined).

• (Barriers) Edit: Click to edit or create radar barrier lines (geographically fixed limits
to automatic target acquisition; see Barrier Line Menu on page 398).
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20.3.2.1 Barrier Line Menu

This sub-menu enables you to work with barrier lines. These are geographically fixed
limits to the automatic acquisition of targets. You can define them yourself or use
already existing ones.

The path to the menu is: Targets→Auto Acquisition Area→Edit.

The automatic acquisition area moves and turns with the own-ship, but barrier lines are
geographically fixed. They are limits to the automatic acquisition of land echoes or other
echoes. Targets are not automatically acquired behind barrier lines. Barrier lines may
be stored for later use and can be edited.

The sub-menu contains the following buttons:
• Manage Barrier Lines: Click this button to list existing barrier lines (see Barrier
Line List on page 399).

• Edit Barrier Line: Click this button to edit barrier lines (see Barrier Line on page 400).
• Save Barrier Lines: Click this button to save new or edited barrier lines to the hard

disk.
• Manage Barrier Line Folders: Click this button to organise your barrier lines into

folders (see Manage Barrier Line Folders on page 401).
• Load Barrier Lines from Floppy: Click this button to load barrier lines from floppy

disk (see Load barrier lines from an external medium on page 402).
• Save Barrier Lines to Floppy: Click this button to save barrier lines to floppy disk (see
Save barrier lines to an external medium on page 403).
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20.3.2.1.1 Barrier Line List

This dialog lists the barrier lines that are already defined. It also enables you to create
new ones.

The path to the dialog is: Targets→Auto Acquisition Area→Edit→Manage Barrier Lines.

The dialog contains the following elements:
• Folder list: Select a barrier folder from the drop-down list to display the barriers

in that folder.
• Sort: The barrier lines in the selected folder can be sorted by distance (from the

own-ship) or by date of creation/modification. Select the sorting method you require
by using the radio buttons.

• List: Click this button to display the Barrier Line menu showing the selected barrier
line.

• Edit: Click this button to display the Barrier Line menu showing the selected barrier
line, ready to be edited.

• Cut: Cut/paste is used to move a barrier line from one folder to another. Select the
barrier line and click Cut.

• Paste: Cut/paste is used to move a barrier line from one folder to another. Go to the
folder you want the barrier line pasted into and click Paste.

• (Create) Barrier Line: Click this button to display the Barrier Line menu, ready to
insert lines (see Barrier Line on page 400).
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20.3.2.1.2 Barrier Line

Use this dialog to edit an existing or newly created barrier line.

There are two paths to this dialog:
• Targets→Auto Acquisition Area→Edit→Edit Barrier Lines

• Targets→Auto Acquisition Area→Edit→Manage Barrier Lines →(Create) Barrier Line

The dialog contains the following elements:
• Line number: The line number of the selected barrier line. Use the up-down controls

to specify line number.
• Time: The date the barrier line was saved.
• List: Click this button to display the Barrier Line List menu.
• Comment: Use this field to describe the barrier line for later use.
• List of points: List of the barrier segment end points (latitude and longitude)

constituting the barrier line.
• Apply: Click to apply your changes to the barrier line.
• Cancel: Cancels text that was entered through the keyboard.
• Copy Pt: Copy/paste is used to copy selected points to other barrier lines. Select the

points you want to copy, and click Copy PT.
• Insert Pt: Insert a new point before or between existing points.
• Delete Pt: Delete the selected point.
• Paste Pt: Go to the folder you want the points pasted into, and click Past PT.
• Datum: Select WGS-84 or Local datum.
• Local: Pressing this button allows you to select a datum from a list of commonly used

datums. If you select a local datum, the name will shown as the button text (instead of
“Local”). See section 20.9.9 on page 551 for more information.
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20.3.2.1.3 Manage Barrier Line Folders

Use this dialog to organise your barrier lines into folders.

The path to the dialog is: Targets→Auto Acquisition Area→Edit→Manage Barrier Line
Folders.

The dialog contains the following elements:
• Folder List: Lists all barrier line folders in the system. Select a folder from the list.
• Display: Displays the barrier lines in the selected folder in the radar area.
• Undisplay: Turns the display of barrier lines off.
• Edit: Allows you to edit the barrier line that is selected in the radar area.
• New: Click to create a new barrier line folder.
• Rename: Click to give a new name to the specified folder.
• Insert File: Click to insert barrier line files from an external memory device into

this folder.
• Revert: Click to cancel un-saved changes and revert to the last saved version.
• Delete: Click to delete the selected folder.
• Backup: Click to save the selected folder to an external memory device.
• Save: Click to save the modified folder to the hard disk.
• List: Click to view the barrier lines in the selected folder (see Barrier Line List on

page 399).
• Refresh: Refreshes the folder list (use this button when you have inserted a new

external memory device).
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20.3.2.1.4 Load barrier lines from an external medium

Use this dialog to load previously defined barrier lines from an external device.

The path to the dialog is: Targets→Auto Acquisition Area→Edit→Load Barrier Lines
from Medium.

The dialog contains the following elements:
• Select input device/directory or Cancel: Window below lists the available

device/directory. Select device/directory from the list.
• Lower window: Displays selected device/directory.
• OK: Click to list contents of selected device/directory.
• Cancel: Click to cancel selected device/directory.
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20.3.2.1.5 Save barrier lines to an external medium

Use this dialog to save barrier lines to an external memory device.

The path to the dialog is: Targets→Auto Acquisition Area→Edit→Save Barrier Lines to
Medium.

The dialog contains the following elements:
• Select output device/directory or Cancel: Window below lists the available

device/directory. Select device/directory from the list.
• Lower window: Displays selected device/directory.
• OK: Click to list contents of selected device/directory.
• Cancel: Click to cancel selected device/directory.
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20.3.3 Target Information

Radar: target information

AIS: target information

This dialog displays the object data belonging to a tracked radar or AIS target.

To bring up the dialog, point to the target you are interested in by using the track-ball,
then press DATA on the operator panel (see The TARGET group buttons on page 35).
(Trial manoeuvre data is displayed if a trial manoeuvre is in progress; see Using the trial
manoeuvre facility on page 313.)
If there are two targets close together – perhaps one a radar target and the other an AIS
target, and you want to view the radar data but it is the AIS data that is shown (or you
want to view the AIS data but it is the radar data that is shown) – click the Tgt+ button.
This shows you the data for both targets. You can view data for up to four targets at
the same time.

The data contained in this dialog can include the following:
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• Upper portion: This part of the dialog displays the target identifier or the
MMSI-number.

• Lower portion: This part of the dialog contains the target data.
• List..: Click to see a list of all targets currently known to the system Target List on

page 408.
• Tgt +: Select a target from the list (see Target List on page 408) and then click Tgt +.

The new target data always appears above the last target data view displayed. You can
display a maximum of four target data views at once.
Alternatively, click Tgt + to bring up data for the target closest to the marker (if
you have clicked with the marker), or closest to the last target for which data was
displayed, or closest to the vessel’s own position (if you have not previously clicked
with the marker or displayed data for a target).

• Tgt -: Click to close the target data that was added least recently (in other words, to
close the target data view at the bottom.

• Tgt Operation: Click to bring up the Radar Target Operations menu (see Radar Target
Operations on page 406).

• AIS Operation: Click to bring up the AIS Target Operations menu (see AIS Target
Operations on page 407).
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20.3.3.1 Radar Target Operations

This dialog enables you to perform some additional operations on a selected target.

To bring it up, click on a radar target and, in the Target Information dialog (see Target
Information on page 404) for that target, click Tgt Operation.

The dialog contains the following elements:
• Radar Target no: Displays the radar target number.
• Identifier: Type an identifying name if you want the target to be identified by a name

instead of the default number. Click Apply New Identifier to complete the action.
• Apply new Identifier: Click to apply the new identifier.
• Display Identifier: Select to display the identifier for this target in the radar area.

To display the identifier for all targets, go to MENU →Display and select Target ID
(see Radar Themes on page 371).

• Cancel this track: Cancels tracking of this target.
• Anchor Watch: Brings up the Target Anchor Watch dialog for this target (see Target
Anchor Watch on page 410).

• Fixed Reference Target: Check this box to designate the target a fixed reference
target to be used for radar positioning. For more information, see Using the radar
positioning system on page 148.

• Cancel All Tracks: Cancels tracking of all radar targets.
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20.3.3.2 AIS Target Operations

This dialog enables you to perform some additional operations on a selected AIS target.

To bring it up, click on an AIS target and, in the Target Inforomation dialog (see Target
Information on page 404) for the target, click AIS Operation.

The dialog contains the following elements:
• AIS Track MMSI:Displays the AIS target's MMSI (Maritime Mobile Service Identity)

number.
• Name: Displays the AIS target vessel's name if available.
• Display Identifier: Select to display the target's name (if available) on the screen.
• Activate this Target: Click to activate the target.
• Deactivate this Target: Click to deactivate the target.
• Activate all AIS Targets: Click to activate all AIS targets on the display.
• Deactivate all AIS Targets: Click to deactivate all AIS targets on the display.
• Association & AIS Target Settings: Click to go to the AIS Target Settings dialog (see
AIS Target Settings on page 388).
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20.3.4 Target List

This dialog lists all targets (optionally for both ARPA and AIS) currently known to the
system (at whatever stage they happen to be at in the target lifecycle).

In Radar the path to the dialog is: Targets→Display Target List.

In ECDIS the path is: Targets→Target List.

The dialog contains the following elements:
• Radar: Check to include radar targets in the list.
• AIS: Check to include AIS targets in the list.
• Column headings: You can click on the column headings to determine how the list is

sorted. By default, it is sorted alphabetically by name (and numerically by MMSI
number for targets whose name is not available). But you can have it sorted by
range, CPA (Closest Point of Approach; the closest target appearing first in the list),
or TCPA (Time to Closest Point of Approach; the target with the shortest TCPA
appearing first in the list). The circumflex appearing next to a column label indicates
how the list is currently sorted.
When the TCPA is close to zero, there is a danger of collision if the CPA is also close
to zero. However, it is possible for the TCPA to be close to zero but for the target
still to be at a safe range.

• When the TCPA is negative, the own-ship has already passed the CPA for the target
and the two vessels are now moving further apart.

• Go To Target: Click this button to position the chart view with the selected target at its
centre. The target will also be highlighted by a surrounding blue border.

• Display Target Data: Click to bring up the data for the selected target (see Target
Information on page 404).
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20.3.5 Select Target

This dialog enables you to select a target and view data about it.

The path to the dialog is: Targets→Select Target.

The dialog contains the following elements:

Type: Select the type of target from the drop-down list.

Ident: Select the target from a list of targets of the specified type.

Select Target with Cursor: Clicking this button you can identify the target by pointing
to it on the screen.

Go To Target: Click this button to position the chart view with the selected target at its
centre. The target will be highlighted by a surrounding blue border and data for the target
will be displayed (see Target Information on page 404).

Display Target Data: Click this button to see data for the selected target (see Target
Information on page 404).
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20.3.6 Target Anchor Watch

Use this dialog to start the anchor watch on a selected target. For information about how
to use it, see Using the anchor watch function on page 324.

The path to the dialog is: Targets→Target Anchor Watch.

The dialog contains the following elements:
• Active: Activates the anchor watch function for the selected target. The warning

limit will be displayed in the radar area.
• Set Current: Sets the target's current position as the anchor watch position.
• Anchor Position: Enter the anchor watch position here (or use the Set Current button

above).
• Deviation: The distance between the target's anchor watch position and its current

actual position.
• Limit: Enter the limit for the anchor watch circle here. All information in the menu is

cleared when tracking of the target is stopped.

410 381287/A



Reference Guide

20.3.7 Alarm Limits

This dialog is for setting alarm limits around radar and AIS targets and around the
own-ship itself. If the limits are breached, either a collision danger or a proximity
violation alert is generated. These alerts are of the highest priority (ALARM) and of the
highest category of severity (category A).

Note

For integrated K-Bridge systems, all alarm limits (including the target alarm limits)
that you specify are individual to each display unit. You must therefore configure each
console individually to make them all agree with each other.

The path to this dialog is: Targets→Target Alarm Limits.
• CPA: The limit for the closest point of approach by a target to the own-ship before a

collision danger alert is given.
• TCPA: The time limit for the CPA before a collision danger alert is given.
• Prox: Tracked targets closer to the own-ship than this limit will cause a proximity

violation alert to be issued. The limit allows you to be alerted in cases where a
target is close to the own-ship but the TCPA is so long that a collision danger alert
is not issued. This can occur, for example, if the own-ship and the target are on a
more-or-less parallel course. In this case the target can still represent a threat because
even a small manoeuvre could cause a collision.

Note

On a Multi-functional Display system, the same target limits apply whether you are in
Radar or ECDIS: changing the limits in one application causes them to change also in
the other.

Specify AIS target alarm limits in the AIS Configure Warn. Limits dialog
(Targets→AIS→Target Settings→Warning Details; see AIS Configure Warning Limits on
page 390).
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For more information on alarms, see Collision avoidance on page 157 and AIS collision
warnings on page 172.
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20.3.8 Known Solution

Use this dialog to create a synthetic echo for a single simulated radar target in order to
test the performance of the radar's tracker. The simulated radar target must in fact be
one of up to five simulated AIS targets. (Only a single simulated AIS target can be used
for the purpose of testing the tracker – you cannot use the other simulated AIS targets
to test it.) You can use the other simulated AIS targets for purposes of radar training
and familiarization.

The path to this dialog is: Targets→Known solution.

For information about how to use this menu to test the radar's tracker, see Testing the
radar's tracking capability on page 152.

Note

When you start the simulator, the presentation of real-time radar video is replaced with
the simulated signals. A large green X appears at the bottom of the screen to indicate
this, and a small green x appears at the position of each simulated target.

The Known Solution dialog contains the following elements:
• Test Targets Active: Check this box to start the simulation; clear it to stop the

simulation.
• Brng: The initial bearing from the own-ship to the simulated target. When you start

the simulation, this field provides the mathematically correct bearing at a given
moment and given the other initial values you entered.

• Range: The initial range (distance) from the own-ship to the simulated target. When
you start the simulation, this field provides the mathematically correct range at a given
moment and given the other initial values you entered.

• SOG: Speed Over Ground of the simulated target (this remains constant during the
simulation).

• COG: Course Over Ground of the simulated target (this remains constant during
the simulation).
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• Radar: Check this radio button to make the associated target generate a synthetic
radar echo.

• AIS: Check this radio button to indicate that you want the associated target to be
included in the simulation.

• Apply: Click this button to apply the values you have entered (in other words, to make
them the initial values for the simulation). You must apply the initial values before
checking Test Targets Active to activate the simulation.
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20.4 Route menu

This menu enables you to create, manage and use routes. It also enables you to monitor
a route that is currently being followed by the autopilot.
To see the menu, click the Route button on the main menu in the top bar.
The menu contains the following buttons:
• Manage Routes: Click to manage routes (see Route List on page 416).
• List Waypoints: Click to view the waypoints in a route and (if required) to make

changes to them (see Edit route on page 420).
• Validate route Click to validate the currently selected route (see Validate Route on

page 422).
• Back-up/Restore Routes: Click to back up or restore routes to or from an external

medium (see Routes Backup/Restore on page 424).
• Set Route Parameters: Click to specify the route parameters (see Route (tab) on

page 570).
• Monitor Route: Click to display information about the selected route and monitor the

own-ship's progress along it (see Route Monitor on page 425).
• Autopilot Mode: Click to change autopilot modes or to start using the autopilot (see
Autopilot Mode on page 427).

• Autopilot Panel: Click this button to view the status and properties of the autopilot
panel (see Autopilot Panel (option) on page 430). If the autopilot is not enabled,
this button is not enabled.

• Compute ETA: Click to calculate your estimated time of arrival (see ETA Computation
on page 432). If you:
– Have the Speed Pilot option configured, see ETA Speed on page 435 with Speed

Pilot configured.
– Do not have the Speed Pilot option configured, see ETA Computation on page 432.

• Speed Pilot: Click to configure the Speed Pilot (see Speed Pilot (option) on page 433).
• Generate Route Automatically: Click to use the route generation and tide prediction

option (see Generating routes, predicting tides, avoiding pirates on page 767).
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• Search and Rescue: Click to select a search pattern for a search and rescue operation
(see Search and Rescue on page 437).

20.4.1 Route List

Use this dialog to manage the routes in your list.
The path to the dialog is: Route→Manage Routes.
You can sort the list of routes by the route name, by the distance to the start of the route
(from the own-ship), or by the date of the route's creation.
The “state” of a route can be:
• Active: The ship is currently following this route.
• Alternate: This route is currently displayed in the chart as an alternative to the route

on which the ship is currently sailing.
• Edit: This route plan is currently opened for editing.
The Route List dialog contains the following buttons:
• New: Clicking the new button brings up theWaypoint List dialog which allows you to

specify a new route (see Edit route on page 420).
• Edit WPT: Allows you to edit the selected route (see Edit route on page 420).
• List WPT: Lists the waypoints for the selected route (see Edit route on page 420).
• Delete: Deletes the selected route.
• Display: Click to display the selected route within the radar area (if it is within the

radar's range).
• Undisplay: Click to remove the selected route from the screen.
• Rename: Allows you to change the name of the selected route.
• Validate: Click to validate the selected route (see Validate Route on page 422).
• Monitor: The selected route is used to monitor that the ship is on track and to give

off-track alarms.
• Unmonitor: The monitoring is turned off.
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• Weather: Click to use the optional weather forecast services.
• Export: Click to export a route to another system (see Route Export on page 419).
• Import: Click to import a route from another system (see Route Import on page 418).
• Print: Click to print details of the selected route (the route details are then added to

the list of items available for printing; you must select them from this list and press
Print once more in the Printer dialog; see Printer on page 590).
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20.4.1.1 Route Import

Use this dialog to import route plans from another navigation console or to export route
plans to another system.

Note

Before you can import or export route plans, you must configure the system to perform
the route import and export operations. This includes specifying the source and/or
target directories (see Configure Route Export on page 661). The service password is
required to configure this.

The path to this dialog is: Route→Manage Routes→Import

The dialog contains the following elements:
• On System: This is a list of the route plans currently stored on your system.
• OnMedium: This is a list of the route plans that are available for import on an external

medium (such as a USB memory stick) that is connected to the system. You can
select them individually or select them all by clicking Select All. Alternatively, click
Select Updated to compare the route files on the external medium with those on the
system itself and download any from the external medium that are newer than the
version currently on the system itself.

• Use XML Format: Select to convert the selected route plans from XML format. (The
file suffix is .rut for the old route format and .rux for the XML format. The system is
also capable of importing some .rt3 files.)

• Restore: Select to import the selected route plans from the medium.
• Refresh: Click to cause the system to re-read the external medium (for example, if

you have opened the dialog before inserting the USB memory stick).
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20.4.1.2 Route Export

Use this dialog to export a route plan to another system.

Note

Before you can import or export route plans, you must configure the system to perform
the route import and/or export operations (see Configure Route Export on page 661).

The paths to this dialog is: Route→Manage Routes→Export

The dialog contains the following elements:
• On System: This is a list of the route plans on your system that are available for

export. You can select them individually or select them all by clicking Select All.
Alternatively, click Select Updated to compare the route files on the system with
those on the external medium and export any from the system that are newer than the
versions currently on the external medium.

• On Medium: This is a list of the route plans already stored on the external medium.
• Use XML Format: Select to convert the selected route plans from XML format. (The

file suffix is .rut for the old route format and .rux for the XML format. The system is
also capable of exporting some .rt3 files.)

• Backup: Select to export the selected route plans to the medium.
• Refresh: Click to cause the system to re-read the external medium (for example, if

you have opened the dialog before inserting the USB memory stick).
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20.4.2 Edit route

This dialog enables you to view and edit the waypoints in a route.

Note

In Radar, the dialog is narrower than in ECDIS. This is because regulations do not
permit dialog boxes to obscure the radar display area. In Radar, therefore, you must
make more use of the horizontal scroll bar to view the table of waypoints.

For each waypoint in the list, you can edit specified fields, including the off-track limit.
Just double-click the field to make it edit-able.

You can reach the dialog by various paths through the menus and dialogs:
• Route→List Waypoints.
• Route→Manage Routes→New.
• Route→Manage Routes→Edit WPT.
• Route→Manage Routes→List WPT.

The dialog contains the following elements:
• Route Name: The name of the route being displayed. For new routes type in the

name here.
• Entry: The waypoint list includes only information that can be changed by the

operator.
• Full: The waypoint list includes items in addition to those set by the operator.
• Edit: Starts an edit session. When an edit session has been started, the Edit button

is removed and Close and Save buttons are displayed. If no route is selected, List
will be displayed.

• Close: Ends the edit session.
• Save: Save the route to the hard disk.
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• Message field: Provides messages regarding the route status, and error situations. The
K-Bridge ECDIS system can validate a route by checking to see if it is deep enough,
do not violate dangers or restricted areas and do not exceed the own-ship's turn rate.
This information is provided here.

• List: List the route waypoints. Use the scroll bar to view all information.
• Select All: Selects all waypoints in the list.
• Mark: Mark the start of a selection of waypoints.
• Insert: Insert new waypoint.
• Delete: Delete selected waypoint(s).
• Copy: Copy selected waypoint(s).
• Paste: Paste copied waypoints into the waypoint list.
• Reverse: Reverse the route, to sail it the other way.
• Undo: Undo last edit operation.
• Datum: Select WGS-84 or Local datum.
• Local: Pressing this button allows you to select a datum from a list of commonly used

datums. If you select a local datum, the name will shown as the button text (instead of
“Local”). See section 20.9.9 on page 551 for more information.
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20.4.3 Validate Route

This dialog enables you to check if the route crosses the own-ship's safety contour or if it
crosses the boundary of a prohibited area or a geographic area where special conditions
exist.

The main paths to this dialog are:
• Route→Validate Route

• Route→Manage Routes→Validate

• Route→List Waypoints→Validate

The dialog contains the following elements:
• Route Name: The name of the selected route.
• Safety Contour: The (current) safety contour value which will be used for route

validation.
• Validation Period: For time-dependent chart information, the date used for validation

can be of importance. If the actual date of sailing is specified in the ETD/Wait field
of the first waypoint, this date is used for the validation. Otherwise the current date
(today) is used.

• Validate (unattended): Validates the complete route and lists the results.
• Validate and View: Validates each leg and turn in the route separately. If a leg or turn

covers two or more charts, the leg/turn is divided into parts so that only one chart is
involved in the validation process at a time. The positions of potential grounding
situations are indicated by blinking red "stars". In the menu the leg/turn is shown with
information about the chart used and the number of potential grounding and warning
situations that have been found.
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• Validate Manually: Used when the available charts (raster charts) do not support
automatic validation. Allows you to validate a route manually. For each leg and turn
check the route against the chart and use the appropriate button to specify that it is
either OK or that it has a possible grounding or warning condition.

• View: Steps through each leg and turn without validation. Possible groundings are
displayed in the chart.

• Full Route: Select to validate the whole route.
• WP77–WP79: (selected set of waypoints) Select to validate this part of route only.
• Edit: Click the button to go to the Route Edit menu.
• List: Displays the available routes.
• Groundings: Lists the number of groundings detected on the leg/turn.
• Warnings: Lists the number of warnings detected on the leg/turn.
• Start: Click the button to start the validation.
• Start On: Click the button to start validation on the selected waypoint.
• Warning: Click during manual validation to indicate that the leg or turn has a warning

situation associated with it.
• Previous: Click the button to redo validation for the previous waypoint.
• Next: Click the button to validate the next waypoint.
• Grounding: Click during manual validation to indicate that the leg or turn has a

danger of grounding associated with it.
• Cancel: Click the button to cancel the validation.
• Save: Click the button to save the validation status with the route. For normal

validation.
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20.4.4 Routes Backup/Restore

Use this dialog to back up (or restore) routes to (or from) a selected device such as a
USB memory stick.

The path to the dialog is: Route→Back-up/Restore Routes.

The dialog contains the following elements:
• On System: List of route plans on this system. Select routes from the list when

making a back-up.
• Select All: Selects all routes in the list.
• Select Updated: Selects only route that are newer than those already on the selected

device.
• Backup >>: The selected routes are copied to the selected device.
• On Medium: List of routes on the selected media device. Select from the list when

restoring routes.
• Select All: Selects all routes on the selected device.
• Select Updated: Selects only routes that are newer than those in the system.
• << Restore: Selected routes are copied to the system.
• Select Device: Enables a menu to select a storage device
• Refresh: Click this button to refresh the lists such as when you have inserted a new

storage device.
• Message area: Messages related to the back-up/restore process.
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20.4.5 Route Monitor

Use this dialog to display information about the selected route and to monitor the
own-ship's progress along it.
The path to the dialog is: Route→Monitor Route.
The dialog contains the following elements:
• Active Route: When a route is selected the name is displayed here.
• AP Mode: Click this button to display the AP Mode menu (see Autopilot Mode on

page 427).
• Validation status: Information is available when a route has been selected for

monitoring.
• Route: Validation status of the route: Not Valid/Man.Val. (the route is checked

manually); Non ENC Val. (the route is validated using an unofficial chart); ENC Val.
(the route is validated using an official chart).

• Current Leg: Background colour indicates the status for the current leg as selected
using the forward and backward buttons below.
– Red - grounding
– Yellow - warning
– Grey - OK

• Next Turn: Background colour indicates the status for the next turn as selected using
the forward and backward buttons below.
– Red - grounding
– Yellow - warning
– Grey - OK

• Next Leg: Background colour indicates the status for the next leg as selected using the
forward and backward buttons below.
– Red - grounding
– Yellow - warning
– Grey - OK

• Curr.WP: Approaching waypoint. This waypoint may be selected by the operator.
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• Brg/Rng WOP: Bearing and range to the next wheel over point.
• Time To WOP: Sailing time to the next wheel over point.
• Crs: New course on the next leg.
• Rate: Turn rate to turn to the next leg.
• Radius: Turn radius to turn to the next leg.
• Dist: Distance of the next leg.
• ETA: Click to select ETA Computation menu.
• XTD Actual: Actual cross track distance.
• XTL: Cross track distance limit.
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20.4.6 Autopilot Mode

This dialog is for selecting the autopilot mode. Use it in conjunction with the autopilot
buttons on the operator panel (see The ALC (alarm and control) NAV panel on page 36).
There are various paths to this dialog:
• Route→Autopilot Mode.
• Route→Monitor Route →AP Mode.
• Own Ship→Autopilot.
• Or click the In Command button on the Top Bar (see Top bar: the “AP in Cmd/In
Cmd of AP” button on page 59).

The dialog contains the following elements:
• CRS: Selects course mode steering.
• HDG: Selects heading mode steering.
• WP: Selects waypoint mode steering.
• Track: Selects track mode steering.
• AP-Mode: Displays the mode as reported from the Autopilot. The possible modes are:

Course, Heading, Track, and Standby. If the text of the AP-Mode field reads:
– Heading, and In Command is un-checked, then this MFD system is not currently

in command of the Autopilot. The operator station that is currently commanding it
is indicated in the message field at the bottom of the dialog.

– Standby, then the Autopilot is not controlling the vessel’s steering gear in any
case. The steering gear is being controlled manually from the bridge or by a
Dynamic Positioning system, or by some other steering control system.

For more information about the different operating modes, see Operating the autopilot
in track-steering mode on page 251.

• In Cmd: Check this box to put the console you are using in command of the autopilot
(this is the equivalent of pressing the IN CMD button on the operator panel; see The
IN CMD button on page 37). You can then specify the autopilot mode you require.
For information about how to give command of the autopilot to a particular operator
station whenever the vessel switches from manual steering to autopilot, see Making
one console take command of the autopilot by default on page 249.

• Course/Heading: In Heading mode this field displays both the ordered and the actual
heading. In Course Mode it displays the ordered and the actual course.
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• Turn Radius: Displays the ordered turn radius transmitted to the autopilot.
• Route Monitor: Click the button to go to the Route Monitor menu (see Route Monitor

on page 425).
• Curved EBL: Click to use the Curved EBL facility to specify a turn and then use it as

input to the autopilot. In Radar, the Trial Manoeuvre facility is also available when
you click this button; the Trial Manoeuvre facility enables you to test whether a
turn can be executed without danger of collision (see Trial Manoeuvre and Curved
EBL on page 473).

• XTD: Displays the cross track distance.
• Autopilot Panel: Click the button to enter the Autopilot Panel dialog (see Autopilot
Panel (option) on page 430). If the Autopilot is not currently operating, this button
does not appear in the dialog.

• Message field: Shows which K-Bridge Radar or K-Bridge ECDIS operator station is in
command of the Autopilot (if any): this information is followed by the Autopilot's
current sailing mode, which will be either of the following:
– ECON: Autopilot in economy mode.
– PREC: Autopilot in precision mode.

Note

An audible turn “pre-warning” alarm will be issued 3 minutes (by default) before the
own-ship reaches the next Wheel-over Point (WOP). Also, an audible turn “warning”
alarm will be issued 30 seconds (by default) before the own-ship reaches the next Wheel
Over Point (WOP). For information about how to specify alternative time periods for
these alarms, see Autopilot Configuration on page 658.

The following table summarizes the possible values for the AP-mode indicator.

Table 26 Autopilot modes

Selected

mode

AP-mode

indicator

What is in
command of the
Autopilot? Interpretation

CRS Course The K-Bridge MFD TheK-BridgeMFD is controlling
the autopilot in course mode.

HDG Heading The K-Bridge MFD TheK-BridgeMFD is controlling
the autopilot in heading mode.

WP Waypoint The K-Bridge MFD TheK-BridgeMFD is controlling
the autopilot in waypoint mode.

TRK Track The K-Bridge MFD TheK-BridgeMFD is controlling
the autopilot in track mode.

None Heading The K-Bridge MFD The K-Bridge MFD is ready
to take control and is waiting
for you to specify the Autopilot
mode.

428 381287/A



Reference Guide

Table 26 Autopilot modes (cont'd.)

Selected

mode

AP-mode

indicator

What is in
command of the
Autopilot? Interpretation

None ****** Undetermined
(another navigation
or DP system could
be controlling
a third-party
autopilot system,
or the steering gear
could be under
manual control
from the bridge).

There is no communication
between the K-Bridge MFD and
the Autopilot.

None Standby An Autopilot
operator panel

The Autopilot is not active and
is therefore not controlling the
steering gear.

None Heading An Autopilot
operator panel

A dedicated Autopilot operator
panel is controlling the steering.
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20.4.7 Autopilot Panel (option)

This dialog provides some optional autopilot facilities. It is not available with all systems.

The dialog enables you to specify whether the autopilot operates in economy or precision
mode (in economy mode there is less rudder movement but also some loss of precision).
The dialog also enables you to specify the primary and secondary compasses for the
autopilot to use.

The path to this dialog is: Route→Autopilot Panel.

The dialog contains the following information and buttons:
• Heading

– Deviation: Shows the deviation between current heading and the ordered heading.
– Order: Shows current heading set-point issued as a steering order to the autopilot.

• Status: Displays the status reported from the autopilot.
• Parameter Set: Displays the active parameter set loaded into the autopilot.
• Control

– Economy: Check this button to operate autopilot in Economy mode thus reducing
rudder movement and also precision of the heading controller.

– Precision: Check this button to operate autopilot in Precision mode thus have
maximum performance of rudder and the heading controller.

• Compass

– Main: Select which gyro to use as the main compass.
– Monitor: Select which gyro to use as the monitored compass.
Note

To alter the selected main or monitoring compass, you must first put the vessel's
steering system under manual control.

• Apply: Click the button to apply the selections.

Autopilot Mode: Click to specify the autopilot mode (see Autopilot Mode on page 427).
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Autopilot Setup: Click to configure the autopilot. The dialogs for doing this are not
described in this manual (see note below)

Note

For a description of the autopilot setup dialogs, refer to the K-Bridge Autopilot Operator
Manual (see References on page 45).
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20.4.8 ETA Computation

This dialog enables you to calculate your estimated time of arrival at a selected waypoint
or at the end of the route. Use it if you do not have the Speed Pilot option configured. (If
you do have the Speed Pilot option configured, see ETA Speed on page 435.)

The path to this dialog is: Route→Compute ETA.

The dialog contains the following elements:
• Route: Name of the monitored route.
• Wp: List of the remaining waypoints on the route
• Distance: Distance to the waypoint.
• ETA: Estimated Time of Arrival at the waypoint.
• Speed: Facility for specifying (using the spin box) the own-ship speed to be used for

ETA calculations. Three options are available:
– Use Current: own-ship speed, SOG, at any time is used.
– Use Planned Speed: The speed which is entered during the planning of the route

is used.
– Use Manual: The speed to use is entered manually in the field to the left.

• Add Wait Times: Checked if the wait times which were included in the planning of the
route shall be included (added) in the calculation of ETA.

• Obey Max Speed: Checked if the ETA shall take into calculations that the planning
may have imposed speed restrictions on some legs.
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20.4.9 Speed Pilot (option)

Use this dialog to configure the Speed Pilot. The dialog is only available on systems that
have the Speed Pilot installed.
The path to this dialog is: Route→Speed Pilot.
For a description of the Speed Pilot option, see Speed pilot on page 761.
Speed Pilot Mode: Indicates the status of the speed pilot.
• The first text field displays current feedback from propulsion (RPM, Pitch, % of

maximum propulsion).
• The second text field (Status field) displays the speed pilot command mode:

– Not Ready: The speed pilot is not ready for communication.
– In Cmd: The speed pilot is in command to be able to perform any Speed pilot

settings.
– Remote: The speed pilot is controlled by K-Bridge Radar.

• Command button
– Active: If Active is displayed, the speed pilot is active.
– Activate: Click button to activate the speed pilot.

Operating Mode:
• Speed Mode ‒ Manual adjustment of speed setpoint using the spin buttons or the

numeric field to the right.
– Spin buttons: Speed can be set by using spin buttons to increase or decrease the

speed order (1 knot step).
– Numeric field: Speed can be set by entering numeric keys in the field. The Apply

button must be clicked in order to initiate the new speed order.
• Route Mode ‒ Automatic speed setpoint from active, monitored route. This mode

takes speed order from the waypoint list speed attribute (Spd). The speed order is
then picked accordingly and put out to the speed pilot. For more information, see
Edit route on page 420.

• ETA Mode: Estimated Time of Arrival selections.
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– ETA Setup: Click this button to calculate the estimated time of arrival using the
Speed Pilot (see ETA Speed on page 435).

– WP: Displays the next waypoint.
– ETA text field: Displays the estimated time of arrival at the end of the selected

route.
– Automatic speed profile update: Check to enable dynamic update of the speed

of the route.

Current Setpoint:

• Ordered Speed – Speed setpoint sent to the speed pilot.
• Diff. Speed – Difference between current speed and ordered Speed.

Status field:

• On schedule – The trip is on schedule.
• No speed pilot – Communication failure with the speed pilot.
• No Active Route – Route mode has been selected without having an active route.
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20.4.9.1 ETA Speed

This dialog enables you to calculate the estimated time of arrival when you are using
the Speed Pilot.

The path to the dialog is: Route→Speed Pilot→ETA Setup.

Toggle the buttons to select the following:
• Calc ETA: Perform calculations without using the Speed Pilot (see ETA Computation

on page 432).
• ETA Speed Pilot: Perform calculations using the Speed Pilot.
Route window:

• Text field: Displays mode and name of monitored route.
• Wp: List of the remaining waypoints of the route.
• Free Speed: Tick off to be able to change speed.
• Want ETA: Estimated Time of Arrival at the waypoint.
• ETA: Estimated Time of Arrival at the waypoint.
OK: Click to enter configured plan.

Cancel: Click to cancel configured plan.

Ins ETA: Click to insert configured estimated time of arrival data; (time format; DD
<Month in 3 letter code> HH:MM).

Del ETA: Click to delete configured estimated time of arrival data; (time format; DD
<Month in 3 letter code> HH:MM).

Fixed Speed Legs: (Note: If Free Speed not ticket off, see above).

Use the spin-box in conjunction with the following buttons to specify the vessel speed
that you want to base the calculations on:
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• Use Current (SMG): Get current speed. May be changed by using spin buttons in
the field to the left.

• Use Planned Speed: The speed which is entered during the planning of the route is
used.

• Use Manual: The speed to use is entered manually by using the spin buttons in the
field to the left.

Add Wait Times (from Plan): Checked if the wait times which were included in the
planning of the route shall be included (added) in the calculation of ETA.

Obey Max Speed (from Plan): Checked if the ETA shall take into calculations that the
planning may have imposed speed restrictions on some legs.

Text field: Information text field for the dialog.
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20.4.10 Search and Rescue

The aim of a search and rescue operation is to locate a missing object as fast as possible.
This dialog enables you to select the search pattern most suitable for the conditions. For
more information, see Specifying the search pattern on page 354.

The path to the dialog is: Route→Search and Rescue.

The dialog contains the following elements:

Selection Window1: Select pattern type.

Selection Window2: Select pattern for search (Flower-, Square-, Sector-, Parallel Track-,
Creeping Line- Pattern).

The Flower Pattern, Square Pattern and Sector Pattern all cover a circular (or square)
search area whose centre is a specified point. The Parallel Track Pattern and the Creeping
Line Pattern cover a rectangular search area.

Note

The parameter fields displayed in the dialog depend on the search pattern selected.

Display of pattern window: This window displays and visualizes the search and rescue
pattern selected.

Latitude and Longitude: These fields specifies the centre point (also called Point datum)
of the search.

Get Cursor: The button is used to enter the point of search and operation graphically
by means of an EBL/VRM tool.

Radius: For Flower, Sector and Expanding Square search patterns, this field is used
to specify the radius of the search area.
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Length / Width: For Parallel Track and Creeping Line search patterns, these fields define
the size of the rectangular area.

Number of Passes: For Flower search pattern this field is used to specify the number of
“petals” on the pattern.

Track Spacing: For Expanding Square, Parallel Track and Creeping Line search patterns,
the field is used to specify the distance between search lines.

Starting Bearing: The selection field specifies the initial bearing of the circular search
patterns and the major axis of the uniform area search patterns. This is normally set to
the known drift direction.

Apply: By clicking the button a pattern is generated according to the textually changed
parameter fields. Also, when the Apply button is pressed, the EBL/VRM will be
removed from the display.

Go To: Clicking the button will move the chart display to the actual position of the
defined search pattern and will change the screen scale so as to provide a reasonable
display of the pattern. Also, the SAR pattern display will automatically be turned ON.

Display Pattern: The toggle button can be used to explicitly turn on and off the display
of the Search and Rescue pattern. (It will not affect the display of the route which was
generated.)

Turn Radius: The field is by default set to the default turn radius specified in the ship
(route) parameter settings. However, if the pattern is such that this turn radius is too
large, a smaller turn radius is computed. If this is smaller than the minimum turn radius
specified in the ship (route) parameters, the minimum radius will be used.

Planned Speed: The field is by default set to the default speed (Cruise Speed) from the
ship (route) parameters.

Generate Route: By clicking the button, a route plan named “$$SearchRescue” will be
generated and automatically monitored.
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20.5 Options menu

This menu contains buttons for any software option modules that are enabled on your
K-Bridge system.

In Radar, the path to the menu is: Tools→Options.

In ECDIS, the path to it is: Options.

The Options menu contains the following buttons:
• Conning Panes: This button allows you to view individual panes from the Conning

application without switching the screen to the Conning application. For a description
of the individual Conning panes, see Using the Conning application on page 261.

• C-Map Weather: This option allows you to download worldwide meteorological
and ocean data forecasts. It also makes available ice charts and cyclone paths and
predictions. To use this option you must have a subscription for C-Map weather data
but you do not have to use a C-Map chart database. The weather forecast functions
have been integrated with the normal route planning functionality of the K-Bridge
navigation software. Therefore you can use them to access weather data at different
points in space and time along a route that you are planning.

• Survey: This option enables you to create survey lines to cover a sea area and to
monitor survey operations.

• Site Maps: This option allows you to import and overlay your own constructions on
to the chart. Currently, the import mechanism is able to handle common DXF file
formats plus DAF and GeoTIFF formats.

• C-Map Services: Click this button to use the optional route generation, tide prediction,
and piracy avoidance facilities (see Generating routes, predicting tides, avoiding
pirates on page 767).

• WMSClient: TheWebMap Services (WMS) Client is an option module for overlaying
images defined by the WMS protocol on top of nautical charts. The functionality
requires connection to the internet or to a ship network with WMS servers present.
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20.6 Own-Ship menu

The menus and dialogs described in this section enable you to:
• View and select the sensors that the radar uses for its position, heading, speed, and (if

applicable) wind data.
• Set an alarm to notify you if the own-ship drifts more than a specified distance from

its anchor position.
• Set alarms to notify you if targets come within a specified range of the own-ship.
• Select the autopilot mode you require.
• Use the trial manoeuvre facilities to see how close you will come to a collision with a

target if you perform a particular turn.
This is the Own Ship main menu. It gives you access to dialogs concerned with the
vessel's position, heading, speed, general movement and sensors.
To see this menu, click the Own Ship button on the main menu.
The menu contains some or all of the following buttons, depending on the application
you view it from:
• (Own Ship) Data: Click this button to see the own-ship's position, speed over ground

and speed through water (see Own-ship Data on page 442).
• (Own Ship) Ship Parameters: Click this button to view details of the ship's

characteristics (for example, its measurements, its pivot point, minimum and
maximum turn rates, and its off-track alarm limit; see Ship (tab) on page 571).

• (Own Ship) Position Offset: Click this button to view (or specify) any position offset
(see Position Offset on page 443).

• (Own Ship) Ship Ref Points: Click this button to see the list of reference points (for
example, the conning position and the pivot position; see Ship Reference Points on
page 444).

• (Sensors) Position: Click this button to see the available position sensors or (if
required) to specify a new primary sensor (see Position on page 445).
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• (Sensors) Heading: Click this button to view details of the heading source or specify a
new primary heading sensor (see Heading on page 452).

• (Sensors) Spd W: Click this button to see details of the speed-through-water (STW)
sensor or specify a new primary STW sensor (see Water Speed on page 455).

• (Sensors) Spd G: Click this button to see details of the speed-over-ground sensor or
specify a new primary ground speed sensor (see Ground Speed on page 458).

• (Sensors) Wind: Click this button to view details of the wind sensor or specify a new
wind sensor (seeWind on page 460; the wind sensor button will only be present if you
have one or more wind sensors installed and connected to the radar system).

• (Sensors) Depth: Click this button to bring up the menus for working with depth
data (see Depth on page 462).

• (Monitoring) Anti-grounding: Click this button to check the area around the own-ship
for any risk of grounding (see Grounding Alarm Setup on page 470).

• (Monitoring) Anchor Watch: Click this button to configure the anchor watch function
for the own-ship (see Own Ship Anchor Watch on page 471).

• (Manoeuvre) Autopilot: Click this button to select the Autopilot mode you require (see
Autopilot Mode (from Own Ship menu) on page 472).

• (Manoeuvre) Trial: Click this button to bring up the dialog for using the trial
manoeuvre and curved EBL tools. These enable you to see how close you will
come to a collision with another vessel if you perform a particular turn.(see Trial
Manoeuvre and Curved EBL on page 473).

• 12hr Log Control: Click this button to bring up the dialog for controlling the logging
of data (see Position log control on page 573).

• Voyage Recording: Click this button to record the own-ship's track over the course of a
single voyage (see Voyage tab on page 577).

• Recording List: Click this button to view and manage the list of recorded voyages on
the system (see Voyage Recording List and related dialogs on page 578).
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20.6.1 Own-ship Data

This dialog enables you to view data about the own-ship's position, heading, speed,
drift and sensors.
The path to the dialog is: Own Ship→Data.
The buttons, fields and options in the dialog are as follows:
• Save log: Click to copy the contents of the operator station’s logged data buffer (which

includes sensor input for up to the last three days) to the hard disk. The data from this
buffer may be required by a service engineer if there is a system malfunction.

• Master: This box will be present and checked if the console you are using is the
navigation master (in other words, if this console is the one that calculates the
vessel’s position, heading, and speed and distributes these to the other K-Bridge
operator stations). Check the box to make the console the navigation master (see also
Integration Configuration on page 659).

• Source: The console that is currently calculating the own-ship data and distributing it
to the other consoles over the network.

• Quality tag: This tag indicates the accuracy of the position information:
– Red: The position is based on dead reckoning (using gyro and log input).
– Yellow: The position is calculated without differential correction (normally from

GPS or Loran C).
– Green: The position includes differential correction (from dGPS).

• Own-ship's position: The current geographical coordinates of the own-ship's conning
position (or steering position). To locate the conning position on the own-ship, see
Ship Reference Points on page 444.
– HDG: Own-ship's heading.
– Pos.Dev.: Deviation between filtered own-ship's position and sensor reading.
– STW: Speed through water.

* L: Longitudinal speed through water (filtered).
* T: Transverse speed through water (filtered).

• SOG: Speed over ground (filtered).
• COG: Course over ground (filtered).
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• Calculated Drift: Speed and direction of the calculated drift. Drift is only indicated
when sensor information is available and in use.

• Pos: Click to reach the Position Sensor menu.
• Reset: The reset button resets the navigation filter providing the own-ship's data.

Observe that the drift values are set to zero.
• Hdg: Click to bring up the Heading menu (see Heading on page 452).
• Spd: Click to bring up theWater Speed menu (see Water Speed on page 455).
• Position Offset: Click to bring up the Position Offset menu (see Position Offset on

page 443).

20.6.2 Position Offset

This dialog enables you to specify a position offset to compensate for errors from the
positioning system, or errors caused by using a chart with a different datum. You can
specify the position offset either by using co-ordinates for latitude and longitude or
by giving a range and bearing.

There are two paths to this menu:
• Own Ship→Position Offset

• Own Ship→Data →Position Offset

The dialog contains the following elements:
• Position Offset: The offset value entered will be added to the position calculated by

the navigation filter. If the value is different from zero, the OFFSET indication will
appear in the top bar as a filled yellow X to the right of the position fixing system used.

• Offset (N/E): Enter the north and east offset in minutes (for south and west use
negative values).

• Brg/Rng: Enter the offset as bearing and range values.
• –>Brg/Rng: Use this button to toggle between "Brg/Rng" and "Offs N/E".
• Clear: Use this button to clear the position offset.
• Apply: Click to apply the specified offset.
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20.6.3 Ship Reference Points

This dialog lists the ship's reference points and indicates the selected reference point on
a graphical outline of the vessel. The dialog also enables you to add new reference
points to the list and to edit existing entries.

There are two paths to the dialog:
• Own Ship→Ship Ref Points

• System→Parameter Settings→Ship (tab)→Ref Pts

The dialog contains the following buttons:
• New: Click to define a new reference point on the ship. Type a new name for it and

specify position relative to aft and to the ship's center.
• Edit: Click to edit the selected reference point..
• Delete: Click to delete the selected reference point from the list.
• Apply: Click to apply your changes.
• Cancel: Click to cancel your changes.
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20.6.4 Position

This dialog enables you to view and select position sensors.
The path to the dialog is: Own Ship→Position.
The fields and buttons in the dialog are as follows:
• Master/Slave text field: The unlabelled text field at the top of the dialog declares

whether the operator station is the navigation master or a slave of the operator station
that is the master. (If there is no master, the text field is blank.)
It is the navigation master that provides calculations of heading, speed, position and
drift to all the other K-Bridge consoles on the network.
Also, if the currently selected heading, speed, or position source fails, it is the master
that automatically selects an alternative if one is available.
If a navigation master has been appointed, you can only use this dialog to select a
position source manually by going to the master operator station itself.
To make an operator station the master, seeMaking one console the navigation master
on page 130.
For more information, see Integration Configuration on page 659.

• Source: This is a list of radio button and function button pairs.
The selected radio button identifies the position sensor (or type of position input)
currently being used by the operator station.
The corresponding function buttons each bring up a dialog associated with the source
named on the button.
To switch to another positioning source, click the radio button for it. The input from
that source is then used by the master operator station (after being passed through
the operator station's Kalman filters), distributed to all the other operator stations,
and displayed in the top bar of each operator station. (If you are configuring the
master operator station, your selection causes the slave operator stations to select the
same position source.)
The possible sources of position input in a standard configuration are as follows
(although the names of the sources might be different on particular vessels):
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– Gps1/2: Click the function button to bring up the dialog for the sensor named on
the button (see Position Sensor on page 448).

– GpsB: If you click the radio button to select this position source, the operator
station uses the backup NMEA position input that it receives on its serial port
instead of the position input that it receives over the LAN from the SINT.
B stands for “backup”. This option is for use in the event of a LAN failure that
prevents the operator station from receiving position input from the selected
position reference system.
Click GpsB to bring up the dialog for the sensor providing the backup NMEA
positioning input (see Position Sensor on page 448).

– RadPos: This radio button is greyed out when there are no fixed targets selected for
it to use as references in its calculations (see Calculating the own-ship's position
on page 148). If you select one or more reference targets, the radio button becomes
selectable: check it when you intend to use radar positioning as the radar's system
for calculating the own-ship’s position.
The RadPos function button brings up the Radar Positioning dialog, which allows
you to perform an own-ship positioning calculation based on the co-ordinates of
one or more fixed reference targets (see Radar Positioning dialog on page 450).

– Manual: Select this radio button to enter position input manually. Manual input is
only accepted when the current own-ship position is based on a dead reckoning.

• R: The R in this button is an abbreviation for "Reset". Click it to reset the position
filter for the corresponding sensor: the position is set immediately to the next position
received from the position sensor; the drift is set to zero; and the speed is set to the
newest value from the speed log.

• Deviation: The difference between the raw position input from the corresponding
position sensor and the filtered position data that is currently displayed on the top bar
and is based on input from the currently selected position sensor.
The difference is presented as metres in a given direction. If the numbers were
“1/234”, the deviation would be 1 meter and the angle of direction would be 234°.
(The deviation referred to here is not between the corresponding position sensor and
the currently selected position sensor. For information about that deviation – which
must remain within a specified limit for an automatic failover from one position
sensor to another to take place – see Position sensor details on page 623.)

• State: The operational state of the corresponding position sensor. The following
states are possible:
– Diff: Sensor operating in differential mode. The position source is dGPS.
– Abs: Sensor operating without differential correction. The position source is

GPS or Loran C.
– D/R: Dead reckoning. There have not been any recent position messages. The

position is updated by dead-reckoning.
– N/A: The sensor is not available.

• Vis: If you check this box for one of the sensors in the dialog, the location according to
the corresponding position sensor is presented graphically on the screen. Specifically
it is the vessel’s conning position (according to the corresponding sensor) that is

446 381287/A



Reference Guide

shown. It appears as a small cross. To use this feature, you need to zoom in until the
own-ship symbol appears as a scaled outline of the vessel. The small cross enables
you to see how far the Conning position would shift if you switched position sensors.

• Get OS Position: Click to enter the current own-ship's position into the manual
position fields.

• Apply: Click to input the manually entered own-ship position to the dead reckoning
calculation.

• Show Filtered: Check this option to present the filtered position data on the display.
• Show Accuracy: Check this option to present an accuracy ellipse on the display: the

current best estimate for the own-ship's position is the centre of the ellipse.
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20.6.4.1 Position Sensor

This dialog shows the information received from the selected position sensor before
any navigation filters have been applied.

The path to the dialog is: Own Ship→Position→GPS1/2.

The dialog contains the following elements:
• Type: The name of the position sensor, as entered when the system was configured.
• Latest Update: Time since the last message was received from the position sensor.
• Readings: The contents of the last message from the position sensor:

– Position
– SOG: Speed over ground
– Differential

• Mode: As received from the position sensor:
• HDOP: Horizontal Dilution Of Precision. Refer to the GPS manual for more

information on this parameter.
• Satellites: The number of satellites used to calculate the position.
• Diff.Age: Time since the latest differential correction was received. Applies only

to dGPS receivers in differential mode.
• UTC: Coordinated Universal Time, formerly known as GMT (Greenwich Mean Time).
• More: Click to view the Satellite display dialog (see Satellite display dialog on

page 449).
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20.6.4.1.1 Satellite display dialog

This dialog displays the current satellite configuration. A diagram in the middle of it
illustrates the position of the satellites in the sky. All satellites expected to be seen over
the horizon are shown in the diagram with the satellites used shown in black.

The text box at the top tells you how many satellites are being used for position fixing.

The path to the dialog is: Own Ship→Position→GPS1/2 →More.

The dialog contains the following information fields:
• HDOP: Horizontal Dilution of Precision.
• VDOP: Vertical Dilution of Precision.
• PDOP: Position Dilution of Precision.
• PRN: Satellite designated number.
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20.6.4.2 Radar Positioning dialog

This dialog enables you to use the radar positioning tool to calculate the position of
the own-ship.

The path to the menu is: Own Ship→Position→RadPos.

For more information, see Using the radar positioning system on page 148.

Caution

This tool performs rough calculations only. It is to be used as a back-up
system only and must never be used as a substitute for an accurate
electronic positioning system.

The dialog contains the following elements:
• Co-ordinate fields: The position (latitude and longitude) of the own-ship according

the tool's calculations.
• Accuracy: The tool's estimate (in metres) of the accuracy of its positioning calculation.

The remainder of this window contains details (including latitude, longitude, range
and bearing) of up to four fixed reference targets. Each target described is identified
by a select-able button numbered from 1 to 4. Details only appear for the fixed
reference targets you have created. For information about creating fixed reference
targets, see Calculating the own-ship's position on page 148.

• Include: Check this box to include the associated fixed reference target in the position
calculation.

• Button (numbered 1–4): Click this button to activate the Target Data dialog for the
target. If you want to include the target in the position calculation, you must check
the Fixed Reference Target option. (Unless a target is marked as a fixed reference
it cannot be included.)
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• Unfix: Click this button to remove the associated target from the list of targets that are
available to be used as fixed references in the positioning calculations. (When you
click this button, the target's position on the chart is no longer marked with an 'R' and
its details are removed from this menu.)

• Position data: These fields show the latitude and longitude of the associated target.
If you have more precise data than is shown, you can edit these fields manually by
using the keyboard. If you do this, then an Apply button appears; click this to apply
the newly entered position.

• RNG, BRG, DEV: These un-editable fields display the:
– Range (distance in nautical miles) of the target from the own-ship.
– True bearing of the target from the own-ship.
– Deviation between the position of the target as measured by the own-ship's main

positioning system and the nominal fixed position of the target (as currently given
in the latitude and longitude fields above the RNG, BRG, and DEV text).
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20.6.5 Heading

This dialog is for selecting the heading source and comparing input from the available
sources. When a gyro-compass is available, that is the recommended heading source.

The path to the dialog is: Own Ship→Heading.

The dialog contains the following elements:
• Master/Slave text field: The unlabelled text field at the top of the dialog declares

whether the operator station is the navigation master or a slave of the operator station
that is the master. (If there is no master, the text field is blank.)
It is the navigation master that provides calculations of heading, speed, position and
drift to all the other K-Bridge consoles on the network.
Also, if the currently selected heading, speed, or position source fails, it is the master
that automatically selects an alternative if one is available.
If a navigation master has been appointed, you can only use this dialog to select a
heading source manually by going to the master operator station itself.
To make an operator station the master, seeMaking one console the navigation master
on page 130.
For more information, see Integration Configuration on page 659.

• Source: This is a list of radio button and function button pairs.
The selected radio button identifies the heading sensor (or type of heading input)
currently being used by the operator station.
The corresponding function buttons each bring up a dialog associated with the source
named on the button.
To switch to another heading source, click the radio button for it. The input from
that source is then used by the master operator station (after being passed through
the operator station's Kalman filters), distributed to all the other operator stations,
and displayed in the top bar of each operator station. (If you are configuring the
master operator station, your selection causes the slave operator stations to select the
same heading source.)
The names of the available gyro-compasses will depend on the vessel. They will
typically be, for example, Gyr1, Gyr2 etc.
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The gyro that is used by the navigation operator stations is determined by your
selection in this dialog (for the master operator station). Therefore it is not necessarily
the same as the gyro that is currently selected by the Navitwin panel. To make sure
the heading repeaters display information that is consistent with the heading data
displayed on the operator station top bars, make sure you select the same gyro in the
Navitwin panel as is currently being used by the K-Bridge operator stations.
The possible sources of heading input are:
– Gyr1/2 : This button brings up a dialog containing (raw and filtered) heading

and rate of turn readings from the selected heading source (see Heading Sensor
on page 454).

– GyrB: If you click the radio button to select this heading source, the operator
station uses the backup NMEA heading input that it receives on its serial port
instead of the heading input that it receives over the LAN from the SINT.
B stands for “backup”. This option is for use in the event of a LAN failure that
prevents the operator station from receiving heading input from the selected gyro.
Click the GyrB button to bring up a dialog containing (raw and filtered) heading
data from the gyro providing the backup NMEA data (see Heading Sensor on
page 454).

– Manual: If no heading input is available either over the LAN or from the backup
NMEA source, you can select this option and enter a heading value manually.

• Deviation: The difference – presented as metres in a given direction – between the
position according to the corresponding position sensor and the currently selected
position sensor. If the numbers were “1/234”, the deviation would be 1 meter and the
angle of direction would be 234°.

• Dev: The difference in degrees between the heading according to the corresponding
heading sensor and the currently selected heading source.

• Meas: The current measurement from the heading source.
• Manual Heading: Allows you to enter manual heading data when manual heading is

selected. Use the spin buttons to increase/decrease the heading value. Click Apply to
make the new value take effect.

• Apply: Click the button to apply a manual heading entry.
• Deviation Limit: If the difference between a heading sensor and the currently selected

heading source exceeds the deviation limit (default 5°), the operator station will issue
an alert. If the currently selected heading source fails and the deviation limit between
it and the alternative heading sensor has been exceeded, the operator station will not
automatically switch to the alternative heading sensor.
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20.6.5.1 Heading Sensor

This dialog enables you to view heading sensor data.

The path to the dialog is: Own Ship→Heading→Gyro1/2.

The dialog contains the following elements:
• Type: Sensor type, as entered at system configuration.
• Latest Update: Time since the last sensor message was received.
• Readings: Shows actual heading read from the sensor and the filtered heading. If the

sensor provides a rate of turn (ROT) measurement, this will be displayed. Otherwise,
a calculated ROT will be displayed.

454 381287/A



Reference Guide

20.6.6 Water Speed

This dialog enables you to select the source of the speed through water (STW) value
that is displayed on the operator station top bar. When the speed log is available, we
recommend you select that.
The path to the dialog is: Own Ship→Spd W.
The dialog contains the following elements:
• Master/Slave text field: The unlabelled text field at the top of the dialog declares

whether the operator station is the navigation master or a slave of the operator station
that is the master. (If there is no master, the text field is blank.)
It is the navigation master that provides calculations of heading, speed, position and
drift to all the other K-Bridge consoles on the network.
Also, if the currently selected heading, speed, or position source fails, it is the master
that automatically selects an alternative if one is available.
If a navigation master has been appointed, you can only use this dialog to select a
speed source manually by going to the master operator station itself.
To make an operator station the master, seeMaking one console the navigation master
on page 130.
For more information, see Integration Configuration on page 659.

• Source: This is a list of radio button and function button pairs.
The selected radio button identifies the speed sensor (or type of speed input) currently
being used by the operator station.
The corresponding function buttons each bring up a dialog associated with the source
named on the button.
To switch to another water speed source, click the radio button for it. The input from
that source is then used by the master operator station (after being passed through the
operator station's Kalman filters), distributed to all the other operator stations, and
displayed in the top bar of each operator station. (If you are configuring the master
operator station, your selection causes the slave operator stations to select the same
water speed source.)
The possible sources of water speed input are:
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– Log1: Click this button to bring up the Speed Sensor dialog for the own-ship’s
speed log (see Speed Sensor on page 457).

– LogB Click this button to bring up the Speed Sensor dialog for the NMEA backup
data (see Speed Sensor on page 457).
If you select this speed source (by clicking the radio button to the left of the LogB
button), the operator station uses the backup NMEA speed input that it receives
on its serial port instead of the speed input that it receives over the LAN from
the SINT.
B stands for “backup”. This option is for use in the event of a LAN failure that
prevents the operator station from receiving speed input from the vessel’s speed log.
Click the LogB button to bring up a dialog containing (raw and filtered) speed data
from the vessel’s speed log provided by the backup NMEA connection from the
SINT (see Speed Sensor on page 457).

– Manual: Select this source if you need to enter speed input manually.
• Measured L/T: The current raw speed measurements (from the corresponding source)

for longitudinal (L)/transverse (T) movement.
• Abs.: The vessel’s actual speed through water, calculated according to the measured

longitudinal/transverse values.
• Manual Speed: Allows you to provide speed input manually (when Manual is

selected). Use the spin buttons to increase/decrease the value. To enter the value,
click Apply.

• Apply: Apply your manually entered speed input.
• Manual Set & Drift: Enter manual set and drift values. Note that the values will only

be used by the operator station’s position filters when dead reckoning is in use. You
can type in a value or use the spin buttons.

• Apply: Apply your manually entered set and drift input.
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20.6.6.1 Speed Sensor

This dialog enables you to view speed measurements from a particular source of speed
input.

The path to the dialog is: Own Ship→Spd W/Spd G→<Speed source>.

The dialog contains the following elements:
• Type: The type of sensor providing the speed input.
• Latest Update: Time since the last sensor input was received.
• Mode: The operating mode of the speed sensor, for example, Water Track or Bottom

Track. The modes will vary for the different types of sensor.
• Readings:

– Speed Over Ground: Displayed if available from sensor. Shows Longitudinal
(L) and Transverse (T) speed.

– Speed Through Water: Displayed if available from sensor. Shows Longitudinal
(L) and Transverse (T) speed.
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20.6.7 Ground Speed

This dialog enables you to view details of the ground speed sensor.
The path to the dialog is: Own Ship→Spd G.
The dialog contains the following options, buttons and data:
• Master/Slave text field: The unlabelled text field at the top of the dialog declares

whether the operator station is the navigation master or a slave of the operator station
that is the master. (If there is no master, the text field is blank.)
It is the navigation master that provides calculations of heading, speed, position and
drift to all the other K-Bridge consoles on the network.
Also, if the currently selected heading, speed, or position source fails, it is the master
that automatically selects an alternative if one is available.
If a navigation master has been appointed, you can only use this dialog to select a
speed source manually by going to the master operator station itself.
To make an operator station the master, seeMaking one console the navigation master
on page 130.
For more information, see Integration Configuration on page 659.

• Source: This is a list of radio button and function button pairs.
The selected radio button identifies the ground speed sensor (or type of ground speed
input) currently being used by the operator station.
The corresponding function buttons each bring up a dialog associated with the source
named on the button.
To switch to another ground speed source, click the radio button for it. The input from
that source is then used by the master operator station (after being passed through the
operator station's Kalman filters), distributed to all the other operator stations, and
displayed in the top bar of each operator station. (If you are configuring the master
operator station, your selection causes the slave operator stations to select the same
ground speed source.)
The possible sources of ground speed input are:
– Log1: Click this button to view ground speed data based on the own-ship’s speed

log (see Speed Sensor on page 457).
– Gps1: Click this button to view ground speed data based on the own-ship’s position

sensor (see Speed Sensor on page 457).
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– LogB Click this button to view ground speed data based on the NMEA backup
data (see Speed Sensor on page 457).
If you select this ground speed source (by clicking the radio button to the left of
the LogB button), the operator station uses the backup NMEA speed input that it
receives on its serial port instead of the speed input that it receives over the LAN
from the SINT.
B stands for “backup”. This option is for use in the event of a LAN failure that
prevents the operator station from receiving ground speed input from either the
vessel’s speed log or position reference system.

– Pos Filter: The operator station’s internal kalman filter is the default source of
ground speed input. The position filter uses data from the selected GPS, speed
log, and gyro (as well as other data) to produce an authoritative estimate of the
vessel’s ground speed.

• Measured L/T: The current ground speed measurements (from the corresponding
source) for longitudinal (L)/transverse (T) movement.

• Abs.: The vessel’s actual speed over ground (from the corresponding source),
calculated according to the measured longitudinal/transverse values.
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20.6.8 Wind

This dialog enables you to work with wind data. Anemometer (wind sensor) input can be
displayed as a wind arrow on the radar/chart display. (Wind sensors need to be present
and configured for this to work; see Wind sensor interface on page 626. The wind data
can be received by the console on a serial line or over the local area network.)

The path to the Wind Sensor dialog is: Own Ship→Wind.

The dialog contains the following elements:
• Wind No: Wind sensor number. If there are multiple wind sensors select one. (The

text of these buttons depends on the name of the wind sensor; see Wind sensor
interface on page 626.)

• Global selection: Select (if the option is present and applicable) to make all other
consoles on the network use the currently selected wind sensor.

• Display Arrow: Check to display an arrow on the ECDIS screen indicating wind
direction. The arrow indicates the true wind direction. (This option is only available
in ECDIS.)

• Relative: Wind direction and speed relative to the ship's heading and speed.
• True: Wind direction and speed relative to north and ground.
• m/s or Knots: Select the unit of measurement for the presentation of the wind sensor

data.

Figure 108 Wind arrow display
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20.6.8.1 Wind Sensor Configuration

This dialog

The path to the dialog is: Own Ship→Wind→Wind No..

The dialog contains the following elements:
• No: Wind sensor number. If there are multiple wind sensors select one.
• Type: Wind sensor name.
• Latest Update: Time since the last wind data was received.
• Sensor Readings:

– Wind Speed: Raw wind speed received from the sensor.
– Wind Direction: Raw wind direction received from the sensor.
– Mode: The data as received from the wind sensor is relative to:

* Ship heading and speed.
* Ship heading and water speed.
* Ground and north.

• Wind Arrow Symbol Offset (mm): Use the spin buttons to apply an offset to the wind
arrow from the own-ship symbol in the display.
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20.6.9 Depth

This is the sub-menu for working with depth data. Depth data input is an option and
requires depth input to be received on a serial line or across the LAN.

The path to the depth sub-menu is: Own Ship→Depth

The menu contains the following buttons:
• Depth Sensor Data: Click to view raw depth sensor data (see Depth Sensor data on

page 463).
• Depth History: Click to display depth history data for the past 50 minutes (see Depth
History on page 464).

• Depth Recording List: Menu to display depth files (see Depth Recording List on
page 466).

• Depth Recording Control: Menu to start and stop depth recording (see Depth
Recording Control on page 465).

• Depth Sensor Setup: Menu to set up depth sensors (see Depth Sensor details on
page 469).
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20.6.9.1 Depth Sensor data

This dialog provides raw depth sensor data.

The path to the dialog is: Own Ship→Depth →Depth Sensor Data.

The dialog contains the following elements:
• No: Depth sensor number.
• Global: Select to make all other consoles on the network use the selected depth sensor.
• Type: Depth sensor name or type.
• Latest Update: Time since the last depth data was received.
• Below Transducer: Depth reading from the sensor. Dependent on the sensor, additional

data can be displayed.
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20.6.9.2 Depth History

This dialog displays depth history data for the past 50 minutes.

The path to the dialog is: Own Ship→Depth →Depth History.

The dialog contains the following elements:
• Depth Range: Select the depth range in diagram: 10m, 20m, 50m, 100m, or 300m.
• Diagram: Colour explanation:

– Light grey: No data.
– Dark grey: Depth of ship's hull.
– Brown: Sea bottom as read from sensor1.
– Blue: Sea bottom as read from sensor2.

• Interval: Click to select time scale axis: 5min, 15min or 50min.
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20.6.9.3 Depth Recording Control

This dialog enables you to start and stop depth recording.

The path to the dialog is: Own Ship→Depth →Depth Recording Control.

The dialog contains the following elements:
• State: Indicates if the system is recording or not.
• Lamp: Flashes green when the depth is recorded. A yellow light indicates NO DATA.
• Record Now!: Click the button to add a depth recording now.
• Name: The depth file name is constructed as follows:

For example E020309F was created 09th March 2002. The default file name can
be modified.

• Started: The time for the first recording.
• Ended: The time for the last recording, when the recording was stopped.
• Start Recordings: Click the button to start recording a new depth file. Automatic or

manual recording depends on the settings in the Depth Recording Setup menu.
• Resume Recordings: Click the button to continue recordings in the last depth file.
• End Recordings: Click the button to stop recording of depth data.
• Settings: Click the button to go to the Depth Recording Setup menu.
• List: Click the button to go to the Depth Recording List menu.
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20.6.9.4 Depth Recording List

This dialog list the files of depth data on the system.

The path to the dialog is: Own Ship→Depth →Depth Recording List.

The dialog contains the following buttons:
• Sort On: Select to sort the list by name, type or time.
• Name/Type/State/Date: Each file is described by name, state, date and file size.
• Display: Click the button to display the selected depth file.
• Undisplay: Turns off display of the selected depth file.
• Delete: Click the button to delete the selected file.
• Go To: Click the button to display the chart covering the starting point of the displayed

depth file.
• Backup: Click the button to save the selected file on a selected device (see Backup
Depth Recording on page 467).

• Rename: Click the button to give the selected file a new name.
• Reload: Click the button to load a depth file from the selected device (see Restore
Depth Recording on page 467).

• Control: Click the button to go to the Depth Recording Control dialog (see Depth
Recording Control on page 465).
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20.6.9.4.1 Backup Depth Recording

The dialog enables you to save depth data to a selected device.

The path to the dialog is: Own Ship→Depth→Depth Recording List→Backup.

The dialog contains the following elements:
• File Name: File name used on selected device. Can be modified.
• Start time: Use the spin buttons to specify the start time for the depth file.
• End time: Use the spin buttons to specify the end time for the depth file.
• Save to Medium: Click the button to save the depth file to a device.
• Cancel: Click the button to cancel the save operation.
• Estimated file size: Specifies the estimated file size and how much free space is

available on the selected disk. If the file is too large, it will be split over several disks.

20.6.9.4.2 Restore Depth Recording

This dialog enables you to load depth data from the selected device.

The path to the dialog is: Own Ship→Depth→Depth Recording List→Reload.

Select the depth data you require from the device and click OK.
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20.6.9.5 Depth Sensor setup

This dialog is for setting up the depth sensor. All measurements are in meters.
WARNING

Before you start using the depth data enter the current draught, the
distance from the depth sensor to the keel, and the current tide. This
enables the system to produce a "normalized" sounding value that is
suitable for recording and for comparison with chart soundings.

The path to the dialog is: Own Ship→Depth→Depth Sensor Setup.
The dialog contains the following elements:
• Record Sensor No: The depth sensor number.
• Depth Readings (meter):

– Measured Depth: Depth measured by the sensor.
– Current Tide: Current tide value.
– Current Draught: The ship's current draught. The value is added to the measured

depth to find water line.
– Over Keel: Sensor placement above the keel. The value is subtracted to give under

keel clearance.
– Chg: Click to go to the Depth sensor details dialog (see Depth Sensor details on

page 469).
– Rec. Sounding: The calculated sounding value used for history diagram and depth

recording.
• Auto Recording Interval:

– - Manual Only: Select to record the depth only when clicking the "Record Now"
button.

– - Distance (NM): Select to record the depth when the ship has moved the specified
distance. Use the spin buttons to set the distance.
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– - Time interval: Select to record the depth at the set time interval. Use the spin
buttons to set the interval.

• Record Minimum Depth: Select to record the minimum value in each interval. When
not selected the last depth value is recorded.

• Recording Ctrl: Click the button to go to the Depth Recording Control dialog (see
Depth Recording Control on page 465).

• Recording List: Click the button to go to the Depth Recording List dialog (see Depth
Recording List on page 466).

20.6.9.5.1 Depth Sensor details

This dialog is for setting up communication with the depth sensor.

The path to the dialog is: Own Ship→Depth→Depth Sensor Setup→Chg.

The dialog contains the following elements:
• Type: Select echo sounder type from the menu.
• Protocol: Select communication protocol from the menu.
• Messages: Select message format from the menu.
• Transducer Location ref. Aft Peak: Specify position of the sensor over keel (necessary

for computation of soundings) and along/across (necessary for exact positioning of
sensor readings). Starboard is positive, port is negative.
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20.6.10 Grounding Alarm Setup

This dialog enables you to set up grounding checks for the own-ship. Whenever a risk is
detected, a grounding alarm will be issued. The system performs the grounding check
against the current chart data.

The path to the dialog is: Own Ship→Anti-grounding.

The dialog contains the following elements:
• Vector length: Use the spin buttons to specify how far ahead (in seconds) grounding

checking is to be performed. When you specify 0, grounding checking is disabled.
• Width: Use the spin buttons to specify the width (in degrees) of the widest part of

the grounding check area. The range is 0 - 30 degrees.
• Warnings: Lists of warning messages. Select one to see its details displayed in the

text area.
• Groundings: Lists of grounding messages. Select one to see its details displayed in

the text area.
• Display: Select to display the grounding check vector in the chart.

Figure 109 The grounding check vector as displayed on the chart

Note

To perform the grounding checks, the system will use the largest-scale chart available
from the selected chart databases (see Chart Types on page 477).
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Note

In the Radar application, the grounding checks are only available when charts are being
displayed (see Displaying charts on the radar display on page 208).

Note

Grounding checks are only enabled when the own-ship's speed (SOG) is above 1 knot.

20.6.11 Own Ship Anchor Watch

This dialog enables you to configure the anchor watch function for the own-ship.

The path to the dialog is: Own Ship→Anchor Watch.

For more information about how to use this dialog, see Using the anchor watch function
on page 324.

The dialog contains the following elements:
• Active: Select to activate the anchor watch. A warning limit circle will be displayed

in the radar area as long as the anchor watch is active.
• Anchor Position: Enter the anchor watch position (the centre of the warning circle)

here.
• Bow To Apos: Click to enter the own-ship's current bow position as the anchor watch

position.
• Deviation Range: Presents the distance between the current bow position and the

anchor watch position.
• Deviation Limit: Enter the radius for the warning circle.
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20.6.12 Autopilot Mode (from Own Ship menu)

This dialog enables you to select the autopilot mode you require.

The path to it is: Own Ship→Autopilot.

This dialog is also available from the Route menu. For a description of it, see Autopilot
Mode on page 427.
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20.6.13 Trial Manoeuvre and Curved EBL

In the Radar application, the Curved EBL and Trial Manoeuvre options are combined
in a single dialog called Curved EBL. The Curved EBL part of the dialog is only the
top half. It specifes the course after the turn (New Course) and the radius of the turn
(Turn Radius). The Trial Manoeuvre part of the dialog is the bottom half and is only
available in the Radar application.

In the ECDIS application, the Curved EBL dialog contains only the curved EBL facilities.

The are two paths to the Curved EBL dialog:
• Own Ship→Trial

• Tools→Curved EBL

The Trial Manoeuvre facility – which is available only in radar – enables you to specify
a point on the curved EBL at which to view the future position of the own-ship in
relation to its tracked targets if the manoeuvre represented by the curved EBL is actually
executed. In other words, this facility enables you to see how close you will come to a
collision with another vessel if you perform a turn.

As well as the Trial Distance (which represents a future position of the own-ship on the
curved EBL), you can specify both the:

• speed (New Speed) at which the own-ship is assumed to be travelling to the Trial
Distance point

• and the rate of acceleration or deceleration (Speed Rate) by which the own-ship is
assumed to reach the New Speed.
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Caution

The Trial Manoeuvre facility calculates the future positions of other vessels
(when the own-ship is at a given point on the curved EBL) by using their
current bearing and speed. Of course in reality the target vessels might
have changed their bearing and speed by the time the own-ship arrives
at a given point.

For this reason, you must use this facility with caution.

For more information, see Using the trial manoeuvre facility on page 313.

Curved EBL

The elements in this dialog that concern the curved EBL tool are as follows:
• Autopilot mode: When this radio button is selected (and the dialog's Enable box is

checked), the curved EBL is used as input to the Autopilot. In other words, the New
Course and Turn radius you specify immediately determine the Autopilot's heading
set-point.
However, you can check the Preset Turn box. When you do this, the New Course and
Turn Radius that you specify will not be activated until you click the Activate button.

• Preset Turn: Checking this box (when the operator station is in heading or course
mode) enables you to specify (for example, using the heading wheel) a turn that you
will not activate immediately. When you check this box, a 'PT' symbol appears near
the own-ship symbol on the main radar display. You can then specify the New Course
and Turn Radius. You can use the heading wheel to do this, or you can move the
handles of the curved EBL on the main display. Neither of these actions will affect
the heading set-point until you click the Activate button in the Curved EBL dialog or
press the Act Turn button on the console.

• Plan Mode: When you select this radio button, the data you enter into the curved
EBL dialog is used to create a route plan (but only if you activate it by pressing
the Activate button).
When you select Plan Mode, a 'P' symbol appears near the own-ship symbol in the
main radar display. Also the heading wheel ceases to affect the vessel's heading;
therefore you can use it to specify the planned turn. When (or if) you want to activate
the turn, click the Activate button in this dialog. To exit Plan Mode without activating
the turn, either press the Auto/Plan button on the console or select Autopilot Mode
in this dialog.

• New Course: Course after the turn. Adjust using the up-down controls.
• Time to Turn: For a planned turn, this value is calculated on the basis of the vessel's

current speed and the value you specify for the distance to the turn. (For a preset
turn, the field is disabled.)

• Dist. to Turn: The distance from the vessel's current position to the start of the turn.
For a planned turn, you can adjust this value by using the up-down controls.

• Turn Radius: The turn radius for the manoeuvre. Adjust this using the up-down
controls.
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• Enable: Check this box to display the curved EBL in the radar area. When you click
this button with the Autopilot Mode radio button selected and the Preset Turn box
un-checked, you are controlling the autopilot directly from the Curved EBL dialog.

• Reset: Reset the curved EBL to its default values. These are:
– New course: the vessel's current heading
– Distance to turn: 1NM
– Turn radius: This default value is determined by the current setting for Default

Radius in the Route tab for the Ship and Route Parameters (see Route (tab) on
page 570). The factory default setting for Default Radius is 1NM.

• Activate: This button does one of two things:
– It uses the curved EBL as direct input to the Autopilot to perform a Preset Turn.

To activate a preset turn, the radar operator station must be in command of the
Autopilot and operating in heading or course mode. It cannot be in track or
waypoint mode.

– It uses the curved EBL to create a route for a planned turn and then uses that route
to perform (and monitor) the turn. If available, automated track steering will be
activated.
The radar operator station can only activate a planned turn if it is not monitoring
a route.

For more information, see Using the curved EBL facility on page 308.

Trial Manoeuvre (available in Radar only)

In the Radar application, you can use a curved EBL as the basis of one or more trial
manoeuvres. These enable you to see how close the own-ship will come to a collision
with the radar and AIS targets it is tracking. The elements in the dialog that concern
the trial manoeuvre tool are as follows:
• Trial distance: Trial distance is a point on the manoeuvre's time/distance line. It is

marked by a 'T' and a cross line. To see the predicted position of tracked targets in
relation to the own-ship during and after the manoeuvre, change the trial distance.
(To change the trial distance, click the spin buttons.)

• New Speed: Sets the speed at which the own-ship is assumed to be travelling to the
Trial Distance point. Adjust using the up-down controls. The default value is the
vessel's current speed.

• Speed Rate: Sets the rate of acceleration or deceleration (Speed Rate) by which the
own-ship is assumed to reach the New Speed. Adjust using the up-down controls.
The default value is 2 knots/minute.

• Trial Manoeuvre: Check this box to use the trial manoeuvre facility (see Using the
trial manoeuvre facility on page 313).

• CPA Circle: Check this box to display a CPA (Closest Point of Approach) circle
around the own-ship symbol in the radar display area while you perform the Trial
Manoeuvre. The radius is the selected CPA limit.
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20.7 Chart menu

The menus described in this section are for setting up and working with charts. The chart
facilities are provided as an option and are therefore not available on all systems.

To see this menu, click the Chart button on the main menu.

This menu contains the following buttons:
• Chart Types: Click this button to select and manage the chart type to be used (see
Chart Types on page 477).

• Legend: Click to inspect the chart's meta-data (see Chart Legend on page 478).
• Safety Depth Setting: Click this button to set the safety depth for the own-ship (see
Safety Depth on page 479).

• Manage Charts: Click this button to manage the charts installed on your system (see
Manage Charts on page 481).

• Manage Notes: Click this button create new mariners' notes and to view and manage
currently stored notes (see Manage Notes on page 507).

• Navtex Messages: Click to view or send Navtex messages (see Navtex Message List
on page 524).

• Colour Differentiation and Calibration: Click the button to check the colour
reproduction quality of your charts (see Colour Differentiation and Calibration on
page 531).

• Reconfigure Chart Databases: Click this button to reconfigure the chart databases (see
Chart Type Setup on page 532).

• Install C-Map SDK: Click this button to install a C-Map Software Development Kit
for managing the chart type in use (see Install C-Map SDK on page 536).

For information about specifying the types of chart information to be displayed in the
radar area, see Chart Themes on page 373.
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20.7.1 Chart Types

Use the Chart Types dialog to specify the type of chart to display and to manage your
charts.

The path to the dialog is: Chart→Chart Types.

The dialog contains the following elements:
• Databases: This list shows which databases (chart types) are available. Individual

databases must be selected to be displayed.
• Mng...: Click this button to manage the specified chart database. For information

about chart management for:
– PR Primar charts, see S-57 and S-63 chart management dialogs on page 481
– C-Map 93 Edition 3 charts, see CM93 Ed.3 chart management dialogs on page 496
– C-Map 93 Edition 2 chartsee C-Map CM-93 edition 2 charts on page 185
– ARCS charts, see HCRF charts on page 203 (these charts are only available on

ECDIS)
• Overscale: By default the overscale value is 100%, which means that a chart is

displayed at its nominal scale. If you select 200%, charts will be displayed at twice
their nominal scale.

• Fill In: This option is for use when a chart does not fill the display area. Check the
box if you want the system to attempt to fill the area surrounding the chart with
lower scale chart data.
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20.7.2 Chart Legend

This dialog lists the chart's meta-data.

The path to the dialog is: Chart→ Legend.

Chart: Information identifying the chart. In the example on the left, the chart number
is 04420031.e; the chart is a Vector Chart; and some source information is given: DK,
KMS, graph, 101B.
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20.7.3 Safety Depth

Use this dialog to specify the own-ship's safety depth setting and to select a safety
contour line.

The path to the dialog is: Chart→Safety Depth Setting.

The elements contained in the dialog are as follows:
• Safety Depth: The safety depth is used to check the planned route to verify that it has

sufficient depth. Enter a depth here that is slightly more than the draught of the ship.
The default value is 30 meters. The safety depth will highlight spot soundings for
depths that are less than the safety depth.

• Safety Contour: The safety contour is used to display the depth contour line for the set
depth. The system will choose a contour from the chart that is equal to or greater than
the value you specify. The safety contour is displayed in the radar area.

• Chart Contours: Lists the contour lines available in the currently displayed chart.

Contours designated as AC are area contours; those designated as C are simple contour
lines.

Making a choice in this list will set the safety contour to the specified value and the
safety depth to the next available setting that is deeper than the specified safety contour.
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20.7.4 Manage Charts
The dialog you see when you select Chart→Manage Charts depends on the chart
database selected.

You can select a different database from the drop-down list at the top of the dialog. (This
is the equivalent of selecting a database and clicking Mng in the Chart Type dialog
(see Chart Types on page 477).

This section describes the dialogs for managing S-57 and S-63 charts, and the dialogs
for managing C-Map 93 Edition 3 charts:
• S-57 and S-63 chart management dialogs on page 481
• CM93 Ed.3 chart management dialogs on page 496

20.7.4.1 S-57 and S-63 chart management dialogs

The path to the menus and dialogs for managing S-57 and S-63 charts is: Chart→Chart
Types→ (PR: Primar) Mng.

The way you handle un-encrypted S-57 charts on the K-Bridge system is similar to the
way you handle encrypted S-63 charts. The only exception is with respect to permits
and licences. This section describes the chart management tabs and dialogs in the order
in which you will encounter them when you are using the charts. However, a note is
provided whenever this order is different from what it would be if you were using S-57
charts.

Note

If you receive charts from the Admirality ENC service or IC-ENC, they are likely to be in
encrypted S-63 format.

For information about:
• The chart database provider and the status of the database, see General tab on

page 482.
• Installing a chart database, see Install tab on page 489.
• Updating a chart database, see Updates tab on page 493.
• Listing the chart databases you have available, see List tab on page 494.
• Displaying chart database version numbers and configuring the display of symbols in

the charts, see Settings tab on page 495.
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20.7.4.1.1 General tab

This dialog contains information about the database provider and the status of the
database.

To see it you must enter a user level password (see Password on page 593).

The path to the dialog is: Chart→Chart Types→ (PR Primar) Mng→General (tab).

The dialog contains the following elements:
• Data Base Status: Displays the name and status of the chart database.
• Provider: Chart database provider (PRIMAR™ or Hydrographic Office).
• License: For encrypted databases. Click this button to insert your license code and

manage your chart permits.
• Certificate: Click the button to display the current certificate for the S-63 database or

to install a new certificate.(This button is not available if you are using S-57 charts.)
• Log: Click the button to display the Database Log dialog.
• Coverage: Click the button to display the Chart Coverage dialog.
• Repair DataBase: Click the button to run an automatic database maintenance process.
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General (tab) —> License

Use this dialog to manage your chart permits.

For unencrypted S-57 chart databases licenses are not necessary.

The description below is valid for PRIMAR™ charts.

The path to this dialog is: Chart→Chart Types→ (PR Primar) Mng→General
(tab)→License.

The dialog contains the following elements:
• User Permit: This 28 character code identifies your system. Provide it to PRIMAR™

to obtain your chart permits.
• Registered Chart Permits: A list of all chart permits entered for this database. The list

contains information about the licensed charts, their edition and the expiry date.
• Remove Permits: Click this button to remove the selected chart permits. (The expired

permits appear automatically in the list as selected once you have clicked License in the
General tab.) Before installing charts from an update CD, you must remove any chart
permits that have expired. Otherwise the installation of the up-to-date charts will fail.

• Type-in Chart Permit: Type in chart permits here. Each chart permit is a 64 character
string.

• Add: Click the button to enter the chart permit into the system. In most cases chart
permits are loaded from disk.

• Read Permits from: Click the button and select a drive or device to load chart permits
from. The system will look for files named "PERMIT.TXT" or "ENC.PMT" in the
root of the drive (or in the directory) you specify.

• Status field: Indicates if entered chart permits are accepted.
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General tab —> Certificate

This dialog enables you to view the currently installed certificate or to view other
available certificates that can be used to verify the signatures of S-63 chart distributions.

The path to this dialog is: Chart→Chart Types→ (PR Primar) Mng→General
(tab)→Certificate.

For each S-63 database there is one “current” certificate file.

Alternative certificate files can be distributed with the software or be available on the
distributed chart CDs.

The elements in the dialog are as follows:
• Current Certificate: Toggle this button to view the currently installed certificate.
• New certificate: Use this button to view other certificates.
• Display full text: Toggle this button on to display the full text of certificate.
• Trust and Instal1: Click this button to replace the current certificate with the one

being viewed.
• Cancel: Return to the General tab without installing new certificate.
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Certificate prompt

This menu is displayed when the system detects a new certificate on the CD. It contains
the following buttons:

Check: Click this button to examine and possibly install the new certificate.

Cancel: Click this button to ignore.

Note

You will not be able to load S63 charts if the current certificate on your system does not
match the S63 files on the distribution medium.
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General tab —> Log

Use this dialog to view the database log file.

The path to it is: Chart→Chart Types→ (PR Primar) Mng→General (tab)→Log.

The elements in the dialog are as follows:
• DataBase Log: Displays the contents of the log file, including chart installations and

updates applied.
• See Details: Click the button to display detailed installation information for the

selected chart entry. There is normally a details file for each installation batch.
• Prev.: Click the button to scroll log text to previous chart entry.
• Next: Click the button to scroll log text to next chart entry.
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General (tab) —> Log —> See Details

This is the dialog you see when you click the See Details button in the Log dialog.

The path to it is: Chart→Chart Types→ (PR Primar) Mng→General (tab)→Log→See
Details.

Use this dialog to view details of the database log file.

The dialog contains the following elements:
• Installation Details: Displays detailed contents of the log file including charts installs

and applied updates.
• Return to Log: Click the button to return to the less detailed log display.
• Prev.: Click the button to scroll the log text to the previous chart entry.
• Next: Click the button to scroll the log text to the next chart entry.
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General (tab) —> Coverage

This dialog displays information about the level of detail for the different areas covered
by the chart. Coloured rectangles with the size of the nominal chart cells are displayed.
Note that for large-scale charts, the nominal rectangle will not correspond very well with
the chart. Multiple harbour charts will be represented with a single coverage rectangle.
Due to the semi-transparent technique that makes it possible to see the chart image
through the colour, the colour will deviate from the pure colours shown in the menu.

The path to this dialog is: Chart→Chart Types→ (PR Primar) Mng→General
(tab)→Coverage.

It contains the following elements:
• Don't Show Coverage: Turn off the chart coverage display.
• Show Licensed Charts: Shows the coverage for all the charts you are licensed to use.

This is useful when not all licensed charts are currently loaded into the system.
• Show Installed Charts: Displays the coverage details of all the charts currently

installed.
• Show Needed Updates: Installed charts are compared with the latest S-63 product

list. All charts available in newer editions or with updates are listed. (This option is
not available for S-57 charts.)

• Show Product List: Displays all charts listed in the S-63 product list. (This option is
not available for S-57 charts.)

• Levels: Select the levels of detail you require.
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20.7.4.1.2 Install tab

Use this dialog to install or update the chart database.

The path to this dialog is: Chart→Chart Types→ (PR Primar) Mng→Install (tab).

The elements in the dialog are as follows:
• Chart CD Status: This area of the dialog contains a directory tree to enable you to

locate the chart database on the inserted medium. When you select a directory, the
system automatically checks to see if it contains a chart database. If it does, the
database will be described at the bottom of the dialog.
Some chart providers distribute their charts on DVDs or memory sticks using the
so-called “large media format”. When they do this, the charts are stored in a structure
containing “ENC folders” each of which is similar to a single CD: in the sample
Install tab above for a DVD containing AVCS charts, each folder labelled B1 through
B5 is an ENC folder. If you select the drive letter at the top of the directory tree, the
system recognizes the contents of the medium and describes them in text at the bottom
of the dialog (clicking Check CD has the same effect).

• Directory: The directory the chart database will be loaded from.
• Check CD: Click the button to cause the system to recognize the contents of the

inserted base or update medium and describe them at the bottom of the dialog.
• Details: This button brings up a dialog that allows you to impose filtering on the

charts that are imported.
• Import S-57 Chart(s): Click this button to install the selected charts.
• Show README: Click this button to display information from the distributor.
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Install (tab) —> Details

This is the dialog that is displayed when you click the Details button in the Install tab. It
allows you to filter the charts that are imported.

The path to the dialog is: Chart→Chart Types→ (PR Primar) Mng→Install (tab) →Details.

The elements in the dialog are as follows:
• Import Inside Area: Select this option to limit the imported charts to ones that cover

an area within the specified coordinates.
• Latitude: The minimum and maximum latitude of the limiting area.
• Longitude: The minimum and maximum longitude of the limiting area.
• Get Cursor: Click this button to define the limiting area by drawing a rectangle in

the chart with the cursor.
• Import for HOs: Select this option and type in a comma-separated list of Hydrographic

Office short names. For example, to limit the import to charts from the Norwegian,
Danish and British Hydrographic Offices, you would type: NO,DK,GB.

• Import All Charts: Switch off all filtering.
• Disregard S-57 Catalog: This option only available if you are using un-encrypted

S-57 charts.
• Import: Click this button when you have finished specifying the filtering you want to

impose. It returns you to the main Install dialog.
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Install (tab) —> Import S-57 Chart(s)

This dialog is for starting to install the charts.

The path to the dialog is: Chart→Chart Types→(PR Primar) Mng→Install (tab)Import
S-57 Chart(s):.

The elements in the dialog are as follows:
• S-57 Import Status: Displays the number of charts and updates found in the specified

directory. Installation time is roughly estimated.
• There are three verification choices for installing charts:

– Verify: Select to verify charts and avoid installation of chart cells with less serious
errors.

– Verify - Ignore Errors: Select to allow installation of chart cells with less serious
errors.

– No Verification (default): Select to install charts without any verification. (We
recommend this option when you are importing charts from a well-known
distributor.)

• Install: Click to start chart installation.
• Show Details: Click the button to display a detailed list of errors and warnings from

the verification and installation process. These are available on the log file.
• Cancel: Click the button to cancel chart installation.
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Install (tab) —> Import S-57 Chart(s) —> Install

This dialog gives you progress information when you are installing the charts.

The elements in the dialog are as follows:
• S57 Import Status: The progress bar will show installation progress and estimate

remaining time. When the installation is completed the status for the loaded charts
is displayed.

• Ignore Errors: Select to allow installation of chart cells with less serious errors.
• Install: Click to start chart installation.
• Show Details: Click the button to display a detailed list of errors and warnings from

the verification and installation process. These are available on the log file.
• Cancel: Click the button to cancel the installation.
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20.7.4.1.3 Updates tab

Use this dialog for updating your charts. Chart updates can be received over the internet,
by e-mail or on CDs.

The path to this dialog is: Chart→Chart Types→(PR Primar) Mng→Updates (tab).

The elements in the dialog are as follows:
• Update by Network: Click the button to display the Network Update menu. (Not

available on the K-Bridge Multi-functional Display Unit.)
• Update by Disk: Click the button to display the Disk Update menu.
• Update Manually: Click the button to display the Manual Update menu.
• Review Updates: Click the button to Review chart updates.
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20.7.4.1.4 List tab

This dialog lists the charts available in the database.

The path to the dialog is: Chart→Chart Types→(PR Primar) Mng→List (tab).

The elements in the dialog are as follows:
• List of Charts: Displays a list of all the charts in the database.
• Simple: Select this option to display the names of the installed charts.

When you have Simple selected and you double-click on a chart in the list, a full
status is displayed for that chart.

• Installed Status: Select this option to display chart names and update status for the
installed charts.

• Full Status: Select this option to display chart names and update status for all installed
and licensed charts.

• Name: The column for chart names.
• Ed: The column for chart editions.
• Upd: The column for chart update numbers.
• Status: The column for chart statuses (for example, whether charts are OK, not

loaded, or missing updates).
• GoTo: Click the button to go to the centre of the selected chart. The chart is displayed

at nominal scale.
• Legend: Click the button to display the legend for the selected chart.
• Delete: Click the button to delete the selected chart from the database.
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20.7.4.1.5 Settings tab

This dialog displays version numbers and enables you to configure the display of
symbols in the charts.

The path to the dialog is: Chart→Chart Types→(PR Primar) Mng→Settings (tab).

The dialog contains the following elements:
• Presentation Library Version: Displays the implemented version of the presentation

library - chart symbols.
• C-Map SDK Version: Displays the version of the C-Map software installed in the

system. (SDK - Software Development Kit).
• Traditional symbols: Select to display traditional chart symbols for chart objects.

When not selected simplified symbols are used.
• Plain Boundaries: Select to displayed charts with plain boundaries. When not selected

chart areas are displayed with annotated boundaries.
• Display Chart1: Click the button to display a resize-able window showing chart

symbols used. Use the drop-down menu to select different views.
• Coverage: Click the button to display the Chart coverage menu which enables you to

specify the levels of detail you require.
• Clear Database: Click this button to delete all charts or all charts and licenses from the

database. You will be prompted to confirm your decision.
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20.7.4.2 CM93 Ed.3 chart management dialogs

The path to the menus and dialogs for managing, removing and installing C-Map edition
3 digital charts is: Chart→Chart Types→<database> Mng.

For information about:
• The license status, the database installation and update log, or the database's coverage,

see General tab on page 497.
• Copying charts from another navigator station on the same network, see Mirror tab

on page 502.
• Installing charts from a CD, see Install tab on page 503.
• Updating the chart database, see Update tab on page 504
• Listing and deleting chart databases, see List tab on page 505
• Configuring how the chart is displayed, see Settings tab on page 506.
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20.7.4.2.1 General tab

This tab provides general information about the installed chart database.

The path to the tab is: Chart→Chart Types→<database> Mng→General (tab).

It contains the following elements:
• Database Status: Displays the database name and version number.
• Licence: Brings up licence information.
• Log: Brings up database log information.
• Coverage: Brings up chart coverage data.

The dialogs that these buttons bring up are described in the next section (see CM93 Ed.3
chart management dialogs on page 496).

If the system is configured to load chart databases from:
• another K-Bridge system over the Local Area Network (LAN), then it is capable of

mirroring (copying) chart databases from other systems on the LAN. In this case the
Mirror tab appears in this dialog behind the General tab (see Mirror tab on page 502).

• a local CD-ROM or DVD drive, the Install tab appears behind the General tab (see
Install tab on page 503)
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Licence information

This tab provides information licences associated with the charts. Most CM-93 edition 3
charts require licence codes. If you do not have a licence code, only overview charts
will be displayed.

The path to this information is: Chart→Chart Types→<database> Mng→General
(tab)→Licence.

It contains the following elements:
• Registered Licences: A list of all licences registered for the CM-93 edition 3 charts.

The list contains the licence name (which identifies the zone/area it covers or indicates
whether it is a supplementary licence covering a particular service such as piracy
avoidance), expiry date and licence code.

• Dynamic licensing: Click this button to bring up the dialog (see next sub-section) that
enables you to pay for chart licences as you use them. (You need to have a credit
arrangement set up with C-Map or your chart agent to perform dynamic licensing.)

• Remove: Click this button to remove the selected licence.
• Type-in Licence: To enter a new licence, select the zone/area or type of service, and

type in the licence code that you have received from C-Map.
• Code: Type in the licence code.
• Add: Click this button to enter the license code into the system.
• Output C-Map User ID file to Medium: Click this button to save the file containing

the licence codes to an external medium.
• Read Licences from Medium: Click this button to make the system input licences

from a user ID file on an external medium.
• Status field: The status field prompts you to type in the code for a new licence, and

indicates whether the license code was accepted or not.

498 381287/A



Reference Guide

Dynamic licensing information

This version of the General tab is for enabling dynamic licensing.
The path to this tab is: Chart→Chart Types→<database> Mng→General (tab)→Dynamic
licensing.
C-Map allows dynamic ("pay-as-you-go") licensing for some databases as an alternative
to normal (static) licensing. To take advantage of this, you must first make arrangements
with C-Map or your chart agent for getting the proper licences. With dynamic licences,
you start with a certain amount of chart credit and, as you use different charts, the system
automatically registers them and decreases your credit accordingly. Your credit and chart
usage are reported to and synchronized with C-Map whenever you perform chart updates
for the database either on-line (if the system supports this) or by e-mail.
The tab contains the following elements:
• Normal lice the nsing: Click this button to return to the tab for non-dynamic licenses.
• Enable dynamic licensing: Check this box to enable dynamic licensing.
• Refresh: Click to refresh the licensing data.
• Credit Rest: Your remaining credit.
• Next Report: The date by which your next chart usage and credit report to C-Map is

due.
• Last Report: The date of your last report to C-Map.
• Non-reported Datasets: The number of charts used since the last report.

– Dataset: Chart name.
– First Use: The date on which the chart was first used.

• Reported Datesets: The number of charts that have already been licensed.
– Dataset: Chart name.
– Expiry: Expiry date for the licence.
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Log information

You can view the chart database's log file.

The path to this is: Chart→Chart Types→(CP: Professional+) Mng→General (tab)→Log.

The tab containing the log information contains the following elements:
• DataBase Log: Displays the contents of the log file including charts installed and

applied updates.
• See Details: This option is not available for C-Map 93 Edition 3 charts.
• Prev.: Scroll Log text to previous chart entry.
• Next: Scroll Log text to next chart entry.
• Print Log: Allows you to print the log file if the system is fitted with a printer.
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Coverage

Information is available about the chart's coverage. Coloured rectangles with the size
of the nominal chart cells are displayed. Note that for large-scale charts, the nominal
rectangle will not correspond very well with the chart. Multiple harbour charts will be
represented with a single coverage rectangle. Due to the semi-transparent technique that
makes it possible to see the chart image through the colour, the colour will deviate
from the pure colours shown in the dialog.

The path to the coverage information is: Chart→Chart Types→(CP: Professional+)
Mng→General (tab)→Coverage.

The tab containing the coverage information contains the following elements:
• Don't Show Coverage: CM-93 edition 3 chart coverage display is turned off.
• Show Coverage of Licensed Charts: Displays all CM-93 edition 3 chart you have

licensed. Used when not all licensed charts are loaded into the system.
• Show Coverage of Installed Charts: Displays all CM-93 edition 3 charts loaded into

the system.
• Levels: Select the chart levels to be displayed in coverage presentation. The colour

code is used in the coverage presentation.
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20.7.4.2.2 Mirror tab

If the console is connected to a local area network, a mirror tab is available which
enables you to copy charts from one display unit to an other.

Note

The mirror tab is only displayed when the system is configured to load chart databases
from a K-Bridge ECDIS, MFD or K-Bridge Planning Station system. On systems that
are configured to load chart databases from a local CD-ROM or DVD drive, the Install
tab is displayed instead (see Install tab on page 503).

The path to the dialog is: Chart→Chart Types→(CP: Professional+) Mng→Mirror (tab).

The dialog contains the following elements:
• Chk: Click to check the database against the database installed in the mirror host.

An information message is displayed.
• Install Charts: Click to install charts from the mirror host. The mirror host will

normally be a K-Bridge ECDIS or K-Bridge Planning Station.
• Install Updates: Click to install updates from the mirror host. The mirror host will

normally be a K-Bridge ECDIS or K-Bridge Planning Station.
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20.7.4.2.3 Install tab

The install tab is only displayed when the system is configured to load from the CD
drive.

The path to this tab is: Chart→Chart Types→(CP: Professional+) Mng→Install (tab).

The tab contains the following elements:
• Chart CD Status: Allows you to select the drive letter for the CD drive, normally D:\.
• Directory: Lists the file directory for the database.
• Install Chart Database: Click to install the chart database from a CD-ROM. The

installation will take about 10 minutes.
• Check CD: Click to check the CD against the installed version of the database. An

information message is displayed.
• Update Chart Database: Click to update the chart database from the CD-ROM. The

installation will take about 10 minutes.
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20.7.4.2.4 Update tab

This tab enables you to update the chart database and review previous updates.

The path to this tab is: Chart→Chart Types→(CP: Professional+) Mng→Install (tab).

The tab contains the following buttons:
• Update by Network: Click to update the charts from the network.
• Update by Disk: Click to update the charts from the CD drive.
• Update Manually: Click to edit an object in the chart manually (this is the same as

clicking the Change button in the Object Info dialog; see Object Info on page 377).
• Review Updates: Click to review updates to the database.
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20.7.4.2.5 List tab

This tab enables you to list charts. It is more useful when you are using S63 charts (see
List tab on page 494) than when you are using C-Map Professional charts.)

The path to this tab is: Chart→Chart Types→(CP: Professional+) Mng→List (tab).

The tab contains the following elements:
• Simple: Select to list just the chart names.
• Installed Status: Select to see (in addition to the name) the edition number for each

chart and also to see an indication of whether you have the latest version of the chart.
• Full Status: This option is only available for S63 charts. As well as the name of the

chart and the installed status information, you also see an indication of the status of
the license for each chart.

• Go To: Click to display the selected chart(s).
• Legend: Click to view the legend for the selected chart. The legend contains key

information about the chart (see Chart Legend on page 478).
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20.7.4.2.6 Settings tab

The settings tab is used to select how the database is displayed.

The path to this tab is: Chart→Chart Types→(CP: Professional+) Mng→Settings (tab).

It contains the following elements:
• Traditional Symbols: Selects between simplified and traditional symbols.
• Plain Boundaries: Selects between complex and plain line styles to designate the

boundary of an area.
• Do Not Use Isol. Dng. for C-Map Charts: When selected, dangerous objects are

displayed using normal cartography symbols instead of ISODNG symbols, to reduce
clutter in older charts.

• Use S52 Symbols for C-Map Charts: Display C-Map charts using S52 symbols.
• Use C-Map Symbols for C-Map Charts: Display C-Map charts using C-Map's own

symbols.
• Display Chart 1: Click this button to display a resizable window showing the chart

symbols used. Use the drop-down menu to select different views.
• Coverage... Click this button to view the chart coverage data.
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20.7.5 Manage Notes

This menu enables you to create and manage mariners' notes. Mariners' notes are
geographically fixed symbols, lines and areas that you can use to add information to
charts or (if charts are not in use) to supplement radar information.

The path to this menu is: Chart→Manage Notes.

The menu contains some or all of the following buttons, depending on the application
you are viewing it from::
• List and Create Notes: Click this button to access the folders containing the currently

stored mariners’ notes and to create new notes (see Nav Notes List on page 508).
• Edit Note: Click this button to edit a note (see Edit Note on page 510).
• Save All Notes: Click this button to save new or edited notes to the hard disk.
• Manage Note Folders: Click this button to manage your note folders (see Manage
Notes Folders on page 512).

• Load Notes from Medium: Click this button to load notes from external media (see
Note Load from Medium on page 513).

• Save Notes to Medium: Click this button to save notes to external media (see Note
Save on Medium on page 514).

• Create Drop Note: Click this button to create notes concerning objects that have been
dropped from the vessel into the sea (see Drop Note on page 515).

• Ship Relative Notes (Templates): Click this button to add your own graphical objects to
the own-ship symbol or to targets; the graphical objects move with the object they are
attached to on the radar display (see Template Manager on page 518).

• ARCS/Seafarer Notes and Diagrams: Click this button to view HCRF (Hydrographic
Chart Raster Format) notes and diagrams (see HCRF Notes and Diagrams on
page 516).

• ARCS/Seafarer Temp. Notices to Mariners: Click this button to view HCRF
(Hydrographic Chart Raster Format) temporary notices to mariners (see HCRF Temp.
Notices to Mariners on page 517).
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20.7.5.1 Nav Notes List

This dialog gives you access to the folders where the mariners’ notes are stored. Among
other things, you can create new notes from this dialog, edit existing notes, and list and
sort the contents of each folder.
The path to the dialog is: Chart→Manage Notes→List and Create Notes.
Folder list: Select a notes folder from the drop-down list to display the notes in that
folder. To create a new folder, see Manage Notes Folders on page 512
The dialog contains the following elements:
Sort on: Notes can be sorted by type, distance from the own-ship or date of
creation/modification.
The list: A sorted list of notes. Select a particular note to edit. Use the horizontal scroll
bar in the dialog to see all of the columns in the table. They have the following headings:
• No. - The note's number.
• Time - The time the note was created or last modified.
• Type - The following types of note are possible:

– 1 Event
– 2 Caution note
– 3 Information note
– 4 Chart correction note
– 5 Other note
– 6 Solid line
– 7 Dashed line
– 8 Safety contour
– 9 Hollow area
– 10 Filled area

• Latitude
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• Longitude
• The first part of the note's text

The remaining elements of this dialog are buttons:
• List: Click this button to view details of the selected note.
• Edit: Click this button to edit the selected note (see Edit Note

on page 510).
• Print: Click the button to bring up a dialog for printing the

selected note or notes (see Printer on page 590). The dialog
that comes up enables you to specify a printer to use. It also
lists the notes or other items currently available to be printed.
You need to select an entry or entries once more to print them
(either to a file or to a printer).

• Paste: Click this button to paste in data from the clipboard.
• Cut: Click this button to delete the selected note.
Click the following buttons to create a new note of the type you
require (they take you to the Nav Note dialog for the particular
type of note you select; see Edit Note on page 510):
• Event: Click this button to create an event note.
• Caution Note: Click this button to create a caution note.
• Info Note: Click this button to create an information note.
• Chart Corr: Click this button to create a chart correction note.
• Other Note: Click this button to create a note of a type not

listed in this dialog. To see the other types of notes available,
see Other Nav Note Creation on page 511.

• Solid Line: Click this button to create solid lines.
• Dashed Line: Click this button to create dashed lines.
• Safety Contour: Click this button to create a safety contour

line. If a planned route crosses the line, a grounding warning
will be generated during route validation. If the vessel crosses
the line, a grounding warning will be generated during
anti-grounding checking.

• Area: Click this button to create a polygon describing an area.
• Filled Area: Click this button to create a filled polygon

describing an area.
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20.7.5.2 Edit Note

Use this dialog to edit mariners' notes.

The path to the dialog is: Chart→Manage Notes→Edit Note; or alternatively click on one
of the buttons in the “Create” area of the Nav Notes List dialog (see Nav Notes List
on page 508) or the Other Nav Note Creation dialog (see Other Nav Note Creation
on page 511).

The elements in the Nav Note dialog are as follows:
• Number: The note's number in the list. Use the arrow buttons to select a note by its

number.
• Time: The date and time that the note was last saved.
• Type: Select the note type from the drop-down menu.
• Comment: The text of the note. If necessary use the scroll bar.
• Edit/End Edit: Click to edit the note. The Type, Comment and Latitude and Longitude

values are not edit-able until you click Edit. Then, to edit the Latitude and Longitude
fields, double-click on them. To finish editing the note, click End Edit.

• Cancel: Click to cancel any unsaved changes to the note.
• Copy Pt: Click to copy selected points to an other note. Select points and click copy.
• Paste Pt: Click to paste the copied points into a list of points.
• Insert Pt: Click this button to insert a new point before or between existing points.
• Delete Pt: Click to delete selected points.
• Datum: Select WGS-84 or Local for the datum.
• Local: Pressing this button allows you to select a datum from a list of commonly used

datums. If you select a local datum, the name will be shown as the button text (instead
of “Local”). See section 20.9.9 on page 551 for more information.
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20.7.5.3 Other Nav Note Creation

This dialog enables you to create another ten different types of navigation note in addition
to the types available in the Nav Notes List dialog (see Nav Notes List on page 508).

The path to the dialog is: Chart→Manage Notes→List and Create Notes→Other Notes.

Click the following buttons to create a new note of the type you require (most of them
take you to the Nav Note dialog for the particular type of note you select; see Edit Note
on page 510):
• Text Note: Click to create a text note.
• Picture Note: Click to create a picture note by importing a graphics file from an

external medium.
• Chart Calibration Pt: Click to create a chart calibration point.
• Restricted Area: Click to create a restricted area border. If a planned route crosses

the border, an area warning will be generated during route validation. If the vessel
crosses the border an area warning will be generated during anti-grounding checking.

• Environmental Line: Click to create an environmental area border. If a planned route
crosses the border, an area warning will be generated during route validation. If the
vessel crosses the border, an area warning will be generated during anti-grounding
checking.

• Danger Highlight: Click to create a note that highlights some danger.
• Danger BRG - NMT: Click to create a bearing limitation line (Not More Than).
• Danger BRG - NLT: Click to create a bearing limitation line (Not Less Than).
• Pred. Tidal Stream: Click to create a note to indicate a predicted tidal stream.
• Actual Tidal Stream: Click to create a note to indicate an actual tidal stream.
• Create Point Symbols: Select the type of point symbol you require from the drop-down

list.
• Create Symbol: Click this button to create and specify the characteristics of the point

symbol.
• Create Symbol - Dangerous: Click this button to create a danger point symbol and

specify its characteristics.
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20.7.5.4 Manage Notes Folders

Use this dialog to manage your folders of mariners' notes.

The path to the dialog is: Chart→Manage Notes→Manage Note Folders.

The dialog contains the following elements:
• Note Folders in Archive: List of note folders in the archive. Select a folder.
• Display: Click to display the notes in this folder on the chart/radar display. The notes

in the folder will be read-only.
• Undisplay: Click to hide the notes in this folder from the chart/radar display.
• Edit: Click to display the notes in the selected folder and allow them to be edited.
• List: Click to list the notes in the selected folder (see Nav Notes List on page 508).
• New: Click to create a new notes folder.
• Revert: Click to revert to an earlier version of the folder.
• Save: Click to save your changes to the folder.
• Rename: Click to rename the selected folder.
• Delete: Click to delete the selected folder.
• Insert File: Click to insert a file into the selected folder.
• Print to: Click to print the notes in the selected folder to an external medium. A

dialog appears prompting you to specify the output device and path. The notes are
printed as a single text file to the device you specify.

• Backup: Click to save the selected folder to an external medium.
• Refresh: This button updates the note lists for all the notes folders found on the

computer. The system updates the note lists automatically but the Refresh button
enables you to do it manually as well.
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20.7.5.5 Note Load from Medium

Use this dialog to load previously made notes from the selected device. Insert the
external disk or memory device.

The path to the dialog is: Chart→Manage Notes→Load Notes from Medium.

The dialog contains the following elements:
• Select input device/directory or Cancel: Select from listed devices/directories.
• OK: Enters selection.
• Cancel: Cancels selection.
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20.7.5.6 Note Save on Medium

This dialog enables you to save notes to a selected device. Insert the external disk or
memory device.

The path to the dialog is: Chart→Manage Notes→Save Notes to Medium.

The dialog contains the following elements:
• Select input device/directory or Cancel: Select from listed devices/directories.
• OK: Enters selection.
• Cancel: Cancels selection.
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20.7.5.7 Drop Note

This dialog is specifically for creating notes concerning objects that have been dropped
from the own-ship into the sea.

The path to the dialog is: Chart→Manage Notes→Create Drop Notes.

The dialog contains the following elements:
• Folder: The topmost drop-down menu allows you to select which folder the created

drop notes should be added to. This button is a shortcut to the manage folder dialog
(seeManage Notes Folders on page 512 ).

• Drop Pos: The second drop down menu allows you to select which reference point
should be used for creating new drop notes. This button is a shortcut to the Ship
Reference Points dialog (see Ship Reference Points on page 444).

• By clicking the New button, a new drop note is created at the defined reference
position on the ship at the current UTC time.
When a drop note has been created by the New button, the operation can be undone
by clicking the UnDo button.

• Def. Text: This field allows you to define a text which is displayed together with the
drop object symbol. If the text contains the special “macro” sequences these are
replaced with the actual macro values:
– %n This is replaced with the note number.
– %1d This is replaced with the depth in meters from depth sensor number 1.
– %2d This is replaced with the depth in meters from depth sensor number 2.
– %d This is replaced with the depth in meters from the current depth sensor.

• Accel.: By this drop down menu, one can define any of the Function Keys F1 to F4
to be used as “Accelerators” for defining new object positions. That is, the function
key can be used in stead of the New button in the dialog.

• The figure below shows screen with a note number 1 launched at the Stb Crane.
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20.7.5.8 HCRF Notes and Diagrams

This dialog enables you to view HCRF (Hydrographic Chart Raster Format) notes and
diagrams.

The path to the dialog is: Chart→Manage Notes→ARCS/Seafarer Temp. Notices to
Mariners.

The dialog contains the following elements:
• Chart: Chart number.
• Notes and Diagrams: List of notes and diagrams available for this chart. By selecting

an entry in the table, the note/diagram will be displayed in a separate window.
• Tidal Data: List of tidal data stations in the chart. Select one of the stations to display

the data in a separate window.
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20.7.5.9 HCRF Temp. Notices to Mariners

This dialog enables you to view HCRF (Hydrographic Chart Raster Format) temporary
notices to mariners.

The path to the dialog is: Chart→Manage Notes→ARCS/Seafarer Temp. Notices to
Mariners.

The dialog contains the following elements:
• General: Select to see general notices.
• Chart: Select to see notices for chart currently being displayed.
• Arrow buttons:Select specific notice by using buttons.
• NtM no: Notice to Mariners number.
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20.7.6 Template Manager

This dialog is the main menu for the Templates tool. It lists all templates currently
available, both those provided by the manufacturer and any that you (or other operators)
have created. It also enables you to create, edit and apply templates.

To reach this dialog, select: Chart→Manage Notes→Ship Relative Notes (Templates).

The dialog contains the following buttons:
• New: Click this button to create a new template. The new template appears (with a

generic name) in the list. It is highlighted to indicate that you can edit its name:
specify the name you want to give the template. When you are ready to define the
new template, select it in the list and click the Edit button.

• Edit: Click this button to edit the definition of the selected template. It brings up the
Template Edit dialog; for a description of this dialog, see Template Edit on page 520).
For more information about using the Template Edit dialog, see Defining the template
on page 227. Before clicking this button, make sure the Draw Templates option is
checked.

• Rename: Click this button to rename the selected template. When you do this, the
name becomes editable: specify a unique name for the template.

• Use: Click this button when you are ready to attach the template to an object on
the chart. It brings up the Template Use dialog; for a description of this dialog,
see Template Use on page 522. For information about how to use the dialog, see
Attaching the template to an object on the display on page 228.

• Input from Floppy: To copy templates from an external medium (for example, a USB
memory stick) to the system's hard disk (so that they appear in the list in this dialog),
insert the external medium, then click Input from Floppy.

• Copy: Click this button to copy the selected template. Then click the Paste button
to paste it into the list. It will appear there as Pasted Template. Next select Pasted
Template and click Rename to give the new template a name. Finally click Edit to
edit its details, and click Use to attach it to a particular object or geographical position
on the chart.
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• Delete: Click this button to remove the selected template or templates permanently
from the list of defined templates. You will be prompted to confirm that you want to
delete the template or templates.

• Output to Floppy: To copy templates to an external medium insert the medium, then
click Output to Floppy.

• Paste: Use this button in conjunction with the Copy button described above when you
want to create a new version of a template that already exists.

• Refresh: Click this button to refresh the displayed list of templates. If you have a
template currently open for editing, do not click the Refresh button unless you want to
revert to the last saved version of that template.

• Draw Templates: Check this box to display templates on the chart. Un-check it
to hide templates.

• Global Templates: Check this box to cause templates on this operator station to be
automatically updated whenever a template is edited on another operator station on
the same network. (The system on which the template is edited must also have its
Global Templates option selected.)
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20.7.6.1 Template Edit

Use this dialog to design the template. You can either draw in the nodes and vectors in
the lower graphical window by using the mouse (or track-ball) and mouse-buttons, or
you can enter values alpha-numerically in the top table (or of course you can use a
combination of these methods).

To reach this dialog, select: Chart→Manage Notes→Ship Relative Notes (Templates)→New
or →Edit.

Make sure you have checked the Draw Templates option in the Template Manager
dialog (see Template Manager on page 518) if you want to use the drawing facilities in
the Template Edit dialog.

The node that is selected in the upper list window is marked by an un-filled black square
in the graphical window. You can also select a node by clicking on it in the graphical
window, which causes it to be highlighted in the top window.

The range, bearing, and X/Y co-ordinate values for each node are displayed in the list
window, and these are updated each time you move the node. You can also edit them
manually and your edits will be immediately reflected in the shape displayed in the
graphical window.

The Template Edit dialog contains the following buttons:
• Insert/End Insert: Click the Insert button to add a new node, then click with the left

mouse-button at the position in the graphical window where you want the new node to
appear: a line is then drawn from the selected node to the new one. Move the mouse
and click again to draw a line from the previously added node to a new node. Click
End Insert when you want to stop adding nodes and lines.
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When you have clicked the End Insert button, you can use the left mouse-button to
select individual nodes in the graphical window and drag them to new positions. Do
this to refine the shape of the template.
To add a line from the very last node to a new node, select A... in the node list in the
top half of the dialog box (the A stands for Append). Then click Insert and finally
click in the graphical window at the position where you want the new node to appear .

• Delete: Click this button to delete the selected node or nodes.
• Zoom In: Use this button to zoom in on the image in the graphical window.
• Zoom Out: Use this button to zoom out from the image in the graphical window.
• Zoom All: Use this button to cancel the previous zooms and view the image in the

graphical window at normal range.
• Save: Click this button to save the template definition. If you do not save the

definition, it will be lost when another template is selected for editing.
If you want to use the template you have drawn as a replacement for the own-ship
symbol on the chart display, you must save the file with the name $$OwnShip and
then check the Use Template '$$OwnShip' as Outline option in the Display tab of the
Parameter Setup dialog (see Display tab on page 565).

For more information about using this dialog, see Defining the template on page 227.
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20.7.6.2 Template Use

This dialog enables you to attach a template to a particular object or geographical
position in the radar display.
To reach this dialog, select: Chart→Manage Notes→Ship Relative Notes (Templates)→Use.
The first half of the Template Use dialog contains the following elements:
• Own Ship: Select this option to attach the selected template to the own-ship symbol

on the chart.
• Target: Select this option to attach the selected template to a radar or AIS target on

the display. Then click Select New Target and use the cursor to select the target in the
radar display. There are four other elements associated with this option:
– Targets (drop-down list): This is a list of all the targets in the system that have a

template attached.
– Select New Target: Click this button after selecting the Targets option, then use the

cursor to select a target in the radar display to attach the template to.
– Detach: Select a target from the drop-down list, and click this button to detach its

template from it.
• Fixed Position: Select this option to attach the selected template to a fixed geographical

position. Position-fixed templates each have a number, and you must use the spin
buttons to specify the number for a new one that you are creating or for an existing
one that you are editing. The following elements are associated with this option:
– New: Click this button if you are creating a new position-fixed template. Specify

its position by entering values into the co-ordinate fields, or by clicking the EBL
button and moving the EBL to the position required. (The values in the co-ordinate
field will change to show the position of the EBL.)

– Detach: Click this button to detach the template from the fixed position identified
by the number next to the spin buttons.

• Apply: Click this button to apply the changes you have specified.
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The second half of the Template Use dialog is for specifying the attributes of the template
as it appears on the radar display:
• Template: Select the template you want to attach from the drop-down list.
• Colour: Select a colour from the drop-down list. The colours are a subset of the S-52

(ECDIS) colours; they will change whenever you change the display palette.
• Scale: Specify the level of magnification you require for the display of the template

(this is specified as a percentage of its size when you drew it in the Template Edit
dialog). Note that the template will scale with the display whenever you change
the scale you are using for the display.

• Rot(ation): Templates attached to a fixed geographical position have a rotation angle
relative to North. Templates attached to the own-ship symbol or to a target can have
an absolute angle (relative to North) or an angle relative to the associated own-ship
(or target's) heading. To display the template relative to North, select Abs. To display
the template relative to the associated own-ship (or target's) heading, select Rel.

• Offset: The Template can be drawn on the display at an offset (range and bearing) from
the object to which it is attached. The angle of offset is always relative to the object's
course (or relative to North for fixed-position templates). Specify the offset (if any)
that you require for the drawing of the template in relation to the object (or location)
on the radar display. The offset is expressed as a range and bearing from the object.

• Bold: Check this box if you want the template to be drawn using bold lines in the
radar display.

• Apply: Click this button to make the template appear on the display according to
your specifications.

For more information about how to use this dialog, see Attaching the template to an
object on the display on page 228.
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20.7.7 Navtex Message List

The dialog enables you to view unread and previously read Navtex messages.

The path to the dialog is Chart →Navtex Messages.

The dialog contains the following elements:
• Unread: Select to display a list of unread messages.
• Read: Select to display a list of previously read messages.
• The list: The list displays either unread or read messages dependent on the selection

above.
• Delete: Click the button to delete one or several selected messages.
• Print: Click the button to bring up a dialog for printing the selected message or

messages. The dialog that comes up enables you to specify a printer to use. It also
lists the messages currently being sent to the selected printer and enables you to print
the selected message or messages to a file instead.

• Display: Click the button to display the selected message (see Navtex Message on
page 525).

• Configure: Click the button to configure the Navtex interface (see Navtex Configure
on page 526).
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20.7.7.1 Navtex Message

This dialog displays the selected Navtex warning message. When a Navtex message is
displayed, the system checks the text for coordinate information and, if it finds any,
it presents it in the Latitude and Longitude fields below the text. You can then use
coordinates to create a mariner's note at the position indicated; or you can use them to
browse to that position in the chart. If there are multiple coordinate pairs in the text
window, you can select different parts of the text, and the coordinate pair in the Latitude
and Longitude fields will change accordingly.
The path to the dialog is Chart →Navtex Messages (select message)→Display.
The dialog contains the following elements:
• ID: Message ID.
• CER: The percentage of this message that is accounted for by communication errors.
• Category: The category of message.
• Station: The station that transmitted the message.
• Delete: Click to delete the message.
• List: Click to return to the message list (see Navtex Message List on page 524).
• Latitude: The latitude coordinate of the place that is the subject of the Navtex message.
• Longitude: The longitude coordinate of the place that is the subject of the Navtex

message.
• Mark in Chart: Click to create a mariner's note at the position indicated by the latitude

and longitude values.
• Go To: Click to go to this position in the chart.
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20.7.7.2 Navtex Configure

To configure Navtex services on your system, select: Chart →Navtex
Messages→Configure.

This section describes the following tabs for configuring Navtex services:
• Navtex Settings (see Settings tab on page 526)
• Navtex Categories (see Navtex Categories tab on page 528)
• Navtex Stations (see Navtex Stations tab on page 529)

20.7.7.3 Settings tab

This dialog is for specifying the type of Navtex receiver connected. The parameters in
the dialog box are normally only changed during commissioning. The system password
is required to change them.

The path to the dialog is Chart →Navtex Messages→Configure (Settings tab).

The dialog contains the following elements:
• Equipment Type: Select the type of Navtex receiver connected to the K-Bridge Radar

from the drop down list.
• Port No: Select the serial port number the Navtex receiver is connected to. Settings

for the serial port are done underMenu→System→Serial Communication. By default,
the serial line is set to 4800, 8 bit data, 1 stop bit, no parity.

• Alarm Handling: The following alarm handling options are available:
– None: Select this radio button to turn off Navtex alarms.
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– Invoke Alarm (on type D): Select this radio button to display alarms of type D on
the ECDIS alarm and message area (see Top bar: the alert area on page 60). Type
D is for distress, search-and-rescue and piracy alerts. (For a list of all the categories
of Navtex messages, click the Categories tab.)

– Invoke Alarm (on types A, B, D and L): Select this radio button to display Navtex
alarms of categories A, B, D and L on the ECDIS alarm and message area (see
Top bar: the alert area on page 60).

– Handle External Alarms: Select this radio button to display all Navtex messages
(received by the Navtex receiver) on the ECDIS alarm and message area (see
Top bar: the alert area on page 60). You can filter them by using the Categories
and Stations tabs.

– Handle External Alarms and Ack: Select this radio button to display all Navtex
messages on the ECDIS alarm and message area (see Top bar: the alert area on
page 60), and in addition to enable them to be acknowledged from ECDIS.

• National Station Support: To receive Navtex messages in the national language for
the waters you are sailing through, select 490kHz. The other bands are not normally
available.

• Load Messages with Invalid Status: Select to display messages that have not been
correctly received as well as messages that have been correctly received.

• Automatically Save After Read: Select to automatically save incoming messages after
they are read. Incoming messages are stored in an Unread directory, while messages
are automatically transferred to the Read directory after the user has read them.
Messages are retained in the Read directory until they are explicitly deleted. If not
selected, messages are automatically deleted after they have been read, unless they
are explicitly saved.

Note

The Navtex interface is mainly a passive "listening" interface. No signals are sent
from the K-Bridge MFD system to the Navtex receiver unless you select the option
Handle External Alarms and Ack (in which case the K-Bridge MFD system sends
acknowledgements to the Navtex receiver).
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20.7.7.4 Navtex Categories tab

This dialog is for specifying which Navtex message types are to be ignored.

The path to the dialog is System →Navtex Messages→Configure (Categories tab).

The elements in the dialog are as follows:
• Ignore: In this column check the box next to the message type that you want the

K-Bridge Radar system to ignore. (Messages of categories A, B, D and L cannot be
filtered out.)

• Message Types: This column lists all the categories of Navtex message available.
Check the Ignore box next to a category to filter out messages of that category.
(Messages of categories A, B, D and L cannot be filtered out.)

• Reset: Click this button to enable receipt of all Navtex messages.
Note

In addition to the filtering that you specify here the Navtex receiver might have its own
message filtering configured. Note that the K-Bridge MFD system will only receive the
messages that the Navtex receiver is configured to receive, and that the Navtex receiver's
settings are not affected by the filtering you specify on the K-Bridge MFD system .
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20.7.7.5 Navtex Stations tab

This dialog enables you to specify the Navtex stations that you want to receive messages
from. The list contains the name and location of each station in the selected area
(and overlap area); it also includes the station's distance from the own-ship and its
broadcasting range and transmission times.
The path to the dialog is System →Navtex Messages→Configure (Stations tab).

Note

The information in this tab is an unofficial compilation. You must refer to other sources
for up-to-date official information. The British Admiralty List of Radio Signals is an
excellent source of NAVTEX and GMDSS information.

The elements contained in the dialog are as follows:
• Area: Select the area that you are currently sailing through. Transmitting stations are

identified by a letter from A to Z. When you select the area (and overlapping area,
if any) that you are currently sailing through, the system displays the names of the
transmitting stations in that area.

• Overlap: Often you will be able to receive signals from areas that overlap the area
you are sailing through. To list the stations in an overlapping area select the area
from the drop-down list.

• Display Station Mask: Select this button to filter out messages with a particular letter
code. To filter out unwanted messages by letter code, select the relevant letter from
the list, and click Disable.

• Use the Enable button to re-enable messages with a particular letter code.
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• When you sail into a new Navtex area, use the Reset button to re-enable messages
with all letter codes. Then if necessary use the Disable button again to filter out
unwanted messages by letter code.

• Display All Known Stations: Select to display the names of all known stations in the
selected area and overlap area.

• Display Stations Within Range: Select to display the names of all stations that the
own-ship is currently within range of in the selected area and overlap area.

• Display National Language Stations: Check this box to display (along with the other
stations) those stations that broadcast in the national language (on band 490kHz) for
the waters you are sailing through. The language is displayed in the Language column.

• Reset: Click the button to enable receipt of messages with all station letter codes.
• Enable: Click the button to enable receipt of messages from stations with the selected

letter code.
• Disable: Click the button to disable receipt of messages from stations with the

selected letter code.
• Go To: This button takes you to the location of the selected station on the chart.
• Display in Chart: Check this box to display in the chart the location and range of

all listed stations.
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20.7.8 Colour Differentiation and Calibration

The colour differentiation and calibration dialog allows you to check the colour
reproduction quality of your ECDIS system.

The path to the dialog is: Chart→Colour Differentiation and Calibration.

Before checking this, the monitor should be set to the calibrated state (see Intensity on
page 367). Then, for each palette (day, dusk, night) the foreground line displayed in the
Colour Calibration dialog should be clearly visible against the coloured background.
Before checking the night palettes on a dark bridge, allow your eyes to adapt to the
darkness for at least 10 minutes. If the foreground and background colours cannot be
differentiated, contact the Kongsberg Maritime service department.
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20.7.9 Chart Type Setup

The console can have a number of chart databases active at any time. The Chart Type
Setup dialog enables you to set the priority for, clean up, and add and remove databases.
For information about:
• Adding a new database, see New Chart Type on page 534.
• Copying (mirroring) a chart database from another operator station on the network,

see Chart Type Mirroring on page 535.
The path to the Chart Type Setup dialog is: Chart→Reconfigure Chart Databases.

You can also reach it from: System→Maintenance→Reconfigure Chart Databases

The dialog contains the following elements:
• Databases: A list of all chart databases in the system. The highest priority database is

at the top of the list. Each database is identified by a two-letter mnemonic:
– CM C-Map
– PR Primar
– AR ARCS
– CW World
– HO S57 HO data
– CP C-Map Professional+
– CE C-Map ENC
– JP Jeppesen PRIMAR
You can edit the two letter mnemonic by double-clicking it and typing in a new
two-letter identifier.

• Remove Database Click the button to remove the selected database from the system.
This is not normally necessary unless there is little hard disk space left. The action
will also remove all licenses related to the database.
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• Cleanup Database: Click the button to remove all charts in the selected database
without removing the database from system.

• Increase Priority: Click the button to increase the priority of the selected database.
The database moves upward in the table.

• Decrease Priority: Click the button to decrease the priority of the selected database.
The database moves downward in the table.

• Add New: Click the button to add a new entry to the database list (see New Chart
Type on page 534).

• Change Mirror: Is used to mirror a chart from a remote Radar, ECDIS or Planning
operator station on to the local area network (see Chart Type Mirroring on page 535).

• Cancel Changes: Click the button to cancel the changes. Cleaned up or removed
databases cannot be brought back.

• Apply Changes: Click the button to write the changes to the hard disk. In order for
these changes to take place you will need to restart the system.
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20.7.9.1 New Chart Type

Use the buttons in this menu to add a new entry to the database list; each database you
select will be added with a default name and mnemonic.

The path to the menu is: Chart→Reconfigure Chart Databases→Add New.

The menu contains buttons for different types of chart databases:
• ARCS Database: This option is not available when you are in the radar application.
• Seafarer Database: This option is not available when you are in the radar application.
• C-Map CM-93 Edition 2 Database: Add a new database for CM-93 Edition 2 charts.

Note that this is the OLD C-Map format which is now rarely used. The main reason
for using this is to provide charts for old DataBridge2000 radars.

• C-Map World CM-93E3 (CD): This is the main C-Map unofficial chart database,
providing coverage worldwide with vector data.

• C-Map Professional+ (DVD): This is the same as the C-Map World database above.
However, due to the additional space on the DVD, this database contains additional
charts and other material.

• C-Map ENC: These are official charts from hydrographic offices but they are
distributed by C-Map as so-called “SENC”.

• Jeppesen PRIMAR: This is a combination of C-Map and official ENC charts.
• S57 Edition 3 Database: This database type should be used if you receive

unencrypted S57 data from a hydrographic office. You should normally have one
database for each separate distribution.

• S63 Database (PRIMAR/AVCS): Add a new database for installing chart data
encrypted according to the S63 formula. You should normally have one database
for each separate distribution.

• DNC Database (NIMA): Add a new database for storing charts belonging to the
DNC product. You should have one separate database corresponding to each DNC
region. Please note that DNC databases require a special pincode from Kongsberg
Maritime in order to be used.

534 381287/A



Reference Guide

• ARCS Demonstration Database: This option is not available when you are in the
radar application.

20.7.9.2 Chart Type Mirroring

This dialog enables you to mirror (in other words, copy) charts from a remote Radar,
ECDIS or Planning operator station on to another operator station via the local area
network.

The path to the dialog is: Chart→Reconfigure Chart Databases→Change Mirror.

To designate the computer you are currently working at as the host for a mirroring
operation (in other words, to designate it as the repository of the source database), check
Use as Mirror Host.

To mirror charts from a remote operator station, select Install from Remote Station, then
select the source station from the drop-down list.

If you simply want to install the chart database from a locally mounted CD, select Install
from Local CD.

Note

To select a remote station as a source for chart mirroring, you must make sure the remote
station is operational and visible on the network.
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20.7.10 Install C-Map SDK

Use this menu to install the C-Map Software Develpment Kit (SDK) into the system.

The path to the menu is: Chart→Install C-Map SDK.

The C-Map SDK installation dialog allows either eToken licensing or the traditional
licensing using a computer "fingerprint" file. eTokens are hardware dongles obtained
from C-Map and plugged into a USB port on the computer.

When eTokens are used, C-Map require you to report the number of the eToken to them
if you want to obtain a licence. When a “fingerprint” file is used instead, the "fingerprint"
file ("user.usr") must be e-mailed to C-Map.

SM: Insert the serial number of the system here. The serial number is found on the
left-hand side, inside the console. Select Reinitialize Licence to enter the serial number.

Reinitialize Licence: Select to allow the serial number to be entered.

Install: Click to install the C-Map SDK into the system.

Note

When you click Install with Reinitialize License checked, your current license code will
become void and you will need new codes from C-Map.
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20.8 Radar menu
The menus and sub-menus described in this section enable you to:
• Set parameters for tuning and noise suppression in the radar video. (For help

understanding the concepts involved, see Concepts of video enhancement on
page 743.)

• To monitor the performance of the transceiver (see Performance Monitor on
page 540).

• To monitor the elapsed hours of operation of the Magnetron unit (see Hours count
on page 541).

20.8.1 (Decca) Radar

This dialog enables you to set parameters for tuning and noise suppression in the radar
picture.

To see this dialog, click the Radar button on the main menu.

The dialog contains the following elements:
• Tune (Auto): Select if you want automatic radar tuning. (This is normally checked.)
• Tune indicator: This indicator shows how well the radar receiver is tuned in relation

to the transmitter. To adjust the tuning manually, see Radar dashboard: the Radar
System Information panel on page 83.

• Source: Click this button to select the Decca radar transceiver that is to be used with
the K-Bridge Radar (see Radar Control on page 539).

• Performance Monitor: Used to check the sensitivity of the transceiver. (see
Performance Monitor on page 540).

• Video Contrast: Sets the contrast between weak echoes and the background. The
range is from zero (the lowest contrast with the background) to 10 (the highest
contrast with the background). If you specify the:
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– Highest contrast, all correlated echoes are shown with the same high contrast. This
gives you the best visibility of weak targets, especially on a bright day. But any
clutter present is also shown with the a high intensity.

– Lowest contrast, weak echoes are shown with a lower intensity than the strong
ones. And clutter is shown with lower intensity than strong targets. This makes it
easier to operate with small amounts of clutter present.

For an explanation of the concepts behind the following options, see Concepts of video
enhancement on page 743:
• Sweep correlation: Reduces the effect of electrical noise (such as interference from

other radar transmitters) on the video displayed. Turn sweep correlation on and off
by checking and un-checking the box.

• Sweep integration: Consolidates the results of all radar pulse repetitions that have
occurred during a single antenna rotation to give the best quality video display. Turn
sweep integration on and off by checking and un-checking the box.

• Scan correlation: Compares video from the current antenna rotation with video from
previous rotations and uses a lower intensity to display targets that are not present in
all the rotations. By default, this feature is on when you have true trails displayed, and
off when you have relative trails displayed. Turn this feature on and off by checking
and un-checking the box.

• Hide uncorrelated: Click this button (and continue to hold it down) to hide echoes
that do not appear in all scans when scan correlation is on. The effect is to clean up
the display. To see the echoes again, release the button. (For more information, see
Video Enhance on page 643.)

• Stretch: Check the box to enable range stretching. This makes smaller echoes easier
to see on the radar video (see Video Enhance on page 643).

• Enhance: Check the box to enable video enhancement (see Video Enhance on
page 643).

• Hours count: Click this button to monitor the elapsed operational time of the radar's
Magnetron unit (see Hours count on page 541).
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20.8.1.1 Radar Control

This dialog enables you to select the radar transceiver to be used with the K-Bridge
Radar. You can also use it to start the transceiver and to configure the pulse length.

The path to the dialog is: Radar→Source.

You can also bring up this dialog by clicking the Scanner/Transceiver button on the
dashboard (see Radar dashboard: the Radar System Information panel on page 83).

The dialog contains the following elements:
• Select: Select the radar transceiver you want to use. For more information, see
Selecting the transceiver for a display unit on page 106.

• Power: Select to power on the selected radar transceivers. (Power off by unchecking
the radio button.) It is not possible to switch power off for a radar that is used by
an other display unit. There is a warm-up period of about three minutes before the
transceiver starts to rotate. This is to allow the Magnetron unit to warm up. The text
and colour of the Scanner/Transceiver button indicate when the transceiver is warming
up (see Radar dashboard: the Radar System Information panel on page 83).

• Ready: Indicates if the transceiver is ready to transmit or not. The warm-up time from
when the power is switched on is about 3 minutes.

• Pulse: The pulse length is normally set to the default value for the selected range. If
you have master control of the radar, you can override this default and specify short,
medium or long as the pulse length.

• Locked: Locks the selected pulse length so the pulse length will not be changed with
the range. This is indicated by a yellow background colour on the radar softkey. The
pulse length is unlocked if another transceiver is selected, Master is changed to Slave,
StandBy is selected, or the transceiver is switched off.

• Master: Select to give the display unit you are using master control of the chosen
transceiver. (For more information, see Making the display unit master of the
transceiver on page 107).
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• Slave: Check to make the display unit you are using a slave in relation to the selected
transceiver (another display unit is master). The new slave status is indicated on the
Scanner/Transceiver button in the Radar System information panel of the dashboard
(see Radar dashboard: the Radar System Information panel on page 83).

• Run: Select to take the radar transceiver from standby to run. Switching to Run
requires Master status.

• Standby: Select to take the radar transceiver from run to standby. Switching to standby
requires Master status. In a standby state, the Magnetron is kept at its operating
temperature and the transceiver is powered, but the radar antenna does not rotate.

20.8.1.2 Performance Monitor

This dialog enables you to check the performance of the selected Decca radar transceiver
(to see it you have to have a Decca radar transceiver connected).

The path to the dialog is: Radar→Performance Monitor.

The dialog contains the following elements:
• Mode Off/RX/System: Select one of the modes for performing monitor.

– In RX mode only the receiver of the performance monitor is used, i.e. the
performance of the radar transmitter is tested.

– In System mode the performance of both the transmitter and receiver is tested.
• PM Tune: Use the slider for gross adjustment and the up/down controls for fine

adjustment during PM tuning.
• Text window: The text windows displays extra information.
• Text field: The text field displays extra information.
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20.8.1.3 Hours count

This dialog enables you to check the elapsed hours of operation of the radar's Magnetron
unit.
The path to the dialog is: Radar→Hours Count.
The dialog contains the following elements:
• Radar Name: Displays the name of the radar that is connected via the RIC/TIC. When

no radar is connected, a “No radar connected” message is displayed..
• Operated Time: Displays the elapsed operational time of the Magnetron in hours or

days. If you click the Edit button (see below) you can also use this field to enter a
value for the elapsed operational time manually.

• Expected Lifetime: Displays the expected lifetime of the Magnetron. If you click
the Edit button (see below) you can enter a value for this field manually. If you set
it to zero, the next two fields disappear.

• Remaining Time: The difference between the expected lifetime and the elapsed
hours of operation of the Magnetron. If the lifetime has expired, a negative number
is displayed.

• Remaining Time bar: A graphical presentation of the elapsed time of operation and
the expected lifetime of the Magnetron. The elapsed time is represented by a green
bar when 0% - 90% of the expected lifetime has elapsed; it is shown by a yellow bar
when 90% - 100% of the expected lifetime has elapsed; and it becomes red when
more than 100% of the expected lifetime has elapsed.

• Edit: Click this button to enter manual values for the Operated Time and the Expected
Lifetime fields. (This button is displayed only when a user password has been
entered.) When you click this button to make the Operational Time and Expected
Lifetime fields edit-able, the Apply and Cancel buttons are displayed.

• Apply: This button only appears if you click the Edit button (see above). It applies the
values you have entered for the Operated Time and Expected Lifetime fields.

• Cancel: This button only appears if you click the Edit button (see above). It cancels
any values you have entered for the Operated Time and Expected Lifetime fields. It is
only effective as long as you have not clicked the Apply button already.
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• Hours/Days: These radio buttons toggle between hours and days as the units of
measurement for the elapsed and remaining time.
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20.9 Tools menu
The menus described in this section enable you, amongst other things, to:
• Add parallel index lines to the radar display to use as general purpose navigational

guides.
• Specify a turn (using the curved EBL tool) and then use it directly as input to the

autopilot.
• Convert geographical positions that are specified according to different geodetic

datums.
• Find a point at which to intercept a radar target.
• Use various timers, speed and distance calculators, and distance measuring tools.
• Design and add graphical objects to radar targets or to the own-ship symbol.

This is the main Tools menu.

To see it, click the Tools button on the main menu.

The menu contains some or all of the following buttons, depending on the application
you view it from:
• Marker Position: Click to display the geographic position of the marker (see Marker
Position on page 544).

• Marker Range and Bearing: Click to display the marker's bearing and range from the
own-ship (see Marker Range & Bearing on page 545).

• EBL/VRM: Click to set up and display an Electronic Bearing Line (EBL) and a
Variable Range Marker (VRM) on the chart (see EBL/VRM on page 545).

• EBL/VRM (Advanced): Click to use the advanced features of the EBL and VRM
facilities (see EBL/VRM Advanced on page 546).

• Curved EBL: Click this button to specify (and then perform) a turn using the curved
EBL tool (see Curved EBL on page 547).
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• Parallel Index Lines: Click this button to use parallel index lines as navigational
guides (see Parallel Index Lines on page 548).

• Position Line: Click this button to calculate own-ship's position using the bearing to
two or three objects with known positions (or using the bearing to objects shown in
the chart; see Position Line on page 549).

• Position Fix: Click to display position fixes from different sources (see Position
Fix on page 550).

• Datum Conversion: Click this button to convert positions specified according to
different chart datum schemes (see Datum Converter on page 551).

• Marker Position in Other Datum: Menu to display the marker and own-ship's position
in a chosen datum (see Marker Position in other datum on page 552).

• Distance Measure: Click this button to measure the distance from a reference point on
the own-ship to a specified position or object (see Distance Measure on page 554).

• Trip Meter: Click this button to find out the distance you have already sailed on a
voyage or the distance that remains to be sailed of the voyage (see Trip Meter on
page 555).

• Stopwatch: Click this button to use the stopwatch and countdown facilities (see
Stopwatch on page 556).

• Time/Distance/Speed Calc: Click this button to calculate the vessel speed for a
planned voyage (based on time and distance), the distance to be covered (based on
time and speed), or the time the journey will take (based on speed and distance); (see
Time/Distance/Speed Calculator on page 557).

• Target Interception: Click this button to find a point at which to intercept or
rendezvous with a radar target (see Target Interception on page 558).

• Find Place Name: Menu used for browsing to a specified place name on the chart
(see Find Port on page 560).

20.9.1 Marker Position

This dialog displays the marker (that is, the cursor) position in latitude and longitude.

The path to it is: Tools→Marker Position
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20.9.2 Marker Range & Bearing

This dialog displays the bearing and range of the marker (that is, the cursor) from the
own-ship

The path to the dialog is: Tools→Marker Range and Bearing

In addition the dialog contains the following element:

m: Select to display range in meters. When not selected range is displayed in nautical
miles.

20.9.3 EBL/VRM

This dialog enables you to set up and display an EBL and VRM. There are three
EBL/VRM pairs available. Each pair is identified by a number at the base of the EBL.

The path to the dialog is: Tools→EBL/VRM

The dialog contains the following elements:
• No: Displays EBL/VRM number.
• From: Position at the base of the EBL/VRM.
• To: Position at the intersection between the EBL and the VRM.
• New: Click the button to create a new EBL/VRM.
• Delete: Click the button to delete the current EBL/VRM.
• Apply: The displayed bearing and range can be edited numerically. Click Apply

to enter new bearing and range values.
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20.9.4 EBL/VRM Advanced

This dialog enables you to set up and display an EBL and VRM using more advanced
features (for example, using Great Circle or Rhumbline geometry).

The path to the dialog is: Tools→EBL/VRM (Advanced).

The dialog contains the following elements:
• No: Displays EBL/VRM number selected in the chart, or specified by using the

up/down arrows.
• From: Position at the base of the EBL/VRM. Edit position as required and click

Apply to activate.
• To: Position at the intersection between the EBL and the VRM.
• New: Click the button to create a new EBL/VRM.
• Delete: Click the button to delete the current EBL/VRM.
• Bearing and range of EBL/VRM: Edit bearing and range as required and click Apply to

activate.
• Great Circle: Select to specify EBL/VRM with Great circle geometry.
• Rhumbline: Select to specify EBL/VRM with Rhumbline geometry.
• Meter: Select to display range in meters. When not selected range is displayed

in nautical miles.
• Datum: Select WGS-84 or Local datum.
• Local: Pressing this button allows you to select a datum from a list of commonly used

datums. If you select a local datum, the name will be shown as the button text (instead
of “Local”). See section Datum Converter on page 551 for more information.
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20.9.5 Curved EBL

Use this dialog to specify a turn and then use it as input to the autopilot.

The path to the dialog is: Tools→Curved EBL.

In Radar, the dialog includes the Trial Manoeuvre facilities which enable you to test
whether a turn can be executed without danger of collision (see Trial Manoeuvre and
Curved EBL on page 473).
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20.9.6 Parallel Index Lines

Use this dialog to set up parallel index lines.

The path to it is: Tools→Parallel Index Lines.

Four parallel index lines are available. For more information, see Using parallel index
lines on page 304.

The dialog contains the following elements:
• ID: Parallel index line number.
• Distance: The distance from the own-ship's conning position to each parallel index

line.
• Bearing: The bearing of the parallel index line.
• Length: The length of the parallel index line.
• Mode: True or relative bearing. The parallel index line will turn with the ship when

relative mode is selected.
• Truncate: To truncate a parallel index line, select it in the display (by using the

track-ball and Left mouse button), check Truncate in this dialog, then click the Left
mouse button at the point on the line where you want it to end.

• New: Creates a new parallel index line.
• Delete: Deletes the selected parallel index line.
• Apply: Applies the details specified in the fields above.
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20.9.7 Position Line

This dialog enables you to estimate the own-ship's position using the bearing to two
or three known fixed positions; one or more of the known fixed positions can be of
an object displayed on the chart.

This dialog provides a fall-back method for estimating the own-ship's position if the
main positioning system fails for any reason.

The path to the dialog is: Tools→Position Line

For instructions on using the Position Line dialog, see Using position lines to estimate
the own-ship's position on page 306.

The dialog contains the following elements:
• Two Points: Select this radio button if you want to estimate the position using two

reference points.
• Three Points: Select this radio button if you want to estimate the position using

three reference points.
• Table: Table of parameters for two or three position lines. Edit Bearing, Latitude, and

Longitude as required.
• New Bearing: Click to add a position line record with a new time stamp, then specify

the bearing (in degrees) to a known position.
• New Range: Click to add a position line record with a new time stamp, then specify

the range (in Nautical Miles) to a known position.
• Redo: Click to redo the last measurement.
• Get Cursor: Click the button and point to an object in the chart to identify the position

of the object. This is an alternative to filling in the latitude and longitude fields.
• Intersection: The calculated position (in other words, where the lines intersect).
• Clear All: Click the button to clear all measurements in the table.
• Define Position Fix: Click the button to define a position fix from the calculated

intersection.
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20.9.8 Position Fix

This dialog displays position fixes from different sources.

The path to the dialog is: Tools→Position Fix

The dialog contains the following elements:
• Fix Type: The source of the position fix. The following are available:
• Dead reckoning
• Visual
• Astronomical
• Radar
• GPS
• Glonass
• Loran/Tchaika
• MFDF
• Transit/Tchaika
• Diff.: Select if the position was received from a differential position sensor.
• Table: Table showing the different position fixes including time, latitude, longitude,

fix type, offset and bearing from ship position. Scroll table to show all fields.
• New: Click to get a new position fix entry in the table.
• Get Cursor: Click to fill in the latitude and longitude fields from the cursor position.
• Offset Ship: The ship is given a manual offset to correspond with current position fix.
• Delete: Click the button to delete the position fix record.
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20.9.9 Datum Converter

This dialog enables you to convert a position specified according to one datum to a
position specified according to another. One of the datums has to be WGS84, which is
the required operating datum for an ECDIS or radar system that is presenting charts.
The path to the dialog is: Tools→Datum Converter.
The dialog contains the following elements:
• Datum Parameters: Use the drop down list to select the actual geographical datum

to convert to or from. The possible datums are included in the list (see Datum
Parameters (drop-down menu) on page 552).

• Valid Area: Shows the limitations of validity in Lat / Lon for the selected datum. Some
are world-wide, others are valid (properly defined) only for a region of the world..

• Conversion: Select one of the following to convert datums.
• 1. Datum->WGS84: Select if the conversion will be from the selected Datum to

WGS84.
• From: Enter the position in the selected datum as 59.05.123N and 010.33.650E, or
• Convert: Click to initiate the calculation.
• WGS84: The corresponding position in WGS84 appears after the calculation.
• 2. WGS84-> Datum: Select if the conversion will be from WGS84 to the selected

datum.
• WGS84: Enter the position in the WGS84 as 59.05.123N and 010.33.650E.
• Convert: Click to initiate the calculation.
• To: The corresponding position in the selected datum appears after the calculation.
• Status Line: Shows the result of the calculations as:

– Conversion OK! The position is converted.
– Point outside valid datum! The position is converted based on the equations for the

selected datum, but it is outside of the region where the datum is valid.
– Please select datum: No datum has been selected.
– Cannot convert (outside area?)! The position conversion gave an illegal result,

probably because the point is outside the valid area.
– Bad input coordinates! The position is not entered as a legal position.
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20.9.9.1 Datum Parameters (drop-down menu)

Datum Parameters: A list of possible datums is displayed when you use the drop down
menu in the Datum Converter dialog (see Datum Converter on page 551).

20.9.10 Marker Position in other datum

Use this dialog to show the marker position and the current own-ship's position in the
selected datum.

The path to the dialog is: Tools→Marker Position in Other Datum.

The dialog contains the following elements:

WGS-84: Select to display the marker position and the current own-ship's position using
WGS-84.

Datum: Select to display marker and current own-ship's position using EUR-7. Click the
EUR-7 button to go to the Datum Converter dialog (see Datum Converter on page 551).

Format: Click this button to specify the format for presenting coordinates in the MFD
dialog boxes (see Coordinate format dialog on page 553).
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20.9.10.1 Coordinate format dialog

This dialog enables you to specify the format for the presentation of coordinates in
the MFD dialog boxes.

The path to the dialog is: Tools→Marker Position in Other Datum→Format.

The Coordinate Format dialog allows you to choose between the following alternatives.
You can:
• Select one of several different Latitude/Longitude formats.
• Use Universal Transverse Mercator coordinates by selecting UTM Zone and

specifying the appropriate zone number.
• Use a Cartesian Coordinate Grid and specify an origin for it. This will give you

distances (measured in NM) North and East of the specified origin.
• Specify Bearing/Range from Own Ship. This will give you bearing and range

measurements in NM from the current position of the own-ship.

The lower part of the dialog (labelled Conversion) allows you to convert between
common WGS 84 latitude/longitude coordinates and the same coordinates according
to according to another datum.

To specify the target datum, click Datum and select the datum you require.

To convert from WGS84 to the specified datum, type the WGS84 latitude and longitude
coordinates opposite the label WGS84:.

To convert from the specified datum to WGS84, type the latitude and longitude
coordinates according to the specified datum opposite the label Datum:.
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20.9.11 Distance Measure

This dialog enables you to measure the distance from a reference point on the own-ship
to a specified position or object.

The path to the dialog is: Tools→Distance Measure.

The dialog contains the following elements:
• From: Use this drop-down menu to select the reference point on the own-ship. By

default, the measurement is taken from the Conning position.
• Detect: Specify whether the terminal point of the distance to be measured is the

position of a chart object, target or mariners' note.
• Read-only field: This field displays the number of the chart, target or mariners' note

whose position represents the terminal point for the distance measurement.
• To: This field displays the coordinates of the selected object. If you are measuring

the distance to a specific position (and not to a chart object, target or note), enter
the coordinates here, and click Apply.

• Apply: Click this button after entering the coordinates of a position that you want to
specify as the terminal point for the distance measurement.

• B/R: Specify the bearing and range to the terminal point of the distance measurement.
• TCPA: This is the Time to the Closest Point of Approach. In other words, it is the

time it will take for the own-ship to sail to the object, target note or specified position.
• New: Click this button to create a new instance of distance measure tool. A maximum

of five tools can be generated. After clicking the New button, you can specify the
destination position with the cursor. If the Chart/Target/Notes boxes are checked,
a “gravity” field is enabled around all objects of the specified kind on the display
making the selection easier.

• Delete: Clicking this button deletes the current instance of the distance measure tool.
• Meters: This field toggles between nautical miles and meters as the unit of

measurement.
• Display text: Click this box to display bearing and range information.
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20.9.12 Trip Meter

This dialog enables you to measure:

• The distance travelled for a particular journey (from the time you started the trip
meter).

• The distance that remains to be travelled for a journey of a specified distance (from
the time you started the trip meter with the Count down button checked).

To reach this dialog, select: Tools→Trip Meter.

The dialog contains the following elements:
• Start/Stop: Press the Start button to start the trip meter. When you have started it, this

button becomes a Stop button.
• Reset: Press the upper Reset button to reset the trip meter to 0.00.
• Count down: Check this box to use the trip meter's countdown function. Then type

into the upper distance field the total distance you want to count down from. When
you click Start, the trip meter starts counting down the distance in nautical miles.

• Split: Press this button (while the trip meter is running) each time you want to record
a split distance. Use the arrow buttons to review the split distances.

• Reset: Press the lower Reset button to reset the split distance to 0.00.

For more information about the trip meter and distance countdown facilities, see Using
the trip meter on page 323.
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20.9.13 Stopwatch

This dialog provides a stopwatch and countdown function.

The path to the dialog is: Tools→Stopwatch.

The dialog contains the following elements:
• Start/Stop: Press the Start button to start the stopwatch. When you have started the

stopwatch, this button becomes a Stop button.
• Reset: Press the upper Reset button to reset the stopwatch to 00:00:00.00.
• Count down: Check this box to use the countdown function, then type into the upper

time field the number of hours, minutes and/or seconds you want to count down
from. When you click Start, a clock is displayed in the upper time field, counting
down in seconds.

• Split: Press this button (while the stopwatch is running) each time you want to record
a split time.

• Reset: Press the lower Reset button to reset the split time to 00:00:00.00.

For more information about the stopwatch and countdown facilities, see Using the
stopwatch and countdown facilities on page 321.
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20.9.14 Time/Distance/Speed Calculator

This dialog enables you to calculate the following:
• The time it will take to travel a specified distance at a specified speed.
• The distance that will be covered in a specified time at a specified speed.
• The speed that must be maintained to travel a specified distance at a specified speed.

To reach this dialog, select: Tools→Time/Distance/Speed Calc.

The fields and checkboxes in this dialog are as follows:
• Time: Specify the time you require the journey to take in this field.
• Distance: Specify the intended distance in this field (check the 'm' box if you want

the calculator to use metres instead of nautical miles).
• Speed: Specify the desired speed in this field (check the 'm/s' box if you want the

calculator to use meters per second instead of knots).

The buttons in this dialog are as follows:
• Time: Enter values for the distance and speed, then click the Time button.
• Distance: Enter values for the speed and time, then click the Distance button.
• Speed: Enter values for the time and distance, then click the Speed button.

For more information about the time, distance and speed calculator tool, see Calculating
the time, distance and speed for a journey on page 322.
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20.9.15 Target Interception

This dialog enables you to use the cursor to select a target and calculate a point at which
to intercept it (see Identifying a target interception point on page 318).

The path to the menu is: Tools→Target Interception.

The buttons, options and fields available in the Target Interception dialog are:
• Select Target: Press this button to activate the Target Interception function. When

you have selected a target, the dialog changes: the Select Target button becomes a
Stop Tracking button (see below), and the fields of the dialog are populated with IP
(Interception Point) data for the selected target.

• Text field: This field contains the name of the target.
• Stop Tracking: Press this button to stop tracking the target.
• Fixed speed: The own-ship speed you want the calculation of the interception point

to be based upon.
• Vessel speed: Select this option to use the own-ship's current speed (instead of entering

a fixed speed) for the calculation of the interception point.
• Rng m: Check this box to use metres (instead of nautical miles) as the unit of

measurement.
• Relative Range This field is for calculating a relative target interception point (in other

words, for calculating what the interception point would be if the target's position
were different). Specify the range relative to the target's actual position. Using the
spin buttons for this field causes an EBL/VRM to be displayed with its centre on the
selected target. Use the mouse or track-ball and left mouse-button to re-size the
range circle and drag the bearing line (see Identifying a target interception point
on page 318).

• Relative Bearing: Specify the bearing relative to the target's actual position. Using
the spin buttons for this field causes an EBL/VRM to be displayed with its centre on
the selected target. Use the mouse or track-ball and left mouse-button to re-size the
range circle and drag the bearing line (see Identifying a target interception point
on page 318).
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• R. Pos/Cancel: Click the R. Pos (Relative Position) button to display an EBL/VRM
with its centre on the selected target. If you are using the EBL/VRM method, use the
mouse or track-ball and left mouse-button to re-size the range circle and drag the
bearing line. For more information about using the EBL/VRM to specify a relative
target position, see Identifying a target interception point on page 318).

• Apply: Click this button to accept the defined relative target position and start
calculating the relative target interception point (the calculation is based on the range
and bearing you have specified from the target's actual position).

• Target speed: The speed at which the target is travelling.
• Range: The distance to the target interception point.
• Course to steer: The course to steer for the target interception point.
• Estimated time: The estimated time before the own-ship arrives at the interception

point.
• System message text field: If the system is not able to compute a target interception

position, it displays a system message at the bottom of the dialog
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20.9.16 Find Port

This dialog enables you to specify a place name to browse to in the chart.

The path to the dialog is: Tools→Find Place Name.

The dialog contains the following elements:
• Ports Only: Check this radio button to limit the search to port names in the database.
• All Places: Check this radio button to extend the search to all land and sea location in

the database.
• Search: Type the first letter or the first few letters of the place name in this field, then

click the Search button to start your search.
• Country: Lists the countries in the database. Select one to limit your search to that

country.
• Port: Lists the ports available in the database.
• UN/Locode: This field provides the UN/Locode for the specified place name.

UN/Locodes are city designations that were suggested by a committee of the United
Nations to improve the efficiency of international transportation. The codes are
similar and partly compatible with the airport codes used by air passengers for tagging
luggage.

• Latitude: The latitude of the specified place.
• Longitude: The longitude of the specified place.
• Go To: Click this button to go to the specified place in the chart display.
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20.10 System menu

This is the main System menu. It gives you access to various system setup, maintenance
and configuration facilities (many of which do not appear in the menu unless the service
password has been entered).
To see the menu, click the System button on the main menu.
The menu contains some or all of the following buttons, depending on the application
you view it from:
• Date and Time: Click this button to configure the time on this and other operator

stations on the network (see Date and Time on page 563).
• Parameter Settings: Click this button to set default parameters for route planning and

to view own-ship data such as the vessel's precise conning position (see Parameter
setup on page 565).

• Preset Parameters: Click this button to view and manage the system parameter sets
(see Preset Parameters on page 585).

• Print Screen: Click this button to capture the contents of the display; the Printer
dialog comes up so that you can send the screen capture to the printer (see Printer
on page 590).

• Printer: Click this button to view the list of items currently available to be sent to the
printer (see Printer on page 590).

• Passwords: Click this button to enter a password to access restricted functions (see
Password on page 593).

• Maintenance: Click this button to upgrade system software, perform back-ups (or
restorations from back-up) of route and parameter data, and to monitor the Transceiver
Interface Control board and Radar Interface Card (seeMaintenance on page 594).

• LAN Communication: Click this button to view the status of the Local Area Network
(LAN) and configure the LAN (see LAN Status on page 609).

• Device configuration: Click this button to view, configure and monitor the data
interfaces on the operator station (see Device configuration on page 612).
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• Sensor Configuration: Click this button to view and configure sensors (see Number of
Sensors on page 617).

• Radar Configuration: Click this button to view and configure the radar transceiver
(see Radar Configuration on page 641).

• Autopilot Configuration: Click this button to set configuration parameters for the
autopilot system (see Autopilot Configuration on page 658).

• Integration Configuration: Click this button if you want to specify a Navigation Master
console (which will calculate the position, speed, heading and time for all K-Bridge
consoles on the network (see Integration Configuration on page 659).

• ARP Configuration: Click this button to check – and if necessary reset – the mouse
and keyboard connected to an Arm Rest Panel for remote control of an operator
station ARP (Arm Rest Panel) Configuration on page 662

• Route Export Configuration: Click this button to set the system up to perform route
import and export exchanges with another system (see Configure Route Export on
page 661).

• Shutdown: Click this button for a choice of shutdown switch-over operations (see
Shutdown on page 664).

• About K-Bridge: Click this button to view corporate information.
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20.10.1 Date and Time

This dialog enables you to specify one of the following:
• The time zone for the MFD unit if the time source used by the MFD is the System

Clock.
The System Clock runs in the K-Bridge Sensor Integrator (SINT). The SINT receives
the time from a GPS sensor and transmits it to the K-Bridge operator stations over
the local area network.

• A new local time (specified as an offset to the current UTC time) if the time data is
received directly from the time sensor as an NMEA (“ZDA”) message time.

The path to the dialog is: System→ Date and Time.
The dialog contains the following elements:
• Update Remote: Sends the current UTC time on the operator station to any other

K-Bridge operator stations on the local area network.
• Current Time (UTC): Current UTC time (UTC is the international abbreviation for

Universal Coordinated Time).
• Current Time (Local): The current time in the local time zone.
• Adjust Offset: If you have selected:

– System clock in the Time Sensor section, specify the local time zone. The time zone
you specify will automatically be propagated to all other K-Bridge navigation
operator stations (and any K-Bridge Autopilot operator panels) on the bridge.

– Sensor No. in the Time Sensor section, use the up and down buttons or the keyboard
to specify the difference between UTC and the current local time.

• Apply: Click this button to apply any offset you have specified.
• Synch: Check this box to synchronise the UTC and local offset on this operator station

with incoming NMEA messages from the GPS. (Use this option if the operator station
is not part of an integrated K-Bridge navigation system.)

• System clock: Check this radio button if you are using a K-Bridge integrated
navigation system on the bridge. In this case, your time source is the system clock in
the K-Bridge Sensor Integrator (SINT) which receives the time from a GPS sensor
and distributes it to the operator stations.
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• Sensor No.: Check this radio button if the time source for the MFD unit is not the
system clock in the K-Bridge SINT. Then select a time sensor from the drop-down
list. (In this case, there needs to be a serial port configured on the MFD unit to receive
the NMEA (“ZDA”) time message (see Number of Sensors on page 617).

• Show (Hide) NMEA: Click the button to display the NMEA time message. (This
button is used by service engineers for troubleshooting.)
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20.10.2 Parameter setup
This dialog contains several tabs which enable you to set initial parameters: for
representing the own-ship in the display, for route planning, and for recording and
displaying route information. The parameters include the ship's dimensions and its
default turn radius and off-track limit.
The path to the dialog is: System→Parameter Settings.
The dialog contains five tabs:
• Display (see Display tab on page 565).
• Route (see Route (tab) on page 570).
• Ship (see Ship (tab) on page 571).
• Track (see Track tab on page 573).
• Voyage (see Voyage tab on page 577).

20.10.2.1 Display tab

This tab enables you to configure how the own-ship is represented in the chart display,
and also when and how chart regeneration is performed.
The path to this tab is either of the following:
• System→Parameter Settings→Parameter Setup (Display tab).
• Own-ship→Ship Parameters→Parameter Setup (Display tab).

The Radar Display tab
The tab contains the following elements when viewed from the Radar application:
• Predict Ship Movement: Check this option to display a graphical prediction of the

ship's movement in the immediate future (the prediction is based on current heading,
speed and rate of turn). You must have the Display Ship Outline option checked in
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the Radar Themes dialog (see Radar Themes on page 371) to view the predicted
movements: they appear when the range scale is large enough for the scaled outline of
the ship to be displayed.

• Setup: Click this button to configure parameters for displaying the ship's predicted
movement (see Ship's movement predictor setup dialog on page 568).
For instructions about displaying the ship's predicted movements, see Displaying the
own-ship's predicted movements on page 317.

• Depth Unit: Click to select meters, feet or fathoms.
• Height Unit: Click to select meters or feet.

The ECDIS Display tab

The tab contains the following elements when viewed from the ECDIS application:
• Own Ship Display:

– Ship Vector: Specify the length of the own-ship's course/speed vector in seconds.
– Ship Bearing Line: Specify the length of the own-ship's bearing line in nautical

miles.
– Display Ship Outline: Check this option to display the own-ship as a skeleton ship

symbol that reflects the ship's true proportions at large range scales:

Un-check the Display Ship Outline option to display the own-ship as a simplified
symbol formed by two concentric rings at whatever chart scale is in use:

– Use Template '$$OwnShip' as Outline: When you enable this option (with the
Display Ship Outline option checked), the skeleton ship symbol is replaced by
whatever shape is defined in the '$$OwnShip' template. For information about
defining templates, see Defining the template on page 227.
When you use your own design for the own-ship symbol on the chart display, the
Ship Length and Ship Width parameters defined in the Ship tab of the Parameter
Setup dialog (see Ship (tab) on page 571) do not affect the proportions of the
displayed symbol.

– Show Heading Line: Select to display the own-ship's heading line in the chart.
– No Marks/One min./Six min.: You can display marks along the course vector,

indicating where the own-ship will be every one or every six minutes. Select No
Marks, One min. or Six min. as required. For an illustratrion, see Ship's movement
predictor setup dialog on page 568.
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– Predict Ship Movement: Check this option to display a graphical prediction of
the ship's movement in the immediate future (the prediction is based on current
heading, speed and rate of turn). You must have the Display Ship Outline option
checked to view the predicted movements: they appear when the range scale is low
enough for the scaled outline of the ship to be displayed.

– Setup: Click this button to configure parameters for displaying the ship's predicted
movement (see Ship's movement predictor setup dialog on page 568).
For instructions about displaying the ship's predicted movements, see Displaying
the own-ship's predicted movements on page 317.

• Change Regeneration Area: Click this button to configure the chart regeneration area
yourself.
When the system is operated in true motion the own-ship moves across the chart. As
it reaches the edge of the display the chart needs to be regenerated. To provide a better
overview you might want to control when the chart is regenerated; you can do this by
defining a regeneration rectangle (see Chart regeneration area on page 569).

• Depth Unit: Click to select meters, feet or fathoms.
• Height Unit: Click to select meters or feet.

The Conning Display tab

The tab contains the following elements when viewed from the Conning application:
• Depth Unit: Click to select meters, feet or fathoms.
• Height Unit: Click to select meters or feet.
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20.10.2.1.1 Ship's movement predictor setup dialog

This tab enables you to configure the display of the ship's predicted movement. You can
vary the number of predicted positions shown, the interval (in seconds) between them,
and the length (in seconds) of the ship's predicted “corridor” of movement.

The path to this tab is either of the following:
• System→Parameter Settings→Parameter Setup (Display tab)→Predict Ship

Movement→Setup.
• Own-ship→Ship Parameters→Parameter Setup (Display tab)→Predict Ship

Movement→Setup.

The tab contains the following elements:
• Number of Predicted Positions: Use the spin buttons to specify the number of predicted

positions you want to see.
• Interval Between Positions (sec): Use the spin buttons to specify the interval in seconds

you require between each predicted position.
• Ship Predicted Corridor (sec): Use the spin buttons to specify the length (in seconds)

for the corridor representing the ship's predicted movement.
• Apply: Click the button to apply the changes you have made to the ship's movement

predictor parameters.
• Cancel: Click the button to cancel all changes.

For further information, see Displaying the own-ship's predicted movements on page 317.
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20.10.2.1.2 Chart regeneration area

This tab enables you to configure the chart regeneration area.

The path to the tab is: System→Parameter Settings→Parameter Setup (Display
tab)→Change Regeneration Area.

The dialog contains the following elements:
• Min. Chart Ahead: The chart is regenerated when the distance ahead of the own-ship

is less that the set percentage.
• Fixed Border Offset: The chart is regenerated when the own-ship gets closer than the

set percentage from the edge. (In percent of the screen diameter).
• Moveable rectangle: Allows you to define each side of the rectangle individually. The

distance for left, right, top and bottom as specified below.
• Left/Right/Top/Bottom: Type distances for moveable rectangle
• Display and Edit Regeneration Area: Select to display the regeneration area in the

chart. The area can be resized by dragging the sides.
• Apply: Click the button to save the parameter set-up.
• Cancel: Click the button to cancel all changes.
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20.10.2.2 Route (tab)

This tab enables you to set some default own-ship parameters to simplify the task
of creating routes.
The path to the tab is: System→Parameter Settings→Route (tab).
The tab contains the following elements:
• Cruise Speed (kn): Set the default speed for routes.
• Max Speed (kn): Enter the own-ship's maximum speed.
• Default Radius (NM): Enter the default turn radius.
• Default Offtrack Limit (m): Enter a default off-track alarm limit.
• Route Distance Tags (NM): Set the distance between the distance tags in routes.
• For Remaining Distance: Select to display the remaining distance rather than the

sailed distance.
• WOP Preserve: Select to keep the Wheel-Over-Points (but not the Waypoints) fixed

when editing legs.
• Set Default: Return to the system's default parameters.
• WPT Name: Select to display WPT name/number when route is edited or active.
• Planned Speed: Select to display planned speed when the route is edited or active.
• Next Course: Select to display next course when the route is edited or active.
• Turn Point: Select to display turn point when the route is edited or active.
• Offtrack Limit: Select to display the off-track limit when the route is edited or active.
• Distance Tags: Select to display distance tags when the route is edited or active.
• Critical Points: Check both the Edited and Active check-boxes if you want to insert

critical points into a route.
• WOP Extension: Select to display extended line segments for aligning the WOP with

an object ahead of or athwart the own-ship.
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• Apply: Accept parameter changes done through the keyboard.
• Cancel: Cancel modifications done through the keyboard.

20.10.2.3 Ship (tab)

This tab contains own-ship-specific parameters that are
normally set at commissioning time and will not normally
need to be changed.
The path to the tab is: System→Parameter Settings→Ship
(tab).
The tab contains the following elements:
• Ship Name: Name of the own-ship.
• Ship Length: Total ship length.
• Ship Width: Maximum ship width.
• Max Ship Draught: Maximum ship draught when

loaded.
• Conning Pos: Conning or steering position, normally

on the centre line. For port use negative values.
• Pivot Point: The own-ship's pivot point, normally on

the centre line. For port use negative values.
• Min. Ship Turn Radius: The own-ship's minimum turning radius. The value is used

to validate routes.
• Max. Ship Turn Rate: The own-ship's maximum rate of turn. If an upcoming turn

exceeds this rate of turn, an alarm is given.
• Turn Accel. Length: Distance from Wheel Over Point to start of the turn * 2.0. This is

the same value that is called Acc (Acceleration) Length in the K-Bridge Autopilot
Operator Manual (see References on page 45).
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• Off-track Alarm Margin: The distance to be subtracted from the Cross-track Distance
limit before a Cross-track Distance alarm is issued. The distance you specify must
be at least the distance from the own-ship's pivot point to the outer edge of the hull.
This ensures that a Cross-track Distance alarm is triggered as soon as part of the
vessel crosses the XTD limit; in other words, it ensures that the alarm is not delayed
until the vessel's pivot point (which might, for example, be 15m from the edge of
the vessel) has crossed the XTD limit.

• ANTS on Validated Routes Only: When selected, only validated routes will be allowed
for use with the autopilot.

• Ref Pts: Click to view the ship's reference points such as its conning position and
pivot point (see Ship Reference Points on page 444).

• Apply: Accepts any text changes made using the keyboard.
• Cancel: Cancels any text changes made using the keyboard.
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20.10.2.4 Track tab

20.10.2.4.1 Position log control

This tab is for logging the vessel's position and controlling the behaviour of the vessel's
track as it appears in the radar display.
There are various paths to the tab through the user interface:
• System→Parameter Settings→Track (tab)

• View→Radar Themes→Own Ship Past Track→More→Track (tab)

• Own Ship→12hr Log Control

• Own Ship→Ship Parameters→Track (tab)

The following options are for configuring the behaviour of the vessel's track in the
display:
• Past Track Displayed (mins): Use the spin buttons to specify how many minutes of

track history you want to display.
• Past Track Label Interval (mins): Use the spin buttons to specify the interval between

past track labels.
The Position Log section of the tab contains the following fields, options, and buttons:
• Log Now!: Click to record the vessel's position at this moment.
• Save AIS and Arpa Targets: Check this box to record past track information for AIS

and Arpa Targets.
• Log Interval (min:sec): Use the spin buttons to specify the time between each logging

of data.
• Log since: The date and time of the oldest item in the log.
• Save to Folder: Click the button to save the logged data for the last 12 hours. The file

is saved in the voyage folder. After you save it, the name of the file is displayed
in the text field below.
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• Save As: Click the button to specify a target filename or to reduce the interval for
the log file. The Saving Position Log submenu will appear, as described in section
20.10.2.4.2.

• Lamp: Flashes when the position is recorded.
• Save to Medium: Click the button to save the log file on the selected device. Then Save

to the Selected Device submenu which will appear, as described in section 20.10.2.4.3.

The following buttons are also available:
• Apply: Click the button to apply the entered values.
• Cancel: Click the button to cancel the entered values.

574 381287/A



Reference Guide

20.10.2.4.2 Save as ... (Saving the position log)

This tab enables you to start, and also to save the results of, the position logging.

The path to the tab is: System→Parameter Settings→Track (tab)→Save As

The tab contains the following elements:
• File Name: Enter a file name here or use the default file name.
• Start time: Use the spin buttons to specify the start time for the log file.
• End time: Use the spin buttons to specify the end time for the log file.
• Log Interval: Time interval between each logging.
• Save AIS and ARPA Targets: Toggle this button On if you would like to save AIS and

ARPA targets together with the own-ship position. Note that saving other targets will
need much more storage than only own-ship data.

• Save to Voyage Folder: Click the button to save the log file.
• Cancel: Click the button to cancel the save operation.
• Apply: Click the button to apply the entered values.
• Cancel: Click the button to cancel the entered values.
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20.10.2.4.3 Save to Medium ... (Saving the position log to an external
medium)

This tab enables you to save the logged position data to a selected device. The log file is
sized to fit on the selected device. Depending on the log interval, the log file will store
from 12 hours to several days of position data.

The path to the tab is: System→Parameter Settings→Track (tab)→Save to Medium.

The tab contains the following elements:
• File Name: The log file name is constructed as follows:

For example L020218F was created 18th Feb. 2002. The default file name may
be modified.

• Start time: Use the spin buttons to specify the start time for the log file.
• End time: Use the spin buttons to specify the end time for the log file.
• Log Interval: Time interval between each logging.
• Save AIS and ARPA Targets: Toggle this button On if you would like to save AIS and

ARPA targets along with the own-ship position data. Note that saving other targets
will need much more storage than only own-ship position data.

• Save to Medium: Click the button to save the log file to the selected device.
• Cancel: Click the button to cancel the save operation.
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20.10.2.5 Voyage tab

This tab enables you to record the own-ship's track over the course of a single voyage.
There are three paths to the tab:
• System→Parameter Settings→Voyage (tab)

• Own Ship→Voyage Recording

• Own Ship→Ship Parameters→Voyage (tab)

This tab contains the following elements:
• Voyage Display Label Interval: Use the spin buttons to specify the interval between

past positions displayed with a text label.
• Voyage Recording Interval: Use the spin buttons to specify the interval between

recorded positions.
• Voyage Recording Control:

– Text field: Displays voyage recording status.
– Lamp: The lamp flashes when the position is recorded.
– Name: The name of the voyage recording file.
– Started: The date and time at which data recording for the voyage was initiated.
– Ended: The date/time of the end of a voyage recording. Only displayed when the

voyage is ended.
– Start New Voyage: Click to start a new voyage recording.
– Resume Voyage: Click to continue the last voyage recording.
– End Voyage: Click the button to stop an ongoing voyage recording.
– Voyage List: Click the button to display the Voyage Recording List dialog (see
Voyage Recording List and related dialogs on page 578).

• Apply: Click the button to save the parameter set up.
• Cancel: Click the button to cancel all changes.
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20.10.2.5.1 Voyage Recording List and related dialogs

Voyage Recording List

This tab enables you to view and manage the list of recorded voyages on the system.
There are two paths to this tab:
• System→Parameter Settings→Voyage (tab)→Voyage List
• Own Ship→Recording List

The tab contains the following elements:
• Sort On: Select to sort the list by name, type or time.
• Name/Type/State/Date: Each file is described by name, type of file (LOG or VOY),

state, date and file size.
• Display: Click to display the selected log or voyage recording file in the chart.

Clicking this button will automatically turn on the Voyage Recording theme in the
Chart Theme menu.

• Undisplay: Turns off display of the selected log or voyage recording.
• Show Text: (This button is not available when you are in the radar application.) In the

ECDIS application, you can click the button to see a text version of the selected log
or voyage recording file.

• Delete: Click to delete the selected file.
• Go To: Click the button to display the chart covering the starting point of the displayed

log/voyage recording.
• Backup: Click the button to save the selected file on the selected device. The Backup

Voyage Recording submenu will appear, as described below.
• Rename: Click the button to give the selected file a new name.
• Replay: Click the button to replay the log/voyage file displayed in the chart. The

Replay submenu will appear, as described below.
• Reload: Click to load a log/voyage file from the selected device. The Restore Voyage

Recording submenu will appear, as described below.
• Control: Click the button to display the Voyage Recording Control menu, as described

above.
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Voyage Recording List (text view) dialog

This dialog is for viewing logged voyage data as text.

The path to this dialog is: System→Parameter Settings→Voyage (tab)→Voyage List (Select
voyage) →Show Text

The dialog contains the following elements:
• File Name: The name of the log file you intend to view.
• Start time: Use the spin buttons to specify the start time for the part of the logged data

that you want to view as text.
• End time: Use the spin buttons to specify the end time for the part of the logged data

that you want to view as text.
• Log Interval: Optionally specify the time interval you require between the logged

items in the display.
• Print AIS and ARPA Targets: Check this box to include data about AIS and ARPA

targets in the text displayed. Be aware that this might produce a lot of output.
• Show as Text: Click this button to display the text version of the voyage file.
• Cancel: Click this button to return to the main Voyage Recording List dialog.

For more information about viewing the logged data as text, see Viewing the past track
or voyage log as text on page 327.
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Figure 110 Sample text view of a log
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Voyage Recording List (backup) sub-menu

This dialog enables you to save a voyage recording to the selected device.

The path to this dialog is: System→Parameter Settings→Voyage (tab)→Voyage List (Select
voyage)→Backup

The dialog contains the following elements:
• File Name: The name of the log file you intend to save. You can modify this file name.
• Start time: Use the spin buttons to specify the start time for the logged data you

want to save.
• End time: Use the spin buttons to specify the end time for the logged data you want to

save.
• Log Interval: Specify the time interval you require between the items of logged data

that you want to save.
• Save to Medium: Click the button to save the voyage file to the selected device.
• Cancel: Click the button to cancel the save operation.
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Voyage Recording Replay sub-menu

This dialog enables you to replay a voyage recording.

The path to the dialog is: System→Parameter Settings→Voyage (tab)→Voyage List
(Select voyage)→Replay.

The dialog contains the following elements:
• Ship Name: The name of the ship where the recording was done. Obtained from

Ship parameters.
• Voyage Name: The name of the replay file.
• Started: The start date/time for the voyage recording.
• Ended: The end date/time for the voyage recording.
• Recording Interval: The interval between each position recording.
• REPLAY is ON: Click the button to toggle replay off/on.
• Speed: Use the spin button to control the replay speed.
• Interpolate: To get a smoother replay select interpolate.
• Replay Targets: (If targets are present in the saved logfile). Display AIS and ARPA

targets from the logfile with own-ship playback.
• Cancel: Click the button to cancel the replay.
• Voyages: Click the button to go back to the Voyage Recording List dialog.

Note

All recordings are done in UTC. All times are displayed in current local time zone.
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Figure 111 Summary of voyage recording replay controls
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Restore Voyage Recording

This dialog enables you to reload a voyage recording file from the selected device.

The path to the dialog is: System→Parameter Settings→Voyage (tab)→Voyage
List→Reload (Select device)→OK (Select voyage file)→Load.

The dialog contains the following elements:
• Voyage Files on Medium: Select a voyage file from the list.
• Load: Click the button to load the selected file from the selected device to the

K-Bridge Radar.
• Cancel: Click to cancel reloading.
• Refresh: Click to read and update the list of voyage files on the selected device.

584 381287/A



Reference Guide

20.10.3 Preset Parameters

This dialog lists the groups of preset parameters currently in use on the system. You can
import new parameter group files from external media or export parameter group files
from the system to external media. You can also load a parameter group (for example
one that you have just imported) for immediate use. And you can save a parameter group
to the system, over-writing the current group of the same name.
The path to the dialog is: System→Preset Parameters.
The dialog contains the following elements:
Preset Parameters Sets: Lists all the currently saved preset parameters groups with their
name and the date and time they were saved.
Load: Click to load and start using the selected preset parameter group.
Load Detailed... : Click to see a list of the preset parameter groups available to be loaded
(see Load Detailed... on page 586).
Save: Click to save the selected preset parameter group.
Saved Detailed... : Click to bring up a dialog displaying all the groups of preset
parameters available (see 20.10.3.2).
Delete: Click to delete the specified group of preset parameters.
Import... : Click to import a preset parameter file from an external medium such as a
CD-ROM or memory stick. The external file must have a file extension *.par (see dialog
Import on page 588).
Export... : Click to export a parameter file to a writeable external device medium. The
external file must have the file extension *.par.
Global: Click if you want parameter to sets to be automatically exchanged between the
K-Bridge Radar and/or K-Bridge Planning systems on the bridge network.
Files are automatically exchanged when they are created or modified, and files deleted
from one station are automatically also deleted from all the others on the network.
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Note

You must enter the service password to enable or disable the Global toggle.

The Global toggle must be enabled on all operator stations that are to exchange
parameter files.

20.10.3.1 Load Detailed...

Use this dialog to select one or more groups of preset parameters to be loaded
immediately on to the system.

The path to the dialog is: System→Preset Parameters→Load Detailed.

Load: Click to load the selected preset parameters.

Cancel Click to cancel the current load operation.
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20.10.3.2 Save Detailed...

Use this dialog to select one or more parameter groups to save to the system.

The path to the dialog is: System→Preset Parameters→Save Detailed.

You can select one or more groups of parameters (by using the check-boxes) and then
specify a name for the new combined parameter set.

Save: Click to save the parameters.

Cancel Click to cancel the current save operation.
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20.10.3.3 Import

Use this dialog to import a parameter file from a CD-ROM or memory stick.

The path to the dialog is: System→Preset Parameters→Import.

The dialog contains the following buttons:
• Import: Select a parameter file to copy to the internal directory. The file will then

appear in the list in the Preset Parameters dialog (see Preset Parameters on page 585).
• Cancel: Click to cancel the import operation.
Note

The parameter file is not loaded unless you explicitly load it from the Preset Parameters
dialog (see Preset Parameters on page 585).
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20.10.3.4 Export

Use this dialog to export a parameter file to a CD-ROM or memory stick.

The path to the dialog is: System→Preset Parameters→Export.

The dialog contains the following buttons:
• Export: Select a parameter file to copy from the internal directory to the external

medium.
• Cancel: Click to cancel the import operation.
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20.10.4 Printer

Use this dialog to select items (such as a mariners’ notes, routes, screen captures,
and Navtex messages) from the list of items available for printing and send them to
a specified printer.

There are different paths to the dialog, including:
• System→Printer

• System→Print Screen

• Chart→Manage Notes→List and Create Notes→Print

• Chart→Navtex Messages→Print

• Route→Manage Routes→Print

To select more than one item to print:
1 First select a single item.

Use the trackball to position the mouse marker over the item, then click the left
mouse-button

2 Select another item but this time hold down the Shift key on the keyboard when
you click the left mouse-button.
This selects all items in the list between – and including – the first and second
selections.

The elements in the Printer dialog are as follows:
• Select printer: Select a printer from the drop-down list.
• Name: The identifier for each item in the list of items available for printing.
• Status: The status of the currently selected item in the list of items available for

printing. The possible statuses are: Ready (meaning that the item is available to be
printed), Waiting (meaning that the item is waiting to be printed after you have
clicked Print), Printing, and Done. When an item in the list has been printed out
and has therefore achieved the status Done, there is a short delay before the item is
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removed from the list. An additional status is Preview, which is the status of the
selected item(s) after you have clicked Preview (the status reverts to Ready when
you close the Preview dialog).

• Type: The type of item: whether it is a mariner’s note, a Navtex message or another
item.

• Print to file: Check to print the selected item(s) to a file instead of to the selected
printer. When you click Print, you will be prompted to specify a path.

• Print: Send the selected item(s) from the queue to the selected printer (or to an output
file if you have checked the Print to file option).

• Copies: Select the number of copies you want printed.
• Remove: Click to remove the selected item(s) from the list.
• Preview: Click to see a preview of the printed output for the selected item(s) (see Print
preview on page 591).

• Stop: Abort printing of the selected item(s) after you have clicked Print.

20.10.4.1 Print preview

This dialog provides a date- and time-stamped preview of an item (such as a
screen-capture) that has not yet been printed.

The path to the dialog is: System→Print Screen→Preview.

The dialog contains the following buttons (in addition to the preview image):
• Prev: Click to see the image of the previous screen-capture in the print queue.
• Next: Click to see the image of the next screen-capture in the print queue.
• Print: Click to print the previewed image.
• Preview: Click the button to view a preview of the selected screen capture.
• Cancel: Click the button to cancel the printing.
• Zoom In: Click to enlarge the preview image on the screen.
• Zoom Out: Click to reduce the size of the preview image on the screen.
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Figure 112 The print preview dialog
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20.10.5 Password

This dialog enables you to enter a password to access restricted parameters.

The path to the dialog is: System→Passwords.

The dialog contains the following elements:
• User Password: Entering the user password allows you to change certain configuration

settings.
• (User Password) Open: Click after entering the user password to allow changes

to user-level parameters.
• (User Password) Lock: Click to inhibit further changes to user-level parameters.
• Service Password: Enter the service password to change more permanent configuration

settings.
• (Service Password) Open: Click to allow changes to service-level parameters.
• (Service Password) Lock: Click to inhibit further changes to service-level parameters.
WARNING

Changing settings behind the passwords can render the system
useless or seriously degrade its performance. Do not change any
settings unless you are trained to do so.
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20.10.6 Maintenance

Use this dialog to upgrade system software, perform backups (or restorations from
backup) of route and parameter data, and to monitor the Transceiver Interface Control
board and Radar Interface Card.

The path to the dialog is: System→Maintenance.

The dialog contains different elements, depending on the application you view it from.

The Radar Maintenance dialog
• System Software Version: States the version of the installed software.
• TIC n Software Version: States the version on the TIC (Transceiver Interface Control)

software in use. For each transceiver there is one TIC board in the interswitch. The
number n indicates the selected TIC board. For more information about the TICs, see
The radar interswitch unit on page 106.

• Computer Name: The name by which the computer by which the computer is
identified by other networked systems.

• Upgrade System Software: Click this button to upgrade the system software from an
upgrade CD-ROM (see Upgrade dialog (see System Upgrade Software on page 596).

• Change Optional Components: Click to manage optional components (see System
Options on page 597).

• Antenna Monitoring: Click to check the performance of the antenna (see Antenna
Monitor on page 598).

• TCVR: Click this button to monitor the operation of a DECCA or Selesmar radar
transceiver (the button is only present if you are using a DECCA or Selesmar
transceiver; see TxRx Monitor (DECCA) on page 600)

• TIC Monitoring: Click to monitor the performance of the radar's Transceiver Interface
Control board (seeTIC Monitor on page 602).

• RICMonitoring: Click to monitor the video handling performed by the radar's Remote
Interface Card (seeRIC Monitoring Video on page 603).
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• Test Video: TIC: Check this option to view test video generated in the receiver. (This
is for service engineers only.)

• Draw Target Gates: Check to see the tracking gates used to track radar targets. (This
is for service engineers only.)

• Global Palette: Check this option to use intensity settings that are the same as the
intensity settings on other consoles on the network. For information about display
settings, see Intensity on page 367.

• Reset Tic: Resets the connected TIC board in the interswitch unit.
• Reset Interswitch: Resets all the TIC boards in the interswitch unit.
• Reconfigure Chart Databases: Click to set the priority for, clean up, or add and remove

databases (see Chart Type Setup on page 532).
• Configure Monitor: Configure the display monitor, see Select Monitor on page 605.
• Backup: Click to back up or restore route information, user editable parameters,

registry settings, or system log data (see Backup/Restore on page 607).

The ECDIS and Conning Maintenance dialogs
• Software Version: States the version of the installed software.
• System ID: This is unique means of identification for your system. It is the same as

your ARCS user permit if you have ARCS charts installed.
• Computer Name: The name by which the computer by which the computer is

identified by other networked systems.
• Serial Number: The serial number of the main computer.
• Global Palette: Check this option to use intensity settings that are the same as the

intensity settings on other consoles on the network. For information about display
settings, see Intensity on page 367.

• Change Optional Components: Click to manage optional components (see System
Options on page 597).

• Copy Log Decoding Program to Medium: Click the button to save the decoding
program to the selected device. This program is required for reading position log and
voyage recording data from an external device (see Copy Log Decoding Program to
Medium on page 606).

• Configure Monitor: Configure the display monitor, see Select Monitor on page 605.
• Backup/Restore: Click to back up or restore route information, user editable

parameters, registry settings, or system log data (see Backup/Restore on page 607).

381287/A 595



K-Bridge Multi-functional Display Unit

20.10.6.1 System Upgrade Software

This dialog enables you to install a new version of the K-Bridge navigation software
from an upgrade CD.

The path to this dialog is: System→Maintenance →Upgrade System Software.

The dialog contains the following button
• Upgrade: Insert the upgrade CD in the reader and click the button to start the upgrade.
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20.10.6.2 System Options

Use this dialog to configure optional system software components.

The path to this dialog is: System→Maintenance → Change Optional Components.

The dialog contains the following elements:
• ARPA Optional Components: List of available optional components. Select the option

you want to enable or disable.
• Enable: Click to enable the selected option.
• Disable: Click to disable the selected option.
• Pincode: Type in the pin code provided by Kongsberg Maritime to enable the option.
Note

Your changes will take effect when you restart the system.
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20.10.6.3 Antenna Monitor

Use this dialog to monitor the radar antenna rotation.
The path to the dialog is: System→Maintenance →Antenna Monitoring.
The dialog contains the following elements:
• Antenna Pulses: The number of antenna pulses for one rotation.
• Cfg: The configured number of pulses that should be received during a single antenna

rotation.
• Last Rot: The number of pulses actually received during the last rotation.
• Mean Last 10 Rot: The mean number of pulses received for the last 10 rotations.
• Min: The lowest number of pulses received for a single rotation since the system was

started up or since the last click of the Reset button in this dialog.
• Max: The highest number of pulses received for a single rotation since the system was

started up or since the last click of the Reset button in this dialog.
• Azimuth Pulses Generated: The TIC (Transceiver Interface Control board) generates

azimuth pulses based upon the incoming antenna pulses. The nominal number of
azimuth pulses generated for a single rotation is 4096.

• Last Rot: The number of azimuth pulses in the last rotation.
• Min: The lowest number of azimuth pulses generated for a single rotation generated

since start-up or since the last click of the Reset button below.
• Max: The highest number of azimuth pulses generated for a single rotation since

start-up or since the last click of the Reset button below.
• Rotation Time, sec: The time taken for the antenna to complete a single rotation.
• Last Rot: The time taken to complete the last antenna rotation.
• Min: The lowest rotation time recorded since start-up or since the last click of the

Reset button below.
• Max: The highest rotation time recorded since start-up or since the last click of the

Reset button below.
• File log:
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– Start: Click to start logging Antenna Monitor parameters to the hard disk.
– Stop: Click to stop logging Antenna Monitor parameters to the hard disk.

• Sectors: Click to see the amount of time the antenna is spending in each sector of its
rotation (see Antenna Sector Monitor on page 599).

• Reset: Resets the maximum and minimum counters.
• More: For future expansion.

20.10.6.3.1 Antenna Sector Monitor

This dialog displays the time (in milliseconds) that the antenna spends in each of the 16
sectors of its rotation (1 sector is 22.5°).

It enables you to monitor variations in the antenna's speed during the rotation (some
variation from sector to sector is normal).

The path to this dialog is: System→Maintenance→Antenna Monitoring→Sectors.
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20.10.6.4 TxRx Monitor (DECCA)

This dialog enables you to monitor the operation of the DECCA radar transceiver.
The path to the dialog is: System→Maintenance→TCVR.
The dialog contains the following elements:
• Transceiver type: X-10kW, X 25kW or S 30kW.
• Software: Displays the version number of the transceiver software.
• Perf. Mon: Checked if the transceiver has a Performance Monitor fitted.
• SART RX: Checked if the transceiver has SART specialised receiver fitted. This is

not normally fitted.
• Status:

– - Text field, Pulse length: Reported by transceiver (Short/Medium/Long).
* If the transceiver is unpowered: "Off".
* If the transceiver is warming up: "WarmUp".
* If the transceiver is in StandBy: "StBy".

– Transmitting: Checked if the transceiver is transmitting.
– Inhibited: Checked if the transceiver is inhibited. NB: With mute sector(s) enabled,

the two check boxes above will be alternating.
– Warming Up: Checked when the transceiver is warming up, approx. 3 min after

power on.
– Swept Gain: Checked if the receiver operates with swept gain. This is not possible

for most transceivers.
– Serial Conn.: Checked if the transceiver reports that it receives serial signals from

the interswitch unit.
– WideBand: Checked if the receiver operates with wide band filter. This is not

possible for most transceivers.
• Errors: The first four fields indicate status in the transceiver. The last four fields

indicate the quality of the serial data communication between transceiver and
interswitch.
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– - Sparking: Checked if the transceiver has detected sparking. The transmission
will then be switched off. Most probable reason is aged magnetron, which needs
replacement. Operation in Short Pulse may be possible until service man is on
board.

– - Head Mark Err: Checked if there is an error in the heading marker. Service
should be called.

– - Charge Trig: Checked if the transceiver has detected an error in charge trig
operation.

– - Modulator: Checked if the transceiver has detected an error in the operation
of the modulator.

• Serial CRC: Checked if the transceiver has detected check sum errors on the messages
from transceiver to interswitch. Number of messages from interswitch to transceiver
on which there has been check sum errors.

• UnKn. Msgs: Checked if the transceiver has detected unknown messages on the
messages from transceiver to interswitch. Number of messages from interswitch to
transceiver which the interswitch does not recognise.

• Voltages:

– Voltage: +30V: System Voltage +30V in transceiver.
– Voltage Modulator: Modulator Voltage.
– Voltage: +12V: System Voltage +12V in transceiver.
– Magnetron Current: Current in magnetron.
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20.10.6.5 TIC Monitor

Use this dialog to monitor the performance of the TIC board in the radar interswitch unit.

The path to the dialog is: System→Maintenance→TIC Monitoring.

The dialog contains the following elements:
• PRF: Current pulse repetition frequency as read on the TIC pcb.
• TIC:

– Source:1: Data from TIC no. 1 (Source: 1).
– Connected: 2: Wired to TIC no. 2 (Connected: 2).

• 24V from Display: Checked if 24V from display.
• TIC Voltages: Nominal and actual voltage levels.
• Temp: Temperature on TIC.
• Run Time: The accumulated operation time for the TIC pcb.
• CPU Loop: Shows how many times per second the processor on the TIC pcb executes

its program.

For more information about the TIC, see The radar interswitch unit on page 106.
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20.10.6.6 RIC Monitoring Video

Use this dialog to monitor the operation of the Radar Interface Card (RIC). The dialog
shows the parameters that are used by the radar scan converter:

The path to the menu is: System→Maintenance→RIC Monitoring.

The dialog contains the following elements:
• Samples/Sweep: Number of samples read from one sweep.
• Errors in Samples/Sweep: Number of errors in samples read.
• Large Az Jumps: Number of large jumps in antenna azimuth between two sweeps.
• Small Az Jumps: Number of small jumps in antenna azimuth between two sweeps.
• Last Large Jump: The size of the last large azimuth jump.
• Largest Jump: The largest recorded jump in azimuth.
• Ant.Dev.RMS: Deviation from smooth antenna rotation.
• PRF: The PRF (Pulse Repetition Frequency) as read by the RIC pcb.
• Errors in Sweep/Bank: Error counter.
• Double Reads of Bank: Error counter.
• Reset Error Counters: Click to reset all error counters to zero.
• RIC Tracker: Click to go to the RIC Monitoring Tracker menu.
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20.10.6.6.1 RIC Monitor Tracker

Use this dialog to monitor the radar tracker.

The path to the dialog is: System→Maintenance→RIC Monitoring→RIC Tracker.

The dialog contains the following elements:
• Large Az Jumps: Number of large jumps in antenna azimuth between two sweeps.
• Small Az Jumps: Number of small jumps in antenna azimuth between two sweeps.
• Last Large Jump: The size of the last large azimuth jump.
• Largest Jump: The largest recorded jump in azimuth.
• Ant.Dev.RMS: Deviation from smooth antenna rotation.
• PRF: The PRF (Pulse repetition Frequency) as read by the RIC pcb.
• Errors in Sweep/Bank: Error counter.
• Double Reads of Bank: Error counter.
• Bank Ident Switch Errors: Error counter.
• Range Number Errors: Error counter.
• Thresh buffer Unavail.: Error counter.
• Reset Error Counters:Click to reset all error counters to zero.
• RIC Video: Click to go back to the RIC Monitoring Video menu (see RIC Monitoring
Video on page 603).

For more information about monitoring the capabilities of the radar tracker, see Known
Solution on page 413.
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20.10.6.7 Select Monitor

Use this dialog to configure the monitor (screen) type used.

The path to the dialog is: System→Maintenance→Configure Monitor.

The dialog contains the following elements:
• Monitor type: Select the monitor type.
• Port No.: Select the serial port (on the operator station computer) that the monitor is

connected to.
• Size: Specify the size of the monitor.
• Orientation: Specify the physical orientation of the operator station in degrees and

in relation to a straight line drawn through the centre of the ship from bow to stern.
This parameter determines the orientation of the Ship pane in the Conning application
(see The Ship pane on page 263).
The bow of the ship’s outline in the Ship pane must point in the same direction as the
bow of the ship. If the operator station is:
– In the centre of the forward bridge (so that you stand at it and look straight ahead),

then the orientation you specify must be 0: the Ship pane will then be vertical and
the bow of its ship symbol will point upwards in the direction of the ship’s bow.

– On a bridge wing (so that you stand at it and look straight out to port or starboard),
then the orientation you specify must be 180° or 270°: the Ship pane will then
be horizontal and the ship symbol will point to your left or right in the direction
of the ship’s bow.

• Apply: Click to apply the entered data.
• Load Calibration File from Monitor: Click to download the colour calibration table

from the monitor to the system's main computer. (This applies only to the 27”
Hatteland TFT (JH27T11) monitor and is normally only necessary during system
commissioning.) When you have downloaded the table, check the Colour Calibration
dialog for the different display palettes (Day, Dusk and Night): there must be
a clear difference between the foreground and background colours (see Colour
Differentiation and Calibration on page 531).
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20.10.6.8 Copy Log Decoding Program to Medium

This dialog is for copying the log decoding program to an external medium

The path to the dialog is: System→Maintenance→Copy Log Decoding Program to Medium.

All removable output devices are displayed. Please select the one where the log decoding
program should be written and click OK.
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20.10.6.9 Backup/Restore

This two tabs in this menu enable you to:
• Back up routes, user-editable parameter settings, registry settings, and/or system logs

(see Backup/Restore – Backup tab on page 607)
• Restore routes, user-editable parameter settings, registry settings, and/or system logs

from previously backed up files (see Backup/Restore – Restore tab on page 608).

20.10.6.9.1 Backup/Restore – Backup tab

Use this tab to back up routes, user-editable parameter settings, registry settings, and/or
system logs.
The path to the tab is: System→Maintenance→Backup→Backup (tab).
The tab contains the following elements:
• Routes: Select if routes are to be backed up (this backs up the contents of the

C:/radec/RouteData folder). The size is displayed to the right.
• User: Select if user edit-able parameters are to be backed up (this includes all

mariners' notes, barrier lines and templates). The size is displayed to the right.
• Registry: Select if Windows Registry settings are to be backed up. The size is

displayed to the right.
• Log: Select if the system's logged data is to be backed up (this backs up all files in the

log directory located at C:\radec\src\logging; it includes serial log files, alarm
list log files and the logbook). The size is displayed to the right.

• Selected size: Displays the amount of data (in kilobytes) to be backed up.
• Space available: Displays the space available on the CD.
• Backup: Click to perform the backup.
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• Message fields: Displays information and error messages.

20.10.6.9.2 Backup/Restore – Restore tab

Use this tab to restore routes, user-editable parameter settings, registry settings, and/or
system logs from back-up.

The path to the tab is: System→Maintenance→Back-up→Restore (tab).

The tab contains the following elements:
• Routes: Select if routes are to be restored. From the drop-down list, select the data to

be restored: it is identified by date and time.
• User: Select if user parameters are to be restored. From the drop-down list, select

the data to be restored: it is identified by date and time.
• Registry: Select if the Windows Registry settings are to be restored. From the

drop-down list, select the data to be restored: it is identified by date and time.
• Restore/Cancel: Click Restore to restore the selected data; the button's text changes to

“Cancel” when you first click it. Then the other Restore button (which is grey in the
picture) will be enabled. Press this other Restore button to continue restoring data.
When the text of the original button says “Cancel”, click it to stop the restore process.

• Message fields: Displays information and error messages.
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20.10.7 LAN Status

This dialog tells you the status of the LAN.

The path to it is: System →System →LAN Communication.

The dialog contains the following elements:
• LAN A and LAN B status lamps: The meanings of the status lamps are:

– Green — the LAN is working correctly
– Red — the LAN network has an error
– Grey — the LAN is disabled

• LAN A/B text field: IP addresses are displayed in the text boxes.
• Configure: Click to configure the LAN (see LAN Configuration on page 610).
• Status text field: Displays the status and/or error messages for each LAN:

The possible error messages are:
• OK Every thing is working correctly.
• Disabled The LAN is not enabled.
• Socket Error Is the cable connected?
• Not all configured LANs are available! If dual LAN were configured, but the system

only is running on one LAN.
• The bound IP unequal configured IP! The configured IP address could not be

connected, so it has connected to another IP address.
• Time-out receiving data! Nothing is received on the LAN. Is the cable disconnected, or

has all other machines stopped?
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20.10.7.1 LAN Configuration

This dialog enables you to configure the LAN.
The path to it is: System→LAN Communication→Configure.
The dialog contains the following elements:
• Available LANs: Select available LAN (0-2):

– 0 = Single LAN multi homed network service provider. Leave LAN card IP1
and LAN card IP2 empty (or disabled).

– 1 = Single LAN with specified network service provider. Network adapter (LAN
card IP1) must be specified. Leave LAN card IP 2 empty (or disabled).

– 2 = Dual LAN with specified network service provider for each LAN A and B.
Specify both LAN cards 1IP and LAN card 2 IP (Network adapter for each LAN).

• LAN card IP A:Displays IP address of LAN card 1 (Network adapter used for LANA).
• LAN card Mask A: Displays Mask address of LAN card 1.
• LAN card IP B:Displays IP address of LAN card 2 (Network adapter used for LAN B).
• LAN card Mask B: Displays Mask address of LAN card 2.
• Route entries: Displays configured subnets (or networks that shall be used. Default

= 1.) It is possible in the Advanced setup of the windows network TCP/IP setup, to
specify several network addresses for the network card to use. If the application is
supposed to send to one or more of these network addresses, the desired addresses
have to be specified in the Subnet IP A and Subnet IP B. If you are using single LAN,
the Subnet IP B is not in use, but it is advisable to set the Subnet IP B equal to the
Subnet IP B, like if A = 192.168.7, then B=192.168.8 (always skip the last number
including the dot).

• Apply: Click the button to enter the configured data
• Edit entry: Select to edit subnet. Select Subnet IP (A and B) to edit. Remember that

each subnet comes in two; A and B. When changing this value the values in Subnet
IP A and Subnet IP B changes.
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• Subnet IP A: Text field to input IP address of subnet A. Default 192.168.7.
• Subnet Msk A: Text field to input Mask address of subnet A. Default 255.255.255.0.
• Subnet IP B: Text field to input IP address of subnet B. Default 192.168.8.
• Subnet Msk B: Text field to input Mask address of subnet B. Default 255.255.255.0.
• Use Multicast: Select to enable for sending and receiving to a specific group

of receivers (default adr.: 230.21.102.31 - may be edited in file Config >
LAN_Socket.ini).

• Use DNet (Restart): Select to enable for use of KM DNet (dualLAN), where
the DNet server must be read. (may be edited in Config>LAN_Socket.ini and
Radec>Run>Config>Topology>Hosts.

Note

Both Use Muliticast and Use DNet are mainly used for integration with DP and the
SINT.

• Default type: Select type of LAN (Single/Dual/Frigate).
• Get defaults: Click the button to get default values of selected type (Not available for

single LAN yet).
• Enable LAN error reporting: Check LAN error reporting to prevent errors to appear

in the alarm manager when something is wrong with the LAN. If this is a single
station on the network, then you would get an alarm "LAN A ", and in the LAN status
dialog an error text will be displayed.

• Disable Media Sense (Req. Restart):

• Show: Select to enable for editing of variable settings in the dialog.
• OK: Click the button to apply your changes.
• Cancel: Click the button to cancel your changes.
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20.10.8 Device configuration

This dialog enables you to configure the I/O interfaces on the operator station. This is
normally only done during commissioning and must only ever be done by qualified
personnel. It is by means of these interfaces that the operator station receives its sensor
data, so changing the settings can render the system useless.

The path to this dialog is: System→Device configuration.

The dialog contains the following buttons:
• Device: From the drop-down list, select the type of interface you want to configure.

The choice includes the operator station computer’s COM ports, its RIC2 (Radar
Interface 2) card, and the virtual LAN ports on which K-Bridge operator stations
receive sensor data from the SINT. The drop-down list also includes up to four LWE
(Light-weight Ethernet) devices. This is either for operator stations that receive sensor
data directly over an LWE connection or it is for operator stations that receive sensor
data via a serial converter (inside the console) to which the navigation sensors are
connected; the serial converter on such consoles communicates with the operator
station computer using a single LWE connection.

• Monitor: Click to go to a dialog that enables you to see the messages coming in (and
any going out) on the selected port (see Serial Monitor on page 613).

• Config: Click to go to a dialog that enables you to change the configuration parameters
for the selected I/O interface. The dialog that comes up depends on the type of
interface selected. For the:
– COM ports, see Serial Port Configuration on page 614
– RIC2 card, see RIC2 Configuration on page 614
– LAN ports, see Serial on LAN settings on page 640
– LWE ports, see LWE port Configuration on page 615
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20.10.8.1 Serial Monitor

This dialog enables you to monitor the I/O messages on the operator station’s interface to
a sensor.

The path to the dialog is: System→Device Configuration→Monitor.

The dialog contains the following elements:
• Sensor port: The I/O interface you are monitoring.
• Config: Click to go to a dialog that enables you to change the configuration parameters

for the selected I/O interface. The dialog that comes up depends on the type of
interface you are monitoring. For the:
– COM ports, see Serial Port Configuration on page 614
– RIC2 card, see RIC2 Configuration on page 614
– LAN ports, see Serial on LAN settings on page 640
– LWE ports, see LWE port Configuration on page 615

• Input: Displays incoming messages.
• Output: Displays outgoing messages.
• HEX: Click to display the messages as hexadecimal numbers.
• ASCII: Click to display the messages as ASCII characters.
• Start: Click to start monitoring the messages on this port. Monitoring will continue

until you click Stop or the log file has reached 1 Mbyte.
• Auto: Start monitoring of messages on this port. The monitoring will continue until

you click Stop, until the log file reaches 1 Mbyte, or until you close the dialog.
• Stop: Click to stop monitoring the selected port. The logged data is written to a file in

the following location: c:\radec\logging. (The filename indicates both the port
number and the type of interface whose I/O log the file contains.)
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20.10.8.2 Serial Port Configuration

Use this dialog to configure the selected serial port.
The path to this dialog is: System→Device Configuration (with a COM port
selected)→Config.
The dialog contains the following elements:
• Serial port: The port you are configuring.
• Monitor: Click to monitor the messages on the serial port (see Serial Monitor on

page 613).
• Baud rate: Click to select the baud rate.
• Data bits: Click to select the number of data bits in each word.
• Parity: Click to select odd, even, or no parity.
• Stop bits: Click to select the number of stop bits after each word.
• Set default NMEA 0183: Click to configure the port with standard settings for an

NMEA 0183 messages: 4800 bits/s baud rate; 8 data bits; no parity, 1 stop bit).

20.10.8.3 RIC2 Configuration

Use this dialog to configure the I/O interface on the RIC2 card.
The path to this dialog is: System→Device Configuration (with the RIC2 interface
selected)→Config.
The dialog contains the following elements:
• Sensor port: The I/O interface (in this case, the RIC2 card) that you are configuring.
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• Monitor: Click to monitor the messages on the RIC2 card (see Serial Monitor on
page 613).

• Baud rate: Click to select the baud rate.
• Data bits: Click to select the number of data bits in each word.
• Parity: Click to select odd, even, or no parity.
• Stop bits: Click to select the number of stop bits after each word.
• Set default NMEA 0183: Click to configure the port with standard settings for an

NMEA 0183 messages: 4800 bits/s baud rate; 8 data bits; no parity, 1 stop bit).

20.10.8.4 LWE port Configuration

Use this dialog to configure a LWE (Light-weight Ethernet) interface between the
operator station computer and either:
• an NMEA-to-Ethernet converter in the console (this is for consoles that receive sensor

input on one or more NMEA-to-Ethernet converters) or
• a sensor that transmits to the operator station directly over a LWE connection
The path to this dialog is: System→Device Configuration (with an LWE interface
selected)→Config.
The dialog contains the following elements:
• Device: From the drop-down list, select a Light-weight Ethernet (LWE) device that

will transmit, or is currently transmitting, data to the operator station.
• IP address: The IP address of the selected device. Edit this field (and click Apply

Changes) if you need to associate the name of the selected device (from the drop-down
list) with a different device.

• Device port: The IP service port on which the selected device receives data from
the operator station.

• Local port: The IP service port on which the operator station receives data from
the selected device.
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• Apply Changes: Click to apply any changes you have made to settings in the dialog.
• Channel names: The name of each channel that the selected device is using or will use

to transmit data to the operator station. If the selected device is an NMEA-to-Ethernet
converter inside the console, it will have multiple channels, one for each sensor. If the
selected device is itself a sensor, it will have only one channel. The channel names in
this dialog must match the names used by each channel on the selected device.
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20.10.9 Number of Sensors

Use this dialog to configure the communication interfaces – including all the sensor
interfaces – for the operator station.
The path to the dialog is: System→Sensor Configuration.
The dialog contains the following fields and buttons:
• Sensor Type: Select the type of sensor (or other equipment) whose interface you

want to configure.
• Number: Indicates the number of each type of sensor (or other equipment) installed.
• No of sensors: Use the spin buttons to set the number of sensors (or other equipment,

as applicable) installed.
• Details: Click to configure the interface between the operator station and the selected

type of sensor or other equipment.
• Stop Logging: By default, the operator station logs sensor input continuously to its

logged data buffer which stores it for up to three days (see Integration Configuration
on page 659). Clicking this button stops the continuous logging of sensor data. Do
not click it unless requested to by a KM service engineer.

• Clear Logs: Clicking this button clears the logged data buffer. Do not click it unless
requested to by a KM service engineer.

The main interfaces you can configure are described in the following sections:
• Heading sensor interface on page 618
• Position sensor interface on page 622
• Speed sensor interface on page 624
• Wind sensor interface on page 626
• Depth sensor interface on page 628
• Radar interswitch interface on page 630
• Autopilot interface on page 631
• Target out interface on page 632
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• Serial route interface on page 634

• AIS interface on page 636

• NMEA output interface on page 637

Some of the above interface configuration dialogs contain a Settings button. This is for
configuring the LAN port if the serial data is to be transmitted over the LAN (see Serial
on LAN settings on page 640).

20.10.9.1 Heading sensor interface

Use this dialog to configure the communication parameters for the heading sensor(s).

The path to the dialog is: System→Sensor Configuration→Heading→Details.

The dialog contains the following elements:
• Type: Select Heading from the drop-down menu.
• No: The operator station's identification number for the heading sensor interface

that you are configuring.
• Enable logging to disk: When checked, this option ensures that input from the sensor is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• Make: Specify the sensor manufacturer/model.
• Name: Insert an identifying name, for example, “Gyr1” or “Gyr2” (for the primary

and secondary gyros) or “GyrB” (for the NMEA backup heading data). The names
you give determine the names of the buttons that the operator will for the heading
sources (for example, on the top bar heading display and in the Heading dialog, see
Heading on page 452).

• Port No: Select a port number between LAN1 and LAN15 corresponding to the
number of the SINT port (from 1-15) that the heading sensor is connected to. In a
standard configuration:
– The primary heading sensor will normally be connected to port 2 on the SINT;

therefore you must specify LAN port 2 as the operator station interface for data
from the primary heading sensor.
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– The secondary heading sensor (if present) will normally be connected to port 6 on
the SINT; therefore you must specify LAN port 6 as the operator station interface
for data from the secondary heading sensor.

– Backup heading sensor data will be received by the operator station from the SINT
over a serial connection; therefore you must specify Serial Port 1 as the operator
station interface for backup heading data.

• Use Default Settings: Click to use the factory default settings for this sensor. Click
once and then confirm to apply this change.

• Sensor Details: Click to configure the heading sensor further (see Heading sensor
details on page 620).
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20.10.9.1.1 Heading sensor details

Use this dialog to perform more detailed configuration of the interface between the radar
system and the heading sensor.

The path to the dialog is: System→Sensor Configuration→Heading→Details→Sensor
Details.

The dialog contains the following elements:
• Heading Sensor No: Select the heading sensor number, if there are more than one

sensor of this type configured.
• Protocol: Select the protocol to be used for heading data from this sensor. We

recommend you select HDT or THS.
• Heading Measurement – Filter Time: To reduce the effect of noise on the heading

information it displays, the K-Bridge MFD system applies a low-pass filter to the gyro
input before it uses the input in calculations. This parameter is the filter-time constant
(expressed in seconds). If your vessel is large and takes a long time to turn, you
can increase the filter time to reduce noise from the heading sensor. If the vessel is
small and turns quickly, you might need to reduce the filter time to reduce latency
in the display of heading information. Unless you have a particular reason to use a
different filter time, specify 0.10 seconds.

• Heading Measurement – Accuracy: This field states the accuracy of the measurements
sent to the K-Bridge MFD system by the heading sensor. The system takes this value
into account when determining the accuracy of the own-ship's position and speed over
ground (so that, if required, these can be displayed graphically at low range scales).
The heading sensor's accuracy must be set correctly when the sensor is installed.
Refer to the documentation supplied with your heading sensor to find out the accuracy
of its measurements. Unless you have a particular reason to specify a different value,
specify an accuracy of 0.10º.

• Heading Measurement – Jump detect: Heading sensors typically transmit
measurements approximately 10 times per second. If the difference between one
measurement and the next is greater than the amount you specify for this parameter,
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an alarm will be issued. The default alarm limit is 3º. On a small fast vessel that can
change its heading quickly, and on which the heading sensor sends measurements
fewer than 10 times per second, you might want to specify a higher limit than this.

• Rate of Turn – From Gyro ROT: If the gyro is capable of sending rate of turn (ROT)
messages, select the option to use rate of turn measurements from the gyro. No
filtering is applied to ROT messages from the gyro. The option is not available with
all heading sensors.

• If the gyro is not capable of sending ROT messages, the console must calculate the
ROT from the change of heading. In this case, select Calculated from Heading. In this
case, the Filter Time is normally 1.0 seconds but you can specify a higher value
for large slow ships, or (if the heading report rate is faster than 8-10 messages per
second) a lower value for faster ships).

• Rate of Turn – Calculated from Heading: Select to calculate the rate of turn using the
heading measurements from the gyro. The calculation will use the filter time specified
in the field below.

• Rate of Turn – Filter Time: Type in the filter time to be used by the system for
calculating the rate of turn using heading measurements from the gyro. Then click
Apply.
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20.10.9.2 Position sensor interface

Use this dialog to configure the communication parameters for the position sensor.

The path to the dialog is:System→Sensor Configuration→Position→Details.

The dialog contains the following elements:
• Type: Select the sensor type.
• No: Select the sensor number (if there is more than one sensor of this type configured).
• Enable logging to disk: When checked, this option ensures that input from the sensor is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• Make: Select the sensor manufacturer/model.
• Name: Insert an identifying name.
• Port No: Select a port number between LAN1 and LAN15 corresponding to the

number of the SINT port (from 1-15) that the position sensor is connected to.
• Use Default Settings: Click to use the factory default settings for this sensor. Click

twice to apply!
• Sensor Details: Click to configure the position sensor(s) further (see Position sensor
details on page 623).

622 381287/A



Reference Guide

20.10.9.2.1 Position sensor details

Use this dialog to perform more detailed configuration of the interface between the radar
system and the position sensor.
The path to the dialog is: System→Sensor Configuration→Position→Details→Sensor
Details.
The dialog contains the following elements:
• Position Sensor No: Select position sensor number, if there are more than one sensor

of this type configured.
• Type: Select the type of position sensor (GPS, Loran-C etc).
• Message: Select the NMEA position message format to be received (GGA, GLL,

TIPY, GNS or RMC). GGA or GNS must be used for GPS. GLL must be used for
LoranC.

• Dev. Alarm Limit: Type in the alarm limit for deviation between the currently selected
position sensor and the alternative sensor, then click Apply. The default limit is 100m.
If this limit is exceeded and the currently selected position sensor fails, the operator
station will not automatically switch to the alternative position sensor.

• Accuracy: Type in the expected accuracy of the position sensors in their absolute and
differential operating modes, then click Apply.

• Datum Info: DTM Message: Check this box if the position sensor is able to send
DTM messages.
If the position sensor is older and cannot output DTM messages, un-check the box.
If you check the box in this situation, you will receive continuous "DTM missing"
alarms); also make sure the position sensor is configured to send position messages
using the WGS-84 datum.

• Datum info: Always WGS-84: Select this option if the position sensor outputs data
using WGS-84 and cannot output DTM telegrams.

• Additional Messages: GRS, GSA, GST and GSV messages are supported. To display
satellite overview data, GSA and GSV messages are required.
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• Antenna Location: Specify the antenna location. along ship from stern and across ship
from centre line. Height is above water. An antenna located on the port side will give
a negative value across.

20.10.9.3 Speed sensor interface

Use this dialog to configure the communication parameters for the speed sensor.

The path to the dialog is:System→Sensor Configuration→Speed→Details.

The dialog contains the following elements:
• Type: Select speed sensor from the drop down menu.
• No: Select the sensor number, if there is more than one sensor of this type configured.
• Enable logging to disk: When checked, this option ensures that input from the sensor is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• Make: Select the sensor manufacturer/model.
• Name: Insert an identifying name.
• Apply: Click to apply your changes.
• Port No: Select a port number between LAN1 and LAN15 corresponding to the

number of the SINT port (from 1-15) that the speed log is connected to.
• Use Default Settings: Click to use the factory default settings for this sensor. Click

once and then confirm to apply this change.
• Sensor Details: Click to go to configure the speed sensor(s) further (see Speed sensor
details on page 625).
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20.10.9.3.1 Speed sensor details

Use this dialog to perform more detailed configuration of the interface between the
radar system and the speed sensor.
The path to the dialog is: System→Sensor Configuration→Sensor
Configuration→Speed→Details→Sensor Details.
The dialog contains the following elements:
• Speed Sensor No: The number of this interface.
• Type: Select the speed sensor type from the drop down menu (single or dual axis,

water or bottom speed).
• Protocol: Select the communication protocol to be used for speed outputs from this

sensor. Select:
– NMEA 0183_VBW if the log can transmit both Speed Over Ground (SOG) and

Speed Through Water (SWT).
– SNMEA 0183_VHW if the log can only transmit STW.
– NMEA 0183_VTG or NMEA 0183_RMC if the log can only transmit SOG.
– NMEA 0183_RMC for compatibility with an old satellite position receiver.

• Accuracy: Set a value for the accuracy of the speed sensor. (This affects the weight
this sensor is given in the position filter. The log has more influence if the accuracy
is set to a low number.)

• TimeOut Limit: Set a time-out limit (of, for example, 5 seconds) for speed input
values. This limit is the maximum time between messages from the log before an
alarm will be given. The limit applies only to pulsed log input. It does not apply to
digital NMEA messages.

• Filter Times Along: Low-pass filter constant for speed along-ship.
• Filter Times Across: Low-pass filter constant for speed across-ship.
• Transducer Location: Specify the transducer location along-ship from the stern and

across-ship from the centre line. A transducer located on the port side will give a
negative value across.

• Across: Low-pass filter constant for speed across-ship.
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20.10.9.4 Wind sensor interface

Use this dialog to configure the communication parameters for the wind sensor.

The path to the dialog is: System→Sensor Configuration→Wind →Details.

The dialog contains the following elements:
• Type: Select Wind from the drop-down menu.
• Enable logging to disk: When checked, this option ensures that input from the sensor is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• No: Select the number of the wind sensor.
• Make: Select the sensor manufacturer/model.
• Name: Insert an identifying name (or edit the existing name) and click Apply.
• Port No: Select the port number this sensor is connected to.
• Settings: Click to configure the LAN port settings if you are using a LAN interface

(see Serial on LAN settings on page 640).
• Use Default Settings: Click to use the factory default settings for this sensor. Click

once and then confirm to apply this change.
• Sensor Details: Click to go to configure the speed sensor(s) further (see Wind sensor
details on page 627).
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20.10.9.4.1 Wind sensor details

Use this dialog to perform more detailed configuration of the interface between the
radar system and the wind sensor.

The path to the dialog is: System→Sensor Configuration→Wind→Details→Sensor Details.

The dialog contains the following elements:
• Wind Sensor No: Select the wind sensor number if there is more than one wind

sensor configured.
• Type: Select “Generic Anemometer” or “AGI Weather Station”.
• Protocol: NMEA 0183 is the only communication protocol available for receiving

wind data from this sensor.
• Messages: The available messages are:

– MWV or MWD
– MWV (includes wind speed plus true and relative direction)
– MWD (includes true wind direction and speed referenced to earth)
– MWV or XDR (XDR content includes transducer measurements of, for example,

temperature, force, pressure, frequency, and angular or linear displacement)
– MWD or XDR
– MWV or MWD or XDR
– VWR (includes relative wind speed and direction)
If you select a message combination (for example, “MWV or MWD”), then both (or
all) of the message types in the combination (for example MWV andMWD) will be
accepted by the K-Bridge Radar system. If messages of both (or all) types are received
and they conflict with each other, the readings will jump from one to the other.

• Sensor location:

– Along: Specify the distance along-ship from the Aft Peak to the wind sensor.
– Across: Specify the distance across-ship from the Aft Peak to the wind sensor.
– Over Keel: Specify the distance over the keel from the Aft Peak to the wind sensor.
– Apply: Click to apply any changes you have made to the specification of the wind

sensor's location.
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20.10.9.5 Depth sensor interface

Use this dialog to configure the communication parameters for the depth sensor.

The path to the dialog is: System→Sensor Configuration→Depth→Details.

The dialog contains the following elements:
• Type: Select Depth from the drop down menu.
• Enable logging to disk: When checked, this option ensures that input from the sensor is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• No: Select the number of the depth sensor.
• Make: Select the sensor manufacturer/model.
• Name: Insert an identifying name (or edit the existing name) and click Apply.
• Port No: Select the port number this sensor is connected to.
• Settings: Click to configure the LAN port settings if you are using a LAN interface

(see Serial on LAN settings on page 640).
• Use Default Settings: Click to use the factory default settings for this sensor. Click

once and then confirm to apply this change.
• Sensor Details: Click to configure the interface further (see Depth sensor details on

page 629).
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20.10.9.5.1 Depth sensor details

Use this dialog to perform more detailed configuration of the interface between the
radar system and the depth sensor.
The path to the dialog is: System→Sensor Configuration→Depth→Details→Sensor Details.
The dialog contains the following elements:
• Depth Sensor No: Select the depth sensor number, if there is more than one sensor

of this type configured.
• Type: Select "Generic EchoSounder" (for an echo-sounder that is used in navigation)

or "Multibeam EchoSounder" (for an echo-sounder that is used for charting and
surveying).

• Protocol: The communication protocol that is used for outputs from this depth sensor.
Select "NMEA 0183" (for an echo-sounder that is used in navigation) or "DESO 25"
(for an echo-sounder that is used for charting and surveying) .

• Messages: The following messages are available if you are using the NMEA 0183
protocol:
– DPT or DBT
– DPT (includes depth relative to keel; requires transducer offsets to be correct)
– DBT (Depth Below Transducer)
– RDS
– NONE
If you select a message combination (“DPT or DBT”), then both the message types
in the combination will be accepted by the K-Bridge radar system. If messages of
both types are received and they conflict with each other, the readings will jump
from one to the other.
The following messages are available if you are using the DESO 25 protocol:
– DA
– DB

• Inhibit Alarm When Input Missing: Check the box to avoid receiving alarms when
there is no valid output from the echo-sounder (for example, when sailing in deep
seas).

• Transducer location:
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– Along: Specify the distance along-ship from the Aft Peak to the depth sensor.
– Across: Specify the distance across-ship from the Aft Peak to the depth sensor.
– Over Keel: Specify the distance over the keel from the Aft Peak to the depth sensor.
– Apply: Click to apply any changes you have made to the specification of the depth

sensor's location.

20.10.9.6 Radar interswitch interface

Use this dialog to change the port connection to the radar interswitch.

The path to the dialog is: System→Sensor Configuration→Radar→Details.

The dialog contains the following elements:
• Type: Select Radar from the drop-down menu.
• No: Not applicable.
• Enable logging to disk: When checked, this option ensures that input from the radar is

included in the operator station’s continuously logged system data. Do not un-check
the option unless requested to by a KM service engineer.

• Make: Not applicable.
• Name: Not applicable.
• Port No: Select the interface you want to use to communicate with the radar

interswitch.
• Use Default Settings: Click to use the factory default settings for this interface. Click

once and then confirm to apply the change.
• Sensor Details: Click to perform further configuration of the interface between the

radar display unit and the interswitch unit Radar Configuration on page 641).
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20.10.9.7 Autopilot interface

Use this dialog to configure the parameters for communication between the radar system
and the autopilot.

The path to the dialog is: System→Sensor Configuration→Autopilot→Details.

The dialog contains the following elements:
• Type: Select Autopilot from the drop-down menu.
• No: Not applicable.
• Enable logging to disk: When checked, this option ensures that data sent to and

received from the autopilot is included in the operator station’s continuously logged
system data. Do not un-check the option unless requested to by a KM service engineer.

• Make: Select the sensor manufacturer/model.
• Name: Not applicable.
• Port No: Select the interface to use for communication between the radar system

and the autopilot.
• Settings: Click to configure the LAN port settings if you are using a LAN interface

(see Serial on LAN settings on page 640).
• Use Default Settings: Click to use the factory default settings for this interface. Click

once and then confirm to apply this change.
• Sensor Details: Not applicable.
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20.10.9.8 Target out interface

Use this dialog to set up a serial line for sending target information out to another
operator station.

The path to the dialog is: System→Sensor Configuration→TargetOut→Details.

The dialog contains the following elements:
• Type: Select Target Out from the drop-down menu.
• Enable logging to disk: When checked, this option ensures that target data sent out on

the serial line is included in the operator station’s continuously logged system data.
Do not un-check the option unless requested to by a KM service engineer.

• No: Not applicable.
• Make: Not applicable.
• Name: If you require, insert an identifying name for the device you are connecting to

(or edit the existing name), and click Apply.
• Port No: Select the serial line you want to use to connect to the device that will

receive the target information.
• Use Default Settings: Click to use the factory default settings for this interface. Click

once and then confirm to apply this change.
• Sensor Details: Click to configure the interface further (see Target out interface details

on page 633).
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20.10.9.8.1 Target out interface details

Use this dialog to perform more detailed configuration of the interface between the radar
system and the operator station that is to receive target information over the serial line.

The path to the dialog is: System→Sensor Configuration→TargetOut→Details→Sensor
Details.

The dialog contains the following elements:
• Target Out Sensor No: Select the Target Out interface you want to configure if there

is more than one.
• Protocol: Select the communication protocol to be used:

– TTD (enables you to send tracked targets and AIS targets)
– TTM (enables you to send only tracked targets, not AIS targets)
– GGA (enables you to send one selected target)

• Export AIS targets: Check to send AIS targets as well as radar targets (this option is
only available if you are using the TTD protocol).

• Export active AIS targets only: Click to send active AIS targets but not sleeping ones.
• TLB – Target Labels: Check to include identifying labels for each target.
• TLB Retransmit Interval: Specify a time interval (in seconds) for re-transmission

of the target label information.
• Issue Alarm When Target Missing: Check this box to receive an alarm when no target

is selected or when a lost target has been selected.
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20.10.9.9 Serial route interface

Use this dialog to configure a serial interface to use for sending route information
to equipment that is not part of the navigation system (for example, to a Dynamic
Positioning operator station).

The path to the dialog is: System→Sensor Configuration→Serial Route→Details.

The dialog contains the following elements:
• Type: Select Serial Route from the drop-down menu.
• Enable logging to disk: When checked, this option ensures that route data sent out on

the serial interface is included in the operator station’s continuously logged system
data. Do not un-check the option unless requested to by a KM service engineer.

• No: You can have up to two serial interfaces for sending out route information. Select
the one you want to configure.

• Make: Select one of the following protocol names: Kongsberg Tx, Dual ALSTOM,
Nmea RTE/WPL. We recommend Nmea RTE/WPL.

• Name: The default name for the serial route interface is DPS-Route. If you have added
a second serial route interface, specify a different name for it.

• Port No: The default port number is LAN11.
• Settings: Click to configure the LAN port settings (see Serial on LAN settings on

page 640).
• Use Default Settings: Click to use the factory default settings for the protocol you

selected when you configured the Make parameter. Click once and then confirm to
apply this change.

• Sensor Details: Click to finish configuring the serial route interface (see Serial route
interface details on page 635).
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20.10.9.9.1 Serial route interface details

Use this dialog to finish configuring the interface you are using to send route information
to an external system such as a Dynamic Positioning operator station.

The path to the dialog is: System→Sensor Configuration→Serial Route→Details→Sensor
Details.

The dialog contains the following elements:
• Serial route No: The number (1 or 2) of the serial route interface whose configuration

you are completing.
• Type: The value you specify from the drop-down list will depend on the protocol you

specified for the Make parameter in the previous menu (see Serial route interface
on page 634). For:
– Kongsberg Tx, select SERIAL_TX.
– Dual ALSTOM, select SERIAL_DPS.
– Nmea RTE/WPL, select SERIAL_WPL+RTE, SERIAL_RTE+WPL, or

SERIAL_RTE (Ext, DP).
• Protocol: You must specify Nmea 0183.
• Talker ID: The Talker ID you select will depend on the protocol you specified for the

Make parameter in the previous menu (see Serial route interface on page 634). For:
– Kongsberg Tx, select PR.
– Dual ALSTOM, select PK.
– Nmea RTE/WPL, select IN.
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20.10.9.10 AIS interface

Use this dialog to configure the parameters for communication between the radar system
and the AIS receiver.

The path to the dialog is: System→Sensor Configuration→AIS→Details.

The dialog contains the following elements:
• Type: Select AIS from the drop-down menu.
• No: Not applicable.
• Enable logging to disk: When checked, this option ensures that input from the AIS

system is included in the operator station’s continuously logged system data. Do not
un-check the option unless requested to by a KM service engineer.

• Make: Select Seatex AIS if your AIS receiver is produced by Kongsberg Seatex (a
subsidiary of Kongsberg Maritime). Otherwise, select Generic AIS. (Some added
functionality is available if you use a Seatex AIS receiver in combination with
K-Bridge; selecting the Seatex AIS option here supports that functionality.)

• Name: Insert an identifying name for the speed pilot if you require.
• Port No: Select the interface you want to use to communicate with the AIS receiver.
• Settings: Click to configure the LAN port settings if you are using a LAN interface

(see Serial on LAN settings on page 640).
• Use Default Settings: Click to use the factory default settings for this interface. Click

once and then confirm to apply this change.
• Sensor Details: Not applicable.
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20.10.9.11 NMEA output interface

Use this dialog to configure the NMEA output interface.

The path to the dialog is: MENU→System→Sensor Configuration→NmeaOutput→Details.

The dialog contains the following elements:
• Output Number: Select the number of the NMEA client device.
• Output Settings:

– LAN: Select if you want to send NMEA data out on the LAN instead of on
a physical serial line.

– Serial: Select to send the data out on a serial line.
– Port: Specify the port you want to send the data out on. If LAN is selected, then

the port you specify is a UDP port in the range 1 to 65535. If Serial is selected then
you are specifying a physical serial port. Also, if you selected Serial and you want
to use the serial lines on the SINT (if applicable), select one of the ports between
LAN1 and LAN15 (the SINT serial lines transmit UDP multicast telegrams on
UDP ports in the range 15101 to 15115).

– IP address: This field is only available if LAN is selected. Specify the IP address of
the device you want to send the NMEA data to.

• Talker (all telegrams): Specify two characters as the talker ID for the NMEA
messages sent out. All messages from this operator station will have the same talker
ID (unless you specify an individual Talker ID when you configure a particular
NMEA sentence; see the Talker button below). In this example HE is the talker
ID: $HEHDT,121.5,T,*34\n.

• Status: Indicates the status of the connection between the serial or LAN port and
the NMEA client device.

• Telegram settings (this output only): This table allows you to specify which NMEA
sentences are to be sent to the client device on the connection you are configuring.
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• Clear: Click to clear the edits you have made to the telegram settings for the selected
NMEA sentence in the table.

• DecPri: Click to move the selected NMEA sentence down by one priority in the table.
• IncPri: Click to move the selected NMEA sentence up by one priority in the table.
• Edit: Select one of the four custom sentences (CU1 to CU4) at the bottom of the table,

specify an interval for it and click Apply Settings. This activates the Edit button. Click
the Edit button to specify the sentence's content. This brings up the NMEA Custom
menu, which enables you to select the component fields for your custom sentence (see
NMEA Custom on page 639).

• Interval: Use the spin buttons to specify the interval at which you want the selected
NMEA sentence to be sent out.

• Talker: Specify an individual two-character Talker ID for the selected NMEA
sentence. If you specify an individual Talker ID, then the selected message will use it
instead of the global one set in the Talker (all telegrams) field (above).

• Apply Settings: Click to apply the changes you have made.
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20.10.9.11.1 NMEA Custom

This dialog is for creating custom NMEA sentences. It is reached from the Edit button in
the Nmea Output dialog (see NMEA output interface on page 637).

The path to it is: MENU →System →Sensor
Configuration→NmeaOutput→Details→CU1/2/3/4→Interval→Apply Settings→Edit.

The dialog contains the following elements:
• Select: Select a field from the list in the top window of the menu, and click the Select

button to include it in your custom sentence. It then appears in the bottom window
of the menu.

• Remove: Click to remove a field that is selected in the bottom window from the list
of components of your custom sentence. The selected component then disappear
from the bottom window.

• Up: Click to move the field selected in the bottom window one place up in the list.
• Down: Click to move the field selected in the bottom window one place down in

the list.
• Talker: Specify an individual (two-character) Talker ID for the custom sentence

you are creating.
• Message ID: Specify a three-character alphanumerical Message ID for the custom

sentence.
• Apply: Click to apply your edits.
• Cancel: Click to cancel your edits.
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20.10.9.12 Serial on LAN settings

Some of the dialogs for configuring the interfaces between the MFD system and the
vessel's sensors (or other peripheral devices) include a Settings button. This enables you
to set up a network port on which to receive serial data (such as NMEA sentences).

If you click the Settings button (in those sensor type dialogs that include it), the dialog
that appears will contain the following elements:
• Port: Specify the IP port you want to receive the serial data on.
• Distribute to other consoles: This option enables incoming messages from the LAN to

be sent out again over the LAN to other consoles, using an internal communication
protocol. If all the operator stations in your navigation system are connected to the
LAN, then only one of them needs to be connected to a serial line: the one that
is connected will automatically distribute any data it receives on its serial port to
the other consoles on the LAN. The Distribute to other consoles option is therefore
disabled by default because (for LAN-based navigation systems) there is no need to
distribute the serial data again.
This option takes effect immediately (in other words, before you click the OK button).

• OK: Click to confirm your changes to the port parameter.
• Cancel: Click to cancel your changes to the port parameter.
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20.10.10 Radar Configuration

This is the main menu for configuring the radar transceiver that is currently displaying
on the screen (when interswitch functionality is present).

The path to the menu is: System→Radar Configuration.

The menu contains the following options:
• Video Enhance: Click to alter video enhancement settings. These include sweep

and scan correlation, sweep integration, enhancement of stable echoes, and video
stretching (see Video Enhance on page 643).

• Tracker: Click to configure the sensitivity of the radar tracker (see Tracker on
page 646).

• Type: Click to view and configure the type of radar antenna and transceiver (see
Tx Type on page 647).

• Tx Names: Click to configure transceiver names (see Tx Names on page 648).
• Clutter: Click to configure video clutter parameters (see Clutter Configuration on

page 649).
• Center Suppr: Click to specify the suppression of video at the start of the antenna

sweep (see Center Suppress on page 652).
• Tx: Click to configure radar transmitter parameters (see Tx Configuration on

page 653).
• Rx: Click to configure radar receiver parameters (see Rx Configuration on page 654).
• Azimuth: Click to configure the antenna's azimuth parameters (see Azimuth
Configuration on page 655).

• Tx Mute: Click to inhibit radar transmission in a specified sector (see Tx Mute on
page 656).

• Gain: Click to configure video gain parameters (see Gain on page 657).
• Enable Alternate Vector Perm.: When checked, the combinations of either True

Motion / relative vector or Relative Motion / true vector are possible.
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• Reset Center at Range Chg: Select to reset the screen center automatically when
changing range.

• RIC Version: The version of the firmware on the RIC card for K-Bridge
Multi-functional Display Unit. It will be version 6 or later.

• Default transceiver: Select transceiver at start-up using the buttons.
• Default Gain: Video gain used at start-up. Modify using buttons.
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20.10.10.1 Video Enhance

This dialog enables you to configure five different video enhancement facilities:
• Video stretching
• Enhancement of stable echoes
• Sweep correlation
• Sweep integration
• Scan correlation

For background information about these, see Concepts of video enhancement on
page 743.

The path to this dialog is: System→Radar Configuration→Video Enhance.

Video Stretch area:

The elements in this area control video range stretching. When you turn video stretching
on, radar echo is stretched in length to make it more visible. Stretching is applied at
the specified start range (so as not to clutter the area closes to the own-ship), and will
increase gradually with range.

The elements are as follows:
• On: Switches video stretching on. It is duplicated by the Stretch check box in the

Radar menu (see Radar menu on page 537).
• Start: Specifies a range inside which video stretching will not be applied. The range

is measured (in pixels) from the position of the radar antenna. You can specify values
from 0 through 510.

• Length: Number of pixels by which echoes will be stretched. You can specify values
from 0 through 7.

• Slope: This value has effect in the range just outside the area with no stretching
(specified by the Start parameter): at the end of the non-stretched video, video is
stretched by one pixel; then, after the number of pixels you specify for the Slope
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parameter, the video is stretched two pixels; then after the same number of pixels the
video is stretched by three pixels; and so on until the full stretch length is reached.
You can specify values for the Slope parameter from 0 through 255.

Enhancement of stable echoes area:
• Filter, N Scans: Sets the number of antenna rotations for the filter. We recommend

you set a value in the range 6 through 12.
• Threshold %: Specifies the presentation threshold (in percent) for each pixel. When

the low pass filter is below the threshold, video will be presented in the normal way
(in other words, without enhancement) for the pixel concerned. When video is above
the threshold, the enhanced video colour will be shown for the pixel concerned. We
recommend you set a value in the range 10% through 40%.

• On: Switches the video enhancement facility on. It is duplicated by the Enhance
check box in the Radar menu (see Radar menu on page 537).

• Max Inp rel thresh: ) Limits the input to the filter to a maximum level. The value
is specified as a number relative to the threshold so that it automatically adapts to
changes in the threshold level. The purpose is to restrict the effect of clutter spikes,
which can be very strong but unstable. The value you specify must be greater than 1.
We recommend a value in the range 1.2 through 1.6.

Sweep Correlation in RIC area:
• On: Switches the sweep correlation facility on. It is duplicated by the Sweep

Correlation check box in the Radar menu (see Radar menu on page 537).
• Tolerance: The maximum percentage by which a sweep may be higher in amplitude

than the previous sweep. We recommend you specify a value that is less than 20.

Sweep Integration area:
• Max sweeps: The maximum number of sweeps that may be used for sweep integration.

The number is limited both by this setting and by the calculated number of sweeps
within the radar beam. This calculation is based on the beam width specified for the
vessel (MENU →System →Radar Configuration →Azimuth), the measured antenna
rotation speed, and the measured pulse repetition frequency. A high number will give
more noise reduction but also have a greater “banana effect” on presented targets.
You can set the maximum number of sweeps to a value in the range zero (sweep
integration off) through 20. Most of the noise reduction effect is achieved with a value
of between 5 and 9, depending on the characteristics of the noise.

• Scheme: Specify the type of sweep integration required:
– Integration: If you specify this scheme, the average value of all sweeps is used for

presentation. This gives the best theoretical improvement of detection capabilities
with the most usual noise distribution.

– Integration without max: If you specify this scheme, the sweep with the highest
value is removed, and the average value of the remaining sweeps is used for
presentation. This may give a better detection under some noise conditions,
especially when the noise is mainly spikes.
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– Integration without 2 max: If you specify this scheme, the sweeps with the two
highest values are removed, and the average value of the remaining sweeps is
used for presentation.

• On: Switches the sweep integration facility on (it is duplicated by the Sweep
Integration check box in the Radar menu (see Radar menu on page 537). .

Scan Correlation area:
• On: Switches the scan correlation facility on. It is duplicated by the Scan Correlation

check box in the Radar menu (see Radar menu on page 537). By default, this feature
is on when you have true trails displayed, and off when you have relative trails
displayed. Turn this feature on and off by checking and un-checking the box.

• Scan number: Specifies the number of previous rotations to be used in the comparison.
• Hide uncorrelated: Click and hold down this button to hide echoes that do not appear

in all scans when scan correlation is on. The effect is to clean up the display. To
see the echoes again, release the button.

General area:
• Apply: Click to apply the video enhancement settings.
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20.10.10.2 Tracker

This dialog enables you to set the threshold characteristics for the radar tracker. If the
tracker's sensitivity is too high it will be affected by noise and this will impair the
tracking of the selected targets. If the tracker's sensitivity is too low, it will easily lose
distinct targets. (These parameters are not to be set except by qualified personnel.)

The path to this dialog is: System→Radar Configuration→Tracker.

The dialog contains the following elements:
• Tracker Sensitivity 1-10: Sets the level of video amplitude to search for when tracking

a target. If no echo is found above this level, the target is lost in this scan. This
parameter is also found on the Target menu (see Targets menu on page 380).

• Auto Acquire Threshold (Rel Gate Min Threshold): For auto-acquisition, the threshold
is set higher than the minimum threshold specified by the Tracker Sensitivity 1-10
parameter. This parameter is used by the system to determine the threshold for
auto-acquisition; higher values reduce the tracker's sensitivity to new targets.

• High (Near): Values at close range.
• Low (Far): Values at very long ranges.
• Max: Thresholds with tracker sensitivity 1.
• Min: Thresholds with tracker sensitivity 10.
• Rng Decay Const: Specifies the range decay for the transition from high thresholds

(near the own-ship) to low thresholds (further from the own-ship).
• Rng of Const High: Range close to the own-ship where the thresholds are constant at

high levels before decay starts.
• Apply: Click to apply the new values.
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20.10.10.3 Tx Type

Use this dialog to view or configure the transceiver and antenna type.

The path to the dialog is: System→Radar Configuration→Type.

The dialog contains the following elements:
• Name: Insert an identifying name here. According to IMO requirements, an X or S,

indicating the radar transmitting band, must be included in the identifier.
• Series: Different series of transceivers can be used with the K-Bridge Radar. This

field specifies the applicable series.
• Transceiver: This field further describes the transceiver type within the selected series.
• Antenna: Specifies the antenna in use. If there is more than one antenna connected to

the selected transceiver, there will be a drop-down list for this option.
• Interface: Specifies the interface type for this transceiver (if there is more than one

possible interface).
• Antenna Height: Insert the antenna's height above sea level.
• Use Default Settings: Click to use the default settings (except for Antenna Height) for

this transceiver type. Click once and then confirm to apply this change.
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20.10.10.4 Tx Names

Use this dialog to set the number of radar transceivers connected through the interswitch,
and the names used to identify each transceiver.

The path to this dialog is: System→Radar Configuration→Tx Names.

The dialog contains the following elements:
• Present: Check the box when this transceiver is connected.
• Name: Insert an identifying name here. According to IMO requirements, an X or S,

indicating the radar transmitting band, must be included in the identifier.
• Apply: Click to apply the new names.
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20.10.10.5 Clutter Configuration

Use this dialog to configure manual anti-sea-clutter control. (This menu is for qualified
service personnel only.) Minimum curve is used for the anti sea damping with manual
anti sea set to 12. Maximum curve is used for the anti sea damping with manual anti sea
set to 99. For anti sea set to less than 12, the minimum curve is scaled accordingly. For
anti sea set to more than 12, the damping is found proportionally between the minimum
and the maximum curves.

The path to this dialog is: System→Radar Configuration→Clutter.

The dialog contains the following elements:
• Manual SeaClutter curves: Set the minimum and maximum antisea amplitude the

selectable ranges, and the antisea curve is drawn as a smooth curve through these
points.

• Min %: Sets the anti sea rejection at sea clutter setting 12 in % of full video range.
• Max %: Sets the anti sea rejection at sea clutter setting 99 in % of full video range.
• Apply: Click to apply the minimum and maximum settings.
• Scope: Click the scope button to see the manual sea-clutter curve (see Scope on

page 650).
• More: Click to go to the menu for more clutter and gain parameters (see Radar Cfg
More on page 651).
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20.10.10.5.1 Scope

Use this dialog to view the manual sea-clutter curve. It shows the effect of the manual
sea-clutter control, as well as the resulting video after configuration of the gain and
clutter controls (in red and green). Any echoes below the manual sea-clutter curve
will not appear in the radar video.

The path to the dialog is: System→Radar Configuration→Clutter→Scope.

The upper curve displays maximum curve for anti sea clutter at Anti Sea 99. The
lower curve displays minimum curve for anti-sea clutter at Anti Sea 10. Third black
curve (not shown) displays the selected anti sea clutter with the applied manual anti
sea clutter setting.

The dialog contains the following elements:
• Def. Points: When selected displays the points defining the curves as short red vertical

lines. The curves may be adjusted graphically by dragging these points vertically.
During dragging, the damping in % is shown in the lower left of the menu.

• Pulse Comp.: The curve starts at the end of the transmission pulse, while the range is
from the start. This is compensated for when this is selected.

• TD: Sweep through the target which is selected for Target Data presentation.
• At EBL: Select to display view in EBL direction, shown in red.
• Filtered: Sweep in EBL direction filtered over several rotations. Shown in red
• Cont: Resulting view at intervals, shown in Green.
• <: Decrease the range scale.
• >: Increase the range scale.
• Gain: Shows the present threshold due to gain setting.
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20.10.10.5.2 Radar Cfg More

Use this dialog to configure additional clutter and gain parameters.

The path to this dialog is: System→Radar Configuration→Clutter→More.

The dialog contains the following elements:
• Auto Clutter CFAR Window: Select the length of the CFAR window used to reduce

clutter to the radar target extractor. The normal setting is 64 samples, 200m.
• Auto Clutter Offset: Applies an offset to the threshold in Auto Clutter (both Anti Sea

and Anti Rain) to decrease the video presented in in clutter.
• Rel Gain: Applies an offset to the video into manual rain proportional to the gain, so

that the anti rain will start from the same level as gain.
• Rel Rain: Applies an offset to video into manual rain, so that even more video is

reduced than with just a differentiation. With this control set to more than 0, higher
values of anti rain clutter will lead to removal of echoes with softer edges.
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20.10.10.6 Center Suppress

Use this dialog to set the suppression of video at the start of each radar sweep.

The path to the dialog is: System→Radar Configuration→Center Suppr.

The dialog contains the following elements:
• Center Suppress: The range to be suppressed at the start of each sweep.

The different transmitter pulse lengths are as follows:
– SP: Set video suppression for short pulses (in meters).
– MP: Set video suppression for medium pulses (in meters)
– LP: Set video suppression for long pulses (in meters).
– VLP: Set video suppression for very long pulses (in meters).
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20.10.10.7 Tx Configuration

Use this dialog to set the radar transmitter parameters. Values can only be changed when
the K-Bridge Radar is master for the selected transceiver (see Making the display unit
master of the transceiver on page 107).

The path to this dialog is: System→Radar Configuration→Tx.

The dialog contains the following elements:
• Delay (Range Indexing): Use this parameter to adjust the range of the radar video.
• Pulse Length, SP, MP, LP: Pulse lengths are adjusted separately for short, medium

and long pulses.
• Pulse Length Default Transitions: Transition between SP and MP, and MP and LP

in meters.
• SP - MP: Transition from SP to MP; adjust using the up-down controls.
• MP - LP: Transition from MP to LP; adjust using the up-down controls.
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20.10.10.8 Rx Configuration

Use this dialog to configure Decca radar receiver parameters. Values can only be
changed when the K-Bridge Radar is master for the selected transceiver (see Making
the display unit master of the transceiver on page 107).

The path to the dialog is: System→Radar Configuration→Rx.

The dialog contains the following elements:
• Ampl.: The amplitude of the incoming video signal to the interswitch, for short pulse

(SP), medium pulse (MP) and long pulse (LP).
• Offset: The offset of the incoming video signal to the interswitch, for short pulse (SP),

medium pulse (MP) and long pulse (LP).
• Coarse Tune Setting: Used to set the operating range for Automatic Tune and Manual

Fine Tune (Operator Tuning). Use slider for fast adjustment and spin buttons for fine
setting. See commissioning documentation for details.

• Tune: Tune indicator to see the effect of Coarse Tune Setting.
• Apply: Applies the entered values.
• Scope: Click to bring up the Scope menu (see Scope on page 650).The video curve

(with gain set to maximum and clutter rejection off) is used to verify the settings for
video amplitude and video offset.
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20.10.10.9 Azimuth Configuration

Use this dialog to configure the antenna azimuth. Values can only be changed when
the K-Bridge Radar is master for the selected transceiver (see Making the display unit
master of the transceiver on page 107).

The path to this dialog is: System→Radar Configuration→Azimuth.

The dialog contains the following elements:
• No of Pulses pr rev: Number of pulses per antenna revolution. For Decca 4096 is

the default.
• Azimuth Correction: Align the radar with the own-ship's centre line by using the

up-down controls.
• Beam Width: Horizontal 3dB width of the radar beam (main look).
• Starboard of CL: Location of radar antenna.
• Fore of Aft Peak: Location of radar antenna.
• Apply: Click to apply changes.
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20.10.10.10 Tx Mute

Use this dialog to inhibit radar transmission in a specified sector. Values can only be
changed when the K-Bridge Radar is master for the selected transceiver (see Making
the display unit master of the transceiver on page 107).

The path to this dialog is: System→Radar Configuration→Tx Mute.

The dialog contains the following elements:
• Tx Mute Sector 1/2:

– Active: Select to switch the mute sector on/off.
– Start Bearing: Relative to the own-ship's heading line.
– End Bearing: Relative to the own-ship's heading line.
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20.10.10.11 Gain

Use this dialog to configure video gain parameters

The path to this dialog is: System→Radar Configuration→Gain.

The dialog contains the following elements:
• Detection Levels: Sets the video detection levels, i.e. the video strengths used as

limits between different video strengths.
• RIC Gain: Used to set the meaning of maximum and minimum gain.
• Calibrate: Sets offset to 0, gain to 1 and clutter off. Will show the input signal directly

in the STC Curve/Scope menu.
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20.10.11 Autopilot Configuration

Use this dialog to configure the relationship between the autopilot and the K-Bridge
Radar system.

The path to the dialog is: System→AP Configuration.

The dialog contains the following elements:
• AP in Command enabled: Check to allow autopilot control from this console.
• Default In Command (Global): Check the box to make this operator station the one

that takes command of the autopilot whenever the vessel's steering system is switched
from manual control to autopilot. (For more information, see Making one console
take command of the autopilot by default on page 249.)

• Route Monitoring enabled: Check to allow route monitoring from this console.
• Report local AP command as alarm: Check to generate an alarm when the autopilot

transitions from Track or Waypoint mode to Heading or Course mode. Such a
transition means that command of the steering gear is now “local” to the autopilot,
and the following alarm is therefore issued: ANTS Mode Terminated, WPT/TRACK
mode changed to LOCAL by AP!. If this option is not checked, then no alarm
will be issued when the transition occurs but an information-only message will be
issued (appearing in the alarms and message area) and a beep sounded. The message
will say: Local Autopilot Command!

• AP Turn Prewarn.: For setting the turn pre-warning alarm time. This is the amount
of time before the next WOP (Wheel Over Point) that the turn pre-warning alarm
sounds. You can set it to sound at 2, 3, 4 or 5 minutes before the next WOP. The
default is 3 minutes.

• AP Turn Warn.: For setting the turn warning alarm time. This is the amount of time
before the next WOP that the turn warning alarm sounds. You can set it to sound at
30, 45 or 60 seconds before the next WOP. The default is 30 seconds.

• Low Speed Alarm Limit: The speed limit below which track steering is not allowed.
• Apply: Click to apply the new values.
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20.10.12 Integration Configuration

Use this dialog to specify the navigation master console: one of the consoles (it can
belong to a K-Bridge Radar or a K-Bridge ECDIS system or to an MFD system) on
the network can be defined as the Navigation Master. Then the calculated position,
speed, heading and time from this console will be transferred over the LAN and used
by all the other consoles on the network. The path to the dialog is: System→Integration
Configuration. The dialog contains the following options and buttons:
• Master Enable: Check this box if this console is to be the master. Typically only the

consoles at the front of the bridge have the Master Enable option enabled. If Master
Enable is selected, the check boxMaster will appear in the Own Ship Data dialog (see
Own-ship Data on page 442).

• Slave Enable: Check this box if the console is to receive its navigation data from
the master console. Typically, a console that is located away from the front of the
bridge, such as a PL10 station, will have its Slave Enable option checked and its
Master Enable option unchecked.

• Master at Start: When this option is checked on a console, that console will make
itself the navigation master at start-up, transmitting common position, speed, heading
and time data to the other K-Bridge consoles. Make sure only one console is
configured to be Master at Start.

• Warning if No Master: Enable: If no navigation master is detected by the console, it
can send a warning about this to the other consoles on the network. Check the Enable
box if you want the console to send such a warning.

• Delay from start: The delay in minutes after the console starts up, before it sends a
warning that it has detected no navigation master on the network. (It only sends
this warning if you have checked the Enable option under the label Warning if no
Master.) The delay specify allows all operator stations to become operational (if
they were started at the same time) before the console issues the warning that it has
detected no navigation master.

• Apply: Click to apply the new values.
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• (Continuous own-ship logging) On/Off: When this option is checked, continuous
logging of internal system data is switched on. You can specify the number of
hours for which data will be stored (before the buffer starts to overwrite previously
stored data). The default (which is also the maximum) is 72 hours. Logging must
be switch on at all times. Do not un-check this option unless requested by a KM
service engineer to switch logging off.

• Apply: Click to apply your logging behaviour changes.
• Save: Click to save the current contents of the logged data buffer to the hard disk

(C:\radec\logging). If you need to save the logged data, remember that the buffer
overwrites itself after the time period specified in this dialog.

• Export: Save the contents of the logged data buffer to an alternative location, for
example, a removable media device.

• (Filter settings (advanced)) Reduce speed 5kn factor: This parameter reduces the
estimate that the filter makes of the speed log’s accuracy when speed through water
is below 5 kn. The default factor of reduction is 1. Do not change this value unless
requested to by a KM service engineer.

• Apply: Click to apply any changes you have made to the advanced filter settings.
• Rotate gvec: When checked, this option causes the filter to use a particular simplified

kinematic vessel model. By default, the setting is checked. Do not un-check it unless
requested to by a KM service engineer.

• (MOB integration): Global Delete Enabled: Check to enable this operator station to
reflect the deletion of a Man Over Board (MOB) event symbol by another operator
station. By default the setting is checked.
(To delete a MOB symbol on your screen, right-click over it and select Delete.)

• Global Drag Enabled: Check to enable this operator station to reflect the moving
(dragging) of a Man Over Board (MOB) event symbol by another operator station.
By default the setting is checked.
(To be able to drag a MOB symbol on your screen, you must first right-click over it
and select Edit. You can then drag it with the trackball.)

For more information about using this dialog, see Making one console the navigation
master on page 130.
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20.10.13 Configure Route Export

Use this dialog to configure the system to export and import route plans to and from
other systems.
The path to the dialog is: System→Route Export Configuration.
For information about how to perform the import and export procedures, see Importing
and exporting route information on page 242.
This dialog contains the following elements:
• None: Select to prevent any importing or exporting of route plans from and to other

systems.
• Only Export: Select if you want to permit the system to export route plans but not

import them.
• Only Import: Select if you want to permit the system to import route plans but not

export them.
• Single Export/Import Directory: Select if you want to use the same directory for both

importing and exporting route plans.
• Separate Export/Import Directory: Select if you want to use different directories for

importing and exporting route plans.
• Export Directory: Specify the directory to which you want to export route plans.

(You can specify a directory on a USB memory stick, for example.) If you specify
a directory on an external computer system, both that computer system and the one
you are exporting from must be connected to the Local Area Network. The console
you are exporting from must have read-write access to the export (target) directory on
the external computer system.

• Exchange Protocol (RRXP): Select if you are using the RRXP exchange protocol
(see The implementation of the RRXP exchange process on page 243) instead of a
straightforward file copy.

• Test: Click to check whether the system is able to access the export directory.
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• Import Directory: Specify the directory from which you want to import route plans.
(You can specify a directory on a USB memory stick, for example.) If you specify a
directory on an external computer system, both that computer system and the one you
are importing to must be connected to the Local Area Network. The computer you
are importing to must also have read access to the source directory on the external
computer system.

• Exchange Protocol (RRXP): Select if you are using the RRXP exchange protocol
(see The implementation of the RRXP exchange process on page 243) instead of a
straightforward file copy.

• Test: Click to check whether the system is able to access the import directory.
• Act as Client (RRXP): Select to make this console the “client” in relation to the

external system that it is exporting to or importing from.
• Apply: Click to save your configuration. The directories you specify will be used as

the source and target locations when you import or export route plans.
• Cancel: Click to cancel your changes.

20.10.14 ARP (Arm Rest Panel) Configuration

This dialog concerns Arm Rest Panels that have a keyboard and/or mouse directly
connected to them.

The Arm Rest Panels (if installed) enable you to use the main radar and ECDIS functions
available on an operator station without leaving your seat. If a mouse and keyboard are
connected to the arm rest panel, you can use these to navigate the user interface of an
operator station remotely and enter input data to it.
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This dialog enables you to reset the operator station’s internal data concerning the
panel-attached keyboard and mouse buttons. (It is provided because the operator station
can occasionally fail to register that certain keyboard keys or mouse buttons have been
released after they were pressed.)
Before using the dialog, make sure that nothing is physically preventing the release of
any keys on a keyboard or any buttons on a mouse that is connected to an Arm Rest
Panel (make sure also that no keys/buttons on the operator station’s own keyboard/mouse
are currently pressed).
The dialog contains a checkbox for the left, right and middle buttons on a mouse and
for six keys on a keyboard (the left and right Ctrl, Shift, and Alt keys). If any of the
checkboxes are checked and no keys or mouse buttons have been intentionally pressed,
use the Reset Keys and Reset Mouse button to reset the operator station’s internal data
concerning the keyboards and mouse devices connected to it (both those connected
locally and those connected remotely through an Arm Rest Panel).
You can also use the dialog to check the LAN communication between the operator
station you are using and up to two Arm Rest Panels.
The path to the dialog through the menu system is: System→ARP Configuration.
The dialog contains the following indicators and buttons:

ARP1/2
• LAN A/B: LAN function indicators.

– Green indicates that LAN communication between the operator station and the
Arm Rest Panel is OK.

– Red indicates that LAN communication has failed between the operator station
and the Arm Rest Panel.

• Restart: Click to restart the Arm Rest Panel (ARP1 or ARP2).
• Restart Both ARP: Click to restart both Arm Rest Panels.

Keys Pressed Status
• Left/Right Alt Key: If an Alt key box is checked, press Reset Keys to reset the

keyboard for both panels.
• Left/Right Shift Key: If a Shift key box is checked, press Reset Keys to reset the

keyboard for both panels.
• Left/Right Ctrl Key: If a Ctrl key box is checked, press Reset Keys to reset the

keyboard for both panels.

Mouse Pressed Status
• Left Button: If this box is checked, press Reset Mouse to reset the mouse for both

panels.
• Right Button: If this box is checked, press Reset Mouse to reset the mouse for both

panels.
• Middle Button: If this box is checked, press Reset Mouse to reset the mouse for both

panels.
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20.10.15 Shutdown

Use this menu to perform different switching, restarting and power-off operations.

The path to the menu through the menu system is: System→Shutdown.

It contains some or all of the following buttons, depending on the application you
view it from:
• Switch to ECDIS/Radar/Conning: Click twice to switch to the application you require.
• Restart Program: Click twice to restart the MFD program (including the ECDIS,

Radar and Conning applications).
• Shutdown Program: Click twice to shut down the MFD program (including the

ECDIS, Radar and Conning applications).
• Restart Computer: Click twice to stop the MFD program (including the ECDIS, Radar

and Conning applications) and restart the entire computer.
• Power Off: Click twice to stop all programs and remove power to the computer.
• Cancel: Use this button if you have clicked once on one of the other buttons in this

dialog and then changed your mind. Clicking Cancel cancels the first click on one of
the other buttons.

Note

The buttons in this menu (except for the Cancel button) require a second click before
they take effect. When you make the first click a confirmation prompt appears in the
dialog's text window.
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Appendix A
Alerts and Operator
Messages

This section contains the following topics:
Introduction....................................................................................................................666
The MFD’s behaviour in response to different priorities of alert ..................................666
Navigation system alerts ................................................................................................668
Radar and ECDIS operator messages ............................................................................732
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A.1 Introduction
This appendix lists and describes the alerts that are generated by the K-Bridge navigation
system, including the operator stations, the SINT (Sensor Integrator), the autopilot and
the speedpilot.

It also lists the operator messages that can appear at the top of the range panel in the
Radar and ECDIS applications (see Radar dashboard: the operator message field on
page 78 and ECDIS range panel: operator message the field on page 88).

A.2 The MFD’s behaviour in response to
different priorities of alert
Alarm priority alerts

A new alarm priority alert will cause the following events to continue until the alert
is acknowledged:
• Flashing (red) of the relevant alert group button (see Top bar: the alert area on

page 60); once the alert has been acknowledged, the button will remain a constant red
as long any acknowledged alarm priority alerts remain uncleared (and there are no
new unacknowledged alarm priority alerts)

• Initiation of the BNWAS alarm sequence if the alarm’s category of severity is A (see
The BNWAS alarm sequence on page 276)

• Transmission of the alarm sound
• Flashing of the ALARM lamp on the operator panel (see The Alarms group on

page 39); once the alert has been acknowledged, the lamp will remain a constant
red as long any acknowledged alarm priority alerts remain uncleared (and there are
no new unacknowledged ones)

Warning priority alerts

A new warning priority alert will cause the following events to continue until the
warning is acknowledged:
• Flashing (yellow) of the relevant alert group button (see Top bar: the alert area

on page 60); once the warning has been acknowledged, the alert group button will
remain a constant yellow as long any acknowledged warning priority alerts remain
uncleared (and there are no new unacknowledged ones)

• The transmission of a beep if the operator station has been configured to give a beep
when a warning is received

• The flashing of the ALARM lamp on the operator panel (see The Alarms group on
page 39); once the warning has been acknowledged, the lamp will remain a constant
red as long any acknowledged warning priority alerts remain uncleared (and there are
no new unacknowledged ones)
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Caution priority alerts

A new caution priority alert will be automatically acknowledged by the operator
station that generates it. Therefore it will never appear on the top bar or in the list of
unacknowledged alerts (see The Unacknowledged alerts button on page 69). Similarly
it will not cause the top bar button for the relevant alert group to flash, because only
unacknowledged alerts cause this to happen.

For more information about alert priorities, see The Alert priority button on page 66.
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A.3 Navigation system alerts
This section lists the navigation system alerts. For each alert, the following information
is given:
• Alert Message: The text that appears in the alert area on the top bar (see Top bar: the
alert area on page 60).

• Alert Description: The text that appears in the Alert Group dialog (see The Alert
list dialogs on page 70).

• Cause: Possible causes of the alert condition.
• Action: Suggestions for solving the problem.
• Priority: Whether the alert is an alarm, warning or caution (plus its category of

severity, A, B or C).

Message: Active gyro changed
Description: Active gyro changed, gyro n
Priority: Caution (category B)

Possible
cause:

An automatic switchover from one gyro to another has been performed.

Acknowledge
from:

No manual acknowledgement required (cautions are automatically
acknowledged when generated).

Suggested
action:

Check the gyro that appears to have failed.

Message: Active position sensor changed
Description: Active position sensor changed, position sensor n
Priority: Caution (category B)

Possible
cause:

An automatic switchover from one position sensor to another has been
performed.

Acknowledge
from:

No manual acknowledgement required (cautions are automatically
acknowledged when generated).

Suggested
action:

Check the position sensor that appears to have failed.

Message: AIS alert
Description: AIS alert
Priority: Warning (category B)

Possible
cause:

Alert received from the AIS.

Acknowledge
from:

Any K-Bridge operator station from which it is possible to control
the AIS system.

Suggested
action:

Check the AIS for failures.
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Message: AIS functionality switched off
Description: AIS functionality switched off
Priority: Warning (category B)

Possible
cause:

Position calculation has been performed using dead-reckoning for 10
minutes. AIS functionality on the operator station has been switched
off.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the position sensor.

Message: AIS safety message received
Description: AIS safety message received
Priority: Warning (category B)

Possible
cause:

A safety message was received from the AIS system.

Acknowledge
from:

Any K-Bridge operator station from which it is possible to control
the AIS system.

Suggested
action:

Read the AIS safety message and take appropriate action.

AIS target capacity
Description: AIS target capacity is at 90%: only nearest targets presented
Priority: Caution (category B)

Possible
cause:

The number of AIS targets is about to exceed the capacity of the
system. More distant AIS targets will be ignored.

Acknowledge
from:

No manual acknowledgement required (cautions are automatically
acknowledged when generated).

Suggested
action:

Do not rely on the automatic detection of AIS targets.

Message: Anchor watch limit exceeded
Description: Anchor watch limit exceeded
Priority: Alarm (category B)

Possible
cause:

The own-ship has activated the anchor watch facility, and the distance
from the given anchorage point has exceeded the anchor watch limit.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Acknowledge the alert.
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Message: ANTS mode terminated
Description: ANTS stopped, AP comm fail
Priority: Alarm (category B)

Possible
cause:

An autopilot is configured and a route is being monitored, but the
autopilot has not sent a communication message for the last 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check if the autopilot is functioning.

2 Revert to manual steering if necessary.

Message: ANTS mode terminated
Description: ANTS stopped, AP insufficient data
Priority: Alarm (category B)

Possible
cause:

The autopilot has terminated track steering after receiving incorrect
or incomplete data.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the connections between the autopilot and the sensors.

2 Check the connections between the autopilot and the commanding
operator station.

3 Revert to manual steering if necessary.

Message: ANTS mode terminated
Description: ANTS stopped, AP sail data internal error
Priority: Alarm (category B)

Possible
cause:

The autopilot has encountered an unexplained error.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try re-engaging track steering.

2 Revert to manual steering if necessary.
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Message: ANTS mode terminated
Description: ANTS stopped, commanding DCU stopped
Priority: Alarm (category B)

Possible
cause:

The operator station that was in command of the autopilot has shut
down.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Engage track steering from another operator station.

Message: ANTS mode terminated
Description: ANTS stopped, ECDIS or conning missing
Priority: Alarm (category B)

Possible
cause:

The autopilot has terminated track steering because it has detected
that there is either no ECDIS or no Conning station currently active
on the bridge.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Activate an ECDIS or Conning station (as applicable).

2 Re-engage track steering

Message: ANTS mode terminated
Description: ANTS stopped, hdg input failure
Priority: Alarm (category B)

Possible
cause:

The input from the heading sensor has failed. The radar or ECDIS has
aborted control of the autopilot, which is now under local control. The
autopilot will maintain the heading it was keeping just before track
steering was terminated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Select another heading sensor.

2 Re-engage track steering
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Message: ANTS mode terminated
Description: ANTS stopped, pos input failure
Priority: Alarm (category B)

Possible
cause:

Input from the position sensor has failed. The radar or ECDIS has
relinquished control of the autopilot.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Select another position sensor.

2 Re-engage track steering

Message: ANTS mode terminated
Description: ANTS stopped, position jump
Priority: Alarm (category B)

Possible
cause:

The autopilot has terminated track steering because there has been an
input jump. An input jump means that the deviation between the actual
input and the expected input (based on the filtered position readings)
exceeds the alarm limit for the selected position sensor (see Position
sensor details on page 623).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

XTD jumps normally occur because of position jumps. Check the GPS
and the ship's position on the chart for position jumps.

Message: ANTS mode terminated
Description: ANTS stopped, route End
Priority: Alarm (category B)

Possible
cause:

The radar or ECDIS has been in command of the autopilot, and the last
waypoint in the monitored route has been passed. The radar or ECDIS
has relinquished control of the autopilot.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Select another route to monitor.

2 Re-engage track steering
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Message: ANTS mode terminated
Description: ANTS stopped, spd input failure
Priority: Alarm (category B)

Possible
cause:

The radar or ECDIS station has been in command of the autopilot;
a Route is being monitored. The steering mode is either Track or
Waypoint. Input from the speed sensor has failed. The radar or ECDIS
has aborted control of the autopilot, which is now under local control.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Select another speed sensor.

2 Re-engage track steering

Message: ANTS mode terminated
Description: ANTS Stopped, track mode changed to local by AP
Priority: Alarm (category B)

Possible
cause:

Someone on the bridge has switched command of the autopilot from
an operator station to the small K-AP operator panel. This has caused
the autopilot to terminate track steering.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

You can re-engage track steering from the operator panel or take
command again at an operator station and re-engage track steering
from there.

Message: ANTS mode terminated
Description: ANTS stopped, track not allowed using selected position sensor
Priority: Alarm (category B)

Possible
cause:

The selected position sensor is not accurate enough to be used for
track steering.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another position sensor.
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Message: ANTS mode terminated
Description: ANTS stopped, XTD jmp
Priority: Alarm (category B)

Possible
cause:

The radar or ECDIS has been in command of the autopilot, and there
has been a sharp increase in the XTD. The radar or ECDIS has aborted
control of the autopilot, which is now under local control.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

XTD jumps normally happen as a result of jumps in the GPS readings.
Check the GPS for position jumps.

Message: AP course/hdg/waypoint mode terminated
Description: AP course/hdg/waypoint mode terminated
Priority: Alarm (category B)

Possible
cause:

Input from a heading, speed or position sensor (as applicable) has
failed.

The radar or ECDIS has aborted control of the autopilot, which is
now under local control.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Select another heading, speed or position sensor (as applicable).

2 Re-engage the autopilot in the required operating mode.

Message: AP turn pre-alert
Description: Ship will turn in nn min
Priority: Alarm (category A)

Possible
cause:

A route is being monitored, and radar or ECDIS is in command of the
autopilot. Track steering is in operation (or was when the alert was
issued). There are nn minutes till the ship begins its turn. (This alarm
will be succeeded by an “AP turn” alarm.)

Acknowledge
from:

If the autopilot is:
• In track steering mode, you can acknowledge the alert from any

K-Bridge operator station that is currently in command of the
autopilot.

• Not in track steering mode anymore but you are monitoring a route,
you can acknowledge the alert from any K-Bridge operator station
that does not currently have the ECDIS browse facility activated
(for browsing away from the vessel on the chart).
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If you are not monitoring a route, you can acknowledge the alert from
any K-Bridge operator station.

Suggested
action:

Check that your planned route is safe.

Message: AP turn pre-alert
Description: WOP will be passed in nn Min
Priority: Warning (category A)

Possible
cause:

A route is being monitored, and radar or ECDIS is in command of
the autopilot. The steering mode is WP (Waypoint), CRS (Course),
or HDG (Heading). There are nn minutes till the Wheel-over Point is
reached. (This warning will be succeeded by an “AP turn” warning.)

Acknowledge
from:

If the autopilot is:
• In WP, CRS, or HDG mode, you can acknowledge the alert from

any K-Bridge operator station that is currently in command of the
autopilot.

• Not in WP, CRS, or HDG mode anymore but you are monitoring a
route, you can acknowledge the alert from any K-Bridge operator
station that does not currently have the ECDIS browse facility
activated (for browsing away from the vessel on the chart).

If you are not monitoring a route, you can acknowledge the alert from
any K-Bridge operator station.

Suggested
action:

Check that your planned route is safe.

Message: AP turn
Description: Ship will turn in nn Sec
Priority: Alarm (category A)

Possible
cause:

A route is being monitored. Radar or ECDIS is in command of the
autopilot. Track steering is in operation. There are nn seconds till the
ship begins its turn.

Acknowledge
from:

If the autopilot is:
• In track steering mode, you can acknowledge the alert from any

K-Bridge operator station that is currently in command of the
autopilot.

• Not in track steering mode anymore but you are monitoring a route,
you can acknowledge the alert from any K-Bridge operator station
that does not currently have the ECDIS browse facility activated
(for browsing away from the vessel on the chart).
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If you are not monitoring a route, you can acknowledge the alert from
any K-Bridge operator station.

Suggested
action:

Check if it is safe to turn, and, if it is, then allow the autopilot to
proceed with the turn.

Message: AP turn
Description: WOP will be passed in nn Sec
Priority: Warning (category A)

Possible
cause:

A route is being monitored. Radar or ECDIS is in command of the
autopilot. The steering mode is WP (Waypoint), CRS (Course), or
HDG (Heading). There are nn seconds till the Wheel-over Point is
reached.

Acknowledge
from:

If the autopilot is:
• In WP, CRS, or HDG mode, you can acknowledge the alert from

any K-Bridge operator station that is currently in command of the
autopilot.

• Not in WP, CRS, or HDG mode anymore, you can acknowledge
the alert from any K-Bridge operator station that is monitoring the
route and is not using the ECDIS browse facility (for browsing
away from the vessel on the chart).

If you are not monitoring a route, you can acknowledge the alert from
any K-Bridge operator station.

Suggested
action:

Check the planned course, and, if it is safe to do so, proceed with the
turn. To execute the turn you must send new orders to the autopilot
manually (for example, by using the heading wheel).

Message: Area
Description: Area
Priority: Warning (category A)

Possible
cause:

The own-ship is near to a caution area.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Take action to avoid the specific danger associated with the caution
area.
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Message: Auto Acq off, few free targets
Description: Auto Acq switched off, few free targets
Priority: Warning (category A)

Possible
cause:

There are fewer than five free targets in the target table.
Auto-acquisition is switched off.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Remove targets that are no longer of interest. If required adjust the
auto-acquisition area and/or the tracker sensitivity, and restart the
auto-acquisition.

Message: Autopilot change steering mode
Description: Autopilot change steering mode
Priority: Alarm (category B)
Acknowledge from: any K-Bridge operator station

Possible
cause:

This alert will be preceded by a “SINT gyro compass switch” alert.
It means that the Grounding Avoidance System has detected that the
heading sensor was failing and has triggered the selection of another
heading sensor.

Suggested
action:

If you are currently using track steering, track steering will continue
uninterrupted by the system. However, you need to come out of track
steering and check the operation of the new gyro before re-engaging
track steering.

Message: Autopilot check system
Description: Autopilot check system
Priority: Warning (category B)

Possible
cause:

Control of the vessel’s steering gear has been switched from automatic
to manual and then back to automatic within less than 5 seconds. This
warning can be the result of a loose connection in the mode selector
switch.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If the switch between steering modes was performed intentionally,
just acknowledge the alarm and take no action. Otherwise, check the
connection in the steering control system’s mode selector switch.
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Message: Autopilot comm. fail
Description: Autopilot comm. fail
Priority: Warning (category B)

Possible
cause:

The Nav OS has not received any serial input from the autopilot
controller in the SINT for at least 5 seconds. This may indicate that the
autopilot controller is malfunctioning, a communication link is broken,
or the communication hardware in the SINT is malfunctioning.

This alarm is generated when the Nav OS detects a serial
communication failure between the autopilot and the Nav OS. The
serial communication might be over a physical serial connection or a
virtual serial connection that uses the LAN.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try taking command of the autopilot from another Nav OS.

2 Check that the configuration of the autopilot sensor input is
correct (select System→Sensor Configuration→Autopilot→Details).
To perform this check, you need to use the service password.

3 Check whether the text field at the bottom of the Autopilot Mode
dialog (Route→Autopilot Mode) contains the alarm message !!
Autopilot Comm. Fail !!.
If it does, this is evidence that there is no serial communication
between the operator station and the autopilot.

4 Check the operation of the other Nav OSes.
If the Autopilot Mode dialog on any other operator stations also
contains the alarm message !! Autopilot Comm. Fail
!!, then it is likely that there is a problem with the Local Area
Network (LAN). If any K-Bridge operator station on the LAN
has hung or is operating slowly, this could be causing a network
traffic jam that is blocking the LAN-based serial communication
between the OS that is in command and the autopilot.

5 Restart any K-Bridge operator stations that have hung or are
operating slowly.

6 If your Nav OS is no longer in command of the autopilot, switch
the vessel's steering control system to manual steering.

7 Restart the SINT.
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Message: Autopilot communication failure
Description: Autopilot communication failure
Priority: Warning (category B)

Possible
cause:

The Nav OS has not received any OPC signal from the autopilot
controller in the SINT for at least 5 seconds. This may indicate that the
autopilot controller is malfunctioning, a communication link is broken,
or the communication hardware in the SINT is malfunctioning.

This alarm is generated when the Nav OS detects a failure of
communication using the OPC protocol between the autopilot and the
Nav OS. The OPC protocol is used to pass configuration parameters –
but not control commands – from the Nav OS to the autopilot (control
commands are sent over a serial connection).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try taking command of the autopilot from another Nav OS.

2 Check that the fields of the Autopilot Panel dialog
(Route→Autopilot Panel) contain valid data and not a series of star
characters (****).
If the dialog fields contain star characters, this is further evidence
that there is no OPC communication between the operator station
and the autopilot.

3 Check the operation of the other Nav OSes.
If the Autopilot Panel dialog on another (or on more than one
other) operator station also displays star characters (****), then
it is likely that there is a problem with the Local Area Network
(LAN).
If any K-Bridge operator station on the LAN has hung or appears
to be operating slowly, this could be causing a network traffic jam
that is blocking the OPC communication between the Nav OS that
is in command and the autopilot.

4 Restart any K-Bridge operator stations that have hung or are
operating slowly.

5 If your Nav OS is no longer in command of the autopilot, switch
the vessel's steering control system to manual steering.

6 Restart the SINT.
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Message: Autopilot compass difference
Description: Autopilot compass difference
Priority: Alarm (category A)

Possible
cause:

The difference between the heading on the main and monitoring
compasses is greater than permitted. If one of the compasses is
magnetic, this alarm is likely to have been caused by a change in
its magnetic deviation. Alternatively it could be caused by transient
reading differences due to yawing. The most serious possible cause is
the failure of one of the compasses.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check that the heading Compass Difference Limit is set correctly

(select: Route→Autopilot Panel→Autopilot Setup→User (tab)).
2 If both the main and monitoring compasses seem to be

functioning correctly, try varying the combination of values for
the Compass Difference Limit and the secondary Compass Offset.

Message: Autopilot configuration error
Description: Autopilot configuration error
Priority: Alarm (category B)

Possible
cause:

One or more configuration parameters are invalid.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the parameter settings.

Message: Autopilot data logging fail
Description: Autopilot data logging fail
Priority: Warning (category B)

Possible
cause:

The autopilot controller's internal data logging has failed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try restarting the SINT.

2 Then restart data logging by opening the Autopilot Panel,
selecting the Service Parameters tab, and selecting the 1=TSF
option in the logging list box.
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Message: Autopilot data logging started
Description: Autopilot data logging started
Priority: Warning (category B)

Possible
cause:

The autopilot controller's internal data logging has been started.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Continue normal operation.

2 If an abnormal situation occurs, collect all the log files by opening
the Autopilot Panel and pressing the Save button (this enables you
to save the files to a USB stick).

Message: Autopilot data logging stopped
Description: Autopilot data logging stopped
Priority: Warning (category B)

Possible
cause:

The autopilot controller's internal data logging has been stopped.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Continue normal operation but be aware that no data inputs or

outputs from the autopilot are now being logged.
If an abnormal situation occurs, you will have no history of it.

2 You can start logging again by opening the Autopilot Panel,
selecting the Service Parameters tab, and selecting the 1=TSF
option in the logging list box.

Message: Autopilot ground log
Description: Autopilot ground log
Priority: Alarm (category B)

Possible
cause:

The autopilot controller is receiving no data from the ground speed log.

If the autopilot’s Ground Log parameter (Route→Autopilot
Panel→Autopilot Setup→Dockside (tab)) is set to NAV, then the
autopilot receives its ground speed log input from the Nav OS.
Therefore, if the autopilot ever loses communication with the Nav OS,
the Autopilot ground log alert will be generated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the ground speed log sensor and its network connection.

2 If the failure occurred while the autopilot was performing
automated track steering, check the setup of the operator station.
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3 Check that the autopilot's Ground Log parameter has been
set correctly (select: Route→Autopilot Panel→Autopilot
Setup→Dockside (tab)).

Message: Autopilot invalid nav data
Description: Autopilot invalid nav data
Priority: Alarm (category B)

Possible
cause:

The autopilot controller (in the SINT) is not receiving valid data from
the operator station. This usually means there is a problem either with
the Nav OS or the with the network operating between the Nav OS
and the autopilot controller.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the operator station setup.

2 Check the network.
3 If the failure persists, use another operator station to control the

autopilot.
4 Restart the operator station and try using it again to control the

autopilot.

Message: Autopilot main compass
Description: Autopilot main compass
Priority: Alarm (category B)

Possible
cause:

Data from the main compass is not being received by the autopilot
controller. This indicates a malfunctioning main compass or loss of
communication between the autopilot and the main compass. This
failure message will be followed by a “Switch to Manual Steering”
message.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Switch to manual steering.

2 Check the main compass and the cable connected to it.
3 Select an alternative main compass.
4 Try restarting the SINT.
5 If the problem remains, do not use the autopilot.
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Message: Autopilot monitor compass
Description: Autopilot monitor compass
Priority: Alarm (category A)

Possible
cause:

Data from the secondary compass is not being received by the autopilot
controller in the SINT. This indicates a malfunctioning secondary
compass or loss of communication between the autopilot and the
secondary compass.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Switch to manual steering.

2 Check the secondary compass and the cable connected to it.
3 Select an alternative secondary compass.

Message: Autopilot new waypoint
Description: Autopilot new waypoint
Priority: Warning (category B)

Possible
cause:

The vessel is approaching a waypoint. The autopilot is operating in
track mode. The vessel will turn as commanded by the Nav OS in
30 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Prepare for the vessel to turn in 30 seconds.

Message: Autopilot no nav comm
Description: Autopilot no nav comm
Priority: Alarm (category B)

Possible
cause:

The operator station has lost contact with the autopilot controller in the
SINT. This may indicate that the autopilot controller is malfunctioning,
that a communication link is broken, or that the communication
hardware in the SINT is malfunctioning.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try taking command of the autopilot from another operator

station.
2 Switch the vessel's steering control system to manual steering.
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Message: Autopilot no panel in command
Description: Autopilot no panel in command
Priority: Alarm (category B)

Possible
cause:

No operator panel is in command of the autopilot.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Take command at an autopilot panel or a Nav OS.

Message: Autopilot off course
Description: Autopilot off course
Priority: Alarm (category A)

Possible
cause:

The difference between the vessel's heading and its current set-point
exceeds the Off Course Limit.

Acknowledge
from:

You can acknowledge this alert from any K-Bridge operator station
that is in command of the autopilot and is not using the ECDIS browse
facility (for browsing away from the vessel on the chart).

Suggested
action: 1 Check the accuracy of the vessel's compasses, speed log, and

rudder feedback.
2 Make sure the vessel's steering gear is functioning properly.
3 Check that the Off Course Limit parameter is set correctly

for the waters you are sailing in (select: Route→Autopilot
Panel→Autopilot Setup→User (tab)).

4 If the warning comes up frequently, it is probably caused by wave
disturbance:
a If you are using the autopilot's Economy mode (set in the

Autopilot Panel dialog), try Precision mode.
b If the user setup parameter Wave Filtering (in the User tab)

is ON, try setting it to OFF.
c If the autopilot is steering inappropriately in rougher waters,

you may need to perform the sea-trial procedure again.
For instructions about performing the sea trial, refer to the
K-Bridge Autopilot Operator Manual.
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Message: Autopilot panel no. n no contact
Description: Autopilot panel no. n no contact
Priority: Alarm (category B)
Possible
cause:

The autopilot panel no. n is no longer reporting its presence on the
network. Check if the panel is powered and if it is responsive.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check if the panel is powered and if it is responsive.

Message: Autopilot parameters need to be saved
Description: Autopilot parameters need to be saved. Check dockside setup
Priority: Warning (category B)

Possible
cause:

This message appears if the autopilot's master parameters have been
reset and the autopilot is now performing a sea-trial to find new
adaptation parameters for the ship.

The performance of the autopilot may vary or not be optimal until the
sea trial is finished.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Since there is no 'auto-save' functionality, if you perform a sea-trial
or master reset you must manually save the new current settings
frequently during the sea-trial procedure and also once when the sea
trial is finished.

To save the parameters during the sea trial or when the sea trial has
finished:
1 Open Dockside Setup tab in the Autopilot Setup dialog (select:

Route→Autopilot Panel→Autopilot Setup→Dockside (tab)).
2 Select the current active parameter set.
3 Click Save.

The current active parameter set is then shown in the Autopilot
Panel dialog.

This warning will disappear when the sea trial is finished and the
Seatrial parameter in the Autopilot Setup dialog's Seatrial tab is
showing 0000.

Note

During the sea-trial the ship must sail at +/- 80 percent of the service
speed (specified in the Autopilot Setup dailog's Master tab).
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If the autopilot parameters have not been saved correctly and you
restart the autopilot, you might find that it does not perform as
expected. In this case, try reloading the parameter set named Seatrial
and saving it as the current parameter set (you can call it, for example,
'Operation'). You can also try doing this if you simply want to undo
recent changes to the parameters or if you want to avoid performing
a full sea-trial procedure.

If you ever perform a master reset (or simply over-write the Seatrial
parameter set) by mistake, then you must perform a full sea-trial
procedure, saving the new parameter settings both during the procedure
and after it. If you cannot perform the sea trial yourself, contact
Kongsberg Maritime customer services. (For instructions about
performing the sea trial, refer to the K-Bridge Autopilot Operator
Manual.)

Message: Autopilot RPM difference
Description: Autopilot RPM difference
Priority: Warning (category B)

Possible
cause:

This message results if the vessel has two or more rudder/propeller
units or thrusters for steering and the RPM for each one is different.
The performance of the autopilot’s steering is reduced if the RPM
is not equal for both (or all) of the vessel’s rudder/propeller units or
steering thrusters.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Make sure the units are operating at the same RPM as each other. For
example, if the levers for each thruster are manually controlled, make
sure they are level.

Message: Autopilot RPM input error [port/stbd]
Description: Autopilot RPM input error [port/stbd]
Priority: Warning (category B)

Possible
cause:

The autopilot has received an invalid RPM measurement concerning a
thruster or rudder propeller. Invalid RPM measurements will not be
used by the autopilot. If the autopilot is not receiving valid RPM input
concerning the thrusters or rudder propellers, steering performance can
be reduced. (If applicable, the alert will indicate whether it concerns
port or starboard thrusters or propellers.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If this warning persists, report it to Kongsberg customer service.
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Message: Autopilot RPM too high [port/stbd]
Description: Autopilot RPM too high [port/stbd]
Priority: Warning (category B)

Possible
cause:

The RPM of the steering thrusters is too high. RPM measurements
that are too high will not be used by the autopilot. If the autopilot
is not receiving valid RPM input concerning the thrusters, steering
performance can be reduced. (If applicable, the alert will indicate
whether it concerns port or starboard thrusters or propellers.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the RPM readings on the Conning display, and check the sensor
that is monitoring the thrusters.

Message: Autopilot RPM too low [port/stbd]
Description: Autopilot RPM too low [port/stbd]
Priority: Warning (category B)

Possible
cause:

The RPM of the steering thrusters is below 20% of maximum. This
reduces the autopilot’s steering capability. Increase the RPM to return
the autopilot to full steering capability. (If applicable, the alert will
indicate whether it concerns port or starboard thrusters.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Increase the RPM to return the autopilot to full steering capability.

Message: Autopilot rudder feedback
Description: Autopilot rudder feedback
Priority: Alarm (category B)

Possible
cause:

This message will accompany another alert concerning rudder
feedback I/O.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the SINT for possible failures.

2 Check the rudder feedback unit, the transmission link and the
direction of rudder movement.
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Message: Autopilot rudder feedback I/O error [port/stbd]
Description: Autopilot rudder feedback I/O error [port/stbd]
Priority: Alarm (category B)

Possible
cause:

There is no rudder feedback signal. This indicates a malfunctioning
rudder feedback or rudder command connection. Alternatively it might
indicate a problem with the vessel's steering gear. (If applicable, the
alert will indicate whether it concerns the port or starboard rudder.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the SINT for possible failures.

2 Check the rudder feedback unit, the transmission link and the
direction of rudder movement.

Message: Autopilot rudder limit exceeded
Description: Autopilot rudder limit exceeded
Priority: Warning (category B)

Possible
cause:

The additional rudder limit (set by the Rudder Limit parameter) has
been exceeded. This warning can be caused by wave disturbance, an
erratic speed log or simply incorrect parameter settings. It may also
indicate a failure in the vessel's steering control system.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check that the user setup parameter Rudder Limit is set correctly

(select: Route→Autopilot Panel→Autopilot Setup→User (tab)).
2 If the warning appears during an immediate turn, try tuning the

sea-trial parameters that affect turning performance. For example,
an increase in the value for Accelerator Length may solve the
problem (select: Route→Autopilot Panel→Autopilot Setup→Sea
trial (tab)).

3 If the warning comes up frequently, it is probably caused by wave
disturbance:
a If you are using the autopilot's Economy mode (set in the

Autopilot Panel dialog), try the Precision mode.
b If the user setup parameter Wave Filtering (in the User tab)

is ON, try setting it to OFF.
c If the autopilot is steering inappropriately in rougher waters,

you may need to perform the sea-trial procedure again.
For instructions about performing the sea trial, refer to the
K-Bridge Autopilot Operator Manual.
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Message: Autopilot rudder not ready [port/stbd]
Description: Autopilot rudder not ready [port/stbd]
Priority: Alarm (category B)

Possible
cause:

The rudder is not ready to be controlled by the autopilot. This might
mean that the steering system is not yet operational. (If applicable, the
alert will indicate whether it concerns the port or starboard rudder.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check whether the steering control system is running.

2 Check that the steering control system has been switched to
autopilot mode.

Message: Autopilot rudder ready I/O error [port/stbd]
Description: Autopilot rudder ready I/O error [port/stbd]
Priority: Alarm (category B)

Possible
cause:

If the autopilot has a rudder-ready signal connection, this failure
message indicates that it cannot receive the signal. (If applicable, the
alert will indicate whether it concerns the port or starboard rudder.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the SINT for possible failures.

2 Check the rudder feedback unit, the transmission link and the
direction of rudder movement.

Message: Autopilot rudder response
Description: Autopilot rudder response
Priority: Alarm (category B)

Possible
cause:

The rudder is not responding properly to commands from the autopilot
controller in the SINT. This alert is issued whenever rudder speed is
less than 0.25°/sec while rudder lag is greater than 5° for more than
five seconds at a time.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the operation of the steering gear pumps.

2 Check that the rudder signal is present at the input terminals on
the SINT. Check the cabling between the SINT and the rudder.
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Message: Autopilot rudder setpoint I/O error [port/stbd]
Description: Autopilot rudder setpoint I/O error [port/stbd]
Priority: Alarm (category B)

Possible
cause:

When it issued a rudder command, the autopilot controller in the SINT
received an error from the rudder set-point I/O card. (If applicable, the
alert will indicate whether it concerns the port or starboard rudder.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the cabling between the SINT and the rudder set-point I/O card.

Message: Autopilot sharp turn
Description: Autopilot sharp turn
Priority: Warning (category B)

Possible
cause:

This warning means that the sharp turn limit will be exceeded by the
proposed turn.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Make sure that the Turn Warning limit parameter is set correctly

(select: Route→Autopilot Panel→Autopilot Setup→Track (tab)).
2 Reduce the vessel's speed or increase the turn radius.

Message: Autopilot water log
Description: Autopilot water log
Priority: Alarm (category B)

Possible
cause:

The autopilot controller in the SINT is receiving no data from the
water-speed log.

If the autopilot’s Water Log parameter (Route→Autopilot
Panel→Autopilot Setup→Dockside (tab)) is set to NAV, then the
autopilot receives water speed log input from the Nav OS. Therefore,
if the autopilot ever loses communication with the Nav OS, the
Autopilot water log alert will be generated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the water-speed log sensor and its network connection.

2 If the failure has occurred while the autopilot was performing
Track steering, check the setup of the operator station.

3 Check that the autopilot's Water Log parameter has been
set correctly (select: Route→Autopilot Panel→Autopilot
Setup→Dockside (tab)).
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Message: Autopilot wrong nav data
Description: Autopilot wrong nav data
Priority: Alarm (category B)

Possible
cause:

An NMEA data packet received from the operator station had an
incorrect sentence structure. This may indicate a mismatch between
the setup of the autopilot and the setup of the operator station. The
autopilot has therefore refused to permit the operator station to control
it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the operator station setup.

2 Check the network.
3 If the failure persists, use another operator station to control the

autopilot.
4 Restart the operator station and try using it again to control the

autopilot.
5 Restart the autopilot.

Message: Chart licensing error
Description: Chart licensing error for Radar mode
Priority: Warning (category B)

Possible
cause:

There is a problem with the chart licence. It might only concern the
presentation of the chart on a radar display.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check your chart licences or contact KM service or your chart provider.

Message: Chart mirrorclient missing update
Description: Chart mirrorclient missing update
Priority: Warning (category B)

Possible
cause:

Mirror client is missing permits or updates that exists on mirror host.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Update mirror client from mirror host.
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Message: Chart proj. mismatch
Description: Chart mismatch n pixels
Priority: Warning (category B)

Possible
cause:

There is a mismatch of up to n pixels between the chart and the radar.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

When evaluating the screen, be aware of the mismatch at the corners
especially.

Message: Close to barrier
Description: Close to barrier
Priority: Warning (category A)

Possible
cause:

The distance to the closest point on a barrier line (for the automatic
acquisition of radar targets) is less than 100 meters.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check whether the automatic acquisition area needs to be changed
before the vessel crosses the barrier.

Message: Collision danger
Description: Collision danger: target breached CPA/TCPA limits
Priority: Alarm (category A)

Possible
cause:

A tracked target has breached the CPA and TCPA limits. (This alert
message will also include the number of targets that have breached
the CPA/TCPA limits and the operator station that has generated the
alert/s.)

Acknowledge
from:

The operator station that issued the alert.

Suggested
action: 1 Check if immediate action is required to avoid danger.

2 Go to the operator station that generated the alert and acknowledge
it from that operator station.
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Message: Command of AP not selected
Description: Command of AP not selected
Priority: Warning (category B)

Possible
cause:

The autopilot reports that no console currently has command of it.
The autopilot will not now respond to immediate course changes but
will continue to steer on its current course until you take command
of it from a console or from the autopilot operator panel (if one is
available on the bridge).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Take command of the autopilot from a console or operator panel.

Message: Commanding station changed
Description: Commanding station changed
Priority: Warning (category B)

Possible
cause:

Command of the autopilot has been transferred to another operator
station.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

To control the autopilot you must now use the new operator station.
(The heading wheel on the operator station that was previously in
command of the autopilot will not now have any effect.)

Message: Common sensor alert
Description: Common sensor alert
Priority: Warning (category B)

Possible
cause:

Alert received from sensor.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Read the sensor alert message and take appropriate action.
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Message: Critical point reached
Description: Critical point reached n
Priority: Warning (category A)

Possible
cause:

The vessel has arrived at the location of a critical point on the chart.

Acknowledge
from:

Any K-Bridge operator station that is currently monitoring the route
and is not using the ECDIS browse facility (for browsing away from
the vessel on the chart).

Suggested
action:

Read the text associated with the critical point and take action
accordingly.

Message: Deviation between heading sensors
Description: Heading deviation n.nººº
Priority: Warning (category A)

Possible
cause:

The deviation between the master operator station's filtered heading
and the raw heading data from one or more of the available gyros has
exceeded the alert limit.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the gyro readings. Make sure the autopilot is not making
manoeuvres based on a faulty heading signal.

Message: Diff. corrections pos. resumed
Description: Diff. corrections pos. resumed on position sensor n
Priority: Warning (category B)

Possible
cause:

The GPS receiver has been in absolute mode and has now changed to
differential mode without differential corrections.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the ship's position on the chart.

2 If the steering mode is Track or Waypoint take special care: the
system might make adjustments to compensate for a possible
position jump due to reduced position accuracy.
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Message: Display communication failure
Description: Display communication failure, error code n
Priority: Warning (category B)

Possible
cause:

The serial line connecting the display (monitor) and the operator
station computer has failed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

To check whether the display can receive control information from
the operator station:
1 Go into the radar application and select View - Palette/Intensity.
2 Adjust the Brilliance setting.

If the light intensity on the display does not change, the display is
not receiving commands from the computer.

3 Check the cabling and connections.

Message: Display data channel driver not installed
Description: DDC driver not installed
Priority: Warning (category B)

Possible
cause:

The selected monitor type requires a display data channel driver to
be installed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service.

Message: Display stabilization changed to water
Description: Ground speed not available
Priority: Alarm (category B)

Possible
cause:

The speed displayed by the speed log has changed automatically from
ground to water speed because ground speed is not available.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the ground speed input readings.
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Message: Display stabilization changed to ground
Description: Water speed not available
Priority: Warning (category B)

Possible
cause:

The speed displayed by the speed log has changed automatically from
water to ground speed because water speed is not available.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the water speed input readings.

Message: End of route
Description: End of route
Priority: Alarm (category B)

Possible
cause:

You are monitoring a route. The ship has passed the last waypoint.
Track steering mode will be terminated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select a new route to monitor.

Message: End of track pre-alert
Description: End of track in nn min
Priority: Alarm (category B)

Possible
cause:

An alarm is given between 1 and 5 minutes (depending on the autopilot
configuration) before the last waypoint of the track is passed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Acknowledge the alarm to inhibit the backup navigator alarm.

Message: Error in antenna azimuth pulses
Description: Error in azim pulses: nn avg: xx
Priority: Warning (category B)

Possible
cause:

The selected radar antenna has sent an incorrect number of azimuth
pulses:
nn – number of pulses in the last revolution
xx – average number of pulses in 10 revolutions

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Be aware that radar echoes may be unstable or erroneous in

azimuth.
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2 If necessary, select another radar transceiver. Contact KM service
to fix the problem.

Message: Fixed target number position deviation
Description: Fixed target number position deviation
Priority: Warning (category A)
Acknowledge from: the operator station that issued the alert

Possible
cause:

The fixed reference target being used for Radar Positioning is
calculated to have moved from its reference position by more than the
alert limit, normally 300 metres. This may be because the target is not
fixed at all. Or it may be because the aspect ratio has changed so that
the centre of the echoes now relates to another point on the target.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Review the fixed reference targets that you are using for Radar
Positioning (see Using the radar positioning system on page 148).

Message: Fixed target number speed limit exceeded
Description: Fixed target number speed limit exceeded
Priority: Warning (category A)

Possible
cause:

The fixed reference target being used for Radar Positioning is
calculated to have a speed above the acceptance limit, normally 6
knots. This may be because the target is not fixed at all. Or it may be
because the aspect ratio has changed so that the centre of the echoes
now relates to another point on the target.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Review the fixed reference targets you are using for Radar Positioning
(see Using the radar positioning system on page 148).

Message: Fixed target number update time limit exceeded
Description: Fixed target number update time nn sec
Priority: Warning (category A)

Possible
cause:

A fixed reference target being used for Radar Positioning has not been
updated (in other words, has not reflected an acceptable echo) for the
latesst nn seconds. It is therefore no longer being used for position
calculations.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Review the fixed reference targets you are using for Radar Positioning
(see Using the radar positioning system on page 148).
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Message: Grounding
Description: Grounding
Priority: Alarm (category A)

Possible
cause:

Grounding danger.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Take immediate action to avoid grounding the vessel or hitting an
obstruction.

Message: Heading jump
Description: Heading Jump
Priority: Alarm (category B)

Possible
cause:

The difference between two readings from the heading sensor (gyro
compass) is more than 3 degrees.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the gyro readings.

2 Check the gyro readings.
3 Check whether the autopilot has made any manoeuvres based on

a faulty heading signal.

Message: Head marker failure (turning unit)
Description: Head marker fail turning unit
Priority: Alarm (category B)

Possible
cause:

The circuitry to detect the heading marker is malfunctioning.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service to fix the problem.
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Message: LAN A/B failure or missing
Description: LAN A/B failure or missing
Priority: Warning (category B)

Possible
cause:

The network is down or not able to transfer data over the bound socket.
Alternatively, it could be that no other consoles are registered on the
network (this operator station is alone on the network).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the network setup, network cable and hub/switch.

2 If this station is alone on the network, disable this alarm in your
network configuration.

Message: Local ADF input failed
Description: Local ADF input failed
Priority: Warning (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of data
mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the data source
mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified data
source, and that it has received no data on that serial connection for a
specified time, normally 5 seconds. The data may be being fed to the
operator station on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local AIS input failed
Description: Local AIS input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of data
mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the data source
mentioned in the alert text can fail.
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Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified data
source, and that it has received no data on that serial connection for a
specified time, normally 5 seconds. The data may be being fed to the
operator station on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check if the AIS sensor is switched on and enabled. Check if its serial
cable or power cable is loose or damaged.

Message: Local ARPA target input failed
Description: Local ARPA target input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of data
mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the data source
mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified data
source, and that it has received no data on that serial connection for a
specified time, normally 5 seconds. The data may be being fed to the
operator station on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local autopilot input failed
Description: Local autopilot input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of data
mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the data source
mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified data
source, and that it has received no data on that serial connection for a
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specified time, normally 5 seconds. The data may be being fed to the
operator station on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local depth input failed
Description: Local depth input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of data
mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the data source
mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified data
source, and that it has received no data on that serial connection for a
specified time, normally 5 seconds. The data may be being fed to the
operator station on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local heading input failed
Description: Local heading input failed
Priority: Alarm (category B)

Possible
cause:

This alert is most likely to concern heading input to the operator
station that is provided on a backup serial connection from the SINT.
It indicates that the serial connection is currently failing to provide
backup input from the sensor mentioned in the alert text. (The backup
sensor input is provided for use in the event of a network failure that
prevents the operator stations from receiving sensor data over the
LAN.)
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(This alert will also appear if the operator station has a non-standard
configuration that includes a direct serial connection to a heading
sensor, and that connection fails.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the backup sensor, verify its status, and if it is OK continue

sailing as normal.
2 Check the serial connection from the backup sensor to the SINT.
3 Check the backup serial connection from the SINT to the operator

station it is connected to (only one operator station has a direct
serial connection to the SINT).

4 Check the backup serial connections between the operator
stations. (The operator station that has a backup serial connection
to the SINT will also have a serial connection to one other operator
station, and it will forward the backup data to that operator station.
The second operator station may also be connected to a third
operator station, and so on).

Message: Local INS input failed
Description: Local INS input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a
local serial connection between the operator station and the Inertial
Navigation System. However, in standard configurations K-Bridge
operator stations receive this data input over the LAN not over local
serial connections. This means that there are almost no circumstances
in which a local serial connection to the INS can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the INS, and that it
has received no data on that serial connection for a specified time,
normally 5 seconds. The data may be being fed to the operator station
on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.
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Message: Local opt. bearing input failed
Description: Local opt. bearing input failed
Priority: Alarm (category B)
Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
serial connection for a specified time, normally 5 seconds. The data
may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local position input failed
Description: Local position input failed
Priority: Alarm (category B)
Possible
cause:

This alert is most likely to concern position input to the operator
station that is provided on a backup serial connection from the SINT.
It indicates that the serial connection is currently failing to provide
backup input from the position sensor. (The backup sensor input is
provided for use in the event of a network failure that prevents the
operator stations from receiving critical sensor data over the LAN.)

(This alert will also appear if the operator station has a non-standard
configuration that includes a direct serial connection to a position
sensor, and that connection fails.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the backup sensor, verify its status, and if it is OK continue

sailing as normal.
2 Check the serial connection from the backup sensor to the SINT.
3 Check the backup serial connection from the SINT to the operator

station it is connected to (only one operator station has a direct
serial connection to the SINT).
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4 Check the backup serial connections between the operator
stations. (The operator station that has a backup serial connection
to the SINT will also have a serial connection to one other operator
station, and it will forward the backup data to that operator station.
The second operator station may also be connected to a third
operator station, and so on).

Message: Local RPM input failed
Description: Local RPM input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
serial connection for a specified time, normally 5 seconds. The data
may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local rudder input failed
Description: Local rudder input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
serial connection for a specified time, normally 5 seconds. The data
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may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local scan. sonar input failed
Description: Local scan. sonar input failed
Priority: Warning (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
serial connection for a specified time, normally 5 seconds. The data
may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local speed input failed
Description: Local scan. sonar input failed
Priority: Alarm (category B)

Possible
cause:

This alert is most likely to concern speed input to the operator station
that is provided on a backup serial connection from the SINT. It
indicates that the serial connection is currently failing to provide
backup input from the speed sensor. (The backup sensor input is
provided for use in the event of a network failure that prevents the
operator stations from receiving critical sensor data over the LAN.)

(This alert will also appear if the operator station has a non-standard
configuration that includes a direct serial connection to a speed sensor,
and that connection fails.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the backup sensor, verify its status, and if it is OK continue

sailing as normal.
2 Check the serial connection from the backup sensor to the SINT.
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3 Check the backup serial connection from the SINT to the operator
station it is connected to (only one operator station has a direct
serial connection to the SINT).

4 Check the backup serial connections between the operator
stations. (The operator station that has a backup serial connection
to the SINT will also have a serial connection to one other operator
station, and it will forward the backup data to that operator station.
The second operator station may also be connected to a third
operator station, and so on).

Message: Local time input failed
Description: Local time input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
serial connection for a specified time, normally 5 seconds. The data
may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Local wind input failed
Description: Local wind input failed
Priority: Alarm (category B)

Possible
cause:

This alert is unlikely ever to be seen. It concerns the failure of a local
serial connection between the operator station and the source of the
data mentioned in the alert text. However, in standard configurations
K-Bridge operator stations receive this input over the LAN not
over local serial connections. This means that there are almost no
circumstances in which a local serial connection to the source of the
data mentioned in the alert text can fail.

Nevertheless, if an operator station issues this alert, it means that the
operator station does have a serial connection to the specified source of
the data mentioned in the alert, and that it has received no data on that
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serial connection for a specified time, normally 5 seconds. The data
may be being fed to the operator station on a different connection or
it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source, verify its status, and if it is OK continue
sailing as normal.

Message: Lost target
Description: Lost target
Priority: Warning (category A)

Possible
cause:

A target has disappeared from the display.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

If the target is one that you need to continue to track, adjust the Tracker
Sensitivity (select Targets) to see if this enables you to re-acquire the
target (see Targets menu on page 380).

Message: Low DMA mem. – restart computer
Description: Low DMA mem. – restart computer
Priority: Warning (category B)

Possible
cause:

The DMA buffer is low. This means that a limited number of switches
between Radar and ECDIS are possible. Operation as Radar (or
ECDIS) will continue as normal.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

No immediate action required. Restart the computer before the next
time you change from radar to ECDIS (or from ECDIS to radar if
ECDIS is the currently active application on the operator station).

Message: Low main bang amplitude
Description: Low main bang amplitude
Priority: Warning (category B)

Possible
cause:

The main bang amplitude reported from the transmitter is lower than a
preset limit.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the radar picture, if possible using the performance monitor. If
the performance is poor, contact KM Service to fix the problem.
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Message: Low peak current in magnetron
Description: Low peak current in magnetron
Priority: Warning (category B)

Possible
cause:

The peak current reported from the transmitter’s magnetron is lower
than a preset limit.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the radar picture, if possible with the performance monitor. If
the performance is poor, contact KM Service to fix the problem.

Message: Low power level in transmitter
Description: Low power level in transmitter
Priority: Warning (category B)

Possible
cause:

The power level reported from the transmitter is lower than a preset
limit.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the radar picture, if possible using the performance monitor. If
the performance is poor, contact KM Service to fix the problem.

Message: Magnetron hours count failure
Description: Magnetron hours count failure: file format unknown
Priority: Warning (category B)

Possible
cause:

There is a problem with the logging of the radar magnetron hours
count. The content of the log file cannot be parsed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service.

Message: Magnetron (old) hours count failure
Description: Magnetron hours count failure: old file format unknown
Priority: Warning (category B)

Possible
cause:

There is a problem with the logging of the radar magnetron hours
count. The content of the old log file cannot be parsed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service.
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Message: Magnetron lifetime expired
Description: Magnetron lifetime expired
Priority: Warning (category B)
Possible
cause:

The Magnetron is reporting that it is at the end of its life.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Replace the Magnetron unit.

Message: Missing antenna pulses (TIC)
Description: No antenna pulses
Priority: Warning (category B)
Possible
cause:

The TIC (Transceiver Interface and Control) card in the interswitch
has not detected any sync pulses. Check the interswitch and restart
it, or select another radar.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar and/or the interswitch.
3 Select another radar.

Message: Missing datum from pos. sensor
Description: Pos. sensor n: missing datum
Priority: Warning (category B)
Possible
cause:

The position sensor is not sending the datum.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the position sensor configuration and the datum setup on the
GPS operator panel.

Message: Missing head marker (TIC)
Description: No head marker
Priority: Warning (category B)
Possible
cause:

The Transceiver Interface and Control (TIC) card in the interswitch
has not detected any head marker pulses.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar or the interswitch.
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3 Select another radar.

Message: Missing interswitch communication
Description: No interswitch comm. for nn sec.
Priority: Alarm (category B)

Possible
cause:

No data has been transferred on the serial-line from the interswitch
during the last nnn sec.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar or the interswitch.
3 Select another radar.

Message: Missing sync pulses (RIC)
Description: Missing sync pulses (RIC)
Priority: Alarm (category B)

Possible
cause:

The Radar Interface Card in the radar operator station has not detected
any sync pulses.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the connection between the Radar Interface Card and the

TIC card in the radar interswitch.
2 Check the radar.
3 Restart the radar or the interswitch.
4 Select another radar.

Message: Missing sync pulses (TIC)
Description: No sync pulses
Priority: Warning (category B)

Possible
cause:

The Transceiver Interface Control (TIC) card in the radar interswitch
has not detected any sync pulses.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the connection between the radar interswitch and the

transceiver.
2 Check the radar.
3 Restart the radar or the interswitch.
4 Select another radar.
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Message: Missing transceiver communication
Description: Missing transceiver communication
Priority: Alarm (category B)

Possible
cause:

No data has been transferred from the transceiver to the interswitch.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar or the interswitch.
3 Select another radar.

Message: Modulator trig fail
Description: Modulator trig fail in transmitter
Priority: Warning (category B)

Possible
cause:

The transceiver has detected a failure in the modulator trigger
operation.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service to fix the problem.

Message: Navtex received important message
Description: Navtex received important message
Priority: Warning (category B)

Possible
cause:

A new message has been received by the Navtext receiver. It is
important that you check the message.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the Navtex messages.

Message: New target
Description: New target
Priority: Warning (category A)

Possible
cause:

A new target has been acquired.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Monitor the target on the radar display.
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Message: NMEA error
Description: NMEA error
Priority: Warning (category B)

Possible
cause:

This message appears if there are any errors in the NMEA telegrams
received by the operator station from a navigation sensor. The error
may be any of the following:
• Illegal checksum: A requested checksum at the end of the

telegram is wrong or missing
• Missing field: One of the mandatory fields in the telegram is

missing
• Illegal value: A value in the telegram is illegal, for instance a

letter inside a numeric value (",34.b4,")
• Illegal lat/lon: A latitude or longitude value is illegal, for

instance a letter inside a numeric field ",1234N.45,N," or an illegal
sphere ",1234.45,D,"

When one of these errors occurs, the whole telegram is rejected
and will not appear in the alert lists: this generic NMEA error alert
appears instead.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Start monitoring the port on which the sensor’s input is received
to see if any more faulty telegrams are received. To do this, select
System→Serial Communication (the service password is required to
access the necessary dialog box).

Message: No available watchcall group
Description: No available watchcall group
Priority: Warning (category B)

Possible
cause:

The pool of available WatchCall Groups has been exhausted. Alerts
required by external equipment will not be transmitted to that
equipment if they have not been assigned a WatchCall group. For
example, alerts that are supposed to trigger the BNWAS will not be
sent to the BNWAS and so will not trigger it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Make sure the watchcall groups have been configured correctly.

2 Contact KM service.
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Message: No conning display
Description: No conning display active
Priority: Alarm (category B)

Possible
cause:

The radar or ECDIS is in command of the autopilot. A route is being
monitored. No Conning display can be found on the network. (This
alarm is initially a warning. But after 60 seconds, its priority escalates
and it becomes an alarm.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the LAN connection for the Conning system. Do not attempt to
run in Track mode without a Conning system on the network.

Message: No data from Polaris simulator
Description: No data from Polaris simulator
Priority: Warning (category B)

Possible
cause:

The system is configured to receive data from a Polaris simulator and
is not receiving data from it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If the system is expecting signals from a simulator (instead of real
signals), try restarting the simulator. If this is a sailing installation,
contact KM Service to correct the configuration.

Message: No diff. corrections pos.
Description: No diff. corrections position sensor (n)
Priority: Warning (category B)

Possible
cause:

The GPS receiver (n) has been in differential mode and has now
changed to absolute mode without differential corrections.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the ship’s position in the chart. If the steering mode is Track
or Waypoint take special care, because the system might make
adjustments to compensate for a possible position jump due to
increased position accuracy.
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Message: No ECDIS to monitor route
Description: No Ecdis to monitor route
Priority: Alarm (category B)

Possible
cause:

A radar operator station is In Command of the autopilot and a route
is being monitored. Steering mode is Track or Waypoint. No ECDIS
has been found on the network. (This alarm is initially a warning. But
after 60 seconds, its priority escalates and it becomes an alarm.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If an MFD on the bridge has switched out of ECDIS (leaving no
ECDIS operating on the bridge), switch it back to ECDIS immediately.

If an ECDIS is connected, check its LAN connection. Do not attempt
to run in Track mode without an ECDIS on the network to monitor
the route.

Message: No input from heading sensor
Description: Heading sensor nn: no input
Priority: Alarm (category B)

Possible
cause:

The selected heading sensor has not sent heading information for the
last 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another heading sensor or use manually entered heading
information.

Message: No input from INS sensor
Description: No input from INS sensor
Priority: Alarm (category B)

Possible
cause:

The INS sensor has not sent position information within a specified
time, normally 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal input. If the INS is used as a primary heading sensor,
switch to use data input directly from the Gyro.
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Message: No input from position sensor
Description: Pos. sensor nn: no input
Priority: (on master operator station) Alarm (category B)
Priority: (on slave operator station) Warning (category B)

Possible
cause:

The selected position sensor has not sent position information during
the last 5 seconds. When this alert is generated by the master operator
station, the alert has priority Alarm (category B). When the alert is
generated by a slave operator station, the alert has priority Warning
(category B).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another position sensor or use dead reckoning.

Message: No input from speed sensor
Description: Speed sensor nn: no input
Priority: Alarm (category B)

Possible
cause:

The selected speed sensor has not sent speed information during the
last 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another speed sensor, or use manual speed.

Message: No input from tender tracker
Description: No input from tender tracker
Priority: Warning (category B)

Possible
cause:

The connection from the tender tracker sensor is a serial line
connection and it has not supplied this computer with data for a
specified time, normally 5 seconds. The sensor data may be being fed
to this computer on a different connection or it may be totally missing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the signal source.
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Message: No navigation master selected
Description: No navigation master selected
Priority: Alarm (category B)

Possible
cause:

All consoles are calculating and using own-ship filtered data for
themselves (instead of one master console performing the calculations
and distributing them to the other consoles).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Make one console the navigation master (see Making one console the
navigation master on page 130), or un-check both the Master Enable
and the Slave Enable options in the Integration Configuration dialog on
all consoles (select System→Integration Configuration; see Integration
Configuration on page 659).

Alternatively, in the Integration Configuration dialog on the console
or consoles that transmitted the warning, disable the warning (see
Integration Configuration on page 659).

Message: No position from position sensor
Description: No position from position sensor: n
Priority: Alarm (category B)

Possible
cause:

The selected position sensor has not sent position information during
the last 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another position sensor or use dead reckoning.

Message: No rate of turn from gyro
Description: No rate of turn from gyro
Priority: Alarm (category B)

Possible
cause:

The selected heading sensor has not sent rate of turn (ROT) information
during the last 5 seconds.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select another heading sensor or configure the ROT to be
calculated instead of read from the heading sensor (select
System→Sensor→Configuration→Heading→Details→Details; see
Heading sensor details on page 620).
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Message: No sync or antenna rot. (RIC)
Description: No sync or antenna rotation (RIC)
Priority: Alarm (category B)

Possible
cause:

The Radar Interface Card has not detected changes on the combined
sync/azimuth input. The radar display will be made blank and a
warning written across it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar or the interswitch.
3 Select another radar.

Message: No sync pulses (RIC)
Description: Missing sync pulses
Priority: Alarm (category B)

Possible
cause:

The Radar Interface Card (RIC) has not detected any significant sync
signals. The radar display will be blanked and a warning written
across it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the radar.

2 Restart the radar or the interswitch.
3 Select another radar.

Message: No tracked target for targetout
Description: No tracked target for targetout
Priority: Warning (category B)

Possible
cause:

The system has been configured to transmit selected radar or AIS
targets to an external device. But either no target has been selected or
the selected target is lost.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Select a target or configure the system not to transmit individually
selected targets over the GGA protocol (select System→Sensor
Configuration→TargetOut→Details; see Target out interface details on
page 633).
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Message: No video (RIC)
Description: No change in video
Priority: Alarm (category B)

Possible
cause:

The Radar Interface Card has not detected any significant signals on
the video input. The radar display will be made blank and a warning
written across it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try increasing the gain setting.

2 Check the radar.
3 Restart the radar or the interswitch.
4 Select another radar.

Message: Position deviation
Description: Position deviation from receiver nn is x m
Priority: Warning (category A)

Possible
cause:

The deviation between the master operator station's filtered position
and the raw position data from one or more of the available position
sensors has exceeded the alert limit. (This alert will not be issued if the
"No Input From Position Sensor" alert has been issued and remains
active.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try resetting the position filter on the master operator station.

2 Check the position reference systems.

Message: Power supply on battery
Description: On battery for nn seconds
Priority: Alarm (category B)

Possible
cause:

The Power Input (220V AC) to the UPS (Uninterruptible Power
Supply) has disappeared. The operator station is running on battery
power. (The alert description indicates the period of time for which the
operator station has been running on battery power; it also indicates
which operator station generated the alert.)

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the ship's power source.
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Message: Priority tender approach alert
Description: Priority tender approach alert
Priority: Warning (category B)

Possible
cause:

The currently designated priority tender has come within a specified
range of the yacht.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Prepare to receive the priority tender.

Message: Proximity violation
Description: Proximity violation: target breached ship's proximity limit
Priority: Alarm (category A)

Possible
cause:

A tracked target is closer to the own-ship than the proximity alert limit
permits (see Alarm Limits on page 411).

Acknowledge
from:

The operator station that issued the alert.

Suggested
action: 1 Check if immediate action is required to avoid danger.

2 Go to the operator station that generated the alert and acknowledge
it from that operator station.

Message: Radar display update failure
Description: Radar display update failure
Priority: Alarm (category B)

Possible
cause:

The radar presentation software is not running. The radar echoes on
the display will not be updated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Restart the radar. Contact KM Service.

Message: Radar tracker update failure
Description: Radar tracker thread update failure
Priority: Alarm (category B)

Possible
cause:

The radar tracker software is not running. The tracked radar targets
will not be updated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Restart the radar.

2 If it still does not update tracked targets, contact KM service.
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Message: Radar update failure
Description: Radar tracker RIC2 FIFO update failure
Priority: Alarm (category B)

Possible
cause:

The radar tracker software is not running. The tracked radar targets
will not be updated.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Restart the radar. Contact KM service.

Message: SINT gyro compass switch
Description: Gyro is switched automatically
Priority: Alarm (category B)

Possible
cause:

This alert will be followed by an “Autopilot change steering mode”
alert. The Grounding Avoidance System has decided that the heading
sensor was failing and has triggered the selection of another heading
sensor.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Track steering will continue if you are currently using track steering.
But you need to come out of it and check the operation of the new gyro
before re-engaging track steering.

Message: SINT low power N1
Description: SINT low power N1
Priority: Alarm (category B)

Possible
cause:

There is a problem with the power in the SINT cabinet.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the PSUs and fuses.

Message: SINT low power N2
Description: SINT low power N2
Priority: Alarm (category B)

Possible
cause:

There is a problem with the power in the SINT cabinet.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the PSUs and fuses.
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Message: SINT master switch to A/B
Description: SINT master switch to A/B
Priority: Warning (category B)

Possible
cause:

This warning informs you that the master process station (PS) in a
SINT configuration with redundant RCUs (Remote Computer Units)
has been automatically switched.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 You can continue to use the autopilot with only one RCU working,

but you must be aware that the SINT is not currently operating
as a redundant system.

2 Try to restart the failed RCU. If that is not successful try to restart
both RCUs together.

3 If that is not successful, contact the Kongsberg Maritime service
department.

Message: SINT missing power N1
Description: SINT missing power N1
Priority: Alarm (category B)

Possible
cause:

No power is being received by the SINT from one of its power supplies.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the power source and fuses.

Message: SINT missing power N2
Description: SINT missing power N2
Priority: Alarm (category B)

Possible
cause:

No power is being received by the SINT from one of its power supplies.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the power source and fuses.
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Message: Sparking in magnetron detected
Description: Sparking in magnetron detected
Priority: Warning (category B)
Possible
cause:

The transceiver has detected sparking in the Magnetron circuitry. This
is probably due to Magnetron ageing.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Transmission has been switched off automatically to protect the
transceiver. Contact KM service to fix the problem. Transmission on
short pulse may be possible until the problem is fixed.

Message: Speed below manoeuvring speed
Description: Speed below manoeuvre speed
Priority: Warning (category B)
Possible
cause:

The vessel’s speed is below the vessel’s low-speed limit for track
steering (see Autopilot Configuration on page 658).

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If it is safe to do so, increase the vessel’s speed and continue in track
steering.

Message: Speedpilot cannot hold set speed
Description: Speedpilot set speed not valid
Priority: Alarm (category B)
Possible
cause:

A speed pilot is configured and connected. The difference between the
actual speed and the set speed has been more than 1 knot for a period
of 5 minutes without any significant acceleration having occurred. The
speed pilot is unable to achieve the set speed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the speed pilot. If necessary disengage the speed pilot and
then restart it.

Message: Speedpilot comm. fail
Description: Speedpilot comm. fail
Priority: Alarm (category B)
Possible
cause:

This alert will only occur if the speed pilot controller in the SINT
is configured to communicate with the Nav OS over a serial
connection (as opposed to an OPC connection, which is the standard
configuration). The serial connection might be a physical serial link or
it might be a virtual serial connection that uses the LAN.

The alert indicates that the Nav OS is not able to establish serial
communication with the speed pilot controller in the SINT. The cause
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may be that the physical serial communication link is broken, or it may
be that the speed pilot controller or some communication hardware in
the SINT is malfunctioning.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try taking command of the speed pilot from another Nav OS.

2 Check that the configuration of the speed pilot sensor input
is correct (select System→Sensor Configuration→Speed
pilot→Details).
To perform this check, you need to use the service password.

3 Check whether the text field at the bottom of the Speed Pilot
dialog (Route→Speed Pilot) contains the alarm message !!
Speed Pilot Comm. Fail !!.
If it does, this is further evidence that there is no serial
communication between the operator station and the speed pilot.

4 Check the operation of the other Nav OSes.
If the Speed Pilot dialog on another (or on more than one other)
operator station also contains the alarm message !! Speed
Pilot Comm. Fail !!, then it is likely that there is a problem
with the Local Area Network (LAN).
If any K-Bridge operator station on the LAN has hung or appears
to be operating slowly, this could be causing a network traffic jam
that is blocking the LAN-based serial communication between the
Nav OS that is in command and the speed pilot.

5 Restart any K-Bridge operator stations that have hung or are
operating slowly.

6 Restart the SINT.

Message: Speedpilot comm. failure (OPC)
Description: Speedpilot comm. failure (OPC)
Priority: Alarm (category B)
Possible
cause:

The Nav OS is not able to communicate with the speed pilot controller
in the SINT. This may indicate that the speed pilot controller
is malfunctioning, a communication link (over the Local Area
Network) is broken, or the communication hardware in the SINT is
malfunctioning.

This alarm is generated when the Nav OS detects a failure of
communication using the OPC protocol between the Nav OS and the
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speed pilot. The OPC protocol is used to pass configuration parameters
and control commands between the Nav OS and the speed pilot.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Try taking command of the speed pilot from another Nav OS.

2 Check the operation of the other Nav OSes.
If any K-Bridge operator station on the LAN has hung or appears
to be operating slowly, this could be causing a network traffic jam
that is blocking the OPC communication between the Nav OS that
is in command and the speed pilot.

3 Restart any K-Bridge operator stations that have hung or are
operating slowly.

4 Check the operating status of the SINT.

Message: Speedpilot ground log
Description: Speedpilot ground log
Priority: Alarm (category B)

Possible
cause:

The speed pilot controller (in the SINT) is receiving no data from the
ground speed log.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the ground speed log sensor and its network connection.

2 Check the setup of the MFD.
3 Check that the autopilot’s Ground Log parameter has been set

correctly in the Autopilot Panel's Dockside parameters tab (select
Route→Autopilot Panel→Autopilot Setup→Dockside (tab)).

Message: Speedpilot no speed input
Description: Speedpilot no speed input
Priority: Alarm (category B)

Possible
cause:

The speed pilot is not receiving speed data from the operator station.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Disengage the speed pilot.
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Message: Speedpilot no station in command
Description: Speedpilot no station in command
Priority: Warning (category B)

Possible
cause:

The speed pilot is ready but no operator station is in command of the it.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Take command of the speed pilot at one of the operator stations.

Message: Speedpilot propulsion feedback error
Description: Speedpilot propulsion feedback error
Priority: Warning (category B)

Possible
cause:

Either no feedback is being received from the propulsion sensor or the
feedback deviates significantly from the order. The speed pilot will
not be able to control the speed.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the propulsion feedback readings.

2 If necessary, disengage the speed pilot.

Message: Speedpilot speed order not obtained
Description: Speedpilot speed order not obtained
Priority: Warning (category B)

Possible
cause:

The speed order and the actual speed have deviated more than a set
limit. The speed pilot is not able to reach the desired speed. Heavy
wind or waves might be the cause.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check that the speed set-point is reasonable and that the

propulsion is working as expected.
2 If necessary, disengage the speed pilot.
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Message: Speedpilot water log
Description: Speedpilot water log
Priority: Alarm (category B)

Possible
cause:

The speedpilot controller (in the SINT) is receiving no data from the
water speed log.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Check the ground speed log sensor and its network connection.

2 Check the setup of the MFD.
3 Check that the autopilot’s Water Log parameter has been set

correctly in the Autopilot Panel's Dockside parameters tab (select
Route→Autopilot Panel→Autopilot Setup→Dockside (tab)).

Message: Station is starting up (booting)
Description: Station is starting up (booting). Computer or program is about to start
Priority: Warning (category B)

Possible
cause:

The K-Bridge software is running for the first time after a reboot of the
computer or after the application has been restarted.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Be aware of this situation and monitor possible alerts from sensors or
other systems.

Message: Stopwatch time elapsed
Description: Stopwatch Time Elapsed
Priority: Warning (category B)

Possible
cause:

The countdown belonging to the MFD's stopwatch facility has reached
zero.

Acknowledge
from:

Any K-Bridge operator station.

Message: Switch to manual - autopilot rudder freeze
Description: Switch to manual - autopilot rudder freeze
Priority: Alarm (category B)

Possible
cause:

The autopilot is receiving no heading sensor information. This is
a follow-up alarm that will be related to a “Main Heading Sensor”
failure message issued earlier. It means that the rudders have been
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frozen by the autopilot because the main heading sensor is missing:
You must switch to manual steering.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action: 1 Switch to manual steering.

2 Check the main compass and the cable connected to it.
3 Select an alternative main compass.
4 Try re-starting the autopilot controller.
5 If the problem remains, do not use the autopilot.

Message: Target capacity
Description: Target capacity is at 90%: space left for n targets
Priority: Caution (category B)

Possible
cause:

The number of targets is about to exceed the capacity of the system.
There is now space left for n new targets. More distant targets will
be ignored.

Acknowledge
from:

No manual acknowledgement required (cautions are automatically
acknowledged as soon as they are generated).

Suggested
action:

Do not rely on the automatic detection of targets.

Message: Target left anchorage
Description: Target anchor watch limit exceeded
Priority: Alarm (category A)

Possible
cause:

The anchor watch facility has been activated for a tracked target, and
the target's distance from the anchorage point has now exceeded the
anchor watch limit. This alarm therefore informs you that the target
has left its anchorage.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action:

Acknowledge the alarm.
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Message: Tender alert
Description: Tender x alert
Priority: Warning (category B)

Possible
cause:

Someone on tender x has pressed its alert button.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If possible, contact the tender vessel.

Message: Tender out of range
Description: Tender x out of range
Priority: Warning (category B)

Possible
cause:

Tender x has passed beyond the limit of its permitted range.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

If possible, contact the tender vessel.

Message: TIC missing 24 VDC from display
Description: TIC has not 24 VDC from own display
Priority: Warning (category B)

Possible
cause:

The TIC card (in the radar interswitch) connected to this console is
receiving no 24 V DC power from the console. It is using power from
other consoles but may cease to operate if other consoles are switched
off.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM Service. Do not switch off the other radar consoles until
the 24V DC from the TIC's own radar console is re-established.
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Message: Too many active AIS targets
Description: Too many active AIS targets: distant targets will be deactivated
Priority: Warning (category B)

Possible
cause:

The number of active AIS targets has exceeded the capacity of the
system. (The Active AIS target table is full.) More distant AIS targets
will be deactivated.

Acknowledge
from:

Any K-Bridge operator station from which it is possible to control
the AIS system.

Suggested
action: 1 Deactivate auto-aquisition of AIS targets.

2 Check the list of active AIS targets, and deactivate targets that
are safely out of range or that cannot affect the safe navigation
of the vessel.

Message: Too many AIS targets
Description: Too many AIS targets: distant targets will be ignored
Priority: Warning (category A)

Possible
cause:

The number of AIS targets has exceeded the capacity of the system.
More distant AIS targets will not be detected.

Acknowledge
from:

Any K-Bridge operator station from which it is possible to control
the AIS system.

Suggested
action:

Do not rely on the automatic detection of AIS targets.

Message: Too many plots
Description: Too many plots: auto acquisition off
Priority: Warning (category B)

Possible
cause:

The number of automatically acquired targets has reached the system’s
maximum.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Reduce the tracker sensitivity settings (select Targets and use the
Tracker Sensitivity 1–10 spin button).
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Message: Too many targets
Description: Too many targets: no space left to acquire new targets
Priority: Warning (category A)

Possible
cause:

The number of tracked radar targets has reached the system’s
maximum.

Acknowledge
from:

The operator station that issued the alert.

Suggested
action: 1 Make room for new targets by removing any targets that cannot

affect the safe navigation of the vessel.
2 If necessary, switch off the automatic acquisition of new targets

or reduce size of the auto-acquisition area.

Message: Transmitter: charge trig fail
Description: Transmitter: charge trig fail
Priority: Warning (category B)

Possible
cause:

The transceiver has detected a failure in the charge trigger operation.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service to fix the problem.

Message: Trip meter distance elapsed
Description: Trip meter distance elapsed
Priority: Warning (category B)

Possible
cause:

The distance set for the MFD's trip meter has now been travelled.

Acknowledge
from:

Any K-Bridge operator station.

Message: Unident alert from scan converter
Description: Unident alert from scan converter
Priority: Warning (category B)

Possible
cause:

An unidentified illegal scan conversion error has occurred.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service to fix the problem.
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Message: Unident alert from tracker
Description: Unident alert from tracker
Priority: Warning (category B)

Possible
cause:

An unidentified illegal tracker error has occurred.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Contact KM service to fix the problem.

Message: VDR alert
Description: VDR alert
Priority: Alarm (category B)

Possible
cause:

This is a general alert indicating that the Voyage Data Recovery (VDR)
system has issued an alarm.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Go to the VDR operator panel to inspect and investigate the alarm.

Message: WP mode changed to CRS mode
Description: Close to turn, WPT mode terminated
Priority: Alarm (category B)

Possible
cause:

The autopilot has changed from Waypoint mode to Course mode.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

When it is safe to, start the turn manually.

Message: Wrong datum from pos. sensor
Description: Pos. sensor nn: wrong datum
Priority: Warning (category B)

Possible
cause:

The position sensor is not sending the same datum as has been
configured for the sensor.

Acknowledge
from:

Any K-Bridge operator station.

Suggested
action:

Check the position sensor configuration and the GPS datum setup.
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Message: XTD limit exceeded
Description: XTD is nn m
Priority: Alarm (category A)
Possible
cause:

An attempt has been made to select Track steering mode, but the
cross-track distance is greater than 1 NM.

Acknowledge
from:

Any K-Bridge operator station that is currently monitoring the route
and is not using the ECDIS browse facility (for browsing away from
the vessel on the chart).

Suggested
action:

Approach nearer to the track before selecting Track steering mode
again.

A.4 Radar and ECDIS operator messages
Radar and ECDIS operator messages are displayed on a yellow background in the
message field just above the range panel (see Radar dashboard: the operator message
field on page 78). They may be accompanied by an audible beep, and they require no
acknowledgement. Their main purpose is to indicate to the operator when the system has
been operated incorrectly.

Table 27 Operator messages

Text Description
Autopilot Communication
Failure

There is no communication between the K-Bridge Radar
operator station and the K-Bridge Autopilot (SINT).

Another route being edited You can only edit one route at a time. You will receive
this message if you have edited a route and not saved it
when you start to edit another route.

Bad Geometry - cannot
validate

Before a route can be validated, its route geometry must
be correct.

Can not be more than nnn
sensors

In the No of Sensors dialog (see Number of Sensors on
page 617) an attempt has been made to input a number
that is larger than permitted.

Can't Acquire, No Free
Targets

The ACQ button on the operator panel has been pressed
(see The TARGET group buttons on page 35) but target
acquisition cannot be initiated, because the target table
is full.

Cease tracking of some targets (see Ceasing the tracking
of targets on page 145).

Can't Acquire, Too Large
Range

The ACQ button on the operator panel has been pressed
(see The TARGET group buttons on page 35) but target
acquisition cannot be initiated, because the range to the
cursor exceeds the maximum range of the tracker.
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Table 27 Operator messages (cont'd.)

Text Description
Cannot edit field! In the Edit Route and Waypoint List dialogs (see Edit

route on page 420), the Waypoint List will include some
data that you can edit (such as co-ordinates or planned
speed) and other data that you cannot (such as Course
and Distance).

Cannot edit monitored
route

You cannot edit the route plan while it is being used for
monitoring.

Cannot set less than Ship
Draught

You will receive this error message if you try to set a
safety contour of less than the maximum value specified
for the ship's draught (see Ship (tab) on page 571).

Cmd Request Denied A request to take command of the autopilot has been
refused because the Route Monitoring or AP In Command
option is disabled in the Autopilot Configuration dialog
(see Autopilot Configuration on page 658).

CRS-Mode Terminated!! CRS mode has been terminated because the operator
relinquished command of the autopilot.

Folder name already in use! Note folders must have a unique name.
Ground Speed is Not
Available!

Ground stabilisation has been selected but there is no
speed sensor providing speed over ground.

HDG-Mode Terminated!! HDG mode has been terminated by the operator
relinquishing command of the autopilot.

Heading deviation too large An attempt has been made by the operator to enter track
steering, but the difference between the ship's heading
and the bearing of the leg is more than 30 degrees.

Illegal Act. WP!! An attempt has been made by the operator to enter track
steering, but the calculated waypoint does not exist.

Illegal coordinate Co-ordinates have been entered in an unrecognised
format. The required format is "59°26.230'N" and
"010°26.844'E" (or S or W), but it can be simplified to
"59 26.3" and "10 26.8E".

Illegal geometry: too short
leg or large radius

In route geometry, if a specified turn radius is too big
there may not be any space for straight legs between
waypoints.

Local Autopilot Command The ECDIS or radar is no longer commanding the
steering control system through the autopilot. HDG,
CRS, WP or TRACK mode is terminated. Command
of the steering control system is taken locally by the
K-Bridge Autopilot.
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Table 27 Operator messages (cont'd.)

Text Description
Manual Drift must be <=
15 knots

The manual drift cannot be set higher than 15 knots.

Manual Drift must be >= 0
knots

The manual drift cannot be set to a negative value.

Manual Speed must be <=
70 knots

The manual speed cannot be set higher than 70 knots.

Manual Speed must be >=
0 knots

The manual speed cannot be set to a negative value.

Max Trial Time Exceeded The trial simulation has been stopped. The maximum
trial time is one hour. Therefore the end of the trial
manoeuvre must be less than one hour's sailing time
away.

Missing OwnShip Data!! An attempt has been made to enter track steering, but
calculations based on position, speed and heading have
caused the attempt to fail.

Missing Sail Data!! An attempt has been made to enter track steering, but
calculations based on position, speed and heading in
relation to the planned route have caused the attempt to
fail.

Must be at least nnn sensors In the No of Sensors dialog (see Number of Sensors on
page 617) an attempt has been made to input a number
that is smaller than permitted.

No Detail Menu is available In the No of Sensors dialog (see Number of Sensors on
page 617) (or in the dialog for a particular type of sensor
interface) an attempt has been made to view Details
where none are available.

No Free Targets Left The ACQ button on the operator panel has been pressed
(see The TARGET group buttons on page 35), and target
acquisition has been initiated. However, the target table
is now full and no more targets can be initiated.

Cease the tracking of some targets (see Ceasing the
tracking of targets on page 145).

No Monitored Route !! An attempt has been made by the operator to put the
autopilot into TRACK or WP mode. However, there is
no route currently being monitored.

No Target is close to the
marker

The DATA button on the operator panel has been pressed
(see The TARGET group buttons on page 35), but there is
no tracked target close to the cursor.
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Table 27 Operator messages (cont'd.)

Text Description
Not In Command! An attempt has been made to select one of the autopilot

steering modes. However, the attempt was made from an
operator station that is not In Command of the autopilot.

Not passed 1. WP !! An attempt has been made by the operator to enter track
steering, but the ship has not yet reached the start of the
route.

Only HeadUp Available -
Hdg Error!

There is no acknowledged input from a heading sensor
and the operator has attempted to use a presentation mode
other than HEAD UP ‒ RELATIVE MOTION. This is
the only permitted mode when there is no heading sensor.

Only nnn Free Targets Left The ACQ button on the operator panel has been pressed
(see The TARGET group buttons on page 35), initiated,
but there are only nnn free entries left in the target table.

Cease the tracking of some targets (see Ceasing the
tracking of targets on page 145).

Perf. Mon. Could not be
activated!

An attempt has been made to start the performance
monitor on a transceiver where the connection has timed
out.

Remote AP-Mode

Terminated!!

Remote control of the autopilot has been terminated by
the operator relinquishing command of it.

Route Turn !! An attempt has been made to select TRACK steering
mode, but the ship is executing a turn on the route.

Route validation is busy Route validation is handled as a single background
process. If you have started one validation process, you
cannot start another until the first has finished.

Route: BAD Geom! The route has inconsistent geometry: the turn radiuses
are too large, leaving no straight legs between turns. The
route must have consistent geometry to be validated.

Route: Bad Geometry! The route has inconsistent geometry: the turn radiuses
are too large, leaving no straight legs between turns. The
route must have consistent geometry to be validated.

Route: Gnd! Route validation has detected grounding risks on the
designated route segment.

Route: Not Validated! The route has not passed validation.
Route: OK! This part of the route has passed validation.
Route: Outside Chart! The route validation process has detected that there is no

valid chart coverage for this part of the route.
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Table 27 Operator messages (cont'd.)

Text Description
Select Manual Steering
Please!

The autopilot is reporting that it has lost its heading input.
TSwitch to manual steering and correct the problem.

Sensor type must be
selected

In the No of Sensors dialog (see Number of Sensors on
page 617) a sensor type must be selected before the
number can be changed or details can be viewed.

Ship outside leg An attempt has been made by the operator to select
TRACK steering mode, but the ship is not on a straight
leg.

Slave Can't Change Pulse
Length

An attempt has been made to change the pulse length
for the transceiver. However, the operator station from
which the attempt was made was not Master in relation
to the transceiver.

Slave Can't Change
Run/StandBy

An attempt has been made to change the Run/Standby
state of the transceiver. However, the operator station
from which the attempt was made was not Master in
relation to the transceiver.

Speed Control Terminated The Speed Pilot did not respond to an activation
attempt within 5 seconds, and the attempt was therefore
terminated.

Threshold Parameters
Outside Limits!

An attempt has been made to use unacceptable values for
the tracker's minimum thresholds.

Too close to turn An attempt has been made to select Track steering mode,
but the difference between the bearing to the turn point
and the heading of the ship is more than 15 degrees.

TRACK Refused: Route
Not Validated

An attempt has been made to select Track steering mode,
but the monitored sailing route has not been validated.

TRACK Steering refused.
No Conning Display

An attempt has been made to select Track steering mode,
but there is no Conning Display connected.

TRACK Steering refused.
No ECDIS

An attempt has been made to select Track steering mode,
but there is no ECDIS connected.

Track Steering Terminated! The sailed route has become unmonitored. The steering
mode has therefore been changed from Track to HDG
Mode. The ship will continue straight ahead.

TRACK-Mode
Terminated!!

Track mode has been terminated by the operator
relinquishing command of the autopilot.

Trial is not permitted in
Relative

The operator has attempted to use the trial manoeuvre
facility in relative motion. It is only available in true
motion.
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Table 27 Operator messages (cont'd.)

Text Description
Trial Speed Too Small The trial simulation has been stopped because the

simulated speed was less than 1 knot.
Trial stopped in Relative The operator has attempted to use the trial manoeuvre

facility in relative motion. It is only available in true
motion.

Type must be "RHL" or
"GC"

This message is issued during the editing of routes or
Mariner's notes when the line/leg type field is set to
something other than "RHL" (RhumbLine) or "GC"
(Great Circle).

Values can't be changed as
Slave

A dialog for changing radar parameters has been
activated but the operator station is only a Slave in
relation to the selected transceiver. The message informs
the operator that this dialog is read-only until the operator
station becomes the Master in relation to the transceiver.

Water Speed is Not
Available!

Ground stabilisation has been selected but there is no
speed sensor providing speed over ground.

WayPoint Steering
Terminated!

The sailed route has become unmonitored. The steering
mode has therefore been changed fromWWaypoint mode
to HDG Mode. The ship will continue straight ahead.

WP too close for TRACK
Sailing

An attempt has been made to select Track steering mode,
but the distance to the next wheel-over-point is less than
500m.

WP-Mode Terminated! WP mode has been terminated by the operator
relinquishing command of the autopilot.

XTD too large An attempt has been made by the operator to select
TRACK steering mode, but the cross-track distance is
greater than 1 NM.
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Appendix B
Ground and water
stabilisation

This section contains the following topics:
Introduction....................................................................................................................740
Ground-referenced sensors ............................................................................................740
Water-referenced sensors ..............................................................................................741
Ground- and water-referenced vectors...........................................................................741
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B.1 Introduction
This appendix explains the concepts of ground and water stabilisation.

The course and speed of the own-ship are measured with reference both to the ground
and the water. The sensors used for this must be type approved. Vectors for tracked
targets are also calculated with reference to both ground and water (although the vectors
actually presented must be either ground or water stabilised: they cannot be both). The
same selection of ground or water stabilisation on the radar dashboard (see The radar
dashboard on page 77) applies to tracked targets, AIS targets, and the own-ship.

To select between ground- and water-referenced sensors, use the Ground and Water
radio buttons (see 2.4 on page 77).

B.2 Ground-referenced sensors
Ground-referenced sensors are found in:
• Electronic Position Fixing Systems (EPFS) such as GPSs.
• Speed logs capable of measuring speed with reference to the sea bed.
• Radar positioning systems that track stationary radar targets.

An EPFS system will either transmit the speed data directly to the K-Bridge Radar
system or it will transmit only position data.

If the K-Bridge Radar system does not receive speed data directly, it calculates the speed
and course from changes in the position data it receives. GPS data is normally the most
accurate basis for this but there are sources of error, including changing atmospheric
conditions and changes between absolute and differential reception.

Ground-referenced speed logs work by analysing the echoes of sound transmitted
through water and returned from the sea bed. Their speed measurements are also subject
to error. In very deep water, for example, there may be no return of sound from the sea
bed at all. In rough seas or when the own-ship's thrusters are operating, the return of
sound from the sea bed can be blocked by bubbles. And, in the case of ground-referenced
speed logs that use the Doppler principle (and therefore transmit their sound at an
angle), the resulting speed measurements can be substantially affected by changes in
temperature and salinity (these cause the sound ray to bend).

Finally some ground-referenced speed logs may use echoes from layers in the water
instead of from the sea bed; where this is the case, it will introduce an error in the speed
measurement that is equal to the speed of the water.

740 381287/A



Appendix B Ground and water stabilisation

B.3 Water-referenced sensors
Water-referenced sensors are speed logs that are capable of measuring speed through the
water close to the ship. Speed logs may be single axis (measuring only the along-ship
speed), or dual axis (measuring also the athwart-ship speed). If a single axis log is used,
it is assumed that the Course Through Water (CTW) is the same as the heading.

Water-referenced speed logs (like ground-referenced speed logs) can be affected by
rough seas or the own-ship's use of its thrusters. These disturbances can cause changes
in the local stream of water that make it impossible to measure what the speed through
“unchanged” water would have been.

B.4 Ground- and water-referenced vectors
If you select “ground” as the principle of stabilization, this causes the vectors presented
for tracked targets, AIS targets and the own-ship to be ground referenced. If you select
“water”, the vectors presented for tracked targets, AIS targets and the own-ship are
water referenced.

Water-referenced vectors are best for collision avoidance, especially at night. When
there is a current in the water (as long as the current is the same at the own-ship as at
the target) then the water-referenced vectors of targets that are heading towards the
own-ship's’s starboard or port side will show directly. The colour of the navigation lights
at night (and which side is visible at day) corresponds to the vector passing to the port or
starboard. (This is correct only if both the target and the own-ship move through the
water in the direction of their heading lines (and there is zero water speed athwart-ship).

AIS information is referenced to ground. The AIS vectors are recalculated based on the
own-ship's’s water speed when they are shown referenced to water.

Measurement of the own-ship's ground speed is more accurate than measurement of its
water speed, and – unlike water – the ground provides a fixed reference that is common
to both the own-ship and its targets. Water-referenced vectors can be misleading when
there is variable current in the water. Ground-referenced vectors provide better guidance
as to where the targets are heading in relation to geographical features (for example,
which side of a small island they are going to make towards), especially when the
electronic chart is displayed.

CPA and TCPA calculations will give the same results irrespective of whether ground or
water stabilisation is used.
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Appendix C
Concepts of video
enhancement

This section contains the following topics:
Introduction....................................................................................................................744
Video stretching .............................................................................................................744
Enhancement of stable echoes .......................................................................................744
Sweep correlation...........................................................................................................746
Sweep integration...........................................................................................................746
Scan correlation .............................................................................................................747
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C.1 Introduction
This appendix provides background information about the video enhancement facilities
available in the K-Bridge Radar system (particularly in the Video Enhance dialog;
seeVideo Enhance on page 643 ).

For further information about how to minimize problems that you might encounter with
the video display, see Minimising radar display problems on page 751.

C.2 Video stretching
Video stretching is designed to make targets more visible by stretching them in range.
When applied, the stretching is performed on all video presented on the screen. It does
not distinguish between stable echoes and clutter, and it is best used in relatively clutter
free conditions. Increasing the pulse length is often a better way to enlarge target echoes.
However, the advantage of stretching is that it can be used to stretch echoes only at
the outer part of the screen. The sea clutter close to the own-ship will then not be
stretched (leaving the visible clutter unchanged), but the targets at longer range will be
presented with larger echoes. The transition between non-stretched and stretched video
is graduated to avoid the appearance of a distinct ring at the transition: at the end of the
non-stretched range, video is stretched by one pixel, then by one more a bit further out,
and so on until the full stretch length is reached.

C.3 Enhancement of stable echoes
Video enhancement is designed to make stationary stable targets more visible than
random noise or clutter. It does this by changing the presented colour, and by extending
the size of the presented echoes by one pixel in each direction. The colour change and
extension are performed only on stationary or slow-moving targets, so moving targets
will not be presented in another colour. This enhancement is only presented when true
trails are displayed. The technique can only enhance stationary and stable echoes that are
presented on the screen. To get the full effect of this enhamcement, you must adjust the
gain and clutter controls so that a small speckle of noise is present on the screen.
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Figure 113 Target without (left) and with (right) video enhancement

The technique used by the system is to average (or more precisely to “low-pass filter”)
the video in each pixel on the screen over several scans. Strong clutter spikes that occur
only in single antenna rotations will be reduced, while weak stable echoes will be
enhanced (see diagram below).

Additionally, the presented size of enhanced video echo is extended by one pixel in
each direction on the screen, to increase its visibility. The enhancement works only if
the pixel represents the same geographical position in successive antenna rotations.
The enhancement is therefore only displayed when True Trails are being displayed.
The low-pass filtering is performed after adjustments for gain and clutter. If gain and
clutter are adjusted in such a way that only the strong and stable echoes are visible, the
enhancement will have no effect.
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C.4 Sweep correlation
Sweep correlation is performed by comparing the incoming video with the video that
was received in the previous sweep (in other words, the previous radar pulse). This
comparison is performed on corresponding samples of the video. If the echo in the
incoming sweep is more than a configurable percentage higher in amplitude than the
echo in the corresponding sample from the previous sweep, then the value from the
previous sweep is used.

This method of comparison suppresses an interference pulse while allowing slowly
rising echoes to persist.

Echoes that are not sweep-to-sweep correlated are completely removed from the screen,
because any real echo will repeat in several sweeps (due to the Pulse Repetition
Frequencies and Antenna Rotation speeds used in K-Bridge Radars).

We recommend you keep sweep-to-sweep correlation on in normal conditions to hide
transmitting pulses from other radar equipment.

Figure 114 Typical interference from another radar

C.5 Sweep integration
The pulse repetition frequency of the radar is so high compared to the rotation time that
even a small target will be hit by several sweeps within the same antenna rotation. The
number of sweeps that will hit a target in each antenna rotation varies between four (for
an X-Band 2.4m antenna with a long pulse) and twenty four (for an S-Band antenna with
a medium or short pulse). The number is lower for high-speed radar.
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Integration over the sweeps within one radar beam width will remove noise but not
echoes from targets that are stable for the 10-15 ms it takes the antenna to sweep across
the target. This includes ships, land and waves. There is no risk of hiding a target by
using sweep integration, but targets may appear wider in bearing. The theoretical
improvement in signal-to-noise ratio is 3dB to 6.9dB. The actual results in K-Bridge
Radar will be slightly lower, because sweep-to-sweep integration is performed after
gain and clutter adjustment, not before.

Sweep-to-sweep integration can be performed with or without sweep-to-sweep
correlation activated. However, sweep-to-sweep correlation is normally recommended,
to reduce noise from other radar equipment without affecting the result of the
sweep-to-sweep integration.

The number of sweeps within the opening angle of the radar antenna beam is calculated
from the measured Pulse Repetition Frequency (PRF) and antenna rotation time, and the
configured beam width for the selected radar. The resulting number is rounded down to
give the nearest integer number of sweeps for integration; it is limited to a maximum
value specified in the Video Enhance dialog.

Traditionally sweep-to-sweep integration has only included past sweeps in its
calculations. However, this leads to a rotation of the presented picture by half a beam
width. The K-Bridge Radar avoids this by performing integration over a number of
sweeps on both sides of the presented sweep.

Figure 115 Target without (left) and with (right) sweep integration

C.6 Scan correlation
Scan correlation is performed by comparing the incoming video with video from the
previous rotation(s) of the antenna and using a lower intensity to display targets that
are not present at the same position in all the rotations. (You can specify whether the
comparison is performed over two or three rotations.)
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The echoes that are present at the same position for only one or two scans appear with a
lower intensity but are not removed completely; this is because high-speed vessels may
travel so fast over the screen that they are not present at the same position in more than
one scan (but their echoes obviously need to be captured).

Figure 116 Target without (left) and with (right) scan correlation

You can remove these targets from the picture by clicking and holding down the Hide
Uncorrelated button; the targets will be visible again when you release the button (see
Video Enhance on page 643).

Figure 117 Target with scan correlation on and “Hide Uncorrelated” pressed

When you configure the correlation to take place over three scans, the correlated video
that disappears is permitted to survive on the screen for one further scan (although with
reduced intensity). This makes the presentation of unstable echoes more stable.

748 381287/A



Appendix C Concepts of video enhancement

Figure 118 Higher definition is achieved with correlation over three scans

In relative motion, stationary targets will move across the screen at the own-ship’s
speed. Scan-to-scan correlation is therefore best adapted for true motion display. We
recommend you have it enabled with true trails (this is the default in true motion), and
disabled with relative trails (which is the default in relative motion).
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Appendix D
Minimising radar display
problems

This section contains the following topics:
Introduction....................................................................................................................752
Second-time echoes .......................................................................................................752
Transmission pulses from other radars ..........................................................................754
Random electrical noise.................................................................................................754
Mirrored (ghost) echoes.................................................................................................754
Dual paths and interference between the two paths.......................................................755
Side lobes .......................................................................................................................756
Echoes from sea clutter..................................................................................................756
Echoes from precipitation (rain clutter).........................................................................757
Refraction of radar beams..............................................................................................759
Suppression of fast-moving targets................................................................................759
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D.1 Introduction
This section describes some of the problems that radar video is susceptible to and
provides tips to help you overcome them.

D.2 Second-time echoes
The radar uses a rotating antenna to transmit radio pulses, receive the echoes from these
transmissions, analyse the echoes and present the result to the user on a video display
unit. The time between transmission of the pulse and reception of the echo is used to
calculate the distance to the target.

It is assumed that an echo is the result of the last transmitted pulse, as illustrated below:

Key to diagram:

T- Transmitted pulse

E - Echo received

t1 – Time from transmission to reception (used to calculate distance)

If, however, the time taken by a transmission to reach a target is longer than the interval
between that transmission and the next transmission pulse, the following situation arises:

Key to diagram:

E - Echo received

t1 – Time from first transmission to reception of echo.
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T2 – Second transmitted pulse

t2 – Time from second transmission to reception (this interval is used to calculate
distance).

We see that in the second case, the distance will be calculated from t2, instead of t1, and
the echo will appear on the screen as too close.

D.2.1 Countering second-time echoes

Automatic inter-sweep time handling
There is a delay between the end of reception for the selected range scale and the
transmission of the next pulse. This reduces the strength of the distant echoes so that the
second-time echoes are less frequent and weaker. They can not be removed completely,
because of the need for frequent updating of the screen. Inter-sweep time is handled
automatically by K-Bridge Radar.

Automatic staggering of transmission intervals
The time between transmission pulses is not constant but is subject to minor variations
from one transmission to the next. In this way, the apparent distance t3 is different from
the apparent distance t2.

If sweep-to-sweep correlation is on, the second-time echo from a small target will be
removed. If the target is larger than the difference between t2 and t3, the echo will
not be completely removed but will nevertheless be substantially reduced. It can be
further reduced with sweep integration. This staggering is always active, and requires
no user interaction

Changing the pulse length
You can change the pulse length (see Radar Control on page 539). When changing from
a short or medium pulse to a long pulse, the pulse repetition frequency is changed from
1800 Hz nominally to 785 Hz nominally. Echoes that disappear from the screen as a
result of a change of pulse length are probably second-time echoes. If they disappear
after a reduction of pulse length, that may also be due to a reduction in echo strength.
Changing the pulse length also changes the resolution of the radar picture (a shorter
pulse gives a higher resolution).
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D.3 Transmission pulses from other radars
When there are other radars transmitting with the same frequency in the same area, the
transmitting pulses will be received through the antenna; they will then be perceived as
echoes and presented on the screen. If the other radar has a different Pulse Repetition
Frequency (PRF), the transmitting pulses will be shown as short lines in a spiral pattern.
If the other radar has a PRF that is equal to the own-ship's radar, the lines will be shown
in a more circular pattern. Staggered transmission intervals will make this circle appear
broken and not perfect.

D.3.1 Countering pulses from other radars
Use weep-to-sweep correlation to remove other radars' transmission pulses from the
presentation. We recommend you set sweep-to-sweep correlation to on in almost all
circumstances.

D.4 Random electrical noise
There is always some electrical noise that reduces the signal-to-noise ratio and the
radar's detection capabilities.

D.4.1 Countering random electrical noise
Random noise will be reduced by sweep-to-sweep correlation, sweep integration and
scan-to-scan correlation. These will all contribute in different ways. Use gain adjustment
to reduce the presented noise to a manageable level.

D.5 Mirrored (ghost) echoes
Radar beams will be reflected by reflecting materials. This is called mirroring. If the
mirroring surface is nearly vertical, the radar beam will be reflected in another direction.
If it then hits a target and is reflected back into the antenna, the radar will present the
echo in the direction of the antenna and not in the direction of the mirrored beam. This
can be very confusing for the radar operator.

D.5.1 Countering mirrored (ghost) echoes
There is little to be done either in radar design or operation to reduce the effect or
occurrence of mirrored echoes.
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However, it is important to be aware of their possibility and also to try to establish
at which bearings they may occur as a result of mirroring objects on the own-ship.
Countermeasures must be performed at the ship-design stage to eliminate possible radar
mirrors or at least to ensure that they are not vertical. Mirrors that reflect the radar waves
into the open sky will normally not create a problem.

D.6 Dual paths and interference between
the two paths
This is another mirror effect. It occurs mainly in calm seas and with small echoes from
targets such as buoys and beacons.

There are two possible paths between the radar antenna and the small target: one direct
path and one path that hits the sea surface and is reflected up to the target. The reflected
path is longer than the reflected path and takes a little longer than the reflected path.

The signals in the direct path and in the reflected path will interfere, giving a received
echo which is the sum of both signals.

If the difference in distance between the two lines is a multiple of the radar wavelength
(3 cm for X-Band, 10 cm for S-Band), then the signals are “in phase”. This means that
they will be added and a strong echo will be presented.

If the difference in distance is such that the signals are “in counter-phase” (half a
wavelength from being in phase) then the reflected signal will be subtracted from the
direct signal and weak echo (if any) will be presented.

When the ship sails towards the reflector, the distance between the direct path and the
reflected path will vary between phase and counter-phase. Therefore the echo from the
reflector will vary between a strong echo and no echo at all.

D.6.1 Countering interference between two paths
There is nothing you can do to stop this interference. If you have two radar antennas
on board, however, there is a possibility (but not a certainty) that the target will not
be weak for both radars at the same time.
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If trails are switched on and configured to persist for one minute or more, the trails from
the strong reflections will indicate the position of the unstable echo. This works best in
true motion. If there is an electronic chart available, the chart will show the positions of
fixed navigational aids.

D.7 Side lobes
The energy and sensitivity of the radar antenna is not restricted to the main beam but
will produce some effect also outside the main beam. This effect is represented in an
antenna's radiation pattern by local peaks to the sides of the main beam (or lobe) called
side lobes. They are of reduced (and progressively diminishing) radiation intensity.
Therefore they will not affect the radar display unless there are very strong echoes
present such as might be produced for example by a steep cliff or the side of a large ship.
The effect is to make the main echo appear to repeat in diminishing shapes at the same
range but slightly different bearings. Sometimes the side lobes can cause the repeated
images to merge on the display with the main echo, causing the target to appear larger.

D.7.1 Countering side lobes
There are no counter-measures for preventing side lobes from occurring. You can remove
them from the screen by reducing the gain threshold, but this will affect the presentation
of echoes in other parts of the screen. Therefore, only adopt this method of countering
side lobes when you are looking at echoes in close proximity to an echo with side lobes.

D.8 Echoes from sea clutter
Echoes from waves may be strong compared to echoes from smaller ships and boats. The
more perpendicular to the sea surface a reflecting object is, the stronger its reflections
will be. The sea echoes will therefore be stronger and much greater in number close to
the radar; their strength and number will decrease with range.
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A radar mounted higher above the surface will have problems with sea echoes at a
longer range than a radar that is mounted lower. As a general rule: If one radar antenna
is mounted twice as high as another, it will have problems with sea clutter for twice
the range.

Sea echoes will also be stronger facing into the wind than facing to the lee-side.

D.8.1 Countering sea clutter
For information about countering sea clutter, see Setting the gain and clutter controls
on page 120.

D.9 Echoes from precipitation (rain clutter)
Precipitation (rain, snow, hail and combinations of these) will also influence the echoes.
Parts of the radar beam will be reflected in each droplet and thus reduce both the echoes
reflected from the target and the signal-to-noise ratio. The reduction of echo strength
is difficult to predict, but the graphs below may give an indication. They are valid for
S-Band and X-Band respectively.

Figure 119 First-detection ranges in rain (S-band)
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Figure 120 First-detection ranges in rain (X-band)

Both the above graphs assume that the rain density is constant in the area and give
the reduction in detection range for two different densities of rain: 4mm/hour and
16 mm/hour. However, conditions with homogenous precipitation are unlikely to be
encountered. The precipitation usually varies across the radar range, and the reduction of
echo strength is not homogenous. This makes it difficult to find one setting of gain and
clutter that is optimal for the entire radar range.

Whatever your rain clutter setting, it may not be optimal for all rain showers in the area,
so you may need to adjust it when focusing on different areas.

Even with rain clutter adjusted properly, some targets will remain undetected in
precipitation, even when other targets in the same precipitation are detected.

The graphs above give estimated ranges for the first detection of targets in different
levels of precipitation (assuming an ideal setting of the gain and clutter controls). But
of course real life may be different and conditions worse than the graphs allow for.
According to the graph for the X-band radar, a target that should be detected at 5 NM
without rain and using a long pulse will be detected for the first time at about:
• 1NM in conditions of 4 mm/h of rain, and at
• 0.2NM in conditions of 16mm/h of rain.

It is also possible to see from the graphs that weak targets will have a more significant
degradation of detection range than strong targets. This is because strong targets have a
higher rate of echo return than weak targets.
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D.9.1 Countering rain clutter
For information about countering rain clutter, see Setting the gain and clutter controls
on page 120.

D.10 Refraction of radar beams
These are effects caused by meteorological conditions that bend the radar beams either
upwards or downwards. Under normal conditions the radar beams will be bent slightly
downwards because of higher humidity close to the water. This results in a “radar
horizon” that is a little further away than the optical horizon. It is usual to have a radar
horizon that is approximately 4/3 of the optical horizon.

Under some conditions, the radar beams will be bent differently from normal, and
differently at different heights. If the temperature increases with height, or the humidity
decreases with height, the radar beams will be bent downwards.

In certain conditions the radar beams will not escape from the lower layers at all and
they are then described as trapped in a “duct” (the duct may vary from 10 to 200 meters
in height). This results in a significant increase in effective radar range across the sea
surface and an increase in the occurrence of second-time echoes.

With a low layer of fog or warm air just above the water the radar beams will be reflected
upwards. This results in a very low effective radar range across the sea surface. In
extreme cases the beam from a radar mounted on top of the ship will not reach the
surface of the sea at all.

D.10.1 Countering the refraction of radar beams
There is little to be done to counter the refraction of radar beams. However, you must be
aware of the phenomenon and know when to expect the problems associated with it.

D.11 Suppression of fast-moving targets
Fast moving targets will move across the screen from one scan to another. This means
that they will be suppressed by scan-to-scan correlation: they will still be visible but with
limited intensity and they will not leave trails.

D.11.1 Countering the suppression of fast-moving targets
When you need to watch fast-moving targets carefully, turn off scan-to-scan correlation
even though this means that it will be more difficult to distinguish weak and slow
targets from noise.
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Appendix E
Speed pilot

This section contains the following topics:
Speed pilot overview......................................................................................................762
User interface .................................................................................................................762
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Setting route speed – Route speed mode .......................................................................763
Setting ETA speed – ETA speed mode ..........................................................................763
Automatic speed update profile .....................................................................................765
Activating the Speed pilot..............................................................................................765
Bumpless transfer...........................................................................................................766
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E.1 Speed pilot overview
This appendix describes the speed pilot option module for the K-Bridge navigation
system.

The following figure shows the interfaces of the speed pilot. The main modules are as
follows: Speed Setpoint Provider (e.g. ECDIS), Speed pilot, Speed Measurement and
Propulsion.

Figure 121 Speed pilot overview

The output from the Speed Controller module is put into the Thrust Allocation unit,
which based on Propulsion models and Allocation algorithms calculates revolutions per
minute (RPM) or pitch set-points for the propulsion control system.

E.2 User interface
For the user interface (Speed Set-point Provider) and a description of the dialog box
involved, see Speed Pilot (option) on page 433.
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E.3 Setting speed – Speed mode
• The operator is to set ordered speed in the Operating Mode of the dialog, by either

entering desired speed or using spin buttons to increase or decrease the speed order
(1 knot step).
If speed is entered by numeric keys the Apply button must be enabled to allow the
operator to initiate the new speed order (see Speed Pilot (option) on page 433).

E.4 Setting route speed – Route speed
mode
• The route speed mode takes speed order from the waypoint list speed attribute. The

speed order is then picked accordingly and put out to the Speed pilot.

Figure 122 Example of Waypoint list

E.5 Setting ETA speed – ETA speed mode
The Estimated Time of Arrival (ETA) speed mode calculates the required speed on the
legs to arrive at a desired time at the end of the route (or at an arbitrary waypoint). A
new waypoint attribute is defined (Free Speed) which indicates that the Speed pilot (in
ETA mode) is allowed to vary the speed order within a certain interval on the leg.
Some tips for setting up the ETA speed are listed below:
1 Bring up the ETA Speed dialog in one of the following ways:

• by pressing the ETA Setup button in the Speed pilot dialog (see Speed Pilot
(option) on page 433), or

• by using the Route→Compute ETA button.
The detailed setup is now done in the opened ETA Speed dialog shown in section
20.4.9.1 on page 435.

2

381287/A 763



K-Bridge Multi-functional Display Unit

a If a route is being monitored, the monitored route is shown in the ETA Speed
dialog.

b If no route is monitored, a selection box is enabled in the bottom part of the
dialog, enabling planning of the ETA for a certain route.
For each waypoint (Wp/leg) there is a checkbox which sets a Free Speed
waypoint attribute. If this is set it indicates that the following leg is allowed
to vary speed “freely”.
Free speed is though within limits; the speed must be between 0.2kn and
maximum ship speed set. (System→Parameter Settings→Route tab→Max Speed;
see Route (tab) on page 570.)
If the Obey Max Speed is checked the speed is even limited by the maximum
speed given by the waypoint max speed setting.
For all waypoints (Wp/legs) not checked as free speed, the speed is determined
by the settings in the Fixed Speed Legs below in the dialog. Either the current
speed (speed is fetched when selection is made), the planned speed (from
route plan Spd attribute) or a manual set speed is used for all none Free Speed
waypoints.

3 To set a desired ETA for a waypoint, select the row with the corresponding
waypoint. In the ETA Speed dialog, select as follows:
• either double click in the wanted ETA column, or
• press Ins ETA button.
A suggested time pops up (based on the ship cruising speed set in System→Parameter
Settings→Route tab→Cruise Speed; see Route (tab) on page 570).
You may now edit the ETA time as you wish (time format; DD <Month in 3 letter
code> HH:MM).
If either the time you enter is not achievable or there is an insufficient number of
Free Speed legs, a warning message is displayed in Status section of the dialog.
Once a legal setup is made, the OK button is enabled allowing you to save your
ETA route settings.

4 It is possible to change any ETA speed settings even if the route is monitored
and used.
When you do changes, the result of the changes are immediately checked and
verified, but will not be used until you press OK (if they are found OK). It is possible
to revert to your old setting pressing Cancel before OK button is pressed.

5 Add Wait Times
The Add Wait Times (from Plan) causes the ETA calculation to take into account the
Wait Times from the plan. This setting will however not cause the Speed pilot to
command a zero order for a certain time, so this should be taken care of by other
means (e.g. manual speed control).
Once the ETA is setup correctly and your route is being monitored, you are able to
select the ETA mode in Speed pilot dialog, see section 20.4.9 on page 433.

6 Selection Calc ETA/ETA Speed pilot
The ETA Speed dialog used as follows:
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• can either be a setup dialog for ETA speed control (select ETA Speed pilot), or
• a tool displaying ETA at the various waypoints (select Calc ETA) on the

monitored route (or selected route if planning mode).
Changing settings in Calc ETA while the Speed pilot is running in ETA mode will
not affect the running of the Speed pilot. Reverting to ETA Speed pilot will change
the settings to your active settings.

E.6 Automatic speed update profile
The Automatic speed profile update in the Speed pilot dialog enables dynamic update
of the speed of the route.
If the speed for some reason is not achieved at earlier parts of the route adjustments may
be necessary on the remaining parts of the route to achieve desired ETA. By enabling
this option this recalculation is done automatically at regular intervals.

E.7 Activating the Speed pilot
To be able to perform any Speed pilot settings the Speed pilot must be in command, see
section 20.4.9 on page 433 and Figure 123 below.
Some Speed pilot statuses are listed below.
Command setting is common with the Autopilot In Cmd and is set as follows:
- either by dialog Autopilot Mode (see Autopilot Mode on page 427), or
- by the panel status text field In Cmd.
• If the station is not In Cmd, the Speed pilot dialog is disabled (except for the ETA Setup

button) indicating that no active control can be performed.
• When In Cmd, all dialog selections (except Activate button) is enabled, making it

possible to prepare the Speed pilot before activating it.
• When the Speed pilot is Not Ready for use (External Speed pilot On/Off-switch is

Off) the Activate button is disabled (grey). The Speed pilot status text field shows
Not Ready.

• When the Speed pilot is Ready for use (External Speed pilot On/Off-switch is On)
the Activate button is enabled.

• If the Activate button is not enabled, the status text field shows Remote. This indicates
that the Speed pilot is active controlling propulsion, but this station is not controlling
it (not providing ordered speed).

• If the Activate button is enabled (displaying Active) the status text field shows In Cmd
indicating that the Speed pilot is active controlling propulsion and this station is
providing ordered speed.

• If no station is In Cmd the Speed pilot is running autonomously with the last given
ordered speed.
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Figure 123 Activation of Speed pilot

E.8 Bumpless transfer
When the Speed pilot is switched On by a ready signal, the output from the Speed pilot
controller is immediately used as order to the propulsion system. The speed at transfer
time is fetched and used as setpoint.

To avoid large jumps and excessive loads on the propulsion system, a bumpless transfer
is made possible. This is done by filtering (smoothing) the propulsion feedback and
using this as the desired order at transfer time. To make the transfer as gentle as possible,
it is important that the propulsion has been at a reasonable steady level for some time,
otherwise propulsion jumps during the transfer may occur.
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Appendix F
Generating routes,
predicting tides, avoiding
pirates

This section contains the following topics:
Introduction....................................................................................................................768
Generating routes automatically ....................................................................................769
Using the tide prediction facilities .................................................................................776
Avoiding piracy blackspots............................................................................................782
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F.1 Introduction
This appendix tells you how to generate routes automatically between two ports, how to
use the tide prediction facilities, and how to avoid known blackspots for piracy.

This option provides automatic route generation facilities (for generating a route between
two specified ports) and tide prediction facilities.

To use this option, you must have a licensed C-Map Professional+ chart database
installed.

The automatic route generation and the tide prediction facilities are integrated with
the normal route planning functionality of the K-Bridge ECDIS and Planning Station
applications. Therefore you can use them to access tide and stream data at different
points in space and time along a route that you are generating automatically.

F.1.1 Route generation
The route generation tool:
• Suggests a route between two ports that you specify.
• Allows you to specify that the generated route must not pass through certain passages

or canals.
• Allows you to specify that the generated route must maintain a minimum depth of

clearance for the vessel for the entire length of the route.
• Checks the generated route's leg and turn-radius geometry. The route generation

facilities can also be configured to correct the route automatically in this regard.
• Generates routes in a format that enables you to pass them through route validation in

the ECDIS and Planning Station applications.
• Can be configured to generate route names automatically on the basis of the port

names or port UN/Locodes that you specify.

F.1.2 Tide prediction
The C-Map Services option also provides tide prediction facilities. To use these you
must also have a C-Map Professional+ database licence.

The tide prediction facilities are concerned with astronomical tides. They:
• Enable you to plot tide and stream symbols on the chart display. The tide symbols

show the current level of the tide. The stream symbols show the speed and direction
of tidal streams.

• Update the data associated with the tide and stream symbols dynaimcally, while you
browse the chart.

• Enable you to display tide levels and daylight data for different times of the day (and
going forward and backward in time) at specified positions around the world.

• Enable you to list the locations for tide and stream data that are nearest to a specified
position.
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• Enable you, when you are using the route planner (Route Editor), to display the tide
data location that is closest to a selected waypoint. The tide prediction for that location
will be given for the own-ship's ETA (Estimated Time of Arrival) at the waypoint.

F.2 Generating routes automatically
This section tells you how to generate a route automatically between two ports by using
the C-Map route generator. Follow the steps in each sub-section in order.

F.2.1 Enabling the C-Map Services option
1 Select System→Maintenance→Change Optional Components.
2 Select C-Map Services and click Enable.
3 Enter 0000 as the licensing PIN-code.

F.2.2 Specifying the departure and destination ports

1 Select Routes→Generate Route Automatically.
This brings up the C-Routes dialog (see left).

2 Unless you have a particular reason for selecting an
alternative database, select the Professional+ database from
the drop-down list.
(Whichever database you select, it must be correctly licensed
for your use.)

3 Select the Ports tab in the C-Routes dialog.
4 Select the name of the port at the start of the route.

You can type in the first letters of a port name in the Search
field and then press the Search button; this helps you to find
a port quickly.
To confirm that a port is really the one you mean, press the
Go To button. This takes you to the location of the selected
port on the chart display.

5 When you have selected the port, click the Add to Route
button.

6 Select the name of the route's destination port and click the
Add to Route button.
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F.2.3 Configuring and calculating the route

1 If the departure and destination ports appear in the list in the
wrong order (because of the order you selected them in), use
theMove Up andMove Down buttons to re-arrange them.
If you want to delete one of the ports because you have
made a mistake, select it and click the Delete button.
Then select a new port instead by going back to the Ports tab
and repeating the port selection process.

2 If you want to specify a minimum depth of water for the
vessel to sail in along the route, use the arrow keys in the
Minimum Depth field to do so.
Note

If you receive an error message later when you calculate
the route, it may be because no route is possible given the
minimum depth you have specified.

3 To allow the vessel to sail in-shore for part of the route,
check the Allow to go in-shore option.

4 To allow the vessel to sail along rivers for part of the route,
check the Allow to use rivers option.

5 Give the route a name of your choice or accept the default
name.
For information about configuring how the system generates
route names, see Configuring how the system generates
route names automatically on page 772.

6 If there are passages on the route that you want to avoid, then
(assuming it is possible to avoid them) click the Passages tab
and specify the passages to avoid (see Avoiding passages
and canals on page 773).

7 Click the Calculate button to generate the route between the
two ports you have specified.
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F.2.4 Correcting the route geometry
The basic route database (which is part of the chart database)
contains a list of waypoints that are connected by straight legs
or great circles. When you generate a route for K-Bridge, the
route geometry needs to be more well-defined than this otherwise
it will not be possible for the automatic track steering facility
to follow it.

The ship's default turn radius is used for all turns in generated
routes (for information about the turn radius own-ship parameter,
see Ship (tab) on page 571).

However, in some places on a route – such as in narrow passages
or along a river – course adjustments can be very frequent and
the legs between waypoints therefore very short.

In these places, if the turn radius is too big for a waypoint that
connects two short legs, the route geometry becomes illegal.
And, because illegal routes cannot be sailed using automatic
track steering, they cannot be validated until the geometry has
been corrected.

When you attempt to validate a route that has illegal geometry, a
Route List prompt dialog is displayed. This dialog gives you the
option to have the geometry corrected automatically. To do this,
press the Auto Correct button.

If you do this, the system performs the correction by reducing
the turn radius for each illegal turn to the maximum radius that
will give correct geometry and not be smaller than the ship's
minimum turn radius specified for the ship.
If the system is not able to correct the geometry automatically,
you must inspect and edit the route manually to correct the
geometry.
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F.2.5 Configuring how the system generates route names
automatically

The C-Routes dialog for calculating the route between two ports
(see Configuring and calculating the route on page 770) contains
a Config... button for configuring how the system generates route
names automatically. (It only generates a name automatically
if you do not specify a name in the Route Name field of the
C-Routes dialog before pressing the Calculate button.) The
Config... button brings up the C-Routes Services Configure dialog
which contains radio buttons for the following four options:
• Generic Name: Select this option to have routes named with a

generic default name.
• UN/Locode:” Select this option to have routes named with the

UN/Locode (minus the country code) for the start and end
ports. An example is “ABD>SVG”, which names a route that
starts at Aberdeen and ends at Stavanger.
UN/Locodes are city designations that were suggested by a
committee of the United Nations to improve the efficiency
of international transportation. The codes are similar to and
partly compatible with the airport codes used by air passengers
for tagging luggage.
The IMO has adopted these UN/Locodes for designating
ports. The naming convention is that a two-letter country code
is followed by a three-letter place code.
If you want to include the country code in the automatically
generated name, select the option UN/Locode w. prefix” (see
below).
If you select one of the UN/Locode naming schemes, the
system matches port names against the UN/Locodes in the
chart database. If it finds no match a default route name is
used.

• UN/Locode w. prefix:” Select this option to have routes named
with UN/Locodes that include the country code. An example
is “GB ABD>NO SVG”, which names a route that starts
at Aberdeen (in Great Britain) and ends at Stavanger (in
Norway).

• Full name: Select this option to have route names that
contain the full names of each port. For example,
“Aberdeen-Stavanger”.

If the system does not produce a UN/Locode for one or both of
the ports at each end of your route, it gives the route a default
name.
If the system does not generate a name automatically that you are
happy with, type a name of your own choosing into the Route
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Name field of the C-Routes dialog before clicking the Calculate
button.

F.2.6 Avoiding passages and canals
In some places you can choose whether to sail along a canal or
passage or to go round it.

If there are canals or passages between the ports you have
specified in the C-Routes dialog (see Configuring and calculating
the route on page 770) and you want to avoid them because of
the size of the ship or out of other considerations then (assuming
it is possible to avoid them) do the following:
1 In the C-Routes dialog, click the Passages tab.
2 Select the passage you want to avoid and click the Disable

button.
This causes the passage's status to change from “Open” to
“Closed”. (By default all passages are “Open”.)

3 If you want to check the location of a passage, select it and
click the Go To button.
This takes you to the location of the passage in the chart
display.

4 To re-open a passage, select it and click the Enable button.
5 When you have closed any passages you want to avoid,

click the Calculate tab and press the Calculate button to
calculate the route (see Configuring and calculating the
route on page 770).
If a route is possible that avoids the passage, the system will
generate a route that avoids it.

The figure below shows two routes from Karlskrona to
Stockholm. The default route goes through Kalmarsund inside of
Øland. When the Kalmarsund passage is CLOSED, the route is
calculated to pass on the outside of Øland.
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Figure 124 Avoiding Kalmarsund on the route between Stockholm and Karlskrona
in Sweden
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Figure 125 Not avoiding Kalmarsund
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F.3 Using the tide prediction facilities
This section tells you how to find out the predicted tide levels at locations you are sailing
to around the world.
To use the tide prediction facilities, you need to:
• Be using the Professional+ chart database (or another database that supports tide

predictions).
• Have the C-Map Services option enabled on your system (see Enabling the C-Map
Services option on page 769).

F.3.1 The C-Map Services main menu
To view the C-Map Services main menu (which is called the
C-Map Supplementary Menu), select Options→C-Map Services.

Although this is the main menu for C-Map Services, you will
find it more convenient to access the tide prediction facilities
by working with particular tide and stream objects on the chart
itself (see Showing where tide and stream data is available on
the chart on page 776).

F.3.2 Showing where tide and stream data is available on
the chart

1 In the ECDIS application, select View→Themes.
This brings up the Themes dialog.

2 Check the Tides and Streams option that appears (among the
supplementary themes supported by the databases you are
using) at the bottom of the dialog.
(Note that, when you check the STANDARD option at the
top of the dialog, the supplementary themes are toggled off.)
This causes tide and stream objects to be displayed on the
chart wherever tide and stream data is available.
Tide objects are represented by this symbol: ; stream

objects by this symbol: .
3 Right-click on one of these symbols to bring up the Tide

context menu or the Stream context menu (as appropriate).
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F.3.3 Viewing tide and daylight data for a location
The C-Map Tide dialog displays the predicted tide and daylight
data at a particular location (the location marked by a particular
tide object on the chart).

To view the Tide dialog, do one of the following:
• Right-click on a tide symbol (see Showing where tide and
stream data is available on the chart on page 776),

• Select Options→C-Map Services→Show Tide Data.
If you access the tide data in this way, the system searches
the chart database for tide objects near the own-ship and
presents the data for the nearest it finds. To check the location
described by the data, click the Go To button. This takes you
to the location in the chart display.

• Select a waypoint from the Waypoint List for a planned route,
and click the Tides button (see Displaying tidal data for a
waypoint in a planned route on page 780).

The C-Map Tide dialog contains the following elements:
Database: The chart database you are using.
Location (drop-down list): The location of the tidal object whose data is displayed. (Use
the arrow to select a new location from the list of locations for which data is available.)
Pos: The co-ordinates of the tidal object whose data you are viewing.
Go To: Click the button to go to the location of the tidal object on the chart display.
Find streams: Click this button to switch to the C-Map Streams dialog.
Find nearest: Click this button to see a list of the tide objects (sorted nearest first) within
a certain radius of the position shown in the Pos field.
Find All: Click this button to view an alphabetical list of the available tide objects.
Timezone: The time zone at the tide object (note that there is currently no provision
for daylight saving time).
Time: Select UTC or the time at the location of the tidal object.
Text field: The text field next to the Timezone field indicates whether the high tide is
semidiurnal (twice daily) or diurnal (once daily).
Arrow buttons: Use these buttons to move backwards and forwards along the time axis in
the chart.
Set Current Time: Click this button to restore the red line (the time marker) in the graph
to the current time at the own-ship.
Tidal curve and daylight graph: The elements of this graph are as follows:
• The vertical axis represents height in metres.
• The horizontal axis represents hours of the day.
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• The tidal curve is displayed as a green line.

• The daylight information is displayed as the background: each hour has a column that
is coloured light grey for dawn and dusk, white for daylight, and dark grey for night.

• The red line is a time marker: use the arrow keys to move the time axis so that the red
line is at different positions in time. This enables you to see clearly what the tides
were or will be at different times. If you are sailing towards the tidal object, for
example, you can put the red line at your ETA (Estimated Time of Arrival) so that
it shows the predicted tide at that time.

The time represented by the red line is also shown at the bottom left of the dialog,
opposite the water level for the tidal object at the time indicated by the red line.

F.3.3.1 Viewing a table of high- and low-water events

The C-Map Tide dialog also includes a tide table. This lists the
times and water levels for all the high- and low-water events at
the selected tide object for the day.

To view the table of high- and low-water events, click the Table
tab in the C-Map Tides dialog.

F.3.4 Displaying stream data
The C-Map Streams dialog displays the predicted tide and
daylight data at a particular location (the location marked by a
particular tide object on the chart).

To view the Streams dialog, either :
• Right-click on a stream symbol (see Showing where tide and
stream data is available on the chart on page 776),

• Or select Options→C-Map Services→Show Stream Data.
If you access the stream data in this way, the system searches
the chart database for stream objects near the own-ship and
presents the data for the nearest it finds. To check the location
described by the data, click the Go To button. This takes you
to the location in the chart display.

The C-Map Streams dialog contains the following elements:

Database: The chart database you are using.
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Location (drop-down list): The location of the stream object whose data is displayed. (Use
the arrow to select a new location from the list of locations for which data is available.)

Pos: The co-ordinates of the stream object whose data you are viewing.

Go To: click the button to go to the location of the stream object on the chart display.

Find streams: Click this button to switch to the C-Map Tide dialog.

Find nearest: Click this button to see a list of the stream objects (sorted nearest first)
within a certain radius of the position shown in the Pos field.

Find All: Click this button to view an alphabetical list of the available stream objects.

Timezone: The time zone at the stream object (note that no provision is made for daylight
saving time).

Time: Select UTC or the time at the location of the stream object.

Arrow buttons: Use these buttons to move backwards and forwards along the time axis in
the chart.

Set Current Time: Click this button to restore the red line (the time marker) in the chart
to the current time at the own-ship.

Tidal curve and daylight chart: The elements of this chart are as follows:

• The vertical axis represents height in metres.

• The horizontal axis represents hours of the day.

• The water-level curve is displayed as a green line.

• The daylight information is displayed as the background: each hour has a column that
is coloured light grey for dawn and dusk, white for daylight, and dark grey for night.

• The arrows represent the direction of the current (relative to north up).

• The red line is a time marker: use the arrow keys to move the time axis so that the
red line is at different positions in time. This enables you to see clearly what the
water levels and direction of current were or will be at different times. If you are
sailing towards the stream object, for example, you can put the red line at your ETA
(Estimated Time of Arrival) so that is shows the predicted water level and current
direction at that time.

The time represented by the red line is also shown at the bottom left of the dialog,
opposite the water level for the stream object at the time indicated by the red line.
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F.3.4.1 Viewing a table of tide flows

The C-Map Tide dialog also includes a table listing the speed and
direction of tide flows for the selected tide object.

To view the table of tide flows, click the Table tab in the C-Map
Streams dialog.

F.3.5 Displaying tidal data for a waypoint in a planned route
The most useful and convenient way of viewing tidal data is in relation to a waypoint
in a planned route.

To do this, select Route→List Waypoints, and in the Waypoint List dialog (see Edit route
on page 420) click the Tides button.

This brings up the data for the tidal object nearest to the selected waypoint. For
information about interpreting the chart and tables displayed, see Viewing tide and
daylight data for a location on page 777.
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Note

The time that the system presents the tide prediction for (in other
words, the position of the red line in the graph displayed) will be based
on the Estimated Time of Departure (ETD) and the planned speed that
are specified for the route to the selected waypoint.

If the Estimated Time of Departure (ETD) for the route to the waypoint
is in the past, you will be prompted to specify a new ETD.

Use the spin buttons to do this, then do one of the following:
• Click Apply to apply the ETD to the route and view the weather

data based on that ETD.
Alternatively, you can alter the route's ETD directly yourself. To
do this, in the Waypoint List dialog (see Edit route on page 420)
edit the ETD/Wait column by specifying the correct ETD for the
selected waypoint.

• Click Ignore to continue to the tide data without specifying an ETD
for the system to base the tide prediction on.

• Click Cancel to cancel the request to view tide data for the route.
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F.4 Avoiding piracy blackspots
This section tells you how to check for reported incidents of piracy at locations you
are planning to sail to or through.

If there have been incidents then skull and cross-bones symbols are displayed on the
chart, indicating both the location of each incident and its type. The type of incident is
indicated by the colour of the symbol; see Specifying which incidents of piracy to display
on page 783. Once you know when and where incidents of piracy have occurred, you
can decide whether to take an alternative route.

Note

Piracy symbols are only available at chart scales of below 1:1000000.

To use the piracy data facilities, you need to:
• Be using the Professional+ chart database (or another database that supports piracy

reports).
• Have the C-Map Services option enabled on your system (see Enabling the C-Map
Services option on page 769).

• Have a valid licence for piracy reports registered in the database (see General tab
on page 497).

F.4.1 The C-Map Services main menu
To view the C-Map Services main menu (which is called the
C-Map Supplementary Menu), in the ECDIS application select
Options→C-Map Services.

This menu includes a Show Piracy Notes button. Click this to
specify the type of incidents you want to display symbols for on
the chart (see Specifying which incidents of piracy to display
on page 783).
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F.4.2 Specifying which incidents of piracy to display
To specify the type of piracy incidents you
want to display symbols for on the chart, bring
up the Piracy Notes dialog.

The path to this dialog is: Options→C-Map
Services→Show Piracy Notes.

The Piracy Notes dialog contains the following
elements:
• Display Piracy Symbols: Check this box

to turn on the display of piracy incident
symbols.

• Incident Period: Use the drop-down list to
specify the time period for which you want
to display symbols representing incidents
of piracy.

• Show Incident Types: The types of incidents for which symbols are displayed are:
– Incidents that have occurred in the last week (black skull and cross-bones)

– Hijacking and kidnapping (red skull and cross-bones)
– Armed robbery or assault (orange skull and cross-bones)
– Attempted attack or boarding (blue skull and cross-bones)
– Theft or suspicious approach (green skull and cross-bones)
Check the box for each category of incident you want to display on the chart.
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F.4.3 Finding out where incidents of piracy have occurred
1 Make sure you are viewing the chart at

a scale of below 1:1000000.
2 In the ECDIS application, either:

• Select View→Themes, and check the
Piracy option that appears (among the
supplementary themes supported by the
databases you are using) at the bottom
of the dialog.
Note that, when you check the
STANDARD option at the top of the
dialog, the supplementary themes
(including Piracy) are all toggled off.

• Or select Options→C-Map
Services→Show Piracy Notes and check
the Piracy option in the Piracy Notes
dialog (see Specifying which incidents
of piracy to display on page 783).

The piracy incident objects (skull and
cross-bones symbols) are displayed on
the chart at the locations where they have
occurred.

3 Double-click on a piracy incident symbol
to view details of the incident it represents (see Viewing a piracy incident report
on page 785).
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F.4.4 Viewing a piracy incident report
1 Follow the instructions in the previous section (see Finding out where incidents

of piracy have occurred on page 784).
2 Double-click on a piracy incident symbol to view details of the incident it represents.

For a general description of the Object Information dialog, see Object Info on
page 377.

381287/A 785



K-Bridge Multi-functional Display Unit

786 381287/A



Appendix G Weather forecasts

Appendix G
Weather forecasts

This section contains the following topics:
Introduction....................................................................................................................788
Enabling the C-Map Weather option .............................................................................788
Accessing the C-Map Weather main menu....................................................................789
Downloading weather data ............................................................................................790
Displaying the weather data on the chart.......................................................................795
Viewing a chart of weather activity ...............................................................................799
Specifying alarm criteria................................................................................................800
Displaying the weather forecast for a planned route .....................................................801
Exporting the weather forecast for a planned route .......................................................805
Configuring the C-Map weather module .......................................................................806
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G.1 Introduction
This appendix describes the C-Map Weather option module for the K-Bridge ECDIS
and Planning Station applications.

The option allows you to download worldwide meteorological and ocean data forecasts.
It also makes available ice charts and cyclone paths and predictions.

To use the option you must have a subscription for C-Map weather data (but you do
not have to use a C-Map chart database).

The weather forecast functions have been integrated with the normal route planning
functionality of the K-Bridge ECDIS and Planning Station applications. Therefore
you can use them to access weather data at different points in space and time along a
route that you are planning.

The C-Map weather facilities:
• Provide data from C-Map servers that has been received from different data providers.

The data is downloaded to your system directly from the internet in a compressed and
encrypted “grib” format (you need an internet connection to use the service).
The data downloaded can vary as to the weather phenomena it describes and as to
the extent of its geographical coverage.
Different weather forecast sets will also have different intervals between predictions,
and different overall forecast lengths (for example, one weather forecast might cover
the next three hours, another the next five days).

• Enable you to overlay weather data on a chart and watch it change as you change the
time that you want the information about.

• Enable you to co-ordinate and display weather forecasts with a route plan. This also
means that you can specify weather alarm criteria for a route.
For example, you might set an alarm for wind speeds of greater than 20 knots, and
another for waves of more than 3 metres in height; you can also view on the chart the
zone in which these criteria are in force.

G.2 Enabling the C-Map Weather option
1 Select System→Maintenance→Change Optional Components.
2 Select C-Map Weather, and click Enable.
3 Enter the licensing PIN-code.
Note

To use the C-Map weather forecasting tools, you need a C-Map eToken. This plugs
into a USB port, and you need to use it whenever you require access to the weather
forecasting facilities.
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G.3 Accessing the C-Map Weather main
menu
To view the main menu for the C-Map weather forecast facilities, select Options→C-Map
Weather.

This menu contains the following buttons:

Download Weather File: Click this button to
go to the dialogs for downloading weather
data from the C-Map server (see Downloading
weather data on page 790).

Load Weather File: Click this button to display
an existing weather file over the chart (see
Displaying the weather data on the chart on
page 795).

Load Ice File: Click this button to display an
existing ice file over the chart.

Load Cyclone File: Click this button to display an existing cyclone file over the chart.

Weather Themes: Click this button to bring up the Weather Themes dialog which enables
you to control the weather data that appears on the screen (see Controlling the displayed
data on page 795).

Time Series: Click this button to see a chart of the weather data from the beginning to the
end of the time period covered by the currently loaded weather forecast (see Viewing a
chart of weather activity on page 799).

Define Weather Alarm Zone: Click this button to define alarm criteria for the alarm zone
around the own-ship (see Specifying alarm criteria on page 800).

Cursor Readout: Click this button to enable a weather data dialog to be displayed
whenever the cursor rests on a weather data object on the chart.

Configure: Click this button to configure the C-Map Weather option module (see
Configuring the C-Map weather module on page 806).
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G.4 Downloading weather data
This dialog enables you to download weather data for a particular geographical area
from the C-Map server.

To reach the dialog, select Options→C-Map
Weather→Download Weather Data.

The data you download is called a “working
set”. It is a combination of: a product that you
have subscribed to from C-Map, a selection
of weather parameters and a collection of
time-specific weather forecast data.

The Download Weather Data dialog contains
the following elements:

Weather working set: This is a drop-down list
containing the names of the working sets that
are available to download. Select the one you
require.

The list includes an item called Subscription.
Select this and click the Download button to
view your most recent C-Map subscription file.

Download: Click this button to download the
selected working set.

Edit: Click this button to edit the selected
working set before downloading it (see
Defining a “working set” (before you can

download it) on page 791).

List: Click this button to list the contents of the selected working set.

New: Click this button to define a new working set to download (see Defining a “working
set” (before you can download it) on page 791).

Progress: The progress bar indicates the progress of the current download.

Downloaded Data: This table logs details of the downloads you have performed. It
records: the time of the download; the name of the working set downloaded; the result
of the download (whether it was successful or not); the size of the download, and the
name of the file downloaded. (Use the horizontal scroll bar or left and right arrows
to view this data.)

Load: To load a working set that you have already successfully downloaded from the
C-Map server, select an instance of it in the table of downloaded data, and click the
Load button to display it.
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G.4.1 Defining a “working set” (before you can download it)
Before you download a working set, you need to specify the product whose features you
will select from and download:
1 In the Download Weather Data dialog (described in the previous section, see

Downloading weather data on page 790), click the Edit or New button.
This brings up another version of the Download Weather Data dialog.

2 In theWeather Working Set Name field, specify the name of the working set.
If you are editing an existing working set, its name appears in this field. You can
edit the name.
If you are creating a new working set, specify a name for it.

3 The drop-down list contains the C-Map products you are subscribed to. Select
the one you require.

4 From the tree structure, which lists the features available for the selected product,
select the features you require.
Do this by checking or un-checking the box to the left of the feature's name in
the tree.

5 Specify the geographical area you are interested in:
• You can define the area you require by using the cursor (controlled by the

trackball) to draw a rectangle on the chart display.
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To do this, check the Display and Edit Area box (to display the rectangle), then
click the Use Cursor button.

• Click the Reset button if you have defined an area but have changed your mind
and now require data for the whole area covered by the product.

The co-ordinates of the area specified are shown in the Latitude and Longitude fields.
6 Use the Period drop-down list to specify kthe number of days you want the weather

forecast to cover.
7 Use the Time Step drop-down list to specify the number of hours between each

forecast.
8 Check the Download Size field to see whether the working set is too large to be

conveniently downloaded.
If you think it is too large, try:
• Removing some of the features you have included.
• Reducing the size of the area covered.
• Reducing the time period for which forecast data will be gathered.
• Increasing the size of the time step between the forecasts generated.

9 When you are satisfied with the parameters you have specified, click the:
• Save button to save the working set (over-writing the previous version of it if you

have not given it a new name).
• Save As button to save the working set with a new name and to a new file.

The following figures shows sample weather data. The first shows sample ECMWF
(European Centre for Medium-range Weather Forecast) data.
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Figure 126 ECMWF data for a 25km range

Figure 127 Mercator currents

381287/A 793



K-Bridge Multi-functional Display Unit

Figure 128 Ice concentrations

Figure 129 Cyclone data
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G.5 Displaying the weather data on the
chart
Only one weather data set can be displayed at a time.

To display a data set:
1 Select Options→C-Map Weather→Load Weather File.
2 In the Open dialog, select the file containing the data set you require.

(Data sets are given names indicating when they were downloaded.)
3 When the data set loads, the chart appears in the display with weather overlays and

the Weather Themes dialog super-imposed.
Use the Weather Themes dialog to control the weather data (see Controlling the
displayed data on page 795).
(You can also view the Weather Themes dialog by selecting Weather Themes from
the main weather menu; see Accessing the C-Map Weather main menu on page 789.)

G.5.1 Controlling the displayed data
When you load a data set, the weather forecast data appears as overlays on the chart
display.

Figure 130 The Weather Themes dialog and overlays

The Weather Themes dialog enables you to control the weather data shown on the chart.
It contains the following elements:
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Display Weather Overlay: Un-check this box
to hide all weather overlays.

Note

Checking the Standard Display option in the
Chart Themes dialog (see Chart Themes on
page 373) toggles OFF the display of weather
data. If you have done this, you must explicitly
check the Display Weather Overlay box in the
Weather Themes dialog to re-enable the display
of weather data.

Exactly which weather themes are available
depends on which features you selected when
you specified the working set (see Defining a
“working set” (before you can download it)
on page 791).

Alarm Zones: Check this box to display the
weather alarm zone around the own-ship. Click the ... button to define alarm criteria (see
Specifying alarm criteria on page 800).

Data set details: The first field in the Weather Data group contains the name of the
downloaded data set and the date and start time of the forecast.

Go To: Click this button to go to an overview in the chart of the area covered by the
weather data (a scale will be used that attempts to be comprehensive while at the same
time presenting useful visual information).

New: Click this button to load another data set (see Displaying the weather data on
the chart on page 795).

Download: Click this button to download another data set (see Downloading weather
data on page 790).

Date fields: The two date fields show the start and end dates for the forecast. Use the spin
buttons to change these.

Spin buttons and slider: Use these to change the time that the displayed weather data
relates to. The slider enables you to move backwards and forwards across the whole of
the weather forecast. The spin buttons enable you to step from one data sample to the
next. (You will see the overlaid data change as you use these time controls.)

Displayed Time: The time that the displayed weather forecast relates to. You can move
the forecast backward and forward in time by using the spin buttons and slider.
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G.5.2 Right-clicking on the area covered by the weather
overlays
When you right-click (using the trackball buttons) in the area containing weather
overlays, the CMCL Weather Forecast menu appears. It contains the following options:

Undisplay Weather Overlay: Select this option to clear the
display of all weather data. To display it again, check the
Display Weather Overlay option in the Weather Themes
dialog (see Controlling the displayed data on page 795).

Weather Themes: Select this option to bring up the
Weather Themes dialog (see Controlling the displayed
data on page 795).

Set Current Time: Select this option to set the time of the weather forecast.

Show Time Series: Select this option to view a chart showing weather activity over the
time covered by the forecast (see Viewing a chart of weather activity on page 799). The
data is for the geographical location indicated by the position of the cursor.

Display Cursor Dialog: Select this option to cause a weather data dialog to be displayed
whenever the cursor rests on a weather data object on the chart. This option is the
equivalent of selecting Options→C-Map Weather→Cursor Readout (see Accessing the
C-Map Weather main menu on page 789).

Configuration Dialog: Select this option to configure the C-Map weather module (see
Configuring the C-Map weather module on page 806).
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G.5.3 Double-clicking on the weather overlays to display
object information
When weather data is being displayed in an overlay on the chart, you can double-click on
it to view Object Information for the currently loaded weather forecast.

The information includes all features that you selected when you defined the data set
before downloading it. It therefore may include features that are not displayed in the
overlays.

Some of the presentation of the data, for example, the units of measurement for the
wind speed, can be modified from the Configuration dialog (see Configuring the C-Map
weather module on page 806).
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G.6 Viewing a chart of weather activity
You can view a chart showing weather activity over the duration of the forecast at the
position indicated by the cursor. This position is specified at the top of theWeather Time
Series dialog (see left).

To view this data,
1 Put the cursor at the desired position in the

area covered by the weather overlays, then:
• Either right-click and select Show Time

Series.
• Or from the main menu select

Options→C-Map Weather→Time Series.
2 Check the box next to each weather feature

that you want to see data for plotted on
the chart.

3 To display the alarm zone around the
own-ship, check the Alarm Zones option.
Click the ... button to define alarm
criteria (see Specifying alarm criteria on
page 800).

4 Use the horizontal scroll bar to move
backwards and forwards in time over the
course of the forecast.
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G.7 Specifying alarm criteria
You can specify alarm criteria that cause an alarm zone to form around the ship. The
criteria take the form of simple “and/or” expressions. The precise form and extent of
the alarm zone depend on the criteria you specify and the conditions described in the
weather forecast.

The sample dialog to the left causes an alarm
zone to exist that covers an area where wind
speed exceeds 20 knots OR total wave height
exceeds 4 metres.

To specify an alarm zone around the own-ship,
do the following:
1 From the main menu select

Options→C-Map Weather→Define Weather
Alarm Zone.
This brings up theWeather Alarm Zone Definition dialog.
You can also bring up this dialog by clicking the Alarm Zones button in either the
Weather Themes dialog (see Controlling the displayed data on page 795) or the
Weather Time Series dialog (see Viewing a chart of weather activity on page 799).

2 Formulate an “and/or” expression by selecting one or two events from the
drop-down lists of weather events and specifying (as applicable) the size, speed or
intensity of each one as an alarm limit.

3 Reset: Click this button to reset the dialog to its default state (in which no alarm
criteria are defined).

4 Apply: Click this button to apply the criteria you have defined.

Figure 131 The weather alarm zone (red shaded area)
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G.8 Displaying the weather forecast for a
planned route
It is useful to be able to view the weather forecast for a route that you are planning to sail.

To do this, either:
• Select Route→Manage Routes then, in

the Route List dialog (see Route List on
page 416), select a route and click the
Weather button.

• Or right-click on the route in the chart
to bring up the context menu for the
route (see below left), then select Display
Weather Forecast.

This brings up the Weather Along Route
dialog (seeMoving backwards and forwards
in time on page 803).

Figure 132 The context menu for a route

Note

The time that the weather forecast data relates to will be determined by the Estimated
Time of Departure (ETD) and the planned speed that are specified for the route.

If the Estimated Time of Departure (ETD) for the route has not been defined or is in the
past, you will be prompted to specify a new ETD.
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In the version of the Route List dialog
containing this prompt, use the spin buttons
to specify the ETD, then do one of the
following:
• Click Apply to apply the ETD to the

route and view the weather data based
on that ETD.
Alternatively, you can alter the route's
ETD directly yourself. To do this, select
Route→Manage Routes; in the Route
List dialog, select the route and click
Edit WP; finally select the first waypoint
in the waypoint list (see Edit route on
page 420) and in the ETD/Wait column
specify the correct ETD.

• Click Ignore to continue to the weather
data without specifying an ETD.

• Click Cancel to cancel the request to
view weather data for the route.
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G.8.1 Moving backwards and forwards in time
This section tells you how to view forecast data at different times along the route.

When you have defined the Estimated Time of
Departure correctly for the route, the system
computes estimated times of arrival at a series
of positions along the route plan and fetches
the weather forecast for each of these positions.

It then plots this information on a feature
diagram for the route in the Weather Along
Route dialog.

If you have specified an alarm condition (see
Specifying alarm criteria on page 800), this
is indicated by a green (=ok) or red (=alarm)
bar at the bottom of the Weather Along Route
diagram.

The alarm state is also overlaid on the route as
green (=ok) or red (=alarm) dots (see below).

And overlaid on the alarm symbol itself is a
“simulated ship” symbol with a time label (see
below).

Drag this symbol along the route to change the forecast time and cause the weather
overlays on the chart to be updated for the new time. Notice that the black time-line in
the feature diagram of the Weather Along Route diagram also moves when you do this.

To remove the simulated ship symbol from the display, right-click on the symbol and
from the context menu select Remove Prediction.

To export weather forecast data for the route, click Export Weather Data (see Exporting
the weather forecast for a planned route on page 805).
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Figure 133 The simulated ship symbol's context menu

Figure 134 Weather data for a planned route
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G.9 Exporting the weather forecast for a
planned route
You can export the weather data for a route by clicking the Export Weather Data button
in the Weather Along Route dialog. This is the dialog that comes up when you view the
weather data for the route (see Displaying the weather forecast for a planned route
on page 801).

When you click the Export Weather Data
button, the dialog changes and the following
options and buttons become available:
• Timestep: Use the spin buttons to specify the

time interval between weather data positions
along the route. (A weather data position
is a position on the route for which weather
data is produced.)

• No Extra Weather Data: If you select this
option, weather data is produced only for
the ETA (estimated time of arrival) at each
weather data position along the route.

• Extra Weather Data: Time Offset (+/-):
Select this option to receive weather data for
the ETA and the ETA plus or minus a time
offset at each weather data position along
the route. Use the spin buttons to specify
the time offset.

• Speed Offset (+/-): Select this option to
receive weather data for the ETA and the
ETA with a speed offset applied at each
weather data position along the route. Use
the spin buttons to specify the speed offset.

• Maximum Weather Data: Select this option
to receive all available weather data for the
weather data positions determined by the
Timestep option.

• Save Weather Data to Medium: Click this
button to save the weather data for the route
to a USB memory stick or other medium.

• Export Weather Data: Click this button to save the weather data to the “export”
location for the K-Bridge operator station.
For information about configuring the “export” location for the operator station,
see Configure Route Export on page 661.

• Export Weather Data and Route Plan: Click this button to save both the weather data
and the route plan to the “export” location for the K-Bridge operator stations.
For information about configuring the “export” location for the operator station,
see Configure Route Export on page 661.
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G.10 Configuring the C-Map weather
module
There are a few configurable parameters associated with the C-Map Weather option
module.

To bring up the dialog for configuring these
parameters, from the main menu select
Options→C-Map Weather→Configure:

This brings up the Weather Configure dialog
which contains the following elements:

Download data using C-Map Terminal: Check
this box to use the C-Map terminal program
for downloading data. In this case, you
need to contact your Kongsberg Maritime
representative for details of how to proceed.

Wind Speed Unit: Select knots (kn) or meters
per second (m/s) as the unit of measurement for wind speed.

Automatically delete weather files: Check this option if you want the system to delete old
weather files automatically. Use the spin buttons to specify when the system should
delete them. (You need to specify this as a number of days after the last date of the
forecast contained in the files has passed.)

Cancel: Click this button to cancel any changes you have made to the C-Map module's
configuration.

Apply: Click this button to apply the changes you have made to the C-Map module's
configuration.
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Appendix H
Keyboard Function Key
Template

This section contains the following topics:
[F1] key functions ..........................................................................................................808
[F2] key functions ..........................................................................................................808
[F3] key functions ..........................................................................................................808
[F4] key functions ..........................................................................................................809
[F5] key functions ..........................................................................................................809
[F6] function keys ..........................................................................................................809
[F7] key functions ..........................................................................................................810
[F8] key functions ..........................................................................................................810
[F9] key functions ..........................................................................................................811
[F10] key functions ........................................................................................................811
[F11] key functions ........................................................................................................811
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H.1 [F1] key functions
This appendix contains a template that you can print out, cut round the edges of, and place
over the 12 function keys on the keyboard of your operator station or Planning Station
computer (note that it is designed for standard-size keyboards, not miniature ones).
If, in combination with a single function key, you press the [Shift], [Ctrl], or [Alt] key,
the [Ctrl] and [Shift] keys together, or the [Right Shift] key, the effect in each case will
be equivalent to pressing a particular button on the operator panel (or in some cases to
clicking a certain button on the screen).
The template, therefore, enables you – if necessary or convenient – to use the keyboard
as an alternative to the operator panel.
The [F1] key enables you to:
• Zoom in: press [Shift][F1]

This is equivalent to pressing RANGE + on the operator panel (see The DISPLAY
group buttons on page 34).

• Zoom out: press [Ctrl][F1]
This is equivalent to pressing RANGE - on the operator panel (see The DISPLAY
group buttons on page 34).

• Return to the default zoom level: press [Alt][F1]
This is equivalent to pressing ZOOM RESET on the operator panel (see The DISPLAY
group buttons on page 34).

• Reset the centre of the screen: press [Ctrl][Shift][F1]
This is equivalent to pressing RESET CENTRE on the operator panel (see The
DISPLAY group buttons on page 34).

H.2 [F2] key functions
The [F2] key enables you to:
• Select the daylight display palette: press [Shift][F2]
• Select the night display palette: press [Ctrl][F2]
• View details of the chart object closest to the cursor on the screen: press [Right

Shift][F2]
This is equivalent to pressing OBJECT INFO on the operator panel (see The CHART
group buttons on page 35).

H.3 [F3] key functions
The [F3] key enables you to:
• Increase the brightness of the display’s backlight: press [Shift][F3]
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This is equivalent to pressing PALETTE + on the operator panel (see The DISPLAY
group buttons on page 34).

• Decrease the brightness of the display’s backlight: press [Ctrl][F3]
This is equivalent to pressing PALETTE - on the operator panel (see The DISPLAY
group buttons on page 34).

H.4 [F4] key functions
The [F4] key enables you to:
• Restore the monitor’s backlight to the level at which chart colours are correctly

calibrated for the current display palette: press [Ctrl][Shift][F4]
This is equivalent to clicking Set Calibrated in the Intensity dialog (see Intensity
on page 367).

H.5 [F5] key functions
The [F5] key enables you to:
• Give the operator station command of the autopilot: press [Shift][F5]

This is equivalent to pressing IN CMD on the operator panel (see The IN CMD button
on page 37).

• Execute a planned turn: press [Ctrl][F5]
This is equivalent to pressing ACT TURN on the operator panel (see The ACT TURN
button on page 38).

• Adjust the course or heading (by reducing the angle of direction): press [ALT][F5]
This is equivalent to pressing the lefthand (decrease) heading button on the heading
wheel (see The heading wheel on page 41).

• Return the display to the real-time view (away from details of a planned turn): press
[Right Shift][F5]
This is equivalent to pressing AUTO/PLAN on the operator panel while a planned turn
is being displayed (see The AUTO/PLAN button on page 39).

H.6 [F6] function keys
The [F6] key enables you to:
• Put the autopilot into Course mode: press [Shift][F6]

This is equivalent to selecting Crs in the Autopilot Mode dialog (see Autopilot Mode
on page 427).

• Put the autopilot into Waypoint mode: press [Ctrl][F6]
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This is equivalent to selectingWP in the Autopilot Mode dialog (see Autopilot Mode
on page 427).

• Increase the distance-to-turn: press [ALT][F6]
This is equivalent to pressing the up button on the heading wheel (see The heading
wheel on page 41).

• Decrease the distance-to-turn: press [Ctrl][Shift][F6]
This is equivalent to pressing the down button on the heading wheel (see The heading
wheel on page 41).

• Specify a planned turn: press [Right Shift][F6]
This is equivalent to pressing AUTO/PLAN on the operator panel (see The
AUTO/PLAN button on page 39).

H.7 [F7] key functions
The [F7] key enables you to:
• Put the autopilot into Heading mode: press [Shift][F7]

This is equivalent to selecting Hdg in the Autopilot Mode dialog (see Autopilot Mode
on page 427).

• Put the autopilot into Track mode: press [Ctrl][F7]
This is equivalent to selecting Track in the Autopilot Mode dialog (see Autopilot
Mode on page 427).

• Adjust the course or heading (by increasing the angle of direction): press [ALT][F7]
This is equivalent to pressing the righthand (increase) heading button on the heading
wheel (see The heading wheel on page 41).

H.8 [F8] key functions
The [F8] key enables you to:
• Turn off the browse facility (in other words, cause the display to track the vessel’s

movements again when you have finished browsing away from the vessel on the
chart): press [Shift][F8]

• Browse away from the vessel on the chart: press [Ctrl][F8]
This is equivalent to clicking the Browse button on the ECDIS range panel (see ECDIS
range panel: viewing controls on page 88).

• Bring up the Docking facility (on vessels for which the Docking option is installed):
press [ALT][F8]

• Stop tracking a target: press [Right Shift][F8]
This is equivalent to pressing CANCEL on the operator panel (see The TARGET
group buttons on page 35).
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H.9 [F9] key functions
The [F9] key enables you to:
• Display the standard chart themes: press [Shift][F9]

This is equivalent to pressing STD DISPLAY on the operator panel (see The CHART
group buttons on page 35).

• Select the themes you want to display on the chart: press [Ctrl][F9]
This key combination displays the Chart Themes dialog (see Chart Themes on
page 373).

• Stop displaying targets and radar video on the charts: press [ALT][F9]
This is equivalent to un-checking the TGT and VID options on the ECDIS range panel
(see ECDIS range panel: viewing controls on page 88).

• Make the boarding area appear or disappear: press [Shift][Ctrl][F9]
For information about the boarding area (see The boarding areas in Radar and ECDIS
on page 99).

• Start tracking the target closest to the marker: press [Right Shift][F9]
This is equivalent to pressing ACQ on the operator panel (see The TARGET group
buttons on page 35).

H.10 [F10] key functions
The [F10] key enables you to:
• View data for the target closest to the marker: press [Right Shift][F10]

This is equivalent to pressing DATA on the operator panel (see The TARGET group
buttons on page 35).

H.11 [F11] key functions
The [F11] key enables you to:
• Test the lamps on the operator panel: press [Ctrl][F11]
• Mark the position of a Man-Over-Board incident: press [ALT][F11]

This is equivalent to pressing MOB on the operator panel (see The MOB (Man Over
Board) button on page 36).

• Acknowledge one or more alerts: press [Ctrl][Shift][F11].
This is equivalent to pressing ACK on the operator panel (see The Alarms group
on page 39).

• Silence the sound associated with an alert: press [Right Shift][F11]
This is equivalent to pressing SOUND OFF on the operator panel (see The Alarms
group on page 39).
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2 / abc, input panel, 42

A
abc..., input panel, 42
About integrated systems, 104
Accessing system
parameters, 347
Operation, 348

ACQUIRE button, 35
Acquiring ARPA targets
Adjusting tracking
sensitivity, 146
Automatic acquisition, 143
Barrier lines, 147
Ceasing target
acquisition, 145
Displaying target data, 147
Displaying targets' past
position indications, 153
Limitations, 142
Manual acquisition, 143
Turning automatic
acquisition off, 145
Turning automatic
acquisition on, 144

Active targets, 174
Aid to navigation, 175
AIS (Automatic
Identification System), 166
AIS / Radar Target
Vectors, 166
Association of
Target Vectors and
Information, 166
Automatic Target
Acquisition or
Activation, 167
Collision warnings, 172
Dependence of sensors
on AIS target, 172
Dependence of sensors
on own ship, 173
Displaying AIS target
data, 168
Symbol list, 174

AIS button, 82
AIS functions
Acknowledging lost
targets, 169
Sending and receiving
text telegrams, 170
Specifying the own-ship
information, 169
Viewing the own-ship's
data, 169

AIS symbols
Active targets, 174
Aid to navigation, 175
Aid to navigation
(virtual), 175
Associated (fused)
targets, 175
Base station, 175
Dangerous targets, 174
Lost targets, 174
Search and rescue
aircraft, 175
Search and rescue
transponder, 175
Selected targets, 174
Sleeping targets, 174
Target identification, 175

ALARM button, 65–66
Alarm priority button, 67
ALARMS buttons – ACK, 40
ALARMS buttons –
ALARM, 40
ALARMS buttons –
ALARM VIEW, 40
ALARMS buttons –
“SOUND OFF", 40
ALC NAV panel buttons
ALARMS buttons –
ACK, 40
ALARMS buttons –
ALARM, 40
ALARMS buttons –
ALARM VIEW, 40
ALARMS buttons –
“SOUND OFF", 40
AUTOPILOT button –
ACT Turn, 38
AUTOPILOT button –
AUTO / PLAN, 39
AUTOPILOT button –
In Cmd, 37
PANEL FAULT, 36
PANEL POWER, 36

Alert area, 60
Alert condition group
buttons, 61
Alert Group dialog, 70
Alert handling, 331
Acknowledgement of
target-related alerts in
ECDIS, 333
Alert acknowledgement
by the originating
operator station, 332
Alert acknowledgement
using the operator
panel, 333

Alert acknowledgement
using the top bar
buttons, 333
Alert acknowledgement
using the
unacknowledged alerts
list, 334
Alert filtering, 335
Alert groups, 333
Alert lists, present and
historical, 336
Alerts from remote
operator stations, 336
Listing active alarms, 335
Output to external alarm
system, 344

Alert help button, 68
Alert Information dialog, 68
Alert List dialog (large
format), 71
Alert list dialogs, 70
Alert priority button, 66
Alert priority group
buttons, 61, 65
Alerts
Acknowledging in Alert
Group dialog, 336
Acknowledging in Alert
List dialog, 339
Right-click menu in list
dialogs, 340
Sorting lists of alerts, 340
Viewing the alert
history, 340

Alphanumeric keyboard, 43
ANCH button, 64
Anchor watch function, 324
Own ship anchor watch, 324
Target anchor watch, 324

Anchor-watch alert button, 64
ARCS demonstration
HCRF charts, 207
Area alert button, 64
AREA button, 64
Automatic track keeping,
247, 251
Accuracy and
performance
constraints, 255
Adapting the autopilot
to different conditions, 249
Alerts given, 254
Automatically stopping
track steering, 254
Conditions resulting
in an automatic
switch-over to a
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different steering
mode, 258
Default “in command”
console, 249
Giving steering control
to the autopilot, 250
Introduction, 248
Manually stopping track
steering, 253
Practical hints, 255
Requirements, 252
Steering using the
curved EBL, 253
Taking command of
the autopilot at a new
operator station, 251
Track mode, 252
Waypoint alerts, 254

AUTOPILOT button –
ACT Turn, 38
AUTOPILOT button –
AUTO / PLAN, 39
AUTOPILOT button – In
Cmd, 37
Autopilot command
button, 59
Autopilot mode, 309

B
Backing up
Notes, routes, and
barrier lines, 348
The system
configuration, 349

Barrier lines, 147
Base station, 175
Bearing scale, 95
Better chart, 92
Better chart, ECL
available, 92
BNWAS, 276
Alarm sequence, 276, 281
Calling for backup, 283
Equipment, 278
Operating statuses, 289
Password access, 285
Resetting the alarm
timer, 280
Restoring password
protection, 289
Selecting backup
navigators, 284
Setting the countdown
period, 289
Starting the BNWAS, 286–287
Stopping the alarm
sound, 283

Stopping the BNWAS, 288
Timeline, 281
User interface
(Conning), 279

Boarding areas, 99
Boarding buttons, 76, 99
Brightness control, 120
Browse indicator, 90

C
C-Map CM-93 edition 2
charts, 185
Chart levels, 185
Deleting charts, 190
Maintaining a stand
alone chart database, 187
Mirroring charts from
K-Bridge ECDIS, 186
Updating charts, 189

C-Map CM-93 edition 3
charts, 178
Configuring the chart
database, 179
Editing chart options, 183
Installing charts, 179
Updating charts, 183
Using multiple chart
databases, 183

Calling for backup, 283
CANCEL button, 35
Categories of severity for
alerts, 67
CAUTION button, 65–66
Caution priority, 67
CCRP
Common Consistent
Reference Point, 114

Chart area, 97
Chart area, example, 97
Chart availability
Better chart, 92
Better chart, ECL
available, 92
Chart Available, ENC
available, 92
Chart with
best resolution
automatically loaded, 92
Manual chart selection, 92

Chart Available, ENC
available, 92
Chart display mode
Browse indicator, 90

Chart formats, 178
CHART group buttons
MANAGE ROUTES, 35
MONITOR, 35

OBJECT INFO, 35
STD DISPLAY, 35

Chart objects
Manipulating objects on
the screen, 126

Chart on/off button (for
radar), 80
Chart quality indicator, 92
Chart regeneration area, 208
Chart Scale, 88
Chart scale status
NOM SCL indicator, 91
OVR X1.7 indicator, 80, 92
UND SCL indicator, 80, 92

Chart type indicator
ENC indicator, 91
ENC/VEC indicator, 91
RNC indicator, 91
VEC indicator, 91

Chart with best resolution
automatically loaded, 92
Clutter control, 120
COG button/indicator, 72
Collision avoidance, 157
Colour calibration, 116
Conning
BNWAS information, 274
Depth information, 269
Heading information, 262
Speed information, 264
Steering control
information, 265
Thruster/propulsion/rudder
information, 263
Weather information, 273
Wind data from different
sensors, 271
Wind information, 270

Conning position, 95, 114
Controlling objects on the
screen, 126
Countdown function, 321
Course mode, 257
Course over ground
button/indicator, 72
Course Up, 80, 89
Creating a critical point in
the chart, 241
Creating a critical point
using the menu, 241
Cross-track distance, 267
Cross-track Distance alert
button, 64
CRS button, 35
CUP/RM, 80, 89
CUP/TM, 80, 89
Curved EBL, 253,
308–309, 311
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Planning mode, 308

D
Dangerous target alert
button, 62
Dangerous targets, 174
DATA button, 35
Depth button/indicator, 73
Depth recordings, 329
Digitizing marker, 101
Display area, 50–51
DISPLAY group buttons
PALETTE (+/-), 34
RANGE (+/-), 34
RESET/CENTRE, 34
SUPPR, 34
TRUE/REL, 34
ZOOM/RESET, 34

Display layout, 50–51
Displaying charts, 208
Limitations of chart
themes, 210
Simultaneous
presentation of charts
and radar video, 209

Distance to Turn, heading
wheel, 41
DNG button, 62

E
EBL/VRM, 300–301, 311
Advanced features
(ECDIS), 546

EBL/VRM button, 87
ECDIS range panel, 88
Enable button, heading
wheel, 41
ENC indicator, 91
ENC official chart
indicator, 80, 91
ENC/VEC indicator, 91

F
FMEA information, 132

G
Gain control, 120–121
Gain knob, 33
Geodetic datum, 140
GRND button, 64
Ground/water stabilisation
menu, 80
Grounding alarm button, 64

H
HCRF charts, 203
ARCS demonstration
charts, 207
Deleting charts, 206
Installing charts, 204
Updating charts, 205

HDG button, 35
HDG button/indicator, 72
Head Up, 80, 89
Heading button/indicator, 72
Heading failure, 133
Heading line, 93
Heading mode, 256
Heading wheel, 41
Distance to Turn, 41
Enable button, 41
Heading, 41
Turn Radius, 41

Heading, heading wheel, 41
High-speed craft, 159
HUP/RM, 80, 89

I
Input panel
2 / abc, 42
abc..., 42
PAGE DOWN, 42
PAGE UP, 42

Inserting critical points, 240–241

L
Log printout, 327
Log text view, 327
LOST button, 62
Lost target alert button, 62
Lost targets, 174

M
Making numeric entries, 131
MANAGE ROUTES
button, 35
Manual chart selection, 92
Mariner's notes
Creating line notes, 221

Mariners' notes, 219
Creating area notes, 222
Creating point notes, 221
Introduction, 220
Modifying notes, 222
Printing notes, 223
Turning mariners' notes
on, 220

Marker, 101

Marker button, 86
Marker inside chart or
radar area, 101
Marker outside chart areas, 101
Master console, 130
Menu area, 75–76, 364
MFD
Powering off, 117
Powering on, 110
Switching between
Radar, ECDIS and
Conning, 120

MOB
Deleting a MOB object, 660
Moving a MOB object, 660

MOB button, 36
MODES group lamps
CRS, 35
HDG, 35
TRACK, 35
WP, 35

MONITOR button, 35
Monitoring routes, 238
Most-relevant dialog
button, 68

N
NAV operator panels, 32
NAV panel, 33
Navigation master, 130
Navigation Tools panel, 86
Navtex functions
Configuring navigation
area, 215
Creating Mariners notes, 216
Filtering message
categories, 215
Filtering Navtex
stations, 215
Introduction, 214
Printing Navtex
messages, 216
Viewing Navtex
messages, 215

NEW button, 63
New target alert button, 63
Next dialog button, 76
NOM SCL indicator, 91
North Up, 80, 89
NUP/RM, 80, 89
NUP/TM, 80, 89

O
OBJECT INFO button, 35
Off-course alarm system, 292
operating statuses, 294
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Setting the deviation
limit, 294

Operator messages, 78, 88
OVR X1.7 indicator, 80, 92

P
PAGE DOWN, input panel, 42
PAGE UP, input panel, 42
PALETTE (+/-) button, 34
PANEL FAULT button, 36
PANEL POWER button, 36
Parallel index lines, 304
Past Pos button, 82
Past position indications,
82, 146, 153
compared with trails, 158

Past track log, 324
Performance monitor, 163
Planning mode, 308
Position button/indicator, 74
Position lines, 306
Position offset, 300
Position offset
button/indicator, 74
Predicted movements, 317
Previous dialog button, 76

R
Radar antenna, 94
Radar antenna location, 94
Radar antennas
automatic standby, 108

Radar dashboard, 77
RADAR group knobs, 33
Gain, 33
Rain, 33
Sea, 33

Radar interswitch unit, 106
Radar on K-Bridge ECDIS, 767
Radar positioning, 148–151
Radar Signal Information
panel, 85
Radar System Information
panel, 83
Radar target symbol, 97
Radar targets, 142
Radar tracker sensitivity, 152
Radar transciever
performance monitor, 163

Radar video area, 93
Rain clutter, 111, 123–124
Rain knob, 33
RANGE (+/-) button, 34
Range button, 79
Range buttons, 88
Range panel, 79
Range rings, 86, 93, 111

Relative motion, 89
Remote markers, 311
Replay track or voyage
logs, 326
Reset centre limits, 96
RESET/CENTRE button, 34
Rings button, 86
RM (Relative Motion), 80
RNC indicator, 91
Routes/tracks, 231
Adding waypoints at the
end of route, 235
Copying waypoints, 236
Creating a critical point
in the chart, 241
Creating a critical point
using the menu, 241
Creating a route in radar
area, 234
Creating a route using
waypoint list, 233
Definitions, 232
Importing/exporting
routes, 242
Inserting critical points, 240
Inserting waypoints, 234
Modifying routes, 234
Modifying routes in
radar area, 235

S
S57 charts from PRIMAR
or AVCS
Installing charts, 198

S57/S63 charts, 193
S57/S63 charts from
PRIMAR or AVCS
Installing charts, 196

Safety contour, 113
SART detection, 352
Scale button, 79
Scaling up and down, 129
Scanner/Transceiver
button, 59, 84
Screen brightness, 120
Screen layout, 48
Screen resets (Radar), 96
Sea clutter, 111, 122, 124
Sea knob, 33
Search and rescue
Creeping line search
pattern, 361
Expanding square search
pattern, 359
Flower/sector search
pattern, 357
Generating a route plan, 356

Parallel track search
pattern, 360

Search and rescue aircraft, 175
Search and rescue
transponder, 175
Search andrescue
Selecting a search
pattern, 354

Selected targets, 174
Set centre limits, 96
Sleeping targets, 174
SOG button/indicator, 73
Speed over ground
button/indicator, 73
Speed through water
button/indicator, 73
Start-up K-Bridge Radar, 110
STD DISPLAY button, 35
Stern marker, 93
Stopwatch, 321
STW button/indicator, 73
SUPPR button, 34
Switch-off K-Bridge
Radar, 117–118
Via system menu, 118
Via the computer, 117

System degradation
warning indicator, 90

T
Target errors, 160
TARGET group buttons
ACQUIRE, 35
CANCEL, 35
DATA, 35

Target Information panel, 81
Target interception point,
318–319
Target symbols, 145
Acquisition phase, 145
AIS, 174
Associated (fused)
target, 146
Collision danger, 146
Lost target, 145
New target, 145
Past position indications, 146
Radar, 145
Target data displayed, 146
Target identification, 146
Tracked target, 145

Target trails, 155–156
Targets, 143
Adjusting tracker
sensitivity, 146
Displaying target data, 147
Past position indications, 153
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Targets button, 90
Templates, 226
Attaching templates to
objects, 228
Copying templates, 229
Creating/editing
templates, 227
Defining templates, 227

Time source, 140
Time/distance/speed
calculator, 322
TM (True Motion), 80
Top bar, 57
sensor buttons, 59

TRACK button, 35
Track-ball marker, 101
Trails, 82, 156
compared with past
position indications, 158

Trails button, 82
Transceiver sensitivity, 163
Trial manoeuvre, 313
Limitations, 313
Operation, 313

Trip meter, 323
True motion, 89
TRUE/REL button, 34
Tune slider, 84
Turn Radius, heading
wheel, 41

U
Unacknowledged alerts
button, 69
Unacknowledged alerts
list, 69
UND SCL indicator, 80, 92
Using curved EBL
Autopilot mode, 309

Using mariners' notes
Managing mariners'
notes, 220

Using trial manoeuvre, 313

V
VEC indicator, 91
Vector button, 81
Vectors, 113
Video button, 90
Video gain, 111
Voyage log, 325
Voyage log and replay,
324, 326
Log printout, 327
Log text view, 327
Past track log, 324

Replay track or voyage
logs, 326
Voyage log, 325

W
WARNING button, 65–66
Warning priority button, 67
Waypoint mode, 257
Weather forecasts, 787
WP button, 35

X
XTD button, 64

Z
Zoom, 128, 130
ZOOM/RESET button, 34
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